## Contents

**IT Service Management** ........................................................................................................................................... 5  
  Asset Management....................................................................................................................................................... 5  
  Asset Management Overview module........................................... 5  
  Asset Management process.......................................................... 23  
  Asset information management................................................... 23  
  Asset classes.................................................................................. 25  
  Asset and CI management............................................................ 27  
  Transfer orders............................................................................... 46  
  Stockrooms...................................................................................... 63  
  Stock rules...................................................................................... 67  
  Software Asset Management plugin........................................... 69  
  Organization Management............................................................ 147  

**Change Management** .................................................................................................................................................. 149  
  Change types.................................................................................... 150  
  Migrate Change Management from releases prior to Geneva........... 151  
  Activate change management plugins.......................................... 151  
  Configure change management..................................................... 169  
  Create a change request............................................................... 222  
  Analyze risk of change and detect conflicts.................................. 231  
  Process a change request............................................................. 236  

**Configuration Management** ................................................................................................................................... 239  
  Configuration Management and the CMDB.................................. 239  
  ITIL Configuration Management integration.................................. 240  
  ITIL.................................................................................................. 241  
  Baseline CMDB............................................................................... 243  
  CI relationships in the CMDB......................................................... 249  
  CMDB classifications...................................................................... 262  
  CMDB Identification and Reconciliation....................................... 268  
  Useful related lists in CI forms....................................................... 287  
  CMDB and Extended CMDB......................................................... 287  
  Enterprise Configuration Management Database (ECMDB) action icons.................................................................. 288  
  Options to populate the CMDB..................................................... 289  
  Help the Help Desk......................................................................... 292  
  Enterprise CMDB........................................................................... 304  
  Table form views............................................................................. 309  

**Contract Management** .............................................................................................................................................. 310  
  Use the Contract Management Overview module.......................... 310  
  Components installed with Contract Management......................... 311  
  Contract Management use............................................................ 315  
  Condition check definitions......................................................... 335  

**Expense Line** ............................................................................................................................................................... 336  
  Activating expense allocations.................................................... 338  
  View an expense............................................................................. 338  
  Installed with Expense Line.......................................................... 340  
  Expense Lines and expense allocations....................................... 342  

**Incident Alert Management** ............................................................................................................................... 347  
  Incident Alert Management features.......................................... 347  
  Activate Incident Alert Management............................................ 347  
  Incident Alert life cycle................................................................. 353  
  Incident Alert contact..................................................................... 355
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Management</td>
<td>385</td>
</tr>
<tr>
<td>Identify incidents</td>
<td>386</td>
</tr>
<tr>
<td>Categorize incidents</td>
<td>386</td>
</tr>
<tr>
<td>Prioritization of incidents</td>
<td>388</td>
</tr>
<tr>
<td>Log incidents</td>
<td>389</td>
</tr>
<tr>
<td>Create a record producer</td>
<td>389</td>
</tr>
<tr>
<td>Define an assignment rule for incidents</td>
<td>395</td>
</tr>
<tr>
<td>Initial diagnosis of incidents</td>
<td>398</td>
</tr>
<tr>
<td>Investigation and diagnosis of incidents</td>
<td>398</td>
</tr>
<tr>
<td>Check related incidents</td>
<td>398</td>
</tr>
<tr>
<td>Escalation of incidents</td>
<td>400</td>
</tr>
<tr>
<td>Incident closure</td>
<td>402</td>
</tr>
<tr>
<td>Close multiple incidents</td>
<td>402</td>
</tr>
<tr>
<td>Close resolved incidents automatically</td>
<td>405</td>
</tr>
<tr>
<td>Track incident resolution information</td>
<td>405</td>
</tr>
<tr>
<td>Attach configuration items to an incident</td>
<td>406</td>
</tr>
<tr>
<td>Incident promotion</td>
<td>408</td>
</tr>
<tr>
<td>Incident resolution and recovery</td>
<td>408</td>
</tr>
<tr>
<td>Perl API Incident</td>
<td>408</td>
</tr>
<tr>
<td>New Call Wizard</td>
<td>411</td>
</tr>
<tr>
<td>Create a form view</td>
<td>414</td>
</tr>
<tr>
<td>Incident Management service improvements</td>
<td>414</td>
</tr>
<tr>
<td>Incident promotion UI actions</td>
<td>415</td>
</tr>
<tr>
<td>Copy attachment contents into a KB field</td>
<td>415</td>
</tr>
<tr>
<td>Incident ticketing integrations</td>
<td>416</td>
</tr>
<tr>
<td>View assign incident SNX</td>
<td>423</td>
</tr>
<tr>
<td>Incident Alert Management roles</td>
<td>380</td>
</tr>
<tr>
<td>Notify with Incident Alert</td>
<td>374</td>
</tr>
<tr>
<td>Incident Alert Management roles</td>
<td>380</td>
</tr>
<tr>
<td>Incident Alert Management example</td>
<td>380</td>
</tr>
<tr>
<td>Subscribe to incident alerts</td>
<td>381</td>
</tr>
<tr>
<td>Incident Management</td>
<td>385</td>
</tr>
<tr>
<td>Gather problem data</td>
<td>500</td>
</tr>
<tr>
<td>Close related incidents from a problem</td>
<td>506</td>
</tr>
<tr>
<td>Problem management service improvements</td>
<td>506</td>
</tr>
<tr>
<td>Create knowledge</td>
<td>506</td>
</tr>
<tr>
<td>Problem Management process</td>
<td>515</td>
</tr>
<tr>
<td>Create a problem template</td>
<td>516</td>
</tr>
<tr>
<td>Use task outage</td>
<td>518</td>
</tr>
<tr>
<td>Use a UI action to create a record</td>
<td>521</td>
</tr>
<tr>
<td>Perl API problem</td>
<td>522</td>
</tr>
<tr>
<td>Customize UI action behavior</td>
<td>522</td>
</tr>
<tr>
<td>Define an assignment rule for problems</td>
<td>523</td>
</tr>
<tr>
<td>Define an inbound email action for problems</td>
<td>523</td>
</tr>
<tr>
<td>Request a change from a problem</td>
<td>524</td>
</tr>
<tr>
<td>Procurement</td>
<td>524</td>
</tr>
</tbody>
</table>
Procurement roles................................................................. 524
Procurement workflows...................................................... 525
Use the Procurement Overview module............................ 527
Activate Procurement.......................................................... 527
Request items source......................................................... 532
Procurement purchase order management for assets.. 535
Receive assets................................................................. 545

Product Catalog................................................................ 547
Components installed with Product Catalog....................... 547
Models.............................................................................. 549
Vendor catalog items......................................................... 557
Product catalog items....................................................... 561
Model categories............................................................. 566

Service Catalog............................................................ 570
Service Catalog Management roles.................................... 571
Service Catalog terms....................................................... 571
Service Catalog properties................................................. 572
Service Catalog setup....................................................... 578
Service Catalog customization........................................... 657
Service Catalog request fulfillment..................................... 727
Service Catalog for end users............................................... 758
Service Catalog item designer............................................ 764
Installed with Service Catalog Management........................ 806
Service Catalog video tutorial............................................ 806

Service Desk................................................................. 806
Service Desk Call.............................................................. 808
Service Desk Call uses...................................................... 810

Service Level Management............................................... 814
Configure SLAs............................................................... 815
SLA processing............................................................... 841
Repair SLAs................................................................. 845
SLA for the end user........................................................ 849
Legacy SLA engines......................................................... 864
Installed with Service Level Management............................ 873

Service Portfolio Management.......................................... 882
Installed with Service Portfolio Management........................ 882
Set up Service Portfolio Management................................ 883
Business service catalog.................................................. 884
Business service scope.................................................... 890
Service offerings............................................................. 892
Service pricing............................................................... 898
Service subscriptions....................................................... 899
Service 360................................................................. 901
My Services SLAs homepage........................................... 937

Index.................................................................................. 943
IT Service Management

Deliver IT services and support to business users.

Asset Management

Asset management integrates the physical, technological, contractual, and financial aspects of information technology assets.

Asset management business practices have a common set of goals.

- Control inventory that is purchased and used.
- Reduce the cost of purchasing and managing assets.
- Select the proper tools for managing assets.
- Manage the asset life cycle from planning to disposal.
- Achieve compliance with relevant standards and regulations.
- Improve IT service to end users.
- Create standards and processes for managing assets.

Most successful ITAM programs involve a variety of people and departments, including IT, finance, services, and end users.

Asset Management and configuration management (CMDB) are related, but have different goals. Asset management focuses on the financial tracking of company property. Configuration management focuses on building and maintaining elements that create an available network of services.

Asset Management Overview module

The Asset Management Overview module displays various asset management gauges showing information such as configuration item by manufacturer, computers by manufacturer, configuration item types, and asset information for a specific vendor. It also includes a gauge showing pending asset retirements for the current week, month, and year.

The Overview module is a type of homepage.

Roles

Only users with certain roles have access to the Overview module. These roles can view the overview page and refresh, add, delete, and rearrange gauges.

- admin
- asset
- sam

Use the Asset Management Overview module

The Asset Management Overview module displays various asset management gauges.

Role required: asset, sam, or admin

1. Navigate to **Asset > Overview**.
2. Click elements within the gauges to obtain more information.
Installed with Asset Management

A number of tables, user roles, UI policies, script includes, client scripts, and business rules are installed with Asset Management.

Demo data is available with asset management. The demo data provides information such as users, specific assets, and individual stockrooms.

Tables

Asset Management includes the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset [alm_asset]</td>
<td>Stores general, financial, and contractual information about assets.</td>
</tr>
<tr>
<td>Asset Entitlement [alm_entitlement_asset]</td>
<td>Enables ServiceNow to categorize the Asset Entitlement table and enforce how entitlements behave.</td>
</tr>
<tr>
<td>Consumable [alm_consumable]</td>
<td>Stores data about consumable assets (previously known as parts).</td>
</tr>
<tr>
<td>Default Stockroom [alm_user_stockroom]</td>
<td>Stores the relationship between a user and their default stockroom.</td>
</tr>
<tr>
<td>Fixed Assets [alm_fixed_assets]</td>
<td>Stores fixed assets, which are containers that can hold multiple assets.</td>
</tr>
<tr>
<td>Fixed asset to asset [m2m_fixed_asset_to_asset]</td>
<td>Stores associations between fixed assets and assets.</td>
</tr>
<tr>
<td>Hardware [alm_hardware]</td>
<td>Stores general, financial, and contractual information about hardware assets.</td>
</tr>
<tr>
<td>License Entitlement [alm_entitlement]</td>
<td>Stores entitlements that permit users or machines to use a software license.</td>
</tr>
<tr>
<td>Software License [alm_license]</td>
<td>Stores general, financial, and contractual information about software license assets.</td>
</tr>
<tr>
<td>Stock Rule [alm_stock_rule]</td>
<td>Transfers stock or sends an email message to the asset manager when a specified asset drops below a set threshold.</td>
</tr>
<tr>
<td>Stockroom [alm_stockroom]</td>
<td>Stores information about stockrooms.</td>
</tr>
<tr>
<td>Stockroom Model [alm_m2m_stockroom_model]</td>
<td>Tracks all models that have ever been stocked in a stockroom. This table is automatically populated.</td>
</tr>
<tr>
<td>Stockroom Type [alm_stockroom_type]</td>
<td>Stores general information about stockroom types.</td>
</tr>
<tr>
<td>Transfer Order [alm_transfer_order]</td>
<td>Contains data about transfer orders, including the state and stockrooms.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Contains data about individual assets being shipped with a transfer order.</td>
</tr>
<tr>
<td>User Entitlement [alm_entitlement_user]</td>
<td>Enables ServiceNow to categorize the User Entitlement table and enforce how entitlements behave.</td>
</tr>
</tbody>
</table>

**User roles**

Asset Management includes the following user roles.

**Table 2: Asset Management user roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>asset (Asset Manager)</td>
<td>category manager, contract manager, financial mgmt user, inventory user</td>
<td>Can manage hardware and consumable assets ([alm_hardware] and [alm_consumable]). Asset manager cannot edit asset records that are created and updated automatically, but can read and delete the asset records when needed. Can create requests. Can create and delete stock information.</td>
</tr>
<tr>
<td>inventory_admin</td>
<td>inventory user</td>
<td>Can create and delete stock information. Can edit stock rules, stockrooms, and stockroom types.</td>
</tr>
<tr>
<td>inventory_user</td>
<td>none</td>
<td>Can access stock information. Can create and manage transfer orders.</td>
</tr>
<tr>
<td>sam</td>
<td>contract manager, model manager, financial mgmt user</td>
<td>Can create, edit, change, and manage software licenses. Can edit the Software model field on a discovery model. Can approve a model. Has full control of the Software Asset Management application. Controls the Software Asset Management IBM PVU Process Pack, if activated.</td>
</tr>
</tbody>
</table>

**UI policies**

Asset Management includes the following UI policies.
### Table 3: Asset Management UI policies

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide asset tag and serial num</td>
<td>[alm_asset]</td>
<td>Hides the asset tag when the asset is pre-allocated and the quantity is greater than 1.</td>
</tr>
<tr>
<td>Hide/show parent stockroom on Stockroom Replenish</td>
<td>[alm_stock_rule]</td>
<td>Shows the Parent stockroom field only when the Restocking option field is set to Stockroom.</td>
</tr>
<tr>
<td>Make allocated to and assigned to mandatory.</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Makes the Allocated to and Assigned to fields mandatory.</td>
</tr>
<tr>
<td>Make substatus readonly when not required</td>
<td>[alm_asset]</td>
<td>Sets the Substatus to read-only if the State is On order, In use, Consumed, or In maintenance.</td>
</tr>
<tr>
<td>Model bundle field hidden but present for UI Policy conditions purposes</td>
<td>[alm_asset]</td>
<td>Hides the Model Bundle field. Exists on page only for use by UI policies and client scripts.</td>
</tr>
<tr>
<td>Pre-allocated constraints</td>
<td>[alm_asset]</td>
<td>Hides unneeded fields and related lists when the asset is pre-allocated.</td>
</tr>
<tr>
<td>Quantity readonly until model and category qualify the asset and are not bundle</td>
<td>[alm_asset]</td>
<td>Sets the Quantity field to read-only for assets that are not consumable, software, or pre-allocated. Quantity is also read-only if the model or model category fields are empty.</td>
</tr>
<tr>
<td>Show 'Assigned to'</td>
<td>[alm_asset]</td>
<td>Shows the Assigned to field if the State field is not On order, In stock, or In transit.</td>
</tr>
<tr>
<td>Show 'Reserved for'</td>
<td>[alm_asset]</td>
<td>Shows the Reserved for field if the State field is On order, In stock, or In transit.</td>
</tr>
<tr>
<td>Show 'Stockroom'</td>
<td>[alm_asset]</td>
<td>Shows the Stockroom field if either of the following conditions is true:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The State field is In stock and Substate is not Pre-allocated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Substate is Pre-allocated and Parent is empty.</td>
</tr>
</tbody>
</table>

### Script includes

Asset Management includes the following script includes.
### Table 4: Asset Management script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AssetandCI</td>
<td>Code for creating and managing the relationship between asset and CI records.</td>
</tr>
<tr>
<td>AssetAndCISynchronizer</td>
<td>Synchronization code between asset and CI records.</td>
</tr>
<tr>
<td>AssetUtils</td>
<td>Utility functions for asset management. Also checks if a license can be merged and then merges licenses if requirements are met.</td>
</tr>
<tr>
<td>AssetUtilsAJAX</td>
<td>AJAX based utility functions for asset management. Call the AssetUtils script include from a client-side UI action.</td>
</tr>
<tr>
<td>Consumables</td>
<td>Code to modify (for example, consume, split, and merge) consumables.</td>
</tr>
<tr>
<td>FixedAssetUtils</td>
<td>Methods for rolling up fixed asset costs.</td>
</tr>
<tr>
<td>PortalFilters</td>
<td>Filters used in the My Assets portal.</td>
</tr>
<tr>
<td>PreAllocatedAssets</td>
<td>Code to modify pre-allocated assets.</td>
</tr>
<tr>
<td>StockRuleFilters</td>
<td>Reference qualifier code for filtering options on reference fields on stock rules.</td>
</tr>
<tr>
<td>StockRuleTransfer</td>
<td>Transfer order creation code for when stock rules are triggered.</td>
</tr>
<tr>
<td>TransferOrderDateTimeAjax</td>
<td>Date comparison utility for transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFinder</td>
<td>Finds an appropriate transfer order to put a transfer order line into.</td>
</tr>
<tr>
<td>TransferOrderHelper</td>
<td>Function that checks if a transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderLineFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderReceiver</td>
<td>Code for receiving a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderReturn</td>
<td>Code for returning a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderStageHandler</td>
<td>Code for changing transfer order stages and transfer order line stages.</td>
</tr>
<tr>
<td>TransferOrderStageHelper</td>
<td>Helper method to get numeric stages for transfer orders and transfer order lines.</td>
</tr>
</tbody>
</table>

### Client scripts

Asset Management includes the following client scripts.
Table 5: Asset Management client scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct substatus</td>
<td>[alm_asset]</td>
<td>Updates the Substatus field when the Status field is modified.</td>
</tr>
<tr>
<td>Ensure no negative quantity</td>
<td>[alm_asset]</td>
<td>Clears the Quantity field when set to less than 1.</td>
</tr>
<tr>
<td>Error on pre-allocated substatus</td>
<td>[alm_consumable]</td>
<td>Prevents Substatus field from being set to Pre-allocated for consumable assets. Also displays an error message.</td>
</tr>
<tr>
<td>Error on pre-allocated substatus</td>
<td>[alm_license]</td>
<td>Prevents Substatus field from being set to Pre-allocated for license assets. Also displays an error message.</td>
</tr>
<tr>
<td>Null out allocated_to</td>
<td>[alm_entitlement]</td>
<td>Does the following when the Assigned to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clears the Allocated to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Makes the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Null out assigned_to</td>
<td>[alm_entitlement]</td>
<td>Does the following when the Allocated to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clears the Assigned to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Makes the Allocated to field mandatory.</td>
</tr>
<tr>
<td>Salvage must be less than cost</td>
<td>[alm_asset]</td>
<td>Displays a warning if a salvage value greater than the cost of an asset is entered.</td>
</tr>
<tr>
<td>Set Cost of the Asset</td>
<td>[alm_asset]</td>
<td>Populates the Cost field when the Model field is set.</td>
</tr>
<tr>
<td>Set Loc/CC/Dep/Com from assigned to</td>
<td>[alm_asset]</td>
<td>Populates the Location, Cost center, Department, and Company fields when the Assigned to field is set.</td>
</tr>
<tr>
<td>Set Location from stockroom</td>
<td>[alm_asset]</td>
<td>Populates the Location field when the Stockroom field is set.</td>
</tr>
<tr>
<td>Update From Location from Stockroom</td>
<td>[alm_transfer_order]</td>
<td>Populates the From location field when the From stockroom field is set.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Model and Quantity based on Asset</td>
<td>[alm_transfer_order_line]</td>
<td>Populates the Model field when the Asset field is set. If the asset is a pre-allocated asset, this client script also populates the Quantity field.</td>
</tr>
<tr>
<td>Update To Location from Stockroom</td>
<td>[alm_transfer_order]</td>
<td>Populates the To location field when the To stockroom field is set.</td>
</tr>
<tr>
<td>Update UI on load and model change</td>
<td>[alm_transfer_order_line]</td>
<td>Runs checks, and updates the user interface, when the transfer order line form is loaded and when a model is selected.</td>
</tr>
<tr>
<td>Validate Delivery by Date</td>
<td>[alm_transfer_order]</td>
<td>Validates that the delivery date is in the future.</td>
</tr>
<tr>
<td>Verify Stock Available</td>
<td>[alm_transfer_order_line]</td>
<td>Verifies that stock exists to fulfill the quantity requested.</td>
</tr>
<tr>
<td>Verify Stock Available (Stockroom)</td>
<td>[alm_transfer_order_line]</td>
<td>Verifies that stock exists to fulfill the quantity requested when the From stockroom value changes.</td>
</tr>
</tbody>
</table>

Business rules

Asset Management includes the following business rules.

Table 6: Asset Management business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated more licenses than rights</td>
<td>Software License [alm_license]</td>
<td>Prevents creation or update of a license if the number of licenses allocated is larger than the total rights.</td>
</tr>
<tr>
<td>Asset Retirement</td>
<td>Asset [alm_asset]</td>
<td>Clears the Assigned to, Stockroom, and Reserved for fields and sets the retirement date to the current time when the asset is retired.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Automatically Change TOL State | Transfer Order Line [alm_transfer_order_line] | If a transfer order has the same From stockroom and To stockroom and it is a personal stockroom, this business rule:  
  • Sets the transfer order line Stage to Delivered.  
  • Sets the asset Substate to Reserved.  
  If a transfer order has the same From stockroom and To stockroom and it is not a personal stockroom, this business rule:  
  • Sets the transfer order Stage to Received.  
  • Sets the asset Substate to Pending transfer. |
<p>| Build bundle components on insert | Asset [alm_asset] | Creates assets for the components related to a bundle if the model of the created asset is a bundle. |
| Clear Assigned To on update | Asset [alm_asset] | Clears the Assigned to field if the State field changes to On order, In stock, or In transit. |
| Clear fields irrelevant for preallocated | Asset [alm_asset] | Clears the value of fields that are irrelevant for pre-allocated assets. |
| Create Asset on insert | Configuration Items [cmdb_ci] | Creates a corresponding asset when a new configuration item with no asset is created. |
| Create asset on model change | Configuration Items [cmdb_ci] | Creates a new associated asset when the Model ID field changes. |
| Create CI on insert | Asset [alm_asset] | Creates a corresponding configuration item when a new asset with no configuration item is created. |
| Create Stockroom Model Relation | Asset [alm_asset] | Creates a record (if none already exists) in the Stockroom Model table indicating the stockroom that holds the model when an asset is created or updated. |
| Delete all Transfer Order Lines | Transfer Order [alm_transfer_order] | Deletes all related transfer order lines when a transfer order is deleted. |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure Entitlements do not exceed rights</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Checks that the total number of entitlements for the related license does not exceed the number of rights given by the license when an entitlement is created.</td>
</tr>
<tr>
<td>GenerateAssets</td>
<td>Model Categories [cmdb_model_category]</td>
<td>Executes a scheduled script job to create assets for configuration items.</td>
</tr>
<tr>
<td>Inherit information from parent</td>
<td>Asset [alm_asset]</td>
<td>Assigns some parent values to the asset when assigning a new parent to an asset.</td>
</tr>
<tr>
<td>Managed Stockroom for Vendor</td>
<td>Stock Rule [alm_stock_rule]</td>
<td>Validates that a vendor replenishing stock rule has a stockroom selected and the stockroom has an associated manager with a valid email address.</td>
</tr>
<tr>
<td>Mandate allocated to or assigned to</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Makes a value in either the Allocated to field or the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Merge Records</td>
<td>Consumable [alm_consumable]</td>
<td>Merges consumables that have matching fields and are not In Transit into one record containing the total count.</td>
</tr>
<tr>
<td>Null out asset on insert and stay</td>
<td>Configuration Items [cmdb_ci]</td>
<td>Clears the Asset field on insert if the field contains an asset that has a CI.</td>
</tr>
<tr>
<td>Null out Ci on insert and stay</td>
<td>Asset [alm_asset]</td>
<td>Nulls out the asset field so a new asset is created for the CI if an insert is performed on an existing CI.</td>
</tr>
<tr>
<td>Populate reserved for field</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>If the transfer order line has an associated request line, this business rule populates the associated asset's Reserved for field with the appropriate information from the request line.</td>
</tr>
<tr>
<td>Push Status to Asset/Consumable</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Modifies the corresponding asset to reflect the current state of transit when a transfer order line moves to another state.</td>
</tr>
<tr>
<td>Release Asset on TOL cancel/delete</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Places the corresponding asset back into stock and unsources the part requirement when a transfer order line in the draft state is canceled or deleted.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rollup TOL cancellation to TO</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Signals to the corresponding transfer order that the transfer order line has been canceled.</td>
</tr>
<tr>
<td>Salvage value must be less than cost</td>
<td>Asset [alm_asset]</td>
<td>Prevents saving an asset record if the salvage value is greater than the cost.</td>
</tr>
<tr>
<td>Sanity check on pre-allocated</td>
<td>Asset [alm_asset]</td>
<td>Prevents creation or update of pre-allocated assets if they do not satisfy the conditions to be pre-allocated.</td>
</tr>
<tr>
<td>Set Class</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Sets the class for this entitlement depending on if the entitlement is assigned or allocated.</td>
</tr>
<tr>
<td>Set Transfer Order Type</td>
<td>Transfer Order [alm_transfer_order]</td>
<td>Sets the type of the transfer order depending on whether there is a related service order or work order task.</td>
</tr>
<tr>
<td>Sync model category</td>
<td>Product Models [cmdb_model]</td>
<td>When the model category changes, this business rule creates assets if they did not previously exist for configuration items associated with the model.</td>
</tr>
<tr>
<td>Transfer Order Stockroom Rules</td>
<td>Transfer Order [alm_transfer_order]</td>
<td>Prevents the From stockroom field from being changed if the transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>Transition reserved to assigned</td>
<td>Asset [alm_asset]</td>
<td>Populates the Assigned to field with the value from the Reserved for field when the asset is in the appropriate state.</td>
</tr>
<tr>
<td>Trickle information down to components</td>
<td>Asset [alm_asset]</td>
<td>Updates components of an asset to reflect any changes that have been made to the asset record.</td>
</tr>
<tr>
<td>Update Asset fields on change</td>
<td>Configuration Items [cmdb_ci]</td>
<td>Synchronizes fields so changes made on the Configuration Item form trigger the same update on the corresponding Asset form, ensuring consistent reporting. ServiceNow recommends updating statuses on the Asset form.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update CI fields on change</td>
<td>Asset [alm_asset]</td>
<td>Synchronizes fields so changes made on the Asset form trigger the same update on the corresponding Configuration Item form, ensuring consistent reporting.</td>
</tr>
<tr>
<td>Update location as needed</td>
<td>Asset [alm_asset]</td>
<td>Updates the location of the asset, if the asset is set to a new stockroom or assigned to a new user.</td>
</tr>
<tr>
<td>Validate Field Agent Type</td>
<td>Stockroom [alm_stockroom]</td>
<td>Ensures you do not create a stockroom of type Field Agent without Work Management or Field Service Management activated. Allows for only one personal stockroom per user.</td>
</tr>
<tr>
<td>Validate TOL and check availability</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Validates changes made to the transfer order line and checks availability of the assets to be transferred in the specified stockroom.</td>
</tr>
<tr>
<td>Validate transfer order</td>
<td>Transfer Order [alm_transfer_order]</td>
<td>Validates that the Delivery by date is not earlier than the current date.</td>
</tr>
<tr>
<td>Validate Unique Users</td>
<td>Default Stockroom [alm_user_stockroom]</td>
<td>Prevents the creation of multiple records with the same user.</td>
</tr>
<tr>
<td>Verify Entitlement (Allocated)</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Ensures that the allocation of the entitlement follows the allocation condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlement (Assigned)</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Ensures that the assignee of the entitlement follows the assignment condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlements (Allocated)</td>
<td>Software License [alm_license]</td>
<td>Ensures that the allocations of all the license's entitlements follow the allocation condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlements (Assigned)</td>
<td>Software License [alm_license]</td>
<td>Ensures that the assignees of all the license's entitlements follow the assignment condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Verify Not Field Agent</td>
<td>Default Stockroom [alm_user_stockroom]</td>
<td>Verifies that the selected default stockroom is not of the Field Agent type.</td>
</tr>
</tbody>
</table>

Installed with Model Management

Several types of components are installed with Model Management.
Demo data is available with Model Management.

Business rules installed with Model Management

Model Management uses a number of business rules.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort action if no license type</td>
<td>[cmdb_software_product_model]</td>
<td>Ensures that a license type (not a license type group that cannot be handled by counters) has been selected.</td>
</tr>
<tr>
<td>Calculate display_name</td>
<td>Product Model [cmdb_model]</td>
<td>Sets the <strong>Display name</strong> field when any of the following field values change: <strong>Manufacturer, Name, Version, Edition</strong>. The display name differs depending on whether the glide.cmdb_model.display_name.shorten property is set to <strong>true</strong> or <strong>false</strong>.</td>
</tr>
<tr>
<td>Date validation</td>
<td>[cmdm_m2m_downgrade_model]</td>
<td>Ensures that the Start date is before the End date.</td>
</tr>
<tr>
<td>Enforce CI Rules</td>
<td>[cmdm_model_category]</td>
<td>Ensures that categories that track assets as consumables or software licenses do not have a CI class.</td>
</tr>
<tr>
<td>Flag parent as bundle on creation</td>
<td>[cmdm_m2m_model_component]</td>
<td>Flags a model that has components as a bundle.</td>
</tr>
<tr>
<td>License Type - Fullname</td>
<td>[cmdm_sw_license_calculation]</td>
<td>Computes the full name of the license type.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>License validation</td>
<td>Software Upgrade and Downgrades [cmdb_m2m_downgrade_model]</td>
<td>Prevents software upgrades and downgrades from being duplicated and prevents having duplicate upgrades and downgrades for the same license where duplication also involves having the same dates. Also ensures that both the Upgrade parent and Downgrade child fields are mandatory and that if the License field is not empty, either Upgrade parent or Downgrade child must be equal to the license.model.</td>
</tr>
<tr>
<td>Protect cmdb_ci_class</td>
<td>[cmdb_model_category]</td>
<td>Prevents CI class from being changed after creation.</td>
</tr>
<tr>
<td>Protect cmdb_ci_class on insert</td>
<td>[cmdb_model_category]</td>
<td>Prevents creation of a category if another category already exists for the chosen CI class.</td>
</tr>
<tr>
<td>Protect Contract</td>
<td>[cmdb_model_category]</td>
<td>Prevents changes to the Contract model category record.</td>
</tr>
<tr>
<td>Set parent's main component link</td>
<td>[cmdb_m2m_model_component]</td>
<td>Populates a read-only reference from the bundle to the component when a bundle component is selected as the main component.</td>
</tr>
<tr>
<td>Unflag parent on last delete</td>
<td>[cmdb_m2m_model_component]</td>
<td>Removes the bundle flag from a model when the last component is deleted from the bundle.</td>
</tr>
<tr>
<td>Update model category</td>
<td>[cmdb_ci]</td>
<td>Updates the model categories for the associated model if the model is not already associated with the CI's model category.</td>
</tr>
<tr>
<td>Validate record before creation</td>
<td>[cmdb_m2m_model_component]</td>
<td>Ensures that a component is not already in a bundle when an attempt is made to add the component to a bundle.</td>
</tr>
</tbody>
</table>

**Client scripts installed with Model Management**

Model Management includes a number of client scripts.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear models not matching license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Clears the <strong>Upgrade parent</strong> and <strong>Downgrade child</strong> fields when the <strong>License</strong> field is changed to a license and neither the upgrade or downgrade fields match the license model.</td>
</tr>
<tr>
<td>Constraints based on asset class</td>
<td>[cmdb_model_category]</td>
<td>Enables or disables bundling options based on the asset class of the category.</td>
</tr>
<tr>
<td>Hide sections when needed</td>
<td>[cmdb_model]</td>
<td>Shows and hides sections according to what is relevant for a given model.</td>
</tr>
<tr>
<td>model_category change</td>
<td>[cmdb_model]</td>
<td>Ensures compatibility of classes between the several categories referenced by the same model (client part).</td>
</tr>
<tr>
<td>Populate downgrade from license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Sets the downgrade child to the software model on the referenced license when an upgrade is selected. Only sets the downgrade to the license if the license is not empty.</td>
</tr>
<tr>
<td>Populate upgrade from license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Sets the upgrade parent to the software model on the referenced license when a downgrade is selected. Only sets the upgrade to the license if the license is not empty.</td>
</tr>
</tbody>
</table>

**Properties installed with Model Management**

Model Management includes the property glide.cmdb_model.display_name.shorten.
### glide.cmdb_model.display_name.shorten

When set to `true`, generates shorter display names for models by eliminating duplication of the manufacturer name. Consider the following model, for which **Manufacturer** is set to **Spotify** and **Name** is set to **Spotify Premium**.

The **Display name** field is set as follows, based on the property setting:

- **false**: Display name is Spotify Spotify Premium
- **true**: Display name is Spotify Premium

For software models, the edition and version are also included in the name, if they are specified.

- **Type**: true | false
- **Default value**: false
- **Location**: System Properties [sys_properties] table

### Script includes installed with Model Management

Model Management includes script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ModelAndCategoryFilters</td>
<td>Refines reference qualifiers for models and model categories based on class.</td>
</tr>
<tr>
<td>ModelCategoryCheck</td>
<td>Ensures compatibility of classes between the several categories referenced by the same model.</td>
</tr>
</tbody>
</table>

### Tables installed with Model Management

Model Management includes numerous tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Model [cmdb_application_product_model]</td>
<td>Stores models used to describe software application products.</td>
</tr>
<tr>
<td>Consumable Model [cmdb_consumable_product_model]</td>
<td>Describes consumable product models.</td>
</tr>
<tr>
<td>Contract Model [cmdb_contract_product_model]</td>
<td>Stores all contract models.</td>
</tr>
<tr>
<td>Depreciation [cmdb_depreciation]</td>
<td>Stores asset depreciation patterns.</td>
</tr>
<tr>
<td>Hardware Model [cmdb_hardware_product_model]</td>
<td>Describes hardware product models.</td>
</tr>
<tr>
<td>Model Category [cmdb_model_category]</td>
<td>Defines groups of assets, consumables, product bundles, and configuration items.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Model Compatibility [cmdb_m2m_model_compatibility]</td>
<td>Stores many-to-many relationship between two models signifying their compatibility with one another.</td>
</tr>
<tr>
<td>Model Component [cmdb_m2m_model_component]</td>
<td>Stores many-to-many relationship between two models signifying that they form a bundle.</td>
</tr>
<tr>
<td>Product model [cmdb_model]</td>
<td>Describes all kinds of product models.</td>
</tr>
<tr>
<td>Software License Calculation [cmdb_sw_license_calculation]</td>
<td>Defines commonly used software licensing patterns.</td>
</tr>
<tr>
<td>Software Model [cmdb_software_product_model]</td>
<td>Describes software product models.</td>
</tr>
<tr>
<td>Software Suite [cmdb_m2m_suite_model]</td>
<td>Stores many-to-many relationship between two models that defines elements of a software suite.</td>
</tr>
<tr>
<td>Software Upgrade and Downgrades [cmdb_m2m_downgrade_model]</td>
<td>Stores many-to-many relationship between two models signifying that being licensed for one model grants rights to the other as well.</td>
</tr>
</tbody>
</table>

**UI policies installed with Model Management**

Model Management includes UI policies.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide unverified</td>
<td>Model Category [cmdb_model_category]</td>
<td>Shows the Enforce CI verification field if the Asset class and CI class fields are not empty.</td>
</tr>
<tr>
<td>Lock fields for Contract and Work</td>
<td>Model Category [cmdb_model_category]</td>
<td>Sets all fields on the Model Category form to read-only if the Name is Contract or, Work Order or Work Task.</td>
</tr>
<tr>
<td>Lock fields for Contract</td>
<td>Model Category [cmdb_model_category]</td>
<td></td>
</tr>
<tr>
<td>Protect model category</td>
<td>Product Model [cmdb_model]</td>
<td>Makes the Model categories field mandatory and read-only if it contains any of the following values: Software License, Contract, Work Order, Work Task.</td>
</tr>
<tr>
<td>Show is an option if Oracle</td>
<td>Software Model [cmdb_software_product_model]</td>
<td>Shows the Is an option field if the selected Manufacturer name starts with Oracle.</td>
</tr>
</tbody>
</table>

**User roles installed with Model Management**

Model Management includes user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>category_manager</td>
<td>model manager</td>
<td>Can create, edit, and delete model categories.</td>
</tr>
<tr>
<td>Role</td>
<td>Contains Roles</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>model_manager</td>
<td>none</td>
<td>Can create new CMDB models. The model manager role can control the base models and any model extensions that are not hardware, software, or consumables. Hardware and consumable models are controlled by the asset manager (asset) role. Software models are controlled by the software asset manager (sam) role.</td>
</tr>
</tbody>
</table>

**Asset Management process**

The best method for managing assets depends on business needs and how your business is organized. These steps are one possible process for getting started with Asset Management.

1. Identify assets in your system. A key component of asset management is the initial and ongoing inventory or discovery of what you own. The ServiceNow platform provides the following options for asset discovery.
   - The separate, robust Discovery tool.
   - A lightweight, native discovery tool, Help the Help Desk lets you scan your network proactively to discover all Windows-based PCs and the software packages installed on those PCs. This WMI-based discovery is included in the base self-service application.
   - For organizations that want to use the discovery technologies they have deployed already, such as SMS, Tally NetCensus, LanDesk, or others, ServiceNow can support integration to those technologies via web services. Scanned data can be mapped directly into the configuration management database (CMDB).

2. Clean up information in the configuration management database (CMDB). Remove information that is obsolete or invalid. Ensure that all remaining information is accurate and complete. Add any necessary information.

3. Create categories of asset models such as computers, servers, printers, and software.

4. Create asset models. Models are specific versions or various configurations of an asset, such as a MacBook Pro 17”.

5. Create individual assets, such as hardware, consumables, and software licenses. If you used a discovery tool, you may already have many assets identified accurately.

6. Manage assets by counting software licenses, viewing assets that are in stock, setting asset states and substates, and analyzing unallocated software.

**Asset information management**

Asset management starts with finding out information about the assets your organization has. Questions to answer include the following.

- What assets does the organization own?
- What assets does the organization lease or rent?
- Who is responsible for each asset?
• Where are all assets located?
• Are assets being used? How frequently are they used?

In the ServiceNow platform, there are several methods for obtaining asset information. After you use a discovery tool to identify assets, you can use tools in the Asset Management application. For example, use the overview gauges, view a list of assets in stock, and view a list of unallocated software licenses.

To view assets that are in stock, navigate to Inventory Management > Stock > In Stock.

![Assets in stock](image)

Figure 1: Assets in stock

View a list of unallocated software licenses

Managing software licenses includes knowing what licenses are owned by your organization, but are not allocated.

Role required: sam
You can, for example, allocate the licenses to users or machines. If no one needs the unallocated licenses, this can be noted so that fewer licenses are purchased in the future.

1. Navigate to **Software Asset > Unallocated Licenses**.
   This list is also available from **Asset Management > Stock > Unallocated Licenses**.

2. View the **Software Counter Details** list (Unallocated License view).
   The **Valuation** column lists the number of unallocated licenses for the given software model.

3. Click a name in the **Model** column for detailed information about a specific license.
   View the **Software Model** list in the **Unallocated License** view.

### Asset classes

The default asset classes are Hardware, Software License, and Consumable. These general classes can be used to manage a variety of assets.

If the general classes are not appropriate for a specific group of assets, consider creating a new asset class. For example, a fleet of cars could be tracked in a custom asset class named Vehicle. Before creating new asset classes, analyze business needs to see if the general classes can be used. A large number of asset classes can be difficult to maintain.

Built-in functionality allows you to use asset classes for financial tracking, in a model bundle, and as a pre-allocated asset.

### Create an asset class

Creating a new asset class requires defining a new table and creating a corresponding application and module, then adding the new asset class to new or existing model categories.
Role required: asset or category_manager

Ensure that the model categories contain models. Use the Table Creator to extend an existing table.

1. Navigate to System Definition > Tables & Columns and scroll to the bottom of the page.
2. Fill in the Table Creator fields with information about the new table.

   For example, to extend the alm_asset table with a new table named u_vehicle and add a new application named Vehicle, fill out the Table Creator fields with the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter Vehicle.</td>
</tr>
<tr>
<td>Table name</td>
<td>Check that u_vehicle has been added to the field automatically.</td>
</tr>
<tr>
<td>Extends base table</td>
<td>Select alm_asset.</td>
</tr>
<tr>
<td>Create new application</td>
<td>Check that the Named check box is selected and that Vehicle has been added to the text box automatically.</td>
</tr>
<tr>
<td>Create new module</td>
<td>Check that the In application check box is selected and select Asset Management.</td>
</tr>
</tbody>
</table>

3. Click Do It!.
4. Navigate to the new application (for example, Asset Management > Vehicle) and click New.
5. Configure the form to include Model, Model Category, and Quantity.
6. Create a model category and add the asset class you created to the Asset class field.
7. Create new models and add them to the model category.

Now that the model category (associated with the new asset class) and the models are created, manage the models as assets. For example, use the model in a bundle.
Asset and CI management

Asset and Configuration Item (CI) management refers to creating assets, setting states and substates for assets and CIs, mapping assets and CIs so that they are in synch, managing consumables, and retiring assets.

Relationship between asset and CI

It is important to manage the relationship between assets and associated CIs. Assets are tracked with the Asset Management application, which focuses on the financial aspects of owning property. Configuration items are stored in the CMDB, which is used to track items and make them available to users.

When an asset has a corresponding configuration item, the asset record and the configuration item record are kept synchronized with two business rules.

• Update CI fields on change (on the Asset [alm_asset] table)
• Update Asset fields on change (on the Configuration Item [cmdb_ci] table)

Note: Assets and CIs can be synchronized only if they are logically mapped.

Asset-CI mapping and synchronization

The State field of asset record and Status field of CI record are synchronized so that changes made on one form trigger the same update on the corresponding form, ensuring consistent reporting.

Note: The ServiceNow platform synchronizes updates between assets and configuration items only if the asset and configuration item are pointed toward each other.

The following diagram illustrates the concept of Asset-CI mapping and synchronization.
This synchronization and mapping is based on the following factors:

- Asset state and CI status are not mapped on one-to-one basis; rather they are mapped to the most logical counterpart on the other table. For example, for a hardware asset set to state **In Stock - Pending disposal**, the corresponding CI is set to **In Disposition** with no substate.
- This synchronization happens between the asset’s State field and the following CI fields:
  - Install Status field: Install Status does not have a sub status and must be used for non-hardware CIs.
  - Hardware Status and Sub status field: Hardware Status is visible only for Hardware CI.
- As a best practice, ServiceNow, Inc. recommends that you drive changes by updating the state on the Asset form.

The Asset-CI synchronization can be driven in the following ways:

- Asset to CI synchronization: Change to the asset’s status updates the logically mapped CI’s Install Status or Hardware Status and sub status.
- CI to Asset: Change to the CI’s Install Status or Hardware Status updates the logically mapped asset’s states and sub states.
• For a CMDB hardware CI, if both Hardware Status and Install Status is updated, the Hardware Status change is considered for mapping the corresponding state of the asset.
• CI’s Install Status and Hardware Status work independently. There is no correlation between them. CI’s Hardware Status change does not change CI’s Install Status and vice versa. To avoid confusion, keeping both status for CMDB CI Hardware is not recommended.

List of the fields that get synced between Asset and CI

When modifying any of following fields on the asset or CI record, the same field on the corresponding record is automatically updated (with the exception of the Cost field, which is informational-only on the CI record).

Following is a list of fields that are synched:
• Asset tag
• Assigned
• Assigned to
• Checked in
• Checked out
• Company
• Cost (synchs in only one direction: asset to CI)
• Cost center
• Delivery date
• Department
• Due in
• Due
• GL account
• Install date
• Invoice number
• Justification
• Lease id
• Location
• Managed by
• Model
• Order date
• Order received
• Ordered
• Owned by
• PO number
• Purchase date
• Purchased
• Serial number
• Support group
• Supported by
• Vendor
• Warranty expiration

Create assets

You can create hardware, software license, consumable, license, and facility assets.
Role required: asset

1. Navigate to **Asset > Portfolios > All Assets.**
2. Click **New.**
3. Fill in the fields.

### Table 7: Asset record fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset as it appears in record lists. Automatically set when asset is created, based on <strong>Asset Tag</strong> and <strong>Model</strong> fields.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model grouping of the asset. Based on the model category selected, the asset can be linked to a configuration item.</td>
</tr>
<tr>
<td>Model</td>
<td>Specific product model of the asset.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>CI automatically created when this asset is created. The name that appears in this field is based on <strong>Model category</strong> and <strong>Model</strong>. Point to the reference icon ( ) to see the configuration item details inherited from the asset record.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of items this asset represents. An asset always has a quantity of one unless one or more of these points are true.</td>
</tr>
<tr>
<td></td>
<td>• It is a consumable. Quantity is unrestricted because consumables are tracked in groups.</td>
</tr>
<tr>
<td></td>
<td>• It is pre-allocated. Quantity is unrestricted when <strong>Model category</strong> and <strong>Model</strong> are defined and <strong>Substate</strong> is set to <strong>Pre-allocated.</strong></td>
</tr>
<tr>
<td></td>
<td>• It has no model and no model category.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Alphanumeric information assigned by your organization to help track the asset.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset, such as <strong>On order</strong> or <strong>In use.</strong></td>
</tr>
<tr>
<td>Stockroom</td>
<td>Current stockroom in which the asset is physically located.</td>
</tr>
<tr>
<td>Reserved for</td>
<td>Person for whom the asset has been ordered. This field is visible when the asset state is <strong>On Order.</strong></td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person using or primarily responsible for this item. This field is visible when the asset state is <strong>In Use.</strong></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Managed by</td>
<td>Person who maintains the asset. This can be different from the person in the <strong>Owned by</strong> field.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Person who has financial ownership of the asset. This can be different from the person in the <strong>Managed by</strong> field.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset of the asset. For example, a monitor or peripheral can have a workstation as their parent asset. When a parent link is defined, the fields related to assignment and state of the child assets is set to read-only and are populated based on the parent assignment and state fields. For more information, see <em>Bundled models</em>.</td>
</tr>
<tr>
<td>Class</td>
<td>Asset group, for example, base, hardware, license, or consumable.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number of this asset.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the asset. The available substate settings depend on the state selected. For example, the <strong>Retired</strong> state contains the <strong>Substate</strong> options <strong>Disposed</strong>, <strong>Sold</strong>, <strong>Donated</strong>, and <strong>Vendor credit</strong>.</td>
</tr>
<tr>
<td>Location</td>
<td>Current physical location of the asset.</td>
</tr>
<tr>
<td>Department</td>
<td>Department to which the asset belongs.</td>
</tr>
<tr>
<td>Company</td>
<td>Company or organization to which this asset belongs.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the asset was assigned to a user.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the asset was installed.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the asset that would be helpful for others to know.</td>
</tr>
<tr>
<td>Financial section (available for all asset types)</td>
<td></td>
</tr>
<tr>
<td>PO number</td>
<td>Purchase order under which the asset was purchased.</td>
</tr>
<tr>
<td>Order received</td>
<td>Date on which the asset was received.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to which the asset is linked.</td>
</tr>
<tr>
<td>Purchase order line</td>
<td>Purchase order line item to which the asset is linked.</td>
</tr>
<tr>
<td>Receiving line</td>
<td>Receiving slip line to which the asset is linked.</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice under which the asset was billed.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price at which the asset was purchased.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor from which the asset was purchased. For assets automatically created from purchase orders in Procurement, the default value of the Vendor field is the vendor specified on the purchase order.</td>
</tr>
<tr>
<td>Purchased</td>
<td>Date on which the asset was purchased.</td>
</tr>
<tr>
<td>Ordered</td>
<td>Date on which the asset was ordered.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date on which the requested item record was opened. The system automatically populates the field when a request line is specified.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number with which the asset is associated.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Group financially responsible for the asset.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>How the asset was acquired. Base system choices are <strong>Purchase</strong>, <strong>Lease</strong>, <strong>Rental</strong>, and <strong>Loan</strong>. For assets automatically created from purchase orders in Procurement, the default value is <strong>Purchase</strong></td>
</tr>
<tr>
<td>Disposal</td>
<td></td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td>Depreciation</td>
<td></td>
</tr>
<tr>
<td>Depreciation</td>
<td>Depreciation method that is applied. Base system choices are <strong>Declining Balance</strong> and <strong>Straight Line</strong>. The depreciation value is defaulted from the associated Model.</td>
</tr>
<tr>
<td>Depreciation effective date</td>
<td>Date on which the specified depreciation method begins.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>Estimated value of an asset at the end of its useful life. This value must be less than or equal to the Cost of the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Residual date</td>
<td>[Read-only] Number of days that have passed since the <strong>Depreciation effective date</strong>.</td>
</tr>
<tr>
<td>Residual value</td>
<td>[Read-only] Value in the Cost field with the depreciation method applied.</td>
</tr>
<tr>
<td>Covered by Fixed Asset</td>
<td>List of all fixed assets that contain the asset. To add the asset to another fixed asset, double-click in the <strong>Fixed asset</strong> column, click the reference lookup icon, select an asset, and click the green check mark.</td>
</tr>
<tr>
<td>Contracts section (available for all asset types)</td>
<td></td>
</tr>
<tr>
<td>Lease contract</td>
<td>Name of the lease contract that applies to the asset.</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Expiration date of the asset's warranty.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the contract covering the asset.</td>
</tr>
<tr>
<td>Supported by</td>
<td>Person managing the contract covering the asset.</td>
</tr>
<tr>
<td>Entitlements section (available for hardware assets)</td>
<td></td>
</tr>
<tr>
<td>Hardware Entitlements</td>
<td>Software asset license entitlements associated to the asset.</td>
</tr>
<tr>
<td>Device Entitlements section (available for software assets)</td>
<td></td>
</tr>
<tr>
<td>Allocated condition</td>
<td>Condition that a configuration item should satisfy to be granted entitlement for this license (available for software entitlements).</td>
</tr>
<tr>
<td>Device Entitlements</td>
<td>Software license entitlements associated to the asset.</td>
</tr>
<tr>
<td>User Entitlements section (available for software assets)</td>
<td></td>
</tr>
<tr>
<td>Assigned condition</td>
<td>Condition that a user item should satisfy to be granted entitlement for this license (available for software entitlements).</td>
</tr>
<tr>
<td>User Entitlements</td>
<td>User license entitlements associated to the asset.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Add depreciation to an asset**

Depreciation is the reduction in value of an asset over time.

Role required: asset
A depreciation schedule can be added to hardware assets. Based on the information specified in the asset record, the ServiceNow platform calculates the depreciation amount daily using the **Calculating Depreciation** scheduled job.

The ServiceNow platform calculates the read-only **Residual date** and **Residual value** fields based on the **Cost**, **Depreciation**, and **Depreciation effective date** fields. For example, if the asset **Cost** is $1000.00, the **Straight Line** depreciation method is selected, and exactly two years have passed, the **Residual value** would be $500.00.

For more information about fixed assets and depreciation, see *Using Depreciation with Fixed Assets*.

1. Navigate to **Asset > Portfolios > Hardware Assets**.
2. Select an asset.
3. Fill in the **Depreciation**, **Depreciation effective date**, **Salvage Value**, and **Covered by fixed asset** fields as described in *Create assets*.

Consider these points.

- If the depreciation effective date is in the future, depreciation is 0 and the current, residual value is the original purchase price. The system does not begin to calculate depreciation until the effective date is reached.
- The salvage value must be less than or equal to the asset cost. If a salvage value greater than the cost is entered, a warning message appears and the record cannot be saved.

4. Right-click the header and click **Save**.
5. Click **Calculate Depreciation**.

The **Residual date**, **Residual value**, and **Depreciated amount** fields are automatically calculated.

---

**Create pre-allocated assets**

A pre-allocated asset physically exists, but is not yet a financial liability.

Role required: asset

Pre-allocated assets are often assets that the vendor still owns, but has agreed to store in a customer stockroom for just-in-time procurement. For example, a pre-allocated asset could be a pallet of 100 computers ready to be allocated. Allocating the asset generates a configuration item (if required by the category) and enables you to assign the asset. Pre-allocated assets can be components of another asset that is already in use. For example, pre-installed, pre-allocated servers can be set up in server racks next to production servers, but the pre-allocated servers only become a financial liability after they are turned on.
The pre-allocated option can only be used for assets, not consumables or licenses. Pre-allocated assets cannot be comprised of bundles.

**Note:** Warranties are not usually active until an item is installed. Therefore, until an asset is allocated and assigned, it is not under warranty.

1. Navigate to **Asset > Portfolios** and select **All Assets**, **Hardware Assets**, or **Other Assets**.
2. Click **New**.
3. Select a **Model Category**.
   Category must have the **Allow pre-allocated** option selected.
4. Select a **Model**.
5. Set **State** to **In Stock** or **In Transit**.
6. Set **Substate** to **Pre-allocated**.
   The pre-allocated substate can only be set when the asset is created.
7. Enter a **Quantity**.
   The quantity can be set only when the substate is **Pre-allocated**.
8. If the **State** is **In Stock**, select a **Stockroom**.

9. Fill in other fields, as appropriate.
10. Right-click the header bar and select **Save**.
    The pre-allocated asset is created and the **Allocate** button is displayed.
Allocate a pre-allocated asset

Assets can be allocated from pre-allocated asset records, which creates new asset records and reduces the Quantity in the original pre-allocated asset record.

Role required: asset

Allocating an asset makes it a financial liability. After all pre-allocated assets have been allocated, the pre-allocated asset record is removed from the asset list.

1. Navigate to Asset > Portfolios > All Assets.
2. Find the row containing the asset to allocate. You may want to filter the Substate column to show only Pre-allocated assets.
3. Click the reference icon (🔍) in the row containing the asset to allocate.
4. Click Allocate at the bottom of the form.
   The system creates and navigates to a new asset record, which has the same model and parent information as the pre-allocated asset. The new asset has a Quantity of one, while the pre-allocated asset’s Quantity is reduced by one.

Split a pre-allocated asset

You can split a pre-allocated asset to create a group that can be moved to a different stockroom.

Role required: asset
For example, a group of 100 pre-allocated computers is in Stockroom A. Split the group into two groups of 50 and move one group to Stockroom B. Allocate the computers from the two different stockrooms.

1. Navigate to **Asset > Portfolios > All Assets**.
2. Find the row containing the asset to split. You may want to filter the **Substate** column to show only **Pre-allocated** assets.
3. Click the reference icon ( ) in the row containing the asset to split.

The asset record is displayed.

4. Click **Split**.
5. Enter a **Quantity to Split** and click **OK**.
   The pre-allocated asset is split into two groups and the **Quantity** field on each record indicates the number in each group.

**Create fixed assets**

Fixed assets are containers that can hold multiple assets. Fixed assets are commonly tracked at the corporate level by a finance or accounting department, but may contain IT assets such as hardware and software.

The **Fixed Asset** option in the Financial Management application shows the IT assets related to a fixed asset record. This link can help IT stay coordinated with the corporate asset system. Users with the financial_mgmt_admin and financial_mgmt_user roles can create fixed assets. After creating a fixed asset and adding assets, the residual value can be automatically calculated.

To create a fixed asset:

1. Navigate to **Financial Management > Fixed assets**.
2. Click **New**.
3. Enter a name for the fixed asset.
4. Click **Submit**.

To add assets to a fixed asset:

1. Navigate to **Financial Management > Fixed assets**.
2. Click a fixed asset.
3. In the **Covered assets** related list, click **Edit**.

4. In the **Collection** list, double-click an asset to add it to the **Covers Assets List**.

5. Click **Save**.

To sum the residual values of all assets in a fixed asset:

1. Navigate to **Financial Management > Fixed assets**.
2. Click a fixed asset.
3. Click **Sum Residual Value**.

The ServiceNow platform calculates the **Residual Value**, **Total cost**, and **Total depreciation** based on information in the **Financial** and **Depreciation** sections on the individual asset records.

---

**Use depreciation with fixed assets**

You can calculate depreciation for a fixed asset using a choice of depreciation schedules. Calculating depreciation for a fixed asset can help IT coordinate with the corporate fixed asset system to report correct valuation and book value.

**Role required:** financial_mgmt_admin or financial_mgmt

When creating a new depreciation schedule, select the **Declining Balance** or **Straight Line** depreciation **Category**. The two categories depreciate an asset by the same overall amount during the asset life cycle, but do so on different schedules.

- **Declining Balance**: depreciates an asset by a greater amount in earlier accounting periods than in later periods.
- **Straight Line**: depreciates an asset by an equal amount each accounting period.

The following example shows depreciated value on a $10,000.00 asset over five years using the two different methods.

**Table 8: Using depreciation with fixed assets**

<table>
<thead>
<tr>
<th>Year</th>
<th>Declining balance</th>
<th>Straight line</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$5000.00</td>
<td>$8000.00</td>
</tr>
<tr>
<td>2</td>
<td>$2500.00</td>
<td>$6000.00</td>
</tr>
<tr>
<td>3</td>
<td>$1250.00</td>
<td>$4000.00</td>
</tr>
<tr>
<td>4</td>
<td>$625.00</td>
<td>$2000.00</td>
</tr>
<tr>
<td>5</td>
<td>$0</td>
<td>$0</td>
</tr>
</tbody>
</table>

1. To view a depreciation schedule, navigate to **Financial Management > Depreciation** and click the **Category**.
2. To create a new depreciation schedule, click **New**.
3. Enter a **Name**.
4. Select a **Category**.
5. Add a **Script** to calculate depreciation value.
6. Click Submit.
   The depreciation schedule is now available in the **Depreciation** field on the asset record.

**Create license assets**

You can manage your organization's software license assets.

Role required: sam

Examples include a license to use a single copy of a desktop software program and an enterprise license to install a software program on multiple computers.

1. Navigate to Asset > Portfolios > License Assets.
2. Click New.
3. In the Rights field, type the number of entitlements to be granted by this license.
4. Complete the form as described in *Create assets* on page 29.

**Set asset states and substates**

Asset states and corresponding substates can be used to accurately track assets at a detailed level.

Role required: sam

Good asset information helps with reporting, controlling assets, and lowering costs. For example, accurately recording missing items using the **Missing** state and the **Lost** and **Stolen** substates enables you to run reports and analyze the information in order to lower costs.

1. Navigate to Asset > Portfolios > All Assets.
2. Select an asset.
3. Edit the **State** and **Substate** fields.
### Table 9: Asset states and substates definitions

<table>
<thead>
<tr>
<th>State</th>
<th>Available substates</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>On order</td>
<td>None</td>
<td>Asset has been ordered but not received.</td>
</tr>
<tr>
<td>In stock</td>
<td>Available, Reserved, Defective, Pending repair, Pending install, Pending disposal, Pending transfer, Pre-allocated</td>
<td>Asset is stored in a stockroom. Substate indicates if it is possible or recommended to put the asset into use.</td>
</tr>
<tr>
<td>In transit</td>
<td>Available, Reserved, Defective, Pending install, Pending disposal, Pre-allocated</td>
<td></td>
</tr>
<tr>
<td>In use</td>
<td>None</td>
<td>Available only for non-consumables.</td>
</tr>
<tr>
<td>Consumed</td>
<td>None</td>
<td>Available only for consumables.</td>
</tr>
<tr>
<td>In maintenance</td>
<td>None</td>
<td>Asset is being repaired or undergoing maintenance.</td>
</tr>
<tr>
<td>Retired</td>
<td>Disposed, Sold, Donated, Vendor credit</td>
<td>Setting an asset to a Retired state is recommended for asset end of life. Only delete asset records that were created erroneously.</td>
</tr>
<tr>
<td>Missing</td>
<td>Lost, Stolen</td>
<td></td>
</tr>
</tbody>
</table>

### Consumables life cycle

Consumables are assets that are not tracked individually, but as a group of the same model.

The group of consumables has one or more of the following traits.

- Same location
- Same state
- Consumed by the same asset, typically as accessories or parts

Some common consumable assets include computer mice, computer keyboards, and pencils. The base ServiceNow system includes the `Consumable` model category. The first step in working with models is to create a model within the model category for an individual consumable asset. Items such as keyboards and computer mice are often tracked as consumables. Consumables cannot be pre-allocated.

Consumable assets are stored in the Consumable [alm_consumable] table. Consumables follow a slightly different life cycle from other assets.

### Stages of consumables

The consumable life cycle stages are as follows.
• On order
• In stock
• In transit
• Consumed
• In maintenance
• Retired
• Missing

View consumable assets

Consumables are tracked as a group of the same model, but you can view individual consumables in the consumable model record.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Consumable Models.
2. Open a consumable model record.
3. View individual consumables in the Consumables related list.
Create consumable assets

Create a consumable to track an asset as a group of the same model.

Role required: asset

1. Navigate to **Asset > Portfolios > Consumables** and click **New**.
2. Fill in the fields, as appropriate.
The system automatically sets the **Class** to **Consumable**.

**Consume consumable assets**

To consume consumable assets, they must have a state of **In Stock** and a substate of **Available**.

Role required: asset

1. Navigate to **Asset > Portfolios > Consumables**.
2. Click the **Display Name** of a consumable asset with a state of **In Stock** and a substate of **Available**.
3. Click **Consume**.

© 2017 ServiceNow. All rights reserved.
4. Enter the **Quantity** to consume.

5. In **Asset**, click the lookup icon and select the asset associated with the consumable. For example, a computer mouse tracked as a consumable asset can be associated with a non-consumable asset such as a computer.

6. In **User**, click the lookup icon and select a user associated with the consumable.

7. Click **OK**.

   On the **Consumable** form, the **Quantity** field shows the reduced number. The Consumables list contains two records for the consumable in the specific stockroom: one with a state and substate of **In Stock** and **Available** (if you did not consume the entire quantity), and one with a state of **Consumed**. If a consumable is not in the process of being transferred to a different stockroom and information in the data record is the same, similar records are merged automatically. After a consumable is consumed, the record remains in the system for reporting purposes.

---

### Retire assets

You can retire an asset at any time.

Role required: asset

After you change the state of an asset to **Retired**, the **Substate** field is active. When you retire an asset, the status of related CIs also changes to **Retired**. Selecting a substate is not required, but can be helpful for tracking and reporting.

1. Navigate to **Asset > Portfolios > All Assets**.
2. In **State**, select **Retired**.
3. Optional: In **Substate**, select **Disposed**, **Sold**, **Donated**, or **Vendor Credit**.
4. Click **Update**.

---

### Delete assets

You can delete an asset at any time.

Role required: asset
A confirmation must be accepted before the asset and components are permanently deleted. If a CI and asset are linked, deleting one also deletes the other.

You should delete an asset only to clean up errors. For tracking purposes, the correct method for managing an asset that is no longer in use is to change the state of the asset to **Retired**.

1. Navigate to **Asset > Portfolios > All Assets**.<br>2. Select the check box to the left of the asset **Name**.<br>3. In the **Actions** choice list below the list, select **Delete**.

## Transfer orders

Transfer orders move assets between company stockrooms.

The Asset Management application enables asset managers to create transfer orders for moving assets between company stockrooms.

Transfer order lines allow the transfer of multiple assets on one transfer order. Actions such as shipment preparation can take place at the order level or the line level. Pre-allocated assets can be included in a transfer order line, but can only be transferred in their full quantity. A business rule prevents asset managers from transferring the same asset at the same time.

Consumable assets and non-consumable assets can be transferred as follows:

- If an asset is consumable, it can be transferred and the quantity can be greater than one. Consumable parts are tracked by the system qualitatively.
- If an asset is non-consumable, it must be transferred as a single entity with a quantity of one. Non-consumable parts correspond to assets defined in the system.

### Transfer assets using transfer orders

The steps below explain how to create a transfer order and move it from **Draft** status to **Received**.

For a more detailed look at the process, see **Move an asset through the transfer process** on page 49.

1. Create a transfer order by navigating to **Inventory Management > Transfer Orders > Create Transfer Order**.<br>2. Enter a From Stockroom and To Stockroom.<br>Note: If you select the same stockroom for both fields, the transfer order automatically moves from **Draft** to **Received** as soon as a transfer order line is added.<br>3. Enter a Delivery by date.<br>4. Click **Submit**.<br>5. Select the transfer order.<br>6. Next to Transfer Order Lines, click **New**.<br>7. Select a Model.<br>8. If the model is a consumable, specify a Quantity.<br>9. Click **Submit**.<br>10. If necessary add more transfer order lines.<br>11. When finished adding assets to transfer, click **Ready for fulfillment** on the transfer order.<br>12. Click **Prepare for shipment**.
13. Click Ship.

**Note:** Alternatively, ship assets by selecting individual transfer order lines and clicking **Ship**.

14. Select each individual transfer order line number and click **Receive**.

**Note:** Assets can only be received individually on the transfer order line level, not at the transfer order level.

All transfer order lines and the transfer order are marked **Received**.

Create a transfer order

To create a transfer order, navigate to **Inventory Management > Transfer Orders**.

1. Navigate to **Inventory Management > Transfer Orders**.

2. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Read-only] Unique number for the transfer order generated automatically by the system.</td>
</tr>
<tr>
<td>From stockroom</td>
<td>[Required] Stockroom from which the items will be shipped.</td>
</tr>
<tr>
<td>From location</td>
<td>[Read-only] Location from which the items will be shipped. Calculated automatically from the From stockroom field.</td>
</tr>
<tr>
<td>Requested date</td>
<td>[Read-only] Date on which the transfer order was requested.</td>
</tr>
</tbody>
</table>
Create a transfer order line

Transfer order lines specify the exact items that comprise a transfer order.

A transfer order can contain one or more transfer order lines. Under a single transfer order, all transfer order lines will have the same From location and To location. Each line contains an asset to transfer and the quantity to transfer. The item to transfer is identified by asset name and model name. A transfer order line can involve one quantity of a non-consumable asset or multiple quantities of a consumable asset. A bundled model can be transferred.

- After creating a transfer order, click New in the Transfer Order Lines related list and fill in the fields as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>[Read-only] Current stage of the transfer order. Transfer order lines can only be created when a transfer order is in <strong>Draft</strong> stage.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to associate with the transfer order line.</td>
</tr>
<tr>
<td>Asset</td>
<td>[Required] Asset requested by the transfer order line. For example, a specific printer. The asset can filter on stockrooms.</td>
</tr>
<tr>
<td>Quantity remaining</td>
<td>[Read-only] Number of items yet to be received. For example, 3 keyboards had been requested, 2 are received, 1 is remaining.</td>
</tr>
<tr>
<td>Quantity returned</td>
<td>[Read-only] Number of items that already needed to be returned.</td>
</tr>
</tbody>
</table>

**Move an asset through the transfer process**

The transfer order itself and each individual transfer order line have a separate stage. The overall stage of the transfer order is calculated cumulatively based on the stages of the individual transfer order lines.

For example, after all transfer order lines are changed to **Received**, the transfer order is marked **Received**. The transfer order line stages are visible in the **Transfer Order Lines** related list.

1. Click the plus icon to expand the stage information.

   After creating transfer order lines, the transfer order and all of the transfer order lines are in **Draft** stage. Transfer orders and transfer order lines always start in **Draft**. While a transfer order or a transfer order line is in **Draft** stage, it can be deleted. See *Delete a transfer order* on page 55 and *Delete a transfer order line* on page 55.

   **Note:** When an asset is part of a transfer order set to **Draft**, the asset record updates to show the asset as reserved. No one else can request or transfer the asset while it is reserved.

2. After all information has been added to the transfer order and the transfer order lines, click **Ready for Fulfillment** on the transfer order.
This moves the transfer order and all transfer order lines to the **Requested** stage. At this point in the process, the transfer order can continue to move forward as a unit or the transfer order lines can be moved forward separately.

3. To move the transfer order, ready all assets for shipment and click **Prepare for shipment** on the transfer order.

   The transfer order and all transfer order lines move to the **Shipment Preparation** stage. You can also click Prepare for shipment on a transfer order line to move only that transfer order line to the **Shipment Preparation** stage. The transfer order stage is set to **Shipment Preparation** as soon as the first transfer order line is set to **Shipment preparation**.

   While an asset is in the **Shipment Preparation** (or earlier) stage, the transfer order line can be cancelled by opening the transfer order line record and clicking **Cancel**. The stage changes to **Cancelled (Closed Complete)**.

   When all transfer order lines reach the **Shipment preparation** stage, the **Ship** button is available on the transfer order.

4. Click **Ship** on the transfer order to move all transfer order lines to the **In Transit** stage.

   In the case that assets ship at different times, transfer order lines can move individually. For example, assume a transfer order is comprised of three assets: a laptop, a printer, and a keyboard. All three assets have been prepared for shipment and the laptop is ready to ship.
5. Click the transfer order line Number next to the laptop. Now, on the transfer order line record for the laptop, click **Ship**.

The laptop moves to the **In Transit** stage, but the printer and keyboard remain in the **Shipment Preparation** stage. Because at least one of the transfer order lines is now in transit, the overall transfer order is moved to the **Partially Shipped** stage. Once all transfer order lines are shipped, the transfer order moves to the **Fully Shipped** stage.
After all transfer order lines are shipped, the next step is to receive the assets. Assets are always received at the transfer order line level.

6. Click the transfer order line **Number** next to the asset.
7. On the asset record, click **Receive**.

Once all transfer order lines are received, the transfer order moves to the **Received** stage.

**Attention:** It may be necessary to return items, such as when they are defective. To return items, receive the items, then follow the return process.

**Summary of transfer order stages**

As assets move through the transfer process, the stage of a transfer order is always based on the stages of the individual transfer order lines.

**Table 10: Transfer order stages**

<table>
<thead>
<tr>
<th>Transfer order stage</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>After all information has been added to the form, click <strong>Ready for Fulfillment</strong>.</td>
</tr>
<tr>
<td>Requested</td>
<td>If all assets in the transfer order are ready, click <strong>Prepare for shipment</strong>. The stage of the transfer order and all transfer order lines is automatically changed to Shipment Preparation. (Transfer order lines can also be set to Shipment Preparation individually.)</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>All transfer order lines have to reach shipment preparation before the <strong>Ship</strong> button is available on the transfer order.</td>
</tr>
<tr>
<td>Partially Shipped</td>
<td>After at least one transfer order line is changed to Shipped, the transfer order is marked Partially Shipped.</td>
</tr>
</tbody>
</table>
### Transfer order stage

<table>
<thead>
<tr>
<th>Transfer order stage</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fully Shipped</td>
<td>After all transfer order lines are changed to Shipped, the transfer order is marked Fully Shipped.</td>
</tr>
<tr>
<td>Received</td>
<td>After all transfer order lines are changed to Received, the transfer order is marked Received.</td>
</tr>
<tr>
<td>Delivered</td>
<td>Only used with Work Management. After an item is delivered to a work agent, the transfer order is marked Delivered.</td>
</tr>
</tbody>
</table>

### Transfer order line asset tracking

As transfer order line actions are triggered, the stock information and states of any affected assets are updated. Consumables and non-consumables are tracked differently.

When an asset is included in a transfer order line, the following takes place:

- a substate field on the asset form changes to reflect the transfer order line states
- the Active TO option on the asset form is automatically selected to show that the asset is part of a transfer order and cannot be added to multiple transfer orders
- the asset is removed from the pool of available assets and changed to a state of In Stock Pending Transfer

### Transfer order line asset tracking of non-consumables

This page provides the effect on asset substates when transfer order line stages change for non-consumables.

<table>
<thead>
<tr>
<th>Transfer order line stage</th>
<th>Affect on asset substate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Asset moves to <strong>In Stock &gt; Pending Transfer</strong> (from the current stockroom). If the asset is a consumable, the quantity can be edited.</td>
</tr>
<tr>
<td>Requested</td>
<td>Asset stays in <strong>In Stock &gt; Pending Transfer</strong>.</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>Asset stays in <strong>In Stock &gt; Pending transfer</strong>.</td>
</tr>
<tr>
<td>In Transit</td>
<td>Asset moves to <strong>In Transit &gt; Reserved</strong>.</td>
</tr>
<tr>
<td>Received</td>
<td>Asset moves to <strong>In Stock &gt; Available</strong> (in the destination stockroom).</td>
</tr>
</tbody>
</table>

### Transfer order line asset tracking consumables

When a consumable is added to a transfer order line, the stock for the consumable is split into two records and the transfer order links to the newly created stock line.

For example:

1. Stockroom A has ten keyboards in stock.
2. A transfer order line named TOL1 transfers three keyboards from stockroom A to stockroom B.
3. The stock of ten keyboards in A is split into two records: seven shown as **In stock > Available** and three shown as **In Stock > Pending Transfer**.
4. Another transfer order is created with a transfer order line named TOL2 that transfers two keyboards from stockroom A to stockroom B.

5. The seven remaining keyboards are split into another two lines: five In stock > Available and two In stock > Pending Transfer.

   **Note:** The three In Stock > Pending Transfer and the two In Stock > Pending Transfer are not merged together because they are not part of the same transfer order line and not necessarily from the same person.

6. As TOL2 for two keyboards moves from Draft to Requested to Shipment Preparation, TOL1 for the three keyboards remains In Stock > Pending Transfer.

7. When TOL1 for the three keyboards moves to the In Transit stage, the three keyboards are changed to the In Transit > Reserved stage. The same happens for TOL2 with two keyboards.

8. When TOL1 is Received, the three keyboards move to In stock > Available in stockroom B.

9. When TOL2 is received in stockroom B, the two keyboards move to In stock > Available and are merged with the three keyboards that are also In Stock > Available in B.

10. At the end, stockroom B shows five keyboards are In Stock > Available.

Delete a transfer order

Users with the inventory_user role can delete transfer orders.

The transfer order or transfer order line must be in the Draft stage.

1. Navigate to Inventory Management > Transfer Orders > Transfer Orders
2. Select the check box beside a transfer order.
3. From the Actions on selected rows menu at the bottom of the list, click **Delete**.

   Alternatively, you can **cancel** a transfer order or a transfer order line while it is in Requested or Shipment Preparation stage.

Delete a transfer order line

Users with the inventory_user role can delete transfer order lines.

The transfer order or transfer order line must be in the Draft stage.

1. Open a transfer order.
2. Select the check box beside a transfer order line.
3. From the Actions on selected rows menu at the bottom of the list, click **Delete**.

   Alternatively, you can **cancel** a transfer order or a transfer order line while it is in Requested or Shipment Preparation stage.

Return items received in a transfer order

If a transfer order is received, but there is a problem with all or some of the items, do a transfer order return.

Items must be received before they can be returned.

1. Check the item status to ensure it has been received by navigating to Inventory Management > Transfer Orders > Transfer Order Returns.
2. Navigate to **Inventory Management > Transfer Orders > Transfer Orders**.
3. Select a transfer order that is in the **Received** stage.

4. Click the transfer order line **Number** of the item to return.
5. Click **Return**.
6. Enter a **Quantity** to return.
7. Enter a reason for the return.
8. Select the **Defective** check box to return items that are broken.

Defective items are returned to the stockroom from which they were delivered, but are not added to available stock. Instead, they are tracked in the separate category named "Defective" so they cannot be requested or transferred again.
9. Click **OK**.
10. Click **Update**.
    
A new transfer order line is automatically created.

A new corresponding parent transfer order is also automatically created with the new transfer order line on it.

11. If you are returning a consumable, navigate to the transfer order line record and click the model name to open the model record.

    The model record shows which stockrooms contain the model. The one defective model is listed.
### Consumable Model

**Display name:** Logitech Logitech Desktop Optical Wireless Mouse  
**Manufacturer:** Logitech  
**Name:** Logitech Desktop Optical Wireless Mouse

#### General

<table>
<thead>
<tr>
<th>Short description</th>
<th>Logitech desktop wireless mouse</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model categories</td>
<td>Consumable</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>Leave-to-category</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>None</td>
</tr>
<tr>
<td>Cost</td>
<td>13.00</td>
</tr>
<tr>
<td>Depreciation</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
</tr>
</tbody>
</table>

#### Consumables

<table>
<thead>
<tr>
<th>Display name</th>
<th>Model category</th>
<th>State</th>
<th>Substate</th>
<th>Stockroom</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

- **Defective**: Fail north - Pick-up/Return
Note: The defective model is still at the stockroom to which it was delivered. The defective model needs to be transferred back to the stockroom where it originated.

12. Move the new transfer order through the regular transfer order process.

Items are automatically returned to the stockroom from which they were delivered. A transfer order line item that has been returned cannot be delivered at a later time.
### Consumable Model

**Display name:** Logitech Logitech Desktop Optical Wireless Mouse  
**Manufacturer:** Logitech  
**Name:** Logitech Desktop Optical Wireless Mouse

**General**

- **Short description:** Logitech desktop wireless mouse
- **Model category:** Consumable
- **Cost:** $15.00
- **Depreciation:**

**Consumables**

<table>
<thead>
<tr>
<th>Display name</th>
<th>Model category</th>
<th>State</th>
<th>Substate</th>
<th>Stockroom</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>Consumed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Logitech Logitech Desktop Optical Wireless Mouse</td>
<td>Consumable</td>
<td>In stock</td>
<td></td>
<td>Southern California Warehouse</td>
<td>1</td>
</tr>
</tbody>
</table>
If you return another defective model from the same, original order, the two defective returns are merged into one line item.
Stockrooms

Stockrooms are places to which assets are assigned.
When stock is low on a particular asset, stock rules can either notify an asset manager or automatically transfer inventory from one stockroom to another.
Stockrooms are separate, standalone entities in the Asset Management application.

View a list of assets in stock

You can view a list of assets in stock.
Role required: asset or inventory_admin

1. Navigate to **Inventory > Stock > In Stock**.
2. View the Assets list in Asset view.
   - The list shows only assets with a state of **In stock**.
Create a stockroom

You can create a stockroom.

Role required: asset or inventory_user

1. Navigate to **Inventory > Stock > Stockrooms.**
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name and identifier of the stockroom.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that primarily uses the stockroom.</td>
</tr>
<tr>
<td>External</td>
<td>Whether this stockroom is managed internally (check box is cleared) or is managed externally by a third party (check box is selected).</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location of the stockroom.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of stockroom, such as Field Agent or On site.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person in charge of the stockroom. Receives restocking notifications and requests for the stockroom's stock rules.</td>
</tr>
</tbody>
</table>

### Delete a stockroom with assets

You can delete a stockroom. If the stock room has assets, you must remove the assets from the stockroom first.

Role required: inventory_admin

1. Navigate to **Asset > All Assets**.
2. Personalize the list to add the **Stockroom** column.
3. Filter the list to show only the assets in the stockroom that you want to delete.
4. Change or remove the stockroom for all of the asset records.
5. After removing assets from the stockroom you want to delete, continue with the instructions for **deleting a stockroom with no assets**.

### Delete a stockroom with no assets

You can delete a stockroom that has no assets.

Role required: inventory_admin

1. Navigate to **Inventory > Stock > Stockrooms**.
2. Select the check box beside the stockroom **Name**.
3. In the **Actions** choice list below the list, select **Delete**.

### Stockroom types

Stockroom types are categories of stockrooms.

The stockroom type has two significant characteristics.
- **Priority**: indicates the order of stockrooms the parts should be sourced from. For example, if a personal stockroom (priority 2) contains the required part, the personal stockroom receives priority over the Central Stockroom (priority 7) because the part in the personal stockroom does not require delivery.
- **Shipment Required**: informs the system if a transfer order needs to be created when the part is sourced from a stockroom of the given type. For example, a part in a personal stockroom does not require shipment, so no transfer order is needed.

**Table 11: Stockroom types defined in the base system**

<table>
<thead>
<tr>
<th>Value</th>
<th>Name</th>
<th>Priority</th>
<th>Shipment Required</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>on_site</td>
<td>On Site</td>
<td>1</td>
<td>False</td>
<td>Stockroom at the customer site.</td>
<td>Close to the users and does not require shipping.</td>
</tr>
<tr>
<td>field_agent</td>
<td>Field Agent</td>
<td>2</td>
<td>False</td>
<td>Virtual, personal stockroom linked with a field service agent (FSA) directly, used for delivery.</td>
<td>Mainly used to indicate to the system that the part has been delivered and is with the FSA.</td>
</tr>
<tr>
<td>fsl</td>
<td>FSL</td>
<td>4</td>
<td>True</td>
<td>Forward Shipping Location.</td>
<td>Small stockrooms where the parts can typically be shipped via overnight delivery.</td>
</tr>
<tr>
<td>tudo</td>
<td>PUDO</td>
<td>5</td>
<td>True</td>
<td>Pick Up/Drop out location.</td>
<td>This type is sometimes called a by-box. Can be a postal box that can receive new and returned parts. Often in close proximity to major customer sites.</td>
</tr>
<tr>
<td>stockroom</td>
<td>Stockroom</td>
<td>6</td>
<td>True</td>
<td></td>
<td>A regional stockroom.</td>
</tr>
</tbody>
</table>
Create a new stockroom type

If you need stockroom types that are not included in the base system, you can create a custom stockroom type.

Role required: inventory_admin

Check the priority level of the stockroom types provided in the base instance to ensure that you assign the correct priority level to any new stockroom types you create. You can also modify the stockroom types included in the base system.

1. Navigate to Inventory > Stock > Stockroom Types.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the stockroom type.</td>
</tr>
<tr>
<td>Description</td>
<td>General information about the stockroom type.</td>
</tr>
<tr>
<td>External stockroom</td>
<td>Whether stockrooms of this type are managed internally (check box cleared) or managed externally by a third party (check box selected).</td>
</tr>
<tr>
<td>Priority</td>
<td>Level of precedence for this type of stockroom.</td>
</tr>
<tr>
<td>Shipment required</td>
<td>Option that determines if stockrooms of this type require shipment by default.</td>
</tr>
<tr>
<td>Value</td>
<td>Internal identifier of the stockroom type.</td>
</tr>
</tbody>
</table>

Stock rules

Stock rules are defined criteria stating that when inventory of a particular asset in a particular stockroom reaches a specified threshold, a certain number should either be transferred from another stockroom or ordered from a vendor.

For example, a specific model of computer keyboard reaches an inventory of 10 in a particular stockroom and, because a stock rule is in place, a transfer order is automatically created to transfer 50 from a different stockroom. Because there can be multiple assets of a model within a stockroom, stock rules enable you to check all assets fitting the criteria and view a total count.
There are two restocking options:

- An email can be sent to the stockroom manager (user identified in the Manager field on the stockroom record) to place a vendor order. A task is also automatically created for the stockroom manager.
- A transfer order can be generated automatically to restock the item from another stockroom.

Stock rules consider existing transfer orders and do not create additional transfer orders if replenishment is already in progress.

A scheduled job named Stock Rule Runner runs once per day to create the restocking transfer orders, send email messages to stockroom managers, and create tasks for stockroom managers. You may need to activate the Procurement application to configure and use this scheduled job.

*Note:* If restocking is in progress, the system does not create duplicate email messages or duplicate transfer orders.

Create a stock rule

Users can create a stock rule to control what happens when inventory of a particular asset in a particular stockroom reaches a specified threshold.

Role required: inventory_admin or asset

1. Navigate to Inventory > Stock > Stock Rules.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Product model to which the rule applies.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Quantity that the stock must reach to trigger restocking. For example, enter a threshold of 10 for a laptop computer that should be restocked when inventory drops below 10 in the specified stockroom.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Restocking option | Location where additional supplies should come from. Select one of the following:  
  • **Stockroom**: creates a transfer order to obtain the asset from another stockroom.  
  • **Vendor**: sends an email to the stockroom manager to order from a vendor. In addition to the email notification, a task is created for the stockroom manager. |
| Active        | Whether this stock rule active (check box is selected). Clearing this check box prevents the stock rule from restocking automatically. |
| Stockroom     | Current physical location of the asset.                                                                                                                                                               |
| Order size    | Minimum order quantity for stockroom transfers or vendor purchases. ServiceNow calculates the smallest multiple of the order size needed to restock the item above the threshold. For example, there are 3 laptops in stock with a threshold of 10 and the **Stockroom** option selected. If the order size is set to 4, the system creates a transfer order for 8 laptops to exceed the threshold and satisfy the rule (3 in stock + 8 ordered = 11). When restocking from a vendor, ServiceNow sends an email to the stockroom manager showing the total number of items to order, as multiples of the order size. |

**Software Asset Management plugin**

ServiceNow® Software Asset Management plugin is a feature provided with the Asset Management application.

A strong software asset management (SAM) program can help an organization reduce software costs, improve compliance, and simplify or develop processes for employee software requests. SAM programs can also help control inventory through accurate databases, which in turn helps identify organizational software needs, identify unused software that can be deleted, as well as reduce or consolidate the number of software vendors used.

**Software Asset Management plugin Overview module**

The Software Asset Management plugin Overview module is a homepage that displays various software asset management reports that are used as gauges.

**Use the Software Asset Management plugin Overview module**

The Overview module is a homepage that displays charts and graphs to help you manage software assets in the organization.
To use the Software Asset Management plugin Overview module, navigate to **Software Asset > Overview**. You can click elements within the gauges to obtain more information or add and move gauges as needed.
The overview shows the following compliance types:

- Immediate Compliance: number of licenses that should be purchased in order to be compliant immediately. Compliance is based on grouping. When tracking software licenses at a high level without any grouping, you are more likely to be compliant. With grouping, you are more likely to be out of compliance. For example, if grouping regionally by location, your organization can be globally compliant, but regionally non-compliant.
- Planned Compliance: based on the number of licenses you plan to allocate and the number installed.

The graphs show important statistics about the software being tracked, including software that has been entitled but is not being used and the total number of unallocated licenses.

Software Asset Management plugin roles

Software Asset Management plugin adds the following user role.

Table 12: Roles

<table>
<thead>
<tr>
<th>Role Title</th>
<th>Contains Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam</td>
<td>inventory_user</td>
<td>Can create, edit, change, and manage software licenses.</td>
</tr>
<tr>
<td></td>
<td>category_manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>contract_manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>financial_mgmt_user</td>
<td></td>
</tr>
</tbody>
</table>

Users with the sam or admin role can view the overview page and refresh, add, delete, and rearrange gauges.

Installed with Software Asset Management plugin

A number of tables, properties, user roles, script includes, client scripts, UI policies, and business rules are installed with Software Asset Management plugin.

Activating Software Asset Management plugin adds these components.

Demo data is available with Software Asset Management plugin.

Tables

Software Asset Management plugin adds the following tables.

Table 13: Software Asset Management plugin tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition [cmdb_processor_definition]</td>
<td>Describes a computer in terms of the attributes IBM uses for its PVU licensing model. A row can be associated with one or more discovered computers if they are all identical in terms of the attributes used for PVU licensing.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Processor Mapping [sam_processor_mapping]</td>
<td>Encodes the information specified by the IBM <em>Table of Processor Value Units per core</em> and is used in matching a computer's processor definition to a PVU cost for that computer. Each row in this table is a mapping between a set of processors and the associated PVU cost (per core).</td>
</tr>
<tr>
<td>Software Counter [sam_sw_counter]</td>
<td>Configures license counting options for software models.</td>
</tr>
</tbody>
</table>
| Software Counter Compliance Violations [sam_sw_counter_violation]    | Stores records of software counter compliance issues that are due to violations other than installs exceeding rights, such as:                                                                                                                                       - Maximum CPU/user count exceeded, based on model limits.  
- Maximum or minimum rights rules not followed, based on model limits.  
- Options installed on a server with a license that does not support options (Oracle). |
| Software Counter Detail [sam_sw_counter_detail]                      | Reconciles a software installation or usage with its corresponding software license and entitlement. The software counting logic automatically generates and maintains these records.                                                                                                             |
| Software Counter History [sam_sw_counter_history]                    | Stores read-only copies of software counter records, which the system generates automatically each time a software counter finishes counting licenses.                                                                                                                         |
| Software Counter Result [sam_sw_counter_result]                      | Records all software counter results. Organizes the results based on the Grouping field (such as Company, Department, or Location) on the Software Counter record.                                                                                                                                                                                   |
| Software Counter Summary [sam_sw_counter_summary]                    | Aggregates all the software counter details for a given allocation state, a given group, and a given software counter. The software counting logic automatically generates and maintains these records.                                                                                                                   |
| Software Discovery Model [cmdb_sam_sw_discovery_model]               | Stores a unique and definitive list of all software found by a discovery tool.                                                                                                                                                                                                                                                              |
| Software Installation [cmdb_sam_sw_install]                          | Associates software discovery models and the hardware on which they are installed.                                                                                                                                                                                                                                                        |
| Software Usage [cmdb_sam_sw_usage]                                   | Associates software discovery models and the hardware that uses the models. ServiceNow Discovery does not populate the Software Usage [cmdb_sam_sw_usage] table. Use a third party tool to add information about software assets to the Software Usage table.                                                                                              |
Properties

Software Asset Management plugin adds the following system properties.

Table 14: Software Asset Management plugin properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam.install_deletion_deadline</td>
<td>Defines the number of days after which a software install is deleted if not discovered with the configuration item. The best practice is to use a value that is greater than the number of days between consecutive discovery runs.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 7</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

User roles

Software Asset Management plugin adds the following user roles.

Table 15: Software Asset Management plugin user roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam</td>
<td>inventory_user contract_manager category_manager</td>
<td>Can create, edit, change, and manage software licenses. Can edit the Software model field on a Discovery model. Can approve a model. Has full control of the Software Asset Management plugin on page 69 feature. Controls the Software Asset Management plugin IBM PVU Process Pack, if activated.</td>
</tr>
<tr>
<td></td>
<td>financial_mgmt_user</td>
<td></td>
</tr>
</tbody>
</table>

Script includes

Software Asset Management plugin adds the following script includes.

Table 16: Software Asset Management plugin script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DiscoveryModelMatcher</td>
<td>Matches a discovery model with a software product model.</td>
</tr>
</tbody>
</table>
### ProcessorDefinitionsUtils
Contains utilities for managing the Processor Definition [cmdb_processor_definition] table.

### ProcessorValueUnitsUtils
Contains logic that determines the IBM PVU pricing associated with a given processor. Also generates an event when a processor mapping is not found.

### SAMMigration
Deprecated. Used by the fix job that migrates software license management data to Software Asset Management plugin.

### SAMSuiteEngine
Contains functions for handling suite inference on software installations.

### SAMUtil
Generates models and counters for Software Asset Management plugin.

## Client scripts
Software Asset Management plugin adds the following client scripts.

### Table 17: Software Asset Management plugin client scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean up Counter</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Ensures integrity between the various counting options of a software counter.</td>
</tr>
<tr>
<td>Deactivate automatched checkbox</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Deactivates the automatically matched check box when a user edits the software model.</td>
</tr>
<tr>
<td>Notify if counter in progress</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Displays a message if the counter is currently running.</td>
</tr>
</tbody>
</table>

## UI policies
Software Asset Management plugin adds the following UI policies.

### Table 18: Software Asset Management plugin UI policies

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce Installs per license</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Makes the Installs per license field mandatory when the software counter License type is By number of users.</td>
</tr>
</tbody>
</table>
### Business rules

Software Asset Management plugin adds the following business rules.

**Table 19: Software Asset Management plugin business rules**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign processor</td>
<td>Computer [cmdb_ci_computer]</td>
<td>Attempts to match a processor with a processor definition.</td>
</tr>
<tr>
<td>Build Primary Key</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Sets the primary key for the record to the serial number on the [cmdb_sam_sw_install] table. If the serial number is empty, the rule creates one based on the publisher, display name, product ID, version, and revision.</td>
</tr>
<tr>
<td>Build Primary Key</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Creates the primary key for the record from the publisher, name, product ID, and version number on the [cmdb_sam_sw_usage] table.</td>
</tr>
<tr>
<td>Check for software suite</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Checks if the current software install is part of a software suite.</td>
</tr>
<tr>
<td>Check for suite omission</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Checks if the current software install should be omitted from any suites.</td>
</tr>
<tr>
<td>Clean up Cache</td>
<td>Software License [alm_license]</td>
<td>Removes the cache for the counter of the software license record when a software license is deleted.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clean up software normalization</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Deletes the discovery model if the discovery model is changed and it is not used by other software installs. This rule is not enabled by default.</td>
</tr>
<tr>
<td>Clear install and usage records</td>
<td>Software Counter Summary [sam_sw_counter_summary]</td>
<td>Uncaches all related install and usage records when a software counter summary is deleted.</td>
</tr>
<tr>
<td>Clear normalized flag</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Clears normalized flag on certain field changes.</td>
</tr>
<tr>
<td>Clear normalized flag</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Clears the is_normalized check box when a field value is changed from a normalized value.</td>
</tr>
<tr>
<td>CPU/Core count change</td>
<td>Computer [cmdb_ci_computer]</td>
<td>Clears the Cached check box on related software installs when the CPU count or CPU core count changes.</td>
</tr>
<tr>
<td>Create a Software Normalization</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Links the record to the discovery model with that primary key on the [cmdb_sam_sw_install] table if the primary key changes. The business rule creates a discovery model if none exist for that primary key.</td>
</tr>
<tr>
<td>Create a Software Normalization</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Links the record to the discovery model with that primary key on the [cmdb_sam_sw_usage] table if the primary key changes. The business rule creates a discovery model if none exist for that primary key.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Delete cached count results</td>
<td>Software License [alm_license]</td>
<td>Marks the software counter results to be recounted when one or more fields on a license have changed. This script runs after a change to a field that a counter can be grouped on, such as location, department, company, cost_center, entitlement_condition, or assigned_condition. If one or more of these fields changes, then the script sets the Recount field to true on any cached counter results matching the previous value. When the counter runs, the results with Recount set to true are treated as non-cached results and are recounted. For example, if Location on a license was Americas and changes to EMEA, cached results for Americas will have Recount set to true for the next count.</td>
</tr>
</tbody>
</table>
| Delete Cached row entry | License Entitlement [alm_entitlement] | When an entitlement is deleted:  
- Deletes all related software counter details.  
- Clears the Cached check box on the related software install. |
<p>| Drop counter Cache | Software Counter [sam_sw_counter] | Clears the Cached check box for the software counter if the grouping, license type, contract, or installs per license change in a software counter. Added enforce field changes to the conditions |
| Flag counter to reprocess | Software Upgrade and Downgrades [cmdb_m2m_downgrade_model] | Clears the Cached check box for all related software counters if the upgrade parent or downgrade child values are changed or deleted. |
| Flag counter to reprocess | Software Suite [cmdb_m2m_suite_model] | Clears the Cached check box for all related software counters if the suite parent or suite child values are changed or deleted. |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>invalidate sw install cache</td>
<td>Computer [cmdb_ci_computer]</td>
<td>Uncaches all install and usage records referencing a computer when the computer's processor field is changed.</td>
</tr>
<tr>
<td>Limit license metric</td>
<td>License [alm_license]</td>
<td>Limits software licenses to a single license metric value.</td>
</tr>
<tr>
<td>Limit license metric combinations</td>
<td>Hardware [cmdb_ci_hardware]</td>
<td>Rejects license metric combinations of the same type, such as CAL (user) and CAL (devices).</td>
</tr>
<tr>
<td>Link to Model</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Finds and sets the model field to the model that best corresponds to the record when a software discovery model is created.</td>
</tr>
<tr>
<td>Mark install for suite omission</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Searches for any matching installs and marks them for suite omission.</td>
</tr>
<tr>
<td>One and only one default mapping</td>
<td>Processor Mapping [sam_processor_mapping]</td>
<td>Ensures only one default mapping by resetting the last resort flag for modified records and setting it to false for new records.</td>
</tr>
<tr>
<td>Process cache reset</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Resets the install of any counter information when it becomes uncached.</td>
</tr>
<tr>
<td>Process suite component deletion</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Updates all other members of an install's suite if the install is deleted.</td>
</tr>
<tr>
<td>rebind processor definitions</td>
<td>Processor Mapping [sam_processor_mapping]</td>
<td>Refreshes processor definitions when a processor mapping changes.</td>
</tr>
<tr>
<td>Rebuild Cache</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Clears the Cached field on the software counter if the associated software model is modified on the software discovery model record.</td>
</tr>
<tr>
<td>Rebuild inferred suite and cached</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Clears the cached flag and inferred suite field on records referencing this discovery model, when the matched model changes.</td>
</tr>
<tr>
<td>Remove cached flag</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Clears the corresponding cached software counter details if a software installation is deleted or if the configuration item on which it is installed changes.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove cached flag</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Clears the corresponding cached software counter details if a software usage record is deleted or if the configuration item from which the software is accessed changes.</td>
</tr>
<tr>
<td>Remove caches from detail</td>
<td>Software Counter Detail [sam_sw_counter_detail]</td>
<td>Clears the Cached check box on the related <em>entitlement</em>, <em>installation</em>, and usage records if they exist.</td>
</tr>
<tr>
<td>Reset counter info on suite change</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Uncaches and resets counter information on the install if its inferred suite changes.</td>
</tr>
<tr>
<td>Reset Installs per License</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Clears the Installations per license fields if the counter license type is not per user.</td>
</tr>
<tr>
<td>Retrieve PVU Mapping</td>
<td>Processor Definition [cmdb_processor_definition]</td>
<td>Finds a matching processor mapping based on the information of the processor definition.</td>
</tr>
<tr>
<td>SAM: Core Process</td>
<td>Global [global]</td>
<td>Not used for any processing.</td>
</tr>
<tr>
<td>Set Display name</td>
<td>Software Counter Result [sam_sw_counter_result]</td>
<td>Sets the display name of the counter result to the counter name with the grouping type.</td>
</tr>
<tr>
<td>Set normalized fields</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Sets normalized fields on insert to be copies of discovered fields.</td>
</tr>
<tr>
<td>Set normalized fields</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Copies the given values as their normalized values when a software install is inserted.</td>
</tr>
<tr>
<td>Sync Software Package</td>
<td>Software Discovery Model</td>
<td>Creates a row in the package table to reflect the row in the discovery model table.</td>
</tr>
<tr>
<td>Update Cache</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Updates all corresponding cached software counter details if usage metrics for this installation change.</td>
</tr>
<tr>
<td>Update Cache</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Updates all corresponding cached software counter details if usage metrics for this software usage change.</td>
</tr>
</tbody>
</table>

**References**

Software Asset Management plugin adds the following references.
Table 20: Software Asset Management plugin references

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition</td>
<td>Activating the Software Asset Management plugin <em>IBM PVU Process Pack</em> after activating Software Asset Management plugin adds a reference to the processor definition to the Hardware [cmdb_ci_hardware] table.</td>
</tr>
</tbody>
</table>

Software Asset Management plugin setup process

Complete a set of steps to prepare to manage your software assets.

To get started with Software Asset Management plugin:

- Identify Software Owned. The following methods identify the software your organization owns:
  - Use Discovery to identify currently owned software and begin working with Software Asset Management plugin.
  - Identify and add the software manually or with a third-party tool.

- Make the Configuration Management Database Accurate
  Clean up information in the configuration management database (CMDB). At first, focus on your top 10-20 software vendors.

- Create Software Models
  Create software models for all of the software your organization wants to monitor. Software models can also be imported from another source such as a Discovery application, an existing data set of software licenses, or a third-party source.

- Create Software License Records
  Create software license records for all of the software your organization owns. This information can also be based on information from a purchasing source or imported as a spreadsheet.

- Configure Software Counters
  Configure software counters to view your organization’s software compliance levels for all of your software.

Request Software Asset Management plugin

Software Asset Management plugin (com.snc.software_asset_management) must be activated by ServiceNow personnel. This plugin includes demo data and activates related plugins if they are not already active.

Role required: none

Request the plugin through the HI Service Portal.

1. In the HI Service Portal, click **Service Catalog > Activate Plugin**.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
</tbody>
</table>
Specify the date and time you would like this plugin to be enabled

<table>
<thead>
<tr>
<th>Date and time must be at least 2 business days from the current time.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Plugins are activated in two batches each business day in the Pacific timezone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reason/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Determine where software is installed**

When determining where software is installed, there are a few points to keep in mind.

- The software instance no longer contains discovered information. The information previously went to the Software Instance [cmdb_software_instance] table, but now goes to the Software Installation [cmdb_sam_sw_install] table. Because the table has changed, you must change your transform maps to point to the new table.
- Models identified by a discovery tool are linked to software models.
- Use grouping to obtain more specific information from a software counter.
- Software installations link a computer with a software model (via a discovery model).

A discovery tool places the data it obtains into the Software Installation [cmdb_sam_sw_install] table. All of the information can be seen in the Software Installations list and the individual Software Installation forms. When a record is created, the system analyzes the Discovery Model table and identifies five key points.

- Publisher
- Display name
- Prod ID
- Version
- Revision

**Find software on the network**

After using a discovery tool, you can find a definitive list of all the software found on the network.

Role required: sam

**Note:** A user with the Asset role can delete software installations, but it is not recommended. As an alternative, archive software installation information.

1. Navigate to Software Asset > Discovery > Software Installations.
A software administrator can, for example, look at the list and see that Adobe Acrobat 9.0, 9.2, 9.3, and 9.5 were found. Then, the administrator can edit software discovery models so all the dot versions are considered version 9.0 when doing reconciliation.

2. Click a **Display Name** in a row.

All installations that map to an individual software discovery model are displayed.
All fields on the form are read-only.

**Table 21: Software installation fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software installation as it appears in record lists.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model that represents the installed software.</td>
</tr>
<tr>
<td>Prod id</td>
<td>Number created by the publisher to identify the software.</td>
</tr>
<tr>
<td>Install location</td>
<td>Path under which the software is installed.</td>
</tr>
<tr>
<td>Install date</td>
<td>Date on which the software was installed.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision of the software.</td>
</tr>
<tr>
<td>Instance key</td>
<td>Encrypted credentials for the software installation.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Hardware on which the software is installed.</td>
</tr>
<tr>
<td>Uninstall string</td>
<td>Identifier used to uninstall the software.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>ISO number of the software.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Foreground | Duration of foreground usage of the software.
Background | Duration of background usage of the software.
Last scanned | Date and time on which the software was last discovered on this hardware.
Last used | Date and time on which the software was last used on this hardware.
Counted by | The counter summary name that the installation is counted on.
Enteritlement | Entitlement that is associated with the software installation.
Inferred suite | Software suite inferred by the inference parameters.
Valuation | Indicates the number of rights the install has.
Cached | If checked, the license installation has already been counted.
Omit from suites | If checked, the license is ignored for any suite calculations. This box is automatically checked if the install finds a possible entitlement of the exact software model for this configuration item.

**Note:** Third-party discovery tools can use software normalization to more effectively manage the software installation database. Software normalization allows you to standardize your software installation data, such as the display name, publisher, revision, and version. You can personalize the software installation form to include these normalization fields.

---

Scan software installations with the system scheduler

Software Asset Management plugin adds a scheduled job for scanning software installations named **SAM License Counters** in **System Scheduler > Scheduled Jobs**.

The SAM License Counters job occurs at 2:00am (local time) every morning. The job queries the Software Installation `[cmdb_sam_sw_install]` table and captures any installations that have not been scanned in the past 7 days. The job runs a join query on hardware that has been scanned within the last day and software installations that have not been scanned in the last 7 days. These software installations are then removed.

### Software licenses

Software licenses are based on defined models.

You can create the models to organize software licenses in any way that makes sense for your organization. Common methods of defining models and licenses include by department or by region.

Licenses can be associated with a contract. For more information, see **Software Contracts**.
Licensing types

Different types of licenses are available in the Software Asset Management plugin feature as listed below.

- By CPU
  - By CPU cores
  - By number of CPUs
- By number of points
  - Per installation - IBM PVU
- By user
  - Number of installs per user
  - Per named user
- By utilization
  - Usage (CPU)
  - Usage (User)
- By workstation
  - Per workstation

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual</td>
<td>Given to individuals.</td>
</tr>
<tr>
<td>Bulk allocated</td>
<td>Allocated to users via entitlements.</td>
</tr>
<tr>
<td>Bulk not allocated</td>
<td>Given to users with details, such as who has a license or where the license is located, not tracked.</td>
</tr>
</tbody>
</table>

Software license management

The Software Asset Management plugin feature allows asset managers to track and organize the number of licenses available to the organization.

Software licenses are based on models that you create to organize software licenses in meaningful ways. Different license calculation types determine how software is counted.

Software licenses can also be associated with a contract which enables a company to cover software licenses for multiple assets or users. For more information, see Software Contracts.

Add a new software license

You can add a new software license.

Role required: sam

1. Navigate to Software Asset > Software Licenses.
2. Click New.
3. Complete the form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Read-only. Name of the software license. Created automatically.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category for the software license. <strong>Software License</strong> is selected by default.</td>
</tr>
<tr>
<td>Model</td>
<td>Software model of the license you are matching to. For example, Microsoft Excel.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of entitlements to be granted by this license. If an enterprise contract is attached to the license, the Rights field does not display.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Asset tag</td>
<td>Number from the asset tag. The tag contains the serial number and bar code for tracking the software license.</td>
</tr>
<tr>
<td>State</td>
<td>Current status of the software license, such as On order or In use.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User currently assigned to this software license.</td>
</tr>
<tr>
<td>Managed by</td>
<td>User or department that maintains the software license. Can be different than the owner. For example, a specified user can own a software license, but the IT department manages it.</td>
</tr>
<tr>
<td>Owned by</td>
<td>User or department with financial ownership of the software license. Can be different than the manager.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset of the software license, if any. For example, the parent asset of Microsoft Word software is often the Microsoft Office suite.</td>
</tr>
<tr>
<td>Class</td>
<td>[Read-only] Automatically created as Software License.</td>
</tr>
<tr>
<td>License metric</td>
<td>[Optional] A single metric which the software license is counted against.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Unique number assigned for identification.</td>
</tr>
<tr>
<td>Substate</td>
<td>More details about the software license stage. The available substate settings depend on the State selected. For example, if you select the Retired state, the substate options available are Disposed, Sold, Donated, and Vendor credit.</td>
</tr>
<tr>
<td>Location</td>
<td>Where the license will be used. For example, a specific site, country, or region.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Department</td>
<td>Department of the person <strong>Assigned to</strong> this software license.</td>
</tr>
<tr>
<td>Company</td>
<td>Company that created the software.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the software license was assigned.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the software license was installed.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the software license that would be helpful for others to know.</td>
</tr>
</tbody>
</table>

For information about the fields in the **Financial** and **Contracts** sections of the form, see *Create assets*.

4. Click **Submit**.

---

Create and manage an enterprise license

Enterprise licenses are typically for large customers and provide some flexibility, an agreed upon discount price, and a mechanism for easy administration.

Use the Contract Management application to set a software license as enterprise or subscription.

1. Navigate to **Contract Management** > **Software Licenses**.
2. Click **New**.
3. Select a **License type** of **Enterprise**.
4. Fill in as many of the remaining fields on the Contract form as you can, and click **Submit**.
5. Reopen the contract.
6. In the **Assets Covered** related list, click **New**.
7. In **Asset**, select the software covered by the contract.
8. In **Date added**, select the date the software license was added to the contract. The date can be in the past, the present, or the future.
9. (Optional) In **Date removed**, select the date asset was, or will be, removed from the contract.
10. Click **Submit**.
11. Navigate to **Software Asset** > **Reconciliation** > **Software Counters**.
12. Click the software you specified.
13. Click **Count Licenses**.

The licenses are listed under **Software Counter Results**. The licenses display as 0, but you are not out of compliance because you have an enterprise license with an enterprise contract. Once an enterprise contract is associated with software, all users are entitled when the licenses are counted.

**Note:** In the Software Licenses list, enterprise licenses display 0 in the **Rights** column. The concept of rights is not used with enterprise licenses.

---

Create and manage a subscription license

You can create subscription licenses, and manage the information as it changes.
Role required: contract_manager

1. Navigate to Contract > Software License and click New.
2. Select a License type of Subscription.
3. Complete the Contract form, right-click the header, and select Save.
4. In the Assets Covered related list, click New.
5. In Asset, select the software covered by the contract.
6. In Date added, select the date the software license was added to the contract. The date can be in the past, the present, or the future.
7. Optional: In Date removed, select the date asset was, or will be, removed from the contract.
8. Click Submit.
10. Click the software specified in step 6.
11. Click Count Licenses.
    The licenses are listed under Software Counter Results.

Software license entitlements

Software entitlements enable you to define the people or machines to which a specific, purchased software license is assigned.

Role required: asset

Asset managers allocate a license to entitle a user or machine to use the license. For example, a company purchases a software license for 100 rights. The software entitlement specifies the 100 employees or machines that are rightfully assigned a license. If the ServiceNow Discovery tool is used and it finds the software installed on 200 machines, the asset manager can identify the employees or computers that have the software installed without a license. The asset manager can ask users to remove the software from their computers.

Built-in rules prevent entitling more licenses than have been purchased. License entitlements use specific software license asset tags. In addition to the mandatory asset tag, an individual person and a specific configuration item can be assigned.

The benefits of using software entitlements include the following.

- If the overall license allotment is exceeded, the asset manager can rapidly address the problem and return to compliant status by either removing unauthorized software or ordering more licenses.
- If the license allotment is not being used completely, the asset manager can respond by lowering the number of licenses purchased in the future.

1. Navigate to Asset > Software > Asset License Entitlements.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Read-only. Name used in record lists.</td>
</tr>
<tr>
<td>Allocated to</td>
<td>The configuration item consuming the license token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>Read-only. Internal flag set and used by software counters logic.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

*Create an entitlement*

You create software entitlements for both CIs and users from the same License Entitlement form.

You can create these entitlements from Asset Management. Navigate to one of these locations and click **New**:

- Asset Management > Software > Asset License Entitlements
- Asset Management > Software > User License Entitlements

1. Navigate to Software Asset > Software Licenses.
2. Click an Asset tag.
3. Click **Add Entitlement** and complete the License Entitlement form using the fields in the table.
4. Click **Submit**.

The view returns to the Software License form.

5. Set an optional condition in the **Allocated conditions** section.

The configuration items given this license must meet the specified conditions. For example, you might set a condition that allocates this software license to CIs in a certain department only.

6. Click **Update**.

Table 23: License entitlement

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>[Read-only] Name used in record lists.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User of the entitlement token.</td>
</tr>
<tr>
<td>Allocated to</td>
<td>The configuration item consuming the license token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>[Read-only] Internal flag set and used by software counters.</td>
</tr>
</tbody>
</table>

Create a software user license entitlement

You can entitle a user to use one of your software licenses.
Role required: asset

1. Navigate to Asset > Software > User License Entitlements.
2. Click New.

3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Read-only. Name used in record lists.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User of the entitlement token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>Read-only. Internal flag set and used by software counters logic.</td>
</tr>
</tbody>
</table>

4. Click Submit.

*Entitle a license to a configuration item*

You can entitle a license to a configuration item, such as a computer or server, or a location, such as a city of building.

Role required: sam

1. Navigate to Software Asset > Software Licenses.
2. Click an Asset tag, or click New to create a new software license.
3. In the Asset Entitlements related list, perform one of the following actions.
   - Double-click in Allocated to to entitle the license to a specific configuration item, such as a computer or server.
   - Double-click in Location to entitle the license to a specific location, such as a city or building.
4. Optional: Set the Allocated conditions condition to the configuration items given this license must meet the specified conditions
   For example, only configuration items in a certain department can be allocated this software license.
5. Click Update.

*Entitle a license to a user or location*

You can entitle a license to an individual user.
Role required: sam

1. Navigate to Software Asset > Software Licenses.
2. Click an Asset tag, or click New to create a new software license.
3. In the User Entitlements related list, perform one of the following actions.
   - Double-click in Assigned to to entitle the license to a specific user.
   - Double-click in Location to entitle the license to a specific location, such as a city or building.
4. Optional: Set the Assigned to condition to require that every user given this license meets the specified conditions.
   Only people in a certain region can be assigned this software license.
5. Click Update.

License upgrade and downgrade

The concept of upgrading and downgrading licenses is built into the Software Asset Management plugin feature.

This is helpful when reconciling licenses. Downgrading a license is the process of purchasing a license, but using an earlier version. Upgrading a license occurs when a newer version of a license is not purchased, but you are allowed to use the newer version. Downgrading is more common than upgrading.

Any version defined as a downgrade child that does not have entitlements and a license can be counted as an installation of the upgrade parent. Use this method to avoid having to uninstall unlicensed versions of software running in your environment. When you define an unlicensed version as a downgrade child of a licensed version, the system creates a software model record for the unlicensed version with an upgrade path to the licensed version. If you delete the downgrade child from the licensed version's record, it is automatically deleted from the Software Model record for the unlicensed version.

**Note:** If the downgrade child has either a license or an entitlement, it must also have a counter, which counts all installations of the downgrade child against its own license.

For example, you have licenses for the software model Microsoft Word 2010, but no licenses or entitlements for Word 2007. Discovery finds installations of Word 2007 being used in your organization. Rather than force users to uninstall all instances of this unlicensed version, you decide to count installations of Word 2007 against your Word 2010 license. To do this, you configure Word 2007 as a downgrade child in the Word 2010 Software Model record. A Software Model record is automatically created for Word 2007 which specifies Word 2010 as the upgrade parent.

If a software version has a downgrade child or an upgrade version that can be counted against the parent, the number of installs counted is restricted to the number of available rights of the parent. For example, Microsoft Word 2010 has a downgrade to Word 2007. Both versions have an active counter. Microsoft Word 2010 finds all entitled copies of Word 2007, and also takes out of compliance any installs from that downgrade counter until the available downgrade rights are used. However, if Microsoft Word 2010 only has 100 rights, then the maximum number of rights to be taken from the downgrade counter is 100.

You can set the start and end dates for a software upgrade parent and downgrade child to be valid. The software counter counts the upgrade and downgrade licenses within the selected dates. If the software counter runs outside of the date range, the upgrade and downgrade licenses are not counted.

**Note:** If an upgrade parent or downgrade child is set on the software model, it applies to all licenses of that model. If set on the software license, it applies specifically to that license.

**Upgrade a license**

You can upgrade a software license using one of two methods: from a software license record or from a software model record.
Role required: sam

1. Complete the following steps to identify an upgrade parent from a software license record.
   a) Navigate to Software Asset > Software Licenses.
   b) Select a model.
   c) In the Upgrade related list, double-click under the Upgrade Parent column heading.
   d) Click the reference lookup icon (🔍).
   e) Select a software model from the list.
   f) Click the green check mark.

2. Complete the following steps to identify an upgrade parent from a software model record.
   a) Navigate to Software Asset > Software Models.
   b) Select a model.
   c) In the Upgrade section, double-click under the Upgrade parent column heading.
   d) Select a software model from the list.
   e) Click the green check mark.

Downgrade a license
You can downgrade a software license using one of two methods: from a software model record or from a software license record

Role required: sam

Note: Downgrade children set on the software license applies specifically to that license. If a downgrade child is set on the software model, it applies to all licenses of that model.

1. Complete the following steps to downgrade a license from a software model record.
   a) Navigate to Software Asset > Software Models.
   b) Select a model.
   c) In the Downgrade section, double-click under the Downgrade child column heading.
   d) Select a software model from the list.
   e) Click the green check mark.

2. Complete the following steps to downgrade a license from a software license record.
   a) Navigate to Software Asset > Software Licenses.
   b) Select a license.
   c) Click New in the Software Upgrade and Downgrades related list.
   d) Select a software model from the list.
   e) Select the Start and End dates.
   f) Click Submit.

Identify a downgrade child from a software license record
How to identify a downgrade child from a Software License record.

1. Navigate to Software Asset > Software Licenses.
2. Select a license.
3. Click **New** in the **Software Upgrade and Downgrades** related list.
4. Select a software model from the list.
5. Select the Start and End dates.
6. Click **Submit**.

**Note:** Downgrade children set on the software license applies specifically to that license. If a downgrade child is set on the software model, it applies to all licenses of that model.

**View a list of unallocated software licenses**

Managing software licenses includes knowing what licenses are owned by your organization, but are not allocated.

Role required: sam

You can, for example, allocate the licenses to users or machines. If no one needs the unallocated licenses, this can be noted so that fewer licenses are purchased in the future.

1. Navigate to **Software Asset > Unallocated Licenses**.
   This list is also available from **Asset Management > Stock > Unallocated Licenses**.
2. View the **Software Counter Details** list (**Unallocated License** view).
   The **Valuation** column lists the number of unallocated licenses for the given software model.

3. Click a name in the **Model** column for detailed information about a specific license.
   View the **Software Model** list in the **Unallocated License** view.
Merge a software license

If you have multiple software licenses that are linked to the same model, you can merge these individual licenses into one new consolidated license.

To be merged, the individual licenses must meet the following requirements:

- The licenses cannot already be merged into another consolidated license.
- The information in the following fields must match for each license:
  - Model
  - Allocated condition
  - Assigned condition
  - Company
  - Location
  - Department
  - Cost center
  - State
- The licenses must have the same set of software upgrades and downgrades and the same set of assets covered. To verify this information, go to Software Asset > Software Licenses and select a license.
  - For upgrades and downgrades, go to the Software Upgrade and Downgrades related list.
  - For assets covered, go to the Assets Covered embedded list in the Contracts related list.

If a license can be merged, Merge with similar licenses appears under Related Links on the Software License form.

To merge a license:

1. Open a license.
2. Click the Merge with similar licenses link.
   Displays a dialog box with a message stating that the merge process is irreversible and that license keys are not merged.
3. Click OK.
   All qualifying licenses, including the current license, are merged into a new consolidated license. An informational message appears until the user is redirected to the newly merged license.

All qualifying licenses are merged into a new consolidated license unless they can be matched to an existing consolidated license. If they are merged into a new consolidated license, the Asset tag field is cleared. After merging, the merged license is marked as Is merged license (field = true) and the Merged into field is set to this license for the consolidated licenses.

Note: Licenses that are marked as merged are not counted.

For the consolidated licenses:

- The number of rights are summed up into a new count.
- The asset and user entitlements are transferred to the new license.
- The expense lines and assets on contract rate cards are transferred to the new license.
- The set of software upgrades and downgrades, as well as the set of assets covered, are copied to the new license.
- The cost of each individual license is summed up into the new license using the system base currency.
• A history of the consolidated licenses and where they went is maintained.

Manage software models

Software Asset Management plugin uses software models to manage licenses, specifically in software counters and license restrictions, and to track upgrade and downgrade licenses.

Role required: sam or model_manager

Create software models for all of the software your organization wants to monitor. Software models can also be imported from another source such as the Discovery application.

[Note: Software does not create configuration items. If the discovery tool you use supports and finds ISO information, details such as ISO ID and ISO serial number are added to the Software Model form for compliance purposes.]

1. Navigate to Software Asset > Software Models.

   Users with the model_manager role can navigate to Product Catalog > Product Model > Software Models, but cannot administer all aspects of software models.

2. Click New.

3. Complete the form.

Table 24: Software model fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>[Read-only] Name of the model. A system property called glide.cmdb_model.display_name.shorten controls how software model display names are generated. Administrators can configure the property.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or an abstract name specified by the model manager, such as Field Agent Laptop.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the software model, such as Professional.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>[Read-only] The category the model is assigned to. The system automatically sets the value to Software License. This field is a glide list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>The process the model should be tracked by. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Leave to Category</strong>: model is transparent and the asset class is defined</td>
</tr>
<tr>
<td></td>
<td>solely by the category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Create Consumable Asset</strong>: model forces the asset class to be</td>
</tr>
<tr>
<td></td>
<td>consumable, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Don't create assets</strong>: model blocks asset instantiation, regardless of</td>
</tr>
<tr>
<td></td>
<td>what the category defines as the asset class.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>The method for purchasing the model. Options are <strong>Both</strong>, <strong>Buy</strong>, and <strong>Lease</strong>.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost a single unit of the model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The depreciation scheme for the model.</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are usually assigned by</td>
</tr>
<tr>
<td></td>
<td>the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the model. Options are <strong>In Production</strong>, <strong>Retired</strong>,</td>
</tr>
<tr>
<td></td>
<td>and <strong>Sold</strong>.</td>
</tr>
<tr>
<td>Certified</td>
<td>The option that determines whether the model is approved for use.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the model that would be helpful for others to know.</td>
</tr>
<tr>
<td>License</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>The exact version of the software. For example, Version 2.</td>
</tr>
<tr>
<td>Major</td>
<td>The ISO major version number of the software.</td>
</tr>
<tr>
<td>Minor</td>
<td>The ISO minor version number of the software.</td>
</tr>
<tr>
<td>Build</td>
<td>The build number of the software.</td>
</tr>
<tr>
<td>Software category</td>
<td>A category name for grouping software with similar characteristics.</td>
</tr>
<tr>
<td>Single or multi license</td>
<td>Defines whether this model uses a single license or multiple licenses.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Maximum socket count</td>
<td>Maximum number of CPU sockets that a computer must have for the software to be installed.</td>
</tr>
<tr>
<td>License type</td>
<td>The tracking type for the license. For example, by number of users, per workstation, per installation with IBM PVU or per Oracle processors. If you select the <strong>By number of users</strong> option, you can create a software counter and specify the number of installations per license.</td>
</tr>
<tr>
<td>Activation status</td>
<td>The activation state of the software model. Options are <strong>None</strong> and <strong>Activated</strong>.</td>
</tr>
<tr>
<td>ISO id</td>
<td>The unique ISO identification number of the software product.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>The serial number issued by ISO for the software.</td>
</tr>
<tr>
<td>Application model</td>
<td>Application associated with this software.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of licenses granted to this software.</td>
</tr>
<tr>
<td>Minimum users</td>
<td>Minimum number of user licenses required for this software.</td>
</tr>
<tr>
<td>Maximum users</td>
<td>Maximum number of user licenses required for this software.</td>
</tr>
<tr>
<td>Suite Components</td>
<td>The child product or products of the suite. For example, Microsoft Word and Microsoft Excel are child products of Microsoft Office.</td>
</tr>
<tr>
<td>Inference percent</td>
<td>The percentage of suite components that need to be present on a system to count as a suite. Used for suite management. For example, Suite A consists of 5 products. If the inference percent is set to 60% and a discovery tool finds three of the products on the system, the software is flagged for possible purchase as a suite.</td>
</tr>
<tr>
<td>Suite Parents</td>
<td>The parent suites to which the software is assigned. For example, the parent suite for several common Microsoft products is a version of Microsoft Office.</td>
</tr>
<tr>
<td>Upgrade</td>
<td></td>
</tr>
</tbody>
</table>

© 2017 ServiceNow. All rights reserved.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrades</td>
<td>An alternative version license to which you have rights. For example, if you purchase version 4 of a software product shortly before version 5 is released, your version 4 license may include a free upgrade to version 5 when it is released.</td>
</tr>
<tr>
<td>Downgrade</td>
<td>An alternative version license to which you have rights. For example, if you purchase version 4 of a software product, your version 4 license may include downgrade rights to version 3.</td>
</tr>
<tr>
<td>Licenses</td>
<td>The software licenses that should be created automatically from this model.</td>
</tr>
<tr>
<td>Software Licenses</td>
<td>Note: This embedded list shows all assets created from this model, whether or not they are software licenses, in versions prior to this release.</td>
</tr>
<tr>
<td>Catalog Item</td>
<td></td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The information about the model as it appears in the product catalog and service catalog. Information only appears if the model has been published to the product catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model as it appears in the product catalog.</td>
</tr>
<tr>
<td>Picture</td>
<td>An image of the software logo.</td>
</tr>
</tbody>
</table>

Any software licenses you create and assign to the new model are displayed in the **Licenses** embedded list on the Software Model form.

**Create and manage software suites**

Software uses the concept of suites instead of bundles.

A software suite is a group of related software offered as one unit. An example is the Microsoft Office Professional suite of office productivity software tools that includes Powerpoint, Word, Excel, Outlook, and Access. In Software Asset Management plugin, create suites and add components to the suite so the licenses your organization owns are counted accurately.

For any software model, you have the option to specify whether the model is a suite (parent) or a component (child). A software model can be a component in multiple suites. For example, Microsoft Word is a component in Microsoft Office Standard and Microsoft Office Professional. Although you can set a single software model as both a suite and a component, software is not typically sold as nested suites.

Use the **Inference percent** and **Inference mandatory** options for even greater control of suites.
• **Inference percent**: specifies what percentage of the components in the suite must be installed for the software to be identified as a suite.

• **Inference mandatory**: enforces that a specific component in a suite must be installed to infer that the suite is installed.

For example, specify the **Inference percent** as 80% and set the **Inference mandatory** option to **true** on Microsoft Access. These settings specify that Microsoft Access must be installed, along with 3 out of 4 other products (Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Outlook) to infer that Microsoft Office Professional is installed.

![Figure 4: The interference percent and interference mandatory fields](image)

To make the new software model record a parent record in a suite:

1. Open a software model record.
2. In the Suite Components section, double-click an empty row under **Suite child**.
3. Add the software to include in the suite.

4. [Optional] Set the Inference mandatory option to true if the software must be installed to count the model as a suite.

5. Repeat as necessary.

To make the new software record a child item:

1. Open a software model record.

2. In the Suite Parents section, double-click an empty row under Suite parent.
3. Add the suite to which this software model should belong.
4. Repeat as necessary.

**Note:** When a change is made to a suite, a scheduled job called Calculate suites [Software Suite Model] is created. The job runs instantly, calculates any suites, and then deletes itself. The calculations are stored in the cmdb_sam_sw_install table under inferred suite.

**License calculations**

Software license calculations count the number of licenses that exist in your network environment. Users with the sam role can choose to count software licenses using a variety of license calculation types, such as counting by the number of users, the number of workstations, the number of CPUs, and others. For example, you can count the number of Adobe Acrobat 9.0 licenses based on the number of users that have the software installed in the organization.

**Calculate software licenses**

Software calculations use license calculation types to determine how software licenses are counted in your organization.

You can use the default license types provided in the base system or create new ones. To view the default types, navigate to **Software Asset > Reconciliation > License Calculations** and select a type. All fields in the default records are read-only.
Table 25: License calculation details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the license type.</td>
</tr>
<tr>
<td>Query table</td>
<td>The table that is being used for data. Possible values are Software install and Software usage.</td>
</tr>
<tr>
<td>Count by</td>
<td>The calculation type by which the license calculation type counts software licenses.</td>
</tr>
</tbody>
</table>

License calculation types
Certain default license calculation types are available.
These license types cannot be deleted.

Table 26: License calculation types

<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
</table>
| By CPU            | • **By CPU cores**: The counter adds up the total license rights for all software license records of this model. The CPU Core Count field on the hardware configuration item determines the number of rights consumed by any software installation located on the configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
• **By number of CPUs**: The counter adds up the total license rights for all software license records of this model. The CPU Count field on the hardware configuration item determines the number of rights consumed by any software installation located on the configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items. |
<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
<tbody>
<tr>
<td>By number of points</td>
<td>• <strong>Per installation - IBM PVU</strong>: The counter adds up the total license rights for all software license records of this model. The installation count for every hardware configuration item that has IBM PVU software is a point calculation. The CPU type determines the PVU per-core multiplier based on the IBM PVU mapping table. The total number of cores on the configuration item is multiplied with this per-core multiplier to determine how many rights are used by an installation on this configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items. This license type is present but does not work until the Software Asset Management plugin <em>IBM PVU Process Pack</em> is active.</td>
</tr>
</tbody>
</table>
| By Client Access License (CAL)   | • **CAL (Device)**: The counter adds up the total license rights for all software license records of this model. Usage is counted as one installation for every unique configuration item (device). For each installation, the counter checks for a valid entitlement record on any of the software license records. The Software Usage [ast_usage] table is used for counting.  
• **CAL (User)**: The counter adds up the total license rights for all software license records of this model. Usage is counted as one installation for every unique user. For that installation, the counter checks for a valid entitlement record on any of the software license records. The Software Usage [ast_usage] table is used for counting. |
<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
</table>
| By user        | • **Number of installs per user**: The counter adds up the total license rights for all software license records of this model. It counts an installation when one software installation matches the discovery models that are mapped to this software model for any hardware used by a user. It counts up to the specified amount. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
• **Per named user**: The counter adds up the total license rights for all software license records of this model. It counts an installation when there is at least one software installation that matches the discovery models that are mapped to this software model for any hardware used by a unique user. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
• **No license needed (User)**: The counter adds up the total number of users of this model. It counts an installation when there is at least one software installation that matches the discovery models that are mapped to this software model for any hardware used by a unique user. It applies to software installation data and hardware configuration items. This license type is used for software installations where no license is required, such as open source applications. |

To compare **Number of installs per user** and **Per named user**:

• **Number of installs per user** counts the number of installs the user has and assigns license cost based on installs per license. For example, UserA has three installs. One license is used by each install, for a total of three licenses.  
• **Per named user**, there is no install limit for a particular user. For example, UserB, who has three installs, needs only one license for the three installs.
<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
</table>
| **By utilization** | • **Usage (CPU):** The counter adds up the total license rights for all software license records of this model. The counter looks at all of the software usage data mapped to any of the discovery model records of the counter’s software model. It counts one installation for every unique configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software usage data.  
• **Usage (User):** The counter adds up the total license rights for all software license records of this model. The counter looks at all of the software usage data mapped to any of the discovery model records of the counter’s software model. It counts one installation for every unique user Accessed From hardware configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software usage data. |
| **By workstation** | • **Per workstation:** The counter adds up the total number of license rights for all software license records of this model. It counts an installation when there is at least one software installation on a hardware configuration item that matches the discovery models that are mapped to this software model. For each installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
• **No license needed (Workstation)** This license type is used for software installations where no license is required, such as open source applications. |
### Category

<table>
<thead>
<tr>
<th>By Oracle install</th>
</tr>
</thead>
</table>

### License type

- **Oracle Named User**: Oracle licensing scheme that counts by the number of unique users.
- **Oracle Named User Plus**: Oracle licensing scheme that counts by the number of unique users and accounts.
- **Oracle Processor**: Oracle licensing scheme that counts by the number of processors on a server.

This category and its license types are available when the Oracle Process Pack is activated.

---

### Create a custom license type

Custom license types allow you to create a license type with special conditions.

**Role required**: sam

A custom script can provide detailed information about the number of rights a software install or usage consumes.

1. Navigate to **Software Asset > Reconciliation > License Calculations**.
2. Click **New**.
3. Complete the form.

**Table 27: New license calculations**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the software license type.</td>
</tr>
<tr>
<td>Query table</td>
<td>The value that is used for queries. This can be either <strong>Software install</strong> to count the number of installations or <strong>Software usage</strong> to count the number of times the software is used.</td>
</tr>
<tr>
<td>Count by</td>
<td>The calculation type by which the license type counts software licenses. Make sure this value is set to <strong>Custom</strong> to create a new calculation type.</td>
</tr>
<tr>
<td>Entitlement type</td>
<td>The entitlement type of the license, either <strong>Workstation</strong> or <strong>User</strong>. This field is available only when the <strong>Count by</strong> field is set to <strong>Custom</strong>.</td>
</tr>
<tr>
<td>Script</td>
<td>The script used for custom license types. This field is available only when the <strong>Count by</strong> field is set to <strong>Custom</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
Create the script

By default, the **Script** field in the Software License Calculation form contains information about available variables and an example script.

You can use the example as the basis of the custom script or replace the example entirely.

You can use the following variables in the custom script.

Table 28: Custom script variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>found</td>
<td>Contains a GlideRecord of the software install or software usage record currently being evaluated.</td>
</tr>
<tr>
<td>workstation</td>
<td>Contains a GlideRecord of the workstation referenced by the found record.</td>
</tr>
<tr>
<td>user</td>
<td>Contains a GlideRecord of the user referenced by the found record. Can be null if no user is assigned.</td>
</tr>
<tr>
<td>counter_id</td>
<td>Contains the sys_id of the counter running the script.</td>
</tr>
<tr>
<td>query_table</td>
<td>Identifies the table currently being queried, either Software Installation or Software Usage.</td>
</tr>
<tr>
<td>valuation</td>
<td>Identifies the value in rights that is given to this software install or software usage record.</td>
</tr>
</tbody>
</table>

The following functions are available as part of the **SAMUtil** script include and can be used in custom scripts.

**Note:** All of these functions utilize and depend on the variables mentioned above.

Table 29: Custom script functions

<table>
<thead>
<tr>
<th>Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getWorkstationInstallsOrUsages</td>
<td>Returns a list of other installs on the given workstation.</td>
</tr>
<tr>
<td>getUserInstallsOrUsages</td>
<td>Returns a list of all other installs belonging to the user.</td>
</tr>
<tr>
<td>createCounterViolation</td>
<td>Returns insert a counter violation for the current counter with the given cause.</td>
</tr>
</tbody>
</table>

Example:

The following script uses the number of rights equal to the number of CPU sockets on the machine the script is installed on. The workstation variable is used to identify any workstation that is in the development environment. If such a workstation is found, the script then assigns a valuation equal to the number of CPU sockets on the machine. Otherwise, if the workstation is not in the development environment, then no rights are assigned.
Software discovery models can be used to help normalize the software you own by analyzing and classifying models to reduce duplication.

Software discovery models are stored in the Software Discovery Model [cmdb_sam_sw_discovery_model] table. There is a distinct difference between software models and software discovery models.

- A software model is a specific version or configuration of software.
- A software discovery model is a model created when Discovery runs and identifies software.

Software discovery models cannot be created manually. The ServiceNow platform uses any of the following field combinations to match the new software discovery model to an existing software model.

- **Display Name, Publisher, and Version**
- **Display Name** and **Version** if the **Publisher** field is empty
• **Display Name** only if the **Publisher** and **Version** fields are empty

When analyzing version numbers, the ServiceNow platform always searches for an exact match first, but rounds down to a major version number if an exact match is not found. For example, if no match is found for version number 8.0.4, but version 8.0 is found, then version 8.0 is used in the **Software model** field.

**Edit a software discovery model**

You can only edit the **Software model** field and **Approved** check box on the Software Discovery Models form.

Role required: sam

If the information automatically added to the **Software model** field is incorrect, you can change to an existing model or create a new one.

None of the software discovery model records are approved when they are created. You must approve them manually after you have reviewed them for accuracy or normalized them. If the automatically generated software model is correct, approve the model.

1. Navigate to **Software Asset > Reconciliation > Discovery models**.
2. Click an entry in the **Publisher** column.
3. Select **Approved**.

![Software Discovery Model](image)

**Automatically match to an existing model**

The automatic matching feature allows you to match a software discovery model to an existing software model.

Role required: sam

1. Navigate to **Software Asset > Reconciliation > Discovery models** and open a model.
2. Clear the **Software model** field.
3. Click an entry in the **Publisher** column.
4. Click **Match model**.
The system searches for the best match from existing models. If a match is found, the system automatically adds the name to the **Software model** field and selects the **Automatically matched** check box. If a match is not found, a **No match found** message is displayed, and two related links appear, allowing you to create a new model. No change occurs if the system has already made a match.

5. If no match is found, create a new model.
   If a model is already matched, then the automatic matching feature does not run.

   The automatic matching feature can also be used when you insert a new discovery model record or if you modify and update an existing discovery model. If automatic matching is run, all software installations and usages that reference the discovery model will have their **Inferred suite** and **Cached** fields cleared.

   For more information on software installation and usage records, see *Determine where software is installed*.

### Create new models

If the automatically generated software model is not correct or if the system cannot find a match from existing models, you can create a new model.

**Role required:** sam

1. Navigate to **Software Asset > Reconciliation > Discovery models** and open a model.
2. Clear the **Software model** field.
3. Save the record.

   Two related links appear for creating software models.

4. Select one of these related links to create a new model, which are available only if no **Software model** is specified.
   - **Create Software Model**: Creates a new software model for this record if a suitable one does not already exist. You can create a new software model for multiple records in the Discovery Models list view. Select one or more records and then click the link in the **Actions** choice list.
   - **Create Software Model and Counter**: Creates a new software model and a new software counter for this record. The system creates the software model automatically using the value in the **Display name** field, and then opens a new Software Counter form. In the Discovery Model list view, you can select multiple records and choose this option from the **Actions** choice list.

5. Complete the form.

<table>
<thead>
<tr>
<th><strong>Table 30: Model fields</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Display name</td>
</tr>
<tr>
<td>Publisher</td>
</tr>
<tr>
<td>Version</td>
</tr>
<tr>
<td>Revision</td>
</tr>
</tbody>
</table>
6. Select **Approved**.

7. Click **Submit**.
Software License Compliance Checker

The Software License Compliance Checker is a fast way to see if the software licenses used in your organization are compliant based on number of rights purchased and number of installations.

For example, if there are 100 licenses for a software program, the Software License Compliance Checker can show if the software has been installed more than 100 times. The Compliance Checker uses information found by a discovery tool such as Discovery, Help the Help Desk, or third-party technologies, to analyze the software installed on your network.

Use the Software License Compliance Checker

You can check software license compliance.

Role required: sam

1. Navigate to Software Asset > System > Check License Compliance.
2. Click Proceed.
   Your organization's network is analyzed for name, software model, rights, installs, license type, and active status.
3. View the results.
   The Software Counters list is color coded.
   - Green - in compliance
   - Orange - within 5% of being out of compliance
   - Red - not compliant
Use counters for software license reconciliation

Software counters reconcile software rights with software installations to verify compliance.

For asset managers, software counters answer the question: Is my number of installations equal to or lower than the number of rights purchased? Counters are useful for software that must be tracked; some software may not need to be tracked closely. Grouping—such as location, company, department, cost center, entitlement workstation and entitlement user—or no grouping can be used with software counters.
In addition to software counters, Software Asset Management plugin offers usage counters that track a license based on use by a workstation or user.

The software counter cache is used to increase the speed of counting software licenses. If there is a large number of software license records, the first time software is counted takes several minutes. After the first count, only changes are processed so the procedure is faster.

Get started with software counters

A good way to see how software counters work is to use the demo data provided with Software Asset Management plugin.

Load the demo data on a non-production instance.

![Software Asset Management plugin demo data](image)

Using the demo data, try some of the procedures on this page, such as Use the Software Counter and View a Usage Counter Result.

To use software counters with your own information, follow the steps in the Software Asset Management plugin setup process on page 81. ServiceNow Discovery does not populate the Software Usage (cmdb_sam_sw_usage) table. Use a third party tool such as Microsoft's System Center Configuration Manager to add information about software assets to the Software Usage table.

Schedule a software count

How to schedule a software count.

The SAM License Counters scheduled job scans your instance for software installations. The SAM License Counters job occurs at 2:00am local time every morning. The job queries the Software Installation [cmdb_sam_sw_install] table and captures any installations that have not been scanned in the past 7 days. The job runs a join query on hardware that has been scanned within the last day and software installations that have not been scanned in the last 7 days. These software installation records are then removed.

**Note:** You can change the deletion interval of software installations with the sam.install_deletion_deadline property in the System Properties [sys_properties] table. For more information, see the property description.

The SAM License Counters scheduled job runs all software counters at once.

To refresh the cache manually for a specific counter:

1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Select a counter whose cache you want to refresh.
3. Right-click in the header bar of the Software Counter record and select Rebuild SAM Cache from the context menu.
Use the software counter

Use a software counter to count the licenses for a specific version of software and receive summary or detailed results.

When a software counter runs for the first time, it can take several minutes to process records. The license counts are cached so that on subsequent runs, the counter processes only changed records, both those from Discovery or altered entitlements, making it faster. The Software Counter form contains check boxes to enable faster counting through the use of quick counters. For more information on using quick counters, see Setting Up Quick Counters.

Use a software counter to count the licenses for a specific version of software and receive summary or detailed results. For example, an asset manager can look at summary information to discover which departments are not in compliance. Then, department managers can look at detailed information to determine the people or individual computers that are not in compliance.

Software counters return results by Licensing Type:

- Entitled in use: Number of people who have been allocated a license and installed the software.
- Entitled not in use: Number of people who have been allocated a license but did not install the software.
- Not entitled: Number of people using an unauthorized copy of the software.
- Not allocated: Number of licenses not assigned.

**Note:** For information about the scheduled job that runs all counters each day or the steps to run all counters manually, see Scheduling Software Counts.

The Software Counters list is color coded:
• Green - in compliance
• Orange - within 5% of being out of compliance
• Red - not compliant

Figure 9: SAM software license compliance check

Create a software counter

How to create a software counter.

Depending on the license type you select for a counter, multiple installations can count as a single license, such as when using the per user license type. This licensing concept is used on occasion by companies like Microsoft and Adobe. It grants users the right to install software on multiple machines if those users already have rights to install the software.

**Note:** You can create new counters from Discovery model records or from the list view.

To manage multiple versions of software from a single licensing perspective for the parent software model:

• The downgrade child software models that are licensed under the parent software model should all be related to a single parent software model.
• The downgrade child software models should not have any software counters associated with them.
• The software counter should be associated only with the licensed parent software model, otherwise misleading results for the counter will be reported.

To create a software counter:

1. Navigate to **Software Asset > Reconciliation > Software Counters**.
2. Click **New**.
3. Fill in the fields on the Software Counter form (see table).
4. Click **Submit**.
5. Reopen the new counter and click **Count Licenses**.
6. Reload the form to view the **counter results**.

### Table 31: Software counter form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Enter the name of the software counter as it appears in record lists.</td>
</tr>
<tr>
<td>Software model</td>
<td>[Required] Click the reference lookup icon and select the software model for which the counter will check compliance.</td>
</tr>
<tr>
<td>Contract</td>
<td>Select the contract that you want to use to limit the license. Used for enterprise and subscription-based licenses. Also restricts how counters retrieve licenses for the given counter. If left empty, all licenses for the model are counted.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to have the scheduler run the counter.</td>
</tr>
<tr>
<td>Rights Owned</td>
<td>[Read-Only] Displays a summation if a contract is specified. The total sum is the license rights provided by all the licenses for the software model (of the counter) under the specified contract. If no contract is specified, this field is a count of all licenses of this model.</td>
</tr>
<tr>
<td>Rights Used</td>
<td>[Read-Only] Displays the number of rights used by all installs, whether a contract is specified or not.</td>
</tr>
<tr>
<td>Immediate compliance</td>
<td>[Read-Only] Displays the number of additional rights needed to achieve compliance based on installations.</td>
</tr>
<tr>
<td>Parameters</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Grouping** | Select the field for grouping data:  
  • Location: group by the geographic location set in the license record.  
  • Company: group by the company set in the license record.  
  • Department: group by the department set in the license record.  
  • Cost Center: group by the cost center set in the license record.  
  • Entitlement (CPU): group by the condition defined in the Allocated condition field of the license record.  
  • Entitlement (User): group by the condition defined in the Assigned condition field of the license record.  
  The software counter results also displays counts for licenses that do not match the grouping parameter. |
| **Enforce to** | [Required] Select the level of adherence to the license:  
  • License: counts all existing entitlements for the installations or usage you are analyzing regardless of the grouping parameter selected.  
  • Strict: counts the license and entitlement as valid only if the license also matches the grouping category. For example, a license is assigned to a specific location, such as Americas. With strict enforcement enabled, the user and the machine on which the license is installed must be in the Americas group. If the person and their license assigned to the Americas group moves to the United Kingdom, the license is still valid, but strict enforcement flags the user as unauthorized to use that license. The license will be counted as valid, but will also show up as not entitled in the summary. |
<p>| <strong>Verify entitlements</strong> | Select the check box to view the software entitlement details for the software counter. Results include the number of installations of all types: not entitled, entitled in use, entitled not in use, and not allocated. For more information, see Setting Up Quick Counters. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate details</td>
<td>Select the check box to generate the details of the entitlement records. For more information, see Setting Up Quick Counters.</td>
</tr>
<tr>
<td>License type</td>
<td>[Required] Select the method for counting licenses. For example, Per named user or Per workstation. For more information, see License Calculation Types.</td>
</tr>
<tr>
<td>Installs per license</td>
<td>Enter the number of installations allowed (one or more) per license for each user if the License type is set to By number of users. You can allow more than two installations per license. For all other license types this field is set to 1 install per license.</td>
</tr>
<tr>
<td>Cached</td>
<td>[Read-Only] Shows whether this option is selected. If selected, only changed information is counted, reducing the amount of time it takes to count the licenses.</td>
</tr>
<tr>
<td>License condition</td>
<td>Specify the condition a license should satisfy in order to be counted.</td>
</tr>
<tr>
<td>Software install condition</td>
<td>Specify the condition an install record should satisfy in order to be counted. This field appears depending on the value of the License type field.</td>
</tr>
<tr>
<td>Software usage condition</td>
<td>Specify the condition a usage record should satisfy in order to be counted. This field appears depending on the value of the License type field.</td>
</tr>
</tbody>
</table>

**Related Lists**

<table>
<thead>
<tr>
<th>Related Lists</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Counter Results</td>
<td>Displays all results for this software counter.</td>
</tr>
<tr>
<td>Software Counter Compliance Violations</td>
<td>Displays all records of compliance violations for this software counter.</td>
</tr>
<tr>
<td>Software Counter Histories</td>
<td>Displays all software counter history records for this software counter. Each time a count is completed, the system automatically generates a software counter history record, which is a read-only copy of the software counter record.</td>
</tr>
</tbody>
</table>

**Note:** A message is displayed at top of the software counter form indicating if a license count is in progress. Reload the form to view the counter results.
Set up quick counters

Quick counter settings can help speed up the software counting process.

The following check boxes are available in the Parameters section of the Software Counter form:

- **Verify entitlements**: When this check box is selected, the software counter will generate entitlement details in the software counter summaries, displaying the number of entitlements in use and entitlements not in use. If the check box is cleared, the software counter will display Entitlement not known with a count of total installs. The counter will not check for entitlements.
- **Generate details**: When this check box is selected, the software counter will generate software counter details for each software counter result type. If the check box is cleared, no details will be available.

Clearing these check boxes in addition to setting the Grouping parameter to None will enable software counters to run more quickly.

View a software counter result

Software counter results provide detailed information about each grouping.

To view software counter results:

1. On the Software Counter form, click a name in the **Software Counter Results** related list.

2. View the Software Counter Result form (see table).
All fields on the form are read-only.

Table 32: Software counter result form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter</td>
<td>Name of the software counter whose results are displayed.</td>
</tr>
<tr>
<td>Grouping</td>
<td>Grouping this software belongs to.</td>
</tr>
<tr>
<td>Parent</td>
<td>Name of the parent software, if one exists, assigned to this software.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of rights available in the group.</td>
</tr>
<tr>
<td>Installs</td>
<td>Number of rights used by installations of the software in the group.</td>
</tr>
<tr>
<td>Immediate compliance</td>
<td>Number of additional rights needed for the group to achieve compliance based on installations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planned compliance</td>
<td>Number of additional rights needed for the group to achieve compliance based on installations and number of unused entitlements available.</td>
</tr>
</tbody>
</table>

**Usage Section**

- **Foreground**: Total duration of foreground usage of the software, based on all the installations for the group.
- **Background**: Total duration of background usage of the software, based on all the installations for the group.
- **Times used**: Total number of times the software was used, based on software usage records for the group.
- **Duration**: Total duration of software usage, based on software usage records for the group. (Not the sum of Foreground and Background.)

**Related List**

- **Summary**: Breakdown of software counter results by type. Click a type to view a detailed summary.

---

**View a software counter summary**

Software counter summaries provide information about each software counter type.

To view a software counter summary:

1. On the Software Counter Result form, click a type in the **Summary** related list.
2. View the Software Counter Summary form (see table).
   - All fields on the form are read-only.
Table 33: Software counter summary

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter result</td>
<td>Name of the software counter result for which the summary is displayed.</td>
</tr>
<tr>
<td>Count as</td>
<td>The software model being counted.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of rights that have been used.</td>
</tr>
<tr>
<td>Valuation</td>
<td>How software is counted during the reconciliation process.</td>
</tr>
<tr>
<td>Software counter</td>
<td>Name of the software counter.</td>
</tr>
<tr>
<td>Summary</td>
<td>Check box that indicates whether the form displays summary information (selected) or detailed information (cleared).</td>
</tr>
<tr>
<td>Type</td>
<td>Type of license counted.</td>
</tr>
<tr>
<td>Usage Section</td>
<td></td>
</tr>
<tr>
<td>Foreground</td>
<td>Total duration of foreground usage of the software, based on all the installations for the grouping.</td>
</tr>
<tr>
<td>Background</td>
<td>Total duration of background usage of the software, based on all the installations for the grouping.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Times used</td>
<td>Total number of times the software was used, based on software usage records for the grouping.</td>
</tr>
<tr>
<td>Duration</td>
<td>Total duration of software usage, based on software usage records for the group. (Not the sum of Foreground and Background.)</td>
</tr>
</tbody>
</table>

**Related List**

| Software Counter Details | Shows every entitlement, software install, and software usage for the software. The related list also shows the Workstation and User, if applicable, for each software counter detail. A software asset manager can, for example, identify people who are using the license but are not entitled. The software can then be uninstalled from machines that are not in compliance or people can be entitled a license to meet compliance rules.  
Click a type to view the software counter detail. |

---

**View software counter detail**

Software counter details provide information about a specific software counter summary.

To view a software counter detail:

1. On the Software Counter Summary form, click a type in the **Software Counter Details** related list.
2. View the Software Counter Detail form (see table).
   - All fields on the form are read-only.
Table 34: Software counter detail

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of the counter detail.</td>
</tr>
<tr>
<td>Software install</td>
<td>Name of the related software install record, if applicable. This field is blank if the type is Entitled not in use or Not allocated.</td>
</tr>
<tr>
<td>Software usage</td>
<td>Name of the related software usage record, if applicable.</td>
</tr>
<tr>
<td>Software counter</td>
<td>Name of the related software counter, if applicable.</td>
</tr>
<tr>
<td>Software counter summary</td>
<td>Name of the related software counter summary.</td>
</tr>
<tr>
<td>Valuation</td>
<td>A valuation of 1 indicates that the license right is being used. A valuation of 0 indicates that the license right is part of a software suite, or that the license allows more than one installation per right. The 0 indicates that this installation does not count against the license.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>Name of the related software license entitlement, if applicable. This field is blank if the type is Not entitled or Not allocated.</td>
</tr>
<tr>
<td>Software license</td>
<td>Name of the related software license, if applicable. This field is blank if the type is Not entitled.</td>
</tr>
</tbody>
</table>

Usage Section
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreground</td>
<td>Total duration of foreground usage of the software, based on the related software install record.</td>
</tr>
<tr>
<td>Background</td>
<td>Total duration of background usage of the software, based on the related software install record.</td>
</tr>
<tr>
<td>Times used</td>
<td>Total number of times the software was used, based on the related software usage record.</td>
</tr>
<tr>
<td>Duration</td>
<td>Total duration of foreground and background software usage, based the related software usage record.</td>
</tr>
</tbody>
</table>

View a usage counter result

A usage counter tracks a license based on how often the license is actually used either by a workstation or a user.

A usage counter tracks a license based on how often the license is actually used either by a workstation or a user. For example, an asset manager can use a usage counter to determine who is actually using the software they have been entitled. If an individual is not using the software at all or very infrequently, the software can be uninstalled and given to an individual who will use it more often. If you have a way of capturing information, for example a proxy server or gateway, you can capture the IP address and the name of the user accessing the license. The captured data can be added directly into the Software Usages list.

1. Navigate to Software Asset > Discovery > Software Usages.
2. Click the Display Name in the row containing the software and user to check.
3. View the Software Usage form (see table).

   All fields on the form are read-only.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software usage record.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Discovery model</td>
<td><em>Software discovery model</em> associated with the installed software.</td>
</tr>
<tr>
<td>Primary key</td>
<td>Unique identifier for table row.</td>
</tr>
<tr>
<td>Usage</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>User who accessed the software.</td>
</tr>
<tr>
<td>Accessed from</td>
<td>Hardware configuration item from which the software was accessed.</td>
</tr>
<tr>
<td>Last scanned</td>
<td>Date and time when the software was last discovered on this hardware.</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of all usage.</td>
</tr>
<tr>
<td>Times used</td>
<td>Number of times the software was accessed from this hardware.</td>
</tr>
<tr>
<td>Last used</td>
<td>Date and time when the software was last used on this hardware.</td>
</tr>
<tr>
<td>Software counter</td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counted by</td>
<td>The software counter summary record in the Software Counter Summary [sam_sw_counter_summary] table on which this usage is counted.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>The entitlement rights of the software.</td>
</tr>
<tr>
<td>Valuation</td>
<td>Number of license rights used by this software usage.</td>
</tr>
<tr>
<td>Cached</td>
<td>If selected, indicates that a software count has already been cached.</td>
</tr>
</tbody>
</table>

### Troubleshoot and tune Software Counter

Whenever you encounter issues with the Software Counter, there are a few workarounds that can resolve such issues. Perform these workarounds before further investigation.

### Troubleshooting Software Counter results

Software counter sometimes may provide unexpected results. For example, the compliance count may completely differ from the previous run or the counter displays information with missing records. To troubleshoot such issues, you can perform the following workarounds.

#### Table 36: Workarounds for troubleshooting software counter results

<table>
<thead>
<tr>
<th>Workaround</th>
<th>Related information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebuild SAM cache</td>
<td>Rebuilding the SAM cache clears all the cached results related to the counter and reconciles the rights. See, Schedule a software count on page 116</td>
</tr>
<tr>
<td>Verify the software counter’s current status</td>
<td>There can be situations where the software counter is picked up by a background schedule job to reconcile. And because the job is still running, the results are not appropriate. You must verify the counter status in such situations. See, Create a software counter on page 118</td>
</tr>
<tr>
<td>Verify Product model mapping with Discovery model</td>
<td>The Software Counter’s product model may have been mapped to an unrelated Discovery Model. This may happen because the system auto-matches newly discovered software. This mismatch causes unexpected results. See,</td>
</tr>
<tr>
<td>Delete orphaned records that refer to an non-existing Software Counter</td>
<td>Any unusual deletion of the software counter may leave the invalid counter references in the software installation records. Such software installation records may not be considered for any other Software Counters counting resulting in unexpected/invalid result and must be deleted. See,</td>
</tr>
</tbody>
</table>
**Workaround**

<table>
<thead>
<tr>
<th>Verify customizations</th>
<th>Related information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The Software Counter results are highly dependent on State, Sub-State or Boolean flags like Cached for many of entities such as, Software Licenses, Software Installations, etc. If you have customized any such fields to change its out-of-the-box value, then it may affect the counter results. For example, Software Counter is highly dependent on Software License State; it only considers Software Licenses with In Use state. Any customizations to the State choice list values affects the Software Counter results. See,</td>
</tr>
</tbody>
</table>

---

**Tuning Software Counter**

The performance of the Software Counter depends on the amount of data that is processed. The Software Counter processes the entire data only for first time and then processes only the delta for subsequent runs. This is a long operation and is executed using scheduled job. You can choose not to generate details for counters to improve the performance.

If you have a big install base, you can disable the Generate Details option for counters. This way the reconciliation will still happen but counter specific details are not dumped.

**IBM PVU Process Pack**

Processor Value Unit (PVU) is a unit of measurement defined by IBM to determine software licensing costs based on processor or server model.

A processor is defined as each core on a socket. Each software package has a price defined as number of points or PVUs per core. For a complete explanation of IBM PVU licensing for distributed software, see [Processor Value Unit (PVU) licensing for Distributed Software](https://www.ibm.com) on the IBM website.

In the ServiceNow platform, the concept of PVU is used in the Software Asset Management plugin IBM PVU Process Pack, which is an add-on to the Software Asset Management plugin feature. It provides the ability to manage software licensed under the IBM Processor Value Units licensing model.

The Software Asset Management plugin Processor Definition Extension is automatically activated when the Software Asset Management plugin IBM PVU Process Pack is activated. It provides data model support for processor definitions and is required by all Software Asset Management plugin process packs.

**Note:** Oracle and Microsoft also use the concept of PVU, but have slightly different definitions.

**Activate the IBM PVU Process Pack**

You can activate the Software Asset Management plugin - IBM PVU Process Pack plugin.

Role required: admin

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.

4. Click **Activate**.

### Requirements to associate a software installation to PVU mapping

Meeting recommended requirements ensures that you receive the highest quality results with PVU mapping.

1. Use a discovery tool, such as ServiceNow Discovery, to identify hardware and populate the configuration management database (CMDB) with the configuration items you want to manage with IBM PVU licensing.
2. Use a discovery tool, such as ServiceNow Discovery, to identify software installations. Check that the added CPU information is correct.
3. **Activate** the Software Asset Management plugin - IBM PVU Process Pack plugin. This also activates Software Asset Management plugin if it is not already active.
4. **Refresh processor definitions**.
5. Ensure that the **software models** you want to manage with IBM PVU licensing have the correct license type: **Per installation - IBM PVU**.
6. **Create software counters** to calculate IBM PVU licenses.
7. Count licenses to determine compliance with IBM PVU guidelines.

### IBM PVU mapping preparation

Most IBM PVU mapping and license checking in the ServiceNow platform is managed automatically.

For the automatic calculations to be as accurate as possible, it is important that configuration item and software model information be accurate.

The important fields describing the processor on the configuration item form are:

- CPU type
- CPU count
- CPU core count
Figure 10: PVU configuration item

This CPU data is often added accurately when the CMDB is populated with information. If the fields contain incorrect information, manually edit the fields on the configuration item form.

The mapping between the configuration item form fields and processor definition fields is as follows.
Table 37: Preparing for IBM PVU mapping

<table>
<thead>
<tr>
<th>Configuration Item Form Field</th>
<th>Processor Definition Form Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU type</td>
<td>Processor name, Server model number, and Processor model number</td>
<td>Combination of processor name, server model number, and processor model number. The CPU type field is created as part of the general process described in Populating the CMDB. Some discovery tools fill in the CPU name instead of CPU type. If the CPU type field is empty, the CPU name field is used for mapping instead. (You can configure the form to display the CPU name, if needed.) If the CPU type field and the CPU name field are both empty, no mapping is done.</td>
</tr>
<tr>
<td>CPU count</td>
<td>Number of sockets</td>
<td>Number of sockets.</td>
</tr>
<tr>
<td>CPU core count</td>
<td>Cores per socket</td>
<td>Cores per socket.</td>
</tr>
</tbody>
</table>

The key field on the Software Model form is License type. For any software licenses you want to track with IBM PVU, open the corresponding software model form and select the **Per installation - IBM PVU** license type.
Refresh processor definitions

After activating the Software Asset Management plugin IBM PVU Process Pack, use the Refresh Processor Definitions module in the Software Asset Management plugin feature to create process definitions for existing computers in the Computer [cmdb_ci_computer] table.

Role required: sam

After this step, software asset business rules update the Processor Definition [CMDB_processor_definition] table automatically when changes are made to computers or when new computers are added. You should
not need to use the Refresh Processor Definitions module a second time, but it is always available if you make significant changes to the Computer [cmdb_ci_computer] table.

1. Navigate to **Software Asset > System > Refresh Processor Definitions**.
2. Click **Proceed**.

**Processor definitions**

Processor definitions are automatically derived from the information in the configuration item form for an item such as a computer or server.

To view a processor definition, navigate to **Software Asset > Reconciliation > Processor Definitions** and click an item.

![Processor Definition](image)

**Figure 12: SAM processor definition**

The following read-only fields are listed.

**Table 38: Processor definitions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the processor as it should appear in the processor list.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Company that built the processor.</td>
</tr>
<tr>
<td>Server model number</td>
<td>Number assigned to the model by the server manufacturer.</td>
</tr>
<tr>
<td>Number of sockets</td>
<td>Number of dies on the computer motherboard. The number of CPUs per die is specified by <strong>Cores per socket</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IBM PVU Mapping</td>
<td>The IBM PVU mapping to which this processor is associated. The information in this field is automatically calculated from the server model number, number of sockets, processor name, and processor model number, based on the rules defined in the IBM PVU Table.</td>
</tr>
<tr>
<td>Processor name</td>
<td>Name assigned to the processor by the manufacturer.</td>
</tr>
<tr>
<td>Processor model number</td>
<td>Number assigned to the model by the processor manufacturer.</td>
</tr>
<tr>
<td>Cores per socket</td>
<td>Number of cores (functional unit needed to execute programs) on each physical connection (socket) on the motherboard.</td>
</tr>
<tr>
<td>Match level</td>
<td>Accuracy level of the association between processor and PVU mapping. Automatically set when association is inferred.</td>
</tr>
</tbody>
</table>

View IBM PVU mappings

Every rule listed in the IBM PVU Table is represented by one PVU mapping record in the ServiceNow Software Asset Management plugin feature.

Role required: sam

For example, in the IBM PVU Table there is one line with processor name POWER5 QCM and in IBM PVU mappings there is a line representing POWER5 QCM.
1. Navigate to **Software Asset > Reconciliation > IBM PVU Mappings**.
2. Click a **Short Description** for detailed information about the mapping.
The fields are for information only and cannot be edited.

**Table 39: IBM PVU mappings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor names</td>
<td>Names of running processors. Processor names are separated by commas.</td>
</tr>
<tr>
<td>Model-based condition</td>
<td>Regular expression used to determine whether the server model number of a</td>
</tr>
<tr>
<td></td>
<td>computer's processor definition matches that of the PVU entry.</td>
</tr>
<tr>
<td>Socket-based condition</td>
<td>Regular expression used to determine whether the number of sockets of a</td>
</tr>
<tr>
<td></td>
<td>computer's processor definition matches that of the PVU entry.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description of this PVU mapping.</td>
</tr>
<tr>
<td>PVUs per core</td>
<td>Number of processor value units consumed (according to the IBM PVU chart)</td>
</tr>
<tr>
<td></td>
<td>by each core.</td>
</tr>
<tr>
<td>Max cores</td>
<td>Maximum number of cores on the processor family, as shown in the IBM PVU</td>
</tr>
<tr>
<td></td>
<td>Table (rightmost column under cores per socket).</td>
</tr>
<tr>
<td>Rule publication date</td>
<td>Date published by IBM on the PVU Rules table.</td>
</tr>
</tbody>
</table>
Use software counters to calculate IBM PVU licenses

To calculate IBM PVU licenses, you can create a software counter with the IBM PVU license type. For a given PVU software package, you only need to create the counter once and then it can be reused.

Role required: sam

Processor definitions are searched as licenses are counted. If a processor definition is found, but no PVU mapping link exists for the processor, the system automatically does the following to obtain a PVU mapping link.

- Pre-filtering based on processor name.
- Advanced filtering based on PVU mapping records' condition field.
- If no exact match is found, the most expensive mapping is used to increase the chance of being compliant.

1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Click New.
3. Enter a Name.
4. Select a Software Model.
5. Select a level of adherence to the license in the Enforce to field.
6. For License type, select Per Installation - IBM PVU.

7. Add information to other fields as necessary.
8. Right-click the header bar and select Save.
9. Click Count licenses.
10. In the **Software Counter Results** list, drill down to obtain summary and detailed information.
Installed with Software Asset Management plugin IBM PVU Process Pack

The following tables, fields, script includes, and business rules are installed with the Software Asset Management plugin IBM PVU process pack.
Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition [cmdb_processor_definition]</td>
<td>Each row in this table describes a computer in terms of the attributes IBM uses for its PVU licensing model. A row can be associated with one or more (if they are all identical in terms of the attributes used for PVU licensing) discovered computers.</td>
</tr>
</tbody>
</table>

Script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessorDefinitionsUtils</td>
<td>Contains utilities for managing the Processor Definition [cmdb_processor_definition] table.</td>
</tr>
<tr>
<td>ProcessorValueUnitsUtils</td>
<td>Contains logic that determines the IBM PVU pricing associated with a given processor.</td>
</tr>
</tbody>
</table>

Business Rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One and only one default mapping [sam_ibm_pvu_mapping]</td>
<td>Ensures only one default mapping by resetting the last resort flag for modified records and setting it to false for new records.</td>
</tr>
</tbody>
</table>

Software contracts

A software contract is a binding agreement between the owner of a software product and a buyer. The contract enables the buyer to use the software legally.

In the ServiceNow ITSA Suite, you can manage and track software contracts with the Contract Management application. When you create a new software contract, you can specify that the contract is an enterprise or subscription license.

View software contracts

You can view a list of created software contracts.

Role required: contract_manager

1. Navigate to Contract > Software License.
2. Click a contract number to view its details.

Create software contracts

You can create a binding agreement that enables the buyer to legally use the software.
Role required: contract_manager

1. Navigate to **Contract > Software License**.
2. Click **New**.
3. Complete the form.
4. Add the software license to the contract.
   
   Be sure to use the **Software License** option. The **License Bundle** and **Software License Contracts** options are deprecated.

**Oracle process pack**

The Oracle process pack is an add-on to Software Asset Management plugin that provides the ability to manage software licensed under the Oracle licensing model.

Administrators can use this feature to perform the following functions.

- Identify the software packs installed on Oracle database servers.
- See the software packs that are currently in use.
- List which options are installed and in use.

**Oracle software counter**

There are two distinct ways of counting Oracle software. Be sure that your Oracle models are set up accurately.

---

**Note:** Oracle license calculation types are available in the Software Counter form after you activate the Oracle process pack.

---

Oracle software that uses the **Oracle Processor** license calculation type counts by the number of processors on a server. This license calculation type must exist in the Software Installation [cmdb_sam_sw_install] table. A software installation record must be inserted with a discovery model that matches the correct Oracle software. For an install to be counted by an Oracle processor counter, the **Installed on** field on the Software Installation form should reference a configuration item with a **Metric type** of **Oracle Processor**.

Oracle software that uses the **Oracle Named User** or **Oracle Named User Plus** license calculation types count by number of unique users or number of unique users plus devices. This license calculation type must exist in the Software Usage [cmdb_sam_sw_usage] table. A software installation record must be inserted with a discovery model that matches the correct Oracle software. For a usage to be counted by an Oracle New User or Oracle New User Plus counter, the **Target host** field on the Software Usage [cmdb_sam_sw_usage] table should reference a configuration item with a **Metric type** of **Oracle NU** or **Oracle NUP**.

**Oracle software models**

In order to count Oracle software licenses, you must create software models for your Oracle software.

For more information, see **Manage software models**.

**Activate the Software Asset Management plugin Oracle Process Pack**

You can activate the Software Asset Management plugin - Oracle Process Pack (com.snc.sam.oracle.pp) plugin.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.
If the plugin depends on other plugins, these plugins are listed along with their activation status.

3. Optional: If available, select the Load demo data check box.

Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.

4. Click Activate.

Installed with the Oracle Process Pack

Activating the Oracle Process Pack plugin adds certain components.

The information from this table appears in the Software Counter Compliance Violations section of the Software Model form.

Table 40: Software counter compliance violations table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Software Counter Compliance Violations [sam_sw_counter_violation] | Used to store counter violations that are due to violations other than installs exceeding rights, such as:  
  - Maximum CPU/user count exceeded (based on model limits)  
  - Maximum or minimum rights rules not followed (based on model limits)  
  - Option installed on a server with a non-option-supporting license (Oracle) |

Table 41: Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter [counter]</td>
<td>Software Counter Compliance Violations [sam_sw_counter_violation]</td>
<td>References the software counter that this violation belongs to. (Reference field to Software Counter table [sam_sw_counter].)</td>
</tr>
<tr>
<td>Is an option (is_option)</td>
<td>Software Model [cmdb_software_product_model]</td>
<td>Indicates if the software model is an option or pack for some other software, such as Active Data Guard or Data Mining options for Oracle Enterprise Edition. This field only appears if the manufacturer is Oracle.</td>
</tr>
<tr>
<td>Field</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>License metric (metric_type)</td>
<td>Software License [alm_license]</td>
<td>A glide list reference to the License Calculation [cmdb_sw_license_calculation] table. This list contains all of the license calculations that apply to this license and identifies the preferred metric types to use when running software counters.</td>
</tr>
<tr>
<td>License metric (metric_type)</td>
<td>Hardware [cmdb_ci_hardware]</td>
<td>A glide list reference to the License Calculation [cmdb_sw_license_calculation] table. This list contains all of the license calculations that apply to this license and identifies the preferred metric types to use when running software counters. This field does not appear on the form by default.</td>
</tr>
</tbody>
</table>

The Oracle Process Pack adds the following license calculation types.

**Table 42: Oracle license calculation types**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Named User</td>
<td>Oracle licensing scheme that counts by the number of unique users.</td>
</tr>
<tr>
<td>Oracle Named User Plus</td>
<td>Oracle licensing scheme that counts by the number of unique users and devices.</td>
</tr>
<tr>
<td>Oracle Processor</td>
<td>Oracle licensing scheme that counts by the number of processors on a server.</td>
</tr>
</tbody>
</table>

Create an Oracle software license

To use the Oracle process pack, you must create an Oracle software license.

Role required: sam

1. Navigate to **Software Asset > Software Licenses**.
2. Click **New**.
3. Select **Software License** in the **Model category** field.
4. Select an Oracle model in the **Model** field.
   - The Oracle models in this list are created by the user. For more information, see [Manage software models](#).
5. Ensure that the **License metric** field specifies the correct license calculation type.
6. Fill in the remaining fields, as appropriate.
7. Click **Submit**.
Validate the requirements to associate a software installation to Oracle mapping

Meeting recommended requirements ensures that you receive the highest quality results with Oracle mapping.

1. Use a discovery tool (such as ServiceNow Discovery) to identify software installations. Check that the added CPU information is correct.
2. **Activate the Software Asset Management plugin Oracle Process Pack** on page 144. This also activates Software Asset Management plugin if it is not already active.
3. Refresh processor definitions by navigating to Software Asset > System and clicking Refresh Processor Definitions.
4. Ensure that the software models you want to manage with Oracle licensing are set up accurately. See **Creating a software model**.
5. **Create a software license** for your Oracle software. Ensure that the license is given the correct license metric.
   - The License metric (metric_type) field on the Software License table is a reference field to the License Calculation table.
6. **Create a software counter** to calculate Oracle licenses with the matching license type.
7. Count licenses to determine compliance with Oracle guidelines.

Run the Oracle software counter

Running the Oracle software counter is a requirement to associate a software installation to Oracle mapping.

Role required: sam

1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Click the name of the counter.
3. Click Count Licenses.

Organization Management

The Organization Management application provides an easy way to perform such asset management tasks as updating users and adding vendors.

It includes managing your vendors and manufacturers, as well as managing locations.

Create a new vendor or manufacturer

You can create a new vendor, which is a company that sells assets or services that your organization purchases. You can also create a new manufacturer, which is a company that builds assets that your organization purchases.

Role required: user_admin

1. Navigate to one of the following:
   - Organization > Vendors
   - Organization > Manufacturers
   - Organization > Companies
2. Switch to the Default view.
3. Click New in the record list.
4. Complete the form and select either Manufacturer or Vendor.
5. Click Submit.

Locations module

The Locations module is the Asset view of the Location table [cmn_location].

In addition to the physical specifics for the location, the Asset view includes the Stock room designation and a list of configuration items (CI) in stock at that location.
Figure 14: Asset location

Change Management

The ServiceNow® Change Management application provides a systematic approach to control the life cycle of all changes, facilitating beneficial changes to be made with minimum disruption to IT services.

**Explore**
- Change Management release notes
- Upgrade to Geneva
- Change types on page 150
- State model and transitions on page 179
- Standard change catalog on page 204

**Set up**
- Activate change management plugins on page 151
- Change properties on page 169

**Administer**
- Configure change management on page 169
- Configure ability to copy a change request on page 171
- Configure the standard change catalog on page 205
- Create blackout and maintenance schedules for implementing changes on page 209
- Add a new change type on page 175
Use
- Create a change request on page 222
- Associated CIs on a change request on page 217
- Process a change request on page 236
- Analyze risk of change and detect conflicts on page 231

Troubleshoot and get help
- Ask or answer questions in the Change Management community
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Support

Develop
- Developer training
- Developer documentation
- Installed with change management core on page 152

Migrate
- Migrate Change Management from releases prior to Geneva on page 151

Change types
Change Management offers ITIL-aligned processes for normal, standard, and emergency change types.

Normal change
Normal change follows the complete change lifecycle including peer or technical approval, change management, and Change Advisory Board (CAB) authorization before being implemented, reviewed, and closed.

Standard change
Standard changes are often considered routine. This is a change that is frequently implemented, has repeatable implementation steps, is considered low risk, and has a proven history of success. Standard changes are considered pre-approved and follow a shorter lifecycle omitting the peer approval and CAB authorization steps. They proceed directly into a scheduled change ready for implementation. Standard changes can be stored in a catalog of templates approved by Change Management to make the process of raising them more efficient. This also enables Change Management to control the changes they have authorized as standard.

Emergency change
Emergency changes cover both fix on fail or retroactive situations where the impact to service has already been experienced, and fail or fail situations where the impact to service is imminent if action is not taken. These changes do not follow the complete lifecycle of a normal change due to the speed with which they must be authorized.
Migrate Change Management from releases prior to Geneva

Prior to Geneva, Change Request installed the following plugins by default:

- Conflict Detection
- Best Practice Change Risk Calculator
- Change Risk Assessment
- Bulk CI changes

From Geneva onwards, new instances will have the Change Management core plugin installed by default. This installs the following new plugins in addition to the Conflict Detection, Best Practice Change Risk Calculator, and Change Risk Assessment plugins.

- Standard change catalog
- State Model
- Mass updates CI

If you are upgrading from a release prior to Geneva, you can choose to activate Change Management core, State Model, Standard change catalog, and Mass updates CI plugins. The State Model, and Standard change catalog plugins are dependent on the Change Management core plugin. Hence, activating either the State model or the Standard change catalog plugins results in the activation of the Change Management core plugin.

You must also consider the following consequences of activating Change Management core and the subsequent changes you might need to make to best suit your organization's requirements:

- The previous change types will be updated from routine, comprehensive, and emergency to standard, normal, and emergency respectively. You must analyze customizations that you may have performed that reference old change type values since those will be affected and will require updating.

  Note: When Change management core is activated, the change types will be updated.

If you have already completed upgrading from a release prior to Geneva, you must perform the following tasks after you activate Change management core to ensure that change types and customizations are updated.

- If you had created newer change types in addition to the default change types, then you must customize them based on the new change types being introduced.
- Modify the customizations that are affected to use the new change type values.
- A new ACL, change_request.type, prevents users from updating the change type. If you allow any roles to update the type of a change request, for example, from Normal to Emergency, modify the ACL. Remove nobody from the Requires role list and add the roles allowed to update the change type.
- If you had the Bulk CI plugin installed, then install the Mass updates CI plugin for enhanced user experience and alignment with the new plugins.

Activate change management plugins

You can activate one or more of the Change Management plugins if you have the admin role. The plugins include demo data and activate related plugins if they are not already active.
Role required: admin

You can activate one or more of the following Change Management plugins.

Activate change management core

You can activate the Change Management plugin (com.snc.change_management) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin
1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

You can activate one or more of the following plugins:

- State model
- Change Management - Collision Detector
- Best practice - change risk calculator
- Change risk assessment
- Standard change catalog
- Best practice - bulk CI changes

You can now configure Change Management.

Installed with change management core

Several types of components are installed with the Change management core.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task CI</td>
<td>Adds Manual Proposed Change (manual_proposed_change) field if the proposed change has been made manually rather than through the Mass Update CI feature</td>
</tr>
</tbody>
</table>

Activate the state model

You can activate the Change Management - State Model plugin (com.snc.change_management.state_model) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Change Management - State Model activates the following related plugin if it is not already active.
Table 43: Plugins for Standard Change Catalog

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core</td>
<td>Change management is used to create and manage change requests. Once this is activated, it will update the values for the Type field on the change request.</td>
</tr>
</tbody>
</table>

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

You can now configure Change Management.

State model post-activation tasks

If you upgraded from a release prior to Geneva, you must update old state labels to new state labels after you activate the Change Management state model.

State values for current change records are not modified when you activate the Change Management state model. However, your current change records will display the new state labels in the state field.

<table>
<thead>
<tr>
<th>State value</th>
<th>New state label</th>
<th>Old state label</th>
</tr>
</thead>
<tbody>
<tr>
<td>-5</td>
<td>New</td>
<td>Pending</td>
</tr>
<tr>
<td>-4</td>
<td>Assess</td>
<td>(Not used)</td>
</tr>
<tr>
<td>-3</td>
<td>Authorize</td>
<td>(Not used)</td>
</tr>
<tr>
<td>-2</td>
<td>Scheduled</td>
<td>(Not used)</td>
</tr>
<tr>
<td>-1</td>
<td>Implement</td>
<td>(Not used)</td>
</tr>
<tr>
<td>0</td>
<td>Review</td>
<td>(Not used)</td>
</tr>
<tr>
<td>1</td>
<td>(Not used)</td>
<td>Open</td>
</tr>
<tr>
<td>2</td>
<td>(Not used)</td>
<td>Work in Progress</td>
</tr>
<tr>
<td>3</td>
<td>Closed</td>
<td>Closed Complete</td>
</tr>
<tr>
<td>4</td>
<td>Canceled</td>
<td>Closed Incomplete</td>
</tr>
<tr>
<td>7</td>
<td>(Not used)</td>
<td>Closed Skipped</td>
</tr>
</tbody>
</table>

For example, records with a state value of -5 have the Pending state label before the Change Management state model is activated. After the state model is activated, these records retain the state value of -5 but will have the New label. To use your organization’s required change management process with the state model, you must update state values to the new labels in your existing change records as appropriate, either manually or by script.
You must also update any reports that run queries based on old state labels to reflect the new state labels.

To automatically update the state field values from old state labels to new state labels, customize and then run the following sample script:

```javascript
updateStates();

function updateStates() {

    function hasApprovers(changeGr) {
        var approverGr = new GlideRecord("sysapproval_approver");
        approverGr.addQuery('sysapproval', changeGr.getUniqueValue());
        approverGr.query();
        return approverGr.getRowCount() > 0;
    }

    function hasRunningWorkflows(changeGr) {
        var workflow = new Workflow();
        var workflowGr = workflow.getRunningFlows(changeGr);
        var hasRunningFlows = workflowGr.getRowCount() > 0;
        return hasRunningFlows;
    }

    // Old State Model
    var PENDING = '-5';
    var OPEN = '1';
    var CLOSED_COMPLETE = '3';
    var CLOSED_INCOMPLETE = '4';
    var CLOSED_SKIPPED = '7';

    // New State Model
    var NEW = '-5';
    var ASSESS = '-4';
    var AUTHORIZE = '-3';
    var SCHEDULED = '-2';
    var IMPLEMENT = '-1';
    var REVIEW = '0';
    var CLOSED = '3';
    var CANCELLED = '4';

    // Find all change requests
    var record = new GlideRecord('change_request');
    record.query();

    // Update state from old value to new value
    while (record.next()) {
        switch(record.getValue('state')) {
            case OPEN:
                if (!hasRunningWorkflows(record) && !hasApprovers(record))
                    record.state = NEW;
                break;
            case CLOSED_COMPLETE:
                record.state = CLOSED;
                record.close_code = "successful";
                break;
            case CLOSED_SKIPPED:
                record.state = CANCELLED;
                record.close_code = "unsuccessful";
                break;
            case CLOSED_INCOMPLETE:
                record.state = CLOSED;
                record.close_code = "successful_issues";
                break;
        }
    }
}
```
Installed with state model

Several types of components are installed with the Change Management state model.

Properties installed with state model

The Change Management state model adds the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.change_request_activity.fields</td>
<td>Change request activity formatter fields.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: assigned_to, cmdb_ci, state, impact, priority, opened_by, work_notes</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.change_management.core.log</td>
<td>Controls the level at which logging should be displayed.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: debug</td>
</tr>
<tr>
<td></td>
<td>• Other possible values:</td>
</tr>
<tr>
<td></td>
<td>• info</td>
</tr>
<tr>
<td></td>
<td>• warn</td>
</tr>
<tr>
<td></td>
<td>• error</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

Note: To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

Business rules installed with state model

The Change Management state model adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scratchpad Variables from parent Change</td>
<td>Change Task</td>
<td>Sets a flag in the Scratch Pad to indicate if the change task has a change request that is on hold.</td>
</tr>
<tr>
<td>mark_closed</td>
<td>Change Request</td>
<td>Sets a change request to inactive depending on the current state.</td>
</tr>
</tbody>
</table>
### Business rule

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel approvals when Change is on hold</td>
<td>Change Request</td>
<td>Cancels all approvals if the change request is put on hold.</td>
</tr>
<tr>
<td></td>
<td>[change_request]</td>
<td></td>
</tr>
</tbody>
</table>

### Client scripts installed with state model

The Change Management state model adds the following client scripts.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide On hold for certain states</td>
<td>Change Request</td>
<td>Hides the On hold field if the state was New, Closed, or Canceled when the</td>
</tr>
<tr>
<td></td>
<td>[change_request]</td>
<td>Change Request form was loaded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field message for State field</td>
<td>Change Task</td>
<td>Adds a field message to the state field under certain conditions such as</td>
</tr>
<tr>
<td></td>
<td>[change_task]</td>
<td>when the change is on hold.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show valid states values</td>
<td>Change Request</td>
<td>Changes the state field to only display the current state and the next</td>
</tr>
<tr>
<td></td>
<td>[change_request]</td>
<td>valid state for the change request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show On hold reason when on hold ticked</td>
<td>Change Request</td>
<td>Makes the On hold reason field mandatory if the option to show the on hold</td>
</tr>
<tr>
<td></td>
<td>[change_request]</td>
<td>reason is selected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Tables installed with state model

The Change Management model adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request [change_request]</td>
<td>List of change requests.</td>
</tr>
</tbody>
</table>

### Script includes installed with state model

The Change Management state model adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChangeRequest</td>
<td>Change request API. Provides an abstraction from the legacy and new change</td>
</tr>
<tr>
<td></td>
<td>types and state models.</td>
</tr>
<tr>
<td>ChangeRequestStateHandlerSNC</td>
<td>Base state handler implementation extended by ChangeRequestStateHandler.</td>
</tr>
<tr>
<td>ChangeRequestStateHandler</td>
<td>Transition between states. Uses one of the defined models to determine</td>
</tr>
<tr>
<td></td>
<td>which transitions are allowed.</td>
</tr>
</tbody>
</table>
### Script include

<table>
<thead>
<tr>
<th>Description</th>
<th>Script include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended by ChangeRequestStateModel_emergency</td>
<td>ChangeRequestStateModelSNC_emergency</td>
</tr>
<tr>
<td>State model for emergency changes.</td>
<td>ChangeRequestStateModel_emergency</td>
</tr>
<tr>
<td>Extended by ChangeRequestStateModel_standard</td>
<td>ChangeRequestStateModelSNC_standard</td>
</tr>
<tr>
<td>State model for standard changes.</td>
<td>ChangeRequestStateModel_standard</td>
</tr>
<tr>
<td>Extended by ChangeRequestStateModel_normal</td>
<td>ChangeRequestStateModel_normal</td>
</tr>
<tr>
<td>State model for normal changes.</td>
<td>ChangeRequestStateModel_normal</td>
</tr>
<tr>
<td>Base client API extended by ChangeRequestStateHandlerAjax.</td>
<td>ChangeRequestStateHandlerAjaxSNC</td>
</tr>
<tr>
<td>Client-callable API for ChangeRequestStateHandler.</td>
<td>ChangeRequestStateHandlerAjax</td>
</tr>
</tbody>
</table>

### Activate conflict detection

You can activate the Conflict Detection plugin (com.snc.change.collision) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.
   
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the **Load demo data** check box.
   
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click **Activate**.

You can now configure Change Management.

### Installed with conflict detection

Several types of components are installed with conflict detection.

**Properties installed with conflict detection**

Conflict detection adds the following properties.

---

**Note**: To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>change.conflict.mode</td>
<td>CI conflict check mode:</td>
</tr>
<tr>
<td></td>
<td>• Basic mode: When enabled, only checks only the current change request's CI against other change requests' CI and affected CIs.</td>
</tr>
<tr>
<td></td>
<td>• Advanced Mode: When enabled, checks both the current change request's CI and affected CIs against other change requests' CI and affected CIs.</td>
</tr>
<tr>
<td>change.conflict.refresh.conflicts</td>
<td>Run conflict detection automatically after changes to Configuration item, Planned start date, Planned end date or State when a change request is updated</td>
</tr>
<tr>
<td>change.conflict.relatedchildwindow</td>
<td>When checking change request conflicts, check whether the change falls within child CIs' maintenance windows</td>
</tr>
<tr>
<td>change.conflict.relatedparentwindow</td>
<td>When checking change request conflicts, check whether the change falls within parent CIs' maintenance windows</td>
</tr>
<tr>
<td>change.conflict.currentwindow</td>
<td>When checking change request conflicts, check whether the change falls within the CI's maintenance window</td>
</tr>
<tr>
<td>change.conflict.currentci</td>
<td>When checking change request conflicts, check against changes already scheduled for the same CI</td>
</tr>
<tr>
<td>change.conflict.blackout</td>
<td>When checking change request conflicts, check against blackout windows</td>
</tr>
<tr>
<td>change.conflict.role</td>
<td>A comma separated list of roles which have access to the conflict detection feature. Roles included here should have access to the underlying change_request record</td>
</tr>
</tbody>
</table>

**Business rules installed with conflict detection**

Conflict detection adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add CI in affected CIs List</td>
<td>Change Request [change_request]</td>
<td>Ensures that the configuration item (CI) is added to the Affected CIs list if the conflict mode is set to advanced.</td>
</tr>
<tr>
<td>Cancel Conflict Detection</td>
<td>Change Request [change_request]</td>
<td>Cancels conflict detection background job if any of Planned Start, Planned End, or Configuration Item fields are updated.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear Conflicts</td>
<td>Change Request [change_request]</td>
<td>Removes any conflict records related to a change request and resets the <strong>Conflict Status</strong> and <strong>Conflict Status</strong> fields. It also resets the <strong>Conflict Status</strong> and <strong>Conflict Status</strong> fields of related changes if removal of conflict records results in no conflict records for those related change requests.</td>
</tr>
<tr>
<td>Set Conflict Status</td>
<td>Change Request [change_request]</td>
<td>Ensures that the <strong>Conflict Status</strong> field is set to <strong>Not run</strong> for new change requests.</td>
</tr>
<tr>
<td>Sync Blackout Window Span</td>
<td>Schedule Entry [cmn_schedule_span]</td>
<td>Creates an entry in the current update set if a blackout window span is inserted, updated, or deleted.</td>
</tr>
<tr>
<td>Update Conflicts</td>
<td>Change Request [change_request]</td>
<td>Determines if conflict checking should be run against a change request and if that is the case, initiates conflict detection in background.</td>
</tr>
</tbody>
</table>

**Client scripts installed with conflict detection**

Conflict detection adds the following client scripts.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Conflict</td>
<td>Client Script [sys_script_client]</td>
<td>Displays a message on the <strong>Conflict status</strong> field when conflicts have been detected.</td>
</tr>
<tr>
<td>Run Conflict Detection</td>
<td>Client Script [sys_script_client]</td>
<td>Runs conflict detection if the URL of the change record that is loaded contains the sysparm_run_conflict_detection=true parameter.</td>
</tr>
<tr>
<td>Show Applies to messages</td>
<td>Maintenance Schedule [cmn_schedule_maintenance]</td>
<td>Displays an information message when <strong>None</strong> is selected in the <strong>Applies to</strong> field.</td>
</tr>
<tr>
<td>Show Applies to messages</td>
<td>Blackout Schedule [cmn_schedule_blackout]</td>
<td>Displays an information message when <strong>None</strong> is selected in the <strong>Applies to</strong> field.</td>
</tr>
</tbody>
</table>

**Tables installed with conflict detection**

Conflict detection adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request [change_request]</td>
<td>Represents a change request</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Description</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Represents a blackout schedule</td>
<td>Blackout Schedule [cmn_schedule_blackout]</td>
</tr>
<tr>
<td>Represents a schedule condition</td>
<td>Condition Schedule [cmn_schedule_condition]</td>
</tr>
<tr>
<td>Represents a maintenance schedule</td>
<td>Maintenance Schedule [cmn_schedule_maintenance]</td>
</tr>
</tbody>
</table>

### Script includes installed with conflict detection

Conflict detection adds the following script includes.

<table>
<thead>
<tr>
<th>Description</th>
<th>Script include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helper methods for the Conflict Detection plugin (com.snc.change.collision)</td>
<td>ChangeCollisionHelper</td>
</tr>
<tr>
<td>Used to initiate the conflict checker in a background job.</td>
<td>ChangeConflictWorker</td>
</tr>
<tr>
<td>Contains the class methods for Collision Detection.</td>
<td>ChangeCheckConflicts</td>
</tr>
<tr>
<td>Class that holds a change conflict's com.snc.change.collision plugin.</td>
<td>ChangeConflict</td>
</tr>
<tr>
<td>Methods to support executing conflict detection from the Change Request form.</td>
<td>ChangeConflictAJAXProcessor</td>
</tr>
<tr>
<td>Class for the change conflict package.</td>
<td>ChangeConflictHandler</td>
</tr>
<tr>
<td>Contains base class methods for Conflict Detection.</td>
<td>ChangeCheckConflictsSNC</td>
</tr>
</tbody>
</table>

### Activate best practice change risk calculator

You can activate the Best Practice- Change Risk Calculator plugin (com.snc.bestpractice.change_risk) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
   
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

You can define risk and impact conditions for your change records.

### Installed with change risk calculator

Several types of components are installed with the Best Practice- Change Risk Calculator.
Properties installed with change risk calculator
Best Practice- Change Risk Calculator adds the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.risk_calculate_rule</td>
<td>Change risk calculation method.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: ui_action</td>
</tr>
<tr>
<td></td>
<td>• Other possible values:</td>
</tr>
<tr>
<td></td>
<td>• none: None</td>
</tr>
<tr>
<td></td>
<td>• business_rule: Business Rule</td>
</tr>
<tr>
<td></td>
<td>• ui_action: UI Action</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

Business rules installed with change risk calculator
Best Practice- Change Risk Calculator adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Risk</td>
<td>Change request</td>
<td>Calculates the risk associated with a change request.</td>
</tr>
<tr>
<td></td>
<td>[change_request]</td>
<td></td>
</tr>
</tbody>
</table>

Tables installed with change risk calculator
Best Practice- Change Risk Calculator adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request</td>
<td>List of change requests.</td>
</tr>
<tr>
<td>[change_request]</td>
<td></td>
</tr>
</tbody>
</table>

Script includes installed with change risk calculator
Best Practice- Change Risk Calculator adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RiskCalculator</td>
<td>Calculates a change request's risk and impact based on defined risk conditions.</td>
</tr>
</tbody>
</table>

Activate change risk assessment
You can activate the Change Management - Risk Assessment plugin (com.snc.change.risk_assessment) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.
Role required: admin

Change Management - Risk Assessment activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Table 44: Plugins for Change Management - Risk Assessment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin</td>
</tr>
<tr>
<td>Assessment Components [com.snc.assessment]</td>
</tr>
<tr>
<td>Best Practice - Change Risk Calculator</td>
</tr>
<tr>
<td>Best Practice - Task Survey Management</td>
</tr>
</tbody>
</table>

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

You can define risk assessment conditions for change requests.

Installed with risk assessment

Several types of components are installed with the Risk Assessment.
Business rules installed with change risk assessment
Change risk assessment adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Risk Calculation</td>
<td>Change request [change_request]</td>
<td>Performs risk assessment when the specified conditions are met.</td>
</tr>
</tbody>
</table>

Script includes installed with change risk assessment
Change risk assessment adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreateAssessment</td>
<td>Creates or associate correct existing risk assessment to the change request.</td>
</tr>
</tbody>
</table>
## Script include

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RiskAssessmentCalculator</td>
<td>Calculates and sets the risk assessment after adding all weighted scores to calculate the composite score.</td>
</tr>
</tbody>
</table>

### Tables installed with change risk assessment

Change risk assessment adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Assessment Thresholds</td>
<td>List of risk assessment thresholds.</td>
</tr>
<tr>
<td>[risk_assessment_threshold]</td>
<td></td>
</tr>
</tbody>
</table>

## Activate standard change catalog

You can activate the Standard Change Catalog plugin (com.snc.change_management.standard_change_catalog) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Role required:** admin

Standard Change Catalog activates the following related plugin if it is not already active.

### Table 45: Plugins for Standard Change Catalog

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core</td>
<td>Change management is used to create and manage change requests. Once this is activated, it will update the values for the <strong>Type</strong> field on the change request.</td>
</tr>
<tr>
<td>[com.snc.change_management]</td>
<td></td>
</tr>
</tbody>
</table>

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click **Activate**.

You can **configure the standard change catalog** or **request a new standard change** from the standard change catalog.

## Installed with standard change catalog

Several types of components are installed with the standard change catalog.

### Tables installed with standard change catalog

Standard change catalog adds the following tables.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request</td>
<td>Change request table. Adds the standard change template version.</td>
</tr>
<tr>
<td>[change_request]</td>
<td></td>
</tr>
<tr>
<td>Change producer version</td>
<td>Contains the record producer and change proposal for the standard change with the current version of the template. It also includes the number and percentage of successful and unsuccessful change requests created from the proposal.</td>
</tr>
<tr>
<td>[std_change_producer_version]</td>
<td></td>
</tr>
<tr>
<td>Standard change properties</td>
<td>List of standard change catalog properties.</td>
</tr>
<tr>
<td>[std_change_properties]</td>
<td></td>
</tr>
<tr>
<td>Standard change proposal</td>
<td>List if standard change proposals.</td>
</tr>
<tr>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Standard change record producer</td>
<td>List of standard change record producers.</td>
</tr>
<tr>
<td>[std_change_record_producer]</td>
<td></td>
</tr>
<tr>
<td>Standard change template</td>
<td>List of standard change templates.</td>
</tr>
<tr>
<td>[std_change_template]</td>
<td></td>
</tr>
</tbody>
</table>

**Properties installed with standard change catalog**

Standard change catalog adds the following properties.

**Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.approval_engine.std_change_proposal</td>
<td>Approval engine to use for the std_change_proposal table.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> String</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Other possible values:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Value 1:</strong> blank to use Approval Rules.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Value 2:</strong> process_guide to use Process Guides.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Value 3:</strong> 'off' to turn off the approval engines for the table. Set to <strong>off</strong> when using Workflow to manage approvals.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
</tbody>
</table>

**Script includes installed with standard change catalog**

Standard change catalog adds the following script includes.
Script include

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StdChangeUtils</td>
<td>Customer extensible Class of StdChangeUtilsSNC. Customers can override the public methods of StdChangeUtilsSNC for their own business needs.</td>
</tr>
<tr>
<td>StdChangeUtilsSNC</td>
<td>Contains functions that are required and used within the Standard Change Request.</td>
</tr>
</tbody>
</table>

Client scripts installed with standard change catalog

Standard change catalog adds the following client scripts.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide chart when it has no stats</td>
<td>Standard Change Template</td>
<td>If there are no statistics on the template, then the chart is not displayed.</td>
</tr>
<tr>
<td></td>
<td>Version [std_change_producer_version]</td>
<td></td>
</tr>
<tr>
<td>Warn on Close and Cancel Without Approval</td>
<td>Standard Change Proposal</td>
<td>Displays a warning message if the change is closed or cancelled without an outstanding approval associated with it.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Set template value read only</td>
<td>Standard Change Proposal</td>
<td>The values that are set in the template are set to read-only so they cannot be changed.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Mark standard change fields read only</td>
<td>Change Request [change_request]</td>
<td>The values that are set in the template are set to read-only so they cannot be changed.</td>
</tr>
<tr>
<td>Hide chart when it has no stats</td>
<td>Standard Change Template</td>
<td>If there are no statistics on the template, then the chart is not displayed.</td>
</tr>
<tr>
<td></td>
<td>[std_change_producer]</td>
<td></td>
</tr>
<tr>
<td>Disable ref expansion in field_list</td>
<td>Standard Change Properties</td>
<td>Remove the ability to expand reference fields and display the reference fields in the field list of change request values.</td>
</tr>
<tr>
<td></td>
<td>[std_change_properties]</td>
<td></td>
</tr>
<tr>
<td>Check Template Values</td>
<td>Standard Change Proposal</td>
<td>Validates that the template fields are set with valid values and that restricted fields have not been selected.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Default Values For Modify</td>
<td>Standard Change Proposal</td>
<td>Populates the default values from the template to modify the template base. These default values can then be adjusted to reflect correct values.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Fetch Mandatory &amp; Restricted Columns</td>
<td>Standard Change Proposal</td>
<td>Retrieves all default values for fields as well as the mandatory and unmodifiable fields for the change request template.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
</tbody>
</table>
### Business rules installed with standard change catalog

Standard change catalog adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Template Name</td>
<td>Standard Change Proposal</td>
<td>Sets the template name to either the short description or the name of the record producer.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Update Standard Change Version stats</td>
<td>Change Request</td>
<td>Updates the statistics of the template version when a change request is updated or deleted.</td>
</tr>
<tr>
<td></td>
<td>[change_request]</td>
<td></td>
</tr>
<tr>
<td>Validate Category</td>
<td>Standard Change Properties</td>
<td>Validates that the selected category is part of the selected catalog.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Restrict fields from Standard Change</td>
<td>Change Request</td>
<td>Checks that fields populated from the standard change proposal are not modified on the change request.</td>
</tr>
<tr>
<td></td>
<td>[change_request]</td>
<td></td>
</tr>
<tr>
<td>Validate template_value compliance</td>
<td>Standard Change Proposal</td>
<td>Validates that the values in the template are correct for the mandatory and restricted fields.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Restrict template value</td>
<td>Standard Change Proposal</td>
<td>Ensures that the template value cannot be modified for the current proposal if the proposal is closed, cancelled, or if the user does not have access to modify the template value.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Retired flag validation</td>
<td>Standard Change Template</td>
<td>Sets the active flag to false and also validates that the template cannot be republished once retired.</td>
</tr>
<tr>
<td></td>
<td>[std_change_record_producer]</td>
<td></td>
</tr>
<tr>
<td>Generate Template On Approval</td>
<td>Standard Change Proposal</td>
<td>Creates, modifies, retires the template based on the proposal once the proposal has been approved.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Make Template reference readonly</td>
<td>Standard Change Proposal</td>
<td>Validates that the template field can only be set when the proposal state is new.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Check Standard Change Setup</td>
<td>Standard Change Proposal</td>
<td>Validates that the category and catalog values are valid values to be used in the standard change properties.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Update Standard Change Catalog</td>
<td>Standard Change Properties</td>
<td>Update the module and wizard parameters to the new category the category changes to in the property.</td>
</tr>
<tr>
<td></td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Make Template to modify or retire mandatory</td>
<td>Standard Change Proposal</td>
<td>Displays a message stating that the template is required modify or retire a standard change proposal.</td>
</tr>
<tr>
<td>Make Template to modify or retire mandatory</td>
<td>[std_change_properties]</td>
<td></td>
</tr>
<tr>
<td>Stamp version name and number</td>
<td>Standard Change Template</td>
<td>Sets the name and number of the version record to be an increment of the version number.</td>
</tr>
<tr>
<td>Stamp version name and number</td>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>Stamp version name and number</td>
<td>[std_change_producer_version]</td>
<td></td>
</tr>
<tr>
<td>Check conflicts in field configurations</td>
<td>Standard Change Properties</td>
<td>Validates that fields cannot be specified in both mandatory and restricted fields.</td>
</tr>
<tr>
<td>Check conflicts in field configurations</td>
<td>[std_change_proposal]</td>
<td></td>
</tr>
</tbody>
</table>

**Email notifications installed with standard change catalog**

Standard change catalog adds the following email notifications.

<table>
<thead>
<tr>
<th>Email notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Change Proposal Request</td>
<td>Recipient of this notification is the user or group in the Approver field.</td>
</tr>
</tbody>
</table>

**Events installed with standard change catalog**

Standard change catalog adds the following events.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>std_change_proposal.approval.rejected</td>
<td>Event is raised when request for a standard change proposal has been rejected.</td>
</tr>
<tr>
<td>std_change_proposal.approval.inserted</td>
<td>Event is raised when an approval request is inserted requesting an approval of a standard change proposal.</td>
</tr>
</tbody>
</table>

**Activate best practice - bulk CI changes**

You can activate the Best Practice - Bulk CI Changes plugin (com.snc.bestpractice.bulkchange) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click **Activate**.
You can now configure Change Management.

Installed with Best Practice- Bulk CI Changes

Several types of components are installed with the Best Practice- Bulk CI Changes.

Tables installed with Best Practice - Bulk CI Changes

Best Practice - Bulk CI Changes adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[change_request]</td>
<td>Change request table.</td>
</tr>
<tr>
<td>[task_ci]</td>
<td>Adds a reference qualifier to filter the Affected CI lookup to the CI Class defined in the change request.</td>
</tr>
</tbody>
</table>

Business rules installed with Best Practice - Bulk CI Changes

Best Practice - Bulk CI Changes adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Proposed Change on Class Change</td>
<td>[change_request]</td>
<td>Runs when the ci_class field is changed. Clears the proposed change field value.</td>
</tr>
<tr>
<td>Delete Affected CIs on Class Change</td>
<td>[change_request]</td>
<td>Runs when the ci_class field is changed. Deletes task_ci records since they may no longer match the ci_class.</td>
</tr>
<tr>
<td>Deploy Proposed Changes to CIs</td>
<td>[change_request]</td>
<td>Runs on update when proposed change value changes. Copies the current proposed change from the change request to the task_ci record.</td>
</tr>
<tr>
<td>Deploy Proposed Changes to new CIs</td>
<td>[task_ci]</td>
<td>Runs on all inserts where task class is change_request. Copies the current proposed change from the change request to the task_ci record.</td>
</tr>
<tr>
<td>affectedCIClassFilter</td>
<td>[global]</td>
<td>A special global rule script called by the new attribute on the task_ci.ci_item field to filter the lookup of CIs based on the change_request.ci_class field value.</td>
</tr>
</tbody>
</table>

Client scripts installed with Best Practice - Bulk CI Changes

Best Practice - Bulk CI Changes adds the following client scripts.
<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert on Change of CI Class</td>
<td>[change_request]</td>
<td>Triggered by a change in the ci_class field. Alerts the user that the affected CIs will be deleted, then forces a form Submit so the business rules run.</td>
</tr>
</tbody>
</table>

Configure change management

You can configure various aspects of Change Management based on the specific requirements of your organization.

Role required: admin or change_manager

Configure one or more of the following aspects of Change Management.

Change properties

Administrators can use change properties to configure change management behaviour.

Navigate to Change > Administration > Change Properties to view and edit these properties.

Table 46: Change Management Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.approval_engine.change_task         | Change Request Tasks approval engine  
  • Type: choice list  
  • Default value: process_guide  
  • Location: System Property [sys_properties] table |
| glide.ui.risk_calculate_rule             | Change Risk calculation method. Business Rule calculates on insert/update, UI Action calculates only on demand. None disables this capability  
  • Type: choice list  
  • Default value: ui_action  
  • Location: System Property [sys_properties] table |
| com.snc.change_request.enable_copy       | Enable Copy Change feature  
  • Type: true | false  
  • Default value: true  
  • Location: System Property [sys_properties] table |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.change_request.copy.attributes                    | List of attributes (comma-separated) that will be copied from the originating change  
• Type: string  
• Default value: category,cmdb_ci,priority,risk,impact,type,assignment_group,assigned_to,short_description,description,change_plan,backout_plan,test_plan  
• Location: System Property [sys_properties] table                                                                              |
| com.snc.change_request.copy.related_lists                 | Related lists (comma-separated) that will be copied from the originating change  
• Type: string  
• Default value: task_ci,task_cmdb_ci_service,change_task  
• Location: System Property [sys_properties] table                                                                               |
| com.snc.change_request.attach.enable_copy                 | Enable copying of attachments from the originating change  
• Type: true | false  
• Default value: true  
• Location: System Property [sys_properties] table                                                                                                                                                                                                                                                                                                                                                                                   |

The following properties are also available for further configuration, within the sys_properties table:

### Table 47: Change Management Properties available from Sys_Properties table

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.change_request.copy.rl.change_task.attributes     | List of attributes (comma-separated) from Change Task (change_task) related list that will be copied from the originating change  
• Type: string  
• Default value: cmdb_ci,priority,assignment_group,assigned_to,short_description,description  
• Location: System Property [sys_properties] table                                                                               |
| com.snc.change_request.copy.rl.task_ci.attributes         | List of attributes (comma-separated) from Affected CIs (task_ci) related list that will be copied from the originating change  
• Type: string  
• Default value: ci_item  
• Location: System Property [sys_properties] table                                                                                                                                                                                                                                                                                                                                                                                   |
### Configure ability to copy a change request

You can configure the ability to copy a change request record and also configure the specific details that can be copied.

**Role required:** admin

You can configure the ability to copy a change. You can do the following:

- Disable the ability to copy a change
- Disable the ability to copy an attachment
- Determine the components of the source change request that must be copied

You can configure the ability to copy a change request in the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Disable the ability to copy a change request</strong></td>
<td>The ability to copy a change request is enabled by default. To disable the ability to copy a change request:</td>
</tr>
<tr>
<td></td>
<td>1. Set the <strong>Enable Copy Change feature</strong> (com.snc.change_request.enable_copy) system property to <strong>false</strong>.</td>
</tr>
<tr>
<td><strong>Disable the ability to copy an attachment</strong></td>
<td>The ability to copy an attachment to the change request is enabled by default. To disable this ability:</td>
</tr>
<tr>
<td></td>
<td>1. Set the <strong>Enable copying of attachments from the originating change</strong> (com.snc.change_request.attach.enable_copy) system property to <strong>false</strong>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Disable the ability to copy the attachments to a change task in the Change Tasks related list of a change request | The ability to copy the attachments to a change task in the Change Tasks related list of a change request is enabled by default. To disable this ability:  
  1. Set the Enable copying of attachments from the originating change's related change tasks (com.snc.change_request.rl.change_task.attach.enable_copy) system property to false. |
| Note: If the ability to copy attachments is enabled, the attachment will appear on the new change request form only after the change request is saved. |
| Configure attributes to be copied                                                        | Common attributes such as columns in the change table are copied by default. To configure the attributes to be copied:  
  1. Edit the list of values in the List of attributes (comma-separated) that will be copied from the originating change (com.snc.change_request.copy.attributes) system property to remove or add more attributes. For example, to the Assigned to attribute from being copied, remove the assigned_to value from the List of attributes (comma-separated) that will be copied from the originating change property. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Configure related lists to be copied | The following related lists in a change record are copied by default:  
  - Affected CIs  
  - Impacted Services/CIs  
  - Change Tasks  
  
  **Note:** You can configure this property to control the copy functionality of the Affected CIs, Impacted Services/CIs, and Change Tasks related lists. You cannot add any other related list to this property.  
  
  To configure the lists to be copied:  
  1. Edit the list of values in the **Related lists (comma-separated) that will be copied from the originating change** (com.snc.change_request.copy.related_lists) system property. For example, to stop copying the Change Tasks related list, remove the change_task value from the Related lists (comma-separated) that will be copied from the originating change property. |
**Configure attributes of related lists to be copied**

You can configure the attributes of related lists to be copied using appropriate system properties.

To configure the attributes of related lists to be copied:

1. Navigate to the appropriate system property for a specific related list to configure the attributes that must be copied. The property name will be `com.snc.change_request.copy.rl.<table name>.attributes`.

You can modify the following system properties to configure the attributes of related lists to be copied:

<table>
<thead>
<tr>
<th>Name of the Related List</th>
<th>System property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Tasks</td>
<td>com.snc.change_request.copy.rl.change_task.attributes</td>
</tr>
<tr>
<td>Affected CIs</td>
<td>com.snc.change_request.copy.rl.task_ci.attributes</td>
</tr>
<tr>
<td>Impacted Services/CIs</td>
<td>com.snc.change_request.copy.rl.task_cmdb_ci_service.attributes</td>
</tr>
</tbody>
</table>

**Customize the copy a change request ability**

To further customize the ability to copy a change request:

1. Modify the `ChangeUtils` script include, which extends the default `ChangeUtilsSNC` script include. For example, the ability to copy a change request is not available by default for standard changes. However, you can provide your own implementation of the `isCopyRulesValid` function in the `ChangeUtils` script include to override the default.

**Note:** You must not modify the `ChangeUtilsSNC` script include.

**Define change request assignment rules**

You can define assignment rules to automate the process of assigning change requests to the appropriate group or individual.

Role required: admin
You can define an assignment rule either for the change request on a whole, or for individual change tasks as they get generated by change requests.

1. Navigate to **System Policy > Assignment** and then click **New**.
2. Populate the fields as follows:
   - **Name** - Database Change
   - **Table** - Change Request [change_request]
   - **Group** - Database
   - **Conditions** - Dot-walk to "Configuration Item.Class is Database".

To test the assignment rule, navigate to **Change > Create New** and populate the form with the following:

- **Configuration Item** - bond trade ny (or any other Configuration Item with a class of Database.)

Save the change and add the **Assignment Group** field to the form. The proper assignment group should be added:

---

**Add a new change type**

You can add a new change type to your change process.

Role required: admin
In addition to the normal, standard, and emergency types of change available by default, you can add new change types based on your organization’s requirements. For example, you can create an Expedited change type for changes that you require to be expedited.

1. Add a new choice to the Type field.
   a) Open an existing change request.
   b) Right click on the Type field and select Show Choice List.
   c) Click New and fill in the following fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the Change Request table.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter a label for the new change type. For example, Expedited.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter a label for the new change type. For example, expedited.</td>
</tr>
<tr>
<td>Sequence</td>
<td>Enter a sequence for the change type. For example, 4.</td>
</tr>
</tbody>
</table>

d) Submit the form.

2. Add the new change type to the Change Request Interceptor.
   a) Navigate to System Definition > Interceptors.
   b) Open the change request interceptor.
   c) Click New on the Answers related list and fill in the following fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Change Request</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the new change type. For example, Direct to Expedited Change.</td>
</tr>
<tr>
<td>User Prompt</td>
<td>Enter a description that will be displayed to the end user when they click Create New under Change.</td>
</tr>
<tr>
<td>Target URL</td>
<td>Set the appropriate target URL. For example, change_request.do?sys_id=-1&amp;sysparm_query=type=expedited.</td>
</tr>
</tbody>
</table>
d) Submit the form.

3. Create the script include for the new change type.
   a) Navigate to **System Definition > Script Includes**.
   b) Search for a change type script include on which to base the workflow for the new change type on. For example, to base it on Emergency change type, search for ChangeRequestStateModelSNC_emergency and open the script include.
   c) Copy the script of the ChangeRequestStateModelSNC_emergency script include from the **Script** field.
   d) Navigate to **System Definition > Script Includes**.
   e) Click **New** to create a new script include.
   f) Name the new script include to match the value of the new type. For example, ChangeRequestStateModelCust_expedited.
   g) Paste the copied script in the **Script** field of the new script include.
   h) Update any references in the pasted script include from ChangeRequestStateModelSNC_emergency to ChangeRequestStateModelCust_expedited.
   i) Click **Save** to save the new script include.

**Note:** An existing script include contains the implementation for all the moving and canMove functions. The moving function is used to pre-populate any fields that are required for the new state. The canMove function is used to check for any additional requirements and validate if a task can move to the next state.

4. Create the script include to define state transitions and control the transitioning between states for the new change type.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Set the appropriate order level for the change type. For example, 400.</td>
</tr>
</tbody>
</table>
Geneva  ServiceNow  IT Service Management

a) Navigate to **System Definition > Script Includes.**

b) Search for change type script include on which to base the transitioning controls for the new change type on. For example, to base it on Emergency change type, search for `ChangeRequestStateModel_emergency` and open the script include.

c) Update the name of the script include to match the value of the new type. For example, `ChangeRequestStateModel_expedited`.

d) Update the reference to the base script include for the new change type. Change the extended Object in line 2 to the base script include name. For example, `ChangeRequestStateModelCust_expedited`, so the reference is similar to `ChangeRequestStateModel_expedited.prototype = Object.extendsObject(ChangeRequestStateModelCust_expedited, {`. 

e) Click **Insert and Stay** to save the new script include.

5. Modify the script include that controls the transitioning between states using one of the defined models for the new change type. The base method is overridden so that the new state model for the new change type can be utilized.

a) Navigate to **System Definition > Script Includes.**

b) Search for and open the `ChangeRequestStateHandler` script include, which controls the transitioning between states using one of the defined models.

c) Create a property to reference the new change request type value. For example, `EXPEDITED:"expedited"`.

d) Override the base method `_resetModel` in order to have the ability to include the new model. For example, if the change request type is `expedited`, then the new state model `ChangeRequestStateModel_expedited` is included. Example code with changes highlighted in bold:

```javascript
var ChangeRequestStateHandler = Class.create();
    // All references to statehandler constants should be through this class ChangeRequestStateHandler
    ChangeRequestStateHandler.DRAFT = ChangeRequestStateHandlerSNC.DRAFT;
    ChangeRequestStateHandler.ASSESS = ChangeRequestStateHandlerSNC.ASSESS;
    ChangeRequestStateHandler.AUTHORIZE = ChangeRequestStateHandlerSNC.AUTHORIZE;
    ChangeRequestStateHandler.SCHEDULED = ChangeRequestStateHandlerSNC.SCHEDULED;
    ChangeRequestStateHandler.IMPLEMENT = ChangeRequestStateHandlerSNC.IMPLEMENT;
```
ChangeRequestStateHandler.REVIEW = ChangeRequestStateHandlerSNC.REVIEW;
ChangeRequestStateHandler.CLOSED = ChangeRequestStateHandlerSNC.CLOSED;
ChangeRequestStateHandler.CANCELED = ChangeRequestStateHandlerSNC.CANCELED;

ChangeRequestStateHandler.prototype =
Object.extendsObject(ChangeRequestStateHandlerSNC, {
EXPEDITED: "expedited",
initialize: function(changeRequestGr) {

ChangeRequestStateHandlerSNC.prototype.initialize.call(this, changeRequestGr);
},
_resetModel: function() {
  this._model = null;
  var type = this._gr.getValue('type') + ";

  if (type == this.NORMAL || type == this.STANDARD || type == this.EMERGENCY)
  ChangeRequestStateHandlerSNC.prototype._resetModel.call(this);
  else if (type == this.EXPEDITED)
    this._model = new ChangeRequestStateModel_expedited(this._gr);
},

type:"ChangeRequestStateHandler"
});

6. Create a workflow for the new change request type.
a) Navigate to Workflow > Workflow Editor.
b) Open an existing change request workflow. For example, Change Request – Emergency.
c) Select Copy from the Actions menu to copy the workflow and name the new workflow. For example, Change Request – Expedited.
d) Select Properties from the Actions menu to update the condition under which the new workflow will execute. For example, Type is Expedited in the condition.
e) Open the matching change tasks workflow that is called by the main workflow. For example, Change Request - Emergency change tasks.
f) Select Copy from the Actions menu to copy the workflow and name the new workflow. For example, Change Request - Expedited change tasks.
g) Select Publish from the Actions menu to publish the new change tasks workflow and make it available for use.
h) Go back to the first workflow you created and update the Workflow activity to reference the new change tasks workflow. For example, Change Request - Expedited change tasks.
i) Select Publish from the Actions menu to publish the new workflow and make it available for use.

State model and transitions
Change Management offers a state model to move and track change requests through several states.
The following table provides a list of all the states that a change request can progress through.

### Table 49: Change states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Change request has not been submitted yet for review and authorization. A change requester can save a change request as many times as necessary while building out the details of the change prior to submission.</td>
</tr>
<tr>
<td>Assess</td>
<td>Peer review and technical approval of the change details are performed during this state.</td>
</tr>
<tr>
<td>Authorize</td>
<td>Change Management and the CAB will schedule the change and provide final authorization to proceed.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>The change is fully scheduled and authorized. It is now waiting for the planned start date.</td>
</tr>
<tr>
<td>Implement</td>
<td>The planned start date has approached and the actual work to implement the change is being conducted.</td>
</tr>
<tr>
<td>Review</td>
<td>The work has been completed. The change requester now determines whether the change was successful. A post-implementation review can be conducted during this state.</td>
</tr>
<tr>
<td>Closed</td>
<td>All review work is complete. The change is closed with no further action required.</td>
</tr>
<tr>
<td>Canceled</td>
<td>A change can be canceled at any point if it is no longer required. However, a change cannot be canceled from a Closed state.</td>
</tr>
</tbody>
</table>

Normal, standard, and emergency changes progress through states in different ways.

<table>
<thead>
<tr>
<th></th>
<th>New</th>
<th>Assess</th>
<th>Authorize</th>
<th>Scheduled</th>
<th>Implement</th>
<th>Review</th>
<th>Closed</th>
<th>Canceled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Standard</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Emergency</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Normal changes progress through all states.

Standard changes are considered to be pre-authorized, so they bypass the Assess and Authorize states that trigger approval records. Approving these changes will progress the change to the next appropriate state. Rejecting these changes will send them back to New state.
The interaction with the Change Request state model is handled by a combination of the following:

- UI actions that add the appropriate state transition buttons or menu actions to a form, based on the current state of the change request.
- Client script to restrict the State drop-down field on the change request form to the current state and any valid transitions to other states.
- Script includes that determine the states available for each change type and the valid transitions from one state to another.

You must activate the State Model plugin to use this state model.

**Normal change state model**

You can progress a normal change through a number of state values.

The primary route for a normal change progresses in the following order:

1. New
2. Assess
3. Authorize
4. Scheduled
5. Implement
6. Review
7. Closed

A normal change can be canceled from every state except the Closed state.
Figure 15: Normal change state model

Emergency change state model

You can progress an emergency change through a number of state values.

The primary route for an emergency change progresses in the following order:

1. New
2. Authorize
3. Scheduled
4. Implement
5. Review
6. Closed

An emergency change can be canceled from the following states:

- Authorize
- Scheduled
- Implement
- Review

Figure 16: Emergency change state model
Standard change state model

You can progress a standard change through a number of state values.
The primary route for a standard change progresses in the following order:

1. New
2. Scheduled
3. Implement
4. Review
5. Closed

A standard change can be canceled from the following states:

- New
- Scheduled
- Implement
- Review
Add a new state to the change state model

You can add a new state to the existing state model for different change types based on your organization's requirements.

Role required: admin

The State model plugin is activated.

The interaction with the Change Request state model is handled by a combination of the following:

- UI actions that add the appropriate state transition buttons or menu actions to a form, based on the current state of the change request.

Figure 17: Standard change state model
• Client script to restrict the **State** drop-down field on the change request form to the current state and any valid transitions to other states.
• Script includes that determine the states available for each change type and the valid transitions from one state to another.

To add a new state:
1. Customize the choice list for the State field on a Change Request and add the new state.

   **Note:** Ensure that the numeric value you use for the new state is not already assigned to an existing choice.

   The new state is added. Use the up and down arrows to ensure the new state is in the correct order for the sequence of states.

2. Navigate to **System definition > Script includes.**

3. Edit the ChangeRequestStateHandler script to perform the following:
   - Update the **constants** section at the start of this script include to include values for the newly added state. For example,
   ```java
   ChangeRequestStateHandler.MY_NEW_STATE = "mynewstate";
   ```
   - Update the **STATE_NAMES** map at the end of the initialize function to include the numeric value for the newly added state. For example,
   ```java
   this.STATE_NAMES["-6"] = ChangeRequestStateHandler.MY_NEW_STATE;
   ```

   **Note:** The **STATE_NAMES** map provides a mapping between the numeric values that are stored in the **State** field on a change request under a memorable name. This enables the memorable name to be used in the state model script includes.

4. Edit the appropriate script include to incorporate the new states into the model for the relevant change request types. Each type of change request has a corresponding script include named `ChangeRequestStateModel_<type>` where `<type>` is the value of the change request type. For example, `ChangeRequestStateModel_normal` defines the state model for change requests with a type of normal.

   Each state model script include defines objects that decide the following:
   - Which states are available.
   - The next state or states for each available state.
   - Functions for each state transition to decide if that transition is available (`canMove`) along with a function to be executed as part of moving to that state (`moving`).

   For example, the `ChangeRequestStateModel_normal` script include.
5. Create a new UI action on the Change Request table that will provide a button to progress the new state to the appropriate point in the life cycle of the change.

a) Use **Insert and Stay** to make a copy of an existing UI action.

**Note:** The new UI action should be based on one of the existing default ones, such as Implement.

b) Update the following fields on the form.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Update to match the name of the new state.</td>
</tr>
<tr>
<td>Action name</td>
<td>Replace the state at the end of the name with the new state.</td>
</tr>
<tr>
<td>Hint</td>
<td>Update the text to refer to the new state.</td>
</tr>
<tr>
<td>Onclick</td>
<td>Rename the function to match the new state.</td>
</tr>
<tr>
<td>Condition</td>
<td>Update the call to the isNext function with the new state.</td>
</tr>
<tr>
<td>Field name</td>
<td>Update</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| **Script** | • Update the function name to match the one specified in the **Onclick** field.  
| | • Update the line that starts with `ga.addParam("sysparm_state_name", ...` to enter the name of the new state as the second parameter of the `addParam` function.  
| | • Update the line starts with `gsftSubmit` and modify the third parameter of this function call to match the value entered in the **Action name** field. |

For example, a modified UI action where the new state’s memorable name is `mynewstate`.

The `ChangeRequestStateHandler` script include contains two functions that are used to determine if a UI action is displayed based on the current state of the change request.

- `isNext(stateName)` - This function only checks if the `stateName` passed as a parameter is available as a next state for the current state of the change request.
- `canMoveTo(stateName)` - This function performs the same check as the `isNext` function. However, it also checks the result of calling the appropriate `canMoveTo` function for the
transition from the current state to the `stateName` passed as a parameter. This function is used if there are additional checks in the `canMove` functions such as checking that a field contains a particular value.

6. Update the process flow configuration to incorporate the new change state.

The process flow is displayed at the top of the **Change Request** form and is configured in a number of process flow records.

![Process Flow Image]

a) Navigate to the **Process Flow** module and filter for existing records for the **Change Request** table.

b) Open a record and use **Insert and Stay** to make a copy of an existing record.

c) Update the following fields on the form.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Update to match the name of the new state.</td>
</tr>
<tr>
<td>Label</td>
<td>Update to match the name of the new state. The value entered here will be included in the process flow at the top of the <strong>Change Request</strong> form.</td>
</tr>
<tr>
<td>Order</td>
<td>Update this number so that the new state is in the correct sequence with the existing process flow records for other states.</td>
</tr>
<tr>
<td>Condition</td>
<td>Update the filter to match the new state.</td>
</tr>
</tbody>
</table>

For example, a new state with label My New State.
Review default workflows on page 190

Any modification to the state model may impact the default workflows for change requests.

Role required: admin

Each change type has a default workflow. To ensure that any change to the state model has not adversely impacted workflows, you must review each of the default workflows.

Review the workflow for each $\text{ChangeRequestStateModel}_<\text{type}>$ script include that has been modified.

### Table 50: Workflows for Change Types

<table>
<thead>
<tr>
<th>Change type</th>
<th>Script include Name</th>
<th>Workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>$\text{ChangeRequestStateModel}_\text{normal}$</td>
<td>Change Request - Normal</td>
</tr>
<tr>
<td>Standard</td>
<td>$\text{ChangeRequestStateModel}_\text{standard}$</td>
<td>Change Request - Standard</td>
</tr>
<tr>
<td>Emergency</td>
<td>$\text{ChangeRequestStateModel}_\text{emergency}$</td>
<td>Change Request - Emergency</td>
</tr>
</tbody>
</table>

Modifications to the default workflow for each change type will depend on where the new state is added in the sequences of states.

**Tutorial: add a new change management state**

This tutorial provides an example of adding a new state to the existing state model.

Role required: admin

Consider the following scenario:

Based on your organization's requirements, you must add a new state Complete between the existing Implement and Review states. You must also add the ability to decide if the Review state is needed.

Perform the following steps:
Add change state tutorial: create a new choice
You must create a new choice for the change request state.

Role required: admin

To create a new choice for the State field in the change request:

1. Open the Change Request form.
2. Right click on the State field label and select the Configure Choices option.
3. Enter the following values on the Configuring State Choices form and click Add.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New item text</td>
<td>Enter Complete</td>
</tr>
<tr>
<td>Numeric value</td>
<td>Enter -6</td>
</tr>
<tr>
<td>Apply to table</td>
<td>Set to Change Request</td>
</tr>
</tbody>
</table>

The new state appears in the Selected slushbucket on the form.

4. Use the up and down arrows to move the new state between Implement and Review states.

5. Click Save to create the new choice and return to the Change Request form.

Add change state tutorial: create a custom field
You must create a new custom choice field to indicate if a change request needs to go through the Review state.

Role required: admin
To create a new custom field:

1. Open the Change Request form.
2. Right click on the form header and go to Configure > Form Layout.
3. Enter the following values in the Create new field section of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Needs Review.</td>
</tr>
<tr>
<td>Type</td>
<td>Enter Choice.</td>
</tr>
</tbody>
</table>

4. Click Add add the new field to the slush bucket.

The new field appears at the bottom of the Selected slush bucket.

5. Use the Up and Down arrows next to the slush bucket to move the new field next to the Assigned to field.

6. Click Save to create the new field and return to the Change Request form. The new Needs review field appears on the Change Request form.

7. Right click on the Needs review field label and select the Configure choices option.

8. The Configuring choices form appears with empty slush buckets for Available and Selected.

9. Use the Enter new item field and Add button to create Yes and No choices that will appear in the Selected slush bucket.
10. Click **Save** to create the new choices and return to the **Change Request** form. The **Needs review** field displays the **Yes** and **No** options.

11. Right click on the **Needs review** field label select **Configure Dictionary**.

12. Update the **Choice** drop down in the **Choice List Specification** section to **Dropdown with – None –**.

13. Click **Update** to save the dictionary modification and return to the **Change Request** form. The **Needs review** field also displays the **— None —** option.

**Add change state tutorial: add a UI policy**

Add a UI Policy to display the **Needs review** field for only change type Normal and for certain states.

Role required: admin

You must create a UI policy to ensure that the new custom field **Needs review** is only available for change requests with change type Normal and only displayed on the form when it reaches the new Complete state.

To create the required UI policy:

1. Open the **Change Request** form.
2. Right click on the form header and go to **Configure > UI Policies**.
3. Click **New** and enter the following values on the **UI Policy** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Enter Change Request.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter Show &quot;Needs review&quot; field. Make it mandatory.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Add the following two new conditions:</td>
</tr>
<tr>
<td></td>
<td>• Type is Normal.</td>
</tr>
<tr>
<td></td>
<td>• State is one of Review, Complete, Closed.</td>
</tr>
</tbody>
</table>

4. Right click on the form header and select **Save** to create the UI Policy record and stay on the form.

5. Click **New** on the **UI Policy Actions** related list on the form.

6. Enter the following values on the **UI Policy Action** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Select Needs review.</td>
</tr>
</tbody>
</table>
Field | Values
---|---
Mandatory | Select True.
Visible | Select True.

7. Click **Submit** to create the UI Policy action and return to the **UI Policy** form.

---

Add change state tutorial: create a new ACL

You must create a new ACL to prevent the **Needs review** field being modified after it has been set.

Role required: admin

The newly created UI Policy makes the **Needs review** field mandatory when a change request reaches the new **Complete** state.

The subsequent configuration of the state model ensures that a user must enter a value in the **Needs review** field before the change request can be saved in the Complete state. To prevent the value being changed in the **Needs review** field once it has been set, a new access control level record (ACL) is required to make the field read only.

To create an ACL:

1. Open the **Change Request** form.
2. Right click on the form header and go to **Configure > Security Controls**.
3. Enter the following values in the **Access control** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Set to Record.</td>
</tr>
<tr>
<td>Operation</td>
<td>Set to Write.</td>
</tr>
<tr>
<td>Name (first part)</td>
<td>Select Change Request</td>
</tr>
<tr>
<td>Name (second part)</td>
<td>Select Needs review.</td>
</tr>
</tbody>
</table>
4. Click Submit to create ACL.

---

Add change state tutorial: update state handler script include
You must update the ChangeRequestStateHandler script include with the new Complete state.

Role required: admin

The ChangeRequestStateHandler script include defines the states available for the Change Request state model.

To update the ChangeRequestStateHandler script include:

1. Navigate to **System Definition > Script Includes**.
2. Open the ChangeRequestStateHandler script include and modify the following.
   1. Add the following line to the top of the script in the **Constants** section:

      ```javascript
      ChangeRequestStateHandler.COMPLETE = "complete";
      ```
   
   2. Add the following line as the last line of the function in the **Initialize** function:

      ```javascript
      this.STATE_NAMES["-6"] = ChangeRequestStateHandler.COMPLETE;
      ```
3. Click **Update** to save your changes.

*Update state model script include*

You must update the `ChangeRequestStateModel_normal` script include to add new functions for the new Complete state.

Role required: admin

You must update the `ChangeRequestStateModel_normal` script include to configure the following:

- Add new `canMove` and `moving` functions for the new Complete state. These functions can return a value of true since there are no special conditions for or extra actions to perform when moving to the Complete state.
- Modify the definition of the existing object for the Implement state to ensure that the next state is Complete.
- Add a new object for the Complete state, which will define Review and Closed as the next two states.

**Note:** The `canMove` functions for the transition to these states from Complete will check the new `Needs review` custom field to determine the correct next state.

To update the `ChangeRequestStateModel_normal` script include:

1. Navigate to **System Definition > Script Includes**.
2. Open the `ChangeRequestStateModel_normal` script include and modify the following.
   1. Add the following line at the end of the script include but before the line starting with `type:`

```javascript
var ChangeRequestStateHandler = Class.create();
// All references to statehandler constants should be through this class ChangeRequestStateHandler
ChangeRequestStateHandler.DRAFT = ChangeRequestStateHandlerSNC.DRAFT;
ChangeRequestStateHandler.AUTHORIZE = ChangeRequestStateHandlerSNC.AUTHORIZE;
ChangeRequestStateHandler.SCHEDULED = ChangeRequestStateHandlerSNC.SCHEDULED;
ChangeRequestStateHandler.REVIEW = ChangeRequestStateHandlerSNC.REVIEW;
ChangeRequestStateHandler.COMPLETED = ChangeRequestStateHandlerSNC.COMPLETED;
ChangeRequestStateHandler.CLOSED = ChangeRequestStateHandlerSNC.CLOSED;

ChangeRequestStateHandler.prototype = Object.extendObject(ChangeRequestStateHandlerSNC, { changeRequestStateHandlerNormal, initialize: function(changeRequestGr) {
  this.initialize.call(this, changeRequestGr);
  this.state_names["-6"] = ChangeRequestStateHandlerSNC.COMPLETED;
}, this.state_names["-6"] = ChangeRequestStateHandlerSNC.COMPLETED;
});

ChangeRequestStateHandler.DRAFT = ChangeRequestStateHandlerSNC.DRAFT;
ChangeRequestStateHandler.AUTHORIZE = ChangeRequestStateHandlerSNC.AUTHORIZE;
ChangeRequestStateHandler.SCHEDULED = ChangeRequestStateHandlerSNC.SCHEDULED;
ChangeRequestStateHandler.REVIEW = ChangeRequestStateHandlerSNC.REVIEW;
ChangeRequestStateHandler.COMPLETED = "complete";

```

```javascript
tocomplete_moving: function() {
  return true;
},

tocomplete_canMove: function() {
  return true;
},
```
2. Modify the existing implement object to `toComplete`:

```javascript
implement: {
  nextState: ["complete"],

  complete: {
    moving: function() {
      return this.toComplete_moving();
    },
    canMove: function() {
      return this.toComplete_canMove();
    }
  },

  canceled: {
    moving: function() {
      return this.toCanceled_moving();
    },
    canMove: function() {
      return this.toCanceled_canMove();
    }
  }
},
```

3. Add the following new state object for `complete`:

```javascript
complete: {
  nextState: ["review", "closed"],

  review: {
    moving: function() {
      return this.toReview_moving();
    },
    canMove: function() {
      if (this._gr.getValue("u_needs_review") == "Yes")
        return true;
      return false;
    }
  },

  closed: {
```
moving : function() {
    return this.toClosed_moving();
},

canMove : function() {
    if (this._gr.getValue("u_needs_review") == "No")
        return true;
    return false;
},

canceled : {
    moving : function() {
        return this.toCanceled_moving();
    },
    canMove : function() {
        return this.toCanceled_canMove();
    }
},

4. Click **Update** to save changes.

Add change state tutorial: create new UI action
You must create a new UI action to display a button on a change request for the new Complete state.

Role required: admin

The new UI action must contain a condition that uses the state model script include to decide when the Complete button is displayed on the Change Request for. In this case, the Complete button will only be displayed when the change has reached the Implement state.

1. Open the Change Request form.
2. Right click on the form header and go to Configure > UI Actions.
3. Search for the existing Implement UI action and open this record.
4. Right click on the form header and select the Insert and Stay option to create a duplicate record.
5. Modify the following fields with new values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Complete.</td>
</tr>
<tr>
<td>Action name</td>
<td>Enter state_model_move_to_complete.</td>
</tr>
<tr>
<td>Hint</td>
<td>Enter Progresses change to Complete state.</td>
</tr>
<tr>
<td>Onclick</td>
<td>Enter moveToComplete();</td>
</tr>
<tr>
<td>Condition</td>
<td>Enter complete as shown:</td>
</tr>
</tbody>
</table>

```
gs.hasRole('itil') &&
new ChangeRequestStateHandler(current).isNext
```

© 2017 ServiceNow. All rights reserved.
### Script

Update function, state name, and state value.

```javascript
function moveToComplete(){
    var ga = new GlideAjax("ChangeRequestStateHandlerAjax";

    ga.addParam("sysparm_name", "getStateValue");
    ga.addParam("sysparm_state_name", "complete");

    ga.getXMLAnswer(function(stateValue){
        g_form.setValue("state", stateValue);
        gsftSubmit(null, g_form.getFormElement(), "state_model_move_to_complete");
    });

    if (typeof window == 'undefined')
        setRedirect();

    function setRedirect()
    {
    current.update();
    action.setRedirectURL(current);
    }
}
```
6. Click Update to save the modifications.

Add change state tutorial: create new process flow record
You must create and add a new process flow record for the new Complete state in order to display the state on the process flow formatter at the top of the Change Request form.

Role required: admin

To create and add a new process flow record for the new Complete state:

2. Search for records where the Table is Change Request.
3. Open the Normal Change – Implement state existing default record.
4. Right click on the form header and select the Insert and Stay option to create a duplicate record.
5. Modify the following fields with new values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Normal Change – Complete State.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter Complete.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter 550.</td>
</tr>
<tr>
<td>Condition</td>
<td>Enter State is Complete.</td>
</tr>
</tbody>
</table>
Update change request workflow

You must update the change request workflow to reflect the addition of the new Complete state.

Role required: admin

The default Change Request – Normal workflow for type Normal change requests must be modified to update the change request to the new state of Complete instead of Review.

To update change request workflow:

1. Navigate to Workflow > Workflow Editor.
2. Select Change Request – Normal from the list of workflows.
3. Select the Checkout option from the Context menu to create a new version of this workflow.
4. Open the Set Values activity that transitions to the End activity and modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Move to Complete.</td>
</tr>
<tr>
<td>Set these values template</td>
<td>Update value to State = Complete.</td>
</tr>
</tbody>
</table>
5. Click **Update** to save the modifications.

6. Open the **Wait for conditions** activity that transitions to the End activity and modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter Change moves to Complete.</td>
</tr>
<tr>
<td>Set these values template</td>
<td>Update value to State is Complete.</td>
</tr>
</tbody>
</table>
7. Click **Update** to save the modifications.

8. Select the **Publish** option from the **Context** menu to publish the new version of this workflow.

Configure transitions for the state model

You can use script includes or UI policies to configure state models and the criteria for moving change requests from one state to another.

*Add a new state change condition using a script include*

To add new criteria for state transitions, you can edit the script includes for the state transition models of each change type.

You can add state change criteria to determine the UI actions that enable a particular state to transition to the next state.

1. Go to **System Definitions > Script Includes**.
2. Open the script include for the state transition model that you want to edit.

<table>
<thead>
<tr>
<th>State transition model</th>
<th>Script include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>ChangeRequestStateModel_normal</td>
</tr>
</tbody>
</table>
3. Modify the appropriate method `canMove` method in the script include. For example, to add a condition for a normal change to transition from the New state to the Authorized state, modify the `draft.authorized.canMove()` method in the `ChangeRequestStateModel_normal` script include. In the script, the GlideRecord you are acting on can be referenced using the `this._gr` variable.

The `canMove` method is part of a structure that defines the transitions available to the change type. The `canMove` method is contained in the `currentState.nextState.canMove()` structure.

**Add new state change conditions using UI Policy**
You can use a UI policy to add new criteria for state transitions. You can edit the default UI policies that are available or create a new policy. The type of change and the state of the change request drives the default UI policies that determine mandatory field requirements.

1. Navigate to **System UI > UI Policies**.
2. Open a default UI policy to edit or click **New** to create a new policy.

These default UI policies are available:

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>CAB fields for normal and emergency changes from the Authorize state and onwards</td>
</tr>
<tr>
<td>Mandatory</td>
<td><strong>Assignment Group</strong> field</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Close notes and Code fields when in the Closed state</td>
</tr>
</tbody>
</table>

**Note:**
In both the mandatory UI policies, the mandatory fields are determined by the state of the change request. For **Show - CAB** fields, the type of change is also taken into account because standard changes do not require approval.

3. Complete the form, as appropriate.
4. Click **Submit**.

**Standard change catalog**
Standard change catalog supports the standard change process by storing all the changes that have been approved by Change Management as standard changes.

Standard changes are pre-approved, low risk changes with a proven history of success. They are logically grouped under specific categories.

Change Management controls which changes become available in the catalog through a proposal process within the standard change catalog.

You must have the Service Catalog change requesters **itil** role to view the list of available standard changes and raise the appropriate one from the same.
This video demonstrates how standard change catalog works and how it enables change managers to manage change requests effectively.

Standard change catalog enables you to perform the following:

**Create standard change proposals**

You can create and modify standard change proposals. You can also filter criteria to view proposals in various states of progression. You can view the details of every proposal when you click on a record.

**View usage statistics of standard change templates**

You can view the usage statistics of a particular template in the **Statistics** section. You can view the number of times change requests have been raised using the standard change template on a monthly basis, the number of times the change requests have been successful and unsuccessful.

These statistics enable you to make informed decisions regarding the effectiveness of the standard change template and decide if they needs modification or retiring.

**View version history of standard change templates**

You can view the history of a particular template in the **Versions** related list. You can view all the versions associated with this template also view the information and statistics related to that specific version.

This history enables you to view how the template has evolved over time and the significant changes that have been made.

**Request pre-approved standard changes**

Raising a standard change from a standard change template ensures that pre-approved information is automatically filled into the necessary fields enabling you to raise changes faster and expediting the fulfilment of the standard change.

**Determine access to standard change templates at user level**

Standard change templates are logically grouped under specific categories. These categories are displayed to users based on user criteria such as user role, geographical location, and department.

**Configure the standard change catalog**

You can configure the standard change catalog using standard change properties.

Role required: admin

The **Standard change catalog** plugin is activated.

1. Navigate to **Change > Administration > Standard Change Properties**. The **Standard Change Properties** form displays.
2. Fill in the fields on the form, as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Select the parent service catalog category under which to add the generated standard change template. You can also choose the category or any children categories of the selected catalog.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This value is not set automatically in the Proposal form but must be specified before it is approved.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Select the parent service catalog under which to add the generated standard change template.</td>
</tr>
<tr>
<td>Mandatory Change Request values</td>
<td>Specify the list of Change Request form fields for which values must be provided when proposing a new standard change template or proposing a modification to an existing standard change template. This configuration ensures that when a standard change request is created from a standard change template, then at least one or more fields on the Change Request form contain pre-set values.</td>
</tr>
<tr>
<td>Default Change Request values</td>
<td>Specify default values for common fields on the Change Request form.</td>
</tr>
<tr>
<td>Restricted Change Request values</td>
<td>Specify the list of fields on the Change Request form for which end users will not be allowed to provide any value when making a proposal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Ensure that internal columns such as Updates, Updated, Updated by, Domain, Created, Created by are specified as restricted to prevent end users from making changes to internal fields.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Read-only fields | Specify the fields on the Change Request form for which end users will not be allowed to provide any value in the created standard change request.  
**Note:** This configuration ensures that for the specified fields, the values approved in standard change template do not change in the created standard change request.  
Fields to copy | Specify the fields whose values will be copied to the Propose a New Standard Change Template record producer from a non standard change request.  
**Note:** If there are any fields that are not specified in this list but for which default values are specified, then the default values will be copied to the record producer.

3. Click **Update** to update and save your configuration.

Users can now start requesting standard changes from the standard change catalog.

Create a standard change proposal

You can create standard change proposals that will be evaluated for approval before being included in the standard change catalog.

Role required: itil or change manager

1. Navigate to **Change > Standard Change > My Proposals**.
2. Click **New**.
3. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Specify the category to which the template will be published.</td>
</tr>
<tr>
<td>Template Name</td>
<td>Enter an easily identifiable name for the template with which the template will be published in the Standard Change Catalog.</td>
</tr>
<tr>
<td>State</td>
<td>Specify a state for the new template. The default value is <strong>New</strong>.</td>
</tr>
<tr>
<td>Proposal Type</td>
<td>Select <strong>New Template</strong> from the types of proposals.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Specify the group that will work on the proposed template.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Specify the user who will work on the proposed template.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter brief text describing the proposal for the template.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter text describing the template proposal in detail.</td>
</tr>
<tr>
<td>Business justification</td>
<td>Enter text providing the business justification regarding the requirement for this template.</td>
</tr>
<tr>
<td>Sample Change Requests</td>
<td>Specify the list of changes that closely resemble the proposed template.</td>
</tr>
<tr>
<td>Change Request values</td>
<td>Specify the field values that should get populated on the standard change created from the template.</td>
</tr>
</tbody>
</table>

4. Perform one of the following actions:
   - Click **Save**. The proposal is created with status **New**.
   - Click **Request Approval**. The proposal is created in status **In Progress**.

   **Note:** You cannot modify a standard change proposal after it is approved.

**Modify or retire a standard change template**

You can modify and retire standard change templates based on your organization's requirements.

Role required: admin or change manager

1. **Navigate to Change > All Templates.**
2. **Select the template you want to modify or retire.**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modify a standard change template</strong></td>
<td>1. Click <strong>Modify Template</strong> under Related Links.</td>
</tr>
<tr>
<td></td>
<td>2. Enter your modifications in the <strong>Modify a Standard Change Template</strong> form.</td>
</tr>
</tbody>
</table>

| Retire a standard change template     | 1. Click **Retire Template** under Related Links.                           |
|                                       | 2. Enter your business justification to retire the specific template in the **Retire a Standard Change Template** form. |

3. **Perform one of the following actions:**
   - Click **Save**. The modifications are saved but not sent for approval.
Detect change conflicts

To identify any other changes that are scheduled at the same time or impact the same configuration items (CIs) and related CIs as a change request, you can run conflict detection automatically or manually.

You can review conflict information in the change request, such as when conflict detection was last run, affected CIs, type of conflict, schedule, and conflicting changes.

Conflict detection also highlights when a change will occur outside of the maintenance schedule or during a blackout schedule. You can then reschedule the change as necessary.

Conflict detection enables you to perform the following:

Identify the recency of the conflict information

On Conflict status and Conflict last run fields on the change request record enable you to identify if conflict detection was run and the date and time it was last run.

Run manual and automated conflict detection

You can run conflict detection manually or automate it based on your requirements. You must save the change request record prior to running conflict detection.

View conflict information

You can view the conflict information in the Conflicts section of the Change Request form after you have saved the change request and run conflict detection. The Conflicts section provides information such as affected CIs, type of conflict, schedule, conflicting changes, and time and date details regarding when the conflict detection was last run, at a glance.

Create blackout and maintenance schedules for implementing changes

To schedule when changes are implemented to CIs, you can create blackout and maintenance schedules.

Role required: admin

The Conflict Detection (com.snc.change.collision) plugin is activated.

Blackout schedules are periods of time where changes cannot be implemented. For example, create a blackout schedule for code freezes at the end of the year.

Maintenance schedules restrict changes to being implemented inside a specific period of time. For example, you can create a maintenance schedule implement changes only on the weekend.

Both blackout and maintenance schedules are condition schedules.

1. Create the schedule.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create a blackout schedule | 1. Navigate to Change > Administration > Blackout Schedules.  
<p>|                         | 2. Click New.                        |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a maintenance schedule</td>
<td>1. Navigate to Change &gt; Administration &gt; Maintenance Schedules.</td>
</tr>
<tr>
<td></td>
<td>2. Click New.</td>
</tr>
<tr>
<td></td>
<td>Note: Maintenance schedules added directly to configuration items are not</td>
</tr>
<tr>
<td></td>
<td>evaluated during conflict detection. A maintenance schedule needs to be</td>
</tr>
<tr>
<td></td>
<td>defined matching the CI class and conditions defined.</td>
</tr>
<tr>
<td>2. Fill in the fields on the form,</td>
<td></td>
</tr>
<tr>
<td>as appropriate.</td>
<td>Table 53: Blackout Schedules form</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the schedule.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the schedule.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select the time zone for the schedule.</td>
</tr>
<tr>
<td></td>
<td>To evaluate planned start and end dates on the change request form for</td>
</tr>
<tr>
<td></td>
<td>logged in users, select Floating.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the CI classification to which the conflict detection is filtered.</td>
</tr>
<tr>
<td>Condition</td>
<td>Select the conditions to specify the CIs to which the schedule applies to.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when a CI is selected from the Applies to list.</td>
</tr>
<tr>
<td></td>
<td>Note: Related fields used in conditions are not evaluated for blackout or</td>
</tr>
<tr>
<td></td>
<td>maintenance schedules.</td>
</tr>
<tr>
<td>3. Right-click the form header and</td>
<td></td>
</tr>
<tr>
<td>click Save.</td>
<td>A blackout or maintenance schedule is created. You will now be able to</td>
</tr>
<tr>
<td></td>
<td>associate one or more schedule entries with this newly created schedule.</td>
</tr>
<tr>
<td>Users can now start applying</td>
<td></td>
</tr>
<tr>
<td>schedules to determine when changes</td>
<td></td>
</tr>
<tr>
<td>are implemented to CIs.</td>
<td></td>
</tr>
</tbody>
</table>

**Risk assessment and risk calculation**

There are two methods to calculate the risk of a change: Change Risk Calculator (activated by default) and Change Management Risk Assessment (an optional plugin).

Change Management Risk Assessment uses information provided by the end user to assess a risk value. Change Risk Calculation uses predefined properties and conditions to calculate a risk value.
The two methods can be used individually or together, depending on your requirements. If both methods are used together, the highest risk value from both methods is always selected.

![Risk assessment and calculation diagram]

Figure 18: Risk assessment and calculation

**Note:** If both Risk Assessment and Risk Calculation are active but you want to use only one method, then remove all conditions for the method that you do not want to use.

**Define risk assessment**

The Change Management - Risk assessment plugin provides a flexible way to capture information from the end user to calculate the risk of the associated change request. You can define the risk assessment questions, thresholds, and conditions based on which the risk for a particular change request is calculated.

Role required: admin or change_manager

The **Change Management - Risk assessment** plugin is activated.

You can use libraries of questions to derive the risk of a change based on criteria contained within the change record. For example, a different set of questions are set for a hardware change versus a software change.

The assessment uses a weighted score approach for each question. The composite weighted score derived from the end user's answers is used to calculate risk. This is based on the thresholds associated with the risk assessment.

1. Navigate to **Change > Risk Assessments**.
2. Click **New**.
   - The **Risk Assessment** form appears.
3. Fill in the fields, as appropriate.

**Table 54: Risk Assessment form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the risk assessment. This name will be displayed to the end user.</td>
</tr>
</tbody>
</table>
4. Click **Submit** to submit the details and create a new risk assessment record.
5. Open the newly created risk assessment record.
6. In the **Assessment Questions** related list, click **New**. The **Assessment Questions** related list enables you to define the questions that the end user must answer as part of assessing the risk involved in a change.
   a) Fill in the fields, as appropriate.

**Table 55: Assessment Questions related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Enter the question that will be displayed to the end user. You must use a select list. <strong>Note:</strong> You cannot ask mandatory choice list questions because they are not supported.</td>
</tr>
<tr>
<td>Weight</td>
<td>Enter the weight to be applied to each question. This weight is multiplied to the score of the answer to calculate the weighted score.</td>
</tr>
</tbody>
</table>

b) Click **Submit** to submit the details and create a new risk assessment question set.

c) Open the newly created question set.

d) In the **Assessment Question Choices** related list, click **New**. The **Assessment Question Choices** related list enables you to define the multiple choices that the end user must answer.

e) Fill in the fields, as appropriate.

**Table 56: Assessment Question Choices related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Enter the order number to determine the sequence in which the choice will be displayed to the end user. The choices are sequenced from lowest order to highest.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the choice to be displayed to the user.</td>
</tr>
<tr>
<td>Score</td>
<td>Enter the score to be awarded to the choice.</td>
</tr>
</tbody>
</table>

f) Click **Submit** to submit and save the question choice.
7. In the **Risk Assessment Thresholds** related list, click **New**. The **Assessment Thresholds** related list enables you to determine the risk that will be set depending on the calculated composite score for a completed assessment. The composite score is the sum of all weighted scores for the assessment.

   **Note:** Ensure that the thresholds are set based on the questions and answer combinations.

   a) Fill in the fields, as appropriate.

   **Table 57: Risk Assessment Thresholds related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Enter a name for the assessment threshold.</td>
</tr>
<tr>
<td>Score Greater Than</td>
<td>Enter the score number.</td>
</tr>
<tr>
<td><strong>Note:</strong> If the score, which is totalled from all of the end user's answers is greater than your specified score number, then the risk in the Risk field will be applied to the change.</td>
<td></td>
</tr>
<tr>
<td>Risk</td>
<td>Select the risk level to apply if the risk threshold is met.</td>
</tr>
</tbody>
</table>

b) Click **Submit** to submit and save the risk assessment threshold.

8. In the **Assessment Conditions** related list, click **New**. The **Assessment Conditions** related list enables you to determine the risk assessment is attached to each change. Typically, the first attachment that matches the conditions gets attached during evaluation. Therefore, ensure that the conditions result in the correct assessments being attached especially when defining multiple questionnaires.

   **Note:** Ensure that the conditions are simple and mutually exclusive so that the assessment conditions are easier to understand and maintain.

   a) Fill in the fields, as appropriate.

   **Table 58: Risk assessment conditions related list fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box if you want the condition to be evaluated.</td>
</tr>
<tr>
<td>Condition</td>
<td>Enter the conditions that will determine which changes will use the specific risk assessment.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the condition.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order number that will determine the sequence in which the risk assessment will be used. If multiple conditions apply, the risk assessment with the lowest order will be used.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table on which the risk assessment will be run.</td>
</tr>
</tbody>
</table>

**Note:** Select the Change [change_request] table if the risk assessment is used on the Change table.

---

**Note:** In case of a default questionnaire, you can add a condition record with no conditions and set the order to a suitably higher number to ensure that other conditions are evaluated first.

b) Click **Submit** to submit and save the risk assessment conditions.

Users can now enter risk assessment information that will calculate the risk associated with a specific change request.

**Identify risk conditions**

The Best Practice- Change Risk Calculator enables dynamic calculations of the risk and impact of a change, which are displayed on the change record.

The Best Practice- Change Risk Calculator also bundles some risk calculations using CI attributes and time measures.

*Specify risk and impact calculation method*

You can specify how and when risk and impact rules are applied.

Role required: admin

The *Best practice- change risk calculator* plugin is activated.

1. Navigate to **Change > Administration > Change Properties**.
2. From the **Change risk calculation method** property, select one of the following options:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **UI Action** | Enables users to check condition rules on demand using the *Calculate Risk* UI action.  
Users will be able to click *Calculate Risk* to apply any matching conditions according to their order. Each time a rule is applied, an alert is displayed confirming the new values for risk and impact.  
The *Calculate Risk* button will appear as a Related Link on the Change Request form only if:  
- There are risk and impact conditions that apply to the current change record.  
- The user has the admin or itil role. |
| **Business Rule** | Enables conditions to be evaluated and applied dynamically through a business rule that exists on the Change Request table.  
The conditions are evaluated before new change request record is inserted and before any update to existing change requests is made.  
Users with either the admin or itil roles or both can execute this business rule. |
| None        | Disables the processing of risk and impact rules entirely. |

**Define risk and impact conditions**  
You can define risk and impact conditions for your change records.  
Role required: admin  
The Best practice- change risk calculator plugin is activated.  
You can define the rules based on which the risk and impact of a change will be calculated.  
If more than one rule matches the criteria specified on a change request, the Order field determines the order in which rules are evaluated. Rules with lower numbers are evaluated first. If there are two or more rules with differing orders, the rule with the lowest order is evaluated and the others are ignored.  
To define a new risk or impact condition:  
1. Navigate to Change > Risk Conditions.  
2. Use one of the following options to define the new rule:
- Condition filter: use the builder to construct the logic.
- Advanced condition: use the **Condition** field to script an advanced condition.
- Script values option: use to script conditions.

**Note:** The **Active** field must be checked for a rule to be evaluated.

Users can now enter criteria based on which the risk and impact of a change request will be calculated.

**Use the condition filter to define risk and impact conditions**

You can use the condition filter to write conditions.

1. Click **New** to create a new calculation.
2. Enter a name.
3. Select either the **Risk** or **Impact** values or both.
   - This determines which field is updated by this risk calculation.
4. Enter a **Description**.
5. Create a condition using the **Condition** field filters.

**Use advanced conditions to define risk and impact conditions**

1. Click **New** to create a new calculation.
2. Enter a name.
3. Select either the **Risk** or **Impact** values or both.
   - This determines which field is updated by this risk calculation.
4. Enter a description.
5. Check the **Use advanced condition** box.
6. Write the script in the **Advanced condition** field that appears.

   Rules are written using standard business rule syntax. The rule needs to set the global variable answer to true or false.

   The figure looks at the currently selected configuration item to determine whether it is a business service. If it is a Business Service then it checks a field named **Business Criticality** to see if the value is 1 - most critical or 2 - somewhat critical. If the condition matches, it sets 'answer = true', which will set the risk for the change request to 'High' and the impact to '1 - High'.

   Another common scenario that requires scripting is determining the Business Services that will be impacted as a result of a change to one or more configuration items. A sample rule has been provided in the plugin.

   In this example rule, the script uses the CIUtils() class to determine which Business Services will be impacted by your change. The servicesAffectedByCI() method is invoked, and passed the current change record. This method grabs the Configuration Item entered on the current change request then locates all associated parent and child Business Services.

   A list or array of Business Services is returned, and then evaluated in the script above to determine if there are any '1 - most critical' services. If there are highly critical services then the answer will be set to true.

**Use a script to define risk and impact conditions**
You can set either risk or impact or both based on variable conditions.

1. Click **New** to create a new calculation.
2. Enter a name.
3. Select the **Risk** or **Impact** values or both. This determines which field is updated by this risk calculation.
4. Enter a description.
5. Check the **Use script values** box.
6. Write the script in the **Script** field that appears.

The Critical service changed condition, which is provided with the plugin, sets risk and impact according to the values returned by the Business Services. If the criticality is 1, the script values are used to assign the appropriate risk and impact.

Values from the current change request can be invoked to optionally set either risk or impact or both. Below is an example using current field values:

```java
if (current.assignment_group.getDisplayValue == "Network") {
    current.risk = 2;
    current.impact = 1;
} else {
    current.risk = 3;
    current.impact = 2;
}
```

**Edit risk and impact conditions**

You can edit the risk and risk conditions from the **Change Request** form.

**Role required: admin**

1. On the **Change Request** form, navigate to **Context > Edit Risk Conditions**.
2. Edit the rules based on your requirements.
3. Click **Update** to save the changes.

**Associated CIs on a change request**

You can associate CIs to change requests through related lists on the Change Request form.

The **Affected CIs** and **Impacted Services/CIs** related lists enable you to manage CI changes.

When you first access a change request and work with these related lists, you can identify CIs across CI classes using configuration class. You can change the configuration class manually to filter the list and narrow the selection of CIs. For example, to filter for Linux servers only, select **Linux Servers** as the **Configuration Class**.

You can also create and save filters to provide quick access to common CI searches. The next time you access the change request, the **Configuration Class** field displays the last associated CI class. This automatic filter ensures that relevant CIs are displayed.

After identifying the CIs affected by a change request, you can add them to the **Affected CIs** related list on the change request. After saving affected CIs, you can open the form context menu and select the **Refresh Impacted Services** option. This option populates the **Impacted Services/CIs** related list based on the affected CIs.

The **Impacted Services/CIs** related list represents a many-to-many relationship between the Task [task] and CMDB [cmdb_ci] tables. The related list displays CIs, such as business services or other CI classes, that are impacted. You can add this related list to any task form such as an incident or problem form. You can also enter the details of the impacted services manually, as required.
Note: The manually added CIs are not deleted each time the impacted services are refreshed. However, business services related to the CIs are displayed on the Impact Services/CIs related list.

Add affected CIs to change requests using dependency views

You can use the dependency views to identify dependent CIs affected by a change request and then add them to the Affected CI(s) related list.

Role required: admin, change manager

When a change request is associated to a configuration item, the change record becomes accessible from dependency views. This makes the affected services easy to assess.

Note: Ensure that you configure the change request form to display the Affected CI(s) related list.

1. In the change request, click the dependency views icon next to the Configuration item field.

Note: If there are critical change requests attached to the database, the map includes the business services that rely on that database. The database icon has a blinking glyph on the lower left edge that indicates any issues with the node.

The configuration item in the map with all its dependent CIs are displayed.

2. Click the down arrow next to the CI to display a list of tasks and issues with the CI.

The list may contain one or more change requests, and follow-on audit tasks. You can open each record from this list.

3. Click the task number to display the complete list of tasks attached to this server.

You can view the user assigned to the change and also open the record for more information.

4. To change the map configuration, select a format from the Layout field or use the filter panel to filter the map.

The dependency views highlights the affected CIs that are dependent on the database.

5. To add an affected CI to the change for the database, click the drop-down arrow next to the highlighted node and select Add Affected CI(s).

You can view the Affected CI(s) related list on the change request.

Associate multiple CIs to a change request

You can associate multiple impacted or affected CIs to a single change request.

Role required: admin, change manager

When you create a change request, you can add multiple CIs to that change request using the Affected CIs or Impact Services/CIs related lists in the change record.

1. Navigate to Change > Open and select a change request record.

2. In either the Affected CIs or Impact Services/CIs related list, click Add.
3. Select the appropriate CIs from the list of CIs displayed in the Configuration Class pop-up window.
<table>
<thead>
<tr>
<th>Configuration Item</th>
<th>Manufacturer</th>
<th>Location</th>
<th>Description</th>
<th>Class</th>
<th>Updated</th>
<th>Maintenance schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>1100 S 8th Street, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-25</td>
<td>15:01:01</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>6054 Northpark Drive, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:02:19</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>1300 Market Street, Phoenix, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:01:17</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>8850 Corporate Drive, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:02:03</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>50 West 50th Street, New York, NY</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:02:25</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>320 West 5th Street, New York, NY</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:01:08</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>8650 Corporate Drive, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:02:27</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>455 North Avenue, San Juan, Puerto Rico</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:01:32</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>163 South Bundy Avenue, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:01:26</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>2501 West 8th Street, London</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:02:42</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>845 Corporate Drive, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:03:08</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>IBM</td>
<td>3121 High Point Road, Scottsdale, SC</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:03:04</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>1300 Market Street, Phoenix, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:03:07</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>741 South Carnegie Boulevard, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:03:07</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>Lenovo</td>
<td>1100 S 8th Street, San Diego, CA</td>
<td>Computer</td>
<td>2019-04-26</td>
<td>12:03:07</td>
<td></td>
</tr>
</tbody>
</table>
• When you first access the change request, all CIs across all CI classes display.
• When you access the change request from the second time onwards, the configuration class of CIs displays the last added CI class. This ensures that relevant CIs are displayed.

**Note:** You can change the configuration class manually, which filters the list of CIs and therefore narrows the selection of CIs. For example, to filter for servers only, select **Server**. You can also save any filters you create to provide faster access to common CI searches.

4. You can perform one of the following actions to add selected CIs.
   - Click **Add Selected** to add the selected CIs to the change request.
   - Click **Add All** to add all of the CIs in the list to the change request.

The selected CIs are added to the change request.

**Extend multiple CI association**
You can extend multiple CI association to enable it for other types of tasks.
Role required: admin
1. Enter `sys_properties.list` in the navigation filter to open the System Property `[sys_properties]` table.
2. Open the **List of all the task types where user wants to associate CIs using a List** (com.snc.task.associate_ci) system property.

**Note:** The value of this property is set to `change_request` by default to enable association of multiple CIs to change requests.

3. To enable multiple CI association to other types of task, add the required table as a value. For example, to enable multiple CI association for problem records, add `problem` as a value.
4. Click **Update** to save and update the property.

**Disable multiple CI association**
You can disable multiple CI association from the related lists on change request records.
Role required: admin
1. Enter `sys_properties.list` in the navigation filter to open the System Property `[sys_properties]` table.
2. Open the **List of all the task types where user wants to associate CIs using a List** (com.snc.task.associate_ci) system property.
3. Remove the `change_request` value.
4. Navigate to **System UI > List control**.
5. To disable multiple CI association for the related lists:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated CIs</td>
<td>Open the entry with the <strong>task_ci.task</strong> related list and remove the selection from the <strong>Omit edit</strong> check box.</td>
</tr>
</tbody>
</table>
Bulk CI Changes

The Best Practice - Bulk CI Changes plugin enables you to record a single change proposal that will be linked to all affected CIs.

You can use Best Practice - Bulk CI Changes for change processes that use the following:

- **Proposed Change** to update CI data
- **Affected CI** related list to track impacted CIs
- change requests based on a single CI Class

If Best Practice - Bulk CI Changes is activated, then the following changes take place within a change request:

- For change requests with no CIs, **Associate CIs** displays the CI class on the change request by default and the **Reference** field, to change the configuration class, displays all the classes that are grouped under the CI class value on the change request. For example, if the CI class on the change request is **Server**, then you can only select a class that is grouped under **Server**.
- For change request with CIs, **Associate CIs** displays the class of the last associated CI. For example, if the last CI associated was **Linux Server**, then the configuration class displays **Linux Server** by default.

Configure change request to perform bulk changes to CIs

You can configure the change request form to perform bulk changes to CIs.

Role required: admin

The *Best practice- bulk CI changes* plugin is activated.

1. Configure the change request form as follows:
   a) Add the **CI Class** and **Proposed Change** fields, if they are not already visible.
      The **Proposed Change** field is hidden by a UI policy until a CI class is selected.
   b) Add the **Affected CIs** related list.
   c) Remove the **Configuration Item** field from the form because all CIs must be tracked through the **Affected CIs** related list.

2. Click **Save** to save and submit the details.

Users can perform bulk changes to CIs on the change request form.

Create a change request

You can create, progress, review, and close a change request.

Role required: itil or admin

1. Create the change request with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted Services/CIs</td>
<td>Open the entry with the <code>task_cmdb_ci_service.task</code> related list and remove the selection from the <strong>Omit edit</strong> check box.</td>
</tr>
</tbody>
</table>
Geneva    ServiceNow    IT Service Management

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| From the Change module         | You can create all three types of change from the Change module.  
| 1. Navigate to Change > Create New.  
| 2. Select one of the following types of change: Normal, Emergency, or Standard. |
| From an incident                | You can create only normal or emergency changes from an incident.  
| 1. Open the incident.           |
| 2. Right-click the incident header and select Create Normal Change or Create Emergency Change. |
| From a problem                  | You can create only normal or emergency changes from a problem.  
| 1. Open the problem.            |
| 2. Right-click the problem header and select Create Normal Change or Create Emergency Change. |
| From an existing change record. | If copying change requests is enabled by your administrator, you can create a new change from a copy of an existing change record.  
| 1. Open the change record that you want to copy.  
| 2. Click Copy Change.           |

Note:  
Manually created tasks from the existing change record are also copied, if the workflow when creating the task is setting the create_from field on the change_task table to workflow.

You can also create a change request from a CI.  
2. Fill in the fields as appropriate.

Table 59: Change request form

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by</td>
<td>Select the profile of the user who requested the change.</td>
</tr>
</tbody>
</table>
## Genev ServiceNow IT Service Management

### Name | Definition
--- | ---
**Category** | Enter the category of change. For example, **Hardware**, **Network**, **Software**.
**Configuration Item** | Select the configuration item (CI) that the change will apply to.
**Priority** | Select the priority for the change, from 1 (Critical) to 4 (Low).
**Risk** | The risk level for the change. In addition to manually evaluating the risk involved in a change, you can use the Change Risk Calculator.
**Impact** | Select the appropriate impact level (**High**, **Medium** or **Low**).
**Short description** | Enter a summary of the change.
**Description** | Enter a detailed description of the change.
**Assignment group** | Select the group that the change is assigned to.
**Assigned to** | Select the specific user that the change is assigned to. If an assignment rule applies, the change is automatically assigned to the appropriate user or group.

3. Click the **Planning** tab and enter information to plan the change.

4. Click the **Schedule** tab to enter a requested by date, a planned start and end date, and work start and end dates. For normal or emergency changes, the planned start and end dates are typically populated automatically during the **Authorize** state. Work start and end dates are populated automatically as the change progresses in and out of **Implement** state.

5. Click the **Conflicts** tab to detect change conflicts.

6. Right-click the form header and click **Save**.

7. Review entries in the related lists and modify the entries as appropriate.

### Table 60: Change Request related lists

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change Tasks</strong></td>
<td>The list of tasks can be created from a workflow. The default workflow generates tasks in <strong>Review</strong> state.</td>
</tr>
<tr>
<td><strong>Approvers</strong></td>
<td>This list is automatically generated from the workflow.</td>
</tr>
<tr>
<td><strong>Problems</strong></td>
<td>If the change was generated from a problem, this list is generated automatically.</td>
</tr>
<tr>
<td><strong>Affected CIs</strong></td>
<td>List of CIs (from the CMDB) that will be affected by the change. You can associate multiple affected CIs with a change.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Impacted services / CIs</td>
<td>List of business services (from the CMDB) that will be affected by the change. You can associate multiple impacted CIs with a change.</td>
</tr>
<tr>
<td>Incidents Pending Change</td>
<td>List of incidents that require the change for resolution.</td>
</tr>
<tr>
<td>Incidents Caused by Change</td>
<td>List of incidents that were caused by implementation of the change.</td>
</tr>
</tbody>
</table>

8. Click **Request Approval** when the change request is ready to progress into the life cycle for authorization. Click **Schedule** in case of standard changes.

   The change request moves into the **Assess** state and approval records are automatically generated based on the selected **Assignment group**. You can now conduct peer and technical reviews of the proposed change.

After a change request is created, it is sent for processing to the change manager. The change manager then reviews, approves, implements, and closes the change request as necessary.

In addition, you can **associate CIs** to the newly created change request.

### Create a change request template

You can create a template that can be used to create change requests with pre-defined supporting tasks.

Role required: admin

1. Navigate to **System Definition > Templates**.
2. Click **New** or open an existing change request template to modify.
3. Click **Configure > Form Layout** to add the following fields to the template: **Next related template**, **Next related child template**, **Link element**.
4. From the **Table**, choose from one of two default change request template configuration items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Link element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change_request</td>
<td>None. This object does not have a link element, because it is at root level.</td>
</tr>
<tr>
<td>Change_task</td>
<td>Parent. Because this task object is one level below root level, it uses the parent table as a link element. In this case, the parent is change_request.</td>
</tr>
</tbody>
</table>

5. Edit the fields on the change request template as needed:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this template.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table the template applies to.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make template available for use.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
User | User who can configure and apply the template. If a user is defined, no other users can see the template unless the **Global** check box is selected.
Group | A group whose members can configure and apply the template. If a group is defined, no other groups can see the template unless the **Global** check box is selected.
Global | Option for allowing any user who can access templates to view and apply this template.
Short description | Enter a unique short description for the template.
Template | This field automatically displays after selecting a table and used to auto-populate records.
  
  Click and select the field from the table. You can select multiple fields.
  
  Enter the information that auto-populates.
Next related template | Using this field creates a record at the same hierarchical level (sibling) as the current template.

  Using this field on a child template specifies an extra child template under the same parent template.

  This field is not supported on top-level templates.
Next related child template | This field creates a record at the hierarchical level below (child) the current template.

  You can assign a child template to a child template.
Link element | Use this field to link a record created from a child template to the record created from the parent template.

  The template script include chooses the first valid reference field that can link to the parent record when this field is left blank.

6. Click **Save** to save the change request template.

### Create a change request from a CI

You can create a change request from a list of CIs, or add selected CIs from a list to a change record.

**Role required:** itil, admin

1. Select a list of CIs. For example, navigate to **Configuration > Application Servers > Servers > Unix**.
2. Select one or more CIs from the appropriate list.
3. Select one of the following options from the **Actions** list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to existing Change Request</td>
<td>Select this option to associate the CIs with an existing change request.</td>
</tr>
<tr>
<td>Add to new Change Request</td>
<td>Select this option to associate the CIs with a new change request.</td>
</tr>
</tbody>
</table>

**Note:** The CIs with a **Business Service** CI class are added to the change request record's `Impacted Services/CIs` related list. The remaining CIs are added to the change request record's `Affected CIs` related list.

Depending on your selection, either an existing change requested is updated with the selected CIs or a new change request record is created with the selected CIs.

4. You can continue to create or modify the change record as required.
Request a standard change from the catalog

Standard change catalog can be used to request a new standard change from the published standard change templates.

Role required: itil

2. Select one of the following options depending on the type of standard change you want to request.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Standard Changes</strong></td>
<td>Request a standard change relating to network related changes.</td>
</tr>
<tr>
<td><strong>Server Standard Changes</strong></td>
<td>Request a standard change relating to servers and attached storage.</td>
</tr>
</tbody>
</table>

3. Select a template from the Items section. For example, **Add network switch to datacenter cabinet** in the Network Standard Changes > Items section.

   When you select the catalog item, a standard change is created. The Standard Change Request form is displayed with values from the standard change template.

Copy a change request

You can copy details of an existing change record to a new change record.

Role required: admin or change manager

The ability to copy a change enables you to:

- Configure the content that is copied.
- Copy the configured attributes, and reset all non-copied attributes to default values.
- Copy the configured related tables.

  **Note:** You cannot copy change details from a standard change.

New change tasks may be created when a change is copied. If your change record has associated workflows that create change tasks, then these change tasks may not be copied because they are created by the workflows. Only manually created tasks are copied, if the workflow when creating the task sets the created_from field on the change_task table to workflow. The created_from field has a default value of manual.

1. Navigate to the change request to be copied.
2. Use the **Copy Change** button on the change request form to copy change details.

   A preview of the new change record appears with values from the original source change record.

3. Edit values on the newly created change record, as appropriate.
4. Click **Save** to save and create a new change request record.

   **Note:** If you click Cancel, the copied change request record is cancelled and no new record is created.

After an existing change request is copied and a new one created, it is sent for processing to the change manager. The change manager then reviews, approves, implements, and closes the change request as necessary.

In addition, you can **associate CIs** to the newly created change request.
Configure ability to copy a change request

You can configure the ability to copy a change request record and also configure the specific details that can be copied.

Role required: admin

You can configure the ability to copy a change. You can do the following:

- Disable the ability to copy a change
- Disable the ability to copy an attachment
- Determine the components of the source change request that must be copied

You can configure the ability to copy a change request in the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Disable the ability to copy a change request</strong></td>
<td>The ability to copy a change request is enabled by default.</td>
</tr>
<tr>
<td></td>
<td>To disable the ability to copy a change request:</td>
</tr>
<tr>
<td></td>
<td>1. Set the <strong>Enable Copy Change feature</strong></td>
</tr>
<tr>
<td></td>
<td>(com.snc.change_request.enable_copy) system property to <strong>false</strong>.</td>
</tr>
<tr>
<td><strong>Disable the ability to copy an attachment</strong></td>
<td>The ability to copy an attachment to the change request is enabled by default.</td>
</tr>
<tr>
<td></td>
<td>To disable this ability:</td>
</tr>
<tr>
<td></td>
<td>1. Set the <strong>Enable copying of attachments from the originating change</strong></td>
</tr>
<tr>
<td></td>
<td>(com.snc.change_request.attach.enable_copy) system property to <strong>false</strong>.</td>
</tr>
<tr>
<td><strong>Disable the ability to copy the attachments to a change task in the Change Tasks related list of a change request</strong></td>
<td>The ability to copy the attachments to a change task in the <strong>Change Tasks</strong> related list of a change request is enabled by default.</td>
</tr>
<tr>
<td></td>
<td>To disable this ability:</td>
</tr>
<tr>
<td></td>
<td>1. Set the <strong>Enable copying of attachments from the originating change's related change tasks</strong></td>
</tr>
<tr>
<td></td>
<td>(com.snc.change_request.rl.change_task.attach.enable_copy) system property to <strong>false</strong>.</td>
</tr>
</tbody>
</table>

**Note:** If the ability to copy attachments is enabled, the attachment will appear on the new change request form only after the change request is saved.

© 2017 ServiceNow. All rights reserved. 229
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Configure attributes to be copied | Common attributes such as columns in the change table are copied by default. To configure the attributes to be copied:  
  1. Edit the list of values in the List of attributes (comma-separated) that will be copied from the originating change (com.snc.change_request.copy.attributes) system property to remove or add more attributes. For example, to the Assigned to attribute from being copied, remove the assigned_to value from the List of attributes (comma-separated) that will be copied from the originating change property. |
| Configure related lists to be copied | The following related lists in a change record are copied by default:  
  - Affected CIs  
  - Impacted Services/CIs  
  - Change Tasks  
  
  Note: You can configure this property to control the copy functionality of the Affected CIs, Impacted Services/CIs, and Change Tasks related lists. You cannot add any other related list to this property.  
  
  To configure the lists to be copied:  
  1. Edit the list of values in the Related lists (comma-separated) that will be copied from the originating change (com.snc.change_request.copy.related_lists) system property. For example, to stop copying the Change Tasks related list, remove the change_task value from the Related lists (comma-separated) that will be copied from the originating change property. |
Geneva  ServiceNow  IT Service Management

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure attributes of related lists to be copied</td>
<td>You can configure the attributes of related lists to be copied using appropriate system properties. To configure the attributes of related lists to be copied:</td>
</tr>
<tr>
<td></td>
<td>1. Navigate to the appropriate system property for a specific related list to configure the attributes that must be copied. The property name will be com.snc.change_request.copy.rl.&lt;table name&gt;.attributes.</td>
</tr>
<tr>
<td></td>
<td>You can modify the following system properties to configure the attributes of related lists to be copied:</td>
</tr>
<tr>
<td></td>
<td><strong>Table 61: System properties for related list attributes</strong></td>
</tr>
<tr>
<td>Name of the Related list</td>
<td>System property</td>
</tr>
<tr>
<td>Change Tasks</td>
<td>com.snc.change_request.copy.rl.change_task.attributes</td>
</tr>
<tr>
<td>Affected CIs</td>
<td>com.snc.change_request.copy.rl.task_ci.attributes</td>
</tr>
<tr>
<td>Impacted Services/CIs</td>
<td>com.snc.change_request.copy.rl.task_cmdb_ci_service.attributes</td>
</tr>
<tr>
<td></td>
<td><strong>Customize the copy a change request ability</strong></td>
</tr>
<tr>
<td></td>
<td>To further customize the ability to copy a change request:</td>
</tr>
<tr>
<td></td>
<td>1. Modify the ChangeUtils script include, which extends the default ChangeUtilsSNC script include. For example, the ability to copy a change request is not available by default for standard changes. However, you can provide your own implementation of the isCopyRulesValid function in the ChangeUtils script include to override the default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must not modify the ChangeUtilsSNC script include.</td>
</tr>
</tbody>
</table>

Analyze risk of change and detect conflicts

After you create a change request, you can assess and analyze the risk and impact involved in the change request and also review any conflicts that may be detected.
Role required: admin or change_manager

Analyze risk of change and review detected conflicts in the following ways.

Perform risk assessment

You can perform risk assessment of your change records after the risk assessment criterion are defined.

Role required: itil or change_manager

1. Open your submitted change request and click the Fill Out Risk Assessment related link. The most appropriate risk assessment based on the definition is displayed.
2. Answer the questionnaire and click Submit.

3. After the risk assessment is complete, click the Execute Risk Calculation related link to calculate the risk based on the assessment.

The results of the risk calculation are displayed.
View a risk assessment response

You can view the risk assessment responses associated with a change request.

Role required: admin, survey_admin, or survey_reader

You can view the risk assessment response in one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Change Management       | Users with admin role can add the Task Assessment > Task related list to the change request form.  
                           | The related list displays risk assessments associated with the change request. Click the reference icon for an assessment to view the responses. |
| Task Survey Management  | Users with survey_admin or survey_reader roles can navigate to Survey > Survey Responses and filter by Instance.  
                           | Survey instances are individual assessments and are distinguished by the date and time when they are taken. |

Review detected change conflicts

You can run review the details of conflicts detected after running either automated or manual conflict detection.

Role required: admin

Before you can review the conflicts detected for a change request, you must detect conflicts in one of the following ways:

- Detect change conflicts manually on page 235
- Detect change conflicts automatically on page 234

After you run conflict detection, you can view the following information regarding conflicts that have been detected.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change</td>
<td>A reference to the scheduled change that has a conflict.</td>
</tr>
<tr>
<td>Affected CI</td>
<td>The affected CI associated with the change.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conflicting change</td>
<td>The change that is in conflict with the scheduled change, if any.</td>
</tr>
<tr>
<td>Related Configuration Item</td>
<td>The parent CI or child CI of the current CI, if it has caused a conflict.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The maintenance window or blackout window that is causing the conflict, if any.</td>
</tr>
</tbody>
</table>
| Type                          | The issue that caused the conflict. You can change the issue to one of the following options:  
                                | • CI Already Scheduled 
                                | • Parent CI Already Scheduled 
                                | • Child CI Already Scheduled 
                                | • Not in Maintenance Window 
                                | • Parent Not In Maintenance Window 
                                | • Child Not In Maintenance Window 
                                | • Blackout                     |
| Last Checked                  | The last time the conflicts were checked. It displays the current time by default. The Last Checked field is automatically updated. |

**Detect change conflicts automatically**

You can automate conflict detection to run at specific intervals or when a change request is updated.

Prior to running conflict detection, you must consider the following scenarios unique to your organization.

- **CMDB list size and relationship complexities**  
  If you are a large organization with a large CMDB, conflict detection might take longer to complete.
- **Inactive changes are not evaluated**  
  Conflict detection does not evaluate inactive changes when determining conflicting changes.
- **Advanced mode conflict checking is switched off by default**  
  When you upgrade, advanced mode conflict checking is switched off by default. Hence, affected CIs are not considered during conflict detection. In order to evaluate all the CIs, set the mode to **Advanced**.

Role required: admin or change_manager

1. Navigate to **Change > Administration > Conflict Properties**.
2. Select one of these options.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run conflict detection automatically after changes to Configuration item, Planned start date, Planned end date or State when a change request is updated</td>
<td>Runs conflict detection automatically when a change to one or more of the following fields is saved.</td>
</tr>
<tr>
<td></td>
<td>• Configuration item</td>
</tr>
<tr>
<td></td>
<td>• Planned start date</td>
</tr>
<tr>
<td></td>
<td>• Planned end date</td>
</tr>
<tr>
<td></td>
<td>• State</td>
</tr>
<tr>
<td>Enable the scheduled change conflict checker</td>
<td>Runs conflict detection at these intervals:</td>
</tr>
<tr>
<td></td>
<td>Change Conflict Detection &lt; 1 Week Away is scheduled every day</td>
</tr>
<tr>
<td></td>
<td>Change Conflict Detection &lt; 1 Month Away is scheduled every two days</td>
</tr>
<tr>
<td></td>
<td>Change Conflict Detection &gt;=1 Month Away is scheduled every 7 days</td>
</tr>
</tbody>
</table>

3. Click **Save**. You can view the conflicts in the **Conflicts** tab on the change request.

### Detect change conflicts manually

You can run conflict detection manually for a change request.

Before you can run conflict detection for a change, the following fields must be completed for the change request:

- **Configuration item**, except in advanced mode. In advanced mode, the **Affected CIs** field is required instead.
- **Planned start date**
- **Planned end date**

Prior to running conflict detection, you must consider the following scenarios unique to your organization.

- **CMDB list size and relationship complexities** If you are a large organization with a large CMDB, conflict detection might take longer to complete.
- **Inactive changes are not evaluated** Conflict detection does not evaluate inactive changes when determining conflicting changes.
- **Advanced mode conflict checking is switched off by default** When you upgrade, advanced mode conflict checking is switched off by default. Hence, affected CIs are not considered during conflict detection. In order to evaluate all the CIs, set the mode to **Advanced**.

Role required: admin or change_manager

1. Navigate to **Change > Open**.
2. Open the change request that you want to check conflicts for.
3. Click the **Conflicts** tab.
4. Click **Check Conflicts**.
Any conflicts appear in the **Conflicts Detected** list.

You can **review the detected conflicts** and resolve them.

## Process a change request

You can approve, implement, review, and close a change request.

**Role required:** ITIL, admin, or change manager

Before you process a change request, ensure that you have *detected any change conflicts* and *performed risk assessment*.

You can perform the following actions on a change request based on your role.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Approve or reject a change request</strong></td>
<td>Open the approval record and click <strong>Approve</strong> to approve the change request or <strong>Reject</strong> to reject it. The change request moves into the <strong>Scheduled</strong> state if it is approved or to <strong>New</strong> state if it is rejected.</td>
</tr>
<tr>
<td><strong>Role required:</strong> change management</td>
<td></td>
</tr>
<tr>
<td><strong>Implement a change request</strong></td>
<td>Click <strong>Implement</strong> to put the change request into action. The change request moves into the <strong>Implement</strong> state and the workflow creates two change tasks: <strong>Implement</strong> and <strong>Post-implementation testing</strong>.</td>
</tr>
<tr>
<td><strong>Role required:</strong> change management</td>
<td></td>
</tr>
<tr>
<td><strong>Review a change request</strong></td>
<td>Click <strong>Review</strong> after reviewing the details on the change request. The change request is moved to the <strong>Review</strong> state. All active change tasks are set to <strong>Closed Incomplete</strong>.</td>
</tr>
<tr>
<td><strong>Role required:</strong> change management</td>
<td></td>
</tr>
<tr>
<td><strong>Close a change request</strong></td>
<td>Click <strong>Close</strong> after entering the change request closure information in the <strong>Closure Information</strong> section. The change request is closed.</td>
</tr>
<tr>
<td><strong>Role required:</strong> change management</td>
<td></td>
</tr>
</tbody>
</table>

### Perform bulk changes to CIs on a change request

You can perform bulk changes to CIs from the change request form.

**Role required:** admin

The Best Practice - Bulk CI Changes plugin is activated and the change request form is configured to perform bulk changes to CIs.

1. On the change request form, select a CI class. The form will save and submit if all required fields are completed.
2. Click **Edit** on the **Affected CIs** related list. The selection is filtered to display only CIs from the selected CI class.
3. Add the CIs that are involved in the change.
4. Enter the proposed changes in the **Proposed change** field. Whenever the **Proposed change** field is modified or affected CIs are added, the saved changes are linked to all affected CIs.

5. Click **Update** to save and update the record. The resulting changes are listed at the top of the form. The following messages display on the form only if there are CIs listed in the **Affected CIs** list.
Place a change request on hold

You can put a change request on hold if it is not in the **New**, **Canceled**, or **Closed** state.

Roles required: itil, admin, or change manager

When a change request is placed on hold, these conditions are applied to it:

- If the change is waiting for any approvals, then the pending approvals are marked **No Longer Required**. When the change request is no longer on hold, then the pending approvals are reinstated and are **Awaiting approval**.
- The change can progress to only the **Canceled** state while it is on hold.
- If a change request is cancelled while it is on hold, then its on hold flag is set to false so the change cannot be canceled and still be on hold.

1. Navigate to **Change > Open**.
2. Open the specific change request.
3. Select the **On hold** check box.
4. In the **On hold reason** field, enter the reason for placing the change request on hold
5. Click **Save**.

**Configuration Management**

With the ServiceNow® Configuration Management application, build logical representations of assets, services, and the relationships between them that comprise the infrastructure of your organization. Details about these components are stored in the configuration management database (CMDB) which you can use to monitor the infrastructure, helping ensure integrity, stability, and continuous service operation.

CMDB Identification and Reconciliation is a core feature in Configuration Management which provides a mechanism for identifying and reconciling data when different data sources such as Discovery create and update CI records.

**Explore**
- CMDB release notes
- Configuration Management and the CMDB on page 239
- CMDB Identification and Reconciliation on page 268
- CMDB and Extended CMDB on page 287
- Enterprise CMDB on page 304

**Set up**
- Options to populate the CMDB on page 289
- Whitepaper: CMDB Design & Configuration
- Whitepaper: CMDB Design
- Whitepaper: Improving Configuration Item Data Quality

**Administer**
- Baseline CMDB on page 243
- CI relationships in the CMDB on page 249
- CMDB classifications on page 262

**Use**
- Create CI class on page 266
- Create or edit a CI relationship on page 256
- Add a proposed change to a CI on page 245

**Develop**
- Developer training
- Developer documentation

**Troubleshoot and get help**
- Search the HI knowledge base for known error articles
- Contact ServiceNow Support

**Configuration Management and the CMDB**

Build and maintain the logical service configurations of the infrastructure and application domains that support a service.

These logical service configurations are mapped with the physical configuration / inventory data of the supporting infrastructure and application elements in the respective domains. They track the physical and
logical state of IT service elements and associate incidents to the state of service elements, which helps in analyzing trends and reducing problems and incidents.

The configurations are stored in a configuration management database (CMDB) which consists of entities, called Configuration Items (CI), that are part of your environment. A CI may be:

- A physical entity, such as a computer or router
- A logical entity, such as an instance of a database
- Conceptual, such as a Requisition Service

In each case, there are attributes about the CI that you want to maintain, and there is control you want to have over the CI. There are changes that may need to be made and tracked against the CI. Also, a CI does not exist on its own. CIs have dependencies and relationship with other CIs. For example, the loss of a bank of disk drives may take a database instance down, which affects the requisition service that the HR department uses to order equipment for new employees.

It is this relationship data that makes the CMDB a powerful decision support tool. Understanding the dependencies and other relationships among your CIs can tell you, for example, exactly who and what is affected by the loss of that bank of disk drives. When you find out that a router has failed, you will be able to assess the effect of that outage. When you decide to upgrade the processor in a server, you can tell who or what will be affected during the outage.

Configuration items are a personal issue, because each customer has a unique environment. Details about the exact physical attributes of a computer may be needed by one customer, but may represent meaningless data to another. The ServiceNow platform provides a mechanism to easily define new classes of configuration items and new relationships that may exist between CIs. New classes can be defined that extend other classes. For example, a laptop class exists that extends the computer class. The computer class itself extends the base CI class. Customer class extensions are automatically part of the ServiceNow environment and blend seamlessly into the integration points for other ITIL processes.

Relationships between CIs can be displayed in a hierarchical fashion, and adding or removing relationship instances is done with a simple double-click of your mouse.

**ITIL Configuration Management integration**

The CMDB has relationships with IT service management processes in the following areas: ITIL incident management, ITIL problem management, ITIL change management, ITIL service catalog management, and financial management.

**ITIL Incident Management**

Configuration management assists incident management by providing the Service Desk with immediate information on the CIs affected, and more timely resolution of faults by understanding what CIs have been affected and changed.

**ITIL Problem Management**

Configuration management assists problem management by linking the CIs affected by problems to the incident / problem / change management processes, and ensuring the CI status is properly maintained.
ITIL Change Management

Configuration management assists change management by recording which CIs have been changed and controlling the status of CIs throughout the entire CI lifecycle. Configuration management ensures any changes made to CIs are recorded and kept accurate.

ITIL service catalog management

With Service Portfolio Management on page 882, business services in the CMDB can also be managed by the Service Catalog team, and exposed to end users who can then request items from them.

Financial management

With Cost Management, costs can be associated with configuration items, so that the cost associated with configuration management can be tracked and bundled into expense lines, budgets, or cost centers.

ITIL

The IT Infrastructure Library (ITIL) is an integrated, process-based, best practice framework for managing IT services.

It provides guidance for creating and operating a Service Desk that provides efficient communication between the user community and the IT provider. Originally initiated to improve IT service management for the UK central government, it has become a standard for many organizations; public or private sector, large or small, centralized or distributed.

ITIL provides processes for three service concepts: design, transition, and operation.

<table>
<thead>
<tr>
<th>Service concept</th>
<th>Processes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design</td>
<td>• service level management</td>
</tr>
<tr>
<td></td>
<td>• availability management</td>
</tr>
<tr>
<td></td>
<td>• capacity management</td>
</tr>
<tr>
<td></td>
<td>• supplier management</td>
</tr>
<tr>
<td></td>
<td>• service catalog management</td>
</tr>
<tr>
<td>Transition</td>
<td>• change management</td>
</tr>
<tr>
<td></td>
<td>• knowledge management</td>
</tr>
<tr>
<td></td>
<td>• asset management</td>
</tr>
<tr>
<td></td>
<td>• configuration management</td>
</tr>
<tr>
<td></td>
<td>• release management</td>
</tr>
<tr>
<td>Operation</td>
<td>• request fulfillment management</td>
</tr>
<tr>
<td></td>
<td>• event management</td>
</tr>
<tr>
<td></td>
<td>• incident management</td>
</tr>
<tr>
<td></td>
<td>• problem management</td>
</tr>
<tr>
<td></td>
<td>• facilities service automation</td>
</tr>
</tbody>
</table>
Service design

This guide provides a general overview of ITIL service design concepts.

Service level management

The service level management process is designed to ensure customer satisfaction within IT service processes. Service level agreements are made between the IT staff and the customers, and the IT desk must monitor their performance as compared to the agreements. In addition, underpinning contracts with external vendors and operational level agreements with internal vendors ensures that these service level agreements are feasible.

Availability management

The availability management process ensures that availability within a system is kept as close to 100% as possible. By both reacting to past service failures, and planning to avoid future service failures, availability management can greatly increase end-user satisfaction with services.

Capacity management

The capacity management process is designed to ensure that business services are not made unavailable by over-capacity. By analyzing past failures and planning for growth of demand of services, capacity management can increase end-user satisfaction with services.

Supplier management

Supplier management is a process that defines and monitors agreements between an IT department and an external supplier.

Service catalog management

The service catalog provides a front end for customers to request items and services. Service catalog management ensures that this service catalog provides accurate and useful information on the items and services.

Service transition

This guide provides a general overview of ITIL service transition concepts and how the ServiceNow platform can enable these processes.

Change management

The change management process ensures that standardized methods and procedures are used for efficient and prompt handling of all changes to minimize the impact of change related incidents on service quality. Consequently, change management aims to improve the day-to-day operation of the organization. IT-related changes that may affect one or many customers are tracked with change management. Adding memory to one machine, getting a new server, and installing the latest Windows OS on all PCs are all
examples. To find out how the ServiceNow platform implements change management, see Change Management on page 149.

**Knowledge management**

The knowledge management process ensures that important information flows freely throughout the IT organization. Knowledge management keeps the CMDB and knowledge base of an organization up-to-date, and uses a knowledge-centered support approach to reduce repeat incidents and problems. For more information, see Knowledge Management.

**Asset management**

Asset management enables a process of monitoring processes, organizations, people, information, applications, infrastructure, and financial capital within an organization. This allows the organization to collect accurate records of these business components, making them available for both internal and external auditing processes. To find out how out the ServiceNow platform implements asset management, see Asset Management on page 5.

**Configuration management**

Configuration management provides a logical model of the infrastructure or a service by identifying, controlling, maintaining and verifying the Configuration Items in existence. To find out how the ServiceNow platform implements configuration management, see Configuration Management on page 239.

**Release management**

This discipline of IT service management is the management of all software configuration items within the organization. It is responsible for the management of software development, installation and support of an organization's software products. Software Control & Distribution procedures include the management of the software Configuration Items and their distribution and implementation into a production environment. This involves the definition of a release program suitable for the organization, the definition of how version control is implemented, and the procedures surrounding how software is built, released and audited. For more information, see Release Management.

**Baseline CMDB**

CMDB baselines provides capabilities that help you to understand and control the changes that have been made to your configuration items.

- You can create a baseline, which is a snapshot of your configuration items. You can review the changes that have been made to that configuration item since a previous baseline. Multiple baselines may be created and the system tracks the changes that have been made per baseline.

  Creating a baseline captures the attributes of the CI as well as all first level relationships for the CI. Any changes to the base CI or to any related CIs are captured and displayed. Newly created CIs are not automatically added to a baseline.

- You can associate a configuration item with a task, generally a change or change task, and to propose changes that are to be made to the CI after the change is complete. You can record changes, and these changes are not applied to the CI immediately but are delayed until the change is complete.
When the change is complete, you can choose to apply the proposed changes which makes all changes previously proposed and associates the changes with the task.

You need the ecmdb_admin role to create and access baselines.

**Create a CMDB baseline**

You can create a baseline for a CI to track updates to the CI over time.

**Role required:** ecmdb_admin

1. Navigate to Configuration > Baselines > Baselines.
   - If the Baselines module is not visible in the Configuration application, the module may be inactive. In that case append /sys_app_module.do?sys_id=f4463879a9fe3dba01b30bc100cbf404 to the instance URL, and in the Module - Baselines form, ensure that the module is Active.
2. Click New.
3. Enter a Name for the baseline.
   - By default, the cmdb_ci table is selected so that the record creates the baseline for all configuration items in the system.
4. Optional: To limit the baseline to specific CIs, select a different Table or choose Conditions that a CI must meet for it to have a baseline entry.
   - For example, you might create a baseline for the Database table with the condition [Location] [is] [<configured location>].
5. Click Submit.
   - The creation of a baseline is time consuming and occurs in the background. A message at the top of the record list notifies you that your baseline has been scheduled and that you will receive an email when the process is complete.

**Display baseline differences**

You can see the changes that have been made to a CI or any first level related CIs by configuring the CI form layout to display the CMDB Baseline diff field. This field is labeled Baseline differences on the form.

1. Open a CI record.
2. Select the baseline you want to see for this CI from the choice list.
   - The field displays the details of any changes that were made to the current record for the selected baseline, or indicates that no changes were made.

<table>
<thead>
<tr>
<th>Baseline differences</th>
<th>For: SQL Baseline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic attribute changes</td>
<td></td>
</tr>
<tr>
<td>2009-09-14 14:46:49 System Administrator - Changed: RAM (MB), Disk space (GB)</td>
<td></td>
</tr>
<tr>
<td>RAM (MB): 4 was: -1</td>
<td></td>
</tr>
<tr>
<td>Disk space (GB): 500 was: 100</td>
<td></td>
</tr>
</tbody>
</table>

3. To add a relationship to the CI, click the green plus icon in the Related Items toolbar.
   - The new relationship appears below the toolbar. For more information about the Related Items toolbar and how to control the display, see CI relations formatter on page 251.
4. Update a related CI and see the changes displayed as Basic attribute changes in the current CI record.
Proposed changes

You can pre-configure changes to configuration items (CIs) and their associated relationships by using proposed changes. These changes are prepared for implementation and then applied at a later time.

When you view a CI, you can display any proposed changes to see what is planned for the CI.

Proposed changes are useful when you want to make modifications while a change process is in the approval stage, and only implement the changes after the approvals are complete. If a change is never approved, there are no record changes to reverse. If the change is approved, a quick command applies all the proposed changes.

You can make the following proposed changes to a CI:

- Modify any field on the CI form.
- Add, modify, or delete a relationship to the CI.

You cannot delete a proposed change.

View proposed changes to a CI

You can view what is planned for a CI by displaying the proposed changes for it.

Role required: personalize_form

Configure the CI form layout to display the CMDB Scheduled Changes field. By default, proposed changes are not displayed.

1. Navigate to Change > Open and open a change request.
2. In the Affected CIs related list, open the Configuration Item.
   You can also navigate directly to the CI form.
3. Right-click the form header, and select Configure > Form Layout.
4. Move the CMDB Scheduled Changes field to the Selected pane.
5. Click Save.
   The CI form reopens and displays details in the Scheduled changes section about any proposed changes.

Add a proposed change to a CI

Proposed changes to a CI can be made while viewing a change request or any task-related record.

Role required: itil

1. In the Change Request form, go to the Affected CIs related list.
If there are no CIs in the Affected CIs list, click **Edit** to add CIs that are affected by this change request.

2. Right-click the CI that you want to configure for a proposed change, and select **Propose Changes**.

3. Complete the form to make the proposed changes, and click **Save Proposed Changes**.

   Clicking **Update** applies the changes immediately. Clicking **Delete** deletes the CI.

4. If you are proposing additions to a relationship to the CI, click the plus icon in the **Related Items** section, define the relationship and click **Save Propose Change**. Confirm saving the proposed change.

   **Note:** Use only with CI relationships. Proposing additions to relationships is not valid for user relationships and group relationships.

5. If you are proposing to delete a relationship to the CI, click the relationship icon beside the relationship you want to delete, and click the **Save Proposed Delete** button.

   Clicking **Update** or **Delete** commits the change immediately.

   After the proposed changes are saved, the **Apply Proposed Changes** button appears on the Change Request form. This button allows the user to commit the proposed changes to the CI. Your business processes determine the appropriate time to commit the changes. The CI retains the existing data until the proposed changes are committed. However, users can see that changes have been proposed.

### Apply a proposed change to a CI

When you apply proposed changes, all the proposed changes for that change request are applied to the configuration item.

Before applying proposed changes, it is recommended that you verify the changes. You can configure the rules that are used to verify changes.

Changes can still be applied if they are unverified or fail verification.

**Role required:** itil

1. Navigate to the **Change Request** form with the proposed changes that you want to apply.

2. Click **Apply Proposed Changes**.

   You may have to right-click the form header and select **Reload form** to see the changes.

When users view proposed changes for the CIs affected by the change request, the applied changes are no longer displayed in the **Scheduled changes** section of the CI form.

### Create or edit a proposed change verification rule

To ensure that proposed changes meet business requirements and do not introduce invalid data to the CMDB, create a rule that includes a script to verify the proposed changes.

**Role required:** asset or itil

When you configure proposed change verification rules for a CI, you have an option to verify that the proposed changes pass the verification test script in the rule. The verification test results are logged as passed or failed, and you can view the results. Running the verification test is not mandatory, and a failed verification test does not prevent you from applying proposed changes.

1. Navigate to **Configuration > Change Verification > Proposed Change Verification Rules**.

2. Click **New** or select an existing rule to edit.
3. Fill in the fields, as appropriate.

Table 62: Proposed Change Verification Rules form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule name</td>
<td>The name of this rule.</td>
</tr>
<tr>
<td>Table name</td>
<td>The table to which the rule applies.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Conditions to apply this rule to specific CIs.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this rule.</td>
</tr>
<tr>
<td>Rule script</td>
<td>A verification Java script that needs to return true or false. For example:</td>
</tr>
</tbody>
</table>

```javascript
validateRule()
{
    var os = current.getValue("os");
    var cpu = current.getValue("cpu_count");

    //Use current.getValue(fieldName) to get the proposed change value, eg. var os = current.getValue("os");

    //Your verification code
    if (os != "SunOS" || cpu < 2) return false;
    return true;
}
```

4. Click Submit or Update.

On the Change Request form, you can click Verify Proposed Changes to verify proposed changes for the affected CIs.

Verify proposed changes

Before applying proposed changes to affected CIs, use proposed change verification rules to verify that the changes meet business requirements and do not add invalid data to the CMDB.

Create or edit the rules used to verify proposed changes. For details, see Create or edit a proposed change verification rule on page 246.

Role required: none

You can apply proposed changes even if they are unverified or fail a verification test.

1. Open the Change Request form that affects the CI.
2. Click Verify Proposed Changes.
   The proposed changes are verified against any proposed change verification rules in which the CI meets the Filter condition criteria.
3. Review the message that appears at the top of the form after the verification process is finished.
The message states whether the verification tests passed or failed.

To view the details of any verification tests that were performed for the change request in the past two days, click the **Proposed Change Verification Log** related link.

### Create or edit a planned change validation script

Create a custom script that checks if a change to a class was valid according to business requirements, and whether the change was planned or not. A planned change validation script is used whenever a CI change is viewed in the CI timeline or change history.

**Role required:** admin or itil

The system attempts to validate each CI change as follows:

- If a custom script exists for the CI or one of the CI parents, then the script is executed and the results are used to flag the change as valid or invalid. Parent CIs are examined in the hierarchical order.
- If a custom script does not exist for the CI or any of its parents, then a predefined validation script is used. The change is determined as a planned change if the change occurred between the **Work start** and **Work end** dates of the change request associated with the changed CI.

However, this check is not always reliable because a user might have manually modified the CI within the work dates, which flags the change as valid even if it is invalid.

The script needs to return a boolean, true or false, which depends on meeting the test criteria in the script. You can define a separate script for each CI class, and you can define multiple planned change validation scripts for a single class. For example, to maintain different versions of the script. Only one script can be active for a CI class at any given time.

These are the parameters that uniquely characterize a change:

- The fields that were changed
- The data source that performed the change
- The time stamp of the change

To correctly determine the validity of a change, examine all of these parameters and apply business logic to evaluate if the validation tests are met. A planned change validation script can test any of these characteristics and determine if a change meets pre-established criteria. For example, the custom script can check if the mode of the CI is operational or maintenance, or who initiated the change.

1. Navigate to **Configuration > Change Verification > Planned Change Validation Script**.
2. Click **New** or select a validation script to edit.
3. Complete the form.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box to activate this script for validating changes.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Class that this script applies to.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to run to validate a change. If the script does not return a boolean value, then it is configured to false.</td>
</tr>
</tbody>
</table>

The script has a template which displays the input variables of the script.
Table 64: Template script input variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>current</td>
<td>GlideRecord</td>
<td>Current record that is being processed.</td>
</tr>
<tr>
<td>updatedOn</td>
<td>GlideDateTime</td>
<td>Time stamp of the change.</td>
</tr>
<tr>
<td>updatedBy</td>
<td>String</td>
<td>Entity responsible for the change.</td>
</tr>
<tr>
<td>fieldsChanged</td>
<td>String</td>
<td>Comma-separated list of the names of all fields that were changed.</td>
</tr>
</tbody>
</table>

This sample script checks who initiated the record update. It returns true if admin initiated the record update. Otherwise, the script returns false.

```javascript
isValidChange();

function isValidChange(/*GlideRecord current, GlideDateTime updatedOn, String updatedBy, String changedFields*/)
{
    //Return true if the user that updated the record has an admin role
    return isUserAdmin(updatedBy);
}

function isUserAdmin(userName)
{
    var grUser = new GlideRecord("sys_user");
    grUser.addQuery('name', userName);
    grUser.query();
    if(grUser.next())
    {
        var roles = new GlideRecord("sys_user_has_role");
        roles.addActiveQuery();
        roles.addQuery('user', grUser.sys_id);
        roles.query();
        while(roles.next())
        {
            if(roles.role.name == 'admin')
            {
                return true;
            }
        }
    }
    return false;
}
```

4. Click Submit.

CI relationships in the CMDB

The CMDB, in contrast to a static asset list, helps you track not only the configuration items (CIs) within your system, but also the relationships between those items.

A relationship in the CMDB consists of two CIs and a relationship type:

- Parent CI
• Child CI
• Type of the relationship that links both CIs

For example, in the [Server1] [Managed by] [Server2] relationship:
• Server1 is the child CI
• Server2 is the parent CI
• [Managed by] is the relationship type

For example, a web application might read data from a particular instance of Oracle, which in turn might depend on a piece of underlying hardware. Most CIs in a CMDB have multiple relationships to other CIs, users, and groups.

The relationships between CIs can be automatically discovered. If you use Discovery, many relationships can be automatically loaded into the system through the discovery process. If you import your data from another system, you may get some form of relationships.

You can add to automatically discovered relationships, create new relationships, or edit relationships for a CI by launching the CI relationship editor from the CI form.

Suggested CI relationships

The system keeps a table of relationship types that are appropriate for a CI type, based on its class. You can view these relationships by navigating to Configuration > Suggested Relationships. You can also create additional suggested relationships.

Suggestion model

The relationship editor has a concept of a base CI, which designates the CI that a user was on before launching the editor, as the base CI in the new relationship. If you launched the relationship editor from the Linux100 CI, then Linux100 becomes the base CI. Also, every CI in the system has a type (class). For example, bond Linux100 is of the Linux server type.

Many CI types are children of other types in the hierarchy. For example, the class hierarchy for a Linux server is:

\[ \text{cmdb\_ci} \rightarrow \text{cmdb\_ci\_computer} \rightarrow \text{cmdb\_ci\_server} \rightarrow \text{cmdb\_ci\_linux\_server} \]

When looking at a Linux server, the suggestion model works by analyzing the suggested relationship table for all relationships whose base class is the user's current base class or any one of its parent classes. For example, when looking at a Linux server, the suggestion model would retrieve any relationships whose base class was:

\[ \text{cmdb\_ci\_linux\_server}, \text{cmdb\_ci\_server}, \text{cmdb\_ci\_computer}, \text{or cmdb\_ci} \]

Suggested CI relationships in the relationship editor

The CI relationship editor uses the suggestion model to help users select reasonable relationships for configuration items.

For example, consider these relationship types in the system:
• Provides Power for :: Receives Power From
• Runs on :: Hosts
A user may reasonably want to define the following relationship between two items as follows:

- a database runs on a server
- a rack provides power for a server

But neither of the following definitions would be appropriate:

- a rack runs on a server
- a server runs on a database

**Add a suggested CI relationship**

You can define suggested relationships which can then be selected when creating new CI relationships.

Role required: ecmdb_admin or admin

To add a new suggested relationship:

1. Navigate to Configuration > Relationships > Suggested Relationship.
2. Click New, and complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base class</td>
<td>Parent CI in the relationship.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Relationship type.</td>
</tr>
<tr>
<td>Dependent class</td>
<td>Child CI class in the relationship.</td>
</tr>
</tbody>
</table>

For example you can add suggested relationships such as the following:

<table>
<thead>
<tr>
<th>Base Class</th>
<th>Relationship</th>
<th>Dependent Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>Is Hosted On</td>
<td>Linux Server</td>
</tr>
<tr>
<td>Oracle</td>
<td>Is Hosted On</td>
<td>Solaris Server</td>
</tr>
</tbody>
</table>

**Note:** You can have the same parent class and relationship appear more than once.

3. Click Submit.

You can delete a suggested relationship to ensure that only appropriate relationships are created. For example, to limit the list of available relationships in the CI relationship editor. Removing a suggested relationship does not have any affect on relationships that are created or updated by Discovery.

**CI relations formatter**

The default CI form includes a CI relations formatter from which you can examine a CI and its relationships in various views. From the CI relations formatter, you can also launch the CI relationship editor for the CI.

The CI relations formatter contains a list of related CIs and a toolbar with controls for viewing the relationships between the current CI and related CIs. You can configure the controls in this formatter to modify varying aspects of the view.
Note: On instances that do not meet the Internet browser requirements for the CI relations formatter, the default CI form includes the legacy CI relations formatter instead. For more information, see Legacy CI relations formatter on page 254.

### Table 66: Controls for viewing related CIs

<table>
<thead>
<tr>
<th>Control</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Add CI relationship]</td>
<td>Starts the relationship editor to manually create CI relationships. For more information, see Create or edit a CI relationship on page 256.</td>
</tr>
<tr>
<td>![Show dependency views]</td>
<td>Launches a Dependency Views map in another window or tab. The form's CI is the central node in the map, with a configurable number of levels above and below that node in the hierarchy. Map indicators next to the nodes indicate the number of tasks, incidents, problems, changes, or outages related to that node. Right-click to expand collapsed nodes or display a list of related tasks or problems.</td>
</tr>
<tr>
<td>![Search for CI]</td>
<td>Filters the CIs included in the display.</td>
</tr>
</tbody>
</table>

Click the Settings icon to configure additional view settings that filter the data displayed. Settings are preserved through logging out and logging back in.

### Table 67: Related Items settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Relations in Flat/Tree Layout</td>
<td>To view a flat list of related CIs that are grouped by relationship type in alphabetical order, click Flat. To view groups of related CIs in a hierarchical tree, click Tree. If you select the tree view, you cannot configure any other settings for viewing related CIs. A single list of upstream and downstream relationships is displayed.</td>
</tr>
<tr>
<td>Show Relations in Split/Merge Layout</td>
<td>To view separate lists for upstream and downstream relationships, click Split. To view a single list that includes both upstream and downstream relationships, click Merge. Relationships are grouped by relationship type.</td>
</tr>
<tr>
<td>Filter Relations by Max Level</td>
<td>Select the number of levels in the hierarchy to include when displaying CIs in a flat view.</td>
</tr>
<tr>
<td>Filter Relations by Relationship Type</td>
<td>Select the types of relationships to view.</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Relations by CMDB View</td>
<td>Filter by tables specified in CMDB views, if any relationship filters exist.</td>
</tr>
</tbody>
</table>

The relations formatter uses the following icons to provide additional information about changes, problems, and outages related to CIs in the relationship:

### Table 68: Icons related to CIs

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recently closed changes</td>
<td><img src="icon1.png" alt="Icon" /></td>
</tr>
<tr>
<td>Planned changes</td>
<td><img src="icon2.png" alt="Icon" /></td>
</tr>
<tr>
<td>Currently open changes</td>
<td><img src="icon3.png" alt="Icon" /></td>
</tr>
<tr>
<td>Recently closed outages</td>
<td><img src="icon4.png" alt="Icon" /></td>
</tr>
<tr>
<td>Problems</td>
<td><img src="icon5.png" alt="Icon" /></td>
</tr>
<tr>
<td>Incidents</td>
<td><img src="icon6.png" alt="Icon" /></td>
</tr>
<tr>
<td>Planned outages</td>
<td><img src="icon7.png" alt="Icon" /></td>
</tr>
<tr>
<td>Currently open outages</td>
<td><img src="icon8.png" alt="Icon" /></td>
</tr>
</tbody>
</table>

In large networks, a list of related CIs might be excessively long, which can slow performance when a CI form is rendered. You can configure these properties to control the amount of data that is displayed. To find a property, enter `sys_properties.list` in the left navigation filter and search for the property.

### Table 69: Properties related to performance

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ecmdb.find_relationship_issues</td>
<td>Hides or displays an icon in the CI relations formatter that links to open issues for the CI. This property defaults to true (displays the icon).</td>
</tr>
<tr>
<td>glide.ui.max_relation_levels</td>
<td>Specifies the maximum level for displaying CIs in flat view before reaching the maximum relations limit. The default value is 5.</td>
</tr>
<tr>
<td>glide.ui.max_relations</td>
<td>Specifies the maximum number of related CIs to display. When exceeded, a notification is displayed indicating that the limit has been reached, and that not all relations are displayed. The default value is 1000.</td>
</tr>
</tbody>
</table>
Create or edit a relationship filter

Create a custom relationship filter to display CI relationships from selected tables in the CI relations formatter.

Role required: ecmdb_admin

The CI relations formatter displays related CIs for the base CI, and the relationships between the CIs. You can use relationship filters on the CI relations formatter to customize CI relationship views.

1. Navigate to Configuration > Relationships > Relationship Filters.
2. Click New or select a filter to edit.
3. Enter or edit the relationship filter name.
4. Right-click the form header and click Save.
5. In the Configuration Types section, click Edit.
6. On the Edit Members form, select the tables of the CIs that you want to show with the filter and then move the tables to the Configuration Types list.
7. Click Save.

On a CI form, in the relations formatter settings, you can select the newly defined relationship filter from the Filter Relations by CMDB View list.

In the legacy CI relations formatter, you can click View and select the newly defined relationship filter.

After you select a filter, the relations formatter displays only CIs from the tables specified in the filter or from descending tables.

Legacy CI relations formatter

On instances that do not meet the internet browser requirements for the latest CI relations formatter, the default CI form includes the legacy CI relations formatter instead.

This element contains the list of related CIs and a toolbar with controls for viewing the relationships between the current CI and related CIs.

Figure 19: Related items field

**Note:** The legacy BSM map provides a more complete view of CI relationships.

Configure the controls in this formatter with two properties that restrict varying aspects of the view.

**Flat layout**

Click the flat layout icon ( ) to group the related CIs by relationship.
Figure 20: Flat layout view

Tree layout

Click the tree layout icon ( ) to group the related CIs in a hierarchical tree.

Figure 21: Tree Layout View

CI relationship editor

Use the CI relationship editor to create CI relationships.

When you use the relationship editor, the CI from which the editor was launched is designated as the base CI. You can then select one or more CIs as a second CI for the relationship. Depending on the selected relationship type, the base CI can become the parent CI or the child CI in the new relationship.

The relationship editor operates differently, depending on whether or not you select the Use suggested relationship check box.
• With suggested relationships, the relationship editor lists all available relationship types for the base CI. To define a new relationship, select a relationship type, and then select a second CI for the relationship. Suggested relationships are highlighted for you. These relationships are displayed in blue with a prefix of [Suggested].
• Without suggested relationships, you define a new relationship by first selecting a second CI for the relationship and then selecting a parent or a child relationship type.

**Suggested relationships**

If you select the Use suggested relationship check box in the editor, the Suggested relationship list appears. It displays all available CI, user and group relationship types for the base CI. Relationship types have a suffix of (Parent) or (Child) to note the relationship descriptor, and suggested relationship types are displayed in blue and have a "***" prefix.

When you select a relationship, you are also designating the base CI as being the parent or the child CI in the new relationship. For example, if you select the 'Feeds' relationship type, the base CI becomes the designated parent CI, and the second CI that you select becomes the child CI in this relationship.

**Downstream relationships**

If you do not select the Use suggested relationship check box in the editor, the Downstream relationships list appears. It displays all relationships in which the base CI is the parent CI. The child CI of the relationship is displayed in the Child column.

**Upstream relationships**

If you do not select the Use suggested relationship check box in the editor, the Upstream relationships list appears. It displays all relationships in which the base CI is the child CI. The parent CI in each relationship is displayed in the Parent column.

**Supported browsers for the CI relationship editor**

You must use supported browser versions in order to use the latest CI relationship editor. If you do not use a supported browser version, the instance provides the legacy CI relationship builder.

These are the supported browser versions:

- Firefox version 20 and up
- Chrome version 25 and up
- Safari version 6 and up
- Internet Explorer version 9 and up

**Create or edit a CI relationship**

Use the relationship editor to view, create or modify CI relationships. You can open the relationship editor from the CI Relations formatter.

Role required: asset, itil, or admin

The relationship editor operates differently, depending on whether you check the Use suggested relationship option or not.

1. Launch the relationship editor:
   a) Open a CI form.
b) Locate the **Related Items** section near the center of the form.

c) Click the plus (+) icon on the **Related items** section.

2. If you want to use suggested relationships then you need to first select a relationship type, and then select one or more CIs to be the child CIs in the relationship:

   a) Check **Use suggested relationship**.

   b) From the **Suggested relationship type** list, select a relationship type.

   You can filter the list of suggested relationships by using the filter check boxes.

<table>
<thead>
<tr>
<th>Filter option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide CI relationship</td>
<td>Hides any relationships between the base CI and another CI (such as &quot;Receives data from&quot;). Default filter is stored in the ci_manage_relationships_filter_hint.cmdb_ci user preference.</td>
</tr>
<tr>
<td>Hide user relationship</td>
<td>Hides any relationships between the base CI and a user (such as &quot;Logs reviewed by&quot;). The default filter is stored in the ci_manage_relationships_filter_hint.sys_user preference.</td>
</tr>
<tr>
<td>Hide group relationship</td>
<td>Hides any relationships between the base CI and a group (such as &quot;Backups done by&quot;). Default filter is stored in the ci_manage_relationships_filter_hint.sys_user_group user preference.</td>
</tr>
</tbody>
</table>

The **Configurations Items** list displays all the CIs that are appropriate for the base CI and the selected relationship type. The **Relationships** list at the bottom of the editor, displays all existing relationships of the selected relationship type, in which the base CI is a parent CI or a child CI.

c) From the **Configuration Items** list, select one or more CIs as a second CI for the relationship.

   You can filter the list of **Configurations Items** by adding conditions in the **Filter** section and clicking **Run filter**.

   If you selected a parent relationship type, these CIs becomes the child CI in the relationship, and if you selected a child relationship type, then the selected CIs become the parent CI in the relationship.

d) In the **Relationships** section, click the plus icon (+) to add the new relationships.

   Alternatively, you can drag the selected CIs to the **Relationships** list. Each new relationship will consist of the base CI, the selected relationship type, and a selected second CI.

3. If you do not want to use suggested relationships, then you need to first select one or more CIs to be the child CIs in the relationship, and then select the relationship type.

   a) Uncheck **Use suggested relationship**.

   b) In the **Configuration Items** list, select one or more CIs as a second CI for the relationship. You can filter the list of **Configurations Items** by adding conditions in the **Filter** area and clicking **Run filter**.

   Depending on the relationship type that you will select, the selected CIs might become a parent or a child CI in the relationship.
c) With at least one CI selected in the Configuration Items list, click the '+' sign in the Downstream Relationships section or the Upstream Relationships section to create the relationship.

- Add the relationship to Downstream Relationships to create a relationship in which the base CI is the parent CI and the selected CI is the child CI.
- Add the relationship to Upstream Relationships to create a relationship in which the base CI is the child CI and the selected CI is the parent CI.

d) For each newly created relationship in either the Downstream Relationships or the Upstream Relationships lists, click Please select a relationship and select a relationship type.

- The list of available relationship types in the Downstream Relationships list contains parent relationships only, in which the base CI is the parent CI.
- The list of available relationship types in the Upstream Relationships list contains child relationships only, in which the base CI is the child CI.

e) Click Save or Save and Exit.

Only after you enter all the information that is necessary for creating the relationship, these buttons light up indicating that there are pending updates that require saving.

Legacy CI relationship builder

In the legacy CI relations formatter, click the CI relationship builder icon (++) to display the legacy Define Relationships page.

Used to define CI relationships manually, this page is a sophisticated version of the standard slushbucket.
Figure 22: Legacy CI relationship page
Select a CI relationship type
The top half of the legacy relationship editor contains a large option box that allows you to select which type of relationship you want to manipulate.

- Click the particular type of relationship you are interested in working with.

If we want to say that Bond Trading is backed up by Fred Luddy, select [Bond Trading] Backup done by

Filter the list of CI relationships
In the legacy relationship editor, the checkboxes along the right hand edge of the select box provide a quick way to filter down the list of available relationships.

By default, the system displays a list of all suggested relationships for the type of CI you selected. For example, if you selected a Database instance, a relationship of “Runs on” makes sense, but a relationship of “Provides HVAC for” does not. The default filter is stored in the user preferences

| cmdb_cici_manage_relationships_filter_hint.cmdb_cici_manage_relationships_filter_hint.sys_user, and cmdb_cici_manage_relationships_filter_hint.sys_user_group. |

- Hide CI relationship -- Hides any relationships between this CI and another CI (e.g. "Receives data from").
- Hide user relationships -- Hides any relationships between this CI and a user (e.g. "Logs reviewed by").
- Hide group relationships -- Hides any relationships between this CI and a group (e.g. "Backups done by").
- Show all relationships -- If you have the appropriate role (out of box this is itil_admin) you will have an additional checkbox labeled “Show all relationships.” If you click that checkbox, the system will let you choose any relationship defined in the system, regardless of where it is on the "suggested" list for this type of CI.

Select CI relationship targets
In the legacy relationship editor, users can link or unlink CIs for a relationship type.

As soon as you pick a relationship type, the system will fill in the two select boxes at the bottom of the screen with CIs that are appropriate for the relationship you suggested. The left hand select box will contain a list of CIs that might reasonably be linked via this relationship, while the right hand box contains a list of those CIs which are already linked.

1. Link or unlink items.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link new items</td>
<td>Move that CI from the left hand box to the right hand box.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unlink existing items</td>
<td>Move them from the right hand box to the left.</td>
</tr>
</tbody>
</table>

When you make either type of change, a message appears indicating that you have pending changes.

2. Apply or cancel your changes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Save button.</td>
<td>This will save your set of changes, and go back to the previous screen (either a CI or the BSM map depending on how you got here).</td>
</tr>
<tr>
<td>Click the Cancel button.</td>
<td>This causes you to exit without saving your changes.</td>
</tr>
</tbody>
</table>

Relation qualifier

A relation qualifier, which is a CI of the Qualifier [cmdb_ci_qualifier] type, stores important information about the CI relationships. In a relation qualifier, you can annotate arbitrary unique information about the relationship between two CIs. You can define multiple qualifiers for a single relationship, resulting in a qualifier chain, however there can be only a single qualifier chain for a specific relationship type between two CIs.

For example, for a relationship between a parent CI and a child CI, you can add a relation qualifier to note that the relationship was discovered based on traffic (such as cmdb_ci_qualifier_trafficbased). This results in having two records in the CI Relationship [cmdb_rel_ci] table for the relationship.

- A record that links the parent CI and the new qualifier
- A record that links the new qualifier and the child CI

For this relationship, there is a parent CI and a child CI, and a relation qualifier of type cmdb_ci_qualifier_trafficbased.

For information about usage of relation qualifiers in the identification process, see Identification rules on page 270.

CI relationship security

When applying security to CI relationships, it is important to apply the access controls both to the cmdb_rel_ci table (which stores the relationships) as well as creating an editCIRelations operation to the * table as well.

If the current instance has defined security for editCIRelations, it will be applied to edit_ci_relations automatically in the process of upgrading, and the out-of-date security will be removed.

Create a CI relation rollup

A CI relation rollup allows you to sum, count, max, min, or mean a relationship type. You can create CI relation rollups.

Role required: ecmdb_admin

CI relation rollup can be useful for tracking and for receiving notifications. For example:

- In a sum rollup, add up fields from multiple CIs and display the result on another CI to which they are related. So, if you have four configuration items in a rack that are all consuming power, create a CI relation rollup to add all the power usage together and display the result in one field on the rack CI form.
• If a certain level of power consumption in a rack is exceeded, send a notification.
• With a rack that has 10 slots, send a notification when 9 slots are filled.

CI relation rollups use the cmdb synch event business rule on the [cmdb_ci] table. Although this business rule is active by default, you must modify the rule slightly before it will run.

1. Navigate to Configuration > Relationships > CI Relation Rollups.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Relationship Type</td>
<td>Select a relationship type from the list to use with the rollup. For example, Members::Member contains the parent descriptor Members and the child descriptor Member of.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of rollup from the drop-down list: COUNT, MAX, MEAN, MIN, or SUM.</td>
</tr>
<tr>
<td>Parent field</td>
<td>The target field on which the operation will be done.</td>
</tr>
<tr>
<td>Child field</td>
<td>The input to the equation type. The Parent field is affected by the selections in the child field.</td>
</tr>
<tr>
<td>Rollup class</td>
<td>The classes that can use the relationship. For example, you can specify that the relationship only applies to racks.</td>
</tr>
</tbody>
</table>

4. To run the cmdb synch event business rule, navigate to Business Rules.
5. Use the search box to find the [cmdb synch event] table.
6. Click the cmdb synch event business rule to go to the Business Rule page.
7. Select the Update, Delete, and Query check boxes.

Additionally, if you wish CI relation rollups to recalculate when there is a change to a relationship, use a similar procedure to select the Active check box on the cmdb_rel_ci synch event business rule.

CMDB classifications

CMDB classifications are groups of configuration items (CIs) that share the same attributes and are stored in their own table. Classifications allow administrators to define the hierarchy of CIs within the CMDB. A CI class refers to the actual table name in the instance database. In that context, CI Type is a friendly name that a CI is known by, such as computer, router, or printer.

As good practice, keep CI classifications as simple as possible.

Configuration Management Database

The Configuration Management Database (CMDB) is a series of tables that contain all the assets and business services controlled by a company and its configurations.
This includes computers and devices on the network, software contracts and licenses, business services, and more. The IT desk can use the CDMB to understand better their network users’ equipment, and the relationships between them. The CMDB can also be referenced by other processes within the system.

The CMDB can be populated using the Discovery product. Discovery searches the network for all attached computers and devices, then populates the CMDB with information on each computer/device’s configuration, provisioning, and current status. Discovery also reports on any software which is running, and the TCP connections between computer systems, thereby establishing their relationships.

The Asset Portfolio, Asset Contracts, and Configuration applications contain modules which display different tables within the CMDB. Each application is designed with a specific purpose in mind.

The two asset applications have an asset management focus, providing a business perspective on the CMDB. The Asset Portfolio application links to CMDB of all assets, hardware, software, assets in stock, as well as records for manufacturers and vendors. The Asset Contracts application contains information about contracts, including leases, service contracts, purchase orders, warranties, and software licenses. The Configuration application has a focus on operation.

**CMDB tables**

The configuration management database (CMDB) employs the following tables.

- The Base Configuration Item [cmdb] table, which is the core CMDB table for non IT CIs.
- The Configuration Item [cmdb_ci] core table, which stores the basic attributes of all the CIs. The admin, itil, or asset user role is required to access this table.
- The CI Relationship [cmdb_rel_ci] table, which defines all relationships between CIs.

The Configuration Item table is extended to other tables, such as Database [cmdb_ci_database] and Computer [cmdb_ci_computer]. The Computer table is extended to the Server [cmdb_ci_server] table, which is extended to the UNIX Server [cmdb_ci_unix_server] table, and so on.

You can use the schema map to view more details of tables and their relationships:

1. Navigate to **System Definition > Tables & Columns**.
2. Select a table and click **Schema Map**.
CI attributes

Attributes apply to all of the CIs in a classification. To change attributes for a CI, you must extend the table and create a new classification for that CI.

The position of a CI in the classification hierarchy is determined by the attributes it shares with the CIs below it. Each time a CI has a single different attribute from its parent, the classification hierarchy branches.

For example, servers have different attributes from computers, which includes workstations and laptops. Linux servers and UNIX servers have different attributes from the parent server classification and from each other, so they occupy separate branches in the hierarchy.
CMDB record types

The CMDB contains the following major record types.

<table>
<thead>
<tr>
<th>Record types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item (CI)</td>
<td>Any computer, device, or service in the CMDB. A CI's record includes all of the relevant data, such as manufacturer, vendor, location, etc. Configuration items can be created or maintained either using tables, lists, and forms within the platform, or using the Discovery application.</td>
</tr>
<tr>
<td>Relation Type</td>
<td>A defined relationship between a CI and either another CI, a user, or a group. Relation types are defined twice, once from the perspective of the child CI and once from the parent CI's perspective. For example, a parent CI that powers a child CI uses relation type Powers::Is Powered By. Example relation types include In Rack::Rack contains, Log Reviewed by::Reviews logs for, or Backup done by::Does backups for. CMDB relationships can be established using Discovery or using the tables, lists, and forms within the platform. The CMDB form has a specific Related Items toolbar optimized for modifying relationships.</td>
</tr>
</tbody>
</table>

Relationship rules

Any time you create a new classification (extend a table), you must create new relationship rules.

The ServiceNow platform relationship rules use separate tables to define the relationships between specific CI base classes and dependent classes. When you extend a table in the CMDB, you must create a new relationship rule in Configuration > Suggested Relationships.

For example, in a default ServiceNow instance, the base class Computer has a Depends on relationship with the dependent class of Computer Peripheral. If you decide to reclassify laptops (classified as Computer by default) into their own base class (for example, [cmdb_ci_laptop]), you must create new rules for the relationships between laptops and other dependent classes, such as peripherals.

Related Lists of CI components

Related Lists in CI records display additional components contained by that CI, such as disk drives on a server and the rules that control the behavior of a network router.

When Discovery runs, the Related List is populated with the components that Discovery finds running on the CI. The CI record might show different lists from scan to scan, depending on whether or not Discovery found the component.
By default, the Related Lists only display those components that are associated with that CI in the CMDB that have been discovered by the last scan. CI components that are discovered but cannot be matched to the CI in the CMDB are added to the CMDB and appear in the Related List. Components that are recorded in the CMDB but are not discovered in a scan, are deemed absent and do not appear in the list.

There are two types of components that appear in the Related List: those that are CIs themselves (such as hard disks), and those that are not (serial numbers and rules). The default filter condition in the breadcrumbs for components that are CIs is \([\text{Status} \neq \text{Absent}]\). The filter condition for components that are not CIs is \([\text{Absent}] = [\text{false}]\).

In the following example, the \text{sncc-tc01} router has several Related Lists affected by these filter conditions, including routing rules, disk drives, interfaces, and network adapters. Only those components found during the last Discovery appear in these Related Lists.

![Figure 24: CI Related Lists](image-url)

**Create CI class**

Use the CI Definition form view when creating a new class (table).

Role required: itil_admin or admin

The CI Definition form serves as a centralized location from which you can create a new table that is derived from the CMDB table, and configure additional CMDB-related configurations for CI identification and reconciliation.

1. Navigate to Configuration > Identification/Reconciliation > Create CI Class.
2. See Create a table for details about filling in the Table form. The table that you specify in Extends table must be an extension of the CMDB table.
3. On the context menu, click Save.
4. Scroll to the bottom of the Table view to use any of the CI Definition form view specific controls, such as CI Identifiers and Reconciliation Definition.
Reclassify a CI

You can upgrade, downgrade, or switch the class of a CI by modifying its **Class** attribute.

**Role required:** itil_admin or admin

Each class is defined with a unique set of attributes. This set consists of attributes that were inherited from the parent class, and additional attributes specifically defined for the class.

When you reclassify a class, the following occurs.

1. The set of attributes is adjusted to match the set of attributes of the newly assigned class. Attributes are added or removed as needed.
2. If any attributes are unique to the current class and are not defined in the newly reclassified class, they are lost.
3. A new record with the CI's sys_id is inserted to the table of the new class, with the appropriate set of attributes for the class.

---

**Note:** In a downgrade or a switch reclassification, some CI data might be lost.

More specifically, depending on the reclassification, the following occurs.

**Downgrade**

The CI class is updated to a class that is lower in class hierarchy, and the newly assigned class is a parent of the current class and has less attributes than the current class. For example, reclassifying a CI from the `cmdb_ci_server` class to the `cmdb_ci_computer` class.

The `cmdb_ci_server` class has attributes that the `cmdb_ci_computer` class does not have. During the downgrade, these attributes and their respective values are not included in the new CI record that is inserted into the `cmdb_ci_computer` class.

**Upgrade**

The CI class is updated to a class that is higher in class hierarchy, and the newly assigned class is a derived child of the current class and has additional attributes. For example, reclassifying a CI from the `cmdb_ci_computer` class to the `cmdb_ci_server` class.

**Switch**

The newly assigned class is in a different branch in the class hierarchy and has a different set of attributes than the current class. For example, reclassifying a CI from the `cmdb_ci_linux_server` class to the `cmdb_ci_win_server` class.

A switch is a combination of a downgrade and an upgrade. For example, if the CI is downgraded to the `cmdb_ci_server` and then upgraded to the `cmdb_ci_win_server` class. The attributes are lost in the same manner as in a downgrade operation.
For more information about system properties for automatic CI reclassification, see CI reclassification on page 279.

1. Locate the CI that you want to reclassify and display it in a list view.
   You can use the application navigator, or open the list for the CI type. For example, if the CI is a server, then enter `cmdb_ci_server.list` in the navigation filter to find the CI in the Servers list.

2. Ensure that the **Class** field is displayed in the list.
   If you do not see this attribute, personalize the list to add the **Class** field.

3. Double-click the **Class** value for the CI, and select a new class.
4. Click the green check box to confirm your selection.

### CMDB Identification and Reconciliation

The Identification and Reconciliation application provides a centralized framework for identifying and reconciling data from different data sources. It helps maintain the integrity of the CMDB when multiple data sources such as Discovery, import sets, and manual entries are used to create and update CI records.

The use of multiple sources increases the risk of introducing inconsistencies through duplicate records. To maintain the integrity of the database, it is important to correctly identify CIs and services so that new records are created only for CIs that are truly new to the CMDB. Identification and Reconciliation helps you prevent duplication of CI records, reconcile CI attributes, reclassify CIs, and allow only authoritative data sources to update the CMDB.

See the [ServiceNow Developers site](https://developer.servicenow.com) for API information.

### Components and process of identification and reconciliation

The CMDB identification and reconciliation functionality is supported by identification rules, reconciliation rules, de-duplication tasks, and reclassification tasks.

### Components of identification and reconciliation

**Identification**

Identification is the process of uniquely identifying CIs, to determine if the CI already exists in the CMDB or if it is a newly discovered CI that must be added to the CMDB. The process relies on identification rules.

**Reconciliation**

Reconciliation is the process of reconciling CIs and CI attributes by allowing only designated authoritative data sources to write to the CMDB at the CI table and attribute level. The CMDB is updated in real time as records are being processed. There is no staging area to verify the reconciliation activities before they are committed. The process relies on reconciliation rules.

**De-duplication tasks**

If the instance encounters duplicate CIs during the identification and reconciliation process, it groups each set of duplicate CIs into a de-duplication task.
Review the information in these tasks to see how it was determined that these CIs are duplicates.

Reclassification tasks

During the CI identification process, a matched CI might need to be upgraded, downgraded, or switched to another CI class. If automatic reclassification is disabled, then the system generates a reclassification task. Review the information in these tasks, and decide whether a manual reclassification of the CI is appropriate.

API

The Identification and Reconciliation API is a centralized API that can be used with different sources of data such as Discovery, Monitoring, or Import Sets. You can use it to enforce identification and reconciliation before data is stored in the CMDB. Data sources do not directly write to the CMDB. Instead, they call the API first to ensure that the data being written does not introduce inconsistencies.

- `createorUpdateCI()`: A scriptable API that creates or updates a CI based on identification and reconciliation rules.

Predefined identification and reconciliation rules are included for tables that are in the base instance. You can customize these rules for your organization. When a new table is created in the CMDB, it inherits any existing identification and reconciliation rules from its parent table. To apply identification and reconciliation rules to a new table, create the rules either at the child level or parent level.
Identification rules

The CMDB identification process relies on identification rules. Each identification rule consists of one or more identification entries that specify the attributes that uniquely identify the CI.

Identification rules apply to a CI class and comprises of one or more identifier entries that have a different priority. Each identifier entry defines a unique attribute set with a specific priority. Create strong identification rules that give the highest priority to the strongest identifier entries. To continuously improve the efficiency of the identification process, routinely review the identification rules. Try to improve weak rules or give them lower priorities than stronger rules.

The identification process and identification rules use unique attributes and required attributes:

**Unique attributes**

Designated sets of criterion attribute values of a CI, that can be used to uniquely identify the CI. Unique attributes can be from the same table or from derived tables.
Required attributes

Designated attributes of a CI that cannot be empty.

The steps for identifying dependent CIs can be different from the steps for identifying independent CIs. This is reflected in the differences between identification rules for dependent CIs and identification rules for independent CIs.

Dependent identification rule

A rule in which identifying a CI requires identifying a dependent CI first. A CI can have dependency on one or more CIs, and a dependent CI can have only a single parent CI with dependency. The relationship types between the CI and its dependent CIs are also included in the identification process. To assist in the identification process of dependent CIs, add Service rules metadata on page 280 that define the dependency structure of CI types and the relationship types.

The payload used for identification of a dependent CI, can include a relationship with a qualifier chain. For such relationship, if there is a matching parent/child pair, the system compares the qualifier chain in the payload, with the qualifier chain of the CIs in the database. If there is a difference, the qualifier chain in the database is updated to match the qualifier chain in the payload for that relationship.

Independent identification rule

A rule that identifies a CI independently of other CIs. The CI is an independent CI.

Create or edit a CI identification rule

Identification rules are used to uniquely identify CIs in the CMDB, as part of the identification and reconciliation process. Each table in the CMDB can be associated with a single identification rule.

Role required: admin or itil_admin

In a CI identification rule, create one or more identifier entries that specify the attributes that uniquely identify the CI. You can configure an identifier entry to match a CI not only based on the CI's own attributes (field based identification) but also based on the CI's related list (lookup based identification) such as Serial Numbers or Network Adapters.

Note: Users with the itil role have read access to the CI identification rules.

1. Navigate to Configuration > Identification/Reconciliation > CI Identifiers.
2. Click New or open an existing rule.
3. Complete the form.

Table 72: Identifier form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of CI identifier.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Class that this CI identifier applies to.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the CI identifier.</td>
</tr>
</tbody>
</table>
4. Right-click the form header and click **Save**.

5. In the **Identifier Entries** related list, click **New** or open an existing entry to specify criteria for matching the CI.

6. Fill in the fields, as appropriate.

Table 73: Identifier Entry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Independent</td>
<td>Check box that specifies the CI identifier can identify the CI independently of other CIs.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that specifies the identifier entry is active.</td>
</tr>
</tbody>
</table>
| Criterion attributes | The set of attributes to uniquely identify the CI. Attributes can belong to the current class, or to a parent class.  
|                   | Click the lock icon to view, add, or remove attributes from the identification rule.  
|                   | It is not possible to add reference fields as a criterion attribute. Reference fields store sys._ids that point to a record in another table, and thus is considered a weak criterion attribute (in terms of uniqueness) for the current table. |
| Optional condition | Use the **Add Filter Condition** and the **Add "OR" Clause** buttons to construct a filter to narrow the set of records that will be searched for a matching CI. Optional condition is applied only to lookup based identification. |
| Identifier        | The CI identifier to which this identifier entry belongs to. By default it is set to the identifier you previously selected.                   |
| Priority          | Priority of the identifier entry. Identifier entries are applied based on priority. Rules with lower priority numbers are given higher priority.  
|                   | Identifier entries of identical priorities are applied randomly.  
|                   | It is recommended that you keep gaps between the priority numbers, so you can assign the unused priority numbers to new entries without modifying the existing priority order. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search on table</td>
<td>The table to search during the identification process. The table list consists of tables that either inherit from the Configuration Item [cmdb_ci] table, or other tables that reference the CI and can be used as a lookup table for identification.</td>
</tr>
<tr>
<td>Allow fallback to parent’s rules</td>
<td>Check box to specify that the identification rules of the CI's parent are used if a match is not found for this identification rule. Applies only for dependent identification rules.</td>
</tr>
<tr>
<td>Enforce exact count match (Lookup)</td>
<td>Check box to specify that for lookup identification, match only on exact lookup records count match.</td>
</tr>
<tr>
<td>Allow null attribute</td>
<td>Check box to allow null values for criterion and unique attributes.</td>
</tr>
</tbody>
</table>

**Note:** “Name” is never allowed to have null values when you use a criterion attribute in the form of ["sys_class_name", "name"], even if **Allow null attribute** is enabled. This restriction is due to sys_class_name being considered a special system matching attribute.

7. **Click Submit.**

For example, the pre-defined **Hardware Rule** applies to the Hardware [cmdb_ci_hardware] table. It has an identifier entry with the criterion attribute **Serial Number, Serial Number Type** and its **Search on table** field is set to **Serial Number**.

The following payload snippet adds a CI to the **cmdb_ci_linux_server** class, that is a child of the Hardware class:

```json
{
  "items": [
    {
      "className": "cmdb_ci_linux_server",
      "lookup": [
        {
          "className": "cmdb_serial_number",
          "values": {
            "serial_number": "VMware-42 21 e3 da 44 14 5a a6-56 48 2b 0a 28 53 42 4c",
            "serial_number_type": "system",
            "valid": "true"
          }
        },
        {
          "className": "cmdb_serial_number",
          "values": {
```
```
When the **Hardware Rule** is applied, the Serial Number [cmdb_serial_number] table is searched for a match with the values specified within the **lookup key**. Unless **Enforce exact count match (Lookup)** is checked, it is not necessary for every lookup key to return a match, as long as there is at least one match. If all matches reference the same CI, then that CI is considered to be the existing CI record. If no match is found, then the identification search continues to the next rule entry. If after all the rules are exhausted without finding a match, a new CI record is created in the database.

Reconciliation rules

Reconciliation rules specify which data sources can update a table or a set of table attributes, and they can be defined at the parent and the child table level. Ensure that there is a reconciliation rule for each data source that is authorized to update an attribute - multiple reconciliation rules can exist for the same set of attributes.

As you create reconciliation rules, keep the following principles and guidelines in mind. These principles are designed for flexibility and the refinement of rules at the attributes level.

**Example reconciliation rules**

For example, you might have the following reconciliation rules. The rules are created for the `cmdb_ci_computer` table and one of its child tables, the `cmdb_ci_linux_server` table. The rules specify the following:

1. **Discovery** is exclusively authorized to update the name attribute in the `cmdb_ci_computer` table.
   
   Because reconciliation rules are inherited by child tables from parent tables, this rule also authorizes Discovery to update the name attribute in any child tables for the `cmdb_ci_computer` table.

2. **ServiceWatch** is exclusively authorized to update the name attribute in the `cmdb_ci_linux_server` table.

3. **ServiceWatch** is exclusively authorized to update all attributes in the `cmdb_ci_linux_server` table, as configured by leaving the **Attributes** field empty in the rule.
Authorization for all attributes in a table

If you want to authorize a data source to update all attributes in a table, leave the attribute list empty in the reconciliation rule for the data source. However, this authorization can be overridden for some of the attributes by rules for child tables in which specific attributes are listed.

For example, if only example rules #1 and #3 are created, then Discovery is authorized to update the name attribute in the cmdb_ci_linux_server table. ServiceWatch is authorized to update all other attributes in the table except for the name attribute.

To override the authorization of Discovery to update the name attribute, example rule #2 is added to specifically authorize ServiceWatch to update the attribute.

Authorization to only specific attributes in a table

If you want to authorize a data source to update specific attributes in a table, list these attributes in the reconciliation rule for the data source. A rule that grants access to specific attributes in a table overrides other rules with an empty attribute list that grants access to the entire table.

Example rule #1 grants Discovery with exclusive authority to update the name attribute of the cmdb_ci_computer table. All other data sources are prevented from updating the name attribute of any CI in the cmdb_ci_computer table.

Child table rules overrides parent table rules

Any reconciliation rules defined for a child table override the rules defined for its parent table.

For example, rule #1 lets Discovery update the name attribute in the cmdb_ci_computer table and all of its child tables. However, rule #2 for the cmdb_ci_linux_server child table, which overrides rule #1 for the parent table, explicitly authorizes ServiceWatch to update this attribute in the child table.

As a result:

- Discovery cannot update the name attribute of the child cmdb_ci_linux_server table. Only ServiceWatch is authorized to update this attribute.
- Discovery is authorized to update the name attribute of CI records in all other child tables of the cmdb_ci_computer table.

Overlapping rules

Rules that authorize different data sources for the same attributes of the same table can coexist and do not exclude each other.

For example, assume the following rule is added. It is similar to example rule #1 but authorizes a different data source:

- ServiceWatch is authorized to update the name attribute in the cmdb_ci_computer table.

Like example rule #1, this new rule applies to the name attribute in the cmdb_ci_computer table so both Discovery and ServiceWatch can update the attribute. Any applicable data source precedence rules are enforced to prevent the data sources from overwriting each other's updates.

Domain separation
If Domain Separation is enabled, then you can scope reconciliation rules to specific domains. Rules of the parent domain, if not overridden, apply to CIs of child domain. All rules that are visible to a domain are applied, and a rule overriding the parent domain displays the child domain version.

Create or edit a CI reconciliation rule

A reconciliation rule specifies the attributes that a data source is authorized to update for a given table and prevents unauthorized data sources from overwriting the attributes' values. If an attribute does not have any reconciliation rules created for it, data sources are allowed to overwrite each other’s updates to the attribute’s value.

Role required: admin or itil_admin

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>The data source that you are configuring this rule for.</td>
</tr>
<tr>
<td>Applies to</td>
<td>The table that the selected data source can update.</td>
</tr>
<tr>
<td>Filter condition</td>
<td>Conditions that the CI must meet, if you want to apply this rule to only specific CIs. For example, to apply this rule only to CIs that are associated with the Finance department, select this condition: [Department] [is] [Finance]</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attributes that the data source is authorized to update. You can select attributes from the current class, or a parent class. To authorize the data source to update all table attributes, leave this field empty.</td>
</tr>
<tr>
<td>Update with null</td>
<td>Attributes that the data source can update with a null value. By default, authorized data sources cannot overwrite a non-null value with a null values. Attributes in this list, which are not in the Attributes list, are not included with the attributes that the data source can update with a null value.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that the reconciliation rule is enforced in, if the Domain Support domain separation plugin is enabled.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this reconciliation rule.</td>
</tr>
</tbody>
</table>

1. Navigate to Configuration > Identification/Reconciliation > Reconciliations Definitions.
2. Click New, and fill in the fields as appropriate.
3. Click Submit.
Define or edit data source precedence

If multiple data sources are authorized to update the same table or the same table attributes in the CMDB, assign a priority to each of these data sources to prevent them from overwriting each other's updates.

Role required: admin or itil_admin

After an attribute is updated by an authorized data source, any subsequent updates are accepted only from the same data source or from a data source with a higher priority. Updates from a data source with a lower priority are rejected. Without data source precedence rules, data sources can overwrite each other's modifications.

Note: Users with the itil role have read access to the CI identification rules.

1. Navigate to Configuration > Identification/Reconciliation > Datasource Precedences.
2. Click New or open an existing data precedence definition.
3. Complete the form.

Table 75: Data Source Precedence form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>The table that this precedence rule applies to.</td>
</tr>
<tr>
<td>Data source</td>
<td>The data source that this precedence rule applies to.</td>
</tr>
<tr>
<td>Order</td>
<td>Priority of this precedence rule within the set of precedence rules for the specified table. Smaller numbers designate higher priority. Data sources without a precedence rule are assigned the lowest priority.</td>
</tr>
<tr>
<td>Application</td>
<td>Domain that this precedence rule applies to, if Domain Separation is enabled.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate this precedence rule.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Resolve de-duplication tasks

If the instance encounters duplicate CIs in the identification and reconciliation process, it does not update or insert the CI. Instead, the instance groups each set of duplicate CIs into a de-duplication task for review. Use de-duplication tasks to track the duplicate CIs until they can be resolved.

De-duplication tasks provide details about the duplication, including a list of all the duplicate CIs and the internal payload used during the identification process. Review the details of each duplicate CI in the task and the data that was used to determine that the CI is a duplicate. A large number of duplicate CIs might be due to weak identification rules.
If the duplicate CI is a dependent CI, then you can view the details of the dependent relationship, the Depend on CI, and any relation qualifier chain. If the dependent CI has a lookup table, then you can see the details of the respective lookup table.

**Skip duplication**

Processing of sets of duplicate CIs depends on the system properties glide.identification_engine.skip_duplicates (set to true by default) and glide.identification_engine.skip_duplicates.threshold (set to 5 by default), and on the number of duplicate CIs in a set.

- If glide.identification_engine.skip_duplicates is true, and the number of duplicate CIs is less than the threshold specified by glide.identification_engine.skip_duplicates.threshold, then the oldest of the duplicate CIs is picked as a match and gets updated. The rest of the duplicate CIs are tagged as duplicates by setting the cmdb_ci's discovery_source field as 'Duplicate'.
- If glide.identification_engine.skip_duplicates is false, then matching of duplicate CIs fails with an error, and none of the duplicate CIs is updated.

**Note:** In either case, de-duplication tasks are always created.

To modify these properties, you need to first add them to the System Properties [sys_properties] table. For more information, see *Properties installed with Identification and Reconciliation* on page 285.

Role required: admin or itil

1. Navigate to **Configuration > Identification/Reconciliation > De-duplication Tasks**.
2. Select a task.

**Table 76: De-duplication Task fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A unique task number.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>A person that is responsible for resolving the task.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description for the task.</td>
</tr>
<tr>
<td>Internal payload</td>
<td>Payload that was used in the identification process, during which the de-duplication task was generated.</td>
</tr>
<tr>
<td>Description</td>
<td>Full description for the task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Notes to keep track of the decisions and steps of resolving the task.</td>
</tr>
</tbody>
</table>
3. In the Duplicate Audit Results section, click a duplicate CI to view the details about how it was identified as a duplicate.

Table 77: Duplicate Audit Results fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate CI</td>
<td>Reference to the duplicate CI.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is a document ID type, which means that it can reference any record on any table. If the referenced CI is deleted as part of resolving duplicate tasks, then this field will be empty.</td>
</tr>
<tr>
<td>Depend on</td>
<td>If the duplicate CI is a dependent CI, then this field displays the depend on CI.</td>
</tr>
<tr>
<td>Qualifier chain</td>
<td>If the duplicate CI is a dependent CI, then this field shows a list of sys_ids of qualifier CIs, if it exists.</td>
</tr>
<tr>
<td>Follow on task</td>
<td>The associated de-duplication task that captures the duplication.</td>
</tr>
<tr>
<td>Relationship</td>
<td>For a duplicate CI that is a dependent CI, this field shows the relationship between the duplicate CI and depend on CI.</td>
</tr>
</tbody>
</table>

Based on your analysis of de-duplication tasks, you can determine which CI should remain active and which of the duplicate CIs in the Duplicate Audit Results records are stale or incorrect. Determine if it is appropriate to delete or inactivate any of these CIs.

**CI reclassification**

During the CI identification process, a CI might need to be reclassified to a different `sys_class_name` type. By default, CIs are reclassified automatically. If automatic reclassification is disabled, then the CI is not reclassified and the system generates a reclassification task for your review.

A CI can be upgraded to a higher class, downgraded to a lower class, or switched to a different branch in the class hierarchy. For more details about reclassification operations, see `Reclassify a CI` on page 267. You can configure CI reclassification behavior at a system-wide level or individually per CI.
Enabling and disabling automatic CI reclassification

You can use the glide.class.upgrade.enabled, glide.class.downgrade.enabled, and glide.class.switch.enabled properties to configure system-wide behavior for CI reclassification. These properties are set to true by default, enabling automatic re-classification. To disable automatic CI re-classification, set the respective properties to false.

Alternatively, in the input payload of the createOrUpdateCI() API you can temporarily override a false value of the glide.class.upgrade.enabled property for individual CIs. In the payload, set these properties to true to enable automatic reclassification.

- classUpgrade
- classDowngrade
- classSwitch

The following sample JSON payload enables automatic reclassification for the specified CI:

```json
{ items: [{className: 'cmdb_ci_server', classUpgrade: true, classDowngrade: true, classSwitch: true, values: {name: 'linux123', serial_number: '12srt567', ip_address: '10.2.3.4'}}, ]}
```

View a reclassification task

When automatic CI reclassification is disabled, reclassification tasks are created for CIs that could not be automatically reclassified during the identification process. Review these tasks to locate the CIs and decide whether to reclassify them.

Role required: admin or itil

1. Navigate to Configuration > Identification/Reconciliation > Reclassification Tasks.
2. Select a reclassification task and example the details on the on the Reclassification Task form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>The CI that must be reclassified.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description noting that CI reclassification was not allowed.</td>
</tr>
<tr>
<td>Description</td>
<td>Description noting the current class of the CI and the class that the CI must be changed to.</td>
</tr>
<tr>
<td>Internal payload</td>
<td>Payload used in the identification process.</td>
</tr>
</tbody>
</table>

Table 78: Reclassification Task form

After examining the task details, you can locate the CI that is noted in the task Description and manually reclassify it. For details, see Reclassify a CI on page 267.

Service rules metadata

Service rules metadata defines the dependency structure of the CI types and the relationship types in service definitions. The metadata helps identify CIs and construct business service maps. Configure and manage service rules metadata with the metadata rules editor.
The dependencies defined by service rules metadata are used when identifying dependent CIs. This information helps prioritize the order of CI identification and match CIs and respective dependent CIs in a payload. Service rules metadata is also used by Service Mapping and can be defined for custom CI types. After defining a new CI type, you can define metadata rules that specify how the new CI type is related to existing types in the CMDB.

Service rules metadata consists of hosting rules and containment rules that describe a relationship type between two CI types. Each set of rules models the data from a different perspective of the CI.

- **Containment rules**: Represent CIs’ configuration hierarchy, each containment rule describing which other CIs are contained by a given CI.
- **Hosting rules**: Represent the placement of the CIs in a business definition, each hosting rule describing what a CI runs on.

The same relationship type can be used in a hosting rule and in a containment rule. It is the context in which the relationship is used that distinguishes between a containment and hosting rule.

The plugins that have been activated on an instance determine which hosting and containment rules are available by default.

### Hosting rules

Hosting rules represent all valid combinations for pairs of hosting and hosted CIs in the service definition. Hosting rules are a flat set of rules that can be only one level deep. You create them for resources, typically physical or virtual hardware.

Each hosting rule is a standalone rule between two CI types. It specifies the relationship between a CI type and another valid CI type that it can host or be hosted on in the service definition.

A hosting rule consists of a parent CI type, a relationship type (such as Hosted On::Hosts) and a child CI type. For example, a hosting rule can specify that the Application type Runs On::Runs the Hardware type.

If a CI is hosted on multiple resources (such as Windows and Linux), create a separate hosting rule for the CI with each resource that it can be hosted on. During CI identification, the pair of CIs in the relationship must satisfy at least one hosting rule.

Hosting rules are stored in the CMDB Metadata Hosting Rules [cmdb_metadata_hosting] table.

### Containment rules

The collection of containment rules represent the containment hierarchy for a CI type. Each rule specifies the relationship between a CI type and another valid CI type that it can contain or be contained by in the service definition. The rules are chained to each other in a containment rules group, with a CI type that is the top-level (root) parent of the group.

Containment rules are logical concepts and represent logical CIs. For example, to describe software that runs on a server, or to specify that the Tomcat type Contains::Contained By the WAR File type.

To designate that data flows into or from a CI type, add an endpoint to the rule for that CI type. After an endpoint is added to a containment rule, you cannot add any child rules to that rule.

Containment rules are stored in the CMDB Metadata Containment Rules [cmdb_metadata_containment] table.
Rules restrictions

The rules that you create are bound by the following restrictions and are enforced in the metadata rules editor. Only valid options that adhere to these restrictions are available in the editor.

- If a CI type is a child in a containment rule, it cannot be a top-level (root) parent of any other containment rule. It also cannot be in any hosting rule, either as a parent or as a child.
- If a CI type is a top-level (root) parent of a containment rule, it cannot be a child in a hosting rule. For example, a CI cannot be hosted on Tomcat, if Tomcat has any containment rules.
- If a CI type is a child in a hosting rule, it cannot be in any containment rule, either as a parent or a child.
- If a CI type is a parent in a hosting rule, it cannot be a child in any containment rule.
- Hosting rules cannot create loops, such as Tomcat –runs_on- VMWare –runs_on- Tomcat.

Hosting and containment rules model

Hosting rules that model the diagram:
- Tomcat ‘Runs on’ Hardware

Containment rules that model the diagram:
- Tomcat ‘Contains’ Configuration File
- Tomcat ‘Contains’ WAR
- WAR has two endpoints for JDBC with MySQL:
  - Inbound
  - Outbound

Valid set of rules
Create a containment rule

Create a containment rule to describe which CIs are contained by a given CI. Containment rules help identify dependent CIs correctly during the business discovery process and service mapping. Discovery calls the identification API that applies business metadata rules.

Role required: admin

When you create a containment rule, the first CI type that you add becomes the top level CI of a containment rules group which is a chain of containment rules. The entire set of containment rules is organized as groups according to top-level CIs.

To create a containment rules group for a new CI type, first add the CI type as CI Type1 of the relationship. To add a child containment rule for a CI type that exists, select that CI type and define the second portion of the relationship rule. This portion is the relationship type and CI Type2.

To each rule within a containment rules group, you can add inbound or outbound endpoints, which are noted by blue up and down arrows. After you add an endpoint to a containment rule, you cannot add child rules for that rule.

1. Navigate to Configuration > Identification/Reconciliation > Metadata Rules Editor.
2. In the Containment Rules section, click Add New Rule.
3. In the Add Top-Level Containment Rule dialog box, select the CI type that you want to be the root CI type for this group of containment rules.
4. To add a child rule for a containment rule:
   a) Point to the containment rule and then click the green plus icon that appears.
   b) In the Add Containment Rule to dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Type</td>
<td>The CI for the rule.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Reverse Relationship Direction</td>
<td>A check box to use the reverse relationship in the rule.</td>
</tr>
</tbody>
</table>

c) Click Create.

5. To add an endpoint to a child rule:
   a) Point to the child rule and click the blue plus icon that appears.
   b) In the Add Endpoint to dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Type</td>
<td>The type of endpoint.</td>
</tr>
<tr>
<td>Inbound or Outbound</td>
<td>The direction of the endpoint.</td>
</tr>
</tbody>
</table>

c) Click Create.
Create a hosting rule

Create a hosting rule to describe what a CI runs on. Hosting rules help identify dependent CIs correctly during the business discovery process and service mapping. Discovery calls the identification API that applies business metadata rules.

Role required: admin

Add a CI type as CI Type1 in the relationship rule. Then define the second portion of the relationship rule, which is the relationship type and CI Type2. The entire set of hosting rules is organized as groups according to the top-level hosted CIs.

1. Navigate to Configuration > Identification/Reconciliation > Metadata Rules Editor.
2. In the Hosting Rules section, click Add New Rule.
3. In the Add Top-Level Hosting Rule dialog box, select the CI type that you want to create this rule for, and click Create.
4. Complete the following steps to specify a child CI type and a relationship type for the rule:
   a) Point to the CI type and click the green plus icon that appears.
   b) In the Add Hosting Rule to dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Type</td>
<td>The CI for the rule.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The relationship type for the rule.</td>
</tr>
<tr>
<td>Reverse Relationship Direction</td>
<td>A check box to use the reverse relationship in the rule.</td>
</tr>
</tbody>
</table>

You can add multiple sets of child CI types and relationships to create multiple hosting rules for the same parent CI type.

   c) click Create.

Installed with Identification and Reconciliation

CMDB Identification and Reconciliation adds tables, properties, and script includes.

Tables installed with Identification and Reconciliation

Identification and Reconciliation uses the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>Identification rule sets defined for different classes of CIs.</td>
</tr>
<tr>
<td>[cmdb_identifier]</td>
<td></td>
</tr>
<tr>
<td>Data Source Definition</td>
<td>Reconciliation rules defined for different classes of CIs at the table and field level.</td>
</tr>
<tr>
<td>[cmdb_datasource_definition]</td>
<td></td>
</tr>
<tr>
<td>Identifier Entry</td>
<td>Rule entries with different priorities assigned to each identifier.</td>
</tr>
<tr>
<td>[cmdb_identifier_entry]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data Source Precedence</td>
<td>Priorities of data sources that are authorized to update the same CI types or CI type with same sets of attributes.</td>
</tr>
<tr>
<td>[cmdb_datasource_precedence]</td>
<td></td>
</tr>
<tr>
<td>Duplicate Audit Result</td>
<td>Duplicate audit results corresponding to a specific duplicate task. These results are generated automatically during the identification process and should not be added manually.</td>
</tr>
<tr>
<td>[duplicate_audit_result]</td>
<td></td>
</tr>
<tr>
<td>Reconcile Duplicate Task</td>
<td>Task to address duplication that is detected during the identification process. Records are generated automatically, and users should not add records manually.</td>
</tr>
<tr>
<td>[reconcile_duplicate_task]</td>
<td></td>
</tr>
<tr>
<td>Reclassification Task</td>
<td>Reclassification tasks that were generated during the identification process.</td>
</tr>
<tr>
<td>[reclassification_task]</td>
<td></td>
</tr>
</tbody>
</table>

**Properties installed with Identification and Reconciliation**

Identification and Reconciliation uses the following properties.

Updating these properties requires users to have the admin role.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.required.attribute.enabled</td>
<td>Flag for enforcing required attributes during identification and reconciliation so that attributes cannot be null.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Properties [sys_properties] table.</td>
</tr>
</tbody>
</table>

| glide.class.upgrade.enabled       | Flag for allowing class upgrade during identification and reconciliation.   |
|                                   | • **Type**: true | false                      |
|                                   | • **Default value**: true                                                  |
|                                   | • **Location**: System Properties [sys_properties] table.                  |

<p>| glide.class.downgrade.enabled     | Flag for allowing class downgrades during identification and reconciliation. |
|                                   | • <strong>Type</strong>: true | false                      |
|                                   | • <strong>Default value</strong>: true                                                  |
|                                   | • <strong>Location</strong>: System Properties [sys_properties] table.                  |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.class.switch.enabled                   | Flag for allowing class switching during identification and reconciliation.  
  - **Type**: true | false  
  - **Default value**: true  
  - **Location**: System Properties [sys_properties] table.                                                                                                                                                                                                                                                                           |
| glide.reconciliation.override.null           | Flag for allowing the update of an empty field by a lower priority data source.  
  - **Type**: true | false  
  - **Default value**: true  
  - **Location**: System Properties [sys_properties] table.                                                                                                                                                                                                                                                                               |
| glide.identification_engine.skip_duplicates.threshold | The maximum number of CIs that can be in a set of duplicate CIs to allow identification to process the duplicate CIs according to the setting of glide.identification_engine.skip_duplicates.  
  If the number of duplicate CIs exceeds the threshold, then identification processes the duplicate CIs as if glide.identification_engine.skip_duplicates is set to false.  
  - **Type**: Integer  
  - **Default value**: 5  
  - **Location**: Add to the System Properties [sys_properties] table.                                                                                                                                                                                                                                           |
| glide.identification_engine.skip_duplicates  | Controls how identification processes a small set of duplicate CIs.  
  - When true: If the number of duplicate CIs is less than the threshold specified by glide.identification_engine.skip_duplicates.threshold, then one of the duplicate CIs is picked as a match and gets updated. For the rest of the duplicate CIs, the CMDB_CIs' discovery_source field is set to 'Duplicate'.  
  - When false: Matching a CI fails, and an error is logged.  
  - **Type**: true | false  
  - **Default value**: true  
  - **Location**: Add to the System Properties [sys_properties] table.                                                                                                                                                                                                                                           |
Script includes installed with Identification and Reconciliation

Identification and Reconciliation uses this script include.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDBTransformUtil</td>
<td>Performs identification and reconciliation.</td>
</tr>
</tbody>
</table>

Useful related lists in CI forms

By default, the forms that display manageable configuration items (CI) - computers, printers, network gear, uninterruptible power supplies (UPS), and power distribution units (PDU) - provide a number of related lists for the form.

The following related lists are common to all forms for manageable CIs.

- **Network Adapters** - Displays all the NICs installed on a CI.
- **CI IPs** - Displays all the IP addresses on this CI:
  - Computers (workstations, laptops using various Mac and Windows operating systems)
  - Windows servers
  - Linux servers
  - AIX servers
  - Solaris servers
  - Devices discovered through SNMP.
- **DNS Names for CIs** - Displays all the DNS names on a CI.

The IP version information appears in all IP address related lists and forms.

---

**Note:** Since all paths here click into the IP Address to DNS Names list that associates an IP address with a DNS name, this part of the common flow was not added to the tree structure.

Discovery source

A table called Source [sys_object_source] stores information identifying the source of a discovery (by ServiceNow Discovery or another product), the ID of that source, and the date/time of the last scan. To view this information, configure a CI form and add the **Sources** related list. This table is populated automatically when the Discovery plugin is enabled.

CMDB and Extended CMDB

The Configuration Management (CMDB) application provides core functionality for the configuration management database, including modules for hardware and configuration items. The separate Extended CMDB plugin includes a collection of modules for specialized configuration items, such as radio hardware, test equipment, and voice system hardware.

The Configuration Management (CMDB) plugin is automatically active for all instances. You must activate the Extended CMDB plugin to see the modules for specialized configuration items.

**Activating the Extended CMDB plugin**

Role required: admin
When you activate the Extended CMDB plugin, the **Configuration by Category** application is added to the application navigator.

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.
   
   If the plugin depends on other plugins, these plugins and their activation status are listed.
3. [Optional] Select the **Load demo data** check box.
   
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when first activating the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click **Activate**.

### Enterprise Configuration Management Database (ECMDB) action icons

Any of the following icons may appear in the ECMDB lists of related items.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="X.png" alt="X" /></td>
<td>For currently active incidents against this configuration item.</td>
</tr>
<tr>
<td><img src="U.png" alt="U" /></td>
<td>For currently active problems against the configuration item.</td>
</tr>
<tr>
<td><img src="A.png" alt="A" /></td>
<td>For currently active changes against the configuration item that are not covered in the past, current, pending changes. For example, a request to update the operating system on a server that is currently in progress may display this icon.</td>
</tr>
<tr>
<td><img src="B.png" alt="B" /></td>
<td>For changes that were recently completed against the configuration item. changes with an &quot;Actual_end_date&quot; in the past.</td>
</tr>
<tr>
<td><img src="D.png" alt="D" /></td>
<td>For changes that are planned soon against the configuration item. changes with an &quot;Actual start date&quot; in the future.</td>
</tr>
<tr>
<td><img src="F.png" alt="F" /></td>
<td>For currently active changes against the configuration item that have an &quot;Actual start date&quot;.</td>
</tr>
<tr>
<td><img src="O.png" alt="O" /></td>
<td>For outages that were recently completed against the configuration item. outages with an &quot;end&quot; date in the past.</td>
</tr>
<tr>
<td><img src="P.png" alt="P" /></td>
<td>For outages that are planned soon against the configuration item. outages with a &quot;begin&quot; date in the future.</td>
</tr>
</tbody>
</table>

*Note: Functionality described here requires the Enterprise CMDB plugin.*
For currently active outages against the configuration item that have a "begin" date in the past and no "end" date.

This will only show up in the Tree view and indicates that a configuration item that is downstream has at least one of the above issues against it.

The system looks 5 calendar days in the past and 7 calendar days in the future when looking at recent outages and changes.

Options to populate the CMDB

You can populate the CMDB by using Discovery, by importing information from another source, or by integrating with an existing external CMDB.

When you populate the CMDB with information, you create a record for each configuration item in the cmdb_ci table or on one of the tables that extend that table.

ITIL configuration management auto-discovery

The key to any configuration management business practice is the initial and on-going inventory or discovery of what you own. The ServiceNow platform provides three options for auto-discovery:

• The separate and highly robust Discovery product.
• A lightweight native discovery tool, called Help the Help Desk, as part of the overall CMDB. Help the Help Desk enables organizations to proactively scan their network to discover all Windows-based PCs and the software packages installed on those PCs. This WMI-based discovery is included in the core ServiceNow functionality, in the Self Service application, at no additional cost.
• For organizations that want to leverage the discovery technologies they already have deployed (SMS, Tally NetCensus, LanDesk, etc.), the ServiceNow platform supports integrations to those technologies via web services. Scanned data can be mapped directly into the CMDB.

For further information and best practices for designing, constructing, and maintaining the CMDB, see white papers CMDB Design & Configuration and CMDB Design.

Populate the CMDB with Discovery

The Discovery product automatically populates the CMDB. Discovery runs probes and sensors to collect information on hardware on the network, software running on that hardware, and the relationships between all of the items found. This information is sent back to the ServiceNow instance, and is used to populate the CMDB.
Figure 25: Discovery overview

**Populate the CMDB by importing information from another source**

Information can be imported to the CMDB using import sets. Import sets find files of information (in formats such as XML, Excel, or CSV), import them, and transform them onto the required table. This process can be scheduled or performed on demand.

To import relationships between CIs, use import sets to populate the table [cmdb_rel_ci] with information on the parent, the child, and the nature of the relationship. The [cmdb_rel_ci] table displays a list of all CI relationships and is useful when importing CI data.
Populate the CMDB by integrating with an existing external CMDB

If the data required for the CMDB is already being collected by another CMDB, it is possible to collect the information from that CMDB in an automated process.
Help the Help Desk

Help the Help Desk is a tool that allows users to populate the CMDB automatically with information about their Windows computer.

Help the Help Desk is a small Web application that downloads and runs locally, using a WMI login script to gather information such as serial number, computer name, disk configuration, network configuration, installed software, memory, and much more. Users have the option of using two types of SOAP authentication for running the Help the Help Desk script.

- Cookie-based authentication on page 294
- Basic access authentication on page 296

User roles and user names

Users must have the soap_ecc role to use Help the Help Desk from within an instance.
For users without access to an instance, you can configure Help the Help Desk to allow users to *run the script without login credentials*. Users with access to an instance can also use Help the Help Desk configured in this way, but only if they have the soap_ecc role.

User name cannot contain these characters: `\n`

Any user name that contains the `\n` characters prevents the **Assigned to** field on a computer from being populated.

### Help the Help Desk device identification

Help the Help Desk uses a predefined series of queries to identify and update existing CIs in the CMDB or to create a new CI if no match is found. These queries attempt to match devices using three criteria in a certain order.

Updates to an existing CI require only a single match as the list is evaluated. For example, if a device's name has changed, but the MAC address is the same, the CI with the matching MAC address is updated.

- Serial number in the `[cmdb_ci_computer]` table
- MAC address in the `[cmdb_ci_network_adapter]` table
- Computer name in the `[cmdb_ci_computer]` table

**Note:** Discovery Identifiers are incompatible with Help the Help Desk queries.

### Script include

The script include `CIIdentifierForHelpDesk` provides the logic for updating existing CIs or creating a new CI if no matching device exists in the CMDB. Do not modify this script. Errors introduced into this script can result in update failures or in new CIs being created for every device found.

### Discovery vs. Help the Help Desk

Help the Help Desk is a standard feature available through the self-service Help the Help Desk application.

It gathers information, much as Discovery does, about a single Windows computer by running a script on that computer. Discovery does many things that Help the Help Desk cannot do.

**Table 79: Comparison of Discovery vs. Help the Help Desk**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Discovery</th>
<th>Help the Help Desk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic discovery by schedule</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Automatic discovery on user login</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Manually initiated discovery</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Windows workstations</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Windows servers</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Linux systems</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>
### Configure SOAP authentication

By default, the ServiceNow system requires SOAP authentication. This affects the way in which your browser is configured for Help the Help Desk.

**Role required:** admin

1. Navigate to **System Properties > Web Services**.
2. Verify the system property for Require basic authorization for incoming SOAP requests glide.basicauth.required.soap is enabled.
3. Click **Save**.

**Note:**

If you receive the error, *There was a problem retrieving the XML data(0): Unknown*, an authentication issue is preventing the script from sending information to your ServiceNow instance. Verify the user meets the requirements for **Cookie-based authentication** on page 294 or **Basic access authentication** on page 296.

### Cookie-based authentication

Cookie-based authentication uses cookies generated by Windows Internet Explorer for SOAP authentication on the instance.

This type of authentication can be used to run the Help the Help Desk script at the time it is downloaded or after it has been saved to the local drive. When the script is downloaded, Internet Explorer generates a cookie using the user's login credentials, and then shares this cookie with the script. When a user attempts to run the script, the instance checks first for this cookie. If the cookie has been created, the script can authenticate on the instance through SOAP.
The following setup requirements are imposed on `.hta` file downloads by Microsoft.

- You must use Internet Explorer and choose to run the script while you're logged in to your instance. If you choose to use a different browser and download the script file to run at a later time, the script will not work properly unless you have an active session on your instance with Internet Explorer.

- Disable **Protected Mode** and **User Account Control (UAC)**. Protected Mode is available in Internet Explorer 7 or later in Windows Vista. UAC is a feature of Windows Vista and Windows 7.

- This feature requires that your logged in user session be persisted to the Help the Help Desk script. For this to occur, the **Remember me check box** in the login screen must be enabled and selected (the
default behavior). This option enables the system to write back an HTTP cookie to your browser to be persisted across sessions.

Basic access authentication

An alternative to cookie-based authentication for the Help the Help Desk script is basic access authentication, which employs two properties to configure the script with credentials.

When a user logs in with the proper credentials, that user accesses the instance in the soap_ecc role, which grants access to the ECC queue but limits the user’s access to other features. The administrator then configures the system properties with the user name and password for the soap_ecc user.

The values from these properties are automatically saved to the script file helpthehelpdesk.js. When this user runs the Help the Help Desk script, the instance checks for a cookie. If no cookie is found, the instance checks for the login credentials provided by the system properties, and authenticates the script automatically.

Set up basic access authentication for the Help the Help Desk script

You can set up basic access authentication for the Help the Help Desk script.

Role required: admin

1. Create a new user with the following values.

<table>
<thead>
<tr>
<th>User ID</th>
<th>Create an easily recognizable user name such as SOAPAUTH or SOAPONLY.</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>SOAP</td>
</tr>
<tr>
<td>Last name</td>
<td>Authentication</td>
</tr>
<tr>
<td>Password</td>
<td>Any password</td>
</tr>
</tbody>
</table>

2. Right-click the header bar and select Save. The record is saved, and the Related Lists appear.

3. In the Roles Related List, click Edit.

4. In the slushbucket, move the soap_ecc role from the Collection list to the Roles list, and then click Save.

5. Navigate to System Definition > Help the Help Desk.

6. Add the user name and password you created to the appropriate properties, and then click Save. The password is encoded when saved.

The login credentials from these properties are saved to the helpthehelpdesk.js script. When the Help the Help Desk script is run by a user logged in with these credentials (in the soap_ecc role), the script is able to authenticate automatically on the instance.

Help the Help Desk login script

The Help the Help Desk script enables organizations to proactively scan their network to discover all Windows based hardware and the software packages installed on those devices.

This WMI-based script is included in the core ServiceNow platform functionality. This script also can be set up to run as a Windows login script and used to keep the CMDB up to date. The script is named helpthehelpdesk.js and can be downloaded from each customer’s local instance.
Install and use the login script

The login script is installed on the instance and can be downloaded directly from a module.

Role required: admin

The same script is used to perform the Help the Help Desk scan, which gathers information about a user's Windows computer and updates the CMDB.

1. Log in to your instance with Windows Internet Explorer.
2. Navigate to System Definition > Help the Help Desk Login Script.
3. Follow the download instructions in the page that appears.
4. Put the helpthehelpdesk.js file in the following folder: %SystemRoot%\sysvol\sysvol\<domain DNS name>\scripts where %SystemRoot% is usually c:\winnt or c:\WINDOWS and <domain DNS name> is the DNS name of the domain, similar to MyDomain.com. This folder is replicated to all domain controllers in the domain.
5. Open the helpthehelpdesk.js file in a text editor, such as Wordpad.
6. Check the var server line to ensure that the URL for your ServiceNow instance is correct. The name of the instance is added automatically. It should look something like this:

```javascript
var server = "https://abctech.service-now.com/";
```

7. Ensure that basic authorization for SOAP requests is enabled in your instance, and a SOAP user is defined.
   This allows the script to connect to your instance. The entry should look something like this:

```javascript
var httpUsername = "user_on_your_instance";
var httpPassword = "user's_password";
```

8. Create a Logon.bat script to run helpthehelpdesk.js as follows.

```bash
@echo off
cscript %0\..\helpthehelpdesk.js
EXIT
```

9. Add Logon.bat to the Logon script field on the Profile tab of the user properties dialog in the Active Directory Users and Computers MMC corresponds to the scriptPath attribute of the user object. Logon scripts can also be configured in Group Policy. However, Group Policy only applies to clients with Windows 2000 or above. The setting in Group Policy is User Configuration, Windows Settings,
Scripts (Logon/Logoff), Logon. Best practice is to copy the file you want for the Logon script to the Windows clipboard.

10. Open the Logon setting in the Group Policy editor.
11. Click the Show Files button.
12. Paste the desired file in the dialog.

You can select the file and edit it in this dialog as well. This is easier than navigating in Windows Explorer to the folder where Group Policy Logon scripts are saved. However, if you do have to navigate to the folder, the path on the domain controller is:

%SystemRoot%\sysvol\sysvol\<domain DNS name>\<policy GUID>\user\scripts\logon

Again, %SystemRoot% is usually c:\winnt and <domain DNS name> is the DNS name of the domain, similar to MyDomain.com.

<policy GUID> is a hexadecimal string representing the GUID (unique identifier) of the specific Group Policy Object (GPO). Group Policies are assigned to a domain, site, or organizational unit in Active Directory.

The logon script setting applies to all users in the domain, site, or organizational unit to which the GPO applies. You will notice that you assign a logon script to all users in the container at once, rather than having to assign the scriptPath attribute for each user. This makes it much easier to assign logon scripts to many users. However, since the same Group Policy applies to all users in the domain, site, or organizational unit, you must code the logon script to accommodate all users.

Encode the Help the Help Desk password

You can use the Help the Help Desk properties to encode the password with simple base64 encoding.

Role required: admin

Configure the user name and encode the password in the properties before downloading the script. This adds the encoded password directly to the script without any further configuration.

1. Navigate to System Definition > Help the Help Desk.
2. Enter a user name and password into the properties for SOAP authentication.
3. Click Save.
The password is encoded immediately.

4. Navigate to **System Definition > Help the Help Desk Login Script**
5. Download the script.

```javascript
/* **************************** Required Variables ****************************
* The following section should be modified if the information is not correct. 
* *****************************/

// If SOAP authentication is turned on on the instance. The http authentication should be provided here
var server = "https://demos.service-now.com/");

var Username = "sncuser",
var httpPassword = "encrypted:CGFzc3dvcmQ=";
```

The script downloads with the encoded password in place. If you download the script before encoding the password in the properties form, you must add the variable and encoded password manually.

**Run the Help the Help Desk script**

You can run the Help the Help Desk script manually.

You also can configure Help the Help Desk to run automatically when users log into their computer. For more details, see **Help the Help Desk login script** on page 296.

1. On your instance, navigate to **Self Service > Help the Help Desk**.
2. Click **Start the Scan to Help the Help Desk**.
3. Run or save the discovery.hta script.
   - If your browser is Windows Internet Explorer, run the script.
   - If you are using any other browser, click Save and save the script to the local machine. To execute the saved script, double-click the file.

The script runs a series of WMI queries to gather information about the Windows machine. When it is finished, the data is sent back to your instance and is used to populate the configuration database (CMDB).

**Access Help the Help Desk status**
Help the Help Desk displays the status of all scans in daily records. Drill down into a record for details on how the CMDB was updated within the last 24 hours from scans performed on the instance.

Role required: admin

1. Navigate to System Definition > Help the Help Desk Status.
   A new status record is created each day and displays the number of scans completed (devices scanned). The Description field shows Help the help desk as the source of the scan.

2. To view the details of individual scans, open a scan record.
3. In the scan record, select the Devices tab to view all the devices scanned by Help the Help Desk that day.

Each CI displays the device class and the activity completed: Created CI or Updated CI. By default, Help the Help Desk cannot discriminate class between servers and workstations and classifies each CI as a Computer. However, if Discovery is activated on the instance, Help the Help Desk can classify CIs as either Windows servers or computers.
4. Select the **ECC Queue** tab to examine the data payload returned from each scan.

If Discovery is active on the instance, the Help the Help Desk status appears in the Discovery Status record list. These scan records are described as **Help the help desk** in the list to differentiate them from regular discoveries run from a schedule or a UI action. Open the status record to access the forms described in this page.

---

**Determine values for the Assigned to field**

This page explains how to set properties to determine which value appears in the **Assigned to** field when the script is run.
Role required: admin

Any user name that contains the \n characters prevents the Assigned to field on a computer from being populated.

- Navigate to System Definition > Help the Help Desk.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.wmi.assigned_to_always_overwrite</td>
<td>If the Help the Help Desk script is run on the same computer by different users, the platform overwrites the user name in the Assigned to field each time the script is run.</td>
</tr>
<tr>
<td></td>
<td>To prevent this, set the For Help the Help Desk script, if the property is &quot;yes&quot;, the &quot;assigned_to&quot; field of the CI is always overwritten; otherwise the field is not overwritten unless it is empty.</td>
</tr>
<tr>
<td></td>
<td>[glide.wmi.assigned_to_always_overwrite] property to false (clear the check box).</td>
</tr>
</tbody>
</table>

| glide.discovery.assigned_user_match_field   | Help the Help Desk attempts to match a Windows user name it finds with the the user_name field of the User [sys_user] table. However, this might not be desirable if the user_name field from the User [sys_user] table contains formatting that is different from that found in Windows. |
|                                             | The For Discovery and Help the Help Desk, the following field in the sys_user table is used to associate a computer CI with a user. |
|                                             | [glide.discovery.assigned_user_match_field] property enables you to select an alternative field for matching. For example, you can create a field called u_username, and then populate it with a user ID that can be matched against the Windows user name. In this case, replace the default value in the property with u_username. |

View scan results
You can view the results of Help the Help Desk scans on an instance.

Role required: admin

These records provide access to logs, CI records, and the ECC queue for all scans conducted each day. Help the Help Desk status reports are also accessible from the Discovery status list.

1. Navigate to System Definition > Help the Help Desk Status.
2. Open the daily status record.

Run the script with browsers other than Internet Explorer
You can run the discovery.hta script with browsers other than Internet Explorer.

Browsers other than IE cannot handle files with the .hta extension. Browsers like Firefox, Safari, and Opera prompt users to download the script file, which you can then double-click to run.
However, in Windows XP (including Vista, Windows 2003 Server, and later), files downloaded from the Internet are marked with a security restriction that interferes with running the script. The typical error message introduced by this security restriction looks like this:

```
eccevent(): Access Denied
```

To remove the security lock on the downloaded file, complete the following steps.

1. Right-click on the downloaded file and select **Properties**.
   - The following message is displayed on the bottom of the form:
     ```
     This file came from another computer and may be blocked to protect this computer.
     ```

2. Click **Unblock** to remove the security restriction.
   - The script will run if SOAP authentication is disabled.

**Detect software on 64-bit systems**

You can detect all system software successfully on a 64-bit machine.

A 64-bit browser can detect both 64-bit and 32-bit software, but a 32-bit browser cannot detect 64-bit software.

- To detect all system software, run the Help the Help Desk script from a 64-bit browser.

**Allow users without a ServiceNow instance login to run the script**

You can configure the Help the Help Desk script to run for users without prompting for a user name and password.

Role required: admin

This setup enables users who do not have access privileges to a your instance to run the script on their Windows machines without having to provide a user name and password. The script can be configured to login in automatically as a SOAP user with the soap_ecc role.

1. Log in to your instance with Windows Internet Explorer.
2. Navigate to **System Definition > Help the Help Desk Login Script**.
3. Follow the download instructions in the page that appears.
4. Put the `helpthehelpdesk.js` file in the following folder: `%SystemRoot%\sysvol\sysvol\<domain DNS name>\scripts` where `%SystemRoot%` is usually `c:\winnt` or `c:\WINDOWS` and `<domain DNS name>` is the DNS name of the domain, similar to `MyDomain.com`. This folder is replicated to all domain controllers in the domain.
5. Open the `helpthehelpdesk.js` file in a text editor, such as Wordpad.
6. Check the `var server` line to ensure that the URL for your ServiceNow instance is correct.
   - The name of the instance is added automatically. It should look something like this: `var server = "https://abctech.service-now.com/"`
7. Ensure that basic authorization for SOAP requests is enabled in your instance and a SOAP user is defined.

This allows the script to connect to your instance. The entry should look something like this:

```javascript
var httpUsername = "user_on_your_instance";
var httpPassword = "user's_password";
```

8. Make the script file available to all users.

Unable to parse SOAP document error

The error message Error: Unable to parse SOAP document means that the Help Desk script was unable to connect to the instance to relay the information that was discovered.

Enterprise CMDB

The Enterprise Configuration Management Database (ECMDB) is targeted toward businesses that want to monitor, manage, measure, track, alert on change, and generally understand business systems that consist of a large number of components, business, and support personnel.

For example, a bond trading service may have multiple application, and web servers, several databases, Linux, UNIX, and Windows servers. There will be security products, network storage, disaster recovery procedures and hardware, etc. that are necessary for the service to operate properly.

The ECMDB makes it easy to either manually enter the relationships or have them populated automatically by discovery tools. In addition to the hardware, software, network, database, and storage areas, it is beneficial to know which individuals or groups are responsible for the service from both a business perspective as well as an IT perspective. Who are the line of business users and managers? Who starts and stops the application or its components? Who monitors the log files? Who is in charge of backup and restore, business continuity, and disaster recovery?

CMDB data model

View a graphical display of the first few layers of the CMDB data model.

The Configuration Management Database (CMDB) is a series of tables that contain all the assets and business services controlled by a company and their configurations. Configuration items such as
computers and other devices on the network, software contracts and licenses, and business services are represented.

The following figure represents the first few levels of the CMDB tables. These tables represent the class or type of the configuration items.

**Note:** Some parts of this model might not be up to date. For example, the Base Configuration Item [cmdb] table which is the parent of Configuration Item [cmdb_ci], isn't showing.
Figure 29: CMDB data model
CMDB relationships

The ECMDB lets you easily track all relationships by relationship type.
The Enterprise CMDB extends the capabilities of the ServiceNow platform CMDB in the following areas.

Extended configuration item types

- Clusters
- Database Instances (Oracle, MySQL, MSFT SQL Server)
- File Systems (Direct and network attached)
- Linux Servers
- Solaris Servers
- AIX Servers

Extended relationships

Accurate description of relationships between items, and between items and people or groups, is important
to understand the fabric of a business service. ECMDB provides many relationship types out of the box,
but it is easy to extend the number of relationship types. Example relationship types include the following.
- Connects to
- Depends on / Provides Service to
- Powered by / Powers
- Protected by / Protects
- Disaster Recovery Provided by / Provides Disaster Recovery for

Visualization

The system can show relationships as a hierarchy using a standard treeview, flattened, or graphically, all in
a simple web interface.

Auditing

Auditing of changes to configuration items is turned on by default.

Federation

Federation of third party discovery and configuration data is supported through standard synchronization
offerings (SMS, LAN Desk, others) and through the CMDB Discovery [cmdb_discovery] table.

Configuration item modeling (product models)

Model driven configuration management allows the definition of CI models up front that can be associated
to product maintenance lifecycles, cost centers, and support organizations, as well as provides a means for
capacity and inventory planning. By defining models for CIs (which have a many to one relationship to the
model), you can dynamically group actual discovered or imported CIs into logical, operational, and financial models. This facilitates an organized approach to managing your assets (CIs) in their respective domains.

### Business service tables

In the CMDB, the Business Service table [cmdb_ci_service] stores information about business services. A business service is work or goods that are supported by an IT infrastructure. For example, delivering email service to an employee can require services such as email servers, web servers, and the work to configure the user’s account. A business service management map graphically displays the configuration items (CI) that support a business service and the relationships between the configuration items.

The Business Service table [cmdb_ci_service] stores the business services in the CMDB.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business criticality</td>
<td>The importance of this service to the business. This field can be used to determine disaster recovery strategies for this service. Default options are:</td>
</tr>
<tr>
<td>Service classification</td>
<td>Designates the type of the service.</td>
</tr>
<tr>
<td>Used for</td>
<td>Designates how this service is used. Default options are:</td>
</tr>
<tr>
<td>Users supported</td>
<td>The users that this service supports. A reference to the Group [sys_users_group] table.</td>
</tr>
</tbody>
</table>
### The Service Configuration Item Association table

The Service Configuration Item Association table [svc_ci_assoc] binds a business service and a configuration item (CI) to track which CIs are part of each business service.

**Table 81: The Service Configuration Item Association table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item Id</td>
<td>A reference to the configuration item [cmdb_ci] table.</td>
</tr>
<tr>
<td>Service Id</td>
<td>A reference to the business service [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>

### The Service Relationship Association table

The Service Relationship Association table [svc_rel_assoc] binds a business service and a relationship to track which relationships are part of a business service.

**Table 82: The Service Relationship Association table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relation Id</td>
<td>A reference to the CI Relationship [cmdb_rel_ci] table.</td>
</tr>
<tr>
<td>Service Id</td>
<td>A reference to the Business Service [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>

### Table form views

When you view a table definition form, you can open the context menu, and select a form view in which to display the table. The default view for a table is the Default view. For any class that is an extension of the CMDB table, you can select the CI Definition view which provides additional access to related tables and information.

The CI Definition form view is a centralized location from which you can configure and view a table. In addition to the information that the default view displays, the CI Definition form view provides the following controls.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon tab</td>
<td>View and create new NG-BSM icons for CI types</td>
</tr>
<tr>
<td>CI Identifier tab</td>
<td>View and create new CI identifiers</td>
</tr>
<tr>
<td>Reconciliation Definitions tab</td>
<td>View and create new data source definitions</td>
</tr>
</tbody>
</table>
To access these additional controls on the CI Definition form view, you need to first create a new table that is derived from the CMDB table, and then view it using the CI Definition form.

### Contract Management

Manage and track contracts with the Contract Management application in the ServiceNow platform. A contract is a binding agreement between two parties. In the ServiceNow platform, contracts contain detailed information such as the following:

- Contract number
- Contract start and end dates
- Active status
- Terms and conditions statements
- Documents
- Renewal information
- Financial terms

Contract Management is active by default. If the Cost Management plugin has been activated, Contract Management integrates with Cost Management to associate contracts with costs and determine the total cost of ownership. You can track recurring expenses with rate cards and expense lines. An administrator can activate the Cost Management plugin.

To use terms and conditions in Contract Management, you must activate the Managed Documents plugin.

To associate contracts with work orders, you must activate the Work Management plugin.

If you are using the Software Asset Management plugin, use the Software Licenses option.

### Use the Contract Management Overview module

You can view information about your contract status in the Contract Management Overview module. It displays various contract management gauges.

Role required: asset, contract_manager

Because the Contract Management Overview module is a type of homepage, you can add, delete, and rearrange gauges on the page.

1. Navigate to **Contract > Overview**.
2. Click elements within the gauges to obtain more information. For example, click any of the colored bars in the **Contract Expenditure by Type** bar chart gauge to view detailed information.
Components installed with Contract Management

Several types of components are installed with Contract Management. Demo data is available.

Tables installed with Contract Management

Contract Management adds the following tables.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Covered [clm_m2m_contract_asset]</td>
<td>Lists the assets covered by a contract. An asset can be covered by multiple contracts and a contract can have multiple assets.</td>
</tr>
<tr>
<td>Asset Covered [clm_m2m_rate_card_asset]</td>
<td>Lists the rate cards that apply to an asset.</td>
</tr>
<tr>
<td>Condition [clm_condition_checker]</td>
<td>Lists the conditions and values for each condition checker.</td>
</tr>
<tr>
<td>Condition Checks [clm_condition_check]</td>
<td>Stores conditions and values that modify specified condition fields.</td>
</tr>
<tr>
<td>Contract History [clm_contract_history]</td>
<td>Stores a copy of the contract when the start date, end date, or terms and conditions change.</td>
</tr>
<tr>
<td>Terms and Conditions [clm_terms_and_conditions]</td>
<td>Lists the terms and conditions used by contracts.</td>
</tr>
<tr>
<td>Terms and Conditions [clm_m2m_contract_and_terms]</td>
<td>Lists all terms and conditions available for use with contracts.</td>
</tr>
<tr>
<td>Users Covered [clm_m2m_contract_user]</td>
<td>Lists the users covered by contracts.</td>
</tr>
</tbody>
</table>

**User roles installed with Contract Management**

Contract Management adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contract_manager</td>
<td>financial_mgmt_user</td>
<td>Manages the contract life cycle. Can create, edit, and delete contracts.</td>
</tr>
</tbody>
</table>

**Script includes installed with Contract Management**

Contract Management adds the following script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConditionChecks</td>
<td>Checks for matching conditions, such as for contract expirations and license compliance, defined in the Condition Checks [clm_condition_check] table.</td>
</tr>
<tr>
<td>ContractManagementUtils</td>
<td>Utilities that manage contract management actions, such as state transitions.</td>
</tr>
</tbody>
</table>

**Client scripts installed with Contract Management**

Contract Management adds the following client scripts.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Tax Cost - Base cost</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> field and the <strong>Total cost</strong> field on the Contract form when the <strong>Payment amount</strong> field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Sales tax</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> field and the <strong>Total cost</strong> field on the Contract form when the <strong>Sales tax</strong> field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Tax rate</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> field and the <strong>Total cost</strong> field on the Contract form when the <strong>Tax rate</strong> field changes.</td>
</tr>
<tr>
<td>Ensure discount is valid percent</td>
<td>Contract [ast_contract]</td>
<td>Ensures that the <strong>Discount</strong> field does not contain a value less than zero or greater than 99.</td>
</tr>
<tr>
<td>Renew Cost Adjustment</td>
<td>Contract [ast_contract]</td>
<td>Sets the <strong>Percentage</strong> field on the Contract form to zero if the user sets a dollar amount for the cost adjustment.</td>
</tr>
<tr>
<td>Renew Cost Percentage</td>
<td>Contract [ast_contract]</td>
<td>Sets the <strong>Amount</strong> field on the Contract form to zero if the user enters a percentage for the cost adjustment.</td>
</tr>
<tr>
<td>Tax exempt/ rate</td>
<td>Contract [ast_contract]</td>
<td>Changes all tax-related fields on the Contract form to read-only if the <strong>Tax Exempt</strong> check box is selected.</td>
</tr>
<tr>
<td>Tax rate/exempt</td>
<td>Contract [ast_contract]</td>
<td>Changes all tax-related fields on the Contract form to writeable if the <strong>Sales Tax</strong> check box is selected.</td>
</tr>
</tbody>
</table>

**Business rules installed with Contract Management**

Contract Management adds the following business rules.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate projected costs</td>
<td>Contract [ast_contract]</td>
<td>Calculates the projected monthly and annual costs for a contract when costs or payment schedule changes.</td>
</tr>
<tr>
<td>(Reports)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculate Totals with Tax</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> and <strong>Total cost</strong> fields for a contract when the contract is created or updated.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ContractHistory</td>
<td>Contract [ast_contract]</td>
<td>Stores history when the start, end, or terms and conditions of a contract change.</td>
</tr>
<tr>
<td>Create Approval Record</td>
<td>Contract [ast_contract]</td>
<td>Updates contract <strong>Terms and Conditions</strong> and starts the contract approval workflow when a contract is sent for review.</td>
</tr>
<tr>
<td>Flag terms and conditions</td>
<td>Terms and Conditions [clm_m2m_contract_and_terms]</td>
<td>Sets the <strong>Use</strong> flag on a Terms and Conditions record to <strong>true</strong> after the record is associated with a contract or to <strong>false</strong> after the record is disassociated from a contract.</td>
</tr>
<tr>
<td>Install Count for manual licenses</td>
<td>Software License Instance [ast_license_software_instance]</td>
<td>Calculates and updates the number of computers a particular license is installed on when a software license instance is created or deleted.</td>
</tr>
<tr>
<td>Manage Contract Lifecycle</td>
<td>Contract [ast_contract]</td>
<td>This business rule:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updates the end date of a contract when a contract extension has been approved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Renews the contract, updating its start date, end date, and base cost (if cost adjustments need to be applied) when a contract renewal has been approved and the renewal has reached its start date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Runs the condition checks to evaluate if dates need to be changed when a contract is approved, or an extension or renewal is approved, or the start or end dates have changed.</td>
</tr>
<tr>
<td>Post Outage to News</td>
<td>Business Service [cmdb_ci_service]</td>
<td>Posts a news article on the knowledge table when there is an outage.</td>
</tr>
<tr>
<td>Update contract cost per asset</td>
<td>Asset Covered [clm_m2m_contract_asset]</td>
<td>Updates the cost per unit value based on the total cost and number of assets associated to the contract.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Contract Lifetime Cost</td>
<td>Contract Rate Card [fm_contract_rate_card]</td>
<td>Calculates the lifetime cost of the contract by calculating the sum of the contract expense lines.</td>
</tr>
<tr>
<td>Updates After Contract Dates Change</td>
<td>Contract [ast_contract]</td>
<td>Updates the Date added and Date removed fields for all assets and users associated with a contract if the contract end date changes.</td>
</tr>
<tr>
<td>Updates After Rate Card Dates Change</td>
<td>Contract Rate Card [fm_contract_rate_card]</td>
<td>Updates the related contract assets and users linked to the rate card when the end date is changed.</td>
</tr>
<tr>
<td>Verify contract’s start and end dates</td>
<td>Contract [ast_contract]</td>
<td>Validates contract start and end dates and contract renewal start and end dates.</td>
</tr>
<tr>
<td>Verify purchase agreement discount price</td>
<td>Contract [ast_contract]</td>
<td>For contracts with the contract model Purchase Agreement, the business rule validates that the Discount field does not contain a value less than zero or greater than 99.</td>
</tr>
</tbody>
</table>

**Contract Management use**

Users with the contract_manager role can use the Contract Management application to create various types of contracts, such as leases, warranties, maintenance, and service.

You can add additional information to contracts, such as the following.

- Assets covered by the contract
- Users covered by the contract
- Terms and conditions associated with the contract
- Other documents related to the contract

Track the various stages of a contract from draft to closure by viewing contract history and running reports. Adjust, extend, and renew active contracts.

**Contract life cycle**

From creation until closure, contracts follow a life cycle that determines which fields can be edited.

When a contract is in Draft state, almost all fields on the contract record can be edited. After a contract moves past the Draft state, certain date, renewal, extension, and financial fields become read-only. The State field and Substate field are always read-only.

A scheduled job named Contract Compliance Checks runs on the Contract [ast_contract] table automatically each night. For more information about the scheduled job, see Use Condition Check Definitions. The scheduled job performs the following actions.

- Changes the contract state to Active if the contract is approved and reaches the specified start date.
- Renews the contract if the contract is approved for renewal and reaches the specified start date.
- Changes the contract state to **Expired** if the contract state is **Active** and reaches the end date.

Expense lines are only generated from contracts that are active or expired.

### Table 83: Contract states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>User adds information about the contract and specifies an approver.</td>
</tr>
<tr>
<td>Active</td>
<td>Contract was approved and has reached the specified start date.</td>
</tr>
<tr>
<td>Expired</td>
<td>Contract reached the specified end date. Expired contracts with an active renewal workflow that are waiting for approval have a substate of <strong>Awaiting Review</strong>. Expired contracts with an active renewal workflow where the renewal was approved, but the renewal date has not yet passed, have a substate of <strong>Renewal Approved</strong>. Expired contracts with no active renewal or extension pending workflow have an empty substate.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Contract was discontinued and is no longer active.</td>
</tr>
</tbody>
</table>

In addition to a state, a contract can also have a substate.

### Table 84: Contract substates

<table>
<thead>
<tr>
<th>Substate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Awaiting Review</td>
<td>Contract is being prepared for review.</td>
</tr>
<tr>
<td>Under Review</td>
<td>Contract is sent to the approver and the approver is reviewing the contract.</td>
</tr>
<tr>
<td>Approved</td>
<td>Contract is reviewed and accepted by the approver.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Contract is reviewed and declined by the approver.</td>
</tr>
<tr>
<td>Renewal Approved</td>
<td>Contract renewal is approved by the approver.</td>
</tr>
<tr>
<td>Renewal Rejected</td>
<td>Contract renewal is rejected by the approver.</td>
</tr>
<tr>
<td>Extension Approved</td>
<td>Contract extension is approved by the approver.</td>
</tr>
<tr>
<td>Extension Rejected</td>
<td>Contract extension is rejected by the approver.</td>
</tr>
<tr>
<td>None</td>
<td>No substate is specified.</td>
</tr>
</tbody>
</table>
Contracts

A contract is a binding agreement between two parties.

In the ServiceNow platform, contracts contain detailed information such as contract number, start and end dates, active status, terms and conditions statements, documents, renewal information, and financial terms.

Working with contracts includes the following tasks and processes.

Create a contract

You can create a variety of contract models for leases, maintenance, or warranties.

Role required: contract_manager or admin

If a contract has one or more associated rate cards, the fields on the Contract form cannot be edited.

1. Navigate to Contract and select the type of contract, such as Insurance, Maintenance, or Service, or select All.
2. Click New.
3. Complete the form.

Not all fields appear on all contract type forms.

Table 85: Contract form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number identifying the contract record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor responsible for the contract. This field is mandatory when the contract model selected is NDA or Purchase Agreement.</td>
</tr>
<tr>
<td>Contract model</td>
<td>Model to which the contract is assigned. For example Lease, Maintenance, Warranty, or Service Contract.</td>
</tr>
<tr>
<td>Commitment</td>
<td>Amount committed to spend with this vendor during this time period, from the start to the end of the contract.</td>
</tr>
<tr>
<td>Discount</td>
<td>Discount the vendor has agreed to provide.</td>
</tr>
<tr>
<td>Contract number</td>
<td>Number assigned to the contract by the vendor.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the contract: Draft, Active, Expired, or Canceled.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the contract. For example, Awaiting Review, Under Review, Approved, or Rejected.</td>
</tr>
<tr>
<td>License quantity entitled</td>
<td>Number of licenses included in the contract. This field is available for Maintenance and Software License contracts.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the contract.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Starts</td>
<td>Date on which the contract takes effect. This field is mandatory if the contract model is <strong>Purchase Agreement</strong> or <strong>NDA</strong>.</td>
</tr>
<tr>
<td>Ends</td>
<td>Date on which the contract expires. Leave the end date blank to create an open-ended contract. This field is mandatory if the contract model is <strong>Purchase Agreement</strong> or <strong>NDA</strong>.</td>
</tr>
<tr>
<td>PO Number</td>
<td>Purchase order number assigned to the contract.</td>
</tr>
<tr>
<td>Vendor account</td>
<td>Vendor account associated with the contract.</td>
</tr>
<tr>
<td>License type</td>
<td>Type of license: <strong>Enterprise</strong>, <strong>SaaS</strong>, or <strong>Subscription</strong>. This field is available for <strong>Maintenance</strong> and <strong>Software License</strong> contracts.</td>
</tr>
<tr>
<td>Application model</td>
<td>Application model associated with the contract.</td>
</tr>
<tr>
<td>Location</td>
<td>Location covered by the contract.</td>
</tr>
<tr>
<td>Contract administrator</td>
<td>Individual who works for the vendor and is responsible for managing the contract.</td>
</tr>
<tr>
<td>Approver</td>
<td>User who approves or rejects the contract. List is filtered to only show users with the itil role.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the contract.</td>
</tr>
<tr>
<td>Renewal/Extension section</td>
<td></td>
</tr>
<tr>
<td>Automatically renew/extend</td>
<td>Indicates whether or not the contract can be renewed at the end of its term.</td>
</tr>
<tr>
<td>Options</td>
<td>Duration of the contract renewal or extension. For example, 1 year.</td>
</tr>
<tr>
<td>Renewal/Extension date</td>
<td>Date on which the contract renewal or extension takes effect.</td>
</tr>
<tr>
<td>Renewal/Extension end date</td>
<td>Date on which the contract renewal or extension ends.</td>
</tr>
<tr>
<td>Renewal/Extension contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Cost adjustment type</td>
<td>Type of cost adjustment applied to the contract: <strong>Fixed</strong>, <strong>Manual</strong>, or <strong>CPI</strong> (consumer price index).</td>
</tr>
<tr>
<td>Cost adjustment amount</td>
<td>Numerical increase or decrease in price of contract. To indicate a decrease in price, enter a negative number. Either a <strong>Cost adjustment</strong> or <strong>Cost adjustment percentage</strong> can be specified, but not both.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost adjustment percentage</td>
<td>Percentage increase or decrease in price of contract. To indicate a decrease in price, enter a negative percentage. Either a <strong>Cost adjustment or Cost adjustment percentage</strong> can be specified, but not both.</td>
</tr>
<tr>
<td>Financial section</td>
<td></td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center that is financially responsible for the asset.</td>
</tr>
<tr>
<td>Tax exempt</td>
<td>Indicates whether or not the contract is exempt from tax.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Indicates whether or not sales tax is applied to the total cost.</td>
</tr>
<tr>
<td>Effective tax rate</td>
<td>Effective tax rate to apply to the total cost, if applicable. Effective tax rate is usually the average tax rate charged.</td>
</tr>
<tr>
<td>Has rate card</td>
<td>Check box to indicate whether the contract has an associated rate card.</td>
</tr>
<tr>
<td>Invoice payment terms</td>
<td>Terms that explain how to pay the contract. For example, <strong>Net Monthly Account or Net 30</strong>.</td>
</tr>
<tr>
<td>Payment schedule</td>
<td>Schedule that defines when to make payments. For example, <strong>Monthly or Annually</strong>.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Amount which has been paid on the contract to date.</td>
</tr>
<tr>
<td>Tax cost</td>
<td>Total cost of the tax.</td>
</tr>
<tr>
<td>Total cost</td>
<td>Final cost of the contract after adjustments have been applied. If a contract has one or more rate cards, this field shows the combined value of all rate cards.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click *Save*.
5. Continue entering information in the additional sections and related lists that appear.

#### Table 86: Contract form fields and related lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terms and Conditions section</td>
<td></td>
</tr>
<tr>
<td>Terms and conditions</td>
<td>Specific legal information in the contract.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Assets Covered</td>
<td>Lists all assets covered by this contract.</td>
</tr>
<tr>
<td>Users Covered</td>
<td>Lists all users covered by this contract.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contract used by</td>
<td>Lists all configuration items (CI) used in this contract.</td>
</tr>
<tr>
<td>Terms and Conditions</td>
<td>Lists all terms and conditions of this contract.</td>
</tr>
<tr>
<td>Expense Lines</td>
<td>Lists all expense lines in this contract.</td>
</tr>
<tr>
<td>Contract History</td>
<td>Displays the changes to the start and end dates of this contract and changes to the terms and conditions.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Lists all service offerings from this vendor. This related list is available when Service Portfolio Management is activated.</td>
</tr>
<tr>
<td>Service Commitments for Contracts</td>
<td>Lists all service commitments for this vendor’s offerings. This related list is available when Service Portfolio Management is activated.</td>
</tr>
</tbody>
</table>

6. Perform one of the following actions.
   • Click **Update** to save and exit the contract.
   • Click **Submit for Review** to send notification to the approver.

Create a software maintenance contract example

One common use case for the Contract Management application is creating a contract to track maintenance payments for enterprise software. You can use this example to learn how to create a software maintenance contract.

Role required: contract_manager or admin

The goal of this example is to create a contract that shows the total amount of maintenance that must be paid for the software application, independent of different license purchases made over time. To use the steps below, the Software Asset Management plugin must be activated.

1. Create an **application model**, adding a **Name** and specifying **Software License** in **Model categories**.
2. Create a software model, adding a **Name** and **Model Number**, and selecting the application model created in step 1.
3. Follow the steps in **Add a new software license** on page 86 to create a new software license, selecting the software model created in step 2 and specifying an **Asset Tag**.
4. Navigate to **Contract Management > Contract > Maintenance**.
5. Click **New** and enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Type</td>
<td>Select <strong>Enterprise</strong>.</td>
</tr>
<tr>
<td>Application Model</td>
<td>Select the application model created in step 1.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Save**. A number of related lists and sections appear.
7. In the **Asset Covered** related list, click **New** and enter the following information.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Select the software license created in step 3.</td>
</tr>
<tr>
<td>Date added</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.
9. Continue completing the form with the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment schedule</td>
<td>Select <strong>Annually</strong>.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>

10. Complete the other fields as appropriate.
11. Click **Update**.
12. **Submit the contract for review**.

**Add an asset to a contract**
You can associate contracts with specific assets, including software licenses.

Role required: contract_manager or admin

Linking a contract with assets clarifies what the contract legally covers.

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. In the **Assets Covered** related list, click **New**.
4. In **Asset**, select a specific asset that is covered by the contract.
5. In **Date added**, select the date the asset was added to the contract. The date can be in the past, the present, or the future.
6. Optional: In **Date removed**, select the date the asset was, or will be, removed from the contract. Specifying **Date added** and **Date removed** is useful for reporting.
7. Click **Submit**.

**Add a user to a contract**
A contract can cover specific users. For example, you may use a contract to hire a group of temporary workers.

Role required: contract_manager or admin

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. In the **Users Covered** related list, click **New**.
4. In **User**, select a specific user covered by the contract.
5. In **Date added**, select the date the user was added to the contract. The date can be in the past, the present, or the future.
6. Optional: In **Date removed**, select the date the user was, or will be, removed from the contract. Specifying **Date added** and **Date removed** can be useful for reporting.
7. Click **Submit**.

**Add a configuration item to a contract**
Contracts can be associated with specific configuration items. You can link a contract with configuration items to clarify what the contract legally covers.
Role required: contract_manager or admin


2. Select a contract.

3. Optional: In the Contract used by related list, click New to create a new configuration item.

4. In the Contract used by related list, click Edit.

5. In the Collection configuration items list on the left, double-click a configuration item name.
   The item is added to the Contract used by List on the right.

6. Click Save.

Add a document to a contract

Contracts can be associated with documents. Linking a contract with related documents helps keep all relevant information about a contract together and easily accessible.

The Managed Documents plugin must be activated.

Role required: contract_manager or admin


2. Select a contract.

3. In the Documents related list, click Edit.
   All documents stored in the Managed Documents application appear in the Collection list. If the Collection list is long, create a filter of Type is Contract and click Run filter.

4. In the Collection list, double-click a document.
   The item is added to the Documents List.

5. Click Save.

Adjust a contract

After creating a contract, you can adjust it as necessary.

Role required: contract_manager or admin

For example, you may need to change the start date, end date, or payment amount for a contract. If a contract has a rate card, the rate card start date, end date, and base cost can also be adjusted. To adjust a contract, the State should be Active. If the end date of a contract rate card changes, the end date of any associated assets changes to match.


2. Select a contract in Active state.

3. Click Adjust.
4. Double-click in any field to edit information.

### Table 87: Adjust contract values

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Start Date</td>
<td>Date on which the contract takes effect.</td>
</tr>
<tr>
<td>Contract End Date</td>
<td>Date on which the contract expires.</td>
</tr>
<tr>
<td>Contract Payment Amount</td>
<td>Total amount paid for the contract. If the contract has one or more rate cards, this field shows the total of all rate card base costs.</td>
</tr>
<tr>
<td>Rate Card Name</td>
<td>Name of the rate card.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date on which the rate card values take effect.</td>
</tr>
<tr>
<td>End date</td>
<td>Date on which the rate card values expire.</td>
</tr>
<tr>
<td>Base cost</td>
<td>Amount that must be paid before taxes.</td>
</tr>
</tbody>
</table>

5. Click **Apply changes to contract and rate cards**.

**Renew a contract**

After creating a contract, you can renew it, if necessary.

Role required: contract_manager or admin

Contract information and history is retained when a contract is renewed. If the end date of the contract changes, the end date of any associated assets changes to match. You can renew a contract that meets the following conditions.

- **State** is **Active** or **Expired**
- **Substate** is **None** or **Rejected**

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract in **Active** or **Expired** state.
3. Click **Renew**.
4. Complete the form.

### Table 88: Contract renewal fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renewal Contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Renewal Start Date</td>
<td>Date on which the renewed contract takes effect.</td>
</tr>
<tr>
<td>Renewal Option</td>
<td>Length of time for the renewal, in years.</td>
</tr>
<tr>
<td>Renewal End Date</td>
<td>Date on which the renewed contract expires.</td>
</tr>
<tr>
<td>Cost Adjustment Type</td>
<td>Type of cost adjustment applied to the renewed contract: <strong>None</strong>, <strong>Fixed</strong>, <strong>Manual</strong>, or <strong>CPI</strong>.</td>
</tr>
</tbody>
</table>
5. Perform one of the following steps.
   - To save all entered data and change the substate to Under Review, click Submit for Review. The contract is sent to the specified Approver.
   - To save all entered data and change the substate to Awaiting Review, click Save But Do Not Submit. The Renew button is available to submit the renewed contract for review at a later time.

6. Change any information on the Contract form, as necessary.
7. Click Update.

If you selected the Save But Do Not Submit option, ensure that you click Renew when you are ready to submit the contract renewal for approval.

Extend a contract
After creating a contract, you can extend it, if necessary. Extending the end date retains contract information and history.

Role required: contract_manager or admin

When you extend a contract, the end date of any associated assets changes to match the new contract end date. All other contract dates, including notification dates, are recalculated automatically based on the new end date. You can extend a contract that meets the following conditions.

- State must be Active or Expired
- Substate must be None or Rejected

2. Select a contract in Active or Expired state.
3. Click Extend.
4. Select an option from Extension Option or enter an Extension End Date.
5. Complete the form.

Table 89: Extend the contract

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension Contact</td>
<td>Individual who works for the vendor and is responsible for extending the contract.</td>
</tr>
<tr>
<td>Extension Option</td>
<td>Length of time for the extension, in years.</td>
</tr>
</tbody>
</table>
### Table: Contract Extension Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension End Date</td>
<td>Date on which the extended contract expires.</td>
</tr>
<tr>
<td>Cost Adjustment Type</td>
<td>Type of cost adjustment to apply to the extended contract: <strong>None, Fixed, Manual, or CPI</strong>.</td>
</tr>
<tr>
<td>Approver</td>
<td>User with the contract_manager role who approves or rejects the contract extension.</td>
</tr>
<tr>
<td>Cost Adjustment</td>
<td>Numerical increase or decrease in price of the extended contract. To indicate a decrease in price, enter a negative number. <strong>A Cost Adjustment or Cost Adjustment Percentage</strong> can be specified, but not both.</td>
</tr>
<tr>
<td>Cost Adjustment Percentage</td>
<td>Percentage increase or decrease in price of the extended contract. To indicate a decrease in price, enter a negative percentage. <strong>A Cost Adjustment or Cost Adjustment Percentage</strong> can be specified, but not both.</td>
</tr>
</tbody>
</table>

6. Perform one of the following tasks.
   - To save all entered data and change the substate to **Under Review**, click **Submit For Review**. The contract can be sent to the specified **Approver**.
   - To save all entered data and change the substate to **Awaiting Review**, click **Save But Do Not Submit**. The **Extend** button is available to submit the extended contract for review at a later time.

**Cancel a contract**

You can cancel a contract when the **State** is **Active**.

Role required: contract_manager or admin

After a contract is canceled, the following process occurs.

- The contract **State** changes to **Canceled**
- Condition checkers are changed to inactive.
- **Renew** and **Extend** buttons become inactive.
- Contract rate cards become inactive.

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. Click **Cancel Contract**.
4. Click **Yes** to confirm contract cancellation.

**Verify contract administrator assignment for notification**

An event runs automatically each night to send reminders to contract administrators about contract expiration dates so they can renew or renegotiate the contract. You can verify that the right contract administrator is assigned to the contract.

Role required: contract_manager or admin
When the contract.expiration event runs on the Contract [ast.contract] table each night, an email message is sent to the person identified as the contract administrator. This occurs at the following times.

- 90 days ahead of the contract expiration date
- 60 days ahead of the contract expiration date
- 30 days ahead of the contract expiration date
- On the contract expiration date

A user with the admin role can edit the contract.expiration condition check that processes contract notifications. Follow the procedure below to verify that the right contract administrator is assigned to the contract.

2. Select a contract.
3. Check that the Contract administrator field contains the correct name. A single name can be specified.

Send the contract for approval

You can send a contract that is in Draft state for approval.

Role required: contract_manager or admin

2. Select a contract in Draft state.
3. Select an Approver for the contract.
4. Click Submit For Review.
   An email message is sent to the selected approver and the contract Substate changes to Under Review.

Approve or reject a contract

You can approve or reject a contract if you are the contract manager.

Role required: contract_manager or admin

2. Select a contract in Requested state.
3. Perform one of the following tasks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve the contract</td>
<td>Click Approve. The contract Substate changes to Approved.</td>
</tr>
<tr>
<td>Reject the contract</td>
<td>Click Reject and enter a rejection reason in the Comments field. The contract Substate changes to Rejected</td>
</tr>
</tbody>
</table>

4. Click Update.
   - A contract with a State of Draft and a Start Date set in the future is kept in Draft until the start date is reached. If the contract has a Substate of Approved, the system changes the State to Active and removes the Substate value.
   - When a contract with a State of Draft and a Start Date set to a date in the past is approved, the contract State is automatically set to Active and Substate is left blank.
Show approval history on contracts
You can set a workflow property to ensure that approval history is saved to the contract approval history journal.

Role required: workflow_admin or admin
After a contract is sent to an approver for review, the approver name cannot be changed. If a contract is rejected by the approver, the same approver or a different approver can be specified before the contract is sent for approval again. Set the following system property so this activity is recorded in the approval history journal.

1. Navigate to Workflow > Administration > Properties.
2. Select the Yes check box for the Log User approval activity - such as requested, approved and rejected - in the Approval History journal when using workflows to manage the approvals for a task property.
3. Click Save.

Terms and conditions
You can add terms and conditions to a contract to keep all documentation that is relevant to a contract in one location.

The terms and conditions can be searched and used in reports. If multiple terms and conditions records are added to a single contract, set an order for the records so they appear in a specific sequence. The terms and conditions fields become read-only after a contract is sent for approval.

Users with the contract_manager role can read contract history and add terms and conditions.

There are three procedures involved in adding terms and conditions to a contract, as follows.

• Create a terms and conditions record.
• Add the record to a contract.
• Build a terms and conditions document for the contract.

Add terms and conditions to a contract
After you create a terms and conditions record, add the record to a contract.

Role required: contract_manager or admin

2. Select a contract.
3. In the Terms and Conditions section, double-click Insert a new row.
4. Click the reference lookup icon and select a terms and conditions record from the list.
5. Optional: Enter a number in Order to specify the sequence in which the record should appear in the terms and condition document.

Note: If you attempt to enter a duplicate terms and conditions record for a contract and save the record, an error message appears and the new duplicate record is not added.

Create a terms and conditions record
You can create a terms and conditions record to add to a contract.

Role required: contract_manager or admin

2. Click New.
3. Enter a Name.
4. In Description, enter the text or copy and paste text from an existing file.
5. Optional: Format the text using the HTML formatting bar.
6. Click Submit.

Build a terms and conditions document within a contract
After adding one or more terms and conditions records to a contract, you can build a terms and conditions document within the contract.

Role required: contract_manager or admin

The terms and conditions records are added in the sequence specified in the Order field.

2. Select a contract.
3. Ensure that one or more terms and conditions records have been added to the Terms and Conditions section.
4. In Related Links, click Build Terms and Conditions.
   All records from the Terms and Conditions related list are added to the Terms and Conditions section of the contract record.

Figure 30: Build terms and conditions controls

5. Click Update.
Create a contract rate card

You can create rate cards to track contract expenses. Rate cards help to record and allocate costs.

You must activate Cost Management plugin to use rate cards.

Role required: financial_mgmt_user, asset, or contract_manager

A contract rate card provides detailed price information for a contract and enables you to generate expense lines for recurring expenses automatically. There can be multiple rate cards for the same contract.

Consider the following case: an organization has a contract with a third-party company, which oversees technical operations in the organization’s datacenters. The contract costs to use a specific server model in the New York datacenter are different from using the same server model in the London datacenter. There are two rate cards to detail these costs separately.

2. Select a contract.
3. In the Contract Rate Cards related list, click New.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The contract rate card number.</td>
</tr>
<tr>
<td>Contract</td>
<td>The internal contract number.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The contract rate card type. Categorizing rate cards can be useful for reporting. Select <strong>Grow Business</strong>, <strong>Run Business</strong>, or <strong>Transform Business</strong>.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the contract rate card.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the rate card is available for use.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the contract rate card.</td>
</tr>
<tr>
<td>Start date</td>
<td>The date on which the contract rate card becomes active. Expense lines are generated for costs incurred beginning on the date specified. For financial calculations to work, the date cannot be before the start date of the contract.</td>
</tr>
<tr>
<td>End date</td>
<td>The date on which the contract rate card becomes inactive. No expense lines are generated for costs incurred after the end date. For financial calculations to work, the date cannot be after the end date of the contract. The date is automatically set to the end date of the contract if no value is entered and the contract has an end date.</td>
</tr>
<tr>
<td>Interval</td>
<td>The amount of time between rate card charges. For example, <strong>Monthly</strong>, <strong>Quarterly</strong>, or <strong>Annually</strong>.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the rate card.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last processed</td>
<td>The most recent date on which the rate card was charged.</td>
</tr>
<tr>
<td>Next process</td>
<td>The next date on which the rate card will be charged.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed information about the rate card.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Check box that indicates whether to apply sales tax to the total cost.</td>
</tr>
<tr>
<td>Tax rate</td>
<td>The effective tax rate to apply to the total cost. Tax rate is usually the average tax rate charged.</td>
</tr>
<tr>
<td>Distribute cost</td>
<td>The method for distributing the amount listed in Base cost and generating expense lines.</td>
</tr>
<tr>
<td>Value</td>
<td>Type of value to use when Allocate and distribute cost based on value is selected in the Distribute cost field.</td>
</tr>
<tr>
<td>Base cost</td>
<td>The amount that must be paid before taxes.</td>
</tr>
<tr>
<td>Tax cost</td>
<td>The total cost of the tax.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The final cost of the rate card after adjustments, such as taxes, have been applied.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create a new expense line
Typically, expense lines are automatically generated based on assets or users, but you can create a new expense line manually if needed.

Role required: asset or contract_manager

2. Select a contract.
3. In the Expense Lines related list, click New.
4. Complete the form.

Table 90: Expense line table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the expense line.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the expense line was created.</td>
</tr>
<tr>
<td>Rate Card</td>
<td>The identification number of the rate card to which the expense line is associated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source ID</td>
<td>The identification number of the item associated with the expense line. If this field is filled in, corresponding information is automatically added to the Source fields on this form.</td>
</tr>
<tr>
<td>Amount</td>
<td>The monetary value of the item specified in the Source ID field. Enter a negative value to indicate a credit.</td>
</tr>
<tr>
<td>Process date</td>
<td>The date the expense line is processed.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense line is located on another expense line.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the expense line, either Pending or Processed.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense line category: Grow Business, Run Business, or Transform Business. Categorizing expense lines can be useful for reporting.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the expense line.</td>
</tr>
<tr>
<td>Asset</td>
<td>The identification number of the asset associated with the expense line, if any.</td>
</tr>
<tr>
<td>Fixed asset</td>
<td>Fixed asset that contains the asset in this expense line. A fixed asset is a container that holds one or more individual assets, including hardware or software assets. The system auto-populates this field with the appropriate fixed asset if the named Asset is contained within that fixed asset.</td>
</tr>
<tr>
<td>Contract</td>
<td>The identification number (not the contract number) of the contract associated with the Asset, if any.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user associated with the Asset, if any.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The name of the configuration item associated with the expense line, if any.</td>
</tr>
<tr>
<td>Task</td>
<td>The identification number of the task associated with the expense line, if any.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the item identified in Source ID, if any.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Generating expense lines based on assets or users
An expense line is an expense amount at a given point in time and the record that incurred or generated the expense. You can generate expense lines based on assets or users assigned to the contract.

Role required: financial_mgmt_user, asset, or contract_manager
Generating expense lines is a three-step procedure.

Add a user or asset to a contract
You can add a user or asset to a contract to generate expense lines.
Role required: financial_mgmt_user, asset, or contract_manager
1. Navigate to **Contract Management > Contract > All**.
2. Create a new contract or select an existing contract.
3. In the **Assets Covered** or **Users Covered** related list, click **New**.
4. Specify an **Asset** or **User**.
5. Specify a **Date Added**.
6. Click **Submit**.
7. Optional: Repeat the previous steps to add more assets or users to the contract.

Create a rate card and assign a user or asset
You can assign a user or asset when you create a rate card. You can only assign the user or asset that is assigned to the contract.
Role required: financial_mgmt_user, asset, or contract_manager
1. Navigate to **Contract Management > Contract > All**.
2. Select a contract with an assigned user or asset.
3. In the **Contract Rate Cards** related list, click **New**.
4. Specify a **Start date**.
   For financial calculations to work, the date cannot be before the start date of the contract.
5. Right-click the header bar and select **Save**.
6. In the **Asset Covered** or **Rate Card Users** related list, click **New**.
7. Select the **Asset** or **User** who is assigned to the contract.
   Only assets and users associated with the parent contract are listed.
8. Specify a **Date Added**.
9. Click **Submit**.

Configure rate card expense generation
After assets or users are added to the rate card, you can use the **Distribute cost** field in the Financial section of the contract to generate rate card expenses.
Role required: financial_mgmt_user, asset, or contract_manager
1. Navigate to **Contract Management > Contract > All**.
2. Select the contract to generate expenses.
3. In the **Contract Rate Card** related list, select a rate card.
4. In **Distribute cost**, select one of the following options to distribute the amount listed in **Base cost**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split expense lines evenly across assets</td>
<td>Select Allocate and distribute cost per asset. For example, with a $100 Base cost and two assets, two expense lines for $50 are created.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Split expense lines across assets based on | Select *Allocate and distribute cost based on value*:  
The Value field displays with Cost and Residual Cost options. The cost is derived from the Cost or Residual Cost field on an asset record. If there are multiple assets on the rate card, the cost or residual cost is distributed based on the value of the assets.  
For example, if you select the Cost option with a $100.00 Base cost, one asset worth $70, and one asset worth $30, two expense lines are created, one for $70 and one for $30. |
| asset value                                |                                                                                                                                                                                                            |
| Split expense lines evenly across users    | Select *Allocate and distribute cost per user*.  
For example, with a $100 Base cost and two users on the contract, two expense lines for $50 are created.                                                                                                      |
| Allocate the cost to the contract instead  | Select *Allocate cost to contract*.                                                                                                                                                                         |
| of the individual assets                    |                                                                                                                                                                                                            |

5. Click **Update**.

Expense lines are automatically generated by a scheduled job for costs incurred between the rate card **Start date** and **End date**. The scheduled job, Process FM Costs, runs on the Contract [ast_contract] table once per day. Expense lines are only generated from contracts with the **Active** or **Expired** state. You may want to generate expense lines for expired contracts to track previous expenses.

**View contract expense lines**
You can view and audit all the expenses recorded for a given contract in the **Expense Lines** related list on a contract record.

Role required: financial_mgmt_user, asset, or contract_manager

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. Select the **Expense Lines** related list.
4. Select an expense line record to view.

Information such as expense line details, total cost of the contract, and the contract current value is listed.

**Monitor a contract**
You can monitor contracts by viewing contract history and creating contract reports.

Role required: asset or contract_manager

If changes are made to a contract start date, end date, or terms and conditions, a copy of the contract is automatically saved and placed in contract history. This is useful for tracking changes to a contract and keeping an audit trail. Configure the **Contract History** related list to include columns for creation and update so you can easily see who edited the contract.

1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. View the **Contract History** related list and perform one of the following actions.
• If earlier versions of the contract exist, click a date in the **Contract Starts** column to view a version.
• If an earlier version of the contract does not exist, change the contract's **Start date** or **End date**. Right-click in the header bar and select **Save**. In the **Contract History** related list, click a date in the **Contract Starts** column to view the earlier version.

**Run contract reports**
A variety of contract reports are available to help track and manage contracts.

1. Navigate to **Reports > View / Run**.
2. Select one of the following reports to run.

**Table 91: Contract reports**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Contracts by Cost Per Unit</td>
<td>All active contracts grouped in ascending order by average cost per unit.</td>
</tr>
<tr>
<td>Active Contracts by Lifetime Cost</td>
<td>All active contracts with an associated rate card grouped in ascending order by total cost. Total cost is measured from the beginning of the contract to the report run date.</td>
</tr>
<tr>
<td>Active Contracts by Monthly Cost</td>
<td>All active contracts grouped in ascending order by cost per month.</td>
</tr>
<tr>
<td>Active Contracts by Vendor</td>
<td>All active contracts alphabetically by vendor.</td>
</tr>
<tr>
<td>Active Contracts by Yearly Cost</td>
<td>All active contracts grouped in ascending order by cost per year.</td>
</tr>
<tr>
<td>All Contracts by State</td>
<td>Contracts grouped by state, such as <strong>Draft</strong>, <strong>Active</strong>, or <strong>Expired</strong>, in bar chart format</td>
</tr>
<tr>
<td>Asset Contracts by Type</td>
<td>All active contracts for assets grouped by type, in pie chart format.</td>
</tr>
<tr>
<td>Asset Contracts List</td>
<td>All active contracts for assets by contract number.</td>
</tr>
<tr>
<td>Contract Expenditure by Type</td>
<td>Total contract expenses by type, such as lease, maintenance, or warranty, in bar chart format.</td>
</tr>
<tr>
<td>Contract Expenditure by Vendor</td>
<td>Total costs of all contracts associated with a specific vendor, in bar chart format.</td>
</tr>
<tr>
<td>Contract Pipeline Report</td>
<td>All contracts with a state of <strong>Draft</strong>, <strong>Active</strong>, or <strong>Expired</strong> and a substate of <strong>Awaiting Review</strong> or <strong>Under Review</strong>, in bar chart format.</td>
</tr>
<tr>
<td>Expiring Contracts</td>
<td>All contracts expiring in the next 90 days.</td>
</tr>
</tbody>
</table>
Condition check definitions

Condition check definitions enable you to define logical conditions that indicate when to change a specific field value in a record.

A scheduled job, called Contract Compliance Checks, evaluates these condition check definitions nightly by running the condition checker. Use this condition checker to check start dates and end dates and to set expiration levels for contracts.

For example, a contract has a start date of March 1st. When the condition checker runs on March 1st, it verifies that the contract Substate is Approved and sets the contract State to Active based on the Start Date field.

The nightly condition checker sets the appropriate expiration level for active contracts based on the contract End Date. The expiration level can be viewed in the Contracts list. Knowing the expiration level can help contract managers renew or extend a contract before it expires.

Define a condition check

You can define a condition check to change values in a contract when the Contract Compliance Checks scheduled job runs each night.

Role required:

1. Navigate to Contract > Administration > Condition Check Definitions.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table to which the condition applies. For a contract check definition, select Contract [ast.contract].</td>
</tr>
<tr>
<td>Category</td>
<td>The category for the condition check. Select Contract or None. The category is used for organizing information and reporting.</td>
</tr>
<tr>
<td>Condition field</td>
<td>The field to be updated, typically Expiration level or State.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name for the event to be fired when this condition changes the value of the field. Create a name using this syntax: &lt;table_name&gt;.&lt;condition_field&gt;, for example, contract.validation.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated.</td>
</tr>
</tbody>
</table>

4. Right-click the header bar and click Save. The Conditions related list appears.
5. In the Conditions related list, click New.
6. Complete the form.
### Table 93: Conditions fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The value the field is set to, if the expiration conditions are met.</td>
</tr>
<tr>
<td>Condition check</td>
<td>The associated condition check.</td>
</tr>
<tr>
<td>Table</td>
<td>The table associated with the condition check.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name of the event this condition triggers.</td>
</tr>
<tr>
<td>Expiration Condition</td>
<td>The condition that must be true for the <strong>Condition check</strong> field to be set to this value (the <strong>Name</strong>). Add as many conditions as are needed.</td>
</tr>
<tr>
<td>Compliant state</td>
<td>System field. Do not use.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated. The first condition that is found to match, where the Expiration Condition is true, is used, and no others are checked.</td>
</tr>
</tbody>
</table>

7. **Click Submit.**
   The Condition Checks form reopens with the new condition listed in the related list.

8. Optional: Continue adding conditions as needed, following the steps above.

### Expense Line

Expense lines enable you to track costs and represent a point-in-time expense incurred. Expense lines can be created manually or generated by the scheduled processing of recurring costs.

The ServiceNow platform generates expense lines automatically when you create an asset, and updates expense lines automatically when you revise the **Cost** or **Quantity** field on an asset record.

Expense lines integrate closely with asset management, CMDB, cost management, and contract management, but can be used with any application. The **Source ID** field on an expense line record can be linked to any record in any table, so expenses can be associated with a wide variety of items, such as a contract, an individual asset, a single configuration item, a software installation, a lease, a service contract, a user, or a group.

Users with the financial_mgmt_admin and financial_mgmt_user roles can work with expense lines.
Activating expense allocations

To use the Expense Allocations and Expense Allocation Rules modules, activate the IT Cost Management plugin.

View an expense

Expense lines can be used in a variety of ways. In this example, you see how to view expenses that are associated with a given contract.

Role required: asset or contract_manager

2. Select a contract.
3. View the Expense Lines related list.
   All of the expense lines for the contract are listed. The total cost of the contract and its current value are also shown.
### Expense Lines

<table>
<thead>
<tr>
<th>Expense Lines</th>
<th>Number</th>
<th>Date</th>
<th>Short description</th>
<th>Rate Card</th>
<th>Amount</th>
<th>Type</th>
<th>Summary type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EXP0010003</td>
<td>2013-01-17</td>
<td>Service Rate Card</td>
<td>Contract: CNTR0008004</td>
<td>$50,000.00</td>
<td>One-time</td>
<td>Run Business</td>
</tr>
<tr>
<td></td>
<td>EXP0010004</td>
<td>2013-01-17</td>
<td>Maintenance</td>
<td>Contract: CNTR0008004</td>
<td>$2,000.00</td>
<td>One-time</td>
<td>Run Business</td>
</tr>
<tr>
<td></td>
<td>EXP0010003</td>
<td>2013-01-17</td>
<td>Janitorial</td>
<td>Contract: CNTR0008004</td>
<td>$1,000.00</td>
<td>One-time</td>
<td>Run Business</td>
</tr>
</tbody>
</table>

**Total:** $53,000.00

---

**Related Links**

- Build Terms and Conditions
- Expense Lines Related List

---

**General**

- **Starts:** 2011-11-19
- **Ends:** 2014-11-19
- **PO Number:**
- **Vendor account:**
- **Contract number:**
- **Contract administrator:**
- **Contract number:**
- **Contract administrator:**

---

**Update**

- Adjust
- Cancel Contract
- Extend
- Renew
- Delete
Installed with Expense Line

Various components, such as tables, script includes, and client scripts, are installed with Expense Line.

Demo data is available with Expense Lines. The demo data provides expense lines with associated source IDs, costs, processing dates, and states.

### Tables

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense Line [fm_expense_line]</td>
<td>Stores information about expense lines, including a link to the associated rate card. Contains the status and next scheduled processing date for the expense line.</td>
</tr>
</tbody>
</table>

### Script includes

<table>
<thead>
<tr>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExpenseLine</td>
<td>Helps create new expense line records.</td>
</tr>
<tr>
<td>ExpenseManagementUtils</td>
<td>Provides utilities for financial management modules.</td>
</tr>
<tr>
<td>ExpenseManagementUtilsAJAX</td>
<td>Provides AJAX utilities for expense lines.</td>
</tr>
</tbody>
</table>

### Client scripts

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Populate sources if inherited [fm_expense_line]</td>
<td>Copies the source fields of the parent expense line to the current line on the Expense Line record if an expense line is inherited.</td>
</tr>
<tr>
<td>Populate source fields from asset [fm_expense_line]</td>
<td>Updates related source fields on the Expense Line record if the source asset changes. For example, if the asset source field changes, the configuration item source field is updated, as well.</td>
</tr>
<tr>
<td>Populate source fields from ci [fm_expense_line]</td>
<td>Updates related source fields if the source configuration item changes on the Expense Line record.</td>
</tr>
<tr>
<td>Populate source fields from contract [fm_expense_line]</td>
<td>Updates related source fields if the source contract changes on the Expense Line record.</td>
</tr>
<tr>
<td>Populate source fields from task [fm_expense_line]</td>
<td>Updates related source fields if the source task changes on the Expense Line record.</td>
</tr>
</tbody>
</table>
## UI policies

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide cost source if empty [fm_expense_line]</td>
<td>Hides cost source if there are no keywords.</td>
</tr>
<tr>
<td>Make sources read only if inherited [fm_expense_line]</td>
<td>Makes any sources (asset, user, task, cost_center, ci, source_id, or contract) on an inherited expense line read-only.</td>
</tr>
<tr>
<td>Hide parent if not inherited [fm_expense_line]</td>
<td>Hides the parent field if the expense line is not inherited.</td>
</tr>
</tbody>
</table>

## Business rules

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Expense Line [alm_asset]</td>
<td>Automatically creates an expense line for a new asset based on asset cost unless the asset is a merged software license.</td>
</tr>
<tr>
<td>Set source allocation fields [fm_expense_line]</td>
<td>Sets the related source fields when the source ID changes. For example, when an asset becomes the source ID, the asset source field and configuration item source field are automatically populated.</td>
</tr>
<tr>
<td>Source ID check [fm_expense_line]</td>
<td>Determines whether a source ID is provided.</td>
</tr>
<tr>
<td>Update Costs [alm_consumable]</td>
<td>Updates a consumable’s cost when quantity is reduced.</td>
</tr>
</tbody>
</table>

## User roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Admin (financial_mgmt_admin)</td>
<td>Financial User</td>
<td>Can create, write, and delete allocation units, fixed assets, depreciation, rate cards, distribution costs, expense lines, and expense allocations.</td>
</tr>
<tr>
<td>Financial User (financial_mgmt_user)</td>
<td>none</td>
<td>Can read allocation units and expense allocations. Can create, read, write rate cards, and expense lines. Can create, read, write, and delete fixed assets, depreciation, distribution costs.</td>
</tr>
</tbody>
</table>
Expense Lines and expense allocations

The Expense lines application tracks costs and record expenses that are incurred.

Create expense lines manually or view expense lines generated automatically when costs are created by scheduled processing. Use expense allocation rules to associate expenses with items such as users, groups, or departments.

Expense lines are a key component of IT cost management because they can be generated from any application and are used to allocate expenses to business entities.

Users with the Financial Admin (financial_mgmt_admin) and Financial User (financial_mgmt_user) roles can use expense lines and expense allocation rules.

To use expense allocation rules, activate the Cost Management application.

Create an allocation rule

Expense allocation rules enable you to associate expenses with an item, such as a user, group, or department.

To use expense allocation rules, activate the Cost Management application.

Role required: admin, financial_mgmt_admin, or financial_mgmt_user

1. Navigate to Cost > Administration > Expense Allocation Rules.
2. Click New.
3. Complete the form.

Table 94: Allocation rule table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The allocation rule name.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to which the allocation rule is associated.</td>
</tr>
<tr>
<td>Allocation field</td>
<td>The field on the Table to populate with the expense allocation.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense allocation is inherited.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the expense allocation is available to use.</td>
</tr>
<tr>
<td>Percentage</td>
<td>The percentage of the expense line allocated to the table and field combination. Not available if the Advanced check box is selected.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense allocation category: Grow Business, Run Business, or Transform Business. Categorizing expense allocations can be useful for reporting.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions under which the expense allocation is applied. Not available if the Advanced check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box that indicates whether to display the <strong>Script</strong> field.</td>
</tr>
<tr>
<td>Script</td>
<td>The script field that determines expense allocations. This field is only available if the <strong>Advanced</strong> check box is selected.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Automatic expense line creation**

You can automatically create expense lines.

The following processes generate expense lines automatically if enabled:

- Active CI rate cards are processed monthly to generate expense lines for each CI in the rate card. If a CI relationship is changed, existing expense lines are not affected. Changes are reflected in the next scheduled expense line.
- Active distribution costs are processed monthly to generate expense lines based on distribution rule targets.
- Closed tasks on task rate cards are processed to generate expense lines.

Expense lines can also be imported from external systems or generated from scripts. To generate an expense from a server-side script use the ExpenseLine API.

**Create expense lines manually**

You can create expense lines at a single level or multiple levels.

Role required: admin, financial_mgmt_admin, or financial_mgmt_user

Create expense lines at a single level or multiple levels. Adding an expense line under another expense line to create a hierarchy is just another way to organize information. Use a hierarchy if it makes sense for your organization. In the example, the last two expense lines are a level under expense line number EXP0010001.
Figure 32: Expense lines inherited

1. Navigate to Costs > Expense Lines.
2. Open an expense line record, or click New to create a new expense line.
3. Fill in the fields, as appropriate.

Table 95: Expense line table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the expense line.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the expense line was created.</td>
</tr>
<tr>
<td>Rate Card</td>
<td>The identification number of the rate card to which the expense line is associated.</td>
</tr>
<tr>
<td>Source ID</td>
<td>The identification number of the item associated with the expense line. If this field is filled in, corresponding information is automatically added to the Source fields on this form.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Amount</td>
<td>The monetary value of the item specified in the <strong>Source ID</strong> field. Enter a negative value to indicate a credit.</td>
</tr>
<tr>
<td>Process date</td>
<td>The date the expense line is processed.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense line is located on another expense line.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the expense line, either <strong>Pending</strong> or <strong>Processed</strong>.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense line category: <strong>Grow Business</strong>, <strong>Run Business</strong>, or <strong>Transform Business</strong>. Categorizing expense lines can be useful for reporting.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the expense line.</td>
</tr>
<tr>
<td>Asset</td>
<td>The identification number of the asset associated with the expense line, if any.</td>
</tr>
<tr>
<td>Fixed asset</td>
<td><strong>Fixed asset</strong> that contains the asset in this expense line. A fixed asset is a container that holds one or more individual assets, including hardware or software assets. The system auto-populates this field with the appropriate fixed asset if the named Asset is contained within that fixed asset.</td>
</tr>
<tr>
<td>Contract</td>
<td>The identification number (not the contract number) of the contract associated with the Asset, if any.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user associated with the Asset, if any.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The name of the configuration item associated with the expense line, if any.</td>
</tr>
<tr>
<td>Task</td>
<td>The identification number of the task associated with the expense line, if any.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the item identified in <strong>Source ID</strong>, if any.</td>
</tr>
</tbody>
</table>

**Delete an expense line**

Deleting an expense line also deletes all expense allocations generated from the expense line.

**Role required: admin or financial_mgmt_admin**

Deleting expense lines and allocations should be limited to an emergency case only when they were created incorrectly.

1. Navigate to **Costs > Expense Lines**.
2. Select an expense line.
3. Click Delete.
4. In the confirmation message, click OK.

Sample allocation rule

You can create a sample expense allocation rule that allocates the cost of an incident to the department of the caller.

Role required: admin, financial_mgmt_admin, or financial_mgmt_user

To use expense allocation rules, activate the Cost Management application.
1. Costs > Administration > Expense Allocation Rules
2. Click New.
3. In Name, enter Incident Caller Department.
4. In Table, select Incident.
5. In Allocation field, click the control, expand the Caller element, and select a department.
6. In Percentage, enter 100 to allocate all of the expense to the caller's department.
7. Select the Active check box.
8. Click Submit.

After an incident expense line is created, the allocation rule processes the expense line and generates an expense allocation linking the expense and amount to the caller’s department. The expense is stored in the Target field on the Expense Allocation record.

Use a scripted allocation

Scripted allocations define custom allocation amounts and targets by executing a script.

Role required: admin, financial_mgmt_admin, or financial_mgmt_user

You can use scripted allocations to perform any of the following actions.
• Allocate an expense to all cost centers based on the current head count in the cost center.
• Query usage data to determine the allocation amount to assign to a target.
• Track the business users that are consuming business services.

1. Navigate to Costs > Administration > Expense Allocation Rules.
2. Select an expense allocation rule.
3. Select the Advanced check box.
4. Use the following concepts to build the script
   • Query for target records and data to use for calculating the allocation amount.
   • Create allocation records using the ExpenseAllocation API.

The following variables are available during the script processing:
• allocation: expense allocation object used to create new allocations (see ExpenseAllocation API).
• expense: GlideRecord for the expense_line that is being processed.
• rule: GlideRecord for this rule.

To create an allocation record, use the allocation object already instantiated in the script scope:

```java
allocation.createAllocation(targetGlideRecord, amount);
```
Incident Alert Management

Incident Alert Management enables organizations to create and manage communications related to major business issues or incidents.

This allows incident alert administrators to bring together all involved users during these events and establish quick and easy communication within this group.

For example, a major issue occurs in an organization’s server room, leading to a high-priority incident being raised. The incident could potentially impact all users, so it is important to bring together key representatives and communicate quickly and effectively. An incident alert can facilitate this communication process and help resolve the source incident.

Incident Alert Management features

You can use the Incident Alert Management application to:

• Create an incident alert when a crisis occurs.
• Set up contact responsibilities to identify the individuals who receive automatic notifications when incident alerts are created. Self-service users can subscribe to incident alerts if they want to receive notifications.
• Manage incident alerts to improve communication while dealing with the crisis.
• Use the optional Notify feature to send notifications by SMS messages and voicemails, and to set up conference calls.
• Monitor events and results with the incident alert dashboard and reports.

Activate Incident Alert Management

Administrators can activate the Incident Alert Management plugin.

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

Installed with incident alert management

Incident alert management installs the following components.

Activating the Incident Alert Management plugin adds or modifies tables, user roles, script includes, and other components.

Demo data is included with incident alert management.
Tables

Incident alert management adds or modifies the following tables.

Table 96: Incident Alert Management tables

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted CI [impacted_ci]</td>
<td>The CIs which have been impacted by the incident alert's source CI.</td>
</tr>
<tr>
<td>Incident Alert [incident_alert]</td>
<td>The base table for incident alerts.</td>
</tr>
</tbody>
</table>

Plugins

The following additional plugins are activated with incident alert management.

Table 97: Incident Alert Management plugins

<table>
<thead>
<tr>
<th>Plugin name</th>
<th>Plugin ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Management</td>
<td>com.snc.contact_management</td>
<td>Provides contact functionality and enables contact administration for incident alerts.</td>
</tr>
</tbody>
</table>

The following additional plugins can optionally be installed to provide additional functionality.

Table 98: Incident Alert Management additional plugins

<table>
<thead>
<tr>
<th>Plugin name</th>
<th>Plugin ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify</td>
<td>com.snc.notifynow</td>
<td>Provides functionality to send SMS notifications and set up ad-hoc conference calls for an incident alert.</td>
</tr>
</tbody>
</table>

Properties

Incident alert management adds the following system properties.
## Table 99: Incident Alert Management properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.iam.log_level</td>
<td>Logging level for the business rule MapUpstreamImpactedCI. Debug is the most detailed option with full trace of how the Impacted CI List is calculated. Error is the minimal logging option with only severe errors being logged.</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Default value: info</td>
</tr>
<tr>
<td></td>
<td>• Possible Values: debug, info, error</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties [sys_properties] table</td>
</tr>
<tr>
<td>glide.ui.incident_alert_activity.fields</td>
<td>Incident alert activity formatter fields. This is the list of fields tracked from the incident alert form in the activity formatter.</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Default value: opened_by, work_notes, comments, severity, estd_disruption_time, actual_disruption_time</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.iam.on_call_escalation_level</td>
<td>Escalation level shown in the selection screen for conference call participants. By default the primary and secondary on-call persons are in the recommended list. The behavior can be changed by adding this property to the system with a different value.</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2 (primary and secondary on-call)</td>
</tr>
<tr>
<td></td>
<td>• Possible Values: 0, 1, 2, 3, etc. Set to -1 to include everybody in the escalation plan.</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>

### User roles

Incident alert management adds the following user roles.
Table 100: Incident Alert Management user roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ia_admin</td>
<td>notifynow_admin, contact_admin</td>
<td>Can create and edit incident alerts, and manage contact information. This role is only contained in ia_admin if Notify is active.</td>
</tr>
<tr>
<td>contact_admin</td>
<td>contact_user</td>
<td>[Requires ia_admin role] Can create and edit contact definitions and contact responsibilities.</td>
</tr>
<tr>
<td>contact_user</td>
<td></td>
<td>[Requires ia_admin role] Can view contacts, contact definitions, contact responsibilities and default overrides.</td>
</tr>
</tbody>
</table>

**Note:** Typically, incident alert administrators may need to have both ia_admin and itil roles, to have full access to incident alert functionality. For example, the itil and ia_admin role are both needed to be able to create incident alerts from within an incident form.

UI actions

Incident alert management adds the following UI actions.

Table 101: Incident Alert Management UI actions

<table>
<thead>
<tr>
<th>UI action</th>
<th>Tables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new incident alert</td>
<td>incident [incident]</td>
<td>Creates new incident alert from an existing incident record.</td>
</tr>
<tr>
<td>Show Live Feed (1)</td>
<td>Incident Alert [incident_alert]</td>
<td>Displays live feed for the document on a list.</td>
</tr>
<tr>
<td>Show Live Feed (2)</td>
<td>Incident Alert [incident_alert]</td>
<td>Displays live feed for the document.</td>
</tr>
<tr>
<td>Follow on Live Feed (1)</td>
<td>Incident Alert [incident_alert]</td>
<td>Adds user to the live feed for this document. If no feed exists, it is created. This is for lists, forms have the redirect.</td>
</tr>
<tr>
<td>Follow on Live Feed (2)</td>
<td>Incident Alert [incident_alert]</td>
<td>Adds user to the live feed for this document. If no feed exists, it is created. This is for forms using the redirect.</td>
</tr>
<tr>
<td>View PIR Report</td>
<td>Incident Alert [incident_alert]</td>
<td>Shows the post incident review report.</td>
</tr>
</tbody>
</table>
The following UI actions are also installed if Notify is activated:

**Table 102: Incident Alert Management additional UI actions**

<table>
<thead>
<tr>
<th>UI action</th>
<th>Tables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate Conference Call</td>
<td>Incident Alert [incident_alert]</td>
<td>Initiate a conference call for a incident alert.</td>
</tr>
</tbody>
</table>

**UI policies**

Incident alert management adds the following UI policies.

**Table 103: Incident Alert Management UI policies**

<table>
<thead>
<tr>
<th>UI policy</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make PIR section source incident fields read only</td>
<td>Incident Alert [incident_alert]</td>
</tr>
<tr>
<td>Closure info</td>
<td>Incident Alert [incident_alert]</td>
</tr>
<tr>
<td>Resolution Info</td>
<td>Incident Alert [incident_alert]</td>
</tr>
<tr>
<td>Capturing open / closed / resolved info</td>
<td>Incident Alert [incident_alert]</td>
</tr>
</tbody>
</table>

**Script includes**

Incident alert management adds the following script includes.

**Table 104: Incident Alert Management script includes**

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentAlertAjax</td>
<td>AJAX methods for incident alert.</td>
</tr>
</tbody>
</table>

The following script includes are also installed if Notify is activated.

**Table 105: Incident Alert Management additional script includes**

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentAlertConferenceCall</td>
<td>Returns a list of frequent participants that have joined Notify conference calls.</td>
</tr>
</tbody>
</table>

**Client scripts**

Incident alert management adds the following client scripts.
Table 106: Incident Alert Management additional client scripts

<table>
<thead>
<tr>
<th>Script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIR visibility</td>
<td>Incident Alert [incident_alert]</td>
<td>Show PIR section if state is resolved or closed.</td>
</tr>
<tr>
<td>Adding info from Source Incident</td>
<td>Incident Alert [incident_alert]</td>
<td>Bring in information from source incident.</td>
</tr>
</tbody>
</table>

Business rules

Incident alert management adds the following business rules.

Table 107: Incident Alert Management business rules

<table>
<thead>
<tr>
<th>Business rule name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Alert insertion limitation</td>
<td>Incident Alert [incident_alert]</td>
<td>Only allow one active incident alert to be associated with an incident.</td>
</tr>
<tr>
<td>MapUpstreamImpactedCI</td>
<td>Incident Alert [incident_alert]</td>
<td>Populate impacted CIs related list.</td>
</tr>
<tr>
<td>Insert in state &quot;New&quot; only</td>
<td>Incident Alert [incident_alert]</td>
<td>Make sure an incident alert can only be created with in a New state.</td>
</tr>
<tr>
<td>Opened, Resolved and Closed capturing</td>
<td>Incident Alert [incident_alert]</td>
<td>Capture who did what and when.</td>
</tr>
<tr>
<td>Automatically WIP if actions taken</td>
<td>Incident Alert [incident_alert]</td>
<td>Automatically change the incident alert state to Work In Progress when comments are added.</td>
</tr>
<tr>
<td>Check role is ia_admin</td>
<td>Contact [contact]</td>
<td>Make sure that the logged in user is an incident alert administrator.</td>
</tr>
<tr>
<td>Map upstream impacted CI</td>
<td>Incident Alert [incident_alert]</td>
<td>Map all impacted configuration items based on source CI.</td>
</tr>
</tbody>
</table>

The following business rules are also installed if Notify is activated.

Table 108: Incident Alert Management additional business rules

<table>
<thead>
<tr>
<th>Business rule name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS on new Incident Alert</td>
<td>Incident Alert [incident_alert]</td>
<td>Send an SMS notification when an incident alert is created.</td>
</tr>
<tr>
<td>Conference Call Allowed</td>
<td>Incident Alert [incident_alert]</td>
<td>Check if a conference call can be initiated.</td>
</tr>
<tr>
<td>Business rule name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Conference Call Finished IA Activity</td>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Extend the Incident Alert activity log when a conference call finishes.</td>
</tr>
<tr>
<td>Update Conference Call Started IA Activity</td>
<td>NotifyNow Conference Call [notifynow_conference_call]</td>
<td>Extend the Incident Alert activity log when a conference call is initiated.</td>
</tr>
</tbody>
</table>

**Incident Alert life cycle**

Incident alerts are created with a **New** state. They follow a process that finishes with the **Closed** or **Cancelled** state.

A series of rules ensure that the alert progression is controlled and standardized.
Table 109: Incident Alert Stages

<table>
<thead>
<tr>
<th>State</th>
<th>Next State</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Work in Progress, Cancelled, Resolved</td>
<td>From <strong>New</strong>, the state can be changed to <strong>Work in Progress</strong>, <strong>Cancelled</strong>, or <strong>Resolved</strong>. The state automatically changes from <strong>New</strong> to <strong>Work in Progress</strong> if the <strong>Actions Taken</strong> field is updated.</td>
</tr>
<tr>
<td>Work in Progress</td>
<td>Cancelled</td>
<td>From <strong>Work in Progress</strong>, the state can be changed to <strong>Resolved</strong> or <strong>Cancelled</strong>. Only the alert creator or a user with the admin role can cancel an incident alert.</td>
</tr>
<tr>
<td>Resolved</td>
<td>Closed</td>
<td>From <strong>Resolved</strong>, the state can be changed to <strong>Closed</strong>.</td>
</tr>
</tbody>
</table>
Incident Alert contact

Contacts allow incident alerts to be associated with users and groups based on conditions defining the association.

Use contacts with incident alerts

Incident alert management uses contacts for notification purposes. 

*Incident alert management* uses contacts for notification purposes. Administrators and incident alert administrators can:

- Create and edit contact responsibilities.
- *Create and edit contact definitions* to automatically assign contacts to alerts.
- *Add contacts manually* to an incident alert.

Create a contact responsibility

Set up contact definitions to identify individuals or groups that must be associated with an incident alert when it is created.

Contact responsibilities allow contacts to be used in specific alerts. They can be used:

- Within a *contact definition*, as part of the rules for assigning users or groups as contacts for incident alerts.
- *On an ad-hoc basis*, to be added within specific incident alerts.

To create a contact responsibility:

1. Navigate to *Incident Alert Management > Contact Administration > Contact Responsibilities*.
2. Click *New*.
3. Fill in the fields.
Table 110: New contact responsibility

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The responsibility name.</td>
</tr>
<tr>
<td>Type</td>
<td>User or Group to indicate whether the responsibility appears in the User Contacts or Group Contacts related list of the Incident Alert form.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a contact definition

Contact definitions specify the conditions for assigning the associated contact responsibility record to incident alerts and the conditions for assigning specific users or groups to those responsibilities.

Contact definitions specify:

- The conditions for assigning the associated contact responsibility record to incident alerts.
- The conditions for assigning specific users or groups to those responsibilities.

For example, a contact definition may be Assign a Crisis Action Manager for Outages with an additional condition of Business/Service impact is True.

To create a contact definition:

1. Navigate to Incident Alert Management > Contact Administration > Contact Definitions.
2. Click New.
3. Fill in the fields.
Table 111: New contact definition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that indicates the conditions defined for this contact definition.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of contacts this definition can be associated with. Can be User or Group.</td>
</tr>
<tr>
<td>Source</td>
<td>The method to determine the user or group to associate with this definition. It can be set to:</td>
</tr>
<tr>
<td></td>
<td>• None: Use no association. The incident alert administrator should associate users or groups manually, editing that responsibility entry within the Incident Alert form.</td>
</tr>
<tr>
<td></td>
<td>• Default Override: Use a default override to associate users or groups based on conditions.</td>
</tr>
<tr>
<td></td>
<td>• Form Field: Use information used from a specified field on the incident alert, as defined by the Source field value.</td>
</tr>
<tr>
<td>Source field</td>
<td>The field on the Incident Alert form that identifies the contact associated with the selected contact responsibility. Appears only when Form field is selected as the value for Source.</td>
</tr>
<tr>
<td></td>
<td>• For user contact types, values can be Assigned to, Closed by, Opened by, or Resolved by.</td>
</tr>
<tr>
<td></td>
<td>• For group contact types, the value is Assignment group.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>The contact responsibility associated with this definition.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The maximum number of contacts that can be associated with the selected Responsibility per incident alert record. This field appears only when None is selected as the value for Source.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate whether the definition is active or not.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.

Create a default override
Default overrides specify the user value for each contact the definition adds to an incident alert.

The Default overrides related list is available if the Source for the contact definition is set to Default override.

For example, you could define two default overrides for a contact definition:

- If Source CI's location is EMEA then user is Beth Anglin, with an evaluation order of 100.
- If Source CI's location is APAC then user is Abel Tuter, with an evaluation order of 200.

If an incident alert is created that matches the conditions of the contact definition, ServiceNow then compares the alert's source CI to these override conditions and assigns the appropriate user as the contact.

To create a new default override:

1. Click **New** in the Default overrides related list.
2. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>The conditions defining whether the default override is to be applied. If multiple conditions are defined, each condition is evaluated in the order listed. If no conditions match, this default override is not applied.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the condition is to be evaluated.</td>
</tr>
<tr>
<td>User value</td>
<td>The user to assign as that contact if the condition matches. If the definition type is set to Group, this field is labelled Group value and defines the group to assign as that contact.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Add a contact manually

Contact entries can be added to an incident alert manually, within an incident alert.

1. Open the incident alert record.
2. Select the User Contacts related list.
3. Do one of the following:
   - Click New to create a new ad-hoc entry.
   - Select an entry created by a contact definition which has the Source field set to None.
4. Select a Responsibility and the User to have this responsibility for this incident alert. That contact information is now listed in the incident alert’s User Contacts related list.

Note: If you delete an incident alert, all contacts associated with that incident alert are also deleted.

Contact administration

As an incident alert administrator, you can assign multiple users and groups as contacts.

You can assign users or groups to incident alerts automatically based on the information provided in these records:

- Contact responsibilities: these provide a name, such as Incident Duty Manager, for a set of tasks related to incident alerts. The contact responsibility record also indicates whether those tasks are
performed by an individual user or a group of users. Contact responsibilities can also be used to manually add contacts to an incident alert.

- Contact definitions: identify a set of conditions to determine which specific user or group is assigned to handle particular responsibilities for an incident alert. For example, All P1 Incidents must have an Incident manager, assigned to US Incident Management group.

Contact responsibilities and contact definitions allow you to define and modify data-driven contact information for automatic notifications, rather than specifying individual users or groups directly for each incident alert.

You can use group contacts. Group contacts are available when you use on-call scheduling, notify and incident alert management. Group contacts include the people that are on-call. The group contacts do not automatically get an SMS notification when an incident alert is created. But they can be included when initiating a conference call that is the result of an incident alert. By default, the primary and secondary on-call persons are available. To modify this behavior, set the system property com.snc.iam.on_call_escalation_level.

Responsibilities for incident alerts

There are two types of responsibilities available for use with incident alerts:

- Default Responsibilities: contacts who are notified by default.
- Other Responsibilities: contacts who can be selected for notification.

Use contact definitions to view and modify the rules that determine the specific users associated with contact responsibilities.

Default Responsibilities

By default, contacts with the following responsibilities are notified when an incident alert is created:

- Duty Manager
- Incident Manager
- Duty Director

These roles are involved with resolving the source incident or original event that the incident alert relates to, and so are seen as key contacts for the incident alert.

The following sections describe typical operational roles for these responsibilities.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duty Manager</td>
<td>The senior point of presence in the monitoring environment at the time an incident occurs. The Duty Manager assesses the incident against standard operating procedures, escalation triggers and personal knowledge and experience, to take corrective actions. To clarify the urgency and impact of an incident, the Duty Manager can contact the Incident Manager for advice.</td>
</tr>
</tbody>
</table>
Incident Manager

A senior technician, accountable for coordinating and managing all technical resources required to resolve incidents. After being notified by the Duty Manager of a serious incident, the Incident Manager assesses the seriousness and associated business impact. Based on this assessment, the Incident Manager decides whether to escalate the incident to the Duty Director. The Incident Manager may escalate to the Duty Director to gain access to resources outside of the department, if necessary.

Duty Director

The escalation point for all issues that affect critical services. The Duty Director works in partnership with the business directors in the organization to approve recovery plans developed by the Incident Manager, and to manage the senior level communications for the source incident.

Other Responsibilities

Incident alert management provides the following additional responsibilities that can be added to incident alerts. You can also create contact responsibilities, as needed. The associated users receive notifications about the alert.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Director</td>
<td>Director within the business who is identified as a potential contact in the event of an incident alert.</td>
</tr>
<tr>
<td>Communication Manager</td>
<td>Business-facing role in the event communication is required in an incident alert.</td>
</tr>
<tr>
<td>Crisis Action Manager</td>
<td>Overall responsibility and accountability for managing incident alerts.</td>
</tr>
<tr>
<td>Crisis Action Team Member</td>
<td>Nominated department heads who are involved when an incident alert occurs.</td>
</tr>
<tr>
<td>Development</td>
<td>Development personnel involved in the troubleshooting and resolving an incident alert.</td>
</tr>
<tr>
<td>Operations</td>
<td>Second or third level operations support involved in troubleshooting and resolving an incident alert.</td>
</tr>
<tr>
<td>Service Owner</td>
<td>Service owner or manager who is identified as a potential contact in the event of an incident alert that relates to one or more of their services.</td>
</tr>
</tbody>
</table>

Table 114: Contact Administration Other Responsibilities

© 2017 ServiceNow. All rights reserved.
<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Support</td>
<td>Second or third level technical support personnel involved in troubleshooting and resolving an incident alert.</td>
</tr>
</tbody>
</table>

Create incident alerts

Incident alerts are typically created to help manage and track communications around a high-priority incident or other issue.

Incident alerts can be created:

- *Directly as standalone alerts.*
- *From an existing active incident.* Only one incident alert can be created for each incident.

Create an alert directly

Create an incident alert directly if the original issue that caused the alert was not logged as an incident. For example, a significant facilities problem may not be logged as an incident in ServiceNow, but may still require an incident alert to be created.

1. Navigate to *Incident Alert Management > Create New.*
2. Fill in the fields.
Table 115: New incident alert form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated incident alert ID, in the format IAxxxxxxxx.</td>
</tr>
<tr>
<td>Severity</td>
<td>The severity for the incident alert. Values are Major, High, Medium, or Low.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source incident</td>
<td>The source incident for this alert, if any. If you select a source incident, the Source CI, Short description, and Background fields are populated with data from this incident, unless there is existing data in those fields.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the alert. Values are New, Work In Progress, Resolved, Cancelled, or Closed.</td>
</tr>
<tr>
<td>Source CI</td>
<td>The source CI for this alert, if any. If there is a source incident selected, this field is populated with the source CI attached to that incident. If there is no source incident selected, select the source CI manually, if applicable. If the source CI has related CIs, these are automatically listed in the Impacted CIs related list.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The assignment group, if any, for that incident alert. For example, there might be a group that represents a crisis management team, including a number of Incident Managers, Duty Directors and Duty Managers.</td>
</tr>
<tr>
<td>Event type</td>
<td>The type of event. Values are: Outage, Degradation, Capacity, SLA/Delay, or Fail-Over.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The assigned user for the alert. This can be an ITIL user or an incident alert administrator, and defaults to the user who creates the alert.</td>
</tr>
<tr>
<td>Business/Service impact</td>
<td>Yes or No to indicate whether the business or a service is impacted.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief summary of the alert.</td>
</tr>
<tr>
<td>Details section</td>
<td></td>
</tr>
<tr>
<td>Opened</td>
<td>When the alert was created.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The creator of the alert. This defaults to the user who creates the alert.</td>
</tr>
<tr>
<td>Estimated disruption time</td>
<td>The estimated duration of the disruption.</td>
</tr>
<tr>
<td>Description</td>
<td>More detailed information for the alert.</td>
</tr>
<tr>
<td>Background</td>
<td>Background information about the alert.</td>
</tr>
<tr>
<td>Activity section</td>
<td></td>
</tr>
<tr>
<td>Actions taken</td>
<td>The details of all actions taken while working on the alert.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Any separate work notes relevant to the alert that might help in communications.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

Create an alert from an incident

Creating an incident alert from within an existing incident record populates the alert with information from that incident.

1. Open an existing incident.
2. Select the **Create new incident alert** related link.
3. A new incident alert record is created and populated with data from the incident.
   - The original incident becomes the source incident of this alert.
   - Other fields populated with data from the source incident are: Source CI, Short description, Background.
4. Fill in other fields as required, as described for **creating alerts directly**.
5. Click **Submit**.

Incident alert related lists

After you create an incident alert, several related lists are added to the form.

**Table 116: Related lists**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted CIs</td>
<td>The Impacted CIs related list shows all the CIs that the CMDB shows as related to the source CI for this alert.</td>
</tr>
<tr>
<td></td>
<td>Administrators and incident alert administrators can modify this list. Click the <strong>Edit</strong> button, then add and remove CIs, as appropriate.</td>
</tr>
</tbody>
</table>

**Note:** Administrators can adjust the `com.snc.iam.log_level` property to view more log information for how this list is determined. By default the value is info. Set this to debug to see more detailed log information.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Contacts</td>
<td>After an incident alert is created, the following default user responsibilities are added to the User Contacts related list:</td>
</tr>
<tr>
<td></td>
<td>• Duty Manager</td>
</tr>
<tr>
<td></td>
<td>• Duty Director</td>
</tr>
<tr>
<td></td>
<td>• Incident Manager</td>
</tr>
<tr>
<td></td>
<td>From this list:</td>
</tr>
<tr>
<td></td>
<td>• Click New to add a new contact.</td>
</tr>
<tr>
<td></td>
<td>• Click the lookup icon beside the responsibility entry to edit the details for that responsibility.</td>
</tr>
<tr>
<td></td>
<td>• Select the check box for the entry, then select Actions on selected rows.. and click Delete, to delete that entry from the user contacts list.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Using Contacts with Incident Alerts.</td>
</tr>
<tr>
<td>Group Contacts</td>
<td>There are currently no default group contacts defined for incident alert management. However, you can define group responsibilities for your organization, then configure the form to add the Group Contacts related list.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related Incidents and Related Problems</td>
<td>The Related Incidents and Related Problems related lists show incidents and problems affected, based on the source incident for the alert. This information is read-only. To make changes to this information, update the source incident.</td>
</tr>
<tr>
<td>Notify</td>
<td>If Notify is active, two additional related lists appear on the Incident Alert form. The SMS Messages related list gives information about the SMS notifications sent to users identified as contacts on the incident alert. For example, by default, SMS notifications are sent to users who are assigned to responsibilities when an incident alert is created. The SMS message content depends on the fields that were filled in when the alert is created, but is generally in the following format: IA0000001: a &lt;severity&gt; severity &lt;event type&gt; incident alert for '&lt;CI name&gt;' has been opened</td>
</tr>
</tbody>
</table>

Note: The CI name may be truncated to keep the content within 160 characters.

The Conference Calls related list shows details of any conference calls that have been launched for the incident alert.

For more information, see Using Notify with Incident Alert Management.

---

**Process incident alerts**

After creating an incident alert, the incident alert administrator can process it through a set of predefined states to ensure efficient and consistent handling.
After creating an incident alert, the incident alert administrator can process it through a set of predefined states to ensure efficient and consistent handling. The incident alert administrator may also be assigned the contact responsibility of Duty Manager.

When an incident alert is resolved, the incident alert administrator can run a post incident review, and can generate a report for that review from within the incident alert.

The incident alert administrator can also view the dashboard and run reports on incident alerts.

**Incident alert task**

Incident alert tasks allow users to track the actions needed to resolve an incident alert.

As a user with the ia_admin role, you can add tasks to an incident alert.

Users without the ia_admin role that are assigned to a particular task can modify only that task record.

**Resolve an alert**

Typically, when the event that initiated the incident alert is resolved, the incident alert can also be marked as resolved.

When an alert is resolved, the following fields are added to the Incident Alert form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved</td>
<td>The date and time when the alert was resolved. Automatically set when the form is saved, but can be changed later.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>The user who resolved the alert. Automatically set when the form is saved, but can be changed later.</td>
</tr>
<tr>
<td>Actual disruption time</td>
<td>The amount of disruption time recorded, based on the time between when the incident alert was created and the time it was marked as resolved.</td>
</tr>
<tr>
<td>Post Incident Review section</td>
<td>Information for discussion and review. For more information, see Run a Post Incident Review.</td>
</tr>
</tbody>
</table>

**Run a post incident review**

After an incident alert has been marked as resolved, the Post Incident Review section appears on the Incident Alert form.

After an incident alert has been marked as resolved, the Post Incident Review section appears on the Incident Alert form. This allows the incident alert administrator to initiate a post incident review (PIR) meeting to review and learn from the issues that arose from the source event.

Fill in this section as appropriate, then use the View PIR Report related link to create the PIR report. This report can be circulated or printed for the PIR meeting.
**Figure 33: Post incident review**

![Post Incident Review](image-url)
The Source Incident Details section contains read-only information, taken from the source incident. Fill in the Incident Alert Details fields as follows:

Table 118: Incident alert details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution code</td>
<td>[Required] Whether the incident alert has been completed. Values can be Complete, Complete with Actions, or Not complete.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>[Required] Any notes about the resolution of the incident alert. After a user enters information in the resolution notes and saves the record, both the Resolution notes and Resolution code are set to read-only.</td>
</tr>
<tr>
<td>Summary</td>
<td>A summary of the incident alert.</td>
</tr>
<tr>
<td>Lessons learned</td>
<td>Any lessons learned from the review process.</td>
</tr>
</tbody>
</table>

Use the View PIR Report related link to create a report that can be circulated or printed for the post incident review meeting.

Close an alert

Typically, when the post incident review is complete, the incident alert can be closed. To close an alert, mark the state as **Closed**.

![Figure 34: Incident alert closed](image)

The following values are then set in the Details section of the alert.

Table 119: Incident alert details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>The date and time when the alert was closed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>Closed by</td>
<td>The user who closed the alert.</td>
</tr>
</tbody>
</table>

These fields can be changed later, if required.

**View the dashboard**

The incident alert dashboard is a homepage that contains gauges and reports showing open incident alerts with a status of New or Work in Progress.

The incident alert dashboard is a *homepage* that contains gauges and reports showing open incident alerts with a status of New or Work in Progress.

To open the dashboard, navigate to **Incident Alert Management > Overview** or point to the homepage icon ( 

) in the banner and select **Incident Alert Homepage**.
Figure 35: Incident alert dashboard

Table 120: Incident alert dashboard

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Alerts</td>
<td>Displays all open alerts. Click an alert number to open the details for that alert.</td>
</tr>
<tr>
<td>Open Alerts By Severity</td>
<td>Groups open alerts by severity levels, as defined in the Incident Alert form.</td>
</tr>
</tbody>
</table>
Run an incident alert report

Administrators and incident alert administrators can run incident alert reports to view the current status of alerts, track them and intervene where required, and improve overall efficiency and effectiveness.

Administrators and incident alert administrators can run incident alert reports to view the current status of alerts, track them and intervene where required, and improve overall efficiency and effectiveness.

To run a report:

1. Navigate to **Reports > View / Run**.
2. Locate the Incident Alert heading.
3. Click a report name and view the results (see table).

4. Alter **parameters** as required, and click **Run Report** to run the revised report.

**Table 121: Result table**

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
<th>Contains</th>
</tr>
</thead>
<tbody>
<tr>
<td>IAs opened in the last 72 hours</td>
<td>All alerts, of any state, which have been opened in the last 72 hours.</td>
<td>Number, Created by, Event Type, Severity, Title, Open time, Estimated Disruption time, Related Record, Assignee.</td>
</tr>
<tr>
<td>Report name</td>
<td>Description</td>
<td>Contains</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open Alerts</td>
<td>Displays all open alerts. Click an alert number to open the details for that alert. Displayed on the dashboard by default.</td>
<td>Number, Severity, Short description, Source incident, State, Business/Service impact, Assigned to.</td>
</tr>
<tr>
<td>Open Alerts By Severity</td>
<td>Groups open alerts by severity levels, as defined in the Incident Alert form. Displayed as a pie chart on the dashboard by default.</td>
<td>Severity.</td>
</tr>
<tr>
<td>Open Alerts by Type</td>
<td>Groups open alerts by alert type, as defined in the Incident Alert form. Displayed as a bar chart on the dashboard by default.</td>
<td>Event type.</td>
</tr>
<tr>
<td>Open IA's this week</td>
<td>All open alerts which have been created in the current week.</td>
<td>Number, Created by, Event Type, Severity, Title, Time Created, Estimated Disruption time, Related Record number, Incident Manager.</td>
</tr>
<tr>
<td>Resolved Alerts</td>
<td>All alerts which have been resolved. This does not include closed alerts.</td>
<td>Number, Resolved by, Event Type, Severity, Title, Actual Disruption time, Source Incident number, Source Incident status.</td>
</tr>
<tr>
<td>Resolved IA's this Week</td>
<td>All alerts which have been resolved in the current week, including any alerts closed this week.</td>
<td>Number, Resolved by, Event Type, Severity, Title, Actual Disruption time, Related Record, Assignee.</td>
</tr>
</tbody>
</table>

### Notify with Incident Alert

Using Notify enables all users involved in the issue to quickly communicate with each other and helps in the fast turnaround and resolution of the issue.

**Note:**

This content applies to the *Legacy Notify* and the newer *Notify* plugin, where there is a difference it will be noted.

Within incident alert management, *Notify* functions can be used to:

- *Send SMS notifications* (text messages) when an event occurs.
- *Launch a conference call* for involved users to discuss the relevant issue.

**Note:** Notify is available as a separate subscription from the ServiceNow platform. To purchase a subscription, contact your ServiceNow account manager.
Send an SMS notification

Notify sends an SMS to the users associated to the alert when it is created.

When you create a new incident alert, Notify sends an SMS notification to the users defined as default contact responsibilities for the alert.

This text message is sent to the mobile phone number on record of each user and takes this form:

IA<number>: a <Severity> severity <Event Type> incident alert for <CI Name> has been opened.

Administrators can modify the content of this message by editing the SMS on new Incident Alert business rule.

Launch a conference call

As part of processing an incident alert, a conference call can be created between involved users.

Call participants can include:

• Those users who have been assigned specific responsibilities.
• Any required ad-hoc user contacts.
• Other involved parties who are not recorded as users, such as third-party contacts.

---

**Note:** Only one conference call at a time can be active for each issue.

1. Navigate to **Incident Management > Open**.
2. Open the relevant incident alert.
3. Click the **Initiate Conference Call** related link.
4. Within the dialog box that appears, select the participants for the conference.
The dialog box displays the recommended and selected participants for the conference. All users from the User Contacts list in the incident alert are selected by default. If a rotation schedule exists for the Group Contacts, the primary and secondary on-call resources are shown in the Recommended list. This way, the current on-call persons can quickly be invited to join the conference call. Calls are placed to the number in the Mobile phone field on the user record. If that information is blank, the user cannot be contacted through Notify. The mobile phone number has to be an E.164 compliant phone number. If the phone number is a local number, without the + prefix, the number will be retrieved based on the user’s location and, if possible, converted into a valid E.164 number.

5. To select ad-hoc participants, do one of the following activities:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the reference lookup icon, and select the relevant user.</td>
<td>Click Add to selected.</td>
</tr>
<tr>
<td>Enter the participant's phone number in the field beside the telephone icon.</td>
<td>Click Add to selected.</td>
</tr>
</tbody>
</table>

6. After the participant list is finalized, click OK.

7. The conference call starts and a Conference call initiated message is displayed at the top of the Incident Alert form. Each user is called and can accept the call to join the conference. Several response types are possible from users invited to join the conference call, apart from Accepted.

8. Click the Conference call initiated message to see details of that conference call.
When the final participant leaves the conference, the conference call closes.

**Note:** VoIP phone systems, which do not use touch tone phones, may encounter issues with recognizing key presses. To avoid problems, ensure that conference call users use touch tone phones, or configure your VoIP system settings to recognize key presses, as described in your VoIP system documentation.

---

**Add a participant**

If the conference participants decide that the input of another user is required, that user can be invited to join the current conference call.

Participants who may have involuntarily dropped out of the conference can also contact the conference call initiator, who can add them to the conference call.

**Note:**

The content applies to the *Legacy Notify* plugin and not to the *Notify* plugin.

---

1. Open the form for the relevant active conference call.
2. Click the *Invite to Conference Call* related link.
3. Select participants as described for launching a conference call.
4. The selected participant is called directly and can join the conference. If you try to add a user that is already in another call to a conference call, the following message appears:

   [Name] is already active in a call.
If you try to start a new call with a user that is already in a conference call, two messages are shown, the first stating this is an invalid participant and the second that this person is already in another call.

View conference call information

Conference calls are listed as system activities in the **Activity** section of the Incident Alert form and also are listed in the **Conference Calls** related list.

Figure 36: Conference bridge history

In the related lists, click **Conference Calls** if you want to view the list of conference calls.
Figure 37: Conference Calls

**Note:** Conference call information can also be accessed by navigating to Notify > Conference Calls starting with the Eureka release. In previous versions, navigate to NotifyNow > Conference Calls.

Responses to conference call information

When a user is invited to join a conference call, Notify may receive one of several responses. These responses can be viewed in the conference call details.
Table 122: Responses to conference call invitations

<table>
<thead>
<tr>
<th>Response</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted</td>
<td>The contact answered the call and accepted the invitation to join the conference.</td>
</tr>
<tr>
<td>Busy</td>
<td>A busy signal was received. Either the contact rejected the incoming call or the phone was in use.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The conference call manager cancelled the outgoing call.</td>
</tr>
<tr>
<td>Completed</td>
<td>The call was finished or the contact hung up.</td>
</tr>
<tr>
<td>Failed</td>
<td>The call could not be completed as dialed, possibly because the phone number did not exist.</td>
</tr>
<tr>
<td>Ignored</td>
<td>The contact answered the phone, but hung up or disconnected without choosing to accept or reject the incoming call.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The contact answered the call and rejected the invitation.</td>
</tr>
<tr>
<td>Ringing</td>
<td>The contact is being called.</td>
</tr>
<tr>
<td>Unanswered</td>
<td>Any other action, for example, missed call, or the contact took another action.</td>
</tr>
</tbody>
</table>

**Note:** Depending on the phone service provider of the contact, the information the participant receives may vary. For example, contacts who have switched off their phones may or may not receive a missed call message.

### Incident Alert Management roles

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITIL user [itil_user]</td>
<td>Can view the dashboard and incident alerts. Can subscribe to incident alerts.</td>
</tr>
<tr>
<td>Incident alert administrator [ia_admin]</td>
<td>Can create and edit incident alerts and contact records.</td>
</tr>
</tbody>
</table>

### Incident Alert Management example

An example of how incident alerts can be used in an incident management process is:

1. An ITIL user creates a high-priority incident regarding a serious issue with the server room.
2. The incident alert administrator creates a new incident alert for this source incident.
3. As a result of a conference call discussion, a problem is identified based on the incident. This problem is assigned to the problem management team, which agrees to investigate further and identify tasks to improve service and prevent similar incidents from occurring.

4. The incident management team resolves the source incident. The source incident may also be closed at this point.

5. The incident alert administrator resolves the incident alert.

6. The incident alert administrator convenes a post incident review meeting to ensure that all identified tasks are logged and tracked to completion.

7. The incident alert administrator can now close the incident alert.

Subscribe to incident alerts

Any self-service user can subscribe to incident alerts, to be notified when:

- A new incident alert is created.
- An incident alert is resolved or closed.
- An incident alert is canceled.
- The Actions Taken field on an incident alert is updated.

Notifications are sent by email. If Notify is active, notifications can also be sent by SMS message or voicemail.

For example, a business manager does not log in to the system on daily basis, but needs to know when a new incident alert is created. The business manager can subscribe to receive notifications whenever a new incident alert is raised.

Filter a notification

If no filtering is applied to a subscription, then a subscribed user receives all notifications for that subscription.

For example, a user subscribed to New IA Raised, with no filtering, receives notifications every time any incident alert is created.

To make the notifications more relevant:

1. Select Advanced filter:
2. Use the condition builder to create an appropriate filter.

For example, you can choose to be notified only when an incident alert is created for a specific CI.
Notification message content

When a relevant notification event happens, a notification message is generated and sent to all subscribed users.

This message will give the notification type, the alert number, and details of the event.
Geneva    ServiceNow    IT Service Management

Figure 38: Notification Message

Subscribe to a notification

1. Navigate to Self-Service > My Profile.
2. Select Notification Preferences under Related Links.
3. Under the device to receive notifications, click in the area labeled To subscribe to a new notification click here.
4. Click the lookup icon beside **Notification Message** to display a list of available notifications.

5. Select one of the following notifications:
   - New IA Raised
   - IA Actions Taken
   - IA Resolved Or Closed
   - IA Cancelled

6. Fill in the details for the selected notification.

![New Notification for System Administrator's Primary email](image)

7. Click **Submit**.
   The notification is then listed in the **Notification Preferences** list.
Incident Management

The goal of Incident Management is to restore normal service operation as quickly as possible following an incident, while minimizing impact to business operations and ensuring quality is maintained.

The ServiceNow platform supports the incident management process with the ability to log incidents, classify according to impact and urgency, assign to appropriate groups, escalate, and manage through to resolution and reporting. Any ESS user can log in to an instance to record the incident and track it through the entire incident life cycle until service has been restored and the issue has been completely resolved.

Within the platform, incidents are handled with the task record system. Each incident is generated through a variety of methods as a task record, and populated with the pertinent information in individual fields. These tasks can be assigned to appropriate service desk members, who will deal with the task as appropriate. Once the incident has been properly dealt with, it is closed.

Logging incidents

By default, any user can create an incident within the system.

8. Repeat this process for each notification you want to receive.
Table 123: Logging an incident

<table>
<thead>
<tr>
<th>Location</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Self Service</td>
<td>ITIL users or administrators can use the Create New module in the Incident application, or select New from the Incident list. The Watch list, Incident state, and Impact fields are available on the ESS view of the Incident form and the variable formatter is not available. ESS users have write access to the Watch list and Impact fields.</td>
</tr>
<tr>
<td>Record producers</td>
<td>Use the Create a New Incident record producer in the service catalog. (This record producer sets the Contact Type field of the resulting incident to Self-Service.)</td>
</tr>
<tr>
<td>Inbound email actions</td>
<td>An email addressed to the instance mailbox can create an incident according to inbound email actions.</td>
</tr>
</tbody>
</table>

Note: If the Security Incident Response plugin is activated, you can click the Create Security Incident button on the New Incident form to create a security incident from the currently displayed incident.

Identifying incidents

In addition to having users log incidents, it is possible to automatically generate incidents from pre-established conditions. Business rules use JavaScript to generate an incident after a certain series of conditions has been met. It is also possible to generate incidents from outside the platform with SOAP messaging.

The incident alert management application allows you to manage communications around high-priority incidents. See Incident Alert Management on page 347.

Identify incidents

In addition to having users log incidents, it is possible to automatically generate incidents from pre-established conditions.

Business rules use JavaScript to generate an incident after a certain series of conditions has been met. It is also possible to generate incidents from outside the platform with SOAP messaging.

Categorize incidents

Incident forms have fields for category and subcategory, which allow for easy classification of incidents. These categories can be used by the system to create automatic assignment rules or notifications. For instance, with a certain assignment rule, an incident with a category of Database could automatically be assigned to a Database group that always handles database issues.
Another important category for incidents is the incident state. This allows the service desk to track how much work has been done and what the next step in the process might be. For more information, see *Categorizing Incidents*.

Add or remove incident categories or subcategories

1. Navigate to **Incident > Create New**.
2. Right-click the **Category** or **Subcategory** field and select **Configure Choices**. The **Subcategory** field is not on the form by default. You might need to add it.
3. To add new categories, click **New**, specify a Label and Value, and click **Submit**.
4. To add existing categories, highlight the desired category and click **Add**.
5. To remove existing categories, highlight the unwanted category and click **Remove**.

Incident categories and subcategories

Assigning incident tickets to categories and subcategories can greatly improve the clarity and granularity of report data.

For example, appropriate incident categories allow you to track how many network-related versus telephone-related incidents you have from week to week.

The platform can also use an incident's category or subcategory to automatically assign the incident to a specific fulfillment group to work on it. For example, Network tickets should automatically go to the Network group based on the category.

### Table 124: Categorizing incidents

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>Password Reset</td>
</tr>
<tr>
<td></td>
<td>Password Expired</td>
</tr>
<tr>
<td></td>
<td>Account Locked</td>
</tr>
<tr>
<td>Inquiry / Help</td>
<td>Anti-Virus</td>
</tr>
<tr>
<td></td>
<td>Email</td>
</tr>
<tr>
<td></td>
<td>Internal Application</td>
</tr>
<tr>
<td>Software</td>
<td>Email</td>
</tr>
<tr>
<td></td>
<td>Operating System</td>
</tr>
<tr>
<td>Hardware</td>
<td>CPU</td>
</tr>
<tr>
<td></td>
<td>Disk</td>
</tr>
<tr>
<td></td>
<td>Keyboard</td>
</tr>
<tr>
<td></td>
<td>Memory</td>
</tr>
<tr>
<td></td>
<td>Monitor</td>
</tr>
<tr>
<td></td>
<td>Mouse</td>
</tr>
<tr>
<td>Network</td>
<td>DHCP</td>
</tr>
<tr>
<td></td>
<td>DNS</td>
</tr>
</tbody>
</table>
Prioritization of incidents

ITIL uses three metrics for determining the order in which incidents are processed. All three metrics are supported by Incident forms.

**Table 125: ITIL incident order**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>The effect an incident has on business</td>
</tr>
<tr>
<td>Urgency</td>
<td>The extent to which the incident's resolution can bear delay</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the incident</td>
</tr>
</tbody>
</table>

ITIL suggests that priority be made dependent on impact and urgency. In the base system, this is true on Incident forms. Priority is generated from urgency and impact according to the following data lookup rules.

**Table 126: Data lookup rules**

<table>
<thead>
<tr>
<th>Impact</th>
<th>Urgency</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - High</td>
<td>1 - High</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>1 - High</td>
<td>2 - Medium</td>
<td>2 - High</td>
</tr>
<tr>
<td>1 - High</td>
<td>3 - Low</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>1 - High</td>
<td>2 - High</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>2 - Medium</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>3 - Low</td>
<td>4 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
<td>1 - High</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>3 - Low</td>
<td>2 - Medium</td>
<td>4 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
<td>3 - Low</td>
<td>5 - Planning</td>
</tr>
</tbody>
</table>

By default, the Priority field is read-only and must be set by selecting Impact and Urgency values. To change how priority is calculated, administrators can either alter the priority lookup rules or disable the Priority is managed by Data Lookup - set as read-only UI policy and create their own business logic.
Log incidents

By default, any user can create an incident within the system. There are several ways to log an incident.

Table 127: Log an incident

<table>
<thead>
<tr>
<th>Location</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Self Service</td>
<td>ITIL users or administrators can use the Create New module in the Incident application, or select New from the Incident list. The Watch list, Incident state, and Impact fields are available on the ESS view of the Incident form and the variable formatter is not available. ESS users have write access to the Watch list and Impact fields.</td>
</tr>
<tr>
<td>Record Producers</td>
<td>Using the Create a New Incident record producer in the service catalog. (Note that this record producer sets the Contact Type field of the resulting incident to Self-Service.)</td>
</tr>
<tr>
<td>Inbound Email Actions</td>
<td>An email addressed to the instance mailbox can create an incident according to inbound email actions.</td>
</tr>
</tbody>
</table>

Create a record producer

The first step in using the service catalog as a front end is to create a record producer.

Record producers appear in the service catalog like catalog items, however, instead of creating a service request, they create a record on any record in the system, populating the record as defined in the record producer.

The following example demonstrates how to create a record producer to request a wireless router reset.

To define a record producer:

1. Navigate to Service Catalog > Record Producers.
2. Click New.
3. Populate the form as follows:

Table 128: Record producer form

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Request to Reset Router.</td>
</tr>
<tr>
<td>Table name</td>
<td>Incident [incident].</td>
</tr>
<tr>
<td>Category</td>
<td>Can We Help You?</td>
</tr>
</tbody>
</table>
4. Right click the form and select **Save**. The related lists Variables and Variable Sets will now appear at the end of the form.

5. Scroll down to the Variables related list and click **New**.

6. Populate the New Variable form as follows:

   **Table 129: New variable form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Reference.</td>
</tr>
<tr>
<td>Name</td>
<td>Router.</td>
</tr>
<tr>
<td>Reference</td>
<td>IP Router [cmdb_ci_ip_router]</td>
</tr>
<tr>
<td>Question</td>
<td>Which router needs to be reset?</td>
</tr>
</tbody>
</table>
7. Click **Update**.

   To view how the new record producer appears to the end user, click the **Preview Item** link:

   ![Catalog Item - Request to Reset Router](image)

   **Reset Router Request**
   Please reset the building’s router.

   **Which router needs to be reset?**
   
   ![Submit](image)

   Now, when a user would like to request that IT reset a router, they can navigate to the Service Catalog and select the **Request to Reset Router** link:
Create a record producer to log incidents

In addition to providing a front-end for service requests, service catalog is also used as a front-end for incident management.

An administrator can set up record producers that create records on the incident table, allowing the end-user to log incidents directly from the Service Catalog. This can be useful in giving end-users one front-end from which they can make all of their requests to their IT Department.

For example, the default Can We Help You? category features record producers such as Report an Incident to enable end-users to directly log incidents from the catalog homepage.

Create a record producer with a template

If a pre-defined template for an incident exists, it can be used with the record producer to fill in standard information for the record producer.

To define a record producer with a template:
1. Navigate to Service Catalog > Record Producers.
2. Click New.
3. Populate the form as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Bond Trade Access Request.</td>
</tr>
<tr>
<td>Table name</td>
<td>Incident [incident].</td>
</tr>
<tr>
<td>Template</td>
<td>Bond Trade Access Denied.</td>
</tr>
<tr>
<td>Category</td>
<td>Can We Help You?</td>
</tr>
</tbody>
</table>
4. Right click the form and select **Save**. The related lists Variables and Variable Sets will now appear at the end of the form.

5. Scroll down to the Variables related list and click **New**.

6. Populate the New Variable form as follows:

   - **Short description**: Bond Trade Access Request
   - Description: This request is for users who have been cleared for access to the Bond Trade application, but cannot log in. If you see a "403 - Access Denied Error" and feel that this was an error, please fill in this request.
Table 131: New variable form

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Multi-Line Text.</td>
</tr>
<tr>
<td>Name</td>
<td>Comments.</td>
</tr>
<tr>
<td>Question</td>
<td>Comments.</td>
</tr>
</tbody>
</table>

7. Submit.

![Variable form diagram]

8. Click **Update**.
   
The record producer will appear to the end user as such:
Once filled in and submitted, it will create the incident with the information from the template, and with the comments supplied on the record producer form, if any.

Define an assignment rule for incidents

To ensure that incidents are promptly dealt with by the appropriate IT service members, administrators can define assignment rules to automate the process.

1. Navigate to System Policy > Assignment and click New.
2. Populate the form as follows:
   - **Name** - New York Database Issues
   - **Table** - Incident [incident]
   - **Execution Order** - 50
   - **Group** - NY DB

   **Note:** The sys_user_group read ACL calls the SNCRoleUtil function. The function checks to see whether the group being reviewed contains either the admin role or security_admin role. The function allows the user to view the group only if the user has the same role. As a result, an itil user cannot assign an incident to a group that has the admin role or security_admin role (or whose parent has the role).

   - **Conditions** - "Location is New York" and "Category is Database".
To test the assignment rule, navigate to Incidents > Create New and populate the form with the following:

- **Location** - New York
- **Category** - Database
When you save the incident, the proper assignment group is added:
Initial diagnosis of incidents

Initial diagnosis of incidents is largely a human process, wherein the service desk looks at the information within the incident and communicates with the user to diagnose the problem in the incident.

To aid in the process, the service desk can consult the configuration management database, which contains information on hardware and software within a network and the relationships between them. CMDB can be populated in two ways: Discovery and Help the Help Desk. Discovery is available as a separate product, but Help the Help Desk is available with the base system.

Investigation and diagnosis of incidents

Like the initial diagnosis and investigation, investigation and diagnosis are largely human processes.

The service desk can continue to use the information provided within by the Incident form and the CMDB to solve the problem. Work notes can be appended to the incident as it is being evaluated, which facilitates communication between all of the concerned parties. These work notes and other updates can be communicated to the concerned parties through email notifications. The administrator may need to add a notification for the work notes list.

Check related incidents

Incidents have three ways to discover related incidents from the Incident form.

The three ways to discover related incidents from the Incident form are:

- Using the Show Related Incidents icon
- Using the Related Incidents related list
- Using the Business Services Map
Find related incidents

Dependency views can help find related incidents based on configuration items (CI).

If a configuration item is attached to an incident, clicking the map icon displays the dependency views map.

To view any tasks attached to the CI, click on the down arrow next to the CI and select **View Related Tasks**.

The figure below displays the options available for a CI.

![Figure 39: CI options](image)

This enables the service desk to find related tasks using the information gathered by the CMDB.

Use the related list

Other incidents by the same caller can also be found using the **Incidents by Same Caller** related list. You may need to add the related list to the form.

Show related incidents

Incidents can show related incidents with the Show Related Incidents icon.

The Show Related Incidents icon is a reference icon that appears beside the **Caller** field on the default incident form, when the field is populated. When clicked, it opens a browser window displaying a list of other incidents for same caller.

**Display the Show Related Incidents icon**

The Show Related Incidents icon displays other incidents related to the referenced record. Administrators can add this icon to any reference field by modifying the dictionary and adding the `ref_contributions=user_show_incidents` dictionary attribute. The icon appears only for users who have read or write access to this field.
Escalation of incidents

There are two types of incident escalators available by default. The platform has a built-in system of escalation rules which can ensure that incidents are handled speedily.

Table 132: Escalator table

<table>
<thead>
<tr>
<th>Escalator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Agreements</td>
<td>SLAs monitor the progress of the incident according to defined rules. As time passes, the SLA will dial up the priority of the incident, and leave a marker as to its progress. SLAs can also be used as a performance indicator for the service desk.</td>
</tr>
<tr>
<td>Set an inactivity monitor</td>
<td>The inactivity monitors prevent incidents from slipping through the cracks by generating an event, which in turn can create an email notification or trigger a script, when an incident has gone a certain amount of time without being updated.</td>
</tr>
</tbody>
</table>

Promote an incident

An incident can be promoted to a problem or change.

To promote an incident to a problem or change:

1. Open the Incident form for the incident to promote.
2. Right-click the form header.
3. Select Create Problem or Create Change.
The form for the new record appears. At this point, the new record is created. You do not need to manually save this record.
Incident closure

Closed incidents are filtered out of view but remain in the system for reference purposes. Closed incidents can be reopened if the user or service desk believes that it needs to be reopened. Incidents that are on the Related Incidents list of a problem can be configured to close automatically when the problem is closed through business rules.

If the knowledge check box is selected, a business rule is triggered by closing the incident, and a knowledge article is generated with the information from the incident. This is useful for knowledge management, and knowledge-centered support, reducing the number of repeat incidents by distributing the information related to the incident.

It is also possible to generate customer satisfaction surveys upon closure of incidents. This allows the service desk to gather information about their quality of service directly from the user.

Close multiple incidents

Service desk technicians with the list_updater role can close multiple incidents from an incident list and attach the same close notes to all of them.
In addition to the default method for closing multiple incidents, an administrator can create a UI action and make the feature available to users without the list_updater role.

Close incidents from a list

You can use the list view to close multiple incidents with the same close notes.

itil, itil_admin, or admin

1. Select the check box beside each incident to be closed.
2. Right-click the list header and select **Update Selected**.
3. Set the State to Closed and enter close notes in the Additional comments field.
4. Click **Update**.

Create a UI action to close multiple incidents

You can create a UI action for closing multiple incidents with the same close notes.

Role required: itil, itil_admin, or admin

1. Navigate to **System UIUI Actions**.
2. Create a UI action like the one in *Closing a UI Action*.

3. Click **Submit**.
   The new UI action appears in the Action choice list at the bottom of lists associated with the selected table.
Create a business rule to close multiple incidents

You can create a business rule for the UI action to close multiple incidents.

Role required: itil, itil_admin, or admin

1. Navigate to System Definition > Business Rules.
2. Create a business rule like the one in Create Business Rule.

Copy and paste the following code to create the new rule:

```javascript
current.active = 'false';
current.short_description = "TEST CLOSE NOTES";
current.incident_state = '7';
gs.addInfoMessage("Closing");
current.update();
```

Use a UI action to close multiple incidents

You can use a UI action to close multiple incidents with the same close notes.

Role required: itil, itil_admin, or admin

1. Navigate to Incident > Open.
2. Select the check box beside each incident to be closed.
3. Go to the Action choice list at the bottom of the list and choose CloseNotes.
4. Set the Incident state to Closed, enter close notes in the Additional comments field, and fill in any other relevant fields.
5. Click Update.
Close resolved incidents automatically

You can configure ServiceNow to automatically close tickets that have been in an Incident State of "Resolved" a specified number of days.

For example, if you set the property to 3 days, then 3 days after an incident is Resolved it will be automatically closed. Any update to the incident, for example an added comment from a Self Service user, would restart this 3-day clock.

If you set this property to zero days (the default), Incidents will not auto-close. To set the property, navigate to **System Properties > System**, and then look for the following property:

<table>
<thead>
<tr>
<th>The number of days after which a Resolved, un-updated incident will be automatically closed by a scheduled business rule.</th>
<th>The default, 0, means incidents will not be automatically closed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 40: Auto Close**

**Note:** If you have an inactivity monitor firing on your incident, it will reset this auto-close clock each time it fires, preventing your incident from being closed. To prevent this, put a Reset Condition on your inactivity monitor of **Incident state is not Resolved**.

Assign a user name to incidents closed automatically

A scheduled job called Autoclose Incidents runs the Incident Autoclose business rule to close incidents as described above. By default, it assigns the name of the administrator who is logged in when the Autoclose Incidents job runs.

**Note:** The Incident Autoclose rule (**System Definition > Business Rules > Incident autoclose**) should be set on the Incident [incident] table, not the Global [global] table, to avoid potential performance issues.

You can set a specific user name to show in the incident record as the Updated By user when the incident is closed automatically. Go to **System Scheduler > Scheduled Jobs > Autoclose Incidents** and add `fcRunAs=<user_name>` to the Scheduled Job record. The following example places System Administrator into the Updated By field when an incident is closed automatically:

```
fcrunAs=admin
fcsScriptName =incident autoclose
```

Track incident resolution information

You can track who resolved or closed an incident and when, and also update the business rule to populate those fields.
Fields

Incident Resolution Fields adds the following fields to the Incident table:

- **Resolved By** - A reference to the user table that is automatically populated on incident resolution or closure.
- **Resolved** - A date-time field that is automatically populated on incident resolution or closure.

![Figure 41: Incident Resolution Fields](image)

**Note:** The new fields are not visible on the form by default. Add them by configuring the form.

Business rules

Incident Resolution Fields updates an existing business rule and adds a new one.

The existing mark_closed business rule runs when the incident state changes to Closed. When Incident Resolution Fields is active, this rule automatically populates the **Resolved By** and **Resolved** fields.

**Note:** If the mark_closed business rule was previously changed, the plugin does not update it.

Incident Resolution Fields adds the mark_resolved business rule, which runs when the incident state changes to Resolved. The business rule automatically populates the **Resolved By** and **Resolved** fields.

Activate incident resolution fields

Incident Resolution Fields is active by default.

Attach configuration items to an incident

To aid in the incident management process, attach as much information as possible to the incident.

The service desk often deals with an incident related to one or more specific configuration items (CIs). If the configuration management team has populated the CMDB, the CI records may hold valuable information for the incident management team. You can associate configuration items to an incident to see how the incident affects other CIs with dependent relationships.

Associate configuration items to incidents

To associate configuration items to incidents from the Incident form, use either:

- The Configuration Item reference field.
- The Affected CI’s related list.
Use the Configuration Item field when there is a single, primary CI that is the cause of the incident, and the Affected CI's related list when multiple CIs are affected by the incident. For example, suppose a load-balancer in a data center is no longer operational. The Configuration Item field might have the specific server which has run out of memory, while the Affected CI related list contains the load-balancer, the data center, the servers which depend on that load-balancer, and business services that are impacted by the missing server.

These CIs can be associated manually using the fields, or can be attached using dependency views.

**Use dependency views to locate affected CIs**

The incident management team can use dependency views to identify CIs that are affected due to a configuration item that has caused an incident.

To locate affected CIs:

1. In the Incident record form, populate the **Configuration Item** field.

2. Click the dependency views icon ( üstü ) next to the **Configuration** field.

The system displays the configuration item.

3. Click on the down arrow next to the CI and select **View Affected CIs**.

The list of all the affected CIs displays in a new window.
4. To add an affected CI, select the CI and click on the down arrow next to it. Select Add Affected CI(s) from the list of options. The selected CI or CIs are now added to the incident.

Incident promotion

When the incident management team has determined that the cause of an incident is an error or widespread problem, the team should initiate the problem management process.

When the issue requires a change to be resolved, the team should initiate the change management process.

You can use a menu item on the Incident form to create a problem or change record and associate the incident with the new record. In this way, incidents can be used to easily create problems or changes.

Note: You cannot promote an incident to a problem or change if the incident already has an associated record of that type.

Incident resolution and recovery

After the incident is considered resolved, the incident state should be set to Resolved by the service desk. The escalators will be stopped and the service desk may review the information within the incident. After a sufficient period of time has passed, assuming that the user who opened the incident is satisfied, the incident state may be set to closed.

If an incident's cause is understood but cannot be fixed, the service desk can easily generate a problem from the incident, which will be evaluated through the problem management process. If the incident creates the need for a change in IT services, the service desk can easily generate a change from the incident, which will be evaluated through the change management process.

In addition to the base system incident management workflow, a Best Practice - Incident Resolution Workflow Plugin is available to bring the incident management workflow into better alignment with ITIL v3.

Perl API Incident

An object representation of an incident in the ServiceNow platform. Provides subroutines for querying, updating, and creating incidents.

Incident module

ServiceNow Perl API - Incident perl module

Creating an Incident

```perl
#!/usr/bin/perl -w
use ServiceNow;
use ServiceNow::Configuration;
use ServiceNow::ITIL::Incident;
my $CONFIG = ServiceNow::Configuration->new();
```
$CONFIG->setSoapEndPoint("https://demoi1.service-now.com/");
$CONFIG->setUserName("admin");
$CONFIG->setUserPassword("admin");

# setting incident values as a hash map in the insert argument
my $incident = ServiceNow::ITIL::Incident->new($CONFIG);
my $sys_id = $incident->insert(
  {
    "short_description" => "this incident was created from the Perl API",
    "category" => "hardware"
  });
print $sys_id . "\n"

# setting incident values by making setValue calls to the incident object
$incident = ServiceNow::ITIL::Incident->new($CONFIG);
$incident->setValue("short_description", "this incident was created from the Perl API - 2");
$incident->setValue("category", "hardware");
$sys_id = $incident->insert();
print $sys_id . "\n"

Querying for Incidents

#!/usr/bin/perl -w
use ServiceNow;
use ServiceNow::Configuration;
use ServiceNow::ITIL::Incident;

my $CONFIG = ServiceNow::Configuration->new();

$CONFIG->setSoapEndPoint("https://demoi1.service-now.com/");
$CONFIG->setUserName("admin");
$CONFIG->setUserPassword("admin");

my $incident = ServiceNow::ITIL::Incident->new($CONFIG);
$incident->addQuery("assignment_group", "Service Desk");
$incident->addQuery("category", "Hardware");
$incident->query();
while($incident->next()) {
    print "number= " . $incident->getValue("number") . "\n";
    print "sd= " . $incident->getValue("short_description") . "\n";
    print "opened_by Display Value= " . $incident->getDisplayValue("opened_by") . "\n";
    print "opened_by sys_id= " . $incident->getValue('opened_by');
}

Adding an attachment to a newly created Incident

#!/usr/bin/perl -w
use ServiceNow;
use ServiceNow::Configuration;
use ServiceNow::ITIL::Incident;

my $CONFIG = ServiceNow::Configuration->new();

$CONFIG->setSoapEndPoint("https://demoi1.service-now.com/");
$CONFIG->setUserName("admin");
Geneva    ServiceNow    IT Service Management

```perl
$CONFIG->setUserPassword("admin");
my $incident = ServiceNow::ITIL::Incident->new($CONFIG);
$incident->setValue("short_description", "test incident for attachment 2");
$incident->insert();
$incident->attach("/Users/davidloo/Desktop/test_files/number_test.xls");
```

**Constructor**

**new**

eval(\$incident = ServiceNow::ITIL::Incident->new($CONFIG);

Example:

```perl
$incident = ServiceNow::ITIL::Incident->new($CONFIG);
```

Takes a configuration object and manufactures an Incident object connected to the ServiceNow instance.

**Subroutines inherited from Task.pm**

- attach
- close
- create
- queryJournal
- reassign
- reopen

**Subroutines inherited from GlideRecord.pm**

- addQuery
- getValue
- getDisplayValue
- setValue
- next
- insert
- query
- update

**Subroutines**

**close**

close(number, hashmap);
Example:

```php
$incident->close($number)
```

Close an incident and update values described in the hash map passed in.

**reopen**

```php
reopen($number, hashmap);
```

Example:

```php
$incident->reopen($number);
```

Re-open a closed incident and update values described in the hash map passed in.

**createProblem**

```php
createProblem();
```

Create a problem ticket from an incident and associate it. Returns the sys_id of the newly created problem ticket.

**createChange**

```php
createChange();
```

Create a change request from an incident and associate it. Returns the sys_id of the newly created change request.

**New Call Wizard**

The Best Practice - New Call Wizard provides a wizard interface for the service desk to track information from a new call.

It allows a support technician to begin recording call information before making a decision about whether the caller is raising an incident or making a catalog request, which improves efficiency when opening tickets from calls.

**Use the new call wizard**

The new call wizard adds the New Call module to the Service Desk application.

To use the wizard:

1. Navigate to **Service Desk > New Call**.
2. Fill in the fields as appropriate.
Table 133: New Call Wizard form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller</td>
<td>A reference to the user table, for the user who is reporting the incident or making the request. For an incident, this is copied to the <strong>Caller</strong> field. For a request, this is copied to the <strong>Requested By</strong> field.</td>
</tr>
<tr>
<td>Location</td>
<td>A reference to the location table. If the user has a location associated, this field auto-populates. For both incidents and requests, this is copied to the Location field.</td>
</tr>
<tr>
<td>Comments</td>
<td>A multi-line text field. For an incident, this is copied to the <strong>Additional comments</strong> field. For a request, this is copied to the <strong>Special instructions</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Call Type</td>
<td>A choice field that determines what type of record the wizard creates. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Incident</td>
</tr>
<tr>
<td></td>
<td>• Request</td>
</tr>
</tbody>
</table>

© 2017 ServiceNow. All rights reserved.
### Create a form view

You can create a view of the Incident form using specific guidelines.

Follow the steps in _Create a view_ and include the following information:

- Make the view Name match the first parameter to `showQuickForm()` in the UI action.
- Ensure that the view contains the fields to be updated.

### Incident Management service improvements

The service desk can improve the incident management process using information gathered within the platform.

Much of the data is already stored within the incident record. More information can be gathered by enabling auditing, which allows for an accurate review of the history of the problem.

The following plugins allow you to gather additional incident information:

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric Definition</td>
<td>Define the key performance indicators to monitor within the system. With these metrics, and the information within the database, it is possible to generate reports that can then be added to homepages or automatically generated and distributed.</td>
</tr>
<tr>
<td>Database Views</td>
<td>Join tables for reporting purposes.</td>
</tr>
<tr>
<td>Vendor Ticketing</td>
<td>Add vendor data to incidents and integrate with Vendor Performance.</td>
</tr>
</tbody>
</table>

Using this information, it is possible to refine automatic rules such as the assignment rules, service level agreements, or inactivity monitors to better suit the service desk's unique environment.

Unnecessary incidents can be avoided by encouraging users to consult the knowledge base before creating an incident.
Incident promotion UI actions

Administrators can customize incident promotion behavior. The menu items Create Problem and Create Change are UI actions with that name. You can edit the UI action to customize the behavior of the menu item.

The Create Problem script carries over these fields from the the Incident form:

- short_description
- cmdb_ci
- priority

The syntax for carrying a field from the Incident form to the Problem form is:

\[ \text{prob.<fieldname> = current.<fieldname>} \]

The Create Change script carries over these fields from the Incident form:

- short_description
- description
- cmdb_ci
- priority

The syntax for carrying a field from the Incident form to the Change form is:

\[ \text{change.<fieldname> = current.<fieldname>} \]

If there is another process that incidents may be promoted to, such as if an incident should really be handled by Facilities Management, you can create a new UI action modeled after the Create Change and Create Problem UI actions to promote the incident to that table.

Copy attachment contents into a KB field

When a user searches for a knowledge base article from an incident, problem, or change request, the displayed article includes an Attach to Task button at the top right.

The word task is replaced by the name of the form where the search was initiated.

When you click this button, the article number and contents are copied into the Comments or Description field of the incident or problem record by default. Administrators can control the field where this information is placed.

Controlling the Attach to Task button

Administrators can customize the copying behavior with a property.

1. Navigate to Knowledge Base > Properties.
2. In the Other Knowledge Properties section, locate When attaching an article to an incident, copy the content into this field:

   ![When attaching an article to an incident, copy the content into this field:](image)

3. Specify a field into which to copy knowledge article content. This must be the Element name for the field, which is found by right-clicking the field name and selecting Configure Label.
By default, this property is set to **comment**, meaning that content will be copied into the **Additional comments** field. If you change the value to **work_notes**, the article content would be copied into the **Work notes** field.

The copy behavior is based on the data type of the destination field. If the destination field is a reference field to `kb_knowledge`, ServiceNow creates a reference link to the existing article rather than copying the article contents into the record.

**Notes/Limitations**

- The target field must be on the form to receive the data.
- You can (optionally) specify more than one target field, separated by commas. In this case, ServiceNow looks for each field in order and copies the contents into the first one it finds on the form. It does not copy the data into multiple fields.
- If the selected field does not exist on the form, ServiceNow checks for **Comments** and **Description** automatically.

### Incident ticketing integrations

An incident ticketing integration exchanges ticket data between your ServiceNow instance and a third party system.

The level of data and the direction of the data that is exchanged categorizes the integration as uni-directional or bi-directional.

The advantages of an incident ticketing integration include:

- Establishing a ticket number that provides a unique key between systems
- Synchronizing the systems so that notifications can be triggered
- Transforming data for more uniform processing
- Tracking ticket activity for accurate reporting

### Incident ticketing integration implementations

In a uni-directional integration, a third party system creates an incident ticket, passes data to ServiceNow, and receives a ticket ID back as confirmation. In a bi-directional integration, incident data is exchanged, synchronized, and updated while data is sent between the systems.

For both integration types, ServiceNow recommends implementing a record-based log of the individual transactions for a given time period. In the event of an outage, a record-based log can tell you what data was exchanged, how it was transformed, when processing occurred, and if there were any errors. Record-based logs also allow you to run all the validation and transformation logic away from the main form, helping performance.

Before implementing your project, develop an Integration Plan in which all of the implementation aspects and requirements are defined. Developing the Integration Plan will help you review the current data, plan for future requirements, and identify and sequence project tasks.

### Uni-directional incident ticketing integrations

Consider the requirements for an external, third party system to create tickets. Define what data needs to be sent at the least to create a ticket and what validation is required.

This way, a standard web service interface can be created and published. This integration responds with a ticket number on success, or with a structured error message for validation failures and processing issues. An advantage of this implementation is that you can publish once and reuse for multiple applications.
provided the additional integrations follow the integration specifications. ServiceNow recommends creating a dedicated account for each interface to provide accountability and report user statistics, and using a simple connectivity Point of Contact (POC).

**Integration plan contents**

- Firewall requirements
- Protocols to be used
- Required Middleware (for example, MS Biztalk)
- Error messages
- Validation Rules

**Example using basic authentication**

This implementation responds to the third party system with the ticket ID. The Import Set tables function as a staging area for your data.
Figure 42: Uni-directional ticketing integration using basic authentication

Example using import sets

An implementation variation for the inbound path would be to use the Import Set Tables as interface tables. In this example, the Incident_Interface Table stores a history of data as it was received and before the data was transformed. The destination Incident Table could store a history of how the incident has changed.
over time and who changed it. The transform scripts would process the import set and the Business Rules would run on the target table.

Figure 43: Uni-directional ticketing integration using import sets

Bi-directional incident ticketing integrations

A bi-directional integration exchanges data between your ServiceNow instance and a third party system so that incident ticket information is synchronized between the systems.
This integration is more complex than a uni-directional integration because it requires comprehensive definitions of field mappings, the standardization of where transformations takes place (inbound, outbound, or both), consideration of the ownership of reference data, and how updates are done on an ongoing basis. Error handling must also be implemented. All of these implementation aspects would be included in the Integration Plan.

While bi-directional implementations are developed on their own merits, it is possible to develop a framework in ServiceNow that can be reused (for example, data driven validation rules).

**Integration Plan Contents**

- Plan contents for all the aspects needed for a uni-directional integration
- State models for each organization
- Business Rule definitions for keeping the tickets synchronized
- Requirements to store history of individual transactions. If this is a requirement, consider creating a interface table which is populated prior to creating and updating the destination table.
- Transformation rules for all data elements
- Time lines for when reference data is transported to the information system. Include requirements to do any transformations before sending the data to and from each system.
- Statement of reference data ownership at all stages
- Update schema definitions

**Example using import sets and web services**

In this implementation, data authentication is done before insertion into the import set. Transform maps and scripts execute before the data reaches the Incident Table. The Incident Table is used to store the history of the incident records. For the outbound data path, the target table could trigger Business Rules before the data is queued in the outbound Web Service.
Example using import sets and the ECC queue

An implementation variation for the inbound path would be to use an import set table (in our example, the Incident Interface Table) to store historical data. Data validation is also done at this time, and you can clear exceptions with processing or manual intervention. The Incident Table uses a Third Party Information table as a reference, and messages are generated based on Business Rules.

Figure 44: Bi-directional ticketing integration using import sets and web services
Implementing this type of integration involves a web-service component for third-party applications for inbound data. The ECC Queue is recommended for outbound data.

Figure 45: Bi-directional ticketing integration using import sets and the ECC queue
View assign incident SNX

View an Incident List

1. Navigate to Incident and click the type of incident list you want to view, such as Open-Unassigned to see all incidents that do not have anyone working on them yet.
   
   What you will see when you click one of these is a list view with several columns, the most important being Number, Category, Priority, Incident state, and Assigned to.

2. You can add more columns by clicking the gear icon and selecting items from the Available box. If you want to see who resolved the incident, you should add Resolved by, for example.

Filter the List To narrow down the list, you can use a quick filter or create a more detailed filter query. In this example, all incidents that are waiting for user information where the priority is critical or high is shown.

Assign or Reassign the Incident: You can assign only one person to an Incident.

1. Click the incident number (in the Number column).
2. On the Incident form that appears, select a user in the Assigned to column by clicking the lookup icon.
3. If you want to narrow down the list of possible assignees and you know the group to which the assignee belongs, select the group in the Assignment group field first. Then select the user in the Assigned to field.

In this example, Beth Anglin, a member of the Service Desk, has been assigned to the incident:

![Assignment group: Service Desk Assigned to: Beth Anglin](image)

Figure 46: Incident Assignment Example

Perform Other Important Updates Other updates you might need to make include:

- Categorizing the incident by choosing a value from the Category field.
- Changing the Priority based on your organizational guidelines.
- Adding a Configuration item (CI), which is the service or item that is experiencing trouble.

Incident change SNX

1. From the form of the record in question, right click the form header bar.
2. Select Create Change.

Note: This option is not available for incidents that already have a change record.
The new Change form displays.
Incident problem SNX

1. From the form of the record in question, right click the form header bar.
2. Select **Create Problem**.

**Note:** This option is not available for incidents that already have a problem record.
The new Problem form displays. At this point, the problem record is created in the system. Users do not have to save the Problem form to create the record.
Password Reset and Password Change applications

The Password Reset application allows end users to use a self-service process to reset their own passwords on the local ServiceNow instance. Alternatively, your organization can implement a process that requires service-desk personnel to reset passwords for end users.
Password Change application

The Password Change application extends the Password Reset application by letting admins define how users change their passwords.

Types of process for Password Reset

• Self-service process: Users reset their password over the Internet using a browser. The self-service process is supported on all supported interfaces, including mobile devices.
• Service-desk password reset process: Users reset their passwords with the assistance of a service-desk employee, over the phone or in person.

Watch the video: Introducing Password Reset (Video).

Elements of a password reset process

Users with the password_reset_admin role can configure one or more password reset processes to connect the user names and passwords of a group of people with:

• A credential store where user credentials (like username/password) are securely stored
• One or more verifications that the admin specifies. For example, answering a personal question that only the user knows how to answer or responding to the system with a code number that is sent to a pre-authorized SMS device like a cellular phone or tablet.

Figure 47: Password reset process
Implementing a password reset process

- Plan to ensure that all applicable organizational guidelines, security policies, and areas of the organization are considered.
- Set up the password reset and password change processes according to the plan.
- In the service-desk model, service-desk employees monitor and reset passwords as needed.
- Monitor password reset activity to identify security threats and to ensure compliance with the organization’s password policy requirements.

Password Reset Orchestration Add-on

You can also subscribe to the Password Reset Orchestration Add-on plugin (com.glideapp.password_reset.addon.orchestration), which provides the ability to reset passwords on Active Directory and other credential stores. Orchestration is available as a separate subscription.

Password Change application

The Password Change application extends the Password Reset application by letting admins define how users change their passwords. Only a self-service process is supported and an admin must publish the URL to the password change form.

User process for changing a password

1. The user logs in to the instance.
2. The user selects the Change Password module or link from the user profile record.
3. On the Change Password page, the user selects the credential store where the password resides.
4. The user enters the old password and then enters a new password.
5. Workflows validate the old password and then implement the new password.
6. The system notifies the user that the password was changed.

Activate and configure the Password Reset application

Password Reset is available as a separate subscription from the rest of the ServiceNow platform and requires the Password Reset plugin. The plugin activates related plugins if they are not already active and includes example verifications. For more information, contact your ServiceNow account representative.

Role required: admin

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click **Activate**.

**Activate Password Reset Orchestration Add-on**

For additional functionality, including the ability to reset passwords on Active Directory, you must use the Password Reset - Orchestration Add-on plugin, which provides two credential store types that are not available in the basic Password Reset application. The Orchestration Add-on is available as a separate subscription. For more information, contact your ServiceNow account representative.

Role required: none

To purchase a subscription, contact your ServiceNow account manager. The account manager will arrange to have the plugin activated on your organization's production and sub-production instances, generally within a few days.

If you do not have an account manager, decide to delay activation after purchase, or want to evaluate the product on a sub-production instance without charge, follow these steps.

1. In the HI Service Portal, click **Service Catalog > Activate Plugin**.
2. Fill out the form.

<table>
<thead>
<tr>
<th>Target Instance</th>
<th>Instance on which to activate the plugin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>Date and time must be at least 2 business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific timezone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments.

| Reason/Comments | Any information that would be helpful for the ServiceNow personnel activating the plugin such as if you need the plugin activated at a specific time instead of during one of the default activation windows. |

3. Click **Submit**.

**Installed with Password Reset**

Several types of components are installed with the Password Reset plugin.

The Password Reset Orchestration Add-on provides additional options within the Password Reset application. However, no additional components are installed.

**Tables installed with Password Reset**

Password Reset adds the following tables.
<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Active Answer</td>
<td>Security questions and associated answers, in an encrypted state, that users have selected while going through the enrollment process.</td>
</tr>
<tr>
<td>Password Reset Active Question</td>
<td>Security questions that users have selected while going through the enrollment process.</td>
</tr>
<tr>
<td>Password Reset Activity Log</td>
<td>All password reset requests.</td>
</tr>
<tr>
<td>Password Reset Activity Monitor</td>
<td>Password reset lockout activity.</td>
</tr>
<tr>
<td>Password Reset Credential Store</td>
<td>Password reset credential stores that are available.</td>
</tr>
<tr>
<td>Password Reset Credential Store Parameters</td>
<td>User-created credential store parameters.</td>
</tr>
<tr>
<td>Password Reset Credential Store Types</td>
<td>Password reset credential store types that are available.</td>
</tr>
<tr>
<td>Password Reset Device Enrollment Code</td>
<td>Device enrollment codes that have been sent to users during SMS code enrollment.</td>
</tr>
<tr>
<td>Password Reset Devices</td>
<td>User SMS devices that are in a state of verified.</td>
</tr>
<tr>
<td>Password Reset Enrollment for Verification</td>
<td>Information about user enrollment by verification.</td>
</tr>
<tr>
<td>Password Reset Enrollment Snapshot</td>
<td>Snapshot of user enrollment by verification. This table is regenerated daily by a scheduled job named Password Reset Enrollment Snapshot.</td>
</tr>
<tr>
<td>Password Reset Extension Type</td>
<td>Extension types that are available.</td>
</tr>
<tr>
<td>Password Reset Identification Type</td>
<td>Password reset identification types that are available.</td>
</tr>
<tr>
<td>Password Reset Process</td>
<td>Password reset processes that are available.</td>
</tr>
<tr>
<td>Password Reset Process Credential Store</td>
<td>Credential stores and the associated password reset processes that the application is using.</td>
</tr>
</tbody>
</table>
### Table name

<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Process User Group [pwd_map_proc_to_group]</td>
<td>Groups and the associated password reset processes that the application is using.</td>
</tr>
<tr>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Verifications and the associated password reset processes that the application is using.</td>
</tr>
<tr>
<td>Password Reset Question [pwd_question]</td>
<td>Questions that the application uses for security question verifications.</td>
</tr>
<tr>
<td>Password Reset Request [pwd_reset_request]</td>
<td>Information about password reset requests.</td>
</tr>
<tr>
<td>Password Reset SMS Verification Code [pwd_sms_code]</td>
<td>SMS verification codes that have been sent to users for a password reset.</td>
</tr>
<tr>
<td>Password Reset User Lockout [pwd_user_lockout]</td>
<td>Users that are locked out of password reset.</td>
</tr>
<tr>
<td>Password Reset Verification [pwd_verification]</td>
<td>Verifications that are available.</td>
</tr>
<tr>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>User-created verification parameters.</td>
</tr>
<tr>
<td>Password Reset Verification Type [pwd_verification_type]</td>
<td>Password reset verification types that are available.</td>
</tr>
</tbody>
</table>

### Roles installed with Password Reset

Roles represent admins who configure Password Reset and users who support other users with Password Reset.

Password Reset plugin adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password reset administrator [password_reset_admin]</td>
<td>Sets up password reset and password change.</td>
</tr>
<tr>
<td>service desk agent [password_reset_service_desk]</td>
<td>Resets passwords on behalf of users, tracks password reset requests, and views logs.</td>
</tr>
<tr>
<td>credentials manager [password_reset_credential_manager]</td>
<td>Determines which credential stores are valid for use with password reset.</td>
</tr>
</tbody>
</table>

### Business rules installed with password reset

The business rules for the password reset process ensure security and proper operation.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify Account Lookup Script</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Checks if the account lookup script has the correctly named function.</td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Credential Store [pwd_cred_store]</td>
<td>Checks if the credential store is part of an active process before allowing deletion.</td>
</tr>
<tr>
<td>Send SMS code</td>
<td>Password Reset Device Enrollment Code [pwd_dvc_enrollment_code]</td>
<td>Sends an enrollment code to a device.</td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Identification Type [pwd_identification_type]</td>
<td>Prevents an identification type from being deleted if it is part of an active process.</td>
</tr>
<tr>
<td>Single credential store per process</td>
<td>Password Reset Process Credential Store [pwd_map_proc_to_cred_store]</td>
<td>Prevents having more than one credential store per process.</td>
</tr>
<tr>
<td>Deactivate process with no group</td>
<td>Password Reset Process User Group [pwd_map_proc_to_group]</td>
<td>Deactivates the process if it does not apply to all users or if the groups associated with it are removed.</td>
</tr>
<tr>
<td>Check unique verifications</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Prevents a verification from being assigned multiple times to a specific password reset process.</td>
</tr>
<tr>
<td>Deactivate process with no verification</td>
<td>Password Reset Process Verification [pwd_map_proc_to_verification]</td>
<td>Deactivates the process if the verifications associated with it are removed.</td>
</tr>
<tr>
<td>Password Reset Validate Auto-generate</td>
<td>Password Reset Process [pwd_process]</td>
<td>Checks that either Email password or Display password is selected when the Auto-generate password check box is selected.</td>
</tr>
<tr>
<td>Validate Process</td>
<td>Password Reset Process [pwd_process]</td>
<td>Verifies that a password reset process is configured correctly.</td>
</tr>
<tr>
<td>Update proc_to_cred_store</td>
<td>Password Reset Process [pwd_process]</td>
<td>Enforces a one-to-one relation between a password reset process and a credential store.</td>
</tr>
<tr>
<td>Set new record flag</td>
<td>Password Reset Process [pwd_process]</td>
<td>Sets a new record flag for the client to take appropriate action.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Validate Security Question</td>
<td>Password Reset Question [pwd_question]</td>
<td>Validates rules for security questions such as no duplicates or empty questions.</td>
</tr>
<tr>
<td>Password Reset Activity Monitor</td>
<td>Password Reset User Lockout [pwd_user_lockout]</td>
<td>Creates an event when the number of users locked out of password reset during a specific interval exceeds the threshold value.</td>
</tr>
<tr>
<td>Add default parameters QA verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Generates parameters for Security Question verifications if none are specified.</td>
</tr>
<tr>
<td>Add params personal confirm verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Generates parameters for personal data confirmation verifications if none are specified.</td>
</tr>
<tr>
<td>Add params personal verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Generates parameters for personal data verification if none are specified.</td>
</tr>
<tr>
<td>Prevent against deletion</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Prevents a verification from being deleted if it is part of an active process.</td>
</tr>
<tr>
<td>Add default parameters SMS verification</td>
<td>Password Reset Verification [pwd_verification]</td>
<td>Generates parameters for SMS code verifications if none are specified.</td>
</tr>
<tr>
<td>Parameter Names Cannot Be Updated</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Prevents parameter name changes.</td>
</tr>
<tr>
<td>Personal Data Param Validation</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Checks that a column exists in the sys_user table for the parameter used in a personal data verification.</td>
</tr>
<tr>
<td>Personal Data Confirm Param Validation</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Checks that a column exists in the sys_user table for the parameter used in a personal data confirmation verification.</td>
</tr>
<tr>
<td>SMS Code Param Validation</td>
<td>Password Reset Verification Param [pwd_verification_param]</td>
<td>Checks for valid parameters in SMS code verifications.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VerifyAutoEnroll</td>
<td>Password Reset Verification Type</td>
<td>Checks if auto-enroll is selected and ensures that an enrollment check script is provided.</td>
</tr>
</tbody>
</table>

UI macros and UI scripts installed with Password Reset

Password Reset plugin adds the following UI macros.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwd_enrollment_form_title</td>
<td>A Jelly macro function that prints the title for the enrollment form. A verification ID is mandatory.</td>
</tr>
<tr>
<td>pwd_enroll_questions_ui</td>
<td>A UI for question and answer security validation enrollment.</td>
</tr>
<tr>
<td>pwd_enroll_questions_ui_js</td>
<td>JavaScript code that requires server-side data for security question and answer enrollment.</td>
</tr>
<tr>
<td>pwd_enroll_sample_ui</td>
<td>A sample UI macro for enrollment for Mock Verification Type.</td>
</tr>
<tr>
<td>pwd_enroll_sms_ui</td>
<td>A UI for SMS verification enrollment.</td>
</tr>
<tr>
<td>pwd_verify_personal_data_confirmation_ui</td>
<td>A UI for verifying personal data confirmation.</td>
</tr>
<tr>
<td>pwd_verify_personal_data_ui</td>
<td>A UI for verifying personal data.</td>
</tr>
<tr>
<td>pwd_verify_questions_ui</td>
<td>A UI for verifying questions.</td>
</tr>
<tr>
<td>pwd_verify_simple_ui</td>
<td>An input section for a simple verification method. This is a single input field.</td>
</tr>
<tr>
<td>pwd_verify_sms_ui</td>
<td>A UI for SMS verification.</td>
</tr>
</tbody>
</table>

UI scripts installed with Password Reset

Several UI scripts are also installed, which can be referenced from a UI macro.

You can create a UI script and reference the script from a UI macro or UI page by using a `<g:include_script>` Jelly tag. For example, the following shows how the `pwd_enroll_questions_ui` script can be referenced by the `pwd_enroll_questions_ui` UI macro, where `[UI Script Name]+".jsdbx"` is the name of the script:

```
<g:include_script src="pwd_enroll_questions_ui.jsdbx" /> 
```

By referencing an external script, you can maintain separation between client JavaScript code and Jelly code, which simplifies maintenance. The following are installed scripts that you can use with password reset UI macros.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwdWfManager</td>
<td>A helper class to handle workflow activities and post-processing.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>pwd_csrf_common_ui_script</td>
<td>A common UI script for handling a Cross-site Request Forgery (CSRF).</td>
</tr>
<tr>
<td>pwd_enrollment_submit_event</td>
<td>A UI script for an enrollment submit event.</td>
</tr>
<tr>
<td>pwd_enroll_questions_ui</td>
<td>JavaScript code for the pwd_enroll_questions_ui UI macro.</td>
</tr>
<tr>
<td>pwd_enroll_sample_ui</td>
<td>Included sample client JavaScript for the pwd_enroll_sample_ui UI macro.</td>
</tr>
<tr>
<td>pwd_enroll_sms_ui</td>
<td>An SMS enrollment UI script.</td>
</tr>
</tbody>
</table>

Workflows installed with Password Reset

The ServiceNow platform installs these password reset workflows that you can use as examples to create your own.

Password reset workflows

The following password reset workflows are used for connecting to a credential store.

Table 137: Credential store password reset workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Reset - Local ServiceNow</td>
<td>The current (local) instance.</td>
</tr>
<tr>
<td>Pwd Reset - Master</td>
<td>The password reset master workflow.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Fatal</td>
<td>An example workflow to use in password reset testing to simulate a fatal error. No retries.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Non Fatal</td>
<td>An example workflow to use in password reset testing to simulate a non-fatal error.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Success</td>
<td>An example workflow to use in password reset testing to simulate a successful completion.</td>
</tr>
</tbody>
</table>

Connection test workflows

The following workflows are used for performing a connection test.

Table 138: Credential store connection test workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Connection Test - Local SN</td>
<td>Workflow for local instance connection test.</td>
</tr>
<tr>
<td>Pwd Connection Test - Master</td>
<td>A master workflow to test credential store connectivity.</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Failure</td>
<td>An example credential store connection test that simulates a failed connection.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Success</td>
<td>An example credential store connection test that simulates a successful connection.</td>
</tr>
</tbody>
</table>

**Get user unlock state workflows**

The following workflows are used to get a user's unlock state.

Table 139: Credential store user unlock state workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Get Lock State - Local SN</td>
<td>Workflow to get a user's lock state for the local instance.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Master</td>
<td>A master workflow to get a user's lock state.</td>
</tr>
</tbody>
</table>

**Unlock user workflows**

The following workflows are used to unlock a user.

Table 140: Credential store unlock user workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Unlock Account - Local SN</td>
<td>Workflow to unlock a user's account for a local instance.</td>
</tr>
<tr>
<td>Pwd Unlock Account - Master</td>
<td>A master workflow to unlock a user's account.</td>
</tr>
</tbody>
</table>

**Script includes installed with password reset**

**Script includes**

Password reset adds the following script includes.

Table 141: Script includes for password reset

<table>
<thead>
<tr>
<th>Script name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdAjaxSMSPublicProcessor</td>
<td>Processes AJAX SMS code generation requests.</td>
</tr>
<tr>
<td>PwdVerifySimpleProcessor</td>
<td>Processes the verification form request, and returns a value indicating if the user was verified.</td>
</tr>
<tr>
<td>PwdVerifyPersonalDataProcessor</td>
<td>Compares the answers provided by the user with the data in the system.</td>
</tr>
<tr>
<td>Script name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PwdAjaxVerifyIdentityServiceDesk</td>
<td>Supports the create request UI for the service desk module in password reset.</td>
</tr>
<tr>
<td>PwdAjaxEnrollmentProcessor</td>
<td>Enrolls the user for the specified verification.</td>
</tr>
<tr>
<td>PwdDefaultAutoGenPassword</td>
<td>Generates a password based on a random word and four digits.</td>
</tr>
<tr>
<td>PwdTestCredStoreConnectionWorker</td>
<td>Provides the credential store connection test.</td>
</tr>
<tr>
<td>PwdVerifyQuestionsProcessor</td>
<td>Processes user input for security question verifications.</td>
</tr>
<tr>
<td>PwdAjaxPublicEnrollSMS</td>
<td>Sends the details of the subscription or mobile from the user profile.</td>
</tr>
<tr>
<td>PwdAjaxRequestProcessor</td>
<td>Processes AJAX requests for the Password Reset application.</td>
</tr>
<tr>
<td>PwdAjaxSMSProcessor</td>
<td>Processes AJAX SMS code generation requests.</td>
</tr>
<tr>
<td>PwdQuestionsEnrollmentCheck</td>
<td>Checks whether the user is enrolled with the specified verification.</td>
</tr>
<tr>
<td>PwdAlwaysEnrolled</td>
<td>Checks if the user is enrolled. This is a default script that always returns true for isEnrolled().</td>
</tr>
<tr>
<td>PwdVerificationParameterUtility</td>
<td>Provides methods for various verification parameter related business rules.</td>
</tr>
<tr>
<td>PwdEnrollSMSProcessor</td>
<td>Processes enrollment for SMS code verifications.</td>
</tr>
<tr>
<td>PwdEnrollQuestionsProcessor</td>
<td>Processes enrollment for question and answer for verifications.</td>
</tr>
<tr>
<td>PwdMockIsEnrolled</td>
<td>Checks whether the user is enrolled in a specific verification.</td>
</tr>
<tr>
<td>PwdAjaxEnrollSMS</td>
<td>Manages mobile device subscriptions for SMS code verifications.</td>
</tr>
<tr>
<td>PwdEnrollSampleProcessor</td>
<td>Processes enrollment for sample verifications.</td>
</tr>
<tr>
<td>PwdVerifyPersonalDataConfirmationProcess</td>
<td>Verifies that the answer was accepted by the user.</td>
</tr>
<tr>
<td>PwdAjaxVerifyIdentity</td>
<td>Verifies the information provided by the user during the first stage of a password reset request.</td>
</tr>
<tr>
<td>PwdSMSEnrollmentCheck</td>
<td>Checks whether a user is enrolled in a specific verification. Returns a boolean value indicating if the user is enrolled.</td>
</tr>
<tr>
<td>PwdVerifyUser</td>
<td>Checks if user exists.</td>
</tr>
<tr>
<td>Script name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PwdDefaultUserAccountLookup</td>
<td>Utilizes a user's sys_user id to find their account in a credential store. This is the default script for user account lookup. The default mapping is to use user_name as the account name.</td>
</tr>
<tr>
<td>PwdNotificationHelper</td>
<td>Provides methods for common notification related tasks.</td>
</tr>
<tr>
<td>PwdAjaxWFRequestProcessor</td>
<td>Processes workflow related tasks for the Password Reset application.</td>
</tr>
<tr>
<td>PwdVerifySMSProcessor</td>
<td>Processes user input for SMS code verification.</td>
</tr>
<tr>
<td>PwdAjaxVerifyProcessor</td>
<td>Checks if the user is verified by all verification methods.</td>
</tr>
<tr>
<td>PwddIdentifyViaEmail</td>
<td>Looks up users by their email.</td>
</tr>
<tr>
<td>PwdPostProcessor</td>
<td>Executes actions after the process completes.</td>
</tr>
<tr>
<td>PwddIdentifyViaUsername</td>
<td>Looks up users by their user name. This is an identity extension.</td>
</tr>
</tbody>
</table>

SOAP messages installed with Password Reset

Password Reset adds the following SOAP messages.

Table 142: SOAP messages for Password Reset

<table>
<thead>
<tr>
<th>SOAP Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Password</td>
<td>When the Orchestration Add-on plugin is active, the system can use the SOAP protocol to change passwords on remote credential stores such as a remote ServiceNow instance.</td>
</tr>
<tr>
<td>Password Reset Request</td>
<td>When the Orchestration Add-on plugin is active, the system can use the SOAP protocol to reset passwords on remote credential stores such as a remote ServiceNow instance.</td>
</tr>
</tbody>
</table>

Integrate Password Reset with a CMS integration

You can configure a site in the ServiceNow content management (CMS) application to define a single-site access point that includes the password reset service.

Role required: content_admin

For example, you may want to create an employee self-service site that provides password reset service. Each password reset process requires a separate CMS page.

1. Navigate to Content Management > Specialty Content > iFrames and create a new iFrame record.
2. Go to Content Management > Sites and create a site that has no login page.

3. Go to Content Management > Pages and create a password reset page.
4. Enter the site you created, for this example, Password Reset Self-Service, in the **Content site** field.
5. Right-click the form header and click **Save**.
6. Click **Edit Page** under **Related Links** and then click **Add content**.
7. Under the **Content Blocks** section, select the iframe added in the previous steps. Add any additional content.
8. Click **Update**.

### Credential stores

Credential stores, such as the User [sys_user] table or an Active Directory server, store user information such as user names and passwords, that can be used as login credentials.

Users with the password_reset_admin or password_reset_credential_manager role can create and modify connections to credential stores.

**Note:** If you have subscribed to the Password Reset Orchestration Add-on and need to connect to an Active Directory credential store or another directory-like service that relies on the SOAP protocol, complete the procedures listed in *Remote credential stores* on page 442 before you create, test, or delete credential stores.
Remote credential stores

Remote credential stores provide a tool for managing remote user names and passwords. A remote credential store refers to any credential store other than the local ServiceNow instance.

Remote credential stores, such as Active Directory, manage user names and passwords outside of the local ServiceNow instance. A remote credential store can also be a remote ServiceNow instance, a UNIX or Linux server, or any other directory-like service. The Password Reset Orchestration Add-on plugin is required to be able to connect to remote credential stores.

Configure password reset for Active Directory

When the Orchestration Add-on plugin is activated, password reset can change passwords on an Active Directory credential store by referencing an Active Directory user role with the appropriate password change privileges.

Active Directory must have a user role with the following privileges:

Descendent User objects:
- Reset password
- Read/Write pwdlastset
- Read/Write UserAccountcontrol
- Write Account Restrictions
- Read/Write lockouttime
- Read MemberOf

Descendent Group objects:
- Read Members
- Read MemberOf

1. Install MID Server on a Windows computer that can connect to Active Directory.
2. Configure the MID Server.
3. In the ServiceNow instance, navigate to Orchestration > Credentials.
4. Click New and then complete the form with the following values for the credential:
   - Type: Select Windows.
   - User name: Enter your Active Directory domain user. For example, domain\admin.
   - Password: Enter your Active Directory domain user password.
   - Applies to: Select the MID Server that is used to access the Active Directory server.
5. Click Submit.
6. Create a credential store for Active Directory.

Set up SOAP credentials for password reset

When the Orchestration Add-on plugin is activated, the ServiceNow platform can use the SOAP protocol to interact with remote credential stores such as a remote ServiceNow instance.

Role required: admin or web_service_admin

1. Navigate to System Web Services > Outbound > SOAP Message.
2. Click Password Reset Request.
3. From the Soap Message Functions related list, configure both the password_reset and sys_user_get_record functions by completing the following steps.
   a) In Basic auth user ID, enter the user ID for the remote system user who has privileges to update records on the User [sys_user] table.
b) In **Basic auth user password**, enter the password for the remote system user who has privileges to update records on the User \([\text{sys}_\text{user}]\) table.

c) Select **Use basic auth**.

d) Click **Update**.

You do not need to enter a value in the **SOAP endpoint** field. The field shows the name of the ServiceNow instance used for password reset.

**Configure the connection to a credential store**

You specify a credential store to access during the password reset or password change process and other settings that control the process.

Role required: password_reset_admin or password_reset_credential_manager

---

**Note:** The Password Reset Windows Application supports only Active Directory (AD) credential stores.

---

1. Navigate to **Password Reset > Credential Stores**.
2. Click **New**, enter a unique and meaningful **Name** and **Description**, and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>You can use credential store types (templates that provide a desired set of capabilities). Credential stores inherit the functionality of the credential store type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application supports only <strong>AD Credential Store</strong>.</td>
</tr>
<tr>
<td></td>
<td>Installed credential store types:</td>
</tr>
<tr>
<td></td>
<td>🔹 <strong>Local ServiceNow Instance</strong> installed with Password Reset.</td>
</tr>
<tr>
<td></td>
<td>🔹 <strong>AD Credential Store</strong> installed with the Orchestration Add-on.</td>
</tr>
<tr>
<td></td>
<td>🔹 <strong>Remote (SOAP) ServiceNow</strong> installed with the Orchestration Add-on.</td>
</tr>
<tr>
<td>Auto-generate password</td>
<td>Script include that generates a temporary password for use during the reset process.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select the <strong>Enforce history policy</strong> check box, then you must specify a value for <strong>Auto-generate password</strong>.</td>
</tr>
<tr>
<td>Enforce history policy</td>
<td>To enforce the history policy that is configured for the credential store:</td>
</tr>
<tr>
<td></td>
<td>1. Select the <strong>Enforce history policy</strong> check box.</td>
</tr>
</tbody>
</table>
2. Follow the procedure that appears after this table.

**Note:** Active Directory domains can be configured to include a history policy that ensures that users do not reuse passwords. For example, the history policy might be configured to not allow the user to reuse any of the previous three passwords when resetting a password.

This option appears only if you select a credential store **Type of AD Credential Store**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>URL or IP address of the credential store that contains the user credential (for example, user names and passwords).</td>
</tr>
<tr>
<td>User account lookup</td>
<td>Script include that maps the user ServiceNow platform ID to the user credential store ID. A default script, PwdDefaultUserAccountLookup, returns the user ServiceNow platform user name.</td>
</tr>
<tr>
<td>Password rule hint</td>
<td>Text that is displayed to the user to help the user to create a password that meets the requirements that the Password rule script enforces. <strong>Note:</strong> The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).</td>
</tr>
<tr>
<td>Password rule</td>
<td>Client script that validates the password that the user enters. The script is invoked when the user enters a new password and clicks <strong>Password Reset</strong>. You can use the script to enforce password strength/complexity requirements.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

If you selected the **Enforce history policy** check box, then follow these steps:

1. Open the associated password reset process definition: **Password Reset > Processes**.
2. On the Details tab of the Password Reset Process form, clear the **Auto-generate password** check box and then save the process definition.
3. On the domain controller, set **Password Aging** (MIN_PASSWORD_AGE) to zero.
4. On the domain controller, set the history policy to twice the desired number of passwords. For example, to enforce that the last three passwords are not repeated, set the history policy to six.

**Note:** This is why you must set the history policy to twice the normal value: To enforce the history policy that is configured for the credential store, the system auto-generates a new temporary password for each reset cycle. The system auto-generates the temporary password even though you have cleared the **Auto-generate password** check box on the Password
Reset Process form. Because the user immediately replaces the temporary password with a new password, two passwords are created for each reset cycle.

Test the connection to a credential store

You test the connection to a credential store after you configure a new credential store or when users experience problems that might involve the connection.

Role required: password_reset_admin or password_reset_credential_manager

A connection test workflow is needed to test a connection.

1. Navigate to Password Reset > Credential Stores and then open a credential store.
2. In the header bar, click Save & Test Connection.
   A progress page displays the result of the test.

Delete the connection to a credential store

Before you delete the connection to a credential store, check all password reset processes to ensure that the credential store is not in use. If the credential store is being used by a process, update the process before deleting the credential store.

Role required: password_reset_admin or password_reset_credential_manager

1. Navigate to Password Reset > Credential Stores and then select the check box for the credential store.
2. In the Actions choice list, select Delete.

Credential store types

A credential store type is a set of workflows that specify how to connect to credential stores that contain information such as user names and passwords.

For information on how to use credential store types, see Remote credential stores on page 442.

A credential store type requires a subflow that defines how to connect to the store, and can include an optional subflow that defines how to test the connection. The Pwd reset – AD and Pwd Reset - Local subflows are available as models for defining custom connection workflows.
Figure 48: Pwd Reset Local sub workflow

The Pwd Connection Test - Local SN subflow is available as a model for defining custom workflows for testing connections.
Installed credential store types
The ServiceNow platform installs certain example credential store types that you can use as models to create your own credential store types.

Table 143: Credential store types

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ServiceNow instance</td>
<td>Represents the current (local) ServiceNow instance.</td>
</tr>
<tr>
<td>AD Credential Store</td>
<td>Represents Active Directory credential store. Installed with the Orchestration Add-on.</td>
</tr>
<tr>
<td>Remote (SOAP) ServiceNow</td>
<td>Represents a remote ServiceNow instance. Installed with the Orchestration Add-on.</td>
</tr>
</tbody>
</table>

Workflows installed with Password Reset
The ServiceNow platform installs these password reset workflows that you can use as examples to create your own.

Password reset workflows

The following password reset workflows are used for connecting to a credential store.
Table 144: Credential store password reset workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Reset - Local ServiceNow</td>
<td>The current (local) instance.</td>
</tr>
<tr>
<td>Pwd Reset - Master</td>
<td>The password reset master workflow.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Fatal</td>
<td>An example workflow to use in password reset testing to simulate a fatal error. No retries.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Non Fatal</td>
<td>An example workflow to use in password reset testing to simulate a non-fatal error.</td>
</tr>
<tr>
<td>Pwd Reset - Mock Success</td>
<td>An example workflow to use in password reset testing to simulate a successful completion.</td>
</tr>
</tbody>
</table>

Connection test workflows

The following workflows are used for performing a connection test.

Table 145: Credential store connection test workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Connection Test - Local SN</td>
<td>Workflow for local instance connection test.</td>
</tr>
<tr>
<td>Pwd Connection Test - Master</td>
<td>A master workflow to test credential store connectivity.</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Failure</td>
<td>An example credential store connection test that simulates a failed connection.</td>
</tr>
<tr>
<td>Pwd Connection Test - Mock Success</td>
<td>An example credential store connection test that simulates a successful connection.</td>
</tr>
</tbody>
</table>

Get user unlock state workflows

The following workflows are used to get a user's unlock state.

Table 146: Credential store user unlock state workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Get Lock State - Local SN</td>
<td>Workflow to get a user's lock state for the local instance.</td>
</tr>
<tr>
<td>Pwd Get Lock State - Master</td>
<td>A master workflow to get a user's lock state.</td>
</tr>
</tbody>
</table>

Unlock user workflows

The following workflows are used to unlock a user.
Table 147: Credential store unlock user workflow

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pwd Unlock Account - Local SN</td>
<td>Workflow to unlock a user's account for a local instance.</td>
</tr>
<tr>
<td>Pwd Unlock Account - Master</td>
<td>A master workflow to unlock a user's account.</td>
</tr>
</tbody>
</table>

Create a credential store type

You can create a credential store type.

Role required: password_reset_admin or password_reset_credential_manager

1. Navigate to **Password Reset > Extensions > Credential Store Types**.
2. Click **New**, enter a unique and meaningful **Name** and **Description**, and then fill in the form.

**Note:** You may need to configure the form to see the Get user lock state workflow and the Unlock user workflow.

Table 148: New credential store fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password reset workflow</td>
<td>Subflow that defines the credential store processing. <strong>Password reset workflows</strong> are available to use as models. You need to provide scripts for each of the activities defined for the subflow.</td>
</tr>
<tr>
<td>Connection test workflow</td>
<td>Subflow that defines how to test the connection. <strong>Connection test workflows</strong> are available to use as models. If you create a connection test subflow, you need to provide scripts for each of the activities defined for the subflow.</td>
</tr>
<tr>
<td>Get user lock state workflow</td>
<td>Subflow that defines how to get the user lock state. <strong>Get user lock state workflows</strong> are available to use as models. You need to provide scripts for each of the activities defined for the subflow.</td>
</tr>
<tr>
<td>Unlock user workflow</td>
<td>Subflow that defines how to unlock a user. <strong>Unlock user workflows</strong> are available to use as models. If you create a connection test subflow, you need to provide scripts for each of the activities defined for the subflow.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

Password Reset Windows Application

The Password Reset Windows Application enables a user who forgets their password or is locked out of a Windows computer to reset the password directly from the Windows login screen.
How the Password Reset Windows Application works

Administrators download and run an EXE or MSI file to install or distribute the application to user computers. The application installs a link on the Windows login screen. The user clicks the link (Forgot Password? in the example) and is then guided through the process of resetting the password.

Restrictions on the Password Reset Windows Application

- For some verification types, you can use only one verification. Custom verifications are not supported. See Password Reset verification types on page 464 for details.
- The Password Reset Windows Application supports newline characters in the Password rule hint text. Other formatting is not supported (bold, underline, hyperlink, and so on). See Configure the connection to a credential store on page 443.
- Custom UI macros configured on the Process > Advanced page are not supported (for example, entry, success, or failure macros). The system displays only the default success and failure messages.

Password Reset Windows Application installation requirements

Review the guidelines to ensure that the Password Reset Windows Application will work on your instance.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required hardware</td>
<td>• 1 GHz or faster processor</td>
</tr>
<tr>
<td></td>
<td>• 512 MB of RAM</td>
</tr>
<tr>
<td></td>
<td>• 10 MB of available hard disk space (x86)</td>
</tr>
<tr>
<td></td>
<td>• 10 MB of available hard disk space (x64)</td>
</tr>
<tr>
<td>Required software</td>
<td>• Microsoft .Net Framework v4.5.2 and up</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Visual C++ Redistributable Package</td>
</tr>
<tr>
<td></td>
<td>for Visual Studio 2013</td>
</tr>
</tbody>
</table>

© 2017 ServiceNow. All rights reserved.
## Supported operating systems
- Windows 7
- Windows 8.1
- Windows 10

## Supported processor architecture
- X86
- X64

## Supported network architecture
- Password Reset Windows Application clients must have direct access to both the Internet and the ServiceNow instance where the Password Reset Windows Application is configured.
- To reset an AD password, the client must be on the corporate network.

---

### Download and install the Password Reset Windows Application

Download the installer and installation instructions from the Knowledge Base. The installer uninstalls any earlier version of the Password Reset Windows Application.

`password_reset_admin, admin`

1. Log in to Knowledge and go to KB0542328.
2. Download the installer and the associated installation instructions.
   - Use the EXE file to install the application either from the command line or using a wizard.
   - Use the MSI file to install the application on multiple computers over a network.

### Plan your Password Reset strategy

To ensure security and efficiency, take the time to plan your Password Reset implementation.

Role required: `password_reset_admin` or `admin`

1. Understand groups and roles.

   Analyze and assess how members of each group in your organization access the system. For example, if members of the sales group primarily access the system remotely, consider using a stronger method or multiple methods to verify each user's identity.

   Identify user roles that have access to critical information and resources. For example, stronger verifications may be required for roles that have access to employee data, accounting information, or network configurations.

   Based on your analysis of groups and roles, determine the number and variety of verifications needed for the different password reset processes.

2. Consider how credentials should be managed.

   Determine whether single sign-on is enabled with the type of directory service or other credential store used. If the directory service is configured for single sign-on, consider increasing the level of security by using multiple methods to verify a user's identity. A compromised user name and password can easily allow access to associated systems in a single sign-on environment.
3. Consider how users will be enrolled for the password reset process. For example, will enrollment in the password reset program be optional or required? How will users be notified to enroll in the program? Will users be auto-enrolled in the program? The answers to these questions will help you determine the appropriate verification types to use.

4. Consider which password reset options to offer to users. Will users reset their own passwords from a self-service module or will the service-desk reset passwords on behalf of users? If the organization uses single sign-on, how will users reset their password if they are unable to log on? Which options are available to users working off-site? To make the Password Reset application with Orchestration available to all users publicly, create a new Password Reset Process only for this purpose and make it accessible to Public. Watch a video on resetting a user’s password: Resetting User Passwords (Video).

Configure your Password Reset or Password Change process

To implement the process, you configure credentials, verifications, and users.

Role required: password_reset_admin or admin

1. Be sure to Plan your Password Reset strategy on page 451.
2. Create the credential store record for user names and passwords that are managed.

   Note: For LDAP integrations: If the Active Directory settings require users to reset the password when logging in, the results depend on the password reset plugin that is installed.
   • The Password Reset plugin cannot change an AD password. End users will not be able to log in to the instance.
   • The Self Service Password Reset plugin depends on the Password Reset Basic plugin. Self-service is intended for password reset only on the local ServiceNow instance and cannot change an AD password.
   • The Password Reset Orchestration Add-on plugin is built on top of Orchestration AD activities. The plugin supports changing the AD password.

3. Define the verifications that the process will use.

A Password Reset process consists of the following elements:

• The credential store that contains user login credentials.
• Optionally, the user groups that are authorized to use the Password Reset process.
• The verifications (extension script includes) that verify the identity of the requesting user and that enable the service desk agents to authorize reset of the password.

1. Navigate to Password Reset > Processes.
2. Click New and then specify a meaningful Name and Description for the process.
3. Select the Credential store that contains the user credentials that the process applies to.
4. Specify the process that you are defining: Select the Password Reset check box and/or the Password change check box.
5. Specify the Apply to all users setting.
Apply to all users setting | Result
--- | ---
Selected | All users use the process that you are defining. This setting is useful only if all users have access to the authentication methods that are defined in this process.

Not selected | Only the users in the groups that you specify use the process. You specify the groups in the Groups related list.

6. If you selected **Password Reset**, fill in the **Password Reset Details** tab and, optionally, the **Advanced** tab. See *Settings on the 'Password Reset Details' tab* on page 458 and *Settings on the Password Reset 'Advanced' tab* on page 461.

7. Save the form. The form refreshes and additional related lists appear.

8. From the **Password Reset Process Verifications** related list, select one or more verifications. See *Password Reset verifications* on page 462.

9. Optional: From the **Password Reset Process Groups** related list, select the user groups that will use the process that you are defining.

The **Password Reset Process Groups** related list appears only if the **Apply to all users** check box is not selected.

10. Select the **Active** check box to enable the Password Reset process that you configured. The check box is available only after the record has been saved.

11. Click **Update**.

12. Navigate to **Password Reset > Properties** to set the properties that configure the Password Reset experience for end users.

### Set Password Reset properties

You can specify properties that configure the Password Reset experience for end users.

Role required: password_reset_admin

While there are no range limits for the values you can enter for properties, consider using only positive integer values starting at 1. When you determine the limit for the upper range of a property, consider the task that the user is performing.

For example, you would not want to allow 100 attempts for users to verify their identity. A more common value is 3 attempts. Similarly, you may not want to force users who are completing the enrollment process to spend time selecting and answering 30 security questions. The more commonly used number of security questions is between 5 and 7.

1. Navigate to **Password Reset > Properties**.

2. Update settings as needed and then click **Save**.

#### Table 149: Password reset properties

<table>
<thead>
<tr>
<th>UI text</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Global Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UI text</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workflow polling frequency</td>
<td>password_reset wf.refresh_rate</td>
<td>Time period between checks on status of the workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 90000 (milliseconds)</td>
</tr>
<tr>
<td>Workflow expiration</td>
<td>password_reset wf.timeout</td>
<td>Maximum wait time, in milliseconds, for the workflow to execute. The workflow is triggered during the password reset request when the user clicks Submit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 500 (milliseconds)</td>
</tr>
<tr>
<td>Disable captcha validation functionality</td>
<td>password_reset captcha.ignore</td>
<td>Enables or disables captcha functionality.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Password Reset application uses Google re-CAPTCHA as the default CAPTCHA service. To use the base-system CAPTCHA, change the password_reset captcha.google.enabled system property to false.</td>
</tr>
<tr>
<td>Password Reset Request Properties</td>
<td>password_reset request.max_attempt</td>
<td>Number of password reset attempts a user has before they are locked out for a period determined by the value in max_attempt_window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 3 (attempts)</td>
</tr>
<tr>
<td>UI text</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of minutes a user needs to wait for resetting/changing password after exceeding the maximum allowed unsuccessful attempts</td>
<td>password_reset.request.max_attempt_window</td>
<td>Time period that a user is blocked or prevented from changing their password after trying the maximum number of times.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 1440 (minutes)</td>
</tr>
<tr>
<td>Number of minutes a user needs to wait to reset/change password after the last successful reset/change</td>
<td>password_reset.request.success_window</td>
<td>Time period that a user must wait to reset their password again after they have successfully reset their password.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 1440 (minutes)</td>
</tr>
<tr>
<td>Number of minutes a user needs to wait to start a reset request after the last successful unlock account</td>
<td>password_reset.request.unlock_window</td>
<td>Time period that a user must wait after a successful unlock operation before starting a new request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 1440 (minutes)</td>
</tr>
<tr>
<td>Number of minutes before a password reset request expires</td>
<td>password_reset.request.expiry</td>
<td>Time period that a user is allowed to perform the password reset process.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default value: 10 (minutes)</td>
</tr>
<tr>
<td>UI text</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Number of security questions required during the password reset request | password_reset.qa.num_reset               | Number of questions that a user must answer in order to verify their identity during the password reset process.  
  • Type: integer  
  • Default value: 3 (questions)  
  • Possible values: integers that are less than the number specified for the num_enroll property.  
  
  **Note:** You can override this security question property by adding the num_reset parameter in the security question verification. |
| Number of security questions required during enrollment                 | password_reset.qa.num_enroll              | During the enrollment process, the number of questions that a user must answer to be enrolled in the password reset program.  
  • Type: integer  
  • Default value: 5 (questions)  
  
  **Note:** You can override this security question property by adding the num_enroll parameter in the security question verification. |

Password Reset SMS Code Properties
<table>
<thead>
<tr>
<th>UI text</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of SMS codes sent for verification per day              | password_reset.sms.max_per_day                            | Maximum number of code numbers that are sent to a user within one 24 hour period. The 24 hour period begins when a user clicks **Send Code**.  
- Type: integer  
- Default value: 10 (per day)  

**Note:** You can override this SMS code property by adding the `max_per_day` parameter in the SMS code verification.  
| Number of minutes before the user can attempt to send another SMS code for verification | password_reset.sms.pause_window                           | Period of time that must pass before another code number can be sent to a user.  
- Type: integer  
- Default value: 2 (minutes)  

**Note:** You can override this SMS code property by adding the `pause_window` parameter in the SMS code verification.  
| Number of digits in the SMS code sent to the user                     | password_reset.sms.default_complexity                     | Number of digits in the code that is sent during the SMS process.  
- Type: integer  
- Default value: 4 (digits)  

You can override this SMS code property by adding the `complexity` parameter in the SMS code verification.  

Table 150: Fields on the Password Reset Details tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public access</td>
<td>This check box is available only when Password reset is selected.</td>
</tr>
<tr>
<td></td>
<td>Select the check box to allow public access to the password reset form through a URL. If the check box is cleared, only service desk employees can reset a password using this process.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Public URL</td>
<td>This field box is available only when <strong>Public access</strong> is selected. URL of the page where users go to reset their password. The value from the URL suffix field is appended to the URL when you tab out of the URL suffix field.</td>
</tr>
<tr>
<td>URL suffix</td>
<td>This field is available only when <strong>Public access</strong> is selected. Suffix used to create a unique URL for the password reset form.</td>
</tr>
<tr>
<td>Display CAPTCHA</td>
<td>This check box is available only when <strong>Public access</strong> is selected. Select the check box to display a captcha on the password reset page.</td>
</tr>
<tr>
<td></td>
<td>The password reset application uses Google reCAPTCHA as the default CAPTCHA service. To use the base-system CAPTCHA, change the password_reset.captcha.google.enabled system property to <strong>false</strong>.</td>
</tr>
<tr>
<td>Identification type</td>
<td>Method that the user employs to claim their identity for the public Password Reset or Password Change process. Any selection overrides the default identification that is associated with the process. The base system includes the <strong>Email</strong> and <strong>Username Identification</strong> identification types. You can create a custom identification type (some knowledge of JavaScript is recommended). See <a href="#">Personal data and personal data confirmation type verifications</a> on page 470.</td>
</tr>
<tr>
<td>Enable account unlock</td>
<td>This check box is available only when <strong>Password reset</strong> is selected. Select the check box to allow users’ accounts on credential stores to be unlocked without resetting the password.</td>
</tr>
<tr>
<td>Unlock user account</td>
<td>Select the check box to unlock users’ accounts on credential stores after a password reset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auto-generate password</td>
<td>This check box is available only when <strong>Password reset</strong> is selected. Select the check box to auto-generate a new password for the user. When this check box is selected, you are required to select the <strong>Email password</strong> or <strong>Display password</strong> check box, or both. This is useful for service-desk-assisted processes.</td>
</tr>
<tr>
<td>Note:</td>
<td>To enable the <strong>Enforce history policy</strong> option for an Active Directory credential store, you must clear the check box. See Configure the connection to a credential store on page 443.</td>
</tr>
<tr>
<td>User must reset password</td>
<td>This check box is available only when <strong>Auto generate password</strong> is selected. Select the check box to require users to reset their password immediately after logging in with the auto-generated password.</td>
</tr>
<tr>
<td>Note:</td>
<td>Users whose credentials are held in the local ServiceNow instance credential store are prompted to change their password the first time that they log in. Users whose credentials are held in an Active Directory credential store are not prompted to change their passwords in the instance. Such users must change their passwords from a computer on the domain.</td>
</tr>
<tr>
<td>Display password</td>
<td>This check box is available only when <strong>Auto generate password</strong> is selected. Select the check box to display the new password on the screen. In a self-service process, the password appears on the user’s screen. In a service-desk process, the password appears on the service-desk employee’s screen.</td>
</tr>
</tbody>
</table>
Geneva  ServiceNow  IT Service Management

**Field** | **Description**
--- | ---
Email password | This check box is available only when **Auto generate password** is selected.
Select the check box to email the new password to the user. While this is useful in a self-service process, it can also be used in a service-desk process. Depending on the password reset process that your organization uses, this option can provide another layer of security by requiring that users access their email to view the password. In a service-desk process, emailing the password to users ensures that only the user requesting the password reset can view the password.

**Related lists**

**Verifications** | This related list is available only after the record has been saved.
One or more verifications that the process uses.

---

**Settings on the Password Reset 'Advanced' tab**

UI macros and script includes can extend the basic functionality of a password reset process.
The Advanced tab appears when you are configuring a process for resetting passwords (**Password Reset > Processes**).

### Table 151: Advanced configuration options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry UI macro</td>
<td>UI macro that displays a customized message to users when they access the initial password reset screen.</td>
</tr>
<tr>
<td>Success UI macro</td>
<td>UI macro that displays a customized message to users on the final password reset screen if their password was successfully reset.</td>
</tr>
<tr>
<td>Failure UI macro</td>
<td>UI macro that displays a customized message to users on the final password reset screen if their password reset failed.</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Script include that performs actions after the password reset process completes whether the outcome is success or failure. For more information on customizing post processor scripts, see the <strong>Post reset script</strong> category described in <strong>Create an Extension Script</strong>.</td>
</tr>
</tbody>
</table>
Configure the required strength for passwords

The password that a user defines must meet certain requirements — it must contain at least eight characters, it must include a numeral, and so on. You can configure the requirements as needed for your organization.

Role required: password_reset_admin

The base system includes example credential stores with various password requirements. You can modify password requirements and provide users with hints for creating password. The default requirements for a new password are:

- At least eight characters
- At least one uppercase and one lower case letter
- At least one numeral

**Note:** This topic describes the procedure for configuring password strength requirements only. You can configure several other settings for the credential store, as described in *Configure the connection to a credential store* on page 443.

1. Navigate to **Password Reset > Credential Stores**.
2. Select the credential store in the list and then configure the following settings:

<table>
<thead>
<tr>
<th>Password rule hint</th>
<th>Text that appears on the password reset page to help the user to create a password that meets all requirements. The <em>Password rule</em> script enforces the requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>The Password Reset Windows Application supports newline characters in the hint. Other formatting is not supported (bold, underline, hyperlink, and so on).</td>
</tr>
<tr>
<td>Password rule</td>
<td>Client script that validates the password that the user enters. The script is invoked when the user enters a new password and clicks <em>Password Reset</em>. You can use the script to enforce password strength/complexity requirements.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
   You should test the connection to a credential store after you configure a new credential store or when users experience problems that might involve the connection.
4. Navigate to **Password Reset > Credential Stores** and then open the credential store.
5. In the header bar, click **Save and Test Connection**.
   A progress page displays the result of the test.

Password Reset verifications

Each *verification* specifies the method and process for verifying the identity of the user that is attempting to reset their password. You can create a verification based on either a verification type (a template) or one of the example verifications that is included with the base system.

**Verifications included with Password Reset**

The Password Reset application includes the following verifications that you either can use as they are or can customize.
• **SMS Verification**: Implements a self-service or service-desk password reset model that relies on auto-generated code numbers. You have the option of making use of the ServiceNow Notify feature to send the SMS codes.

• **QA Verification**: Implements a self-service password reset model with questions that the admin creates and answers that the user supplies during enrollment. During password reset, the system poses a specified number of questions to verify user identity.

• **Personal Data - Enter User Name**: Implements a self-service password reset model that relies on user information that is available in the system.

• **Personal Data - Confirm Email Address**: Implements a self-service password reset model that relies on user information that is available in the system.

### Verifications included with the demo data

The demo data adds **Sample Mock Verification #1** and **#2**. Both verifications are based on the Mock Verification type.

### Create a verification from an existing verification

The Password Reset application includes several example verifications that you can use as they are or as the basis for a custom verification.

1. Navigate to **Password Reset > Verifications** and select a verification.

2. If needed, modify the parameters on the **Password Reset Verification Parameters** tab (as described in the topic for the type of verification that you are working on).

3. Click **Submit**.

4. Each verification type has properties that control the user experience. Review the property settings and make changes as needed.

### Create a verification based on a verification type

You can create a verification based on a verification type (a template).

1. Navigate to **Password Reset > Extensions > Verification Types**.

2. Click **New**, enter a unique and meaningful **Name** and **Description**, and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Create new verifications based on one of the verification types in the base system.</td>
</tr>
<tr>
<td></td>
<td>• Personal Data Confirmation Verification</td>
</tr>
<tr>
<td></td>
<td>• Personal Data Verification</td>
</tr>
<tr>
<td></td>
<td>• Security Question Verification</td>
</tr>
<tr>
<td></td>
<td>• SMS Code Verification</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Position of the verification as it appears on the Enrollment form and Password Reset form.</td>
</tr>
</tbody>
</table>
### Field: Password Reset Verification Parameters

- **Description:** Parameters used by a verification to configure specific behaviors, like number of questions required to enroll, request expiration time, and columns used. Set parameters for any behavior that should be different from the default specified in the Password Reset Properties. The available parameters are described separately for each verification type.

---

3. Click **Submit**.

4. Each verification type has properties that control the user experience. Review the property settings and make changes as needed.

### Password Reset verification types

You can use the verification types in the base system as they are or as templates for your custom verification types.

Password Reset allows you to define and use multiple instances of any verification type. The Password Reset Windows Application applies restrictions as noted.

<table>
<thead>
<tr>
<th>Personal Data Confirmation Verification Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verifies user identity using data from the User [sys_user] table. The user data is displayed to a service desk employee. The service desk employee verifies the data. Enrollment is not required for this type. Recommended for service desk processes.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The Password Reset Windows Application does not support the Personal Data Confirmation Verification type.

See [Personal data and personal data confirmation type verifications](#) on page 470

<table>
<thead>
<tr>
<th>Personal Data Verification Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verifies user identity using data from the User [sys_user] table. The user is required to answer questions. Enrollment is not required for this type.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The Password Reset Windows Application allows you to define and use multiple verifications of the Personal Data type.

See [Personal data and personal data confirmation type verifications](#) on page 470
<table>
<thead>
<tr>
<th>Verification Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Questions Verification Type</td>
<td>Verifies user identity by presenting personal security questions that the user must answer correctly.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset and Password Reset Windows Application support only a single verification of the Security Questions type.</td>
</tr>
<tr>
<td></td>
<td>See <em>Create a question for a ‘Security Questions’ verification</em> on page 469</td>
</tr>
<tr>
<td>SMS Code Verification Type</td>
<td>When a user requests password reset, the system sends a code to an SMS-capable device that the user has authorized. To verify identity, the user then enters the code on the Password Reset web page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset and Password Reset Windows Application support only a single verification of the SMS Code type.</td>
</tr>
<tr>
<td></td>
<td>See <em>SMS code type verifications</em> on page 471</td>
</tr>
<tr>
<td>Mock Verification Type</td>
<td>Not a functional identity verification. Demonstrates how to add a verification type in a Password Reset process.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Password Reset Windows Application does not support the Mock verification type.</td>
</tr>
<tr>
<td></td>
<td>• The enrollment UI macro for this verification gets the user input and returns the entered value in the enrollment processor.</td>
</tr>
<tr>
<td></td>
<td>• The Password Reset UI macro for this verification gets input from the user and returns the entered value through the verification processor.</td>
</tr>
</tbody>
</table>

*Verification type components*

You can configure the Password Reset app to automatically enroll users in password reset, or you can define an enrollment check.

To define an enrollment check, you must define both an enrollment processor script, which specifies how enrollment is processed, and a corresponding enrollment UI macro, which specifies how the enrollment information is displayed to the user. For example, the following verification type uses `PwdEnrollSMSProcessor` as the enrollment processor script and `pwd_enroll_sms_ui` as the enrollment UI macro.
A verification type must also define a verification processor script and a corresponding verification UI macro. The example uses `PwdVerifySMSProcessor` as the verification processor script and `pwd_verify_sms_ui` as the verification UI macro. The following shows the verification processor script:
Figure 51: Verification type SMS processor

The following is the corresponding UI macro:
Create a custom verification type

If the verification types in the base system do not meet your needs, you can create a custom verification type.

Review the verification types that are provided in the base system to determine whether you need to create a custom verification type. Then review the verification type components that you will need to develop.
Role required: password_reset_admin or admin

1. Navigate to Password Reset > Extensions > Verification Types.
2. Click New, enter a unique and meaningful Name and Description, and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Script to check whether a user is enrolled for verification. Automatic enrollment requires an enrollment check. If no script is specified when Automatic Enrollment is selected, a default script is provided.</td>
</tr>
<tr>
<td>Automatic enrollment</td>
<td>Indicator for whether users are auto-enrolled. If this is not selected, an enrollment UI macro and enrollment processor script must be provided.</td>
</tr>
<tr>
<td>Enrollment UI</td>
<td>Enrollment UI macro that provides the UI for the enrollment.</td>
</tr>
<tr>
<td>Enrollment processor</td>
<td>Enrollment processor script that processes the enrollment.</td>
</tr>
<tr>
<td>Verification UI</td>
<td>Verification UI macro that provides the UI for the verification.</td>
</tr>
<tr>
<td>Verification processor</td>
<td>Verification processor script (extension scripts) that processes the verification.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Delete a password reset verification

Before you delete a verification, make sure that the verification is not being used by a password reset process.

Role required: password_reset_admin or admin

If a verification is being used by a process, remove the verification from the process before deleting the verification.

1. Navigate to Password Reset > Verifications.
2. Select the check box for the verification.
3. In the Actions choice list, select Delete.

Create a question for a 'Security Questions' verification

For the Security Questions Verification type, you can select from a default question set and/or you can create custom questions.

Role required: password_reset_admin or admin

1. Navigate to Password Reset > Security Questions and then click New.
2. The default language is English. Enter the English language question in the Security question field.
3. To add the same question in another language, complete the following steps.
   a) In the Translations embedded list, click Insert a new row in the Security question field.
   b) Enter the question in the Security question field and then select the language in the Language field.
The user will see the verification question in the language that was used when the user enrolled.

4. Click Submit or Update.

Configure the number of questions for a ‘Security Questions’ verification

When you design a Security Questions verification, you can specify both the number of questions to display when users enroll and the number to display when a user requests password reset.

Role required: password_reset_admin or admin

1. Navigate to Password Reset > Verifications and then open a verification that uses the Security Questions Verification Type.

2. Configure the parameters in the Password Reset Verification Parameters related list.

Table 153: Parameters for Security Questions Verification

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>num_enroll</td>
<td>Number of security questions that are displayed while a user is enrolling for password reset.</td>
</tr>
<tr>
<td></td>
<td><strong>Data Type:</strong> Positive integer that does not exceed the number of questions in the security questions list (<strong>Password Reset &gt; Security Questions</strong>).</td>
</tr>
<tr>
<td></td>
<td><strong>Default Value:</strong> 5</td>
</tr>
<tr>
<td>num_reset</td>
<td>Number of security questions that are displayed while a user is attempting to reset the password. The questions are selected at random and are presented in random order.</td>
</tr>
<tr>
<td></td>
<td><strong>Data Type:</strong> Positive integer that does not exceed the value of the num_enroll parameter</td>
</tr>
<tr>
<td></td>
<td><strong>Default Value:</strong> 3</td>
</tr>
</tbody>
</table>

3. Click Update.

Personal data and personal data confirmation type verifications

Personal data verifications allow users to verify their identity by providing answers to questions that are generated from personal information stored in the User [sys_user] table.

Users are typically not required to enroll for password reset if they are associated with a password reset process that uses a personal data verification.

Personal data confirmation verifications allow employees with the service-desk role to access personal data from the sys_user table when assisting a user with a password reset request.

For personal data and personal data confirmation verifications, you specify parameters as name/value pairs that correspond to a particular piece of user information. For example, to verify users by their email address, set the label parameter (the text that the end user should see) to Email (that is, label=Email) and set the column parameter (the column in the table that holds the data) to email (that is, column=email). You can use only one set of name/value pair parameters per verification. Additional parameters are ignored.
To use multiple pieces of personal information for user verification, create additional personal data or personal data confirmation verifications and add those to the related password reset process.

### Table 154: Personal data and personal data confirmation type verifications

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>label</td>
<td>Label that the user sees during the password reset request. Data Type: String Default Value: n/a</td>
</tr>
<tr>
<td>column</td>
<td>Column of the sys_user table that provides the data that is used to verify the identity of the user. Data Type: String Default Value: n/a</td>
</tr>
</tbody>
</table>

**Personal data identification types**

The Password Reset application provides the email and username identification types. You can use either type as provided or as a model to create a custom identification type.

### Table 155: Identification types

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Identification</td>
<td>Identifies users by their email addresses.</td>
</tr>
<tr>
<td>Username Identification</td>
<td>Identifies users by their usernames.</td>
</tr>
</tbody>
</table>

**Create a custom identification type**

A custom identification type enables the user to enter alternative verification information such as an employee ID while resetting the password.

Role required: password_reset_admin or admin

1. Navigate to **Password Reset > Extensions > Identification Types**.
2. Click **New**, enter a unique and meaningful **Name** and **Description**, and then fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification field label</td>
<td>Text to display as a label for the Identification field.</td>
</tr>
<tr>
<td>Identification processor</td>
<td>Identification processor script. Choose an existing script, or create your own using the Identification form processor category (extension script).</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**SMS code type verifications**

Simple Message Service (SMS) code verifications allow users to verify their identity with the help of an SMS enabled device, such as a cell phone that accepts text messages.

When a user requests a password reset, the system sends a code to the SMS device that the user has authorized. The user must enter the code to verify their identity.
You can change the default behavior of an SMS code verification using either of the following methods:

- Setting parameter values, as shown below
- Updating property settings for the Password Reset application

**Note:** Create only one instance of each SMS code parameter. Attempting to create additional parameters causes an error.

### Table 156: SMS code type verifications

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| expiry         | Number of minutes the verification code is valid.  
**Data Type:** Integer (any positive integer)  
**Default Value:** 5 |
| complexity     | Number of digits in the verification code sent to user.  
**Data Type:** Integer (any positive integer)  
**Default Value:** 4 |
| pause_window   | Number of minutes before the user can attempt to send another SMS code for verification.  
**Data Type:** Integer (any positive integer)  
**Default Value:** 2 |
| max_per_day    | Maximum number of SMS codes sent for verification per day.  
**Data Type:** Integer (any positive integer)  
**Default Value:** 10 |

*Use NotifyNow to send SMS codes for enrollment and verification*

You can configure the password reset application to send SMS enrollment and verification codes using ServiceNow NotifyNow (via Twilio). NotifyNow is tightly integrated with the workflow engine and business rules and delivers a highly configurable and trusted way to deliver SMS messages.

**Role required:** admin

NotifyNow requires a separate contract with Twilio.

2. Activate the **Notify** plugin.
3. Associate the Twilio account with Notify.

No other configuration is required. Users who request password change or reset will now receive SMS codes through NotifyNow.

### Customize the Password Reset process: Scripting

Password reset scripting enables you to customize password reset by creating your own credential store, verification, and identification types, and extend them by defining extension scripts.
Password reset scripting is available to users with the password_reset_admin role. The easiest way to customize password reset is:

1. Create your custom types and scripts
2. Follow the configuration steps described in Configure your Password Reset or Password Change process on page 452
3. Select the new types that you created. You can customize the following components:
   - Credential store types: Define new types for how to connect to your credential stores by creating custom workflows for connection and testing.
   - Verification types: Define new types for how users are verified.
   - Identification types: Define new types for how users can identify themselves.

Extension script

Extension scripts allow you to extend password reset functionality by defining custom scripts that can be used in a credential store, verification, or identification type, or as a post-processor in a process. Extension scripts are predefined hooks within the Password Reset application that perform specific types of behavior defined by the extension category, which refers to where the script will be used.

For information about how to define extension scripts, see Extension scripts on page 476.

Password reset scripting examples

The examples illustrate password reset scripting.

Perform a user account lookup and process an identification form

The following example shows a script that performs a user account lookup and processes an identification form. The main script calls two extension scripts, one to perform the user account lookup, and the other to process the identification form.

```javascript
// User account lookup
var lookupExtensionSysId =
    getExtensionScriptSysId('SampleUserAccountLookupExtension',
                            'user_account_lookup');
var lookupExtension = new SNC.PwdExtensionPoint(lookupExtensionSysId);

// Setup parameters required for this extension type - userId
var params = new SNC.PwdExtensionPointParameter();
params.userId = 'joe.employee';

// Invoke the extension
var answer = lookupExtension.process(params);
gs.print('user: ' + answer);

// Form processor sample - Identification form processor
var identExtensionSysId =
    getExtensionScriptSysId('SampleIdentificationProcessorExtension',
                             'identification_form_processor');
var identificationExtension = new SNC.PwdExtensionPoint(identExtensionSysId);

// Setup parameters required for this extension type - processId
var params = new SNC.PwdExtensionPointParameter();
params.processId = 'pwdreq1234';
```
// Simulate the posted form parameter for the identification processor
var request = new SNC.PwdExtensionPointParameter(); // A real life case
// will inject it's own request object
request.setParameter('sysparm_user_id', 'joe.employee');

var userIdentity = identificationExtension.processForm(params, request);
gs.print('identity: ' + userIdentity);

// Simple helper to return the sys-id for a given extension script function
function getExtensionScriptSysId(scriptName, category) {
  var result;
  var gr = new GlideRecord('sys_script_include');
  gr.addQuery('name', scriptName);
  gr.addQuery('script', 'CONTAINS', 'category: "password_reset.extension.' + category + '"');
  gr.query();
  if (gr.next() ) {
    result = gr.getValue('sys_id');
  }
  return result;
}

Define a credential store

The following is an example of an extended process function in the User Account Lookup category used
to define a credential store. To create this extension script, go to Password Reset > Extensions > New
extension script and create a new script. To configure the User Lookup in a password reset process, see
Credential Stores.

<?xml version="1.0" encoding="UTF-8"?>
<record_update table="sys_script_include">
  <sys_script_include action="INSERT_OR_UPDATE">
    <active>true</active>
    <client_callable>false</client_callable>
    <description>Simple account lookup that returns the supplied user id</description>
    <name>SampleUserAccountLookupExtension</name>
    <script><![CDATA[var SampleUserAccountLookupExtension = Class.create();
SampleUserAccountLookupExtension.prototype = {
  category: 'password_reset.extension.user_account_lookup', // DO NOT REMOVE
  // THIS LINE!

  process: function(params) {
    return params.userId;
  },

  type: 'SampleUserAccountLookupExtension'
};]]></script>
  <sys_created_by>admin</sys_created_by>
Create an identification type

The following is an example of an extended processForm function in the Identification Form Processor category that can be used to create an identification type. To create this extension script, go to Password Reset > Extensions > New extension script and create a new script.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<record_update table="sys_script_include">
  <sys_script_include action="INSERT_OR_UPDATE">
    <active>true</active>
    <client_callable>false</client_callable>
    <description>Script that processes an identification form. Returns the sys-id of the user that corresponds to the requested input; if no user was found, null should be returned.</description>
    <name>SampleIdentificationProcessorExtension</name>
    <script><![CDATA[
        var SampleIdentificationProcessorExtension = Class.create();
        SampleIdentificationProcessorExtension.prototype = {
          category: 'password_reset.extension.identification_form_processor', // DO NOT REMOVE THIS LINE!
          /**********
          * Process the identification form request, and returns the user's sys_id. If no user was found, null should be returned.
          * @param params.processId The sys-id of the calling password-reset process (table: pwd_process)
```
Extension scripts

Extension scripts allow you to extend password reset functionality by defining custom scripts that can be used in credential store, verification, or identification types.

Extension scripts are predefined hooks within the Password Reset application that perform specific types of behavior defined by the extension category, which refers to where the script can be used. You can create, edit, and use extension scripts. For detailed reference information, see Password reset extension script includes on page 480.

The base system includes several scripts in each category. You can use them as-is or as a template for creating custom scripts. For more information, see Installed password reset script includes on page 488.
Extension script categories

Extension scripts contain a category that indicates what application is being extended and to what purpose for example, category: 'password_reset.extension.enrollment_check'.

In the table, the category indicates where a script can be used in the Password Reset application. For example, a script in the Enrollment check category can be selected to perform the enrollment check for a verification. For more information about each script include, see Password reset extension script includes on page 480.

Table 157: Extension script categories

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment check</td>
<td>Defines how enrollment is to be checked. Scripts of this category are available in the Enrollment check field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
<tr>
<td>Enrollment form processor</td>
<td>Defines how an enrollment form is processed (if not automatic enrollment). Scripts of this category are available in the Enrollment form processor field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
<tr>
<td>Identification form processor</td>
<td>Defines how an identification is processed. Scripts of this category are available in the Identification processor field when you define a verification type (Password Reset Identification Type form).</td>
</tr>
<tr>
<td>Password generator</td>
<td>Defines how to generate a password. Scripts of this category are available in the Auto generate password field when you configure a credential store (Password Reset Credential Store Type form).</td>
</tr>
<tr>
<td>Post reset script</td>
<td>Executes at the end of a password reset process. Scripts of this category are available in the Post reset script field when you configure a process (Password Reset Process form).</td>
</tr>
<tr>
<td>User account lookup</td>
<td>Defines how a user account lookup is performed. Scripts of this category are available in the User account lookup field when you configure a credential store (Password Reset Credential Store form).</td>
</tr>
<tr>
<td>Verification form processor</td>
<td>Defines how a verification form is processed. Scripts of this category are available in the Verification processor field when you define a verification type (Password Reset Verification Type form).</td>
</tr>
</tbody>
</table>
Extension script example
This example shows a script that uses two sample extensions, one process extension and one processForm extension.

```java
// User account lookup var lookupExtensionSysId =
  getExtensionScriptSysId('SampleUserAccountLookupExtension','user_account_lookup');
var lookupExtension =
  new SNC.PwdExtensionPoint(lookupExtensionSysId);

// Setup parameters required for this extension type - userId
var params =
  new SNC.PwdExtensionPointParameter();
params.userId = 'joe.employee';

// Invoke the extension var answer = lookupExtension.process(params);
gs.print('user: ' + answer);

// Form processor sample - Identification form processor
var identExtensionSysId =
  getExtensionScriptSysId('SampleIdentificationProcessorExtension','identification_form_processor');
var identificationExtension =
  new SNC.PwdExtensionPoint(identExtensionSysId);

// Setup parameters required for this extension type - processId
var params =
  new SNC.PwdExtensionPointParameter();
params.processId = 'pwdreq1234';

// Simulate the posted form parameter for the identifcation processor
var request =
  new SNC.PwdExtensionPointParameter();
request.setParameter('sysparm_user_id', 'joe.employee');

var userIdentity = identificationExtension.processForm(params, request);
gs.print('identity: ' + userIdentity);

// Simple helper to return the sys-id for a given extension script
function getExtensionScriptSysId(scriptName, category){
  var result;
  var gr =
    new GlideRecord('sys_script_include');
  gr.addQuery('name', scriptName);
  gr.addQuery('script', 'CONTAINS', 'category: ' + category + 'password_reset.extension.' + category + '');</span>g
  gr.query();
  if(gr.next()){
    result = gr.getValue('sys_id');
  }
  return result;
}

process function:

```xml````xml
<?xml version="1.0" encoding="UTF-8"?><record_update
  table="sys_script_include"><sys_script_include
  action="INSERT_OR_UPDATE"><active>true</active><client Callable>false</client Callable><description>Simple account lookup that returns the supplied user id</description><name>SampleUserAccountLookupExtension</name><script><![CDATA[var SampleUserAccountLookupExtension =Class.create();
SampleUserAccountLookupExtension.prototype={
  category:'password_reset.extension.user_account_lookup',// DO NOT REMOVE THIS LINE!

  //////////
  * Returns the credential-store account id for a given user
  *
  * @param params.userId The sys-id of the user being checked (table: sys_user)
  * @return The credential-store account-id (string) for a given user
```
process:function(params){return params.userId;},
type:'SampleUserAccountLookupExtension'
};]]></script><sys_created_by>admin</sys_created_by><sys_created_on>2013-07-30 16:44:55</sys_created_on><sys_id>2df5a103d73201002bb9af728e610333</sys_id><sys_mod_count>1</sys_mod_count><sys_updated_by>admin</sys_updated_by><sys_updated_on>2013-07-30 16:46:00</sys_updated_on><sys_script_include><sys_app_file action="INSERT_OR_UPDATE"><customer_update>false</customer_update><publish_override/><replace_on_upgrade>false</replace_on_upgrade><restore/></sys_app_file><sys_code>!!!1W4/</sys_code><sys_created_by>admin</sys_created_by><sys_created_on>2013-07-30 16:44:55</sys_created_on><sys_id>8306e143d73201002bb9af728e6103d3</sys_id><sys_mod_count>0</sys_mod_count><sys_name>SampleUserAccountLookupExtension</sys_name><sys_parent/></sys_path><sys_policy/></sys_policy><sys_source_deleted>false</sys_source_deleted><sys_source_id>2df5a103d73201002bb9af728e610333</sys_source_id><sys_source_table>sys_script_include</sys_source_table><sys_type>code</sys_type><sys_update_name>sys_script_include_2df5a103d73201002bb9af728e610333</sys_update_name><sys_updated_by>admin</sys_updated_by><sys_updated_on>2013-07-30 16:46:00</sys_updated_on></sys_app_file></record_update>

processForm function:

```xml
<?xml version="1.0" encoding="UTF-8"?><record_update table="sys_script_include" action="INSERT_OR_UPDATE"><active>true</active><client_callable>false</client_callable><description>Script that processes an identification form. &lt;/p&gt;
Returns the sys-id of the user that corresponds to the requested input; if no user was found, null should be returned. &lt;/p&gt;
</description><name>SampleIdentificationProcessorExtension</name><script><![CDATA[

var SampleIdentificationProcessorExtension = Class.create();
SampleIdentificationProcessorExtension.prototype={
category:'password_reset.extension.identification_form_processor', // DO NOT REMOVE THIS LINE!

************
 * Process the identification form request, and returns the user's sys_id.
 * if user was not identified return null.
 * @param params.processId The sys-id of the calling password-reset process (table: pwd_process)
 * @param request The form request object. fields in the form can be accessed using: request.getParameter('element-id')
 * Supported request parameters:
 * sysparm_user_id - the user identifier
 * @return The sys-id of the user that corresponds to the requested input; if no user was found, null should be returned.
 ************

processForm:function(params, request){return request.getParameter('sysparm_user_id')+'_'+params.processId;},
type:'SampleIdentificationProcessorExtension'
```
Password reset extension script includes

Password reset scripts allow you to extend password reset functionality by creating your own credential store, verification, and identification types, and by adding operations to password reset processes.

A script include is associated with a specific category, which is available in the appropriate field of a password reset form.

The ServiceNow platform installs several scripts in each category. You can use them as-is or as a template for creating custom scripts. For a description of these scripts, see Installed password reset script includes on page 488.

Note: You should create new extension scripts only from the Password Reset Extension Script form (Password Reset > Extensions > New extension script). Extension scripts are special purpose script includes that should not be created in the System Definition > Script Includes interface.

Use these script includes for customizing a password reset process.
Table 158: Password reset script includes

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Check</td>
<td>Checks if a user is enrolled for a given verification.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns:</td>
<td>This example signals that the user is enrolled if both expected parameters are supplied. The code would be contained in the Script field of an extension script named SampleEnrollmentCheck:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.userId - The sys_id of the user to check (table: sys_user).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.verificationId - The sys_id of the verification to check (table: pwd_verification).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(boolean) true, if the user is enrolled in the specified verification, otherwise, false.</td>
<td></td>
</tr>
</tbody>
</table>

```javascript
var SampleEnrollmentCheck = Class.create();
SampleEnrollmentCheck.prototype = {
  category : 'password_reset.extension.enrollment_check', // DO NOT REMOVE THIS LINE!
  process : function (params) {
    return (params.userId && params.verificationId) ? true : false;
  },
  type : 'SampleEnrollmentCheck'
};
```

© 2017 ServiceNow. All rights reserved.
<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Form Processor</td>
<td>Checks if all necessary information has been collected from the user. Stores the information so it can be used for verification when the user resets his or her password.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td>Returns: (boolean) true, if the user is enrolled in the specified verification; otherwise, false.</td>
<td>This example processes an enrollment form submission successfully if the user-submitted response was success. The code would be contained in the Script field of an extension script named SampleEnrollmentProcessor:</td>
</tr>
</tbody>
</table>

```javascript
var SampleEnrollmentProcessor = Class.create();
SampleEnrollmentProcessor.prototype = {
    category: 'password_reset.extension.enrollment_form_processor', // DO NOT REMOVE THIS LINE!

    // Process the enrollment form request, and return whether the user was successfully enrolled.
    // @param params.userId - The sys_id of the user trying to enroll (table: sys_user).
    // @param params.verificationId - The sys_id of the verification to be processed (table: pwd_verification).
    // @param request - The form request object. Fields in the form can be accessed with request.getParameter('<element-id>').
    processForm: function(params, request) {
        var verificationId = params.verificationId;
        var sampleInput = request.getParameter('sample_input');
        if (gs.nil(verificationId) || (sampleInput !== 'success')) {
            return false;
        }
        var gr = new GlideRecord('sys_user');
        gr.get(params.userId);
        gs.print('User: ' + gr.getValue('user_name') + ' successfully enrolled');
        return true;
    },

    type: 'SampleEnrollmentProcessor'
};
```

The following information should be added to the state of the enrollment process:

- `gs.getSession().putProperty("result.status", status)` - Whether the user was successfully enrolled.
- `gs.getSession().putProperty("result.message", message)` - An associated message to be returned to the UI, such as a detailed error message.
- `gs.getSession().putProperty("result.value", value)` - A custom value associated with the enrollment.
<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output ifields</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification Form Processor</td>
<td>Processes an identification form request.</td>
<td>processForm(params, request)</td>
<td>Parameters:</td>
<td>Returns: the sys_id of the user that corresponds to the requested input; if no user was found, returns null.</td>
<td>This example attempts to identify the user within the sys_user table given a user name submitted from the identification form. The code would be contained in the <strong>Script</strong> field of an extension script named PwdIdentifyViaUsername:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• params.processId</td>
<td></td>
<td>var PwdIdentifyViaUsername = Class.create();</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• request</td>
<td></td>
<td>PwdIdentifyViaUsername.prototype = {</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The form</td>
<td></td>
<td>category : 'password_reset.extension.identification_form_processor', //</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>request</td>
<td></td>
<td>DO NOT REMOVE THIS LINE!</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>object.</td>
<td></td>
<td>initialize : function () {</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fields in</td>
<td></td>
<td>} ,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the form</td>
<td></td>
<td>/ **********</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>can be</td>
<td></td>
<td>* Process the identification form request, and returns the user's sys_id. If user was not identified return null.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>accessed</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>with</td>
<td></td>
<td>params.processId</td>
</tr>
<tr>
<td>Script include</td>
<td>Description</td>
<td>Method signature</td>
<td>Input fields</td>
<td>Output fields</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------</td>
<td>------------------</td>
<td>--------------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>Password Generator</td>
<td>Returns an auto-generated password.</td>
<td>process(params)</td>
<td>Parameters:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- params.processId</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The sys_id of the calling password reset process (table: pwd_process).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Returns: (String) an auto-generated password.</td>
<td>This example randomly generates a password from a base word and numbers. The base word is selected depending on the credential store. The code would be contained in the Script field of an extension script named SamplePasswordGenerator:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```javascript
var SamplePasswordGenerator = Class.create();
SamplePasswordGenerator.prototype = {
    category: 'password_reset.extension.password_generator', // DO NOT REMOVE THIS LINE!
    process: function(params) {
        var basePassword;
        var gr = new GlideRecord('pwd_cred_store');
        gr.addQuery('name', 'Local ServiceNow Instance');
        gr.query();
        if (gr.next()) {
            if (params.credentialStoreId == gr.getValue('sys_id')) {
                basePassword = "Password";
            } else {
                basePassword = "Dorwssap";
            }
        }
        return this.generateSimple(basePassword);  
    },
    generateSimple: function(base) {
        var pwd = base;
        var numbers = '0123456789';
        var length = 4;
        for (var i = 0, n = numbers.length; i < length; i++) {
            pwd += numbers.charAt(Math.floor(Math.random() * n) + 1);
        }
        return pwd;
    }
};
```

© 2017 ServiceNow. All rights reserved.
<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
<th>Example</th>
</tr>
</thead>
</table>
| Post Reset    | Performs additional operations after the completion of the password reset process. | process(params) | Parameters:  
  - params.resetRequestId: The sys_id of the calling password reset process (table: pwd_process).  
  - params.wfSuccess: A flag indicating whether the workflow completed successfully. True if, and only if, successful. | Returns: void | This example adds failed reset requests to the system log. The code would be contained in the Script field for an extension script named PwdPostProcessor:

```javascript
var PwdPostProcessor = Class.create();
PwdPostProcessor.prototype = {
  category: 'password_reset.extension.post_reset_script', // DO NOT REMOVE THIS LINE!
  initialize: function () {
    // We could place actions here that we always want executed
    return;
  },
  process: function (params) {
    if (!params.wfSuccess) {
      gs.log('[PwdPostProcessor.process] failure post processing for request [' + params.resetRequestId + ']');
    }
  };

  type: 'PwdPostProcessor';
};
```

© 2017 ServiceNow. All rights reserved.
<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
<th>Example</th>
</tr>
</thead>
</table>
| User Account Lookup | Gets the credential store account ID for a given user. | process(params) | Parameters:  
- params.userId - The sys_id of the user being checked (table: sys_user). | Returns: (String) the credential store account ID for the given user. | This example gets the credential store account for a user. This code would be contained in the Script field of an extension script named SampleUserAccountLookupExtension:  

```javascript
var SampleUserAccountLookupExtension = Class.create();
SampleUserAccountLookupExtension.prototype = {
    category: 'password_reset.extension.user_account_lookup',
    // DO NOT REMOVE THIS LINE!
    // **********
    // Returns the credential store account ID for a given user.
    // This sample echoes the user_id supplied as the credential store account ID for that user.
    // *
    // @param params.userId The sys_id of the user being checked (table: sys_user).
    process: function(params) {
        return params.userId;
    },
    type: 'SampleUserAccountLookupExtension'
};
```
<p>|</p>
<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
<th>Method signature</th>
<th>Input fields</th>
<th>Output fields</th>
<th>Example</th>
</tr>
</thead>
</table>
| Verification Form Processor | Processes a verification form request and indicates whether the user was verified or not. | processForm(params, request) | params: | Returns: (boolean) true, if the user is verified; otherwise, false. | This example shows a verification processor that returns true only if the user sent **ok** in the input field; otherwise, it returns false. The code would be contained in the **Script** field of an extension script named SampleVerificationFormProcessor:

```javascript
var SampleVerificationProcessor = Class.create();
SampleVerificationProcessor.prototype = {
    category: 'password_reset.extension.verification_form_processor', // DO NOT REMOVE THIS LINE!
    processForm: function(params, request) {
        if (request.getParameter('sysparm_simple_input') == 'ok') {
            return true;
        } else {
            return false;
        }
    },
    type: 'SampleVerificationFormProcessor'
};
```

© 2017 ServiceNow. All rights reserved.
Installed password reset script includes

The ServiceNow platform installs several password reset script includes, which you can use as-is or customize.

Use these script includes as a basis for creating customized password reset extension scripts as needed.

For information on how to customize password reset script includes, see Extension scripts on page 476. When you create a new extension, it must take the input values and return the values described on this page for the extension category.

**Note:** You should create new extension scripts only from the Password Reset Extension Script form (Password Reset > Extensions > New extension script). Extension scripts are special purpose script includes that should not be created in the System Definition > Script Includes interface.

**Enrollment check script includes**

Enrollment check script includes provide functionality for extending enrollment checks.

All enrollment check script includes take the following parameters, and return a boolean indicating whether the user is verified.

- params.userId: The sys_id of the user being checked (table: [sys_user]).
- params.verificationId: The sys_id of the verification being checked (table: [pwd_verification]).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdAlwaysEnrolled</td>
<td>Provides a default check that always returns true.</td>
</tr>
<tr>
<td>PwdMockIsEnrolled</td>
<td>Provides an example check that always returns true.</td>
</tr>
<tr>
<td>PwdQuestionsEnrollmentCheck</td>
<td>Determines if a user has enrolled for password reset using security question verification.</td>
</tr>
<tr>
<td>PwdSMSEnrollmentCheck</td>
<td>Determines if a user has enrolled for password reset using SMS verification.</td>
</tr>
</tbody>
</table>

**Identification form processor script includes**

Identification form processor script includes provide functionality for extending identification processing.

All identification form processor script includes take the following parameters, and return the sys_id of the user that corresponds to the requested input, or if the user was not identified, returns null.

- params.processId: The sys_id of the calling password reset process (table: [pwd_process]).
- param request: The form request object. Fields in the form can be accessed with request.getParameter('<element-id>'). The supported request parameter is sysparm_user_id, the user identifier value entered in the form.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdIdentifyViaEmail</td>
<td>Verifies a user's identity by checking his or her email address.</td>
</tr>
</tbody>
</table>
Name | Description
--- | ---
PwdIdentifyViaUsername | Verifies a user's identity by checking his or her user name.

*Enrollment form processor script includes*

Enrollment form processor script includes provide functionality for extending enrollment form processing.

All enrollment form processor script includes take the following parameters, and return a boolean indicating whether the user was successfully enrolled.

- `params.userId`: The sys_id of the user trying to enroll (table: [sys_user]).
- `params.verificationId`: The sys_id of the verification used to enroll (table: [pwd_verification]).
- `params.enrollmentId`: The sys_id of this enrollment process.
- `request`: The form request object. Fields in the form can be accessed with `request.getParameter('<element-id>')`.

The following information should be added to the state of the enrollment process:

- `gs.getSession().putProperty("result.status",status)`: Whether the user was successfully enrolled.
- `gs.getSession().putProperty("result.message",message)`: An associated message to be returned to the UI, such as a detailed error message.
- `gs.getSession().putProperty("result.value",value)`: A custom value associated with the enrollment.

Table 161: Enrollment form processor script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdEnrollQuestionsProcessor</td>
<td>Handles questions and answers for verification.</td>
</tr>
<tr>
<td>PwdEnrollSampleProcessor</td>
<td>Provides an enrollment processor for sample verification.</td>
</tr>
<tr>
<td>PwdEnrollSMSProcessor</td>
<td>Provides an enrollment processor for SMS verification.</td>
</tr>
</tbody>
</table>

*User account lookup script includes*

User account lookup script includes return the credential store account_id for a given user.

The following parameter returns the credential store account_id for a given user.

- `params.userId`: The sys_id of the user being checked (table: [sys_user]).

Table 162: User account lookup script include

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdDefaultUserAccountLookup</td>
<td>Provides a default script for user account lookup from a user_id to the account in a credential store. The default mapping is to use the user name as the account name.</td>
</tr>
</tbody>
</table>

*Password generator script includes*

Password generator script includes returns an auto-generated string password.
Password generator script includes take the following parameter, and return an auto-generated string password:

- `params.credentialStoreId`: The sys_id of the calling password reset process (table: [pwd_process]).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdDefaultAutoGenPassword</td>
<td>Generates a password from a random word and 4 digits.</td>
</tr>
</tbody>
</table>

**Verification processor script includes**

Verification processor script includes returns true if the user is verified.

Verification processor script includes take the following parameters, and return true if the user is verified.

- `params.resetRequestId`: The sys_id of the current password reset request (table: [pwd_reset_request]).
- `params.userId`: The sys_id of the user to be verified (table: [sys_user]).
- `params.verificationId`: The sys_id of the verification (table: [pwd_verification]).
- `request`: The form request object. Fields in the form can be accessed with `request.getParameter('<element-id>')`.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdVerifyPersonalDataConfirmationProcess</td>
<td>Verifies that the answer was accepted by the user.</td>
</tr>
<tr>
<td>PwdVerifyPersonalDataProcessor</td>
<td>Verifies that the user's answers match the expected data in the system.</td>
</tr>
<tr>
<td>PwdVerifyQuestionsProcessor</td>
<td>Provides question and answer verification of user input on the second page of the verification form.</td>
</tr>
<tr>
<td>PwdVerifySimpleProcessor</td>
<td>Provides simple verification of user input on the second page of the verification form.</td>
</tr>
<tr>
<td>PwdVerifySMSProcessor</td>
<td>Provides SMS verification of user input on the second page of the verification form.</td>
</tr>
</tbody>
</table>

**Post processor script includes**

Post processor script includes execute custom actions after the password reset process has completed.

All post processor script includes take the following parameters.

- `params.resetRequestId`: The sys_id of the current password reset request (table: [pwd_reset_request]).
- `params.wfSuccess`: A flag indicating whether the workflow completed successfully: True if, and only if, successful.
Table 165: Post processor script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PwdPostProcessor</td>
<td>Executes actions after the process completes for success, failure, or both conditions.</td>
</tr>
</tbody>
</table>

Service desk processes: Resetting passwords

The specific details of the password reset process vary depending on the verification type and settings you have chosen. Also, depending on your organization’s password reset requirements, users can reset their passwords through a publicly accessible web page, or service desk employees with the password_reset_service_desk role can perform password resets on behalf of users.

To see a video on resetting a user’s password, go to Resetting User Passwords (Video).

View requests for password reset

The Reset Requests module displays the current status of each password reset request from the Password Reset Request table [pwd_reset_request].

Role required: password_reset_admin or password_reset_service_desk

Navigate to Password Reset > Reset Requests.

Table 166: Password reset request fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The user whose password is being reset or changed.</td>
</tr>
<tr>
<td>Process</td>
<td>The process that implements this password reset request.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of password reset request:</td>
</tr>
<tr>
<td></td>
<td>• Change Password: This request is for a password change.</td>
</tr>
<tr>
<td></td>
<td>• Help Desk: This reset request was opened on behalf of the requesting user by a service desk agent.</td>
</tr>
<tr>
<td></td>
<td>• Self Service: This reset request was opened by the requesting user.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Action Type</td>
<td>The corrective action to be taken by password reset request.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change Password</strong>: update the credential store with the new password.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reset and Unlock Account</strong>: generate a new password for the user and unlock the user's account.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reset Password</strong>: generate a new password for the user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Unlock Account</strong>: unlock the user's account.</td>
</tr>
<tr>
<td>Status</td>
<td>The result of the password reset request:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Completed With Failure</strong>: user completed all of the steps in the password reset process, but the password was not reset in the credential store.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Completed With Success</strong>: user completed all of the steps in the password reset process and the password was reset in the credential store.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Expired</strong>: user did not complete all of the steps in the password reset process in the time allowed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>In Progress</strong>: user is currently working through the steps to reset the password.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Max Number of Attempts</strong>: user failed to correctly answer the security questions during the identity verification step and has exceeded the maximum number of attempts allowed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Verified</strong>: user has completed the identity verification step and is verified. The user can now move to the password reset step.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the request is open or closed.</td>
</tr>
<tr>
<td>Retry</td>
<td>The total number of times the user has attempted to complete a password reset request.</td>
</tr>
</tbody>
</table>

**Specify lockout for failed login attempts**

The system provides inactive script actions that enable you to specify the number of failed login attempts before a user account is locked and to reset the count after a successful login.
Role required: admin

Navigate to **System Policy > Script Actions** to view or activate the scripts.

- **SNC User Lockout Check with Auto Unlock**:
  - Uses the `glide.user.max_unlock_attempts` property value to set the limit for failed login attempts.
  - Unlocks the user account after the time period that is specified for the `glide.user.unlock_timeout_in_mins` property. If no value is specified, then the system unlocks the user account after the default period of 15 minutes.

- **SNC User Lockout Check**:
  - Keeps track of the number of failed login attempts and locks the user account after a specified number of failed login attempts (default: 5).

- **SNC User Clear**:
  - Updates the user record upon a successful login: Resets the number of failed login attempts and updates the date of the last login.

**View the log of failed login attempts**

Each time a user attempts to log in, the action is recorded in an event log. You can view a log of failed login attempts.

Role required: admin

1. Navigate to **System Policy > Event Logs**.
2. Filter for `login.failed` in the **Name** field. You can view the attempted login name, date, and IP address logged for the attempt.

**Reset a password**

This example shows how service desk employees can reset passwords using email verification with the unlock user account feature enabled.

Role required: password_reset_admin or password_reset_service_desk

1. Navigate to **Password Reset > Service Desk**.
2. Select a user and the password reset process to use.
3. Click **Verify Identity**.
4. On the Verify Identity form, enter the answers that the user provides and then click **Continue**.
   - If the user's identity is verified, the Reset Password form appears with the status for the user, including whether they were successfully verified and their current account lock state.
5. Perform one of the following actions.
   - If the user is not locked, the form displays the **Reset password** button. Enter the new password and click **Reset password**.
   - If the user is locked, the form displays the **Reset password** and **Unlock account** buttons. You can enter a new password and click **Reset password** to reset the password and unlock the account. If the **Enable account unlock** check box is selected for the password process, you can unlock the account without resetting the password by clicking **Unlock account**.

**Subscribe to a blocked user notification**

You can receive email notifications when the number of users that are blocked, or locked, exceeds the password blocked threshold.

Role required: admin, password_reset_credential_manager or password_reset_admin
Notifications can alert you to suspicious activities. The default threshold is 10.

1. Add a new email notification device or modify an existing device.
2. Subscribe to the Password Reset-Activity Monitor Lockout notification.

View blocked users

A blocked user is a person who is prevented from logging in to the system if certain events occur.

Events include the following:

• The user exceeds the limit for the number of failed password attempts.
• The user’s most recent password reset occurred before the wait time required until the next reset.
• The user fails to provide the correct information while attempting to reset their password.

If the number of blocked or locked users exceeds the limit within a defined time interval, it triggers a system log event. You can configure the number of blocked, or locked, users and the time interval required to generate the log event by setting the password_reset.activity_monitor.incident_threshold and password_reset.activity_monitor.incident_window properties.

To view a list of blocked users, navigate to Password Reset > Blocked Users.

Unblock a user

You can unblock a blocked user.

Role required: password_reset_admin or password_reset_service_desk

1. Navigate to Password Reset > Blocked Users.
2. Select a user from the list of blocked users.
3. Select Delete from the Actions on selected rows list.

Unblock a user whose password was reset by Service Desk

When a user’s password is reset by Service Desk, the Blocked status is not reset. You must reset it manually to unblock the user.

Role required: password_reset_admin or password_reset_service_desk

A user can be blocked (not allowed to use the Password Reset application) if the user is manually banned or flagged as exceeding max attempts. When the password reset request is made through self-service, the user is unblocked when the password is successfully reset.

In contrast, Service Desk users are allowed any number of retries; max_attempt_reached does not apply, and the Blocked status for the user is not reset after the password is reset. As a result, after you successfully reset a requester’s password, the you must manually unblock the user.

If the user is not unblocked manually, then the system resets the blocked state only when the max_attempt_window time period elapses and the user tries to reset the password using self-service.

1. Navigate to Password Reset > Blocked Users.
2. Change the Blocked setting for the user from true to false.
Monitoring Password Reset and Password Change activity

The Password Reset application provides a number of tools for monitoring and troubleshooting password reset activities.

Users with the password_reset_credential_manager or password_reset_admin role can view and quickly determine the status of password reset activities, identify potential security threats, and monitor for compliance with your organization's password security policies.

The Reset Requests, Activity Log, and Blocked Users modules are useful for monitoring password reset activities and for troubleshooting password reset issues. They also provide access to more detailed information than the Overview module offers.

Password Reset Overview module

The Password Reset > Overview module displays reports on password reset and password change activities.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Requests (last 7 days)</td>
<td>Number of password reset requests by type over the last 7 days.</td>
</tr>
<tr>
<td>Blocked Users (last 7 days)</td>
<td>Number of users blocked over the last 7 days.</td>
</tr>
<tr>
<td>Password Reset Request Status (last 7 days)</td>
<td>The current status of all password reset requests by process.</td>
</tr>
<tr>
<td>Password Reset Request by Action (last 30 days)</td>
<td>Number of password reset requests by action type: <em>Reset Password</em>, Unlock Account, or Reset and Unlock.</td>
</tr>
<tr>
<td>Password Reset Top Users (last 30 days)</td>
<td>Number of password reset requests per user. A large number of password reset requests from a single user could indicate a security issue.</td>
</tr>
<tr>
<td>Password Reset Failed Verifications (last 7 days)</td>
<td>Number of failed verification attempts, by verification instance. A failed verification occurs when a user attempts to reset their password, but fails for one reason or another, during the identity verification step. A large number of failed verification attempts for a specific type of verification could indicate that the process is too complicated or unclear.</td>
</tr>
<tr>
<td>Password Reset Enrollment By Verification</td>
<td>Number of users by verification type who have and have not enrolled in the password reset program. A large number for users who have not enrolled could indicate a compliance or communication issue within the organization.</td>
</tr>
<tr>
<td>Password Change Top Users (last 30 days)</td>
<td>Number of password change requests per user. A large number of password change requests from a single user may indicate a security issue.</td>
</tr>
</tbody>
</table>
To make room for new data, the system periodically purges the data that is used for password reset monitoring and reporting.

Users with the password_reset_admin role can customize the layout of the reports that appear in the Overview module.

Write to the ServiceNowPwdReset event log

Use the Password Reset event log to monitor the status of password reset activities, identify potential security threats, and monitor for compliance with your organization's password security policies.

Role required: password_reset_credential_manager or password_reset_admin

1. Edit the DebugFlag registry key entry at:
   
   - Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Windows > CurrentVersion > Authentication > Credential Providers > {B6EFF27D-C1C4-481F-B81B-F3547C47D58A}
   
2. By default, the key is set to 0. Set the key to 1 to write log entries to the ServiceNowPwdReset event log.

View the ServiceNowPwdReset event log

Use the Password Reset event log to monitor the status of password reset activities, identify potential security threats, and monitor for compliance with your organization's password security policies.

Role required: admin

1. On the Start menu, click Programs (or All Programs) > Administrative Tools > Event Viewer.
2. The ServiceNowPwdReset log appears.
   
   If the log does not appear, then, on the Windows Logs menu, click Applications > Service Logs.

View the activity log

You can view the activity log, which provides detailed information that can be used for troubleshooting and for generating reports on password reset metrics.

Role required: password_reset_credential_manager or password_reset_admin

Information contained in the activity log is stored in the Password Reset Activity Log [pwd_reset_activity] table.

1. To view the activity log, navigate to Password Reset > Activity Log.
2. Review the information.

Schedule for purging the Password Reset reporting data

To make room for new data, the system periodically purges the data that is used for password reset monitoring and reporting.

Information contained in reports and monitoring tools may change dramatically immediately after a data purge. Contact ServiceNow Technical Support if you need to modify purge intervals.
### Table 168: Purge intervals for password reset tables

<table>
<thead>
<tr>
<th>Table name</th>
<th>Purge interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>[pwd_reset_request]</td>
<td>90 days (7,776,000 seconds). Depending on your organization's data monitoring requirements, you may request that this rule be configured to purge successful requests after 90 days, and to keep failed requests for 120 days.</td>
</tr>
<tr>
<td>[pwd_user_lockout]</td>
<td>90 days (7,776,000 seconds). Depending on your organization's data monitoring requirements, you may request that this rule be configured to purge successful requests after 90 days, and to keep failed requests for 120 days.</td>
</tr>
<tr>
<td>[pwd_reset_activity]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td>[pwd_activity_monitor]</td>
<td>90 days (7,776,000 seconds).</td>
</tr>
<tr>
<td>[pwd_dvc_enrollment_code]</td>
<td>1 day (86,400 seconds).</td>
</tr>
<tr>
<td>[pwd_sms_code]</td>
<td>1 day (86,400 seconds).</td>
</tr>
</tbody>
</table>

**Users: Reset your password on Windows systems**

If your organization has configured the ServiceNow Password Reset Windows Application, you can reset your password directly from your Windows login screen.

1. Start your computer or press **Ctrl+Alt+Delete** to go to the Windows login screen.
2. Click the **Forgot Password?** link. (Your administrator may have configured different text for the link.)

3. On the **Identify** page, enter the requested information and then click **Next**.

4. On the **Verify** page, enter the requested information, and then click **Next**.
   If your identity is verified, the **Reset** page displays whether you were successfully verified and the locked/unlocked state of your account.

5. Perform one of the following actions:
   - If your account is not locked, the page displays the **Reset Password** button. Enter and retype the new password and then click **Reset Password**.
   - If your account is locked, the page displays the **Reset Password** and **Unlock Account** buttons.
     - You can enter a new password and click **Reset password** to reset the password and unlock the account.
     - If your administrator has selected **Enable account unlock** for the password process, you can unlock the account without resetting the password by clicking **Unlock account**.

Users: Enroll in the password reset program

Some organizations auto-enroll users in a password reset program. Your organization may offer you the option to enroll for one or more methods of verifying your identity while you are resetting your password.

The procedure for enrolling depends on the settings specified by the password reset administrator. You may need to enroll using security questions, SMS, or both.

- **Verifying your identity using security questions:** To enroll, you choose multiple questions that only you can answer (like your first pet’s name) and then supply answers. The system stores your answers securely. Later, when you use a web page to request that your password be reset, the system presents one or more of the questions. You answer the questions to verify your identity.
Verifying your identity using SMS codes: To enroll, you authorize a device like a cellular phone for SMS verification. Later, when you use a web page to request that your password be reset, the system sends a numerical code to the device. You enter the code on the web page to verify your identity.

Enroll for identity verification by means of security questions

Your organization can require you to enroll for password reset services using security questions. To enroll, you select questions and provide answers that only you know. At another time, when you request password reset, your answers verify your identity.

Role required: none

1. Navigate to Password Reset > Enrollment.
2. Select a question from the list and enter the answer in the field below it. Repeat the process until the required number of question and answer fields are filled in.
   If you are required to enroll for the security questions verification method, then the Security Questions tab is marked with an asterisk (*).
3. Optional: Enroll for identity verification by means of SMS codes.
4. Click Submit.

Enroll for identity verification by means of SMS codes

The process of verifying your identity using SMS codes works as follows: When you use a web page to request password reset, the system sends a numerical code to the mobile device that you specified in your Password Reset profile. You then enter the code on the web page to verify your identity.

Role required: none

1. Navigate to Password Reset > Enrollment.
   If you had previously added an SMS-enabled device to your user profile, the device is listed.
2. To add a device, click Add Device and then follow the instructions to add and verify the device. You should provide a meaningful Name for each device. Repeat the process for as many devices as you need.
3. After you have verified each device, select the Authorized check box for each device that you expect to use to change or reset your password.
   Note: You can deauthorize a device at any time by clearing the Authorized check box.
5. Click Submit.

Problem Management

Problem Management helps to identify the cause of an error in the IT infrastructure that is usually reported as occurrences of related incidents.

Resolving a problem means fixing the error that will stop these incidents from occurring in the future. While Incident Management deals with fighting symptoms to incidents, Problem Management seeks to remove the causes of incidents permanently from the IT infrastructure. Problem resolution and elimination of root cause often calls for applying a change to the configuration item in the existing IT environment.

The ServiceNow platform supports the Problem Management process with capabilities to record problems, create knowledge from problems, request changes, assign to appropriate groups, escalate, and manage
through to resolution and reporting. This page attempts to detail the out-of-box functionality provided by the platform to manage problems in accordance with the ITIL process.

Within the platform, problems are handled using the task record system. Each problem is generated through a variety of means as a task record, populated with the pertinent information in individual fields. These tasks can be assigned to appropriate problem management team members, who will deal with the task as appropriate. Once the problem has been properly dealt with, the problem task is closed.

Gather problem data

The quick resolution of problems requires gathering as much information about problems as possible. In addition to the information within the problem ticket itself, there is often useful information that can be gathered in other tables.

Check related records

You can find information pertinent to the problem in related records. Common related records include changes (through the RFC field), incidents in the incident related list, security incidents in the security incidents related list, and vulnerable items in the vulnerable items related list. All of the directly related records are accessible through related lists. If the appropriate related list does not appear on the form, add it by configuring the form.

**Note:** The security incidents related list will appear if the Security Incident Response module is activated. The vulnerable items related list will appear if the Vulnerability Response module is activated.

Check known errors and the knowledge base

Another source of information about a problem is documentation about known errors and the knowledge base. Information on already known issues can be found in two places: the Known Errors module in the Problem Management application, or in the Knowledge Base. The Known Errors module filters the problem table to present all of the problems whose cause has been identified, but cannot be fixed. The Knowledge Base may have information gathered from incidents, and may also have useful workarounds for problems.

Use the CMDB

The Configuration Management Database stores information on all of the configuration items and their relationships. In addition to providing basic information about the configuration item to serve as a reference, there are two tools within the CMDB that can provide important information on problems:

- The Business Service Map, which can help isolate problems caused by problems in related items
- The CMDB Baseline, which can help track planned and unplanned changes

Use the Business Service Map

The Business Service Map provides a visual representation of the configuration items and their relationships and displays information on related issues. For example, the following image is a BSM for the CI NY-02-02, a server rack.
Figure 53: BSM for server rack NY-02-02

The caution symbol in the top right-hand corner indicates that there is a problem attached.
Figure 54: Related issues

The light color in on the rack indicates that it is affected by an down-stream CI's incident. In this case, the orange-colored Data Center Zone NY2A has the caution symbol, which indicates that there is an incident attached:
Figure 55: Incident for NY2A

Lastly, one of the upstream CIs is colored in blue. This indicates that the CI has a change record attached:
With this information, we can see not only the CI, but also its relationships upstream and downstream. The rack's problem might be caused by an improper change to the Web Server software on one of its Linux Servers, or it might be caused by the incident logged on the Data Center Zone where it resides.

Use the CMDB baseline

If a baseline has been generated, any changes (planned or unplanned) will be tracked within the system. Since one major cause of problems is improperly executed changes, seeing the history of changes of a configuration item can help the Problem Management team track problems caused by improper changes.

To check the CMDB Baseline, view the CI's record and check the fields Baseline Differences and Scheduled Changes. You may need to configure the form to add these fields.
Figure 57: Problem baseline

This information provides a window into the history of the configuration item. The changes are recorded, including the time of change and the person who recorded the change. In the example above, because the
change in RAM is associated with a change request, it is possible to review the change and see what was planned and what was implemented.

Also in the example, the computer recorded both a planned and an unplanned change. System Administrator changed RAM according to CHG30002, changed the disk space, removed QuickTime, and associated the CI with CHG30002.

Close related incidents from a problem

Once a Problem is considered resolved, all of the incidents related to the problem with the state Awaiting Problem can be closed using a UI action from the Problem form.

**Note:** Functionality described here requires the ITIL role.

To close related incidents with state Awaiting Problem, right-click the header and select Close Incidents:

Figure 58: Closing Related Incidents from a Problem

Problem management service improvements

The problem management process can be improved if the service desk uses information gathered within the platform.

Much of the data is already stored within the incident record. More information can be gathered by enabling auditing, which allows for an accurate review of the history of the problem. Using metrics, it is possible to define the Key Performance Indicators to monitor within the system.

With these metrics, and the information within the database, it is possible to generate reports, which can be added to homepages or scheduled for automatic generation and distribution.

Using this information, it is possible to refine automatic rules such as the assignment rules, service level agreements, or inactivity monitors to better suit the problem management team’s unique environment.

Create knowledge

The ServiceNow knowledge base houses the information an organization needs to keep and share. For example, it might include desktop support information, company/department processes and procedures, and documentation on internally developed applications.

Add information to the knowledge base by performing any of the following tasks.
• Create articles manually.
• Create articles automatically from an incident.
• Create articles automatically from a problem.
• Link to or import content stored in another knowledge base.
• Publish managed documents to the knowledge base.

By default, most new articles are created as drafts and move through a review state before they are published. An exception to the standard workflow is posting news from the Problem form.

If the administrator enables the optional knowledge submission workflow, articles created from incidents or problems become knowledge submissions, which are processed through a different path.

Access an external knowledge article

You can add new search engines to the advanced search function or add links at the top of knowledge pages.

Role required: admin

This lets you configure access to a knowledge base, either public or private, or to a public search engine.

1. Navigate to Knowledge > Administration > Navigation Add-ons.
2. Click New.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the search engine name or link text.</td>
</tr>
<tr>
<td>Type</td>
<td>Select Search or Link.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter a number to indicate the sequence of this search option or link.</td>
</tr>
<tr>
<td>URL</td>
<td>For a link, enter the URL. Leave blank for a search engine.</td>
</tr>
<tr>
<td>Script</td>
<td>For a search engine, enter a script that opens the search engine's results page for the search text. Leave blank for a link.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Communicate a workaround

Role required: itil

The Communicate Workaround option on the Problem form quickly and easily communicates workarounds to multiple users from one place, eliminating the need to manually update each incident.

1. Open the problem for which you have a workaround.
2. Enter the information in the Work notes text box and select the Workaround check box.
3. Click Post.
4. Click the Communicate Workaround related link.
This adds the problem number and the contents of the **Workaround** field as a new entry in the **Activity** field on all related incidents. By default, any entries made in an incident **Activity** field generate an email notification to the **Caller** on the Incident form.

If group on-call rotation scheduling is in effect when you communicate a workaround, the system stops the escalations on the associated incidents because the workaround has been communicated to the end users. This effectively communicates knowledge to the appropriate audience, but does not create a knowledge article.

### Create knowledge from an incident

Incidents within ITIL processes often generate information that may be needed in the future.

**Role required:** itil

The instance can automatically submit relevant information to the knowledge management process when the incident is closed.

1. Select the **Knowledge** check box in the Closure Information section.
2. Resolve and close the incident.

Closing the incident triggers the business rule **Incident Create Knowledge**. By default, the business rule creates a knowledge article in the **Draft** workflow state. The incident **Short description** becomes the article **Short description**. The incident **Additional comments** become the article **Text**.

If the knowledge submission workflow is enabled, the incident **Short description** and **Additional comments** become a knowledge submission instead of an article.

Following is an example of an incident being closed.
And this is the article that appears in the knowledge base.
Options for creating knowledge from a problem

The ServiceNow Problem form includes four options for creating knowledge directly from the problem:

- Knowledge check box
- Communicate Workaround related link
- Post Knowledge related link
- Post News related link

Create knowledge manually

You can create knowledge base articles directly in the Knowledge form.

Role required: admin, knowledge_admin, or knowledge

1. Navigate to Knowledge > Create New.
2. Select a **Category** for the article using the category picker.
   When you select a category in the category picker, any associated subcategories appear in the next column. Select the most appropriate category from any column.

3. Enter a **Short description** to identify the article in the knowledge portal and search results.

4. In the **Text** field, enter the article's content.
   Use HTML or Wiki markup to format the content, according to the **Article type** selection.

5. Complete the form, as appropriate.
   This table describes all fields and buttons on the Knowledge form. Some fields are available only to users with specific roles.

### Table 170: Create knowledge article form

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Do not modify. The record number is assigned by the system and should not be changed.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Select the knowledge base in which the article belongs.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category using the category picker.</td>
</tr>
<tr>
<td>Published</td>
<td>Enter the date the article was published. The current date is used by default.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Enter the date when the article expires. Only published articles within the valid date range are visible to most users.</td>
</tr>
<tr>
<td>Image</td>
<td>Click the lookup icon to select an image that was previously uploaded to the database. The image appears as an icon beside the article name in the knowledge portal.</td>
</tr>
<tr>
<td>Article type</td>
<td>Select the markup language to use for formatting the article.</td>
</tr>
<tr>
<td></td>
<td>• HTML: the Text field offers a WYSIWYG interface with a toolbar to apply formatting and create links. Click the HTML icon on the toolbar to display HTML mode, where you can view and format with HTML markup.</td>
</tr>
<tr>
<td></td>
<td>• Wiki: the Text field offers the Wikitext icon that toggles between a preview of the formatted text and an edit field where you can enter text with Wiki markup language to define formatting.</td>
</tr>
<tr>
<td>Workflow</td>
<td>The workflow state for the article: Draft, Review, or Published. Generally, only published articles appear in the portal. Users with role-based permissions might also see articles in the draft or review state in the portal and search results, depending on administrator settings.</td>
</tr>
<tr>
<td>Source</td>
<td>Click the lookup icon to select the task that formed the basis for this article, if any.</td>
</tr>
<tr>
<td>Roles</td>
<td>Specify user roles to limit who can view the article. Otherwise, all users can view the article after it is published.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Select this check box to have this article's link open a file attachment. To upload the attachment, click the paperclip icon in the upper right corner. The link in the knowledge portal or search results opens the attachment instead of navigating to the text of the article. You can link to one attachment per article.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Select this check box to display a list of attachments below the article. Although you can link to only one attachment (see the Attachment link field), you can attach multiple files and list them below the article in article view.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Enter text to appear as a title for the article in the knowledge portal and search results.</td>
</tr>
<tr>
<td>Text/Wiki</td>
<td>Enter the text of the article. This area accepts either HTML or Wiki Markup, according to the selected Article type.</td>
</tr>
<tr>
<td></td>
<td>If Article type is HTML, you can work in WYSIWYG mode, using the toolbar above the text field to apply formatting and create links. Click the HTML icon on the toolbar to open HTML mode, where you can view and format the text with HTML commands.</td>
</tr>
<tr>
<td></td>
<td>If Article type is Wiki, click the Wikitext icon to toggle between an edit field and the formatted text.</td>
</tr>
<tr>
<td>Update</td>
<td>Click the Update button to save any changes made to the form and return to the article list. To save changes and stay on the form, right-click the header bar and choose Save.</td>
</tr>
<tr>
<td>Mark Public / Mark Internal</td>
<td>Click the Mark Public button to make the article accessible to everyone. This action sets public as the role for the article.</td>
</tr>
<tr>
<td></td>
<td>Click the Mark Internal button to make the article accessible only to the roles specified by the administrator. If no roles are specified, the article is available to the public and there is no change.</td>
</tr>
<tr>
<td>Search for Duplicates</td>
<td>Click this button to search the knowledge base for existing articles that contain similar content.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click this button to delete the knowledge article from the system. You must confirm the request before the record is deleted.</td>
</tr>
</tbody>
</table>

**Note:** If you include a permalink URL to another knowledge article, do not include the `<span id="permatext">` tag that is part of the permalink CSS. If you do, the normal permalink at the bottom of the article does not render correctly.

6. Click Submit.
Make an attachment visible

As with other records, you can add attachments to knowledge articles.

Role required: admin, knowledge_admin, or knowledge role

By default, the attachments appear only to users with the admin, knowledge_admin, or knowledge role, who can view the knowledge record.

1. Navigate to Knowledge > Published and select the article, or click the Edit Article button when viewing the article.
2. Select the Display attachments check box to display a list of attachments to users viewing the article.
   You may need to configure the Knowledge form to display this field.
   A list of attachments appears below the article.

Modify the UI Action

You can modify the behavior of the Communicate Workaround, Post Knowledge, and Post News related links.

Role required: admin

1. Navigate to System Definition > UI Actions.
2. Locate and open the UI action with the same name as the related link to modify.
3. Edit the UI action and click Update.

Post news

You can quickly create and publish a knowledge article in the News category.

Role required; itil

1. Open the problem from which to post news.
2. Click the Post News related link.
   The resulting knowledge article contains the following information.
   • The problem number and Short description become the knowledge article Short description.
   • The problem Description and Work notes become the knowledge article Text.
   • The problem Configuration Item becomes the knowledge article Configuration Item for the Affected Products related list.

By default, the Post News related link creates an article in the Published workflow state. These articles appear in the News category of the knowledge portal immediately.

If the knowledge submission workflow is enabled, the problem Short description and Work notes are placed into a knowledge submission instead of an article.

Post knowledge

You can create a knowledge article from the problem immediately, and not wait for when the problem is closed.

Role required: itil, knowledge

1. Open a problem from which to post a knowledge article.
2. Click the Post Knowledge related link.

The resulting knowledge article contains the following information:

- The problem number and Short description become the knowledge article Short description.
- The problem Description and Work notes become the knowledge article Text.
- The problem Configuration item becomes the knowledge article Configuration Item.
- The article Topic is set to Known Error.

By default, the system creates a knowledge article in Draft workflow state. If the knowledge submission workflow is enabled, the problem Short description and Work notes are placed into a knowledge submission instead of an article.

Use the knowledge check box

As with incidents, problems within ITIL processes often generate information that may be needed in the future.

Role required; itil

The system can automatically submit a knowledge article when a problem is closed.

1. Select the Knowledge check box on the Problem form.
2. Resolve and close the problem.

Closing the problem triggers the business rule Problem Create Knowledge. By default, the business rule creates a knowledge article in the Draft workflow state, ready for a knowledge team member to review and publish. The problem Short description becomes the article Short description, and the problem Work notes become the article Text.

If the knowledge submission workflow is enabled, the problem Work notes become a knowledge submission instead of an article.

Problem Management process

Identify and log problems

A problem can be generated in a number of ways:

- An IT staff member can generate one manually using Problem > Create New or by clicking New from the problem record list.
- An IT staff member can generate a problem from an incident.
- A record producer can be created to allow users to log problems in the service catalog.
- If a user attempts to create a generic task, the task interceptor asks them to specify what type of task to create. In this way, tasks are always assigned a handling process.
- If an appropriate inbound email action is configured, a problem can be generated from an email.

A problem can be associated with a configuration item using CMDB to help the problem management team see the affected item and its relationships to other configuration items.

A problem can be assigned to a user or group. This can be done manually, or using an assignment rule.

A problem can be associated with one or more incidents in the Incidents related list. The association is automatic if the problem is generated from an incident. This allows the problem management team to access the knowledge generated by the service desk during incident investigation.
Investigate and update problems

If the problem management team has a problem model process for dealing with certain problems, they can be codified in the system with workflows. This allows for standardization and automation of the process.

**Note:** The ServiceNow platform also provides the Structured Problem Analysis application as a method for identifying the true root cause of a problem.

As a problem is updated, email notifications are sent to concerned parties. If *inbound email actions* are specified, the problem can be updated via email.

The platform has an in-built system of escalations rules which can ensure that problems are handled speedily. Two escalators are available in the system.

- Service level agreements: SLAs monitor the progress of the problem according to defined rules. As time passes, the SLA will escalate the priority of the problem, and leave a marker as to its progress. SLAs can also be used as a performance indicator for the problem management team.
- Inactivity monitors: The inactivity monitors prevent incidents from being overlooked by generating an event, which can create an email notification or trigger a script, when a problem has not been updated within a certain amount of time.

Resolve problems

If a problem needs a change request to be resolved, it is possible to *request a change*, which is resolved using the change management process. After a change has been requested, the problem appears on a related list on the change item's form. After the problem is associated with a change item, change the problem state to *Pending Change*.

You can create a business rule to close the problem automatically if the change associated with it is closed. This automates the process of closing problems that are *Pending Change*. You can also create a business rule that automatically close all incidents associated with the problem if the problem is closed.

If a problem's cause has been determined but there is no permanent fix, changing the problem state to *Known Error* communicates this fact to the IT staff. This helps reduce the time spent on other incidents that have the known problem by making known errors easy to find, as a list of Known Errors is automatically generated. To communicate knowledge related to a problem to users, you can open the problem and communicate a workaround, create a knowledge base article, or create a news item.

Create a problem template

Role required: admin

1. Navigate to **System Definition > Templates** and click **New**.
2. Complete the form using the following information.
   - **Name:** Performance Issues
   - **Table:** Problem
   - **Global:** Selected (true). This allows any user to use the template.
   - **Short Description:** Performance Issues
   - **Template:** Select each field and enter the value listed below.
     - **Description:** Significant performance issues have affected the configuration item.
     - **Impact:** 2 - Medium
• **Urgency**: 1 - High
• **Contact Type**: Self-service

This defines the field values that are filled in by the template.

3. Click **Submit**.

### Problem templates

You can create templates that store populated versions of the problem form for reuse, which saves time by reducing the amount of time spent filling out the form.

**Role required**: admin

By defining common problems as templates, an administrator can save time for service desk members later, allowing them to focus on solving the incidents at hand.

After a template is defined, it can be used from a record producer or from a module.
Use a template from a module

This example demonstrates how to place the Performance Issues template in a module in the Self-Service application to enable users to directly file the problem using the template.

Role required: admin

1. Perform the appropriate action for your version of the UI:

| UI16 | 1. Navigate to **System Definition > Application Menus**.  
|      | 2. Open the **Self-Service** application menu. |
| UI15 or UI11 | Right-click **Self-Service**, and select **Edit Application Menu**. |

2. Scroll to the **Modules** related list and click **New**.

3. Complete the form with the following information.
   - **Title**: Report Performance Issues
   - **Application menu**: Self-Service
   - **Order**: 473. This order places the new module after **Requested Items** in the Self-Service application. Order can be viewed by looking at the **Modules** related list on the Application form.
   - **Hint**: Log a problem about performance issues.
   - **Link Type**: New Record
   - **Table**: Problem [problem]
   - **Arguments**:

   ```
   problem.do?sys_id=-1&sysparm_template=Performance Issues
   ```

   This argument deploys the template in the new problem record.

4. Click **Submit**.

   The new module appears in the Self-Service application.

Use task outage

Task-outage relationship enables users to create an outage from an incident or problem form.

The Task-Outage Relationship plugin creates a many-to-many relationship between the Task [task] table and the Outage [cmdb_ci_outage] table, and includes the UI Action Create Outage Record. The Task-Outage Relationship plugin can be activated by an administrator.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>

The business rule Add Short Description is included in the plugin, to add a short description to outages in the following format "CI Name Outage."
The UI Action Create Outage Record is added to the Task [task] table to create outages directly from the task form.

Add the UI action to another task form

By default, the create outage record is available on the incident and problem tables and can be added to either task form.

Role required: admin

1. Navigate to System Definitions > UI Actions.
2. Select the UI Action Create Outage.
   By default, the condition is:
   \[
   \text{current.getRecordClassName() == 'incident' || current.getRecordClassName() == 'problem'}
   \]
3. Alter the Conditions field as described in the examples below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add this UI Action to the Ticket [ticket] table</td>
<td>current.getRecordClassName() == 'incident'</td>
</tr>
<tr>
<td>To use the UI Action on only the Incident [incident] table</td>
<td>current.getRecordClassName() == 'incident'</td>
</tr>
</tbody>
</table>

4. Click Update.

Associate a task to an outage

You can associate a defined outage with tasks.

Role required: itil

1. Navigate to the outage record.
2. Add the Task related list to the form.
3. Click Edit on the related list to add or remove tasks.

Create an outage from a task

Role required: itil

1. Navigate to the task record.
2. Right-click the header bar and select Create Outage Record from the context menu.
3. Populate the Outage record as appropriate.
   If a Configuration Item was specified on the task, it is associated with the outage.

When you save the outage, it appears in the Outage related list on the task form.
Use a UI action to create a record

You can create a record on one table based on information contained in a record on another table, for example, create a change request from a problem record.

Role required: itil

Three record UI actions are available in the base system.

• Incident forms have Create Problem
• Incident forms have Create Change
• Problem forms have Create Change

1. Navigate to an incident or problem record to be created from.
2. Right click the form header.
3. Click the desired UI action.

The new record opens, and you can complete the information and save it.

Add related records

You can create a related list of records on the new record in order to keep track of records on the original table.

For instance, the Problem form has a list of related incidents, which might include the incident the problem was created from (if the problem was created from an incident).

If the related list is already present on the form, the record should already appear on the related list. More can be added to the related list by clicking the Edit button.

If the related list does not already appear, right click the form header bar and select Configure > Related lists. Use the slushbucket to add the appropriate related list.

Close related records automatically

Task records on the related list typically do not close by default when the current task record is closed.

This can be achieved by scripting a custom business rule.

Configure a custom UI action

You can configure a custom UI action to create a record on another table.

Role required: admin

The set of default UI actions can be used as a template for configuring similar UI actions on other pages.

For example, you can use the Problem UI action to create a Create Change UI action on any release form.

The Problem UI action is a better template to use than the Incident UI action.

Note: This functionality requires a knowledge of Javascript.

To configure a Custom UI Action:

1. Navigate to System Definition > UI Actions
2. Select the Create Normal Change record that has Problem in the table field.
3. Right click the header bar and select Insert and Stay.
4. Update the condition and script as appropriate.
5. Change the table to the desired new table. This is the table from which new records will be created.

After the table is changed, the new record is automatically saved and the record view is displayed.

Perl API problem

An object representation of a problem in the ServiceNow platform. Provides subroutines for querying, updating, and creating problems.

Constructor - new

new(Configuration);

Example:

```perl
$problem = ServiceNow::ITIL::Problem->new($CONFIG);
```

Takes a configuration object and manufactures a Problem object connected to the ServiceNow instance.

Subroutines inherited from Task.pm

- attach
- close
- create
- queryJournal
- reassign
- reopen

Subroutines inherited from GlideRecord.pm

- addQuery
- getValue
- getDisplayValue
- setValue
- next
- insert
- query
- update

Customize UI action behavior

You can customize the behavior of UI actions.

Role required: admin

The following example customizes the behavior of the Close Incidents UI action to close all incidents related to the current problem

1. Navigate to System UI > UI Actions.
3. Alter the script as necessary. For example, remove the following line to close all incidents related to the current problem, regardless of the incident state.

```java
incident.addQuery("incident_state", ",=", 3);
```

4. Click **Update**.

**Define an assignment rule for problems**

After a problem is logged, it must be assigned to the appropriate group or individual to handle the problem. You can define assignment rules to automate the assignment process.

Role required: admin

In this example, define an assignment rule to assign database problems to the database group.

1. Navigate to **System Policy > Assignment** and click **New**.
2. Complete the form using the following information.
   - **Name**: Database Problems
   - **Applies To** section:
     - **Table**: Problem [problem]
     - **Conditions**: Dot-walk to [Configuration Item.Class] [is] [Database]
   - **Group** in the Assign To section: Database
3. Click **Submit**.
4. Test the assignment rule by completing the following steps.
   a) Navigate to **Problem > Create New**.
   b) Complete the problem form and select a configuration item with a class of Database.
   c) Click **Submit**.
   d) Open the problem and verify that the assignment group was added.

**Define an inbound email action for problems**

Inbound email actions enable users to log or update incidents or other tasks on an instance via email. You can define an inbound email action to log problems.

Role required: admin

The inbound email action parses the email and responds using a script. No problem management inbound email actions are provided in the base system.

1. Navigate to **System Policy > Inbound Actions** and click **New**.
2. Complete the form with the following information.
   - **Name**: Log Problem
   - **Type**: New
   - **Active**: True
   - **Target Table**: Problem [problem]
• **Condition** in When to run section:

```javascript
\email.subject. indexOf ( "Problem: " ) == 0
```

• **Script** in Actions section: Insert the following:

```javascript
//Note: current.opened_by is already set to the first UserID that matches the From: email address
current. description = email. body_text ;
current. short_description = email. subject. toString ( ). substring ( 9 ) ;

current. assignment_group. setDisplayValue ( "Development" ) ;

if (email. body. assign != undefined )
current. assigned_to = email. body. assign ;
current. insert ( ) ;
```

3. Click **Submit**.

**Request a change from a problem**

After a problem is identified and isolated, it may require changes to be made through the organization's Change Management process.

Role required: itil

This is easily accomplished from within the problem record.

1. Open the problem record.
2. Right click the form header bar and select **Create Change**.

   The Change Request form opens with information populated from the problem.

To modify how the Create Change UI action works, navigate to System Definition > UI Actions. Select the Create Change UI action that specifies Problem in the Table column.

**Procurement**

Procurement managers can use the Procurement application to create purchase orders and to obtain items for fulfilling service catalog requests.

Procurement offers the ability to perform the following functions.

• Track service catalog requests
• Create and manage purchase orders
• Create and manage transfer orders
• Receive assets

**Procurement roles**

The Procurement application uses the following roles.
### Procurement workflows

Procurement uses the following workflows.

- In the Service Catalog Request workflow, items ordered from the service catalog that cost over one thousand dollars require approval.
Figure 59: Service catalog request workflow

- In the Source Request workflow, catalog tasks are created so that a procurement manager can source the item by creating a transfer order or purchase order.

Figure 60: Source request workflow

These workflows are provided in the base system. You can edit these workflows in the graphical workflow editor or create a workflow to better fit your organization's procurement needs.
Use the Procurement Overview module

Use the gauges on the Procurement Overview homepage to help you track and manage requests, purchase orders, and other important aspects of the procurement process.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Overview.
2. Click elements within the gauges to obtain more information.
   For example, click a request number to view the request record.

Activate Procurement

You can activate the Procurement plugin that provides core procurement capabilities.

Role required: admin

1. Navigate to System Definition > Plugins.
2. Right-click the plugin name on the list and select Activate/Upgrade.
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the Load demo data check box.
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click Activate.

Components installed with Procurement

Several types of components are installed with Procurement.

Demo data is available with Procurement. The demo data provides sample requests, purchase orders, purchase order line items, and receiving slips.

Business rules installed with Procurement

Procurement plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust remaining quantity</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Calculates the remaining quantity of items ordered on a purchase order line item by subtracting the amount received from the amount ordered.</td>
</tr>
<tr>
<td>Can request be sourced</td>
<td>Request [sc_request]</td>
<td>Checks if a request can be sourced.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cancel Procurement Orders</td>
<td>Request [sc_request]</td>
<td>Cancels all unreceived purchase orders and unshipped transfer order lines associated with the request's items if the request state changes to <strong>Closed Cancelled</strong>.</td>
</tr>
<tr>
<td>Check if req item is sourced</td>
<td>Requested Item [sc_req_item]</td>
<td>Sets the <strong>Sourced</strong> field on the parent request to <strong>true</strong> if all requested items have been sourced.</td>
</tr>
<tr>
<td>Check if request is sourceable</td>
<td>Requested Item [sc_req_item]</td>
<td>Checks if the request associated with a requested item can be sourced (obtained from a transfer order or by creating a purchase order to a vendor).</td>
</tr>
<tr>
<td>Create Assets</td>
<td>Receiving Slip Line [proc_rec_slip_item]</td>
<td>If the purchase order line item is available, creates the assets for a receiving slip line when the slip line assets are received.</td>
</tr>
</tbody>
</table>
| Handle roll up states and assets removal  | Purchase order line items [proc_po_item] | Manages purchase order line items if they are canceled or received. If a purchase order line is canceled, this business rule deletes any pre-created assets. 
This business rule also checks the status of other purchase order lines that share the same purchase order and, if necessary, updates the status of the purchase order. For example, when the last purchase order line is received, the status of the purchase order changes to **Received**. |
<p>| Redirect TOL to existing TO-Procurement   | Transfer Order Line [alm_transfer_order_line] | Attaches a transfer order line to an existing transfer order if the transfer order is in the <strong>Draft</strong> stage and has the same <strong>From stockroom</strong> and <strong>To stockroom</strong> values as the transfer order line. |
| Shipping Cost Changes                     | Purchase Order [proc_po]    | Recalculates the total cost of the purchase order if the shipping rate changes.                                                            |</p>
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Change</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Marks the requested item as Received if the state of the associated transfer order line changes to Received.</td>
</tr>
<tr>
<td>State Change</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Sets the time at which the purchase order line item is ordered and updates the original requested item when the purchase order line item is received.</td>
</tr>
<tr>
<td>State Change PO</td>
<td>Purchase Order [proc_po]</td>
<td>Changes the purchase order line item status when the status of the associated purchase order changes.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Calculates the total order cost based on the cost of individual items and the quantity ordered. When you receive a purchase order line item, this business rule also takes the following steps.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Populates the List price field with the value from the Cost field unless you enter a different value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Calculates the Total list price field value by multiplying the List price and Ordered quantity values.</td>
</tr>
<tr>
<td>Update expected delivery date for PO</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Sets the Expected delivery date for purchase orders to the latest purchase order line Expected delivery date.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Update expected delivery date for POLs | Purchase Order [proc_po]           | Sets the **Expected delivery date** of associated purchase order lines to the purchase order's **Expected delivery date** if at least one of the following conditions is true.  
• The purchase order line has no expected delivery date.  
• The purchase order line's expected delivery date is later than the purchase order's expected delivery date.  
• The purchase order line's expected delivery date is the same as the purchase order's previous delivery date. |
<p>| Update Ordered Date                   | Purchase Order [proc_po]           | Sets the <strong>Ordered date</strong> field to the date and time at which the status of the purchase order is set to <strong>Ordered</strong>.                           |
| Update PO                             | Purchase order line items [proc_po_item] | Updates the purchase order if the cost of any purchase order line item changes.                                                            |
| Update Purchase Order Line            | Receiving Slip Line [proc_rec_slip_item] | Updates the <strong>Quantity received</strong> field on the associated purchase order line item when a receiving slip item is received.              |
| Update Request Item CI                | Hardware [alm_hardware]            | Sets the <strong>Configuration item</strong> field on the catalog task and requested item to the related hardware CI created during the procurement process. |</p>
<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide request item if request is not empty</td>
<td>Catalog Task [sc_task]</td>
<td>Displays the task’s Request item and the request item’s Requested for value if the task is associated with a requested item and not directly with a request. Otherwise, if the task is associated with a request, the client script displays the Request and the request's Requested for value.</td>
</tr>
<tr>
<td>Purchase Order Line Mandatory</td>
<td>Receiving Slip Line [proc_rec_slip_item]</td>
<td>Changes the Purchase Order Line field on the Receiving Slip Line form to mandatory if the associated receiving slip has a listed purchase order.</td>
</tr>
</tbody>
</table>

**Script includes installed with Procurement**

Procurement plugin adds the following script include.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcurementUtils</td>
<td>Provides utilities for Procurement.</td>
</tr>
</tbody>
</table>

**Tables installed with Procurement**

Procurement plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order [proc_po]</td>
<td>Stores information about items ordered, cost of items ordered, and users that require the items for orders placed with a vendor.</td>
</tr>
<tr>
<td>Purchase order line items [proc_po_item]</td>
<td>Stores information about items and quantity ordered on purchases orders.</td>
</tr>
<tr>
<td>Receiving Slip [proc_rec_slip]</td>
<td>Stores receiving information for items ordered with a purchase order. Can reference multiple receiving slip lines.</td>
</tr>
<tr>
<td>Receiving Slip Line [proc_rec_slip_item]</td>
<td>Stores receiving information for items ordered on a specific purchase order line, such as the items ordered, quantity ordered, and who ordered them.</td>
</tr>
</tbody>
</table>

**User roles installed with Procurement**

Procurement plugin adds the following user roles.
<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>procurement_admin</td>
<td>procurement_user</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can refresh, add, delete, and rearrange gauges in the Procurement Overview module.</td>
</tr>
<tr>
<td>procurement_user</td>
<td>financial_mgmt_user, model_manager</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can view and refresh gauges in the Procurement Overview module.</td>
</tr>
</tbody>
</table>

**Request items source**

A request from the service catalog can contain multiple items that need to be obtained or sourced.

There are two methods of sourcing an item.

- Items in a stockroom can be transferred to a different stockroom.
- Items not in a stockroom can be ordered, with a purchase order, and delivered to a specific stockroom.

Although there are separate procedures for creating a transfer order and a purchase order from a request, both procedures may be used for a single request. For example, on a request that contains four items to source, two items are available to transfer from a stockroom and two must be purchased from vendors. Only items with an assigned model can be sourced. Sourcing bundles is not supported.

**Create a purchase order from a request**

You can create a purchase order directly from a request. This enables procurement managers to obtain items and fulfill requests from the Service Catalog.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Requests > Requests.
2. Click the Number of a request that has been approved but not sourced. Look in the Request State and Sourced columns.
3. In the Catalog Tasks related list, click a Number.
4. Click Source Request.
5. In Destination Stockroom, select the stockroom to which the requested item or items should be delivered.
6. Select the **Create PO** check box for each item that needs to be purchased. If the product is available from a single vendor, the vendor name is added to the **Vendor** field automatically. If the item is available from multiple vendors, a choice list appears in the **Vendor** field.

7. Select a vendor from the list. If the selected vendor does not have the item, the **Vendor Out of Stock** field shows **Out of Stock**. This can be configured in the **Out of Stock** option on the Vendor Catalog Item form.

8. Optional: Select the **Consolidate Purchase Orders** check box to combine the listed items with existing purchase orders.

When Consolidate Purchase Orders is checked, all items sourced from the same vendor on the same request are placed on the same purchase order. When a vendor is selected, the system automatically searches for purchase orders that have been created for the same request, have the same **Vendor** selected, and have the **Requested** status. If the system finds a match, all items are placed on the same purchase order and can be ordered together. If the system does not find a match, a new purchase order is created.

For example, if you are purchasing 25 phones from Apple and an open purchase order already exists for Apple, the 25 phones are added to the open purchase order. If there are no open purchase orders
for the selected vendors, new purchase orders are created. Items ordered from the same vendor are grouped together. Different items are shown on separate lines on the purchase order.

9. Click **OK**.

   the catalog task reopens and you see a message that the purchase order was created. When you view the request, the **Sourced** check box is selected.

Create a transfer order from a request

You can create a transfer order directly from a request to source items from stockrooms.

Role required: procurement_admin or procurement_user

When an item is sourced with a transfer order, the system automatically looks for an existing transfer order to which the new order can be added. When transfer orders are combined, items can be received more quickly and efficiently. Transfer orders created in the Procurement application are not merged or combined with transfer orders created from other applications, like in Work Management.

For a new request to merge with an existing transfer order, the existing transfer order must have the following characteristics:

- Was created in the Procurement application
- Has the state set to **Draft**
- Has the same **Type** value as the new request. Configure the transfer order record to add the **Type** field.
- Has the same **From Stockroom** value as the new request
- Has the same **Destination Stockroom** value as the new request

1. Navigate to **Procurement > Requests > Requests**.
2. Click the request **Number** of a request that has been approved but not sourced.
   
   Check the **Request State** and **Sourced** columns.
3. In the **Catalog Tasks** related list, click a **Number**.
4. Click **Source Request**.
5. In **Destination Stockroom**, select the stockroom to which the requested item or items should be delivered.
6. In **From Stockroom** for each item, select a stockroom from which the item should be sourced.

7. Click **OK**.
A transfer order is created to move the item or items from the **From Stockroom** location to the **Destination Stockroom** location. When you view the request, the **Sourced** check box is selected.

### Procurement purchase order management for assets

Accurate purchase order information is important for invoice tracking, receiving, and reporting in the ServiceNow platform.

The Procurement application enables users with an appropriate procurement role to manage purchase order information for assets. It also provides direct access to service catalog requests. You can create purchase orders and transfer orders directly from requests.

Before using the Procurement application, create assignment groups for catalog tasks. Assignment groups are sets of users, filtered by location, who can perform catalog tasks.

### Track a request from the service catalog

The Procurement application lets you track a request that was ordered from the service catalog.

**Role required:** procurement_admin or procurement_user

When a user places an order from the service catalog, a request record is created to track the order. Each ordered item becomes a requested item that is listed on the request record. For example, a single request for 1 laptop, 2 monitors, and 1 keyboard creates the following records.

Request REQ00000001: 4 items
- Requested Item RITM00000001: 1 laptop
- Requested Item RITM00000002: 2 monitors
- Requested Item RITM00000003: 1 keyboard

1. Navigate to **Procurement > Requests > Requests**.
2. Click a request **Number**.

   The **Requested Items** related list displays the items that were ordered. You can view the requested item, or view associated **Purchase Orders** and **Transfer Orders** on other related lists. A catalog task is automatically generated for each requested item to identify the source of the item, whether it needs to be purchased or transferred from a stockroom.

### Cancel a request from the service catalog

You can cancel a request from the service catalog if, for example, the item is no longer needed or the request was not approved.

**Role required:** catalog_admin, procurement_admin, or procurement_user

When a service catalog request is canceled, the following actions occur automatically.

- Associated purchase orders that have not been received are canceled.
- All procurement tasks are canceled.
- Associated transfer orders are canceled, if all transfer order lines related to the transfer order are also associated with the service catalog request and the transfer order lines have all been canceled. If the transfer order contains transfer order lines that are not related to the service catalog request and those lines have not been canceled, the transfer order is not canceled.
Associated transfer order lines that are in the **In Transit** or **Delivered** stages are not canceled.

1. Navigate to **Procurement > Requests > Requests**.
2. Click a request **Number**.
3. Click **Cancel Request**.

### View and edit a catalog task

Catalog tasks are used to source items and fulfill requests. You can view and edit catalog tasks from a request.

**Role required:** procurement_admin or procurement_user

If a request requires approval, a catalog task is created automatically when the request is approved. If a request does not require approval, a catalog task is created automatically when the request is created.

**Note:** If a request contains one requested item and the item has no model specified, a catalog task is not created automatically. If a request has multiple requested items and only some of them have a model specified, catalog tasks are created automatically, but only for the requested items with a model.

1. Navigate to **Procurement > Requests > Tasks**.
2. Open a catalog task.
3. Edit the fields as necessary.

#### Table 172: Catalog task fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the catalog task.</td>
</tr>
<tr>
<td>Request</td>
<td>The number of the request to which the catalog task is associated. The information in this field is derived from the <strong>Number</strong> field on the Request form.</td>
</tr>
<tr>
<td>Request item</td>
<td>The number of the requested item to which the catalog task is associated. The information in this field is derived from the <strong>Number</strong> field on the Requested Item form.</td>
</tr>
<tr>
<td>Requested for</td>
<td>The name of the person for whom the associated item was requested. The information in this field is derived from the <strong>Request</strong> or <strong>Request item</strong> field.</td>
</tr>
<tr>
<td>Due date</td>
<td>The date by which the catalog task should be completed.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>The configuration item associated with the <strong>Request Item</strong>.</td>
</tr>
<tr>
<td>Approval</td>
<td>The status of catalog task approval: Not Yet Requested, Requested, Approved, or Rejected.</td>
</tr>
</tbody>
</table>
4. Click Update.

Create a purchase order

You can create a purchase order. Purchase orders specify assets to order from a single vendor.

Role required: procurement_admin or procurement_user

For example, an organization can create a purchase order to buy 20 laptop computers or 10 servers. Information on a purchase order enables physical and financial tracking of the assets that were ordered.

You can also use a transfer order if an asset is already owned by an organization. A transfer order is used to internally transfer assets from one stockroom to another instead of purchasing the assets. For example, a company stockroom in New York has five laptops that are needed in Boston. You create a transfer order to move the laptops from the New York stockroom to the Boston stockroom.

After you create a purchase order, the Receiving Slip related list is available on the Purchase Order form. A receiving slip is created manually or automatically when the item is received. The Receiving Slip related list shows all receiving slips related to the purchase order. After a receiving slip is added to a purchase order, all fields on the purchase order record become read-only.

1. Navigate to Procurement > Orders > Purchase Orders.
2. Click New.
3. Complete the form.

Table 173: Purchase order fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due by</td>
<td>The date by which the purchase order <strong>Total cost</strong> must be paid.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier to which the purchase order was issued.</td>
</tr>
<tr>
<td>Ship to</td>
<td>The stockroom to which items on the purchase order should be shipped.</td>
</tr>
<tr>
<td>PO date</td>
<td>The date on which the purchase order was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order: <em>Canceled, Ordered, Received, Requested, or Suspended.</em></td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to whom the purchase order is assigned.</td>
</tr>
<tr>
<td>Bill to</td>
<td>The location responsible for paying the purchase order <strong>Total cost</strong>.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the purchase order.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Shipping</td>
<td>The delivery method to be used when shipping the items on the purchase order.</td>
</tr>
<tr>
<td>Terms</td>
<td>The purchase order payment terms: <em>Credit, Net 30 days, or Net 90 days.</em></td>
</tr>
<tr>
<td>Ship rate</td>
<td>The amount that must be paid for the delivery method specified in the <strong>Shipping</strong> field.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The sum of all item costs on the purchase order and the shipping costs.</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the purchase order contents.</td>
</tr>
<tr>
<td>Details section</td>
<td></td>
</tr>
<tr>
<td>Initial request</td>
<td>The record number of the request that requires the items on the purchase order.</td>
</tr>
<tr>
<td>Requested by</td>
<td>The user requesting the items on the purchase order.</td>
</tr>
<tr>
<td>Requested</td>
<td>The date the user in the <strong>Requested by</strong> field requested the items on the purchase order.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time the <strong>Order</strong> button is clicked on the Purchase Order form.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the items associated with the purchase order are expected to arrive in the stockroom identified in the <strong>Ship to</strong> field. This field cannot be edited when the purchase order has a <strong>Status</strong> of <strong>Received</strong> or <strong>Canceled</strong>. (For more information about this field, see <em>Purchase order expected delivery date</em> on page 542.)</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order status changed to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Contract</td>
<td>The record number of the contract with the vendor from which the items on the purchase order are ordered.</td>
</tr>
<tr>
<td>Department</td>
<td>The department responsible for paying for the purchase order.</td>
</tr>
<tr>
<td>Budget number</td>
<td>The budget number associated with the purchase order.</td>
</tr>
<tr>
<td>Vendor account</td>
<td>The vendor account associated with the purchase order.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Add purchase order line items to specify what you are ordering from this vendor.

**Create a purchase order line item**

After you save a new purchase order, you create purchase order line item records to specify the individual items to order.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, click **New**.
4. Complete the form.

**Table 174: Purchase order line item fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order line item.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier from which this product should be ordered.</td>
</tr>
<tr>
<td>Product Model</td>
<td>The model of the purchase order line item.</td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The product catalog category to which the product model is assigned. For example, <strong>Hardware</strong>, <strong>Software</strong>, or <strong>Supplies</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Part number</td>
<td>The identification number assigned to the product model.</td>
</tr>
<tr>
<td>Request line</td>
<td>The identification number of the requested item record associated with this purchase order line item.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time at which this purchase order line item was ordered.</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the purchase order line item is expected to arrive in the stockroom identified in the <strong>Ship to</strong> field on the purchase order record. This field is automatically filled with the value in the <strong>Expected delivery</strong> field on the purchase order record. This field can be edited when the purchase order line item has a <strong>Status</strong> of <strong>Requested</strong>. For more information about this field, see <em>Purchase order expected delivery date</em> on page 542.</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order line item status was changed to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Purchase order</td>
<td>The purchase order record number associated with this purchase order line item.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order line item: <strong>Canceled</strong>, <strong>Ordered</strong>, <strong>Pending Delivery</strong>, <strong>Received</strong>, or <strong>Requested</strong>.</td>
</tr>
<tr>
<td>Ordered quantity</td>
<td>The number of product models that were ordered.</td>
</tr>
<tr>
<td>Received quantity</td>
<td>The number of product models that were shipped and received. The vendor may have sent multiple shipments. The received quantity can be larger or smaller than the <strong>Ordered</strong> quantity. For example, you may have ordered five laptops but the vendor sent six.</td>
</tr>
<tr>
<td>Remaining quantity</td>
<td>The number of product models that still need to be received to fulfill the <strong>Ordered</strong> quantity.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List price</td>
<td>The price at which the item retails, not including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the list price from the associated vendor catalog item. If the vendor catalog item does not have a list price value and you have not entered a value, this field is automatically populated with the value from the Cost field.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single product model, including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the cost from the associated vendor catalog item.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The cost of a single product model multiplied by the value specified in Quantity.</td>
</tr>
<tr>
<td>Short description</td>
<td>A few words or short phrase describing the purchase order line item.</td>
</tr>
</tbody>
</table>

5. **Click Submit.**  
The purchase order reopens with the line item listed. The purchase order and line item are in **Requested** status.

6. Optional: Continue adding purchase order line items for this vendor, as needed.

7. After you initiate the order with the vendor and are ready to show that the order was placed, click **Order**.  
The status of the purchase order and line items change to **Ordered**.

**Purchase order status**

Purchase orders follow a specific life cycle. The **Status** field on the purchase order record is always read-only.

![Purchase order status diagram](image)

**Figure 61: Purchase order status**
Table 175: Status life cycle

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested</td>
<td>When you create a purchase order, the status is Requested.</td>
</tr>
<tr>
<td>Ordered</td>
<td>When you add purchase order line items, and click Order, the status changes to Ordered.</td>
</tr>
<tr>
<td>Pending Delivery</td>
<td>When you create assets before receiving them as a purchase order line item, the status of purchase orders and purchase order line items changes to Pending Delivery status.</td>
</tr>
<tr>
<td>Received</td>
<td>When ordered assets arrive in the specified stockroom and you click Receive, the status of purchase orders and purchase order line items changes to Received.</td>
</tr>
<tr>
<td>Canceled</td>
<td>You can cancel a purchase order if its status is Requested, Ordered, or Pending Delivery. For more information, see Cancel a purchase order on page 542.</td>
</tr>
</tbody>
</table>

Purchase order expected delivery date

The purchase order record and the purchase order line item record both contain an Expected delivery date field.

The Expected delivery field can be edited on both records. Editing the field on one record can change the field on the other record.

- If you add an expected delivery date to the purchase order and the expected delivery date field on the purchase order line item is blank, the date on the purchase order is added automatically to the purchase order line item.
- If you add an expected delivery date on the purchase order line item and the expected delivery date field on the purchase order is blank, the date on the purchase order line item is added automatically to the purchase order.
- If the purchase order and the purchase order line item have the same expected delivery date and you change the date on the purchase order, the date is changed automatically on the purchase order line item.
- If you change the date on the purchase order line item to a date that is later than the one specified on the purchase order, the date on the purchase order is changed to the new date. The expected delivery date of a purchase order line item cannot be later than the expected delivery date on the associated purchase order.
- If you change the date on the purchase order line item to a date that is earlier than the date specified on the purchase order, the date on the purchase order remains the same.

Cancel a purchase order

You can cancel purchase orders with a status of Requested, Ordered, or Pending Delivery.

Role required: procurement_admin or procurement_user

Purchase order line items can also be canceled from a purchase order.

1. Navigate to Procurement > Orders > Purchase Orders.
2. Open a purchase order to cancel.
3. Click **Cancel**.
   All associated purchase order line items that have not been received are canceled and any assets created for the purchase order are deleted.

**Cancel a purchase order line item**

You can cancel a purchase order line items with a status of **Requested**, **Ordered**, or **Pending Delivery**.

Role required: procurement_admin or procurement_user

Keep the following in mind when you cancel a purchase order line item.

- When a purchase order line item is canceled, if all other line items are also canceled, the purchase order is canceled.
- After a purchase order line item is canceled, it can be reordered if the associated purchase order has not been canceled or received.
- If you cancel a purchase order line item for which assets were created, the assets are deleted from the system and removed from the purchase order.
- If you reorder the same purchase order line item, the assets are recreated for that line if the line has a status of **Pending Delivery**.

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, select a line item to cancel.
4. Click **Cancel**.

**Reorder a purchase order**

You can reorder a purchase order that was canceled.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order with a status of **Canceled**.
3. Click **Order**.
   The status changes to **Ordered** for the purchase order and all associated purchase order line items.

**Reorder a purchase order line item**

You can reorder a purchase order line item that was canceled.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, select a line item with a status of **Canceled**.
4. Click **Order**.
   The purchase order line item **Status** field changes based on the **Status** field of the associated purchase order. For example, if the purchase order has a status of **Pending Delivery**, the purchase order line item status changes to **Pending Delivery** and the assets for the purchase order line item are created automatically.
Create an asset and reserve it for the requester

In the procurement process, hardware, software, and consumable assets can be created before the assets are delivered. This allows you to create the asset record early in the process to reserve the asset for the user who requested it.

Role required: procurement_admin or procurement_user

Some requests must be approved before items on the request can be sourced. In the base system, requests over $1,000 require approval. To change the $1,000 approval threshold and other workflow attributes, edit the Service Catalog Request workflow.

When the asset state is **In stock**, the **Reserved for** field is maintained as the asset is received and placed in a stockroom. When the asset state changes to **In use**, the **Reserved for** field is relabeled **Assigned to**. If there is a name in the **Reserved for** field, the name is retained when the field is relabeled. A user with the asset role can change the name in the **Assigned to** field. This is helpful, for example, if an IT technician orders 10 laptops and needs to assign them to individual users.

**Note:** If assets are not created prior to delivery, they are automatically created from line items when purchase orders are received.

1. Navigate to **Procurement > Requests > Tasks**.
2. Open a task with a **State** of **Open** and a **Short description** of **Source Request Items**.
3. Click **Source Request**.
   - If the request is already fulfilled or the items in the request are not sourceable, the **Source Request** button is hidden.
   - If the requested item does not have an assigned model, the item is not listed on the Source the Request dialog box.
   - Any items on the purchase order that have a remaining quantity of **0** are not listed on the Source the Request dialog box.
4. Select a **Destination Stockroom**.
5. Select the **Create PO** option for one or more listed items.
6. For each item requiring a purchase order, select a **Vendor**.
7. Click **OK**.
8. Navigate to **Procurement > Orders > Purchase Orders**.
9. Open the purchase order you just created. If you created a purchase order for more than one item, multiple purchase orders may have been created; select one of them.
10. Click **Order**. After items are ordered, no additional purchase order line items can be added to the purchase order. The status of all purchase order line items changes to **Ordered**.
11. Click the **Create assets prior to delivery** related link to automatically create assets for all purchase order line items. Hardware, software, and consumable assets are listed in the **Assets** related list. Click an asset in the list to view the asset record. Note that, except for consumables, the **Reserved for** field contains the name of the user who made the original request.

You can also create assets for individual purchase order line items. On a purchase order, go to the **Purchase order line items** related list and click a specific purchase order line item number. Then, click the **Create assets prior to delivery** related link. Only the assets included on the purchase order line item are created.

Consumables follow a slightly different life cycle from other assets, such as hardware and software. For more information, see **Consumables life cycle** on page 41.
Receive assets

Assets can be received and added to the system when they are delivered to a stockroom.

Users with an appropriate procurement role can receive assets. If one purchase order contains multiple purchase order lines, the lines can be received at different times. This is useful if items arrive at the stockroom in different shipments. The purchase order status does not change to Received until all purchase order lines are received.

As an alternative to receiving assets when they arrive, you can create assets before they arrive and reserve them for the requester.

Receive an asset

When assets are received and delivered to a stockroom, they are added to the system.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Orders > Purchase Orders.
2. Select a purchase order with a Status of Ordered.
3. Click Receive.
   The Receive Purchase Order dialog box opens and the product model that was ordered is listed.
4. Select the Received check box for any line item you are receiving.
5. Optional: Edit the Stockroom if the items arrived at a different stockroom than the one specified on the purchase order.
6. Optional: Edit the Qty Received if the number of items delivered does not match the number ordered. Enter an integer greater than zero.
7. Optional: Edit the Unit Cost if the price changed between the time the item was ordered and the time it arrived at the stockroom. Enter a number; the number can include decimals.
8. Optional: Select the Reserve check box to reserve an item for the user specified in the For User field.
   When a reserved item is received, the State and Substate fields on the corresponding asset record are automatically set to In stock and Reserved, respectively. If the Reserve check box is not selected for an item, the State and Substate fields on the corresponding asset record are set to In stock and Available.
9. Optional: In the For User field, select the user for whom the item was ordered. If a name was specified in the Requested for field on the Purchase order line item form, the name is added to this field automatically but can be changed.
   The Product and Part# columns are automatically filled in based on the product model record.
10. Optional: Select the Allow Asset Tag Input check box to display the asset tag and serial number fields. The fields are not displayed for consumable assets. If the asset already has an asset tag or serial number, the numbers are automatically added to the fields. If you change the asset tag or serial number in the dialog box, the new values are saved in the asset record.
11. Click OK.
   A receiving slip is automatically created and can be viewed in the Receiving Slips related list. If items on a purchase order are received at different times, a new receiving slip is created each time any item on the purchase order is received. For example, if 30 laptop computers were ordered and arrived in three separate shipments, three receiving slips are created.
   An asset record is automatically created for each item if an asset was not created prior to receiving the item.
Create a receiving slip

Receiving slips are created automatically during the process of receiving assets. You can also create receiving slips manually.

Role required: procurement_admin or procurement_user

After a receiving slip has been created for a purchase order, all fields on the purchase order record are changed to read-only.

1. Navigate to Procurement > Receiving > Receiving Slips.
2. Click New.

   A Number is assigned automatically. The current date and time is added automatically to the Received field.
3. Select a Purchase Order.

   Only purchase orders with a status of Ordered, Pending Delivery, or Requested are listed in the selection window. The Vendor column lists the vendor specified on the purchase order. The Ship to column lists the destination stockroom specified on the purchase order.
4. Select a Receiving Stockroom.
5. Click Submit.

Add a receiving slip line to the receiving slip to identify the items from the purchase order that were received.

Create a receiving slip line

When assets arrive at a stockroom and you receive them, a receiving slip is created on the purchase order. You create a receiving slip line to identify the specific assets and quantities that were received.

Role required: procurement_admin or procurement_user

If the asset already exists, the asset record is updated when you save the receiving slip line. If the asset does not already exist, a new hardware or software asset record is created. The Model category and Configuration item fields are automatically filled in on the new asset record based on information in the request, purchase order, or receiving slip. If Asset Tag and Serial Number information exists, it is not overwritten.

1. Navigate to Procurement > Receiving > Receiving Slips and open a receiving slip.
2. In the Receiving Slip Lines related list, click New.

   The following fields are completed automatically.
   • A Number is assigned.
   • In Received, the current date and time are added.
   • In Received by, the currently logged in user is added.
3. In Purchase Order Line, click the reference lookup icon and select a purchase order line.

   The Purchase Order Line field is mandatory if the parent receiving slip has an associated purchase order. Only purchase order lines that are associated with the same purchase order linked to the parent receiving slip are available to select.
4. In Quantity, enter the number of items received. For example, five items were ordered, but only two are being received.
5. Optional: Edit the Received by, Requested for, and Unit cost fields, as needed.
6. Click Submit.
After you create a receiving slip line, the **Receiving stockroom** field on the Receiving Slip record becomes read-only.

**Consumable assets**

A consumable asset is one that is purchased in quantity and distributed. It is assigned to the consumable model category, and the asset record tracks the quantity that are available and total cost. When consumable assets are received, they are merged into an existing consumable record, if available.

For the records to merge, the consumable cannot be listed on an active transfer order and the **Model**, **Location**, **Model Category**, **Stockroom**, **Status**, and **Substatus** fields on the asset record must match.

If consumables are merged into an existing consumable record, the cost of the additional consumables received is added to that of the existing consumables in the record. For example, if 50 computer keyboards arrive and 20 keyboards of the same model already exist in the receiving stockroom, the two records are merged showing 70 keyboards in the stockroom with a combined total cost.

If no matching consumable record exists in the receiving stockroom, a record is created. After the consumables are received, the quantity is updated, but individual consumables are no longer tracked within the Procurement application and are not displayed on receiving slip lines.

**Product Catalog**

The product catalog is a set of information about individual models. Models are specific versions or various configurations of an asset. Asset managers use the product catalog as a centralized repository for model information.

A detailed and well-maintained product catalog can coordinate with service catalog, asset, procurement, request, contract, and vendor information.

Models published to the product catalog are automatically published to the service catalog. The service catalog includes information about goods (models) and services. A model may be listed more than once if the model is available from multiple vendors. Models are included with the Asset Management application.

Keep the following in mind when working with the product catalog:

- A product catalog item can be linked to multiple vendor catalog items or to a single model.
- A model can only have one product catalog item.
- A vendor catalog item can only have a single product catalog item.

**Components installed with Product Catalog**

The following components are installed with the Product Catalog plugin.

Demo data is available with the product catalog. The demo data provides a variety of models, model categories, product catalog items, vendor catalog items, and vendors.

**Tables installed with Product Catalog**

Product Catalog plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call</td>
<td>The base table for Product Catalog that contains all call information.</td>
</tr>
<tr>
<td>[new_call]</td>
<td></td>
</tr>
</tbody>
</table>
### Roles installed with Product Catalog

Product Catalog plugin adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>model_manager</td>
<td>Can create new CMDB models.</td>
<td>none</td>
</tr>
<tr>
<td>category_manager</td>
<td>Can do everything that model managers can do and can administer model categories.</td>
<td>model_manager</td>
</tr>
</tbody>
</table>

### Script includes installed with Product Catalog

Product Catalog plugin adds the following script include.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProductCatalogUtils</td>
<td>Utilities for creating and maintaining product catalog items derived from vendor catalog items and models.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Product Catalog

Product Catalog plugin adds the following client script.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Script contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Model Fields</td>
<td>[pc_vendor_cat_item]</td>
<td>Adds the description and price, if they do not exist, when a vendor catalog item is added to the product catalog.</td>
</tr>
</tbody>
</table>
Business rules installed with Product Catalog

Product Catalog plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear model</td>
<td>[pc_product_cat_item]</td>
<td>Clears the link on a model if the link is cleared from the product catalog.</td>
</tr>
<tr>
<td>Create child product catalog entries</td>
<td>[cmdb_hardware_product_model]</td>
<td>Creates entries in the product catalog for all items in a bundled model when the bundled model is created.</td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>[pc_vendor_cat_item]</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>[cmdb_model]</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
</tbody>
</table>

Models

Models are specific versions or various configurations of an asset. Models are used for managing and tracking assets through various ServiceNow platform asset applications, including Product Catalog, Asset Management, and Procurement.

Model definitions can be based on vendor-provided criteria, for example, the manufacturer name Apple MacBook Pro, or on a custom abstraction, for example, Graphic Designer Workstation. All model information is located in the Product Catalog application.

A model can be in one or more model categories. For example, a laptop can be a computer and a server. Model definitions specify whether the model creates an asset, a configuration item, or both. On a hardware model record, compatible hardware models can be added.

Unless otherwise noted, working with product models requires the model_manager role. This role is contained by other roles, such as sam, category_manager, and asset.

Creating models

Models are created in the Product Catalog > Product Model > All Models module.

See Model form fields on page 549 for a list of the fields that appear on all models, regardless of the type of model.

Model form fields

There are fields on the Model form that apply to all types of models.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the model. A system property called glide.cmdb_model.display_name.shorten controls how software model display names are generated.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or abstract name specified by the model manager, such as <strong>Field Agent Laptop</strong>.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the software model, such as <strong>Professional</strong>.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>The categories to which the model is assigned. This field is a glide list and cannot be used to create reports.</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>The process by which the model should be tracked. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Leave to Category</strong>: model is transparent and the asset class is defined solely by the category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Create Consumable Asset</strong>: model forces the asset class to be consumable, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Don't create assets</strong>: model blocks asset instantiation, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>The method for purchasing the model. Options are <strong>Both</strong>, <strong>Buy</strong>, or <strong>Lease</strong>.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The <strong>depreciation scheme</strong> for the model.</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are usually assigned by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the model. Options are <strong>In Production</strong>, <strong>Retired</strong>, and <strong>Sold</strong>.</td>
</tr>
<tr>
<td>Certified</td>
<td>The option that determines whether the model is approved for use.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the model that would be helpful for others to know.</td>
</tr>
</tbody>
</table>
Create hardware models

You use hardware models to track equipment assets such as servers and racks. You can create a new hardware model.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields on page 549. The hardware model fields listed below are found in the Information section of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power (watts)</td>
<td>The electrical power, in watts.</td>
</tr>
<tr>
<td>Height (U)</td>
<td>The total height of the hardware item, in inches.</td>
</tr>
<tr>
<td>Flow Rate (cfm)</td>
<td>The flow rate of the hardware model, expressed in cubic feet per minute.</td>
</tr>
<tr>
<td>Sound Power (bels)</td>
<td>The noise measurement, in bels (1 bel=10 decibels).</td>
</tr>
<tr>
<td>Weight (lbs)</td>
<td>The total weight, in pounds.</td>
</tr>
</tbody>
</table>

4. Click Update.

Add compatible models to a hardware model

On a hardware model record, you can add compatible hardware models. This is a good method for tracking hardware assets that can work together.

Role required: model_manager
Note: Hardware models included in bundled models cannot be added as compatibles.

1. Navigate to **Product Catalog > Product Model > Hardware Models.**
2. Click a hardware model **Name.**
3. Click **Add Compatible.**
4. Select a compatible model.
5. Click **Submit.**
   The selected model is listed in the **Compatibles** related list.

Add substitute models to a hardware model

On a hardware model record, you can add substitutes to track what hardware models can be substituted for another hardware model.

Role required: model_manager

For example, a 19" monitor may be a valid substitute for a 17" monitor. Note that substitutions are directional so, in this case, a 17" monitor is not a substitution for a 19" monitor. Information about valid substitute models is useful when you select models while creating transfer orders.

When you select substitute models, note the following conditions.

- Substitute models can be used with work management transfer orders. Substitute models are not used in procurement part sourcing.
- Hardware models included in bundled models cannot be added as substitutes.

1. Navigate to **Product Catalog > Product Model > Hardware Models.**
2. Click a hardware model **Name.**
3. Click **Add Substitution.**
4. In the **Collection** list on the left, double-click a hardware model.
   The hardware model is added to the **List** on the right.
5. Click **Save.**
   The model is listed in the **Substitutes** related list.

Create consumable models

Consumables are items that are tracked as a group, not individually. An example of consumable items are computer keyboards.

Role required: model_manager

1. Navigate to **Product Catalog > Product Model > Consumable Models.**
2. Click **New.**
3. Complete the form.
   For general field descriptions, see **Model form fields** on page 549. There are no fields specific to consumable models.
   Any consumable assets you create and assign to the new model are displayed in the **Consumables** related list on the model record.
4. Click **Submit.**
Bundled models

A bundled model is a single model comprised of individual models. For example, a laptop, printer, keyboard, and mouse can be combined into a single bundled model. If you assign any one asset from the bundled model to an individual, that person receives all of the components in the bundle.

Bundled models can be abstract or concrete.

**Abstract**

Permits use of one model in multiple bundles. The abstract bundle is created as a container. One asset in the bundle is usually specified as the main component. Model categories define which assets can be included in a bundle and which can be the main component of a bundle.

Add a main component to make it easier to track the bundle components. For example, create an abstract bundle adding a computer as the main component and a mouse and keyboard as other components. When the bundle is assigned to a user, the asset record for the computer shows the computer, mouse, and keyboard all assigned to the user. Abstract bundles are used more often than concrete bundles.

**Concrete**

Is a fixed bundle where the main component is an asset. Specify the main component and the other components to create an exact bundle. Concrete bundles do not allow for a many-to-many relationship with models.

Keep the following tips in mind when creating and using bundled models.

- Bundles can be nested inside bundles.
- Hardware and consumable models can be used in a bundle. Software and contract models cannot be used in a bundle.
- When a parent link is defined, the fields related to assignment and state of the child assets are read-only and populated based on the parent's assignment and state fields.
- Taking action on the parent bundle affects the children in the bundle. For example, if you assign a bundle to an individual, all child asset records show that same individual as the person assigned.
- You cannot pre-allocate bundles.
- In a bundle, consumables are consumed and assets are set to the same state as the master component.
- Only the bundle, not individual components, can be part of a transfer order.
- You control what can go into a bundle through the model category. For example, the model category Servers might be set to never allow servers in bundles.
- To create a collection of software, you must create a suite instead of a bundled model.
- A software license cannot be the master component of a bundle.

To create an abstract model, set the model category to Bundle and add components. To create a concrete model, create a model in the Product Catalog > Product Model > Bundled Models module and add components.

Add model components to a bundle

You add model components to a model as needed, for example, when you upgrade a bundle to include additional assets.
Role required: model_manager

1. Navigate to Product Catalog > Product Model > Bundled Models.
2. Open a bundle record.
3. In the Model Components related list, click New.
4. Select the Model category of the component, such as Computer.
5. Select the Component, such as Apple Computer MacBook Pro 17”.
6. Select the Is main component check box if this component is the one that other components are attached to.
7. Click Submit.
8. Repeat steps 3-7 to add more components to the bundle.
   Any components you add to the bundled model are displayed in the Model Components related list.
Geneva    ServiceNow    IT Service Management

Figure 62: Bundled model components

<table>
<thead>
<tr>
<th>Display name</th>
<th>Developer workstation bundle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Developer workstation bundle</td>
</tr>
<tr>
<td>General Information</td>
<td>Compatibilities</td>
</tr>
<tr>
<td></td>
<td>Substitutes</td>
</tr>
<tr>
<td></td>
<td>Assets</td>
</tr>
<tr>
<td></td>
<td>Configuration items</td>
</tr>
<tr>
<td></td>
<td>Product Catalog</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Short description</th>
<th>Developer workstation bundle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model categories</td>
<td>Bundle</td>
</tr>
<tr>
<td>Model number</td>
<td>DWB-001</td>
</tr>
<tr>
<td>Barcode</td>
<td>DWB-001</td>
</tr>
<tr>
<td>Owner</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>In Production</td>
</tr>
<tr>
<td>Certified</td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
</tbody>
</table>

Related Links

Publish to Hardware Catalog

**Model Components**

<table>
<thead>
<tr>
<th>Bundle = Developer workstation bundle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is main component</td>
</tr>
<tr>
<td>Component</td>
</tr>
<tr>
<td>Model category of component</td>
</tr>
<tr>
<td>true</td>
</tr>
<tr>
<td>false</td>
</tr>
<tr>
<td>false</td>
</tr>
<tr>
<td>false</td>
</tr>
</tbody>
</table>

Actions on selected rows...
Remove model components from a bundle

You remove a component from a bundled model, for example, when you need to replace it with a different component.

Role required: model_manager

No component history is retained, so if you remove a component from a bundled model, no record is saved showing that the component was ever part of a bundle.

1. Navigate to Product Catalog > Product Model > Bundled Models.
2. Open a bundle record.
3. In the Model Components related list, select the component you want to remove.
4. In the Actions choice list below the list, select Delete.
5. Click OK.

Software models

Software models are created as part of the asset management process. You can create product models for software from the product catalog, but you cannot administer all aspects of the software models.

Software models are used in software counters. For more information about creating software models, see Manage software models on page 97

Create application models

You can create application models that can be managed and tracked within a Scrum development process.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Application Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields on page 549. There are no fields specific to application models.
4. Click Submit.

Work order models

When work management is activated, the ServiceNow platform adds the Work Order Models and Work Task Models modules to the product catalog.

Users with the wm_admin role can define new model records, which can be used as templates to create work orders for common procedures.

Models created for VMware support and Amazon EC2

When you activate Orchestration for VMware or Amazon EC2, the system creates a new model (vmware instance or ec2 instance) automatically.

When the virtual machine is terminated, the asset state changes to Retired.
Add skills to a model

You can associate skills with any model. Creating associations between skills and models is helpful if you are using work management and need to assign tasks to agents based on their skills with specific models.

Role required: skill_admin or model_manager

1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In the Skills related list, click Edit.
4. Add items from the Collection list to the Skills List.
5. Click Save.

Publish models to the hardware or software catalog

You can publish models to the hardware or software catalog to make the models available in the service catalog.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In Related Links, click Publish to Hardware or Publish to Software Catalog.
4. Select a category.
5. Click OK.

Delete models

If a model is no longer needed, it can be deleted as long as no assets or configuration items use the model.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > All Models.
2. Select the check box beside the product model.
3. From the Actions choice list below the list, select Delete.
4. Click OK.

Vendor catalog items

The vendor catalog is a list of goods available from different vendors.

An accurate and complete vendor catalog can make it easier to keep items in stock at the best possible price.

You can link multiple vendor catalog items to a single product catalog item, which allows you to track information about a single item at different vendors.

For example, for an iPhone 5 product catalog item, you can create separate vendor catalog items from Apple and from Amazon. Select the vendor with the best price when you source an item. Users need the model_manager role to work with vendor catalog items.
Synchronize information

Certain information is synchronized between models, product catalog items, and vendor catalog items.

When working with models, product catalog items, and vendor catalog items, keep the following in mind:

- Changes to a model record update vendor catalog items automatically only if the vendor catalog items are published, not linked.
- If a model is linked to a vendor catalog item, any changes to the model do not update the vendor catalog item.
- After publishing a vendor catalog item or model to the hardware or software catalog, some fields become read-only on the vendor catalog item or product catalog item record. Information can only be updated on the model record.

List of synchronized fields:

- Description
- Short description
- Name
- Product ID
- Price
- Vendor
- Specs
- Features
- Model
- UPC
- Model number
- Cost
- Manufacturer

Create a vendor catalog item

You create a vendor catalog item to associate product models with a vendor.

Role required: model_manager

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Click New.
3. Complete the form.

Table 177: Vendor Catalog Item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item is built from information in the Product Model, Vendor, and Product ID fields.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier that provides the item.</td>
</tr>
<tr>
<td>Product model</td>
<td>The specific version or configuration of the item.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out of stock</td>
<td>The option that indicates whether the item is currently unavailable for order. This field is important if you are sourcing request items. Clear this check box if the item is available to order.</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>List price</td>
<td>The price at which the item retails, excluding vendor discounts.</td>
</tr>
<tr>
<td>Vendor price</td>
<td>The price at which the item is available in the vendor catalog. If the vendor offers a discount, the vendor price reflects the discounted price.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Displays the overall ranking for this vendor’s products and services, such as Valued Partner or Blacklisted Supplier. Rank tier expresses your organization’s opinion of this vendor's performance and can be used to decide if the vendor's products should be promoted or discontinued. Users with the vendor_manager role can edit this field.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
</tbody>
</table>

**General section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product catalog item</td>
<td>Name of the product catalog item, if the item has been added to the product catalog. Leave this field empty if you are going to link a vendor catalog item to the hardware catalog.</td>
</tr>
<tr>
<td>UPC</td>
<td>The barcode number used to uniquely identify and track items for sale.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to list the item in the vendor catalog. Clear this check box to hide the item in the vendor catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the item.</td>
</tr>
</tbody>
</table>

**Information section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifications</td>
<td>Facts about the item such as size, weight, version, or speed.</td>
</tr>
<tr>
<td>Features</td>
<td>Distinct properties or distinguishing characteristics of the item.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Link an item to the hardware catalog**

After you create a vendor catalog item, link the item to the hardware catalog for viewing.
To see the **Link to Hardware Catalog Item** related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

**Role required:** model_manager

1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Link to Hardware Catalog Item**.
4. Select a **Catalog Item**.
5. Click **OK**.

   The page refreshes to the selected hardware catalog item. The vendor catalog item is listed in the **Vendor Catalog Items** related list.

---

**Link an item to the software catalog**

After you create a vendor catalog item, link the item to the software catalog for viewing.

To see the **Link to Software Catalog Item** related link on the Vendor Catalog Item form, add a software model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

**Role required:** model_manager

1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Link to Software Catalog Item**.
4. Select a **Catalog Item**.
5. Click **OK**.

   The page refreshes to the selected software catalog item. The vendor catalog item is listed in the **Vendor Catalog Items** related list.

---

**Publish an item to the hardware catalog**

After you create a hardware item for the vendor catalog, publish it to the hardware catalog for viewing. The hardware catalog is a section within the service catalog.

To see the **Publish to Hardware Catalog Item** related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

**Role required:** catalog_admin

After you publish a vendor catalog item to the hardware catalog, the **Publish to Hardware Catalog** related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the hardware catalog.

1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Publish to Hardware Catalog**.
4. Select a **Category**.
5. Click **OK**.

   The Hardware Catalog form opens and the item is listed in the **Vendor catalog Items** related list.
Publish an item to the software catalog

After you create a software item for the vendor catalog, publish it to the software catalog for viewing. The software catalog is a section within the service catalog.

To see the Publish to Software Catalog Item related link on the Vendor Catalog Item form, add a software model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

Role required: catalog_admin

After you publish a vendor catalog item to the software catalog, the Publish to Software Catalog related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the software catalog.

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Open a vendor catalog item.
3. In Related Links, click Publish to Software Catalog.
4. Select a Category.
5. Click OK.

The Software Catalog form opens and the item is listed in the Vendor catalog Items related list.

View a vendor list

You can view a list of vendors from the product catalog.

Role required: model_manager

The list includes every company that has the Vendor option selected on its record.

1. Navigate to Product Catalog > Catalog Definition > Vendors.
2. Click any vendor Name for more information.

Product catalog items

Product catalog items are hardware and software that you want to track and offer in the service catalog.

The product catalog is an extension of the service catalog that contains a list of available models. Users with the catalog_admin role can create, activate, and deactivate product catalog items.

Create a product catalog item

You can create hardware and software product catalog items to include in the product catalog and the service catalog.

Role required: catalog_admin

You must activate the items separately before they appear in the product catalog or service catalog.

1. Navigate to Product Catalog > Catalog Definition > Hardware and Software Items.
2. Click New.
3. Complete the form.

Some of the fields listed do not appear until you save the product catalog item.
Table 178: Product catalog item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item as you want it displayed in the product catalog.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>The catalog this item is listed in.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor that supplies the item. If the item is purchased from multiple vendors, use the vendor catalog and leave this field empty.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>The overall ranking for the selected vendor's products and services. This field is only visible in a Product Catalog Item record when the CI class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Model</td>
<td>The specific version or configuration of the item.</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>Price</td>
<td>The price at which the item is available in the product catalog. Enter a numerical value and select the appropriate currency.</td>
</tr>
<tr>
<td>Recurring price</td>
<td>The item's recurring price. For example, a subscription to a mobile phone contract may cost $500.00, with an $30.00 monthly recurring price.</td>
</tr>
<tr>
<td>Recurring price frequency</td>
<td>The interval at which the recurring price is accrued.</td>
</tr>
<tr>
<td>List Price</td>
<td>The price at which the item retails. This field is only visible when the Class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Cost</td>
<td>The price at which the item was purchased from the vendor. The cost may be less than the List Price if your organization received a discount from the vendor. This field is only visible in a product catalog item record when the CI class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Omit price in cart</td>
<td>When selected, hides the price when the item is displayed in the service catalog. Clear the check box to show the price in the service catalog. This field is only visible in a product catalog item record when the CI class is Hardware Catalog.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow associated with this item.</td>
</tr>
<tr>
<td>Execution plan</td>
<td>The execution plan associated with this item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
<tr>
<td>Ordered item link</td>
<td>The list of links containing more information about items. The links can be reused across multiple items.</td>
</tr>
<tr>
<td>Class</td>
<td>The catalog item class this item belongs to. Select <a href="#">Hardware Catalog</a> or <a href="#">Software Catalog</a>. This field is visible by default. When you save the record as a hardware or software catalog item, the form is retitled Hardware Catalog or Software, respectively.</td>
</tr>
</tbody>
</table>

**General section**

<table>
<thead>
<tr>
<th>Category</th>
<th>The named group of items to which the item belongs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery time</td>
<td>The amount of time it takes to deliver the item, starting from when it is ordered from the product catalog.</td>
</tr>
<tr>
<td>UPC</td>
<td>The barcode number used to identify and track items.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the item. The description is displayed in the product catalog listing.</td>
</tr>
</tbody>
</table>

**Product Information section**

<table>
<thead>
<tr>
<th>Cost</th>
<th>The price at which the item was purchased from the vendor. This field is only visible when the Class is <a href="#">Software Catalog</a>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifications</td>
<td>Facts about the item, such as size, weight, version, or speed.</td>
</tr>
<tr>
<td>Features</td>
<td>Distinct properties or distinguishing characteristics of the item.</td>
</tr>
</tbody>
</table>

**Images section**

<table>
<thead>
<tr>
<th>Icon</th>
<th>A small image that appears next to the name when the item is displayed in the service catalog. Supported file types are jpg, png, bmp, gif, and jpeg.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td>An image showing the item. Supported file types are jpg, png, bmp, gif, and jpeg.</td>
</tr>
</tbody>
</table>

**Related lists**

<p>| Includes            | Additional catalog items provided with this item. This related list is for informational purposes only.                                                                                         |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
<td>Service catalog variables associated with this item. A service catalog variable provides the ability to capture and pass on information about choices a customer makes when ordering an item from the service catalog.</td>
</tr>
<tr>
<td>Vendor Catalog Items</td>
<td>Vendor catalog items associated with this item. Vendor catalog items allow you to track information about this item by its specifications for each vendor.</td>
</tr>
</tbody>
</table>

Hardware catalog item record with an icon and picture of the item.
Figure 63: Hardware catalog item

4. Optional: Click **Try It** to preview the item as it appears in the service catalog.
5. Click **Submit** or **Update**.

### Activate a product catalog item

You can activate a product catalog item to make it available in the product catalog and the service catalog.

**Role required:** catalog_admin

You can activate the item from either the list view or the record.

1. Navigate to **Product Catalog** > **Catalog Definition** > **Hardware and Software Items**.
2. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activate one or more items from the list view</strong></td>
<td>Select the check box next to one or more items in the record list and click <strong>Activate</strong> below the list.</td>
</tr>
<tr>
<td><strong>Activate from the record</strong></td>
<td>Click <strong>Activate</strong> under <strong>Related Links</strong>.</td>
</tr>
</tbody>
</table>

### Deactivate a product catalog item

You can deactivate a product catalog item to remove it from the product catalog and the service catalog.

**Role required:** catalog_admin

You can deactivate the item from either the list view or the record.

1. Navigate to **Product Catalog** > **Catalog Definition** > **Hardware and Software Items**.
2. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Deactivate from the list view</strong></td>
<td>Select the check box next to one or more items in the record list and click <strong>Deactivate</strong> below the list.</td>
</tr>
<tr>
<td><strong>Deactivate from the record</strong></td>
<td>Click <strong>Deactivate</strong> under <strong>Related Links</strong>.</td>
</tr>
</tbody>
</table>

### Model categories

Model categories associate CI classes with asset classes. Model categories are part of the Product Catalog application.

The model category configuration determines if the ServiceNow platform should create an asset from a CI, and, if so, what class of asset. Asset classes in the base system are **Hardware**, **Software License**, and **Consumable**. You can associate a model category to many models and a model to many model categories. For example, a specific model of a computer can be a **Computer** and a **Server**.
View model categories

Default model categories are included with product catalog. You can view a list of default categories and the categories that you created.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category to view its details.

Create model categories

You can add custom model categories for your instance.

Role required: model_manager

When you create model categories, keep the following in mind:
• The base system provides a model category for each CI class in the CMDB. As you create new 
cmdb_c classes, create a corresponding row in the model category table for the model table to be 

used.
• If you select an Asset class on any existing model category, the system automatically creates assets 
for all configuration items associated with the model category, if configured to do so. If an asset is not 
created automatically, you can create the asset manually. After an asset class is selected for a model 
category, the asset class cannot be changed.
• The Allow pre-allocated, Allow in bundle, and Allow as master options are only available if an asset 
class is specified for the model category.
• If you select Consumable or Software License for the asset class, the Allow in bundle option is 
available, but not Allow pre-allocation or Allow as master.
• When a CI is created from a model category that requires asset tracking, the system automatically 
creates an asset record for the asset class specified in the model category. It then links that asset 
record to the CI. The model category of the CI is determined by a combination of the CI class and the 
list of categories supported by the model, if a model is specified. Asset tracking is specified on the 
model record.
• When an asset is created from a model category that requires CI tracking, the system automatically 
creates a CI record of the class specified by the category and links it to the asset.
• The Model Categories list (Product Catalog > Product Model > Model Categories) shows all of the 
CI classes and what asset class is generated on the asset side.

1. Navigate to Product Catalog > Product Model > Model Categories and click New.
2. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for this category.</td>
</tr>
<tr>
<td>CI class</td>
<td>If a CI class is needed, it must be specified when you create the model category. The CI class cannot be added to the model category later.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Asset class</td>
<td>Default options and any new asset classes you have created. Setting the asset class triggers the creation of assets depending on the model category selected. An asset class can be added to the model category at a later time, but cannot be changed after it is added. If you select <strong>Consumable</strong> or <strong>Software License</strong>, the CI class field becomes read-only because consumables and software licenses do not create CIs. If you specify a CI class and then select <strong>Consumable</strong> or <strong>Software License</strong>, the CI class field is changed to <strong>None</strong> automatically.</td>
</tr>
<tr>
<td></td>
<td>• Asset: An item that should be tracked individually.</td>
</tr>
<tr>
<td></td>
<td>• Consumable: An asset not tracked individually, such as keyboards.</td>
</tr>
<tr>
<td></td>
<td>• Hardware: A physical piece of computer equipment, such as a laptop or server.</td>
</tr>
<tr>
<td></td>
<td>• Software License: A legal statement defining the uses of software, such as the number of installations allowed or the terms of distribution.</td>
</tr>
<tr>
<td>Allow pre-allocation</td>
<td>Add and track items in this category as pre-allocated assets.</td>
</tr>
<tr>
<td>Allow in bundle</td>
<td>Use items in this category in bundles.</td>
</tr>
<tr>
<td>Allow as master</td>
<td>Use items in this category as the master component in a bundle.</td>
</tr>
<tr>
<td>Enforce CI verification</td>
<td>Prevents the system from automatically creating assets in a specific model category when CIs are added manually or found with Discovery. This option enables an administrator to review and verify new CIs before adding them as assets. For example, an administrator can prevent contractors’ computers that are discovered as CIs by Help the Help Desk from being added to the asset portfolio.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

Create assets manually

The ServiceNow platform does not create an asset automatically under certain conditions. You can create an asset manually as needed.

Role required: model_manager

The conditions under which an asset is not automatically created include the following.
• Forced CI verification: If you select the Enforce CI verification check box in the Model Category form, the system does not create an asset automatically when a CI is created or discovered. When Enforce CI verification is enabled, newly created CIs do not trigger an automatic creation of an asset. Instead, these newly created CIs have their Requires verification field automatically set to true, which displays the following UI actions for the CI:
  • Create Asset: Creates an asset and sets Requires verification to false.
  • Merge CI: Merges duplicates of a CI. This is useful if an asset for the CI was created in a separate process, which created an associated CI. Then a second CI was created either manually or via the discovery source - and the duplicate CIs did not properly coalesce.

• Configuration errors: In rare cases, the system can fail to create the asset automatically. This may occur if you assign the model and model category to the CI in the wrong sequence.

Follow these steps to create an asset manually.
1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category that has no assigned CI class.
3. Click Create Assets.
   This action creates assets from all CIs deferred for verification in this model category. This option is only available for users with the admin role.

Edit model categories

All default model categories can be edited, except for the Contract model category. You can edit any custom model categories that you created at any time.
Role required: model_manager
1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category record.
3. Make changes as appropriate.
4. Click Update.

Delete model categories

If a model category is no longer needed, you can delete it.
Role required: model_manager

Only model categories that are not referenced by any models can be deleted.
1. Navigate to Product Catalog > Product Model > Model Categories.
2. Select the check box beside the model category Name.
3. From the Actions on Selected Rows menu below the list, click Delete.
4. Click Delete.

Service Catalog

The Service Catalog application helps you create service catalogs that provide your customers with self-service opportunities. You can customize portals where your customers can request catalog items, such as service and product offerings. You can also define catalog items and standardize request fulfillment to ensure the accuracy and availability of the items provided within the catalogs.
Service Catalog Management roles

The Service Catalog Management application uses these roles.

Table 180: Service Catalog Management Roles

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Role Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator [admin]</td>
<td>Can manage all aspects of the Service Catalog application, including scripting functions such as creating UI macros or business rules.</td>
</tr>
<tr>
<td>Catalog administrator [catalog admin]</td>
<td>Can manage the Service Catalog application, including catalogs, categories, and items, but not including scripting functions available to administrators.</td>
</tr>
</tbody>
</table>

Service Catalog terms

The Service Catalog application uses these terms.

**Execution Plans**

Define how something gets delivered. For example, a PDA might go through procurement / activation / and installation of the desktop software.

**Execution Plan Tasks**

Plan Tasks represent a step in the Execution Plan, are associated with a Fulfillment Group, and have an approximate duration.

**Fulfillment Groups**

Fulfillment Groups work execution tasks. For example, one group may activate a cell phone while a different group installs the desktop software.

**Tickets**

Tickets represent work done by Fulfillment Groups as part of an Execution Plan.
Service Catalog properties

The Service Catalog application contains these properties.

To configure service catalog system properties, navigate to Service Catalog > Catalog Policy > Properties.

The following service catalog properties are available with all releases.

Table 181: Service Catalog Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.approval_engine.sc_request</td>
<td>Service Catalog requests approval engine.</td>
</tr>
<tr>
<td>glide.approval_engine.sc_task</td>
<td>Service Catalog Tasks approval engine.</td>
</tr>
<tr>
<td>glide.sc.allow.checkout.clone</td>
<td>Enable cloning requests during checkout.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property is deprecated when cart layouts are enabled</td>
</tr>
<tr>
<td>glide.sc.allow.clone.roles</td>
<td>List of roles (comma-separated) that can use bulk ordering functionality.</td>
</tr>
<tr>
<td></td>
<td>Blank means all users.</td>
</tr>
<tr>
<td>glide.sc.allow.quantity</td>
<td>List of roles (comma-separated) that can use the quantity selector in the</td>
</tr>
<tr>
<td></td>
<td>shopping cart. Blank means all users.</td>
</tr>
<tr>
<td>glide.sc.approval.hover</td>
<td>Show the current pending approver's name in the stage widget mouseover.</td>
</tr>
<tr>
<td>glide.sc.audit variables</td>
<td>Audit changes to Service Catalog variables.</td>
</tr>
<tr>
<td>glide.sc.can_search</td>
<td>List of roles (comma-separated) that can search the Service Catalog. Blank</td>
</tr>
<tr>
<td></td>
<td>means all users.</td>
</tr>
<tr>
<td>glide.sc.category.canview.override</td>
<td>List of roles (comma-separated) that override entitlements so that they can</td>
</tr>
<tr>
<td></td>
<td>view any category within the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td>• Default value: admin and catalog_admin</td>
</tr>
<tr>
<td>glide.sc.checkout.cancel</td>
<td>Allow ess users the option to cancel their requests from the checkout screen</td>
</tr>
<tr>
<td>glide.sc.checkout.cancel.condition</td>
<td>Condition under which users may cancel a request. Requires **Allow ess</td>
</tr>
<tr>
<td></td>
<td>users the option to cancel their requests from the checkout screen** to be</td>
</tr>
<tr>
<td></td>
<td>True.</td>
</tr>
<tr>
<td>glide.sc.checkout.request.number</td>
<td>Show the request item number for each line item on the checkout screen.</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property is deprecated when cart layouts are enabled</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.sc.checkout.twostep</td>
<td>Use the two step catalog checkout model.</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>glide.sc.checkout.twostep.back</td>
<td>Show the Back to Catalog button on the two step checkout screen.</td>
</tr>
<tr>
<td>glide.expert.checkout.twostep</td>
<td>Use the two step checkout model when placing a catalog order from a wizard.</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>glide.sc.checkout.task.display</td>
<td>Show tasks related to requests on the Order Status page, the screen you see in the service catalog after a successful order is placed.</td>
</tr>
<tr>
<td>glide.sc.delivery_summary.name</td>
<td>Use the delivery task name instead of the short_description for the delivery plan summarizer field.</td>
</tr>
<tr>
<td></td>
<td>• Default value: false (uses the short_description)</td>
</tr>
<tr>
<td>glide.sc.enhance.labels</td>
<td>Append pricing information to option labels.</td>
</tr>
<tr>
<td>glide.sc.entitlement.override</td>
<td>List of roles (comma-separated) that can override normal entitlement checking inside the catalog. A role of &quot;itil&quot; means that the itil role can order any catalog item, even one protected by entitlement restrictions.</td>
</tr>
<tr>
<td>glide.sc.ess.description</td>
<td>Field name to use for the description column of the checkout form. If blank, the default is used.</td>
</tr>
<tr>
<td></td>
<td>• Default value: short_description</td>
</tr>
<tr>
<td>glide.sc.home.filter</td>
<td>List of content types (comma-separated) to allow on the catalog homepage. Blank allows all content types.</td>
</tr>
<tr>
<td>glide.sc.price.display</td>
<td>When to show prices and sub-totals on the service catalog cart.</td>
</tr>
<tr>
<td>glide.sc.req_for.roles</td>
<td>List of roles (comma-separated) that can view the &quot;Requested for&quot; widget in the Service Catalog. Blank means all users. Controls access to the Requested For widget on the catalog homepage. Users with access to this widget can request items for another person. Users without access can place orders in their own name, only.</td>
</tr>
<tr>
<td>glide.sc.reset_cascade</td>
<td>On an order guide, reset cascading variable values on an item when a user goes back using the &quot;describe needs&quot; button.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.sc.reset_cascade_all</td>
<td>On an order guide, reset the values of cascading variables and non cascading values on an item when a user navigates back and forth between the <strong>Described Needs</strong> and <strong>Choose Options</strong> screens. If set to false, only the values for the cascading variables are reset.</td>
</tr>
<tr>
<td>glide.sc.restrict.quantity.changes</td>
<td>Prevent changes to requested item quantity when approved (except for catalog_admin users).</td>
</tr>
<tr>
<td>glide.sc.round.delivery.times</td>
<td>Round all delivery plans &gt; 1 day to the nearest day (true) or display the precise time (false).</td>
</tr>
<tr>
<td>glide.sc.search.rowcount</td>
<td>Number of Service Catalog matches returned for global searches. Limits the number of results returned by a catalog search to improve search performance.</td>
</tr>
<tr>
<td>glide.sc.variable.snapshot</td>
<td>Render variables on a request item as they appear on the order panel, followed by the delivery plan variables (true), or merge the two based on their order values (false).</td>
</tr>
<tr>
<td>glide.sc.request_for.columns</td>
<td>Additional columns for the &quot;request for&quot; Service Catalog widget. Choose fields in the user [sys_user] table. Must be semicolon separated.</td>
</tr>
<tr>
<td>glide.sc.request_for.order_by</td>
<td>Ordering of matches for the &quot;request for&quot; Service Catalog widget. Choose fields in the user [sys_user] table.</td>
</tr>
<tr>
<td>glide.sc.search.suggestions</td>
<td>Specify whether search suggestions should be enabled.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>glide.sc.homepage.show.collapse</td>
<td>Toggle whether the expand/collapse icon is rendered for category widgets on the service catalog homepage.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: false</td>
</tr>
<tr>
<td>glide.sc.item.cannot_add_to_request</td>
<td>List of class names for catalog items that cannot be added to an existing request.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: sc_cat_item_guide, sc_cat_item_producer, sc_cat_item_wizard</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.sc.item.cannot_try_it</td>
<td>List of class names for catalog items that do not use the default &quot;Try It&quot; UI Action.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> string</td>
</tr>
<tr>
<td>glide.sc.item.not_normal_cart_item</td>
<td>List of class names for catalog items that do not generate a normal cart item.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> string</td>
</tr>
<tr>
<td>glide.sc.item.cannot_show_price</td>
<td>List of class names for catalog items that do not show the price in listings.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> string</td>
</tr>
<tr>
<td>glide.sc.item.cannot_show_search</td>
<td>List of class names for catalog items that do not have the search field displayed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> string</td>
</tr>
<tr>
<td>glide.sc.guide.tab.validate</td>
<td>Validate mandatory fields when switching tabs in <strong>Choose Options</strong> section of Order Guides.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td>glide.sc.max_items</td>
<td>Number of Catalog Items or Categories to preview in a section.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td>glide.sc.show_additional_cats</td>
<td>Show the additional categories section when viewing a catalog item.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td>glide.sc.cat_view_use_popup_for_details</td>
<td>When browsing a category, use the popup icon to show item details.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> true</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.sc.auto_expand</td>
<td>Number of Catalog Items to expand in browsing and search when not using popup icons to view details.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 2</td>
</tr>
<tr>
<td>glide.sc.use_breadcrumb_links.cms</td>
<td>Use links for breadcrumbs rendered in Service Catalog pages accessed via a CMS site.</td>
</tr>
<tr>
<td></td>
<td>This enables users with the CMS administrator (content_admin) role to choose whether service catalog breadcrumbs are displayed with or without links for greater navigation control.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: false</td>
</tr>
<tr>
<td>glide.sc.use_sub_cat_section</td>
<td>In category view, display subcategories in a panel.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td>glide.sc.search.disabled_cats</td>
<td>Service catalog searches return items in inactive categories.</td>
</tr>
<tr>
<td></td>
<td>Search results can include catalog items in non-accessible categories, as specified by the active flag or by security constraints.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td>glide.sc.placeholder.image</td>
<td>Name of placeholder picture for items that do not have a picture defined. This is applicable only to Mobile and not Desktop.</td>
</tr>
<tr>
<td></td>
<td>ServiceNow provides two possible images: <code>sc_placeholder_image.png</code> and <code>sc_placeholder_image-01.png</code>. In addition, the default can be replaced with a custom image.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: <code>sc_placeholder_image.png</code></td>
</tr>
<tr>
<td>glide.sc.mobile.home.category.render</td>
<td>Specify how sub-categories are rendered in the Mobile UI, prior to user selection of Card or List layout.</td>
</tr>
<tr>
<td></td>
<td>Note: The service catalog homepage parent category layout cannot be modified from the default Card layout.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: choice list</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: <code>card</code></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.sc.mobile.limit.description</td>
<td>Limit descriptions in category and item listings to two rows in the Mobile UI.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> true</td>
</tr>
<tr>
<td>com.glide.servicecatalog.view_includes_category_descriptions</td>
<td>Show category descriptions in the category view page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> yes</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> yes</td>
</tr>
<tr>
<td>glide.sc.use_user_criteria</td>
<td>Use &quot;User Criteria&quot; to define access to catalog items and categories. Entitlements are not honored if set to true.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> true</td>
</tr>
<tr>
<td>glide.sc.user_criteria_migration</td>
<td>Enable &quot;User Criteria&quot; related lists for catalog items and categories when migrating from entitlements.</td>
</tr>
<tr>
<td></td>
<td>Set this to <strong>true</strong> to display the user criteria related lists without needing to switch to user criteria functionality.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> false</td>
</tr>
<tr>
<td>glide.sc.remove_inactive_cat_items_from_cart</td>
<td>Enable removal of inactive catalog items from cart.</td>
</tr>
<tr>
<td></td>
<td>If enabled, this automatically removes all deactivated catalog items from the shopping cart. This avoids users ordering items which are placed in the cart while active and then are made inactive.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> false</td>
</tr>
<tr>
<td>glide.sc.auto.cart.address.reset</td>
<td>Automatically update the delivery address for catalog carts when the details of a user's location changes.</td>
</tr>
<tr>
<td></td>
<td>If enabled, when changes are made to a user's address, and the user has an active cart, updates the user's address in the cart, if not enabled, the old address is retained in the cart.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> true</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> false</td>
</tr>
</tbody>
</table>
### Service Catalog setup

Service Catalog enables users with the Catalog Administrators role (catalog_admin) to set up the service catalog.

### Set up a service catalog

Administrators and catalog administrators, users with the catalog_admin role can use the Service Catalog application to define service catalog content and layout.

Administrators and catalog administrators can define and manage multiple service catalogs.

To set up a service catalog:

1. Assign roles to the users working with the service catalog.
2. Customize the service catalog homepage to meet your requirements.
3. Define content to provide in the service catalog:

<table>
<thead>
<tr>
<th>Catalog items</th>
<th>The goods and services available within the catalog.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Categories</td>
<td>The groups of items displayed on the catalog home page</td>
</tr>
<tr>
<td>Variables</td>
<td>The options available for tailoring a catalog item to meet specific needs.</td>
</tr>
</tbody>
</table>
4. Define the request fulfillment processes your organization uses to deliver ordered catalog items.

Administrators and catalog administrators can further extend the service catalog to provide more powerful features, using specialized catalog items, configuration options, and scripting functions. For example, administrators can customize the checkout process used when ordering catalog items.

Set URLs for catalog modules

You can direct users to a specific catalog via a URL to a module in that particular catalog. When you create a module for your catalog page, you can direct users to a specific catalog and view from this module via a URL.

In the Link Type section, select URL (from Arguments), then in the Arguments field, enter a URL of the form catalog_home.do?sysparm_catalog$id of sc_catalog record&sysparm_catalog_view$view name of sys_portal_page.

For example, catalog_home.do?
sysparm_catalog=742ce428d7211100f2d224837e61036d&sysparm_catalog_view=catalog_technical_catalog

**Note:** If you make the default catalog inactive, then deactivate the Catalog module otherwise users can continue to access the inactive catalog using that module.

If a URL has a valid sysparm_catalog parameter, but an invalid or missing sysparm_catalog_view parameter, the view with the default value from the corresponding Catalog Portal Page record is used. If a URL has a valid sysparm_catalog_view parameter, but an invalid or missing sysparm_catalog parameter, the corresponding Catalog Portal Page record is used to set the catalog.

**Note:** To ensure peak performance, define both parameters correctly.

Set up multiple service catalogs

Multiple service catalogs enable your organization to offer different sets of services. Administrators and catalog administrators can manage multiple service catalogs to provide services to different teams within the organization, such as IT services, human resources, and facilities management.

End users can access multiple catalogs from a single homepage, can search across all catalogs, or can search directly within each catalog.

**Enabling Access for Catalogs**

You can enable read access to the catalogs by applying the rule read ACL on Catalog (sc_catalog) table. See *Access control rules* for more information.

**Create a new catalog**

Service catalog enables you to create new catalogs.

1. Navigate to Service Catalog > Catalog Definition > Maintain Catalogs.
2. Select New.
3. Enter the new catalog details (see table).
4. Right-click the form header and select **Save**.
5. Define **catalog items** and categories to include in the catalog.
6. Optional: Define additional **portal pages** for the catalog.
7. Optional: **Manage sites** if you are using a CMS system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The descriptive name for the catalog.</td>
</tr>
<tr>
<td>Application</td>
<td>The <strong>application scope</strong> for this catalog.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate whether the catalog is available to end users.</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the catalog, displayed on the multi-catalog homepage.</td>
</tr>
<tr>
<td>Background Color</td>
<td>The background color used for the catalog on the multi-catalog homepage.</td>
</tr>
<tr>
<td>Desktop image</td>
<td>The larger image to display with the catalog on the multi-catalog homepage.</td>
</tr>
<tr>
<td>Catalog Home’ page</td>
<td>A custom page to redirect to when the user clicks the catalog within a breadcrumb.</td>
</tr>
</tbody>
</table>
Geneva    ServiceNow    IT Service Management

### Manage items in a catalog

Service catalog enables you to manage items within a catalog.

Use the **Catalog Items** related list on the Catalog form to view and manage the items available in the catalog.

<table>
<thead>
<tr>
<th>Catalog Items</th>
<th>New</th>
<th>Search</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To define a new catalog item for the catalog, click **New** and enter the details for the item.

### Manage catalog portal pages

Service catalog enables you to create and manage multiple portal pages for a catalog.

A catalog portal page provides a **homepage** for a specific catalog. You can use portal pages to create different catalog views for different user groups. Each portal page accesses the same catalog content and presents that content in different ways.

Catalog portal page details include the owner, title, and view to use for that page.

**Note:** The **View** field on a portal page is the value used when you refer to the homepage in a URL or module. When you upgrade to the Eureka release, this view value for the default service catalog portal page is automatically set to `catalog_default`. If you previously changed this value, you should manually reapply this change after upgrade.

1. The **Catalog Portal Pages** related list shows portal pages available for that catalog. Each catalog has a default page, created automatically when the catalog is created.
2. Select an appropriate action:
   - Click **New** to create a new portal page.
   - Click **Edit** to select an additional portal page for the catalog.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Continue shopping' page</td>
<td>The location to direct service catalog users to when they click the <strong>Continue Shopping</strong> button. This field is designed to reference a content page url suffix.</td>
</tr>
</tbody>
</table>

© 2017 ServiceNow. All rights reserved.  581
• Select a portal page to view and edit details for that page.

Upgrade to multiple service catalogs

Administrators and catalog administrators must consider these points before they upgrade to multiple service catalogs.

Before upgrading, you should be aware of changes made to the underlying service catalog data model. These changes are made to implement multiple catalogs and should not affect a standard upgrade. However, the changes may impact the instance if you have made customizations, such as changes to the data model.

The following tables are provided with multiple service catalogs:

<table>
<thead>
<tr>
<th>Table [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Site [sc_catalog_site]</td>
<td>Associates catalogs to sites.</td>
</tr>
<tr>
<td>Catalog Portal Page [sc_catalog_view_mtom]</td>
<td>Links catalogs to CMS portal pages. Defines the default catalog to portal page combination used by default links.</td>
</tr>
<tr>
<td>Catalog Items Catalog [sc_cat_item_catalog]</td>
<td>Stores the catalogs an item is available in.</td>
</tr>
<tr>
<td>Catalog Item Category [sc_cat_item_category]</td>
<td>Stores the categories an item is available in.</td>
</tr>
</tbody>
</table>

Use catalog site records

A new default catalog site record is automatically created after an upgrade.

Catalog site records appear in the Sites related list on the Catalog form.

The Catalog Site [sc_catalog_site] table associates catalogs with CMS web sites.

Several service catalog system properties are deprecated and replaced with fields on the catalog site record. This enables you to specify values for different sites used by different catalogs.

<table>
<thead>
<tr>
<th>Property</th>
<th>Catalog site field [name]</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.sc.home.cms_page</td>
<td>CMS homepage [cms_home]</td>
</tr>
<tr>
<td>glide.sc.search.cms_page</td>
<td>CMS search page [cms_search]</td>
</tr>
<tr>
<td>glide.sc.continue.shopping.target</td>
<td>CMS ‘Continue Shopping’ page [cms_continue_shopping]</td>
</tr>
</tbody>
</table>

When you upgrade, a new default catalog site record is automatically created. It is populated with the default system properties from the previous version, which associate the Employee Self-Service site to the default service catalog. The ‘Continue Shopping’ page field on the Catalog form is also populated with the previous version's glide.sc.continue.shopping.target property value.
Service catalog categories

Categories organize service catalog items into logical groups.

Categories can have a parent-child relationship, for example, IT and Laptops. A child category is a subcategory of its parent category. Each catalog item, order guide, record producer, content item, and subcategory appears as a single item within the category.

Figure 65: Service Catalog Categories

Administrators and catalog administrators can create and configure categories, defining their characteristics and adding content such as catalog items to them.

Note: If there are no active items in a category's hierarchy, that category does not appear in (and cannot be added to) the catalog. Users with the admin or catalog_admin roles can see all categories, regardless of the number of active items. Configure the glide.sc.category.canview.override property to change this behavior.

Create a category

Administrators and catalog administrators can create or edit a category.

To create or edit a category:

1. Navigate to Service Catalog > Catalog Definition > Maintain Categories.
   
   A list of existing categories appears. If the Parent field is blank, the category does not have a parent category.

2. Click New or select the category to edit.
3. Group the Service Details form with one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group by the type of change from the baseline.</strong></td>
<td>Select Change Type from the list.</td>
</tr>
<tr>
<td><strong>Group by the class of the CI.</strong></td>
<td>Select Class from the list.</td>
</tr>
</tbody>
</table>

4. Fill in the fields on the form, as appropriate.

**Table 184: Name of form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The descriptive name for the category.</td>
</tr>
<tr>
<td>Parent</td>
<td>Any parent category for which this category is a subcategory.</td>
</tr>
<tr>
<td>Catalog</td>
<td>The catalog this category belongs to.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box for indicating whether the category is available to add to the service catalog homepage.</td>
</tr>
<tr>
<td>Location</td>
<td>Any location information relevant for the category.</td>
</tr>
<tr>
<td>Header icon</td>
<td>The icon displayed beside the category header, when the category is a top-level category.</td>
</tr>
<tr>
<td>Icon</td>
<td>The small icon displayed beside the category name, when the category is listed as a subcategory.</td>
</tr>
</tbody>
</table>
### Configure dynamic categories

Dynamic categories display commonly requested items and knowledge articles on the right side of the service catalog homepage by default.

Use dynamic categories to provide users with an access option that automatically adjusts to changing request trends.

1. Navigate to **Service Catalog > Catalog Definition > Maintain Dynamic Categories**.
2. Select **New** or open an existing dynamic category.
3. Fill in the fields on the **Dynamic category** form, as appropriate.

   The **Dynamic category** form contains many of the same fields as the Category form. Additional fields are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>The kind of items to display. Can be <strong>Requested items</strong> or <strong>KB Articles</strong></td>
</tr>
</tbody>
</table>

© 2017 ServiceNow. All rights reserved.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search how long?</td>
<td>For catalog items only, the period during which to search for the most common requests. For example, enter 7 00:00:00 to display the most commonly requested items in the previous seven days.</td>
</tr>
<tr>
<td>Number of Entries</td>
<td>The number of items to display in the dynamic category.</td>
</tr>
</tbody>
</table>

4. Use this example of a step with additional info. The results displayed are limited to those items or knowledge articles available in the currently-viewed catalog.

Service catalog items

The overall catalog is made up of a collection of discrete catalog items.

A catalog item can be a good or service. If something can reasonably be ordered by itself, it's a catalog item. If something only really makes sense as part of a greater whole, it's part of an item, rather than an item in and of itself. For example a new Dell server is a catalog item, as is a new Executive Desk.

Figure 66: A Catalog Item

Create a catalog item

Service catalog enables you to define individual catalog items.

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Click New.
3. Enter the catalog item details (see table).
4. Click Submit.
5. Optional: Assign the item to additional catalogs and categories.
6. Define variables for the item, if applicable.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the item name to appear in the catalog.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Select the catalogs this item appears in.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a category for the item. Categories can only be selected after the <strong>Catalogs</strong> field is populated. Catalog searches find only items that are assigned to a category.</td>
</tr>
<tr>
<td>Model</td>
<td>[Read-only] Click the reference icon to view the product model to which the item is linked. This field is visible by default only for items created by publishing models.</td>
</tr>
<tr>
<td>Workflow or Execution Plan</td>
<td>Select either a workflow or an execution plan (formerly named delivery plan) to define how the item request is fulfilled. If you select a workflow, the <strong>Execution Plan</strong> field is hidden. Clear the <strong>Workflow</strong> field to select an execution plan.</td>
</tr>
<tr>
<td>Price</td>
<td>Set a price for the item and select the currency from the choice list.</td>
</tr>
<tr>
<td>Recurring Price</td>
<td>Set a price that occurs repeatedly at a regular interval. For example, a printer maintenance service may have a $100.00 monthly recurring price.</td>
</tr>
<tr>
<td>Recurring Price Frequency</td>
<td>Select the time frame for recurrence, such as <strong>Monthly</strong> or <strong>Annually</strong>, only if the <strong>Recurring Price</strong> field has an entry.</td>
</tr>
<tr>
<td>Omit Price in Cart</td>
<td>Select this check box to hide the item price in the cart and the catalog listing.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make this item active (available to be ordered).</td>
</tr>
<tr>
<td>Icon</td>
<td>Upload a 16x16 pixel image to appear as an icon beside the item name in the catalog. If no image is uploaded, the default icon appears beside this item. To use your own default icon, upload an image. The uploaded image overwrites the default image stored in images/service_catalog/generic_small.gif.</td>
</tr>
<tr>
<td>Preview Link</td>
<td>Click <strong>Preview Item</strong> to preview in a new window how the current item definition would look in the catalog.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Enter text that appears on the service catalog homepage, search results, and the title bar of the order form.</td>
</tr>
<tr>
<td>Ordered Item Link</td>
<td>Specify the record defining a link to preview, as shown on the ordered item screen.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the item. This description appears in the catalog when a user selects the item or clicks the associated Preview link.</td>
</tr>
<tr>
<td>Picture</td>
<td>[Optional] Upload an image of the item.</td>
</tr>
<tr>
<td>Availability</td>
<td>Define which devices display the item: Desktop and Mobile, Desktop Only, or Mobile Only. &lt;br&gt;<strong>Note:</strong> Unsupported catalog item types are not displayed on mobile devices, even if Availability is set to show an item of this type.</td>
</tr>
<tr>
<td>Mobile Picture Type</td>
<td>Define the type of picture to display for the item on mobile devices. Set to Desktop to use the standard desktop picture, Mobile to use a specific image for the mobile device using the Mobile picture field, or None for no picture.</td>
</tr>
<tr>
<td>Mobile Picture</td>
<td>Appears if Mobile picture type is set to Mobile. Select the image file to upload for the mobile picture.</td>
</tr>
<tr>
<td>Hide Price (mobile listings)</td>
<td>Select this check box to hide the item price on mobile devices. Clear the check box to display the price.</td>
</tr>
</tbody>
</table>

**Fields that can be added by configuring the form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>Select a template to populate the generated record with predefined values. This is available for Record Producer items only.</td>
</tr>
<tr>
<td>No Quantity</td>
<td>Select this check box to hide the quantity selector for the item.</td>
</tr>
<tr>
<td>No Cart</td>
<td>Select this check box to hide the shopping cart for the item.</td>
</tr>
<tr>
<td>No search</td>
<td>Select this check box to prevent this item being listed in search results.</td>
</tr>
<tr>
<td>Order</td>
<td>Control the ordering of items in category lists.</td>
</tr>
</tbody>
</table>

**Related Lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
<td>Define variables for the item to provide options for ordering the item.</td>
</tr>
<tr>
<td>Variable Sets</td>
<td>Link an existing variable set to the item to provide multiple options for ordering the item.</td>
</tr>
</tbody>
</table>
Edit a catalog item

Catalog administrators can edit an item from the service catalog listing.

To edit a catalog item from the service catalog listing:

Right-click the header and select one of the following options:

- **Configure Variables**: add or remove variables from an item.
- **New Variable**: create a new variable for the item.
- **Configure Item**: edit the item definition.
- **Configure Client Scripts**: edit the catalog client scripts for the item.
- **Configure UI Policies**: edit the catalog UI policies for the item.

Copy a catalog item

Copy an item to create a full duplicate of the item, including the item details, attachments, variables, client scripts, and approvals.

This may be more useful than using the Insert function, which only copies the item details.

1. Open a catalog item form.
2. Use the **Copy** button to create a new copy of a catalog item, named **Copy of [item name]**.

**Note**: If you copy an active catalog item, the copy is also active. Consider deactivating the copy by clearing the **Active** check box until your changes are complete.

Add a catalog item

Service catalog enables you to add a catalog item to multiple catalogs and categories.

A catalog item may be available in more than one catalog and category. For example, a laptop carrying case may be available from both Laptops and Cases and Accessories categories.

Within an item:

- The **Catalogs** related list defines the catalogs the item is available in.
- The **Categories** related list defines the categories the item is available in.

To assign an item to an additional category or catalog, enter the new details in the appropriate related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved By Group</td>
<td>Add the groups that must approve requests for this item.</td>
</tr>
<tr>
<td>Approved By</td>
<td>Add the users who must approve requests for this item.</td>
</tr>
<tr>
<td><strong>Categories</strong></td>
<td>Add any additional categories associated with this item.</td>
</tr>
<tr>
<td><strong>Catalogs</strong></td>
<td>Add any additional catalogs associated with this item.</td>
</tr>
</tbody>
</table>
Share catalog items across catalogs
You can share a catalog item, enabling users to order that item from different catalogs. For example, you can share a Password Reset item across catalogs serving different teams.

To share a catalog item across several catalogs:

1. Navigate to Service Catalog > Catalog Definition > Maintain Items
2. Open the item to share.
3. Select the additional catalogs for that item in the Catalogs field.
### Record Producer

**Name:** Password Reset  
**Application:** Global  
**Active:** ✓  
**Preview Link:** [Preview Item](#)

**Catalogs:**  
- Service Catalog  
- Can We Help You?  
- ess

**Accessiblity**  
- What it will contain  
- Generated Record Data

**Variables:**  
- Catalog Item = Password Reset  
- Actions on selected row(s): [Edit]  
- Search

**Catalogs:**  
- New  
- Edit

© 2017 ServiceNow. All rights reserved.
4. Select **Update**.
   The shared item then appears in the **Catalog Items** related list for each catalog selected.

**Types of catalog items**

Service catalog offers a few types of catalog items.

The basic service catalog item functions can be extended.

**Order guides**

Order guides enable customers to make a single service catalog request that generates several items.

For example, a New Employee Hire order guide could contain several items that new employees commonly need, such as business cards, computer, and cell phone. After selecting this order guide, the customer can then provide information about the new employee, including location and job title. The order guide then submits an order for catalog items like business cards, based on the details provided.

Order guides determine which catalog items to order by evaluating order guide rule conditions. Information the customer enters within the order guide can be passed as cascading variables to the ordered items, allowing common information to be reused across multiple items.

Administrators and catalog administrators can create order guides for the service catalog.

Order guides can be run automatically, generating a set of ordered items without needing to manually submit a service catalog request. For example, an onboarding workflow for a new employee can automatically run an order guide to order items for that employee.

The script field in an order guide can be used to add or remove catalog items to or from the order guide. It can be added to the order guide form by configuring the form layout.

- To add a catalog item that is not added to the order guide via a rule base, write the following code in the script field:

  ```java
guide.add("<sys_id_of_cat_item>")
  ```

- To remove a catalog item that is added to the order guide via a rule base, write the following code in the script field:

  ```java
guide.remove("<sys_id_of_cat_item>")
  ```

**Video tutorial**

Watch the demonstration video on how to set up an order guide.

**Create an order guide**

You can create an order guide with a two-step or three-step ordering process.

To create an order guide:

1. Navigate to **Service Catalog > Catalog Definition > Order Guides**.
2. Click **New**.
3. Fill in the fields as appropriate (see table).
4. Right-click the form header and click **Save**.
5. In the Rule base related list, define the **rules** that determine which items are included in an order.
6. [Optional] In the Variables related list, define any variables required.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Order guide name that appears in the catalog.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to indicate whether the order guide is active or not.</td>
</tr>
<tr>
<td>Category</td>
<td>Category heading under which the order guide appears in the catalog.</td>
</tr>
<tr>
<td>Two step</td>
<td>Check box to enable two-step ordering instead of the default three-step ordering, omitting the final step. With two-step ordering, selecting Check out submits the request immediately, then displays the order confirmation screen. This is not applicable for Service Portal.</td>
</tr>
<tr>
<td>Icon</td>
<td>A 16x16 pixel image to appear as an icon beside the order guide name in the catalog. If no image is uploaded, the default icon appears beside this order guide. To use your own default icon, upload an image, overwriting the image stored in images/service_catalog.generic_small.gif.</td>
</tr>
<tr>
<td>Cascade variables</td>
<td>Check box to select whether the variables used should cascade, which passes their values to the ordered items. If this check box is cleared, variable information entered in the order guide is not passed on to ordered items.</td>
</tr>
<tr>
<td>Ordered Item Link</td>
<td>Link to more information about an ordered item. Select a predefined link item to appear on the ordered item screen. Customers can click the link to access more information. This is not applicable for Service Portal.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles that users must have to access this order guide.</td>
</tr>
<tr>
<td>Short description</td>
<td>Summary of the order guide purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>Description that appears on the first page of the order guide. Apply formatting with the HTML editor.</td>
</tr>
<tr>
<td>Picture</td>
<td>[Optional] Image of the item.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Order to cart | Check box allowing users to add order guides to their cart, then continue shopping rather than checking out immediately. This is not applicable for Service Portal. **Note:** This only works when the Two step check box is also set to true.

Review an order guide example
Consider a scenario where you have a New Employee Hire order guide that provides services and items as part of the onboarding process.

To place an order from the order guide:

1. **Describe Needs:** The order guide prompts the end user for information.

2. **Choose Options:** The order guide uses the information entered and predefined rules to generate options.
The end user selects configuration options for the ordered items, and provides any additional information needed.

3. Check Out: The end user reviews and edits item information, then clicks **Submit Order** to place the request.

---

**Request an order guide**

Order guides present the customer with a three-step ordering process by default.

1. Describe Needs: Enter information as prompted. Order guide rules evaluate this information to determine which catalog items to order.
2. Choose Options: Select configuration options for the ordered items and provide any additional information needed.
3. Check Out: Review and edit item information, then click **Submit Order** to place the request.

**Note:** The Check Out step can be omitted from an order guide to provide a quicker two-step process. To omit this third step, select the Two step check box when **creating the order guide.**

---

**Create an order guide rule**

You can add a catalog item to an order guide using specific rules.

Order guide rules define conditions that must be met for a specific item to be included in an order. For example, a New Employee Hire order guide rule might state that if the new employee's job title is CTO or Director, and the department is IT, then add an executive desktop item to the order.

To create an order guide rule:

1. Navigate to **Service Catalog > Catalog Definition > Order Guides.**
2. Open an order guide.
3. In the Rule base related list, click **New.**
4. Fill in the fields as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If this condition is true</td>
<td>Conditions that must be true for this rule to apply. Create conditions using the condition builder. Conditions can be evaluated against Keywords, Requested By, Requested For, or any variables defined for that order guide.</td>
</tr>
<tr>
<td>Include this item</td>
<td>Item to include in the order if all conditions defined in If this condition is true are matched.</td>
</tr>
<tr>
<td>At this position</td>
<td>Tab position to place this item within the Choose Options screen. Tab positions are numbered in order from left to right, with the lowest number appearing at the left of the screen.</td>
</tr>
<tr>
<td>Show quantity</td>
<td>Check box to show the quantity ordered within the order confirmation.</td>
</tr>
<tr>
<td>Ignore Mandatory Evaluation</td>
<td>Check box to allow customers to proceed without completing mandatory fields for the Describe Needs and Choose Options screens. A field's mandatory status is determined by the variable defining that field.</td>
</tr>
<tr>
<td></td>
<td>If mandatory fields are not enforced, then relevant information is not passed on to the ordered items. For example, in a New Employee Hire order guide, if the address is not provided then this information is not included in business cards ordered.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
Create an order guide variable
You can create variables within an order guide.

To create or edit order guide variables, open an order guide, then select an entry from the Variables related list. Service catalog variables within order guides define the questions and potential answers presented to the customer while ordering. This information can then be used by order guide rules. Variables can also be cascaded, which passes the variable values along to individual ordered items.

Add a variable set to an order guide
You can add a variable set to an order guide.

To add a variable set to an order guide:

1. Navigate to Service Catalog > Catalog Definition > Order Guides.
2. Open an order guide.
3. In the Variable Sets related list, click Edit.
   You may need to configure the form to add the Variable Sets related list.
4. Select and add a variable set.
5. Click Save.

Cascade an order guide variable
Cascading enables values entered for variables in the initial order form to be passed to the equivalent variables in the ordered catalog items.

Cascading allows values entered for variables in the initial order form to be passed to the equivalent variables in the ordered catalog items. For example, a variable on the initial order form prompts the
customer to enter a delivery location value. If you enable cascading, the value for this variable then populates delivery location fields on each of the ordered items.

To enable cascading, select the **Cascase variables** check box when creating the order guide. Then, create variables on the catalog items that match the names of the corresponding variables in the order guide. When a customer places an order, the variables on the ordered items inherit the values of the identically named variables in the order guide.

Use a variable set when cascading variables
You can use a variable set with an order guide.

To cascade variables requires the same variable on both the order guide and the ordered items. It can be useful to define each variable just once in a variable set, then assign the variable set to both the order guide and the individual catalog item. This approach avoids duplication and ensures the variable is the same in both locations.

To use a variable set with an order guide:

1. **Create the variable set.**
2. In the Variable Set form, create each variable.
3. Add the variable set to the order guide and to each catalog item involved.

**Note:** The individual variables in a variable set do not appear in the Order guide or Catalog Item forms. To view the variables in a variable set, open the variable set record.

Hide cascaded variables
You can hide the duplicated variables on the **Choose Options** screens to keep your screen clean.

When cascading variables, you may want to hide the duplicated variables on the Choose Options screens, making these screens simpler.

To hide duplicate variables on all screens after the initial Describe Needs screen in the Service Catalog Platform UI, run an onLoad catalog client script.

For example,

```javascript
function onLoad(){
var item = $('current_item');
var guide = $('sysparm_guide');
if(item!=null && guide !=null && item.value==
guide.value) return;

g_formsetDisplay('YOUR_VARIABLE_NAME',false);
}
```

To hide duplicate variables on all screens after the initial Describe Needs screen in Service Portal, use the `isOrderGuide()` API.

For example,

```javascript
if(g_service_catalog.isOrderGuide())

    g_form.setDisplay('variable_name', false);
```

Avoid enforcement of a mandatory field
You can avoid enforcing a mandatory field within tabs.

By default, mandatory fields must be filled in before switching tabs in the **Choose Options** section of order guides.
Figure 67: Order guide mandatory fields

In this example, if the customer attempts to select another tab without filling in the Street Address field, a warning prompt appears. The customer cannot switch tabs without entering this information.

To avoid this enforcement in all order guides:

1. Navigate to Service Catalog > Catalog Policy > Properties.
2. Locate the property Validate mandatory fields when switching tabs in 'Choose Options' section of Order Guides (glide.sc.guide.tab.validate).
3. Clear the Yes check box.

   If you make this change, mandatory fields are still mandatory, but the customer can switch between tabs before filling in the mandatory fields. Enforcement is then checked when the customer chooses to proceed to the next step.

   To avoid enforcement of mandatory fields altogether, use the Ignore Mandatory Evaluation check box within the relevant order guide rule.

Run order guides automatically

An order guide automatically from within a workflow or a server script, passing parameters to that order guide to define variable values.

You can run an order guide automatically from within a workflow or a server script, passing parameters to that order guide to define variable values.

This enables you to automatically generate a set of ordered items as part of a wider process, without needing to manually submit a service catalog request and reenter existing information.

For example, you can run an order guide to fulfill HR onboarding requests, passing parameters such as the new employee's position and department. The order guide then generates a set of requested items such as laptop and email account, based on those parameters.
Record Producer
A record producer is a specific type of catalog item that allows end users to create task-based records, such as incident records, from the service catalog.

Record producers provide a simplified alternative to the regular form interface for creating records.

**Note:** Use record producer to create task-based records only.

You can create a record producer for tables and database views that are in the same scope as the record producer and for tables that allow create access from applications in other scopes.

Define a record producer in the service catalog or from the table record.

**Note:** To ensure that standard service catalog processes are followed, such as initiating workflows as expected, do not create requested item records from record producers. Instead, create requested item using catalog items.

Create a record producer
You can create a record producer for tables and database views that are in the same scope as the record producer and for tables that allow create access from applications in other scopes.

1. Navigate to **Service Catalog > Catalog Definition > Record Producers**.
2. Click **New** or select the record producer to edit.
3. Fill in the fields on the Record Producer form (see table).
4. Click **Submit**.

   After you submit the form, the **Variables, Variable Sets, Categories,** and **Catalogs** related lists become available.

5. Open the record again to define variables for the record producer.
<table>
<thead>
<tr>
<th>Name</th>
<th>Password Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Global</td>
</tr>
<tr>
<td>Active</td>
<td>Yes</td>
</tr>
<tr>
<td>Table name</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Model</td>
<td>[Select Model]</td>
</tr>
<tr>
<td>Preview link</td>
<td>Preview Item</td>
</tr>
<tr>
<td>Catalogs</td>
<td>[Select Catalogs]</td>
</tr>
<tr>
<td>Category</td>
<td>[Select Category]</td>
</tr>
<tr>
<td>View</td>
<td>ess</td>
</tr>
<tr>
<td>Availability</td>
<td>Desktop and Mobile</td>
</tr>
<tr>
<td>Can cancel</td>
<td>[ ]</td>
</tr>
<tr>
<td>No records to display</td>
<td></td>
</tr>
</tbody>
</table>
**Note:** You may need to configure the form to see all fields.

### Table 188: Record Producers in the Service Catalog

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The descriptive name for the record producer.</td>
</tr>
<tr>
<td>Note:</td>
<td><img src="image" alt="Note: The list shows only tables and database views that meet the scope protections for field styles." /></td>
</tr>
<tr>
<td>Table name</td>
<td>The table in which the record producer creates records.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box for making the record producer active. Only active record producers are available to users if they meet the role criteria.</td>
</tr>
<tr>
<td>Preview Link</td>
<td>A link that opens a preview of the item.</td>
</tr>
<tr>
<td>Accessibility</td>
<td></td>
</tr>
<tr>
<td>Catalogs</td>
<td>The service catalog this record producer belongs to.</td>
</tr>
<tr>
<td>Category</td>
<td>The service catalog category this record producer belongs to. When users perform catalog searches, only items that are assigned to a category appear in search results.</td>
</tr>
<tr>
<td>View</td>
<td>The CMS view in which the item is visible.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles required to use the record producer.</td>
</tr>
<tr>
<td>Availability</td>
<td>The interface the record producer is available from: Desktop and Mobile, Desktop Only, or Mobile Only.</td>
</tr>
<tr>
<td>Can cancel</td>
<td>A check box for displaying a Cancel button on the record producer. Users can click Cancel to cancel the record producer and return to the last-viewed screen.</td>
</tr>
<tr>
<td>What it will contain</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A short summary of the record producer.</td>
</tr>
<tr>
<td>Description</td>
<td>The full description of the record producer. The description appears under a More information link on the record producer to give users any additional information they may need.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Script</td>
<td>Scripts that should be run to dynamically assign values to specific fields on the created record.</td>
</tr>
<tr>
<td>Icon</td>
<td>The small icon that appears on the list of service catalog items. Click the <strong>Click to add</strong> link and upload the photo.</td>
</tr>
<tr>
<td>Picture</td>
<td>The picture that appears at the top of the record producer form on the desktop view. Click the <strong>Click to add</strong> link and upload the photo.</td>
</tr>
<tr>
<td>Mobile picture</td>
<td>The small picture that appears on the list of service catalog items. Click the <strong>Click to add</strong> link and upload the photo.</td>
</tr>
<tr>
<td>Mobile picture type</td>
<td>The picture that the mobile interface uses on the list of service catalog items. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Desktop: Uses the icon specified in the <strong>Icon</strong> field. Selecting this option hides the <strong>Mobile picture</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• Mobile: Uses the icon specified in the <strong>Mobile picture</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• None: Does not use any picture on the mobile view. Selecting this option hides the <strong>Mobile picture</strong> field.</td>
</tr>
<tr>
<td>Generated Record Data</td>
<td>Static assignments for fields on the created record.</td>
</tr>
</tbody>
</table>

Create record producers from tables

You can create service catalog record producers directly from a table record.

To create a record producer from a table record:

1. Navigate to **System Definition > Tables** and open the table record.

   **Note:** When using a workflow with a Record producer, set the condition to Run the workflow.

2. Under **Related Links**, click **Add to Service Catalog**.
3. Complete the **Name, Short Description, and Category** fields as you would for service catalog items.
4. Use the slushbucket to select the fields and the order in which you want them to appear. To use container variables, select `|- container start -|` and `|- container end -|`. 
5. Click **Save and Open** to open the record producer and define additional options. Alternatively, click **Save** to return to the table record.

- A record producer is created with these values:
  - **Table name**: table record opened in step 1
  - **Name**, **Short Description**, and **Category**: information entered in step 3
- A variable is created for each of the selected fields with these values:
  - **Name**: Column name of the field
Set up a record producer

To enter data with a record producer, use any combination of the following methods:

- Create a variable on the record producer with the same name as the field in the target record. For example, a variable named caller_id on a **Create a New Incident** record producer populates the caller_id field on the new incident record. Use a variable type that corresponds to the field type.
- Define a template to assign a static field value for all records created by the record producer.
- Define a script that uses any variable or server-side objects and functions to assign values.
  - Use current.*FIELD_NAME* to reference fields on the record being created.
  - Use producer.*VARIABLE_NAME* to reference values entered by the end user.

**Redirect After Submitting a Record Producer**

To redirect an end user to a particular page after the record producer is submitted, define the redirect link in the Script field using producer.redirect. For example, the following code redirects users to their homepage after the record producer is submitted:

```javascript
producer.redirect="home.do";
```

Variables to collect data for record producer fields

Use variables to collect data for record producer fields.

You can use the following variable types to collect data for the corresponding record producer fields.

### Table 189: Creating Variables for Field Types

<table>
<thead>
<tr>
<th>Field type</th>
<th>Recommended variable type</th>
</tr>
</thead>
<tbody>
<tr>
<td>True/False</td>
<td>Yes/No</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference</td>
</tr>
<tr>
<td>Date or Due Date</td>
<td>Date</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Choice or any field with an associated choice list</td>
<td>Select Box</td>
</tr>
<tr>
<td>HTML</td>
<td>HTML</td>
</tr>
<tr>
<td>List or UI Action List</td>
<td>List Collector</td>
</tr>
<tr>
<td>String with length greater than 256</td>
<td>Multi Line Text</td>
</tr>
<tr>
<td>String, Integer, Decimal, Floating Point Number</td>
<td>Single Line Text</td>
</tr>
<tr>
<td>All other field types</td>
<td>Multi Line Text</td>
</tr>
</tbody>
</table>
Values Returned

When you construct a record producer, you should be aware of the return value.

Most of these field types return a string. However, there are some exceptions. For example, a Reference value returns the `sys_id` of the target object, and a List value returns a comma-separated list of `sys_ids`.

Example 1: For a List value, return an array which can be iterated to retrieve the individual values submitted by your user:

```
var sys_id_string = producer.glide_list_field; var sys_id_list = string.split(',');
```

Example 2: For a Date or Date/Time value, return a date which can be evaluated by GlideDate.

```
var glideDateTime = new GlideDateTime(producer.date_field);
```

Content items

A content item is a service catalog item that provides information instead of goods or services.

Content items may reference knowledge articles, static blocks of text, or external web-based content.

To define content items:

1. Navigate to Service Catalog > Catalog Definition > Content Items.
2. Click New.
3. Fill in the form to define the item.

4. Click Submit.
Table 190: Content Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name, Category, Icon, Roles, Active</td>
<td>As for standard catalog items.</td>
</tr>
</tbody>
</table>
| Content type | The type of information to display when a user selects the item.  
  - **KB Article**: a ServiceNow knowledge article available to users with the specified roles.  
  - **Catalog Content**: a static block of text, formatted with HTML.  
  - **External Content**: documents or web pages stored outside the ServiceNow ITSA Suite instance. |
| Target | Location where the content appears.  
  - **Within Catalog**: displays the content within the catalog iframe window (which may not render some external websites properly).  
  - **New Window/Tab**: displays the content in a new browser window or tab. Choose this option if the content does not display properly within the catalog. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| URL                 | The full URL (including the prefix `http://` or `https://`) for external content to display when a user selects the item. This field is available only if the **Content type** is **External Content**.  

**Note:** Since ServiceNow ITSA Suite instances are accessed via HTTPS, links to HTTP sites may result in a mixed mode content error or warning, depending on browser security settings. |
| KB article          | The knowledge article to display when a user selects the item. This field is available only if the **Content type** is **KB Article**. |
| Short description, Description, Picture | As for standard catalog items. These fields are only available if the **Content type** is **Catalog Content**. |

---

### Add an ordered item link

Catalog administrators can provide a link on the ordered item screen, linking to more information about an item.

After users order the catalog item, they can click the link to see relevant information about the item they ordered, for example, for standard delivery terms and conditions. The URL text and link can be defined once and reused across multiple items.

Links are rendered with an added parameter providing the sys_id of the requested item. For example, if the link is mylink.com, it is rendered as mylink.com?req_item=abcde12345. This can be useful for virtual provisioning situations.

**Note:** The ordered item link cannot be configured for mobile devices.

To create an ordered item link, then add an ordered item link to an item:

1. Navigate to **Service Catalog > Catalog Definition > Ordered Item Links**.
2. Click **New**.
3. Enter a **Name** for the ordered item link.
4. Enter **Link text** to display as the link. For example, *Click here to see more information about the iPhone*.
5. Enter the exact **Link URL**. For example, `http://www.mylink.com`.
6. Select the **Target**. You can choose to open the link in a new window or tab, or within the catalog. If **Within Catalog** is chosen, the link must be within the same site. An HTTP site cannot be called from within HTTPS.
7. Click **Submit**.
8. Navigate to **Service Catalog > Catalog Definition > Maintain Items**.
9. Click an item **Name**.
10. In the **Ordered Item Link** field, click the reference lookup icon.
11. Click an ordered item link **Name**.
12. Click **Update**.

### Service catalog UI policy

UI policies can be used to define custom process flows for tasks. **UI policies** are useful when applied to service catalog items. Keep the following points in mind when creating service catalog UI policies:

- A catalog UI policy applies to either a specific catalog item or any item that uses a specific variable set.
- A catalog UI policy can only contain and reference variables that are defined for the catalog item or variable set.
- Exactly like UI policy conditions, the variables in a service catalog UI policy condition must be visible (even if hidden by UI policy or read-only) on the form for the condition to be tested. Also, ensure that the variables have names. For more information see ***Creating a Catalog Client Script***.
- Limited UI policy functionality applies to following variables:
  - Mandatory and Read Only policy do not apply to the following variable types: Break, Container Start, Container Split, Container End, UI Macro, UI Macro with Label, Label, UI Page
  - Set visible policy does not apply to the following variable types: Break, Container Split, Container End

- Service catalog UI policies are applied to variables and variable sets of catalog items ordered in the service catalog. Policies can also be applied when the variables are present in a Requested Item or Catalog Task form.
- Catalog UI policies are supported for catalog items viewed in a service catalog **wizard**.

**Note:** The UI policy for catalog items always takes precedence over UI policy for variable sets.

### Create a UI policy for catalog items

You can apply UI policies to variables and variable sets of catalog items ordered in the service catalog.

1. Navigate to **Service Catalog > Catalog Policy > Catalog UI Policies**.
2. Click **New**.
3. Right-click the form header and select **Views > Default view** or **Advanced**.
4. In the **Applies to** field, select **A Catalog Item**.
5. Fill in the remaining fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>Select the type of item this UI policy applies to:</td>
</tr>
<tr>
<td></td>
<td>• <strong>A Catalog Item</strong>: enables the <strong>Catalog item</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>A Variable Set</strong>: enables the <strong>Variable set</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Catalog Item or Variable Set</td>
<td>Select the catalog item or a variable set this UI policy applies to. The field name and options available depend on the <strong>Applies to</strong> selection.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter a brief description (example, Out-of-state move).</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the UI policy. Clear the check box to disable it.</td>
</tr>
<tr>
<td>When to Apply</td>
<td><strong>Catalog Conditions</strong> Create conditions for the UI policy using catalog item variables. The policy is applied if the conditions evaluate to true. For example, a catalog item of <strong>Schedule a Move</strong> may have a condition of <strong>move_from &gt; is &gt; San Diego</strong>. The UI policy is applied when an employee schedules a move from San Diego to any other company location.</td>
</tr>
<tr>
<td>Applies on a Catalog Item view [Advanced view]</td>
<td>Select the check box to apply the UI policy to catalog items within the order screen.</td>
</tr>
<tr>
<td>Applies on Catalog Tasks [Advanced view]</td>
<td>Select the check box to apply the UI policy on a Catalog Task form.</td>
</tr>
<tr>
<td>Applies on Requested Items [Advanced view]</td>
<td>Select the check box to apply the UI policy on a Requested Item form.</td>
</tr>
<tr>
<td>On load [Advanced view]</td>
<td>Select the check box to apply the UI policy when the form is loaded. Clear the check box to apply the policy only when the form is changed.</td>
</tr>
<tr>
<td>Reverse if false [Advanced view]</td>
<td>Select the check box to reverse the UI policy if the <strong>Catalog Conditions</strong> statement evaluates to false.</td>
</tr>
<tr>
<td>Script</td>
<td><strong>Run scripts [Advanced view]</strong> Select the check box to use the <strong>Execute if true</strong> and <strong>Execute if false</strong> scripting fields. Scripts are necessary to apply a UI policy other than <strong>Read Only</strong>, <strong>Mandatory</strong>, or <strong>Visible</strong>. For example, you must create a script to apply a UI policy to a specific role.</td>
</tr>
<tr>
<td>Other fields</td>
<td><strong>Order</strong> Enter the sequence in which this UI policy is evaluated if more than one matching UI policy exists. The order is evaluated from the lowest value to the highest value.</td>
</tr>
<tr>
<td></td>
<td><strong>Global</strong> This field is not used for the service catalog.</td>
</tr>
<tr>
<td></td>
<td><strong>Inherit</strong> This field is not used for the service catalog.</td>
</tr>
<tr>
<td></td>
<td><strong>UI Action</strong></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default view or Advanced view</td>
<td>Changes the form view to the default or advanced view. The fields change based on the view.</td>
</tr>
<tr>
<td>UI Action</td>
<td></td>
</tr>
<tr>
<td>Variable name</td>
<td>Select the variable that belongs to the catalog item or variable set.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Choice list for specifying how the UI policy affects the mandatory state of the field. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Leave alone</td>
</tr>
<tr>
<td></td>
<td>• True</td>
</tr>
<tr>
<td></td>
<td>• False</td>
</tr>
<tr>
<td>Visible</td>
<td>Choice list for specifying how the UI policy affects the visible state of the field. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Leave alone</td>
</tr>
<tr>
<td></td>
<td>• True</td>
</tr>
<tr>
<td></td>
<td>• False</td>
</tr>
<tr>
<td>Read Only</td>
<td>Choice list for specifying how the UI policy affects the read-only state of the field. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Leave alone</td>
</tr>
<tr>
<td></td>
<td>• True</td>
</tr>
<tr>
<td></td>
<td>• False</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
Service catalog UI policy examples

The following is an example of how service catalog UI policies work.

**Example**

The following UI policy makes it mandatory for any department to specify the name of the department if **Department** is selected for the question **Department or group?**.
Figure 68: Catalog UI Policy

Service catalog variables

Administrators and users with the catalog_admin role can define service catalog variables.
A service catalog variable provides the ability to capture and pass on information about choices a customer makes when ordering a catalog item. Some variables can be defined to affect the order price, depending on the selected value.

For example, a New PC catalog item can use a variable called "Memory", which provides choices to allow customers to select extra memory, for associated extra prices.

Variables can be stored, accessed from multiple places, and passed between tasks in a process when fulfilling a request.

Variables can be displayed on the Requested Item and Catalog Task forms after an item has been ordered.

ServiceNow ITSA Suite provides a full set of variable types.

Types of variables

ServiceNow provides a set of 26 variable types.

The service catalog supports several types of service catalog variables, which are also referred to as questions. Some variable types accept variable attributes. You can also attach help text to any service catalog variable.

Refer to each variable for more information:

- Break
- Check box
- Container variables
- Date
- Date and Time
- HTML
- Label
- List Collector
- Lookup Multiple Choice
- Lookup Select Box
- Macro
- Macro With Label
- Masked
- Multi-Line Text
- Multiple Choice
- Numeric Scale
- Reference
- Select Box
- Single-Line Text
- UI Page
- Wide Single-Line Text
- YesNo

The following table shows the UI policy that does not apply to the variable/s listed against it.
### Table 191: UI policy and variables

<table>
<thead>
<tr>
<th>UI policy</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory</td>
<td>Break, Container Start, Container End, Container Split, Label, Macro, Macro with Label, UI Page</td>
</tr>
<tr>
<td>Read only</td>
<td>Break, Container Start, Container End, Container Split, Label, Macro, Macro with Label, UI Page</td>
</tr>
<tr>
<td>Visible</td>
<td>Break, Container End, Container Split</td>
</tr>
<tr>
<td>Show Attributes When Type is One of Certain Values</td>
<td>Macro, Macro with Label</td>
</tr>
</tbody>
</table>

#### Break

Displays a horizontal line across the form. Breaks are formatting elements. No data is collected. The break variable is not yet supported on service portal and mobile devices.

> Once this request is fulfilled and the category is created, you will be notified via email and sent a link to begin creating your items.

![Break](image)

**Figure 69: Break**

#### Check box

Creates a check box to enable/disable options by selecting/clearing it. List check boxes in order under a `label` to create a multi-option question (as shown in the figure).

Consecutive check box variables are automatically grouped under an `Options` label. If you want to define a label of your own, then group check boxes under a `label` variable. The default Options label is replaced with the label variable.
Optional Software

☐ Microsoft Powerpoint
☐ Adobe Acrobat
☐ Adobe Photoshop
☐ Siebel Client

Figure 70: Check box

Container start, container split, container end

All three variables are used to define a layout for a container that can hold more variables. Use container start and container end variables to define the start and end points of a container layout. The container end must be used along with container start to close a container.

A container layout can be split into two or three columns using the container split variable. By default, the split is calculated at the 50% mark.

A container is similar to a variable set. Unlike a variable set, containers can be used anywhere (including inside a variable set) and can be nested (a container inside a container). Refer to KB0539982 for more information on using container variables.

To reproduce the container format as shown in the figure, do the following in the container start variable:

- Select a Layout with 2 Columns Wide, alternating sides.
- Select the check box for Display title to use a collapsible title bar.

The container variables are not yet supported on service portal and mobile devices.

Memory & CPU Options

CPU Speed

- Intel Xeon Processor (2.66GHz 1.333GHz FSB)
- Intel Xeon Processor (3.73GHz 1.333GHz FSB)

Memory

1GB

Figure 71: Container

Date

Creates a date input widget to display a date value.
Date and time

Creates a date and time input widget to display both date and time values. Time value is stored in Greenwich Mean Time (GMT) and displayed in the time zone of the current user.
HTML

HTML variables are useful for providing more content for an item that requires more advanced formatting, including images.

The variable can be:

- Used for user input.
- Used for reusable content when put into a variable set (for example, terms and conditions).
- Available in two modes: Edit and Read-only. In edit mode, a toolbar is available, and links do not work. In read-only mode, no toolbar is available, and links work. To switch between modes, use entitlements or create a UI policy to set the HTML field to read-only mode.

**Attention:** HTML variables are not supported for display on the shopping cart summary or approval summary screens. If the type is 'HTML', the available in summaries field is hidden in the variable form.

The HTML variable is not yet supported on service portal and mobile devices.
Your comments are valuable to us.

Figure 74: HTML

**Label**

Displays a label across the form. Labels are formatting elements. No data is collected.

**Tip:** You can use labels to arrange questions into sections. Use labels to create a multi-option question (for example, using *check boxes*).
List collector

Uses the list collector *slushbucket* interface to add multiple records from a table. The list collector variable is not yet supported on service portal and mobile devices.

Lookup multiple choice

Creates radio buttons using data from a table. Functionality is similar to *lookup select box*, which creates a choice list from queried data.
The lookup multiple choice variable is not yet supported on service portal and mobile devices.

Software
- Adobe Systems Acrobat 9.0
- Adobe Systems Dreamweaver 5.5
- Adobe Systems Fireworks CS6
- Apple QuickTime Pro 7
- IBM Lotus Notes 8.5.3
- Microsoft Access 2010

Figure 77: Lookup multiple choice

Lookup select box

Creates a choice list using data queried from a table. Functionality is similar to lookup multiple choice, which creates radio buttons from queried data.

To create the lookup select box shown in the figure, enter the following values:

- **Lookup from table**: Incident [incident]
- **Lookup value field**: Sys ID
- **Lookup label field**: number, category, priority
- **Reference qual**: caller_id=javascript:gs.getUserID()^active=true

The lookup select box variable is not yet supported on service portal and mobile devices.
Macro

Inserts a *UI macro* into the catalog item.

UI macros in the service catalog do not support the following glide_list functions: clickthrough, slushbucket editing, and email field.

**Attention:** Use *phase one* Jelly only for any UI macros added as variables. Phase two Jelly within the macro is not processed and appears on the page as standard content.

The macro variable is not yet supported on service portal and mobile devices.

Macro with label

Inserts a UI macro with a label.

The macro with label variable is not yet supported on service portal and mobile devices.
Masked

Inserts a text input box. Text entered in this text box is masked out, with each keystroke represented as an asterisk (*) symbol. Masked is useful for questions asking for sensitive or confidential data such as passwords.

The masked variable is not yet supported on service portal and mobile devices.

Multi-line text

Creates a multiple line text input widget.
**Multiple choice**

Creates radio buttons for question choices.

![Multiple choice](image)

**Figure 83: Multiple choice**

**Numeric scale**

Creates a horizontal set of radio buttons with numeric options from Scale min to Scale max (a *Likert scale*).

![Numeric scale](image)

**Figure 84: Numeric scale**

**Reference**

References a record in another table. For example, a variable named point_of_contact references the User [sys_user] table.

Keep the following information in mind as you work with reference variables:

- Reference variables use the *auto-complete feature*. To ensure that users have enough information, configure the *reference lookup list*.
- Reference variables store the sys_id of the selected record (like reference fields). To use the display value in a *script*, use the same methods as for a reference field.

```javascript
current.variables.<variable name>.getDisplayValue()
```

```javascript
current.variable_pool.<variable name>.getDisplayValue()
```

**Figure 85: Reference**

**Select box**

Creates a choice list from pre-defined question choices.
Do you need this today?

Yes

Figure 86: Select box

Single-line text

Creates a single-line text input field.

The single-line text variable is not yet supported on service portal and mobile devices.

Last Name

Johnston

Figure 87: Single-line text

UI page

Inserts a UI page into the catalog item.

Attention: Use phase one Jelly only for any UI page added as variables, as phase two Jelly within the UI page is not processed and appears on the page as standard content.

The UI page variable is not yet supported on service portal and mobile devices.

Wide single-line text

Creates a single-line text input field that spans the form, allowing for longer input.

The wide single-line text variable is not yet supported on service portal and mobile devices.

Figure 88: Wide single-line text
Yes/No

Creates a choice list with Yes and No as options.

![Yes/No Choice List](image)

Figure 89: Yes/No

Service portal and mobile support for variables

The service catalog on mobile devices and service portal do not support the following variable types:

- Break
- Container variables
- HTML
- Label
- List Collector
- Lookup Multiple Choice
- Lookup Select Box
- Macro
- Macro With Label
- Masked
- Single-Line Text
- UI Page
- Wide Single-Line Text

Create a variable

Create service catalog variables to ask questions for ordering a catalog item.

To create a variable for a catalog item:

1. Navigate to Service Catalog > Maintain Items.
2. Select the desired catalog item.
3. In the Variables related list, click New.
4. Select the variable type - some additional fields are displayed depending on the type.
5. Fill in the fields.

Table 192: Catalog variable form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select a variable type to create.</td>
</tr>
<tr>
<td>Application</td>
<td>Read-only field that indicates which applications can use this variable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cat item</td>
<td>Displays the catalog item using the variable.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Select to make the variable mandatory as part of the ordering process.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to make the variable active (available).</td>
</tr>
<tr>
<td>Order</td>
<td>The sequence order for the placement of variables. Variable with the least value is placed at the top followed by variable with the next greatest value. For example: 1, 2, 3, 4... 100, 200, 300, 400...</td>
</tr>
<tr>
<td>Global</td>
<td>If selected, the variable is available for all catalog tasks within service catalog workflows or execution plans by default. If deselected, the variable must be associated with individual catalog tasks.</td>
</tr>
</tbody>
</table>

**Fields displayed when the variable belongs to record producers**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map to field</td>
<td>Maps the variable to a specific field on the table for the record producer.</td>
</tr>
<tr>
<td>Field</td>
<td>The field that the variable maps to.</td>
</tr>
<tr>
<td>Record producer table</td>
<td>The table that the record producer creates a record in.</td>
</tr>
</tbody>
</table>

**Question**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Compose a question to display to the end user.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter an identifying name for the question to be stored in the system.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>When the user rests the pointer on the variable, the tooltip is displayed. Enter a brief note to describe the purpose of the 'Question'.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a detailed description of the question. It is not visible to the customer.</td>
</tr>
<tr>
<td>Show help</td>
<td>Select to provide help information.</td>
</tr>
</tbody>
</table>

**Type Specifications:** Options in this section differ depending on the variable type.

**Default Value**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value</td>
<td>The default value for the variable.</td>
</tr>
<tr>
<td>Variable attributes</td>
<td>The attributes for this variable.</td>
</tr>
</tbody>
</table>

**Availability**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible Elsewhere</td>
<td>Displays the variable on other types of catalog items (such as content items and record producers).</td>
</tr>
<tr>
<td>Visible on Bundles</td>
<td>Displays the variable on bundles.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Visible on Guides</td>
<td>Displays the variable on order guides.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If an order guide has too many items and variables, consider unchecking this option on as many items as possible, to improve loading performance on order guides.</td>
</tr>
<tr>
<td>Visible on Summaries</td>
<td>Displays the variable on the summary of the catalog item.</td>
</tr>
</tbody>
</table>

6. If applicable, **apply roles** to control who can create, read, or update the information in the variable.

7. Click **Submit**.

**Define help information**

Additional user assistance helps to fulfill a variable’s purpose.

To include help information for variables:

1. Select the **Show Help** option.
   Additional fields appear, to define the **Help** tag and **Help** text.

2. In the **Help** tag field, enter the short descriptive text that should appear between the question and the responses. For example, **Click here for help** or **Preview**.
3. In the **Help text** field, enter the expanded help text that appears when the user clicks the **Help** tag.

**Note:** Help Text and Help Tag are not designed to support HTML tags. If you choose to use HTML tags, the `glide.ui.escape_text` property in High Security Settings is honored. See [KB0562895](#).

---

### Password

![Password](image)

### Variable type specifications

List of fields displayed for variable type specifications.

#### Table 193: Type specifications for catalog variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Displayed for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price if checked</td>
<td>The price of the item.</td>
<td>CheckBox</td>
</tr>
<tr>
<td>Recurring price if checked</td>
<td>The price that increments for the order, when the user requests more than a single quantity.</td>
<td>CheckBox</td>
</tr>
<tr>
<td>Layout</td>
<td>Sets the layout for the container, whether one or two columns.</td>
<td>Container Start</td>
</tr>
<tr>
<td>List table</td>
<td>The table with the values for the list collector.</td>
<td>List Collector</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Displayed for</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reference qual</td>
<td>Supports <em>reference qualifiers and advanced reference qualifiers.</em> Returns all matching results (no maximum).</td>
<td>List Collector, Lookup Multiple Choice, Lookup Select Box, Reference</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For security reasons, the use of scripts in the Reference qual field is restricted to system administrators through the Allow javascript in Default Value business rule.</td>
<td></td>
</tr>
<tr>
<td>Lookup from table</td>
<td>Specify a database table for the variable to look into. The values from this table are populated in the Lookup value field.</td>
<td>Lookup Multiple Choice, Lookup Select Box</td>
</tr>
<tr>
<td>Lookup value field</td>
<td>Specify a database field for the variable to look into. Values associated to the database field are loaded as selection options for the variable.</td>
<td>Lookup Multiple Choice, Lookup Select Box</td>
</tr>
<tr>
<td>Lookup label field(s)</td>
<td>A comma-separated list of fields on the lookup table whose values are used to display the selections in the select box.</td>
<td>Lookup Multiple Choice, Lookup Select Box</td>
</tr>
<tr>
<td>Lookup price field</td>
<td>The field whose value is used to modify the price of the item being ordered.</td>
<td>Lookup Multiple Choice, Lookup Select Box</td>
</tr>
<tr>
<td>Lookup recurring price field</td>
<td>The field whose value is used to modify the recurring price of the item being ordered.</td>
<td>Lookup Multiple Choice, Lookup Select Box</td>
</tr>
<tr>
<td>Choice direction</td>
<td>Sets the direction for choice list. Across arranges choices horizontally. Down arranges choices vertically.</td>
<td>Lookup Multiple Choice, Multiple Choice</td>
</tr>
<tr>
<td>Include none</td>
<td>Select the check box to include the term None in a list of choices.</td>
<td>Lookup Multiple Choice, Lookup Select Box, Multiple Choice, Select Box</td>
</tr>
<tr>
<td>Unique values only</td>
<td>Permit the field to have a unique value. The system does not allow two records to have the same value for that field.</td>
<td>Lookup Multiple Choice, Lookup Select Box, Select Box</td>
</tr>
<tr>
<td>Macro</td>
<td>The <em>Ui macro</em> to insert into the catalog item.</td>
<td>Macro, Macro with Label, UI Page</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Displayed for</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Use confirmation</td>
<td>Select to provide the user with a confirmation prompt. Users reenter data when prompted to confirm their data entry.</td>
<td>Masked</td>
</tr>
<tr>
<td>Use encryption</td>
<td>Select to store the answer in encrypted format in the database. If not encrypted, the answer is stored in plain text format. Encryption uses Triple DES with system encryption.</td>
<td>Masked</td>
</tr>
<tr>
<td>Do not select the first choice</td>
<td>Applies to default choice selection on loading the page. If checked, no choices are selected. If unchecked, the first choice is selected by default.</td>
<td>Multiple Choice, Numeric Scale</td>
</tr>
<tr>
<td>Scale min</td>
<td>Enter the lowest value/level on the selectable scale.</td>
<td>Numeric Scale</td>
</tr>
<tr>
<td>Scale max</td>
<td>Enter the highest value/level on the selectable scale.</td>
<td>Numeric Scale</td>
</tr>
<tr>
<td>Reference</td>
<td>Specify a reference table for the variable.</td>
<td>Reference</td>
</tr>
<tr>
<td>Use reference qualifier</td>
<td>Select the type of qualifier - simple, dynamic, or advanced.</td>
<td>Reference</td>
</tr>
<tr>
<td>Reference qual condition</td>
<td>Simple qualifier - Option to build conditions.</td>
<td>Reference</td>
</tr>
<tr>
<td>Dynamic ref qual</td>
<td>Dynamic qualifier - Select a dynamic filter to run a query against a reference field.</td>
<td>Reference</td>
</tr>
<tr>
<td>Choice table</td>
<td>Specify a database table. The values from this table are populated in the Choice field.</td>
<td>Select Box</td>
</tr>
<tr>
<td>Choice field</td>
<td>Specify a database field. Select box variable loads the field choices as selection options. If no choices are defined for a field, then the variable loads field-related distinct values from the database table.</td>
<td>Select Box</td>
</tr>
</tbody>
</table>

**Variable attributes**

Some service catalog variables support specific attributes.

In the catalog variable form, attributes are entered in the **Variable attributes** field. You can enter multiple attributes for a variable type by separating each with a comma.
Note: If you do not see the Variable attributes field, then enable the Show attributes when Type is One of Certain Values UI policy.

Lookup multiple choice, Lookup select box

- ref_qual_elements: A list of fields to be sent back to the server to get an updated reference.

Reference

- ref_auto_completer: Specifies the name of a JavaScript class (client-side) that creates the list for auto completion choices.
- ref_ac_columns: Specifies the columns whose display values appear in an auto completion list in addition to the name.
- ref_ac_order_by: Specifies the column that is used to order the auto completion list.

Single-line text, Wide single-line text

- max_length: Sets the maximum character length. For example, max_length=200. The maximum value for max_length is 4000.

Attention: Attribute behavior is specific to the service catalog.

Question choice

Service catalog enables you to define a question choice for a variable.

Some variable types present the user with a list of choices. For example, a multiple choice variable that asks how much memory you want in a computer requires you to define the available choices, such as 1GB and 2GB.

To define a question choice for a variable:

1. Open the variable definition.
2. In the Question Choices related list, click New.
3. Enter the question choice details and click **Submit** to save the record.
   - **Price** and **Recurring price**: variables may affect the item's price and recurring price (if used).
   - **Order**: the number defining the order this appears when displayed.
   - **Question**: the actual question being asked for that variable.
   - **Text**: the choice presented to the user.
   - **Value**: the value stored in the database.

4. Repeat the steps for each available choice to define the full set of choices for that variable.

   **Note**: When you modify variable choices that are attached to a catalog item, the existing requested items (RITMs) are also affected. For example, if you add a variable choice for the catalog item, the value of that choice is also considered in the existing RITMs. If you delete a variable choice that is selected for a RITM, the value of that choice still persists in the RITM.

**Pass variables between tasks**

Variables are passed from one step of the fulfillment process to another. They can be processed by any workflow or execution plan that is associated with the requested items.
For example, consider the following tasks within the fulfillment process for a New PC catalog item.

1. Procure a PC.
2. Install corporate standard software.
3. Set up email account.
4. Deliver and set up PC for requester.

Step 4 may require a piece of information from step 3 (the email account credentials for setting up email on the PC). If steps 3 and 4 are executed by different fulfillment groups, you can use variables to make this information visible in the tasks for steps 3 and 4, and to pass it between groups so that the second group can access the email account credentials.

Service catalog data lookup

The Data Lookup and Record Matching Support for Service Catalog plugin offers similar features to the general Data Lookup and Record Matching Support plugin.

The Data Lookup and Record Matching Support for Service Catalog plugin offers similar features to the general Data Lookup and Record Matching Support plugin. Use the plugin for service catalog to perform data lookups for variables on service catalog item screens, on requested items, and on catalog tasks as a user fills out the values contained in variables.

Service catalog data lookup roles

Service catalog enables specific roles to participate in the process of creating and using service catalog data lookups.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>catalog_lookup_admin</td>
<td>Similar to data_lookup_admin. Can create, update, and delete catalog data lookup definitions, matcher variable definitions, and setter variable definitions.</td>
</tr>
<tr>
<td>catalog_lookup_manager</td>
<td>Can read catalog data lookup definitions, matcher variable definitions, and setter variable definitions. The role can be granted to anyone using catalog data lookups so they can see the definitions for which they are creating rules. As required, grant create, read, write, or delete access to the individual data lookup rules tables created to delegate maintenance.</td>
</tr>
</tbody>
</table>

Create a catalog lookup definition

You can create a catalog data lookup definition record.

**Note:** The Run on Insert and Run on Update options are not supported for catalog data lookups. Other options operate the same as for normal data lookup.

2. Click New.
3. Select Catalog Data Lookup Rule.
4. Enter a Name.
5. In Applies to, select catalog item or variable set.
6. In Catalog item/Variable set, select a specific item or set.
7. Select a Matcher Table.
8. Select other options, as required.
9. Right-click the form header and click Save.
10. From the Catalog Matcher Variable Definitions related list, click New.
11. In Source Variable name, select the variable name of the item or variable set that contains the values to be matched.
12. In Matcher table field, select the field from the matcher table that contains the value to be matched.
13. Fill in the other fields, as appropriate.

For example:

14. Click Submit.
15. From the Catalog Setter Variable Definitions related list, click New.
16. In Source Variable name, select the variable name for the item or variable set to be updated.
17. In Matcher table field, select the field from the matcher table that contains the value to be set.
18. Fill in the other fields as appropriate.
19. Click Submit.
20. Click Update.

For example:
Table 195: catalog data lookup definitions fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name to identify the definition record.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select what the data lookup rule should apply to: a catalog item or a variable set.</td>
</tr>
<tr>
<td>Catalog item/Variable Set</td>
<td>Select the catalog item or variable set to which the data lookup rule should apply.</td>
</tr>
<tr>
<td>Matcher Table</td>
<td>Select the table containing the lookup values. This table normally begins with a u_ prefix.</td>
</tr>
</tbody>
</table>

*Note:* The list shows only tables and database views that are in the same scope as the catalog data lookup definition.

<table>
<thead>
<tr>
<th>Active</th>
<th>Select this check box to run this catalog data lookup rule. Clear the check box to ignore this catalog data lookup rule.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on form change</td>
<td>Select this check box to automatically look up values whenever a user changes a variable value on a catalog item or form. This is the only supported method for catalog data lookup rules.</td>
</tr>
</tbody>
</table>

*Note:* This does not include changes automatically made by other data lookup rules, such as the priority lookup rules.

Setter variable definition fields

The setter fields determine what variable the data lookup changes when the matching conditions are true.

Table 196: Setter variable definition fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Lookup</td>
<td>Displays the name of the parent data lookup definitions record.</td>
</tr>
<tr>
<td>Source variable field</td>
<td>Select the variable from the source item or variable set that the data lookup updates.</td>
</tr>
<tr>
<td>Matcher table field</td>
<td>Select the field from the matcher table that provides the new value for the update.</td>
</tr>
<tr>
<td>Always replace</td>
<td>Select this check box to replace any existing value with a value from the data lookup. Clear this check box to ignore the update if the field has an existing value.</td>
</tr>
</tbody>
</table>
The columns of a data lookup table contain both matcher and setter field data.

Each data lookup is a query that searches for a row containing values that match the matcher fields. The data lookup then returns the value listed in the setter fields.

For example, you can define the matching settings for bronze, silver, and gold offerings as described previously.

To add values to the lookup table:

1. In the navigation filter, enter the name of the new custom lookup table.
2. Configure the list and create appropriate fields for the lookup table.
3. From the table list, click **New** and enter appropriate matcher and setter field values. For example:

   ![Server Offering Lookups](image)

   ![Server Offering Lookups](image)

   **Note:** Each row in a data lookup table must be unique.

Custom data lookup

You can create a custom table to store lookup data. The custom table must extend the Data Lookup Matcher Rules [dl_matcher] table.

For example, you can create a Server Offering Lookups table to store information about matcher offerings (bronze, silver, and gold) and associated setter values (memory and disk space) for each matcher offering.

Create a custom data lookup

Creating a new catalog data lookup is similar to creating a normal, custom data lookup except when creating the catalog data lookup definition record.

2. Add data lookup values to the data lookup table.
3. Create a catalog data lookup definition record.
4. (Optional) Create a data lookup module.

Troubleshooting Service Catalog data lookup

If the custom data lookup definition rules are not behaving as expected, check for the following conditions:

- Ensure that the matcher variable is not read-only. Since users cannot change read-only variables, there cannot be an on form change event for read-only variables.
- Ensure that the data in the matcher table is correct.
- If the lookup requires an exact match, verify that there is a matcher table row for each possible combination (including blank values). The lookup fails if cannot find a matching value.
- If the variable is an option or check box, it always has a value, so you must select **Always replace**.
- Verify that you have not created a recursive rule, such as:
If Variable A = 1, then Variable B = 2. If Variable B = 2, then Variable A = 2.

Audit service catalog variables

The audit history records all changes to named service catalog variables. Auditing is enabled by default for service catalog variables.

These changes are displayed in:

- The requested item history for all variables associated with the item.
- The catalog task history for all variables that would normally be used by the task.

This auditing allows service catalog administrators to view a full history of changes to variables that may have affected the parent record, including their creation.

**Note:** Unnamed variables are not audited

Enabling Auditing

To enable auditing:

1. Navigate to System Properties > Service Catalog.
2. Locate the line Audit changes to Service Catalog Variables.
3. Select the Yes check box to enable auditing.

Service catalog variable sets

Administrators and catalog administrators often define multiple catalog items that use the same group of service catalog variables.

For example, a catalog administrator defines ten catalog items for types of servers, and the request process for all of these items asks the same five questions, using the same variables.

Associating these variables individually per catalog item is repetitive, time-consuming and error-prone. Also, to make a single change to multiple catalog items involves manually changing each item. For example, to add a new variable to ten catalog items, you would need to manually associate this new variable with each item.

Variable sets allow you to group variables together, and share this group between multiple catalog items and order guides. Changes made to a variable set affect all items that use the variable set, allowing you to change the set once, then apply the changes to all items using that set.

**Note:** Variables in a set use the same rules as other variables to determine when the variables in a set appear on a task. For example, variables must either be global or be attached directly to an item. A note indicates neutral or positive information that emphasizes or supplements important points of the main text. A note supplies information that may apply only in special cases. Examples are memory limitations, equipment configurations, or details that apply to specific versions of a program.

Create a variable set

Service catalog allows you to define a set of variables to be stored as a variable set for future use.

To create a variable set:

1. Navigate to Service Catalog > Catalog Variables > Variable Sets.
2. Click New.
3. Enter details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The variable set name.</td>
</tr>
<tr>
<td>Order</td>
<td>The order number. See <a href="#">Define variable set order</a>.</td>
</tr>
<tr>
<td>Display title</td>
<td>A check box to give the variable set its own <em>title and header bar</em>, with collapse and expand buttons on the right.</td>
</tr>
<tr>
<td>Title</td>
<td>The variable set title. Appears if the <strong>Display title</strong> check box is selected.</td>
</tr>
<tr>
<td>Layout</td>
<td>The layout display. Set to <strong>1 Column Wide</strong> or <strong>2 Columns Wide, alternating sides</strong> or <strong>2 Columns Wide, one side, then the other</strong>.</td>
</tr>
</tbody>
</table>

4. Right-click and select **Save**.

5. Create the variables to use in that set.
   1. In the **Variables** related list, click **New**.
   2. Follow the steps for **creating variables**.

6. Click **Submit** to save the record.

*Add a title and header bar*

Variable sets can display an optional title, along with a section header bar to collapse and expand the section.

To give the variable set a title and header bar:

   Within a variable set record, select **Display Title**.
Note: When a user requests the item, all check box variables are grouped together under a default title of Options. To use a custom title, insert a variable of type Label, with an Order value that puts it directly above the check box variables.
Define variable set layout

Variable sets can have one of many layouts.

- **1 column wide**: Variables appear in a single vertical column, ordered from top to bottom. This is a simple way to display information, but can result in empty space to the right of questions. This is the default layout.
- **2 columns wide, alternating sides**: Variables are laid out in two columns with variables placed alternately in the left and right columns.
- **2 columns wide, one side, then the other**: The first half of the variable set is laid out sequentially in the left column and the second half is laid out sequentially in the right column.

**Note:** Variables with several possible choices defined, such as *multiple choice* variables, are considered a single entity in layouts. All choices are displayed as a single, contiguous unit.

For additional layout options, you can also add *container variables* to a variable set.

For example, create the following variables and orders:

<table>
<thead>
<tr>
<th>Table 197: Variables and orders</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable</strong></td>
</tr>
<tr>
<td>Alfa</td>
</tr>
<tr>
<td>Bravo</td>
</tr>
<tr>
<td>Charlie</td>
</tr>
<tr>
<td>Delta</td>
</tr>
<tr>
<td>Echo</td>
</tr>
<tr>
<td>Foxtrot</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 198: Layouts for variables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1 Column Wide</strong></td>
</tr>
<tr>
<td>Alfa</td>
</tr>
<tr>
<td>Bravo</td>
</tr>
<tr>
<td>Charlie</td>
</tr>
<tr>
<td>Delta</td>
</tr>
<tr>
<td>Echo</td>
</tr>
<tr>
<td>Foxtrot</td>
</tr>
</tbody>
</table>

**Define variable set order**

A variable set is a discrete unit with an order number by default.

All variables within the set are included wherever the set is included.
For example, if you set the following order for some example variables and a variable set:

- Variable A (100)
- Variable B (200)
- Variable C (300)
- Variable Set 1 (250) - containing three variables (VS1, VS2, VS3) with incremental order values (150, 250, 350)

The variables are displayed in this order:

- Variable A (100)
- Variable B (200)
- Variable Set 1 (250): Variable VS1 (150)
- Variable Set 1 (250): Variable VS2 (250)
- Variable Set 1 (250): Variable VS3 (350)
- Variable C (300)

Set an item specific order

You can set the order value on a per item basis.

When a variable set is used by more than one catalog item, you can define item-specific ordering to provide more flexibility in the layout, using the catalog variable set record associated with the item.

Use the Order field in this catalog variable set record to set this order value on a per-item basis, overriding the default value defined in the variable set.

To view and edit the catalog variable set order for an item:

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Open the catalog item to edit.
3. Navigate to the Variable Sets related list
4. Click the reference icon for the variable set.
5. Set the order value as required.
As the catalog variable set order is specific to the link between the item and the variable set, it overrides the default order defined on the variable set itself:

*Set orders flexibly examples*

The following example demonstrates the layout of variables when variable sets and item variables are associated with an item under different scenarios.

The order for display of the variables and variable sets is specified using the Information icon in the Related Lists.
- In Layout 1, order values are specified for both Variable Set A and Variable Set B at the Related Lists level and those order values always take precedence. Hence, the layout is organized based on the order value specified for the variable sets at the Related Lists level.
- In Layout 2, an order value is not specified for Variable Set A whereas an order value is specified for Variable Set B at the Related Lists level. In this case, the empty value for Variable Set A is considered as zero. Hence, the layout is organized based on the order value of 0 for Variable Set A and 300 for Variable Set B.
In Layout 3, order values are not specified for both Variable Set A and Variable Set B at the Related Lists level. In this case, the order values specified within the variable sets are considered. Hence, the layout is organized based on the order value of 400 for Variable Set A and 150 for Variable Set B.

Add a variable set to a catalog item

Service catalog enables you to add a variable set to one or more catalog items.

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Open a catalog item.
3. In the Variable Sets related list, click Edit.
   You may need to configure the form to add the Variable Sets related list.
4. Select and add a variable set.
5. Click Save.

Set security for items and categories

Administrators can control access to content in the service catalog by creating and applying user criteria records.

Catalog managers and catalog editors can apply existing user criteria for items and categories to which they are assigned. However, catalog managers and catalog editors cannot create or edit user criteria directly.

You can create user criteria records that define conditions for user information. Then apply these criteria records to catalog items and categories, controlling access to these items and categories.

For example, create a USA Sales user criteria record matching users who are both in the sales team and based in the USA. Then apply this record to the USA IT Hardware catalog category, so only users matching the record can access that category.

The feature is active by default in new Fuji instances and upgraded instances that do not use entitlement-based access controls. If you upgrade an instance that uses entitlements, you can migrate to user criteria to take advantage of the improved control, flexibility, and reuse.

Access controls allow you to:

- Manage access to multiple items and categories in one user criteria record. For example, create a single UK Employees user criteria record and apply it to multiple items and categories that are available to employees in the UK.
- Allow access if one condition matches, or if all conditions match. For example, define that only users who are both in a specific location and who belong to a specific department can have access.
- Use Available For and Not Available For lists to allow or prohibit access to users matching the conditions in a criteria record. For example, specify that a US-based catalog category is available for the users located in the USA but is not available for users belonging to the Sales department (whether in the US or not).
- Extend matching to create conditions matching additional fields in the User [sys_user] table, without having to use a script. For example, you can add a condition to match items against the Cost center field in user records.

**Note:** For changes in User [sys_user] table records to be effective, you should log out and log in.

Create a user criteria record

User criteria records define conditions that are evaluated against user records.
You can apply several user criteria records to a single catalog item or category. In this situation, users need to match only one of these criteria records to have access.

**Note:** When a change is made to the end user profile such as their location so that it affects their ability to view items, then those changes will not take effect till the end user has relaunched their session.

1. Navigate to **Service Catalog > Catalog Definition > User Criteria** and create a record.

2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the criteria record.</td>
</tr>
<tr>
<td>Users</td>
<td>The individual user records to match.</td>
</tr>
<tr>
<td>Groups</td>
<td>The group records to match.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles to match.</td>
</tr>
<tr>
<td>Advanced</td>
<td>A check box to display or hide the <strong>Script</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Script</td>
<td>A <em>script</em> to define any additional criteria, and return <em>true</em> or <em>false</em>. This field is available only if <em>Advanced</em> is selected. <strong>Note:</strong> Because scripts are evaluated dynamically, including scripts in user criteria records can decrease performance.</td>
</tr>
<tr>
<td>Check box</td>
<td>For check boxes, describe the selected condition. For example: &quot;Check box for enabling the feature&quot; or &quot;Select the check box to enable the feature.&quot; Describe the cleared condition only when it is not obvious.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to activate or deactivate this criteria record.</td>
</tr>
<tr>
<td>Companies</td>
<td>The companies to match.</td>
</tr>
<tr>
<td>Locations</td>
<td>The locations to match.</td>
</tr>
<tr>
<td>Departments</td>
<td>The departments to match.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Match All | A check box to determine whether all elements from each populated criteria field must match. If selected, only users who match all criteria are given access. If cleared, the user must meet one or more of the set criteria to be given access. By default, this check box is cleared so that any condition met provides a match. For example, consider a user criteria record for the following:
- Locations A or B
- Company C or D
With Match All selected, only users meeting all of these conditions are matched. For example, a user with a location A and a company C.
With Match All cleared, users meeting any of these conditions are matched. For example, a user with a location B.

**Note:** If you select Match All, ensure that you do not create contradictory conditions which can never be met. For example, if all users in location A work for company G, then the conditions in this example can never be met.

---

### Apply user criteria to items

Service catalog enables you to apply user criteria to an item, defining which users can and cannot access that item.

You can apply user criteria to all types of catalog item, including order guides, content items, and record producers.

**Note:** The user criteria restriction applies only within Service Catalog for the specific item it is applied for. However, the user criteria restriction is not applied outside the Service Catalog where the user has access to the item via the table.

To apply user criteria to an item:

1. In an item record, navigate to the **Available For** or **Not Available For** related lists.
2. Click **Edit** to add an existing user criteria record, or click **New** to create a new one.
3. Save the record to associate the user criteria record with the item.

**Note:**
The **Not Available For** settings override **Available For** settings. A user on the **Not Available For** list for an item cannot access that item, even if that user is also on the **Available For** list for that item.

---

**Apply user criteria to categories**

You can apply user criteria to a category, defining which users can and cannot access that category.

1. In a category record, navigate to the **Available For** or **Not Available For** related lists.
2. Click **Edit** to add an existing user criteria record, or click **New** to create a new one.
3. Save the record to associate the user criteria record with the category.

**Note:**
- The **Not Available For** settings override **Available For** settings. A user on the **Not Available For** list for a category cannot access that category, even if that user is also on the **Available For** list for that category.
- The user criteria restrictions of a category do not automatically apply to the catalog items within the category. If required, you should apply the user criteria restrictions to the individual catalog items.

---

**Apply user criteria to items and categories**

You can apply a user criteria record to items and categories, either from the item or category form or from the user criteria form.

**Note:** The user criteria restriction applies only within Service Catalog for the specific item it is applied for. However, the user criteria restriction is not applied outside the Service Catalog where the user has access to the item via the table.

To apply criteria directly to an item or category, use the **Available For** or **Not Available For** related lists in the Item or Category form.

**Note:**
- When a change is made to the end-user profile, such as location, and it affects their ability to view items, those changes do not take effect until the end user has relaunched the session.
- The user criteria restrictions of a category do not automatically apply to the catalog items within the category. If required, you should apply the user criteria restrictions to the individual catalog items.

To apply criteria directly from the User Criteria form, add items to the **Available For Catalog Items** and **Not Available For Catalog Items** related lists, and add categories to the **Available For Categories** and **Not Available For Categories** related lists. You may need to configure the User Criteria form to add these lists.

**Note:**
- The **Not Available For** settings override **Available For** settings. A user on the **Not Available For** list for an item cannot access that item, even if that user is also on the **Available For** list for that item.
Extend user criteria

Service catalog enables you to extend user criteria to match against additional reference fields in the User [sys_user] table, such as hidden or custom fields, without using a script.

You can then add a matching field in the User Criteria [user_criteria] table, allowing you to define conditions based on this field in user criteria records.

**Note:** The column on the User table must be a reference field, and the matching column on the User Criteria table must be a glide_list type field. Also, both columns must have matching names. Columns with a “U” prefix are catered for, so, for example, “cost_center” and “u_cost_center” are considered as matching.

1. Navigate to **System Definition > Tables**.
2. Locate and open the **User Criteria** record.
3. In the **Columns** section, insert a row for the new field.
4. Set the type to **List** and select the appropriate reference field. For example, select `cmn_cost_center` to set criteria based on cost centers.
   
   You have a step with a list, note, and image.
5. Navigate to **Service Catalog > Catalog Definition > User Criteria**.
6. Select or create a new user criteria record, and see that you can now use the new field.

You can further extend the User Criteria table to match against any columns in other tables. In the User [sys_user] table, add a new reference field to the other table, then extend the user criteria table to refer to that reference field, as described above.

Implement user criteria best practice

When creating user criteria for your system, consider the following good practice recommendations.

- **Design Criteria for Reuse:**
  
  Ensure that you design user criteria for maximum reuse. Create user criteria records with common sets of conditions matching your organization's requirements. Allow them to be shared across as many items and categories as possible, rather than creating multiple similar criteria records for individual items and categories.

- **Naming conventions:** Give each user criteria record a meaningful name, to help you determine the function for that record. For example,
  
  - Users in company Cloud Dimensions AND in London
  - Users in company Cloud Dimensions OR in London
  - Users belonging to the Group Development, IT, or Sales
  - Users with role itil, asset_manager, or catalog_admin

- **Test user criteria on a non-production instance:** Consider testing user criteria on a development or test instance, and then transferring the records from the user criteria tables and catalog records to your production instance using update sets.

User criteria migration

Service catalog user criteria records provide access control for service catalog items and categories.

You may need to migrate your access controls to use user criteria. The user criteria feature is automatically enabled for new instances. If you upgrade your instance, a script runs to determine current access control usage.
• If your instance does not use *entitlement-based* access controls, the user criteria feature is automatically enabled.
• If your instance does use entitlements, the user criteria feature is not enabled. If you want to use user criteria, use the procedure described on this page to migrate your access controls from entitlements to user criteria.

Migrate to user criteria to provide more reuse, control, and flexibility compared to entitlements.

For example, you can use a single criteria record to make multiple catalog items available to only users who meet all these requirements:

- Are located in EMEA or APAC
- Belong to ACER
- Are in the Training department

*Migrate to service catalog user criteria*

Service catalog enables you to maintain the required access controls to your service catalog while migrating from entitlements to user criteria.

To maintain the required access controls to your service catalog while migrating from entitlements to user criteria:

1. Navigate to Service Catalog > Catalog Policy > Properties and verify that the user criteria feature is not already enabled on your system.
   - If the property *Use "User Criteria" to define access to catalog items and categories* (glide.sc.use_user_criteria) is set to **true**, you can skip the following steps. The user criteria feature is automatically enabled because entitlements were not used in your old system.
   - If this property is set to **false**, continue with the following steps. The user criteria feature has not been enabled yet on your system.

2. To preview the user criteria feature, set the service catalog property *Enable both "User Criteria" and "Entitlement" related lists for catalog items and categories when migrating from entitlements* (glide.sc.user_criteria_migration) to **true**. This option lets you compare user criteria records and entitlements before you fully switch to user criteria.

3. Inspect your service catalog items and categories to identify access control sets that you can configure user criteria records for. Review your current entitlements and record your organization's current design for access controls. Focus on identifying patterns where multiple items have the same combination of location, group, and so on. Each combination is a possible access control set.

4. *Create a user criteria record* for each access control set that you identified from your inspection of the service catalog.

You have a step with a list, note, and image.

5. *Apply these user criteria records* to the items and categories identified, replacing the equivalent entitlements.

6. Enable user criteria on your system by setting the service catalog property *Use "User Criteria" to define access to catalog items and categories* (glide.sc.use_user_criteria) to **true**. When this property is set to **true**, any remaining entitlements are no longer used.

   **Note:** Scripts in user criteria cannot reference the category or catalog item as current as entitlement scripts do. For scripts in user criteria, use the user_id available for the user currently being evaluated against the category or catalog item.

*Data structure differences*

There are significant data structure differences between entitlements and user criteria, which you must be aware of while migrating.
Using entitlements, the following tables are loaded into memory and evaluated before rendering.

For catalog items:

**Figure 91: Entitlements Data Structure - Catalog Items**

For categories:

**Figure 92: Entitlements Data Structure - Categories**

The user criteria architecture collects all user attributes in the User Criteria [user_criteria] table.

User criteria records can link to items and categories, as follows.

For catalog items:

- Catalog Item Available for [sc_cat_item_user_criteria_mtom]
- Catalog Item Not Available for [sc_cat_item_user_criteria_no_mtom]
Figure 93: User Criteria Data Structure - Catalog Items

For categories:
- Category Available for [sc_category_user_criteria_mtom]
- Category Not Available for [sc_category_user_criteria_no_mtom]

Figure 94: User Criteria Data Structure - Categories

Set security for a variable
Apply role-based restrictions to a catalog variable to control which users can create, write (update), read, and delete a value for the variable.

To apply role-based restrictions to a catalog variable:
1. Click the lock icon next to each field.
2. Select the roles that should have the associated access.

This example shows that, for the the CPU Speed variable used by the Executive Desktop catalog item, only users with the itil role can write (update) or create a value for that variable.
Note: You might need to configure the variable form to add the Create roles, Read roles, Update roles, and Write roles fields.

Legacy service catalog access controls

Service catalog supports several ways to control access to a catalog item or category; this is also known as catalog entitlements.

A service catalog item with no specific access controls is available to all users. If access controls are specified, only users who meet all conditions have access.

The following entitlements are available:

- **Role**
- **Custom script**
- **Company, Department, Group, User, or Location**

Access controls are checked in the following order: roles, then scripts, then Company, Department, Group, User, or Location.
Note: The functionality described here is superseded by access controls using user criteria. Migrate to user criteria for a more flexible and re-usable way to define access controls.

Service catalog administration
Service catalog enables an administrator to configure the service catalog.

To restrict items and categories by company and department:

1. Navigate to Service Catalog > Maintain Items or Service Catalog > Maintain Categories.
2. Open an item or category, and then configure the related lists in the form to add Available for Department and Available for Company.
3. Click Update to save the form layout.
4. Open the item or category you wish to secure and add companies and departments to related lists.

   The item or category is available only for the companies and departments listed. If no companies or departments are listed, then the item or category is available to all companies or departments.

Restrict access
Service catalog enables an administrator to grant or deny access to a service catalog item or category by company, department, group, user, or location.

1. Navigate to Service Catalog > Maintain Items or Service Catalog > Maintain Categories.
2. Open the relevant catalog item or category.
3. Personalize the form to add the appropriate Available or Not available lists.

4. Add the companies, departments, groups, users, or locations to the appropriate list.
5. Click Update.

Restrict access by role
By default, individual catalog items and categories do not have access restrictions.

Administrators can grant or deny access to a service catalog item or category based on role.

1. Navigate to Service Catalog > Maintain Items or Service Catalog > Maintain Categories.
2. Open the relevant catalog item or category.
3. Add the required roles to the Roles field.

   You may need to personalize the form or change to Default View to see the Roles field.
Restrict access by a script
Service catalog enables you to control access to a service catalog item or category with a custom script.

1. Navigate to Service Catalog > Maintain Items or Service Catalog > Maintain Categories.
2. Open the relevant catalog item or category.
3. Configure the form to add the Entitlement script field.

4. In the Entitlement script field, enter the access control script.

Sample Scripts

The following example script grants access to a catalog item named French Blackberry to users with a language of Fr (French):

```plaintext
gs.log ( 'Running Entitlement script for French Blackberry' ) ;
```
The following example script could be used to distinguish between two categories of users (one with full access and one with restricted access) on the catalog of services:

```javascript
if (gs.getUser().getLanguage() == 'fr')
    answer = true;
else
    answer = false;
answer;
```

Overriding Entitlement Scripts by Role

1. Navigate to **Service Catalog > Properties**.
2. Enter the roles for which to override the entitlement script (grant access) in the property List of roles (comma-separated) that can override normal entitlement checking inside the catalog. A role of "itil" means that the itil role can order any catalog item, even one protected by entitlement restrictions.

Service Catalog customization

Service Catalog enables you to customize the catalog in various ways.

Maintain cart layout

Service catalog enables you to configure the layout and functionality of the service catalog cart used in your organization to place requests for catalog items.

You can:

Role required: admin

- Remove components. For example, hide prices throughout the cart if your catalog does not use pricing.
- Change labels. For example, change the **Order now** button label to **Request Item** in the shopping cart.
- Change the order of elements. For example, change the order of the columns on the order status screen.
- Configure, hide, or create functionality. For example, add a **Requested For** reference field to the shopping cart.

Configure cart layout

Configure cart layout records to define functionality for widgets or screens in the shopping cart.

To configure cart layout:

1. Navigate to **Service Catalog > Catalog Definition > Maintain Cart Layouts**.
2. Select a widget or screen:
• **Cart widgets:** Item Ordering Widget, Shopping Cart Widget, or Item Ordering Widget (Order Guide)

• **Shopping cart screens:** Cart Preview Screen, Cart Preview Screen (Two Step), or Cart Preview Screen (Mobile)

• **Order status screens:** Order Status Screen or Order Status Screen (Mobile)

3. Update the **Title** field to change the title that appears on the widget.

4. Leave the default **Target** value. Do not change this value because it identifies the cart element being defined.

5. Update the other sections of the cart layout record, as required. The availability of these sections varies for each widget and screen record.
- In the **Components** section, select the components to display, such as delivery times, item descriptions, and prices.
- In the **Columns** section, select which columns to display, such as the item description column, delivery time column, or price column.
- In the **Buttons** section, select the buttons to display, such as **Add to Cart**, **Edit Cart**, and **Delete Item**.
- In the **Button Labels** section, enter new labels to replace the default button labels.
A new label is used on all screens that the button appears on. For example, the **Continue Shopping** button is used on several screens, so changing its label affects all those screens.

6. If required, *configure the widget and column macros*.

7. Save the record, and then test the results of your configuration by ordering items from your service catalog.

   Some settings and properties in your instance may override or affect your cart layout. See *Overriding Cart Layouts for Items* for more details.

---

**Configure widget and column macros**

Service catalog enables you to configure macros that define functionality for elements within each widget or screen.

Some widgets or screens also have column macros that define the horizontal layout and configuration of shopping cart contents.

You can configure these macros to alter the display order of elements, or hide elements, within the widget or screen. You can also *create new macros* to implement any extra requirements.

1. Navigate to **Widget Macros > Column Macros** related list.
2. Click the order number entry of a macro to edit its display order, or to activate or deactivate it.
3. Click Update.
4. Click the Widget / View Macro entry of a macro to view its functionality settings. You cannot edit functionality settings for default macros, but these settings can be a useful reference for creating your own widget macros.

Create macros for cart layout
Service catalog enables you to create macros for cart layout records using Jelly scripts to define customized behavior and display within a widget or screen.

Macros that you create do not affect upgrades because customized widget functionality is isolated from general cart behavior.

To create a new macro:
1. Open the relevant cart layout record.
2. Navigate to Widget Macros or Column Macro related list.
3. Click New.
4. Enter details for the macro.

Table 200: Macro form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name for the new macro.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate whether the macro is displayed or not.</td>
</tr>
<tr>
<td>Description</td>
<td>A summary of how the macro is used.</td>
</tr>
<tr>
<td>Active</td>
<td>A check box to indicate whether the macro is displayed or not.</td>
</tr>
<tr>
<td>XML</td>
<td>The Jelly script to apply for your macro.</td>
</tr>
</tbody>
</table>

5. Save the macro record.
This example demonstrates the script to add a Requested for reference field as a widget macro to a cart layout record.

```xml
<?xml version="1.0" encoding="utf-8" ?>
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide"
xmlns:j2="null" xmlns:g2="null">
    <j:set var="ref" value="sc_cart" />
    <j:set var="jvar_ref" value="${jvar_cart.getRequestedFor()}">
    <j:set var="jvar_ref_display" value="${jvar_cart.getRequestedForDisplayName()}">
    <tr>
        <td colspan="3">
            ${gs.getMessage('Requested for')}: 
        </td>
    </tr>
    <tr>
        <td colspan="3" style="padding: 4px;"> 
            <g:catalog_requested_for />
        </td>
    </tr>
</j:jelly>
```

Configure cart layout for specific items

Service catalog enables you to set fields in the Catalog Item form to configure the cart layout for specific items.

This overrides any general cart layout settings. For example, you can hide an item's price by setting the Omit price in cart field to true for that item.

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Select the catalog item.
3. Configure the form to add both Use cart layout and any of the following item configuration fields you require:
   - Omit price in cart
   - No cart
   - No order
   - No order now
   - No proceed checkout
   - No quantity
4. Clear the Use cart layout check box to display the configuration fields for that item.
5. Set the item configuration field values as required.
6. Click Update.

Override cart layouts for items
Service catalog enables you to use additional methods to configure cart behavior or layouts, which override cart layout record settings.

For example, your cart layout record settings might hide item prices, but you may decide to display the price of the Sales Laptop. In that case, you would set the relevant configuration values on that catalog item. Be aware of the impact of these additional methods, to ensure your cart behaves in the way you want.

Note:
If you are migrating to cart layouts, you may have defined additional settings and properties that impact your cart layout settings.

Configure order guide widgets
You can customize the widget that provides details of the current catalog item on an order guide or wizard.

Role required: admin, catalog_admin

Order guide cart widget is visible when an order guide item is ordered.

1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Item Ordering Widget (Order Guide) record.
3. You can add and remove components and rename widget title.
4. Click Update.
Configure catalog item widgets

You can customize widgets that appear for catalog items.

Role required: admin, catalog_admin

Both shopping cart and item ordering widgets are visible on the standard catalog page and any ESS catalog page. The shopping cart widget is also available in additional locations, such as the catalog homepage.

1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
   a) Open the Item Ordering Widget record to modify the widget for ordering item.

**Note:** By default, order guides use a two-step process, and catalog items use a one-step checkout process. If you configure the checkout process, keep in mind that order guides and catalog items will provide different cart experiences if they use different checkout processes.
b) Open the **Shopping Cart Widget** record to modify the widget for shopping cart.

2. You can add/remove components, buttons, rename widget title and button labels.

3. Click **Update**.
Macbook Pro

The Apple Macbook Pro model, with a Retina display, fights glare and provides excellent performance for computing tasks.

Technical Specs:
- Intel core i7 processor
- 512GB SSD storage
- Intel Iris Plus Graphics 650
- Backlit keyboard

Adobe Acrobat

Optional Software
- Adobe Photoshop
- Eclipse IDE

Additional software requirements

Figure 96: Item ordering and shopping cart widgets
Configure desktop order status screen

Service catalog allows you to customize the order status screen that is displayed on desktops.

Role required: admin, catalog_admin

To configure the order status screen that displays on desktops:

1. Navigate to **Service Catalog > Catalog Definitions > Maintain Cart Layouts.**
2. Open the **Order Status Screen** record.
3. You can add/remove components, columns, buttons, and rename labels. See *Configure cart layout.*
4. Click **Update.**
Order Status

Thank you, your request has been submitted

Order Placed: 2016-08-01 02:58:42
Request Number: REQ0010004
Estimated Delivery Date of Complete Order: 2016-08-03

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Delivery Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>RITM0010009</td>
<td>Apple iPad 3</td>
<td>2016-08-03</td>
</tr>
</tbody>
</table>

Back to Catalog  Continue Shopping  Cancel Request

Copy this Request for:

[Blank lines]
Configure mobile order status screen

Service catalog allows you to customize the order status screen that is displayed on mobile devices.

Role required: admin, catalog_admin

You cannot modify widget macros or button labels on mobile devices.

1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Order Status Screen (Mobile) record.
3. You can add and remove components and buttons.
4. Click Update.

Figure 98: Order status screen on mobile

Configure mobile shopping cart screen

Service catalog allows you to customize the shopping cart screen that is displayed on mobile devices.

Role required: admin, catalog_admin

© 2017 ServiceNow. All rights reserved.
The shopping cart on mobile devices always uses a two-step checkout process. You cannot modify widget macros or button labels on mobile devices.

1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Cart Preview Screen (Mobile) record.
3. You can add and remove components and buttons.
4. Click Update.

Configure one-step shopping cart screen

Service catalog allows you to customize the shopping cart display screen for a one-step checkout process.

Role required: admin, catalog_admin

One-step checkout is the default checkout process for catalog items.

1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Cart Preview Screen record.
3. You can add and remove components, columns, buttons, and rename title and button labels. See Configure cart layout.

4. Click Update.

Figure 100: Shopping cart screen displayed for default one-step checkout process

Configure two-step shopping cart screen

Service catalog allows you to customize the shopping cart display screen for a two-step checkout process.

Role required: admin, catalog_admin

Changes made to the two-step record are visible only if the two-step checkout process is enabled in properties. By default, catalog items use a one-step checkout process.

1. Navigate to Service Catalog > Catalog Definitions > Maintain Cart Layouts.
2. Open the Cart Preview Screen (Two Step) record.
3. You can add/remove components, columns, buttons, and rename title and button labels. See Configure cart layout.
4. Click Update.
Figure 101: Shopping cart screen displayed for a two-step checkout process
Cart layout considerations

Some of these properties are impacted when you use cart layouts. For example, with the order status screen, the **When to show prices and sub-totals on the Service Catalog Cart** (glide.sc.price.display) property overrides cart layout settings for displaying prices.

Consider the possible outcomes with service catalog properties that will be impacted when you enable cart layouts, and then alter the settings or properties to achieve the cart layout and functionality you require.

### Table 201: Table title

<table>
<thead>
<tr>
<th>Property</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow ESS users the option to cancel their requests from the checkout screen. [glide.sc.checkout.cancel]</td>
<td>Overridden when the <strong>Cancel Request</strong> check box in cart layout settings is selected. If this check box is selected, the <strong>Cancel</strong> button is displayed even if the property is set to <strong>No</strong>.</td>
</tr>
<tr>
<td>Enable cloning requests during checkout. [glide.sc.allow.checkout.clone]</td>
<td>Not used (deprecated) if cart layouts are enabled. It is replaced by the <strong>Clone Checkout</strong> check box in cart layout settings. The <strong>Clone Checkout</strong> check box is cleared by default for new instances. For upgraded instances, the check box is set to the existing value of the glide.sc.allow.checkout.clone property.</td>
</tr>
<tr>
<td>List of roles (comma-separated) that can use the quantity selector in the shopping cart [glide.sc.allow.quantity]</td>
<td>Overrides any relevant cart layout settings.</td>
</tr>
<tr>
<td>Show the request item number for each line item on the checkout screen (default false). [glide.sc.checkout.request.number]</td>
<td>Not used (deprecated) if cart layouts are enabled. It is replaced by the <strong>Request Item Number column</strong> check box in cart layout settings.</td>
</tr>
<tr>
<td>Show the 'Back to Catalog' button on the two step checkout screen. [glide.sc.checkout.twostep.back]</td>
<td>Not used (deprecated) if cart layouts are enabled. It is replaced by the <strong>Back to Catalog</strong> check box in cart layout settings.</td>
</tr>
<tr>
<td>When to show prices and sub-totals on the Service Catalog Cart. [glide.sc.price.display]</td>
<td>Overrides any relevant cart layout settings.</td>
</tr>
</tbody>
</table>

Migrate cart layouts

Service catalog enables you to configure cart layouts to add, remove, or change elements of the service catalog shopping cart.

**Role required: admin**

This feature is enabled by default and default cart layout settings implemented. For upgrades, an upgrade script checks to see if your current cart macros are customized.

- If cart macros are not customized, cart layout configuration is enabled by default.
• If cart macros are customized, cart layout configuration is disabled. You must migrate your system to use this feature.

Review cart layout configuration settings

Before you migrate your system to use cart layouts, familiarize yourself with existing configurations for catalog content and decide whether to discard or retain these configurations.

Check your current configurations for:
• UI macros defining custom shopping carts that have been linked to items.
• Service catalog properties that might be impacted by cart layouts.
• Item-specific settings that may override cart layout record settings.

Review item-specific cart layout settings

Some catalog items may have cart layout settings that are specific to them.

For example, these items might show prices even though the general cart layout record settings hides prices.

To retain item-specific settings, clear the Use cart layout check box in the catalog item form.

Figure 102: Item-specific settings

Note: You may need to configure the form to display the Use cart layout check box.
Migrate customized macros to cart layouts

If any of the following UI macros are customized, migrate the customizations to cart layout widgets before you enable cart layouts.

- sc_catalog_homepage_cart
- sc_catalog_requested_for
- catalog_item
- catalog_cart_default
- sc_cart_main

In addition, if you have customized the com.glideapp.servicecatalog_category_view UI page, or the Catalog Cart dynamic content, you must migrate these customizations before you enable cart layouts.

Move customizations to cart layouts

To move customizations to cart layout widgets:

1. Save copies of the customizations for later reference.
2. Revert the customizations to restore the customized macros or other content to their standard state.
4. Run the following script in Background Scripts to set the property and set the correct state for all the items in the catalog:

   ```javascript
   var cm = new CartLayoutMigration();
   cm.configureLayoutProperty();
   cm.setLayoutFalse();
   cm.setEmptyLayout();
   ```

5. Reimplement any cart layout customizations that you want to maintain in the upgraded instance by configuring widget macros.

Enable cart layouts

After you review configuration settings and migrate any customized macros, you can enable cart layouts.

To enable cart layouts:

- Set the Use the sc_layout driven cart macros glide.sc.use_cart_layouts service catalog system property to Yes to enable cart layouts for your system.

Legacy flexible checkout and delivery forms

ServiceNow includes several options that provide administrators some control over content in service catalog’s template-driven forms.

Some service catalog forms, such as the checkout form, are generated from templates, instead of being data-driven like other forms in the system, such as the Incident form.

Template-driven forms provide enhanced look-and-feel over standard data-driven forms, but they provide more limited control over the form content.

Note:

It is recommended that you use cart layout records to configure cart layouts. Using cart layout records lets you configure the service catalog cart without writing and maintaining scripts.
Modify the delivery screen

In the final checkout step, a summary screen provides a list of all items and services ordered.

⚠️ **Warning:** Modifying the Order Status or Summary screen requires advanced scripting and a knowledge of Jelly. Also, the upgrade process skips updates to the summary screen after a customization. With these constraints in mind, you can modify the summary screen by editing the `com.glideapp.servicecatalog_checkout_view` UI page.

![Image of Catalog order summary status]

**Figure 103: Catalog order summary status**

*Requester search results*

After you enable the two-step checkout process, the Requested for field appears on the Request form. The Requested for field references the User `[sys_user]` table and has an auto-complete feature. Two service catalog properties (Service Catalog > Catalog Policy > Properties) enable an administrator to add columns to the search results for this field and to order the list by one of the columns.
### Table 202: Service catalog properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional columns for the &quot;request for&quot; Service Catalog widget. (glide.sc.request_for.columns)</td>
<td>Choose fields from the User [sys_user] table. Must be semicolon separated.</td>
</tr>
<tr>
<td>Ordering of matches for the &quot;request for&quot; Service Catalog widget. (glide.sc.request_for.order_by)</td>
<td>Choose fields from the User [sys_user] table.</td>
</tr>
</tbody>
</table>

### Modify the checkout form

By default, the checkout forms list the Description, Delivery Date, Stage, Price, Quantity and Total columns. For example:

**Summary**

Your request number is **REQ10005**, which you can use to refer to this request in future interactions with the service desk.

You may also bookmark the following link to get back to **Request REQ10005**.

Note that clicking on the bookmark link (above) will simply take you back to this screen.

<table>
<thead>
<tr>
<th>Description</th>
<th>Delivery Date</th>
<th>Stage</th>
<th>Price (ea.)</th>
<th>Qty</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>A BlackBerry Wireless Device</td>
<td><strong>2007-04-08</strong></td>
<td>✔️</td>
<td>$500.00</td>
<td>1</td>
<td>$500.00</td>
</tr>
</tbody>
</table>

**Delivery Information**

Estimated Delivery Date of Complete Order: **2007-04-08**

---

**Figure 104: Checkout default**

Administrators can use specific control options, to modify the checkout form to:

- Use an alternate description field
- Add the request item number for each line

**Add the request item number**

By default, the request item number is not displayed in the list.

To display this number as an additional column:

1. Navigate to **Service Catalog > Catalog Policy > Properties**.
2. Locate the property: Show the request item number for each line item on the checkout screen (default false).
3. Select the **Yes** check box to add the number column to the checkout form.
**Use an alternate description field**

By default, the `short_description` column of the catalog item appears as the item description.

1. Navigate to **Service Catalog > Catalog Policy > Properties**.
2. Locate the property **Field name to use for the description column of the checkout form**. If blank, the default (`short_description`) is used.
3. Enter the name of the alternative field (a column in the Catalog Item `{sc_cat_item}` table) and save it. For example, if you selected **name**:

**Define item quantity**

In the Service Catalog, the default quantity choices are 1 to 5.

Administrators can configure the quantity selector with additional choices.

---

**Summary**

Your request number is **REQ10005**, which you can use to refer to this request in future interactions with the service desk.

[102x485]You may also bookmark the following link to get back to **Request REQ10005**.

Note that clicking on the bookmark link (above) will simply take you back to this screen.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Delivery Date</th>
<th>Stage</th>
<th>Price (ea.)</th>
<th>Qty</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>BTN10005</td>
<td>Blackberry</td>
<td>2007-04-08</td>
<td>✔️ ✔️ ✔️ ✔️ ✔️</td>
<td>$500.00</td>
<td>1</td>
<td>$500.00</td>
</tr>
</tbody>
</table>

**Total:** $500.00

**Delivery Information**

Estimated Delivery Date of Complete Order: **2007-04-08**

---

[© 2017 ServiceNow. All rights reserved.]
To configure the quantity selector:

1. Navigate to **System Definition > Choice Lists**.
2. Search for the table `sc_cart_item` and the element quantity. The existing quantity choices appear.
3. Add quantity choices, modeling them after the existing ones.

**Note:** To reduce the quantities available for catalog items, delete the relevant quantity records. For example, to reduce the quantity range to 1-3, delete the records for 4 and 5.

To restrict the roles allowed to change quantities, edit the **List of roles (comma-separated) that can use the quantity selector in the shopping cart** (glide.sc.allow.quantity) service catalog property. For example, you might limit this ability to the admin and catalog admin roles.

---

**Remove item restrictions**

Service catalog enables you to remove or apply restrictions on all order guides, record producers, and wizard launchers.

Catalog administrators can use service catalog properties to configure the behavior and usage of a catalog item.

By default, all order guides, record producers, and wizard launchers have these restrictions:

- They cannot be added to a requested item
- They do not provide a Try It action
- They are not added to the cart as items

To remove these restrictions or apply these restrictions to other types of items:

Modify the comma-separated lists of tables in the following properties:

- **List of class names for catalog items that cannot be added to an existing request** (glide.sc.item.cannot_add_to_request): restricts the items that can be added to a requested item, after an end user places a request. For example, to restrict content items from being added to an existing request, add `sc_cat_item_content` to the list for this property.

- **List of class names for catalog items that do not use the default "Try It" UI Action** (glide.sc.item.cannot_try_it): restricts the items which allow you to click Try It on the item form to preview how it appears in the service catalog. Items with such restrictions do not display Try It on the form.

- **List of class names for catalog items that do not generate a normal cart item** (glide.sc.item.not_normal_cart_item): restricts which item types are added to the cart by default.

### Define item price

You can define a price for every item.

**Check box**

A check box variable helps to set the price or recurring price of the item being ordered.

Create a checkbox variable and set the price of the item in type specifications.

Use the **Price if checked** or **Recurring price if checked** field to specify the price or recurring price difference for that variable when the option is selected.

**Multiple choice**

For a multiple choice variable, there are two options for pricing.

- Specify the price difference in the **Price** field on the question choices.
- Specify the recurring price difference in the **Recurring Price** field on the question choices.

**Note:**

Select Boxes operate the same as multiple choice variables but are displayed as select boxes.

### Set up variable price

The price or recurring price of a catalog item can be modified with variables, increasing the base price for that item.

This is useful if you want the price or recurring price dynamically calculated based on how a user completes the ordering form. For example, the cost of an item can be increased based on options the user selects, such as extra memory in a PC.

The following **variable types** can be configured to modify the total cost of an item:

- Check box
- Multiple choice
- Reference
- List collector
• Select box
• Lookup select box

Reference
A reference variable includes a Pricing implications field.

If this field is selected and there is a price, u_price, recurring_price or u_recurring_price field on the referenced table, the value of that field is used to modify the cost of the item being ordered when a reference value is selected.

For example, suppose that computers in Phoenix cost $100 more than the ordering price and computers in Boise cost $100 less than ordering price.

1. Set up a reference variable to the Location [cmn_location] table.
2. Put a u_price field on the Location table.
3. Set that field to 100 for the Phoenix location.
4. Set that field to -100 for the Boise location.

When ordering a computer, if Phoenix is selected as the location for this variable, the ordering price is increased by $100. If Boise is selected, the ordering price is decreased by 100.

Note: List collectors operate the same as a reference variable, but use the List table field to specify the table being referenced. Since it is a list collector variable; multiple selections can be made that all modify the ordering price or recurring price.

Lookup select box
A lookup select box variable is more powerful than a reference variable.

Specify the following when creating a lookup select box variable:

• Lookup from table: the table from which values are queried.
• Lookup value field: the field on the lookup table whose value is used as the variable's value (typically sys_id).
• Lookup label field(s): a comma-separated list of fields on the lookup table whose values are used to display the selections in the select box. For example, manufacturer, name for the Software [cmdb_ci_spkg] table would display selections as:
  • Microsoft | Excel
  • Adobe | Photoshop Elements
• Lookup price field: the field whose value is used to modify the price of the item being ordered.
• Lookup recurring price field: the field whose value is used to modify the recurring price of the item being ordered.

Set a recurring price
A catalog item can have a recurring price in addition to an initial price. For example, a subscription to a mobile phone contract may cost $500.00, with an $30.00 monthly recurring price.

The price and the recurring frequency are set on the catalog item record. After the price and frequency are set, the recurring price appears in the catalog, catalog search results, catalog page for the item, shopping cart, and order summary screen.
If multiple items with the same recurring price frequency are placed in the shopping cart, they are grouped together. The grouping makes it easier to view how much items cost for each frequency (for example, weekly, monthly, and annually). If the shopping cart contains items with and without recurring costs, they are grouped separately.

On a request record, recurring prices are grouped by frequency and shown in the **Recurring Prices** related list. In the example below, two items each have a monthly recurring cost of $100.00 and their prices are grouped as a single record of $200.00 monthly. Another item with an annual recurring cost of $500.00 is listed as a separate record.
If a request record contains multiple items with the same recurring frequency, click the arrow next to the corresponding recurring prices record to view details. In the example below, two items (the mobile phone and the sales laptop) each have a monthly recurring cost and are grouped together under the **Monthly** recurring prices record, but are listed separately when the recurring prices record is expanded. Only one item has an annual recurring cost.
**Hide prices in the service catalog**

Administrators can configure options to hide catalog item prices in the service catalog for listings of specific items, for specific types of items, or for all items.

Item prices may appear in these places:
Figure 105: Catalog Order

A catalog item listing in the Order This Item panel

Figure 106: Catalog Subcategory

A subcategory listing

Figure 107: Shopping cart

The shopping cart panel

Figure 108: Edit Cart

The edit cart page

Figure 109: Order Confirmation

The order confirmation page
Hide prices globally
Service catalog enables you to configure service catalog properties to hide prices.
Navigate to Service Catalog > Catalog Policy > Properties to view and edit service catalog properties.

Hiding Prices by Item Types
By default, prices do not appear for order guides, record producers, and wizard launchers.
You can change which catalog item types show prices using the List of class names for catalog items that do not show the price in listings property (glide.sc.item.cannot_show_price). Provide a comma-separated list of table names for item types that you want to hide prices for.
For example, to hide prices for standard catalog items, add sc_cat_item to the list.
You can also remove an existing entry to display prices for that item type. For example, to display prices for order guides, remove the order guide entry sc_cat_item_guide from the list.

Hiding Prices for All Items
By default, zero-priced items have prices hidden in listings and carts.
You can configure this behavior to always hide or show prices, using the When to show prices and sub-totals on the Service Catalog Cart property (glide.sc.price.display).
Set this to Always show prices to display prices for all items on all service catalog screens, or to Never show prices to hide prices for all items on all service catalog screens.

Hide prices for specific items
To hide prices of specific items:

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Open the relevant item definition.
3. Select the Omit Price on Cart check box.
   The price does not appear in the catalog listing or when the item is added to the cart. The price is listed as "-" on the edit cart, order confirmation, and order status screens.

Extend the pricing model
To customize the catalog item price or recurring price:

1. From the left navigation pane, select System Definition > Script Includes.
2. Edit the CatalogPriceCalculator script to customize the item price and the CatalogRecurringPriceCalculator script to customize the recurring price.
Enable bulk requests

Bulk requests enable a customer to create up to 10 copies (clones) of the same Service Catalog request, for different users, without having to enter the same information multiple times.

For example, you can request a new piece of equipment for several specified people, generating multiple individual requests quickly from a single initial request.

To enable bulk requests:

1. Navigate to Service Catalog > Properties
2. Locate the property Enable cloning requests during checkout.
3. Select the Yes check box.
4. Locate the property List of roles (comma-separated) that can use bulk ordering functionality.
5. Enter the roles for which to enable bulk Service Catalog requests, or leave the field blank to enable the function for all users with a role.
6. Click Save.

Create scripts

Service catalog enables you to use certain scripts.

Some functions are available, specifically for service catalog:

- Client-side scripting: allows catalog designers to use the same functionality available on other forms.
- The Service Catalog Script API makes catalog ordering easier from inside business rules.
- Scriptable Assignment of Execution Plans allows selection of an execution plan at the time of ordering, based on scripted conditions.

Create a custom cart

Administrators with a knowledge of Jelly can customize the look and feel of service catalog carts, either globally or for specific catalog items, using our UI macro capability.

**Note:**

You can configure cart layouts without scripting.

Once created, a custom cart can be reused and linked to catalog items.

1. Navigate to System UI > UI Macros.
2. Click New to create a new macro.
3. Fill in the details and write the script to define your custom cart.

**Note:** Designing a custom cart requires knowledge of the Jelly expression language. For reference purposes, the default cart script appears in the list as catalog_cart_default.

4. Click Submit.

Link a cart to an item

Service catalog enables you to link a cart to an item.

1. Navigate to Service Catalog > Catalog Items.
2. Open an item to test your new cart.
3. In the Cart field, select the cart to use.
You may need to configure the form layout to add this field to the form.

4. Save the changed form.

In the example below, the HP bl35p uses the `irm_technical_cart`. 
This cart appears as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Sales Laptop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>✓</td>
</tr>
<tr>
<td>Availability</td>
<td>Desktop and Mobile</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Service Catalog</td>
</tr>
<tr>
<td>Cart</td>
<td>catalog_cart_default</td>
</tr>
<tr>
<td>Category</td>
<td>Hardware</td>
</tr>
<tr>
<td>Workflow</td>
<td>Service Catalog Item Request</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application</th>
<th>Global</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>$1,100.00</td>
</tr>
<tr>
<td>Recurring price</td>
<td>$100.00</td>
</tr>
<tr>
<td>Recurring price frequency</td>
<td>Annually</td>
</tr>
</tbody>
</table>

![Image of a laptop with Windows operating system]
Service catalog client script

You can create client scripts to customize the catalog.
To create a catalog client script:

1. Navigate to Service Catalog > Catalog Policy > Catalog Client Scripts. A list of current custom catalog client scripts appears.
2. Click New.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the catalog client script.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select the item type this client script applies to:</td>
</tr>
<tr>
<td></td>
<td>• A Catalog Item: enables the Catalog item field.</td>
</tr>
<tr>
<td></td>
<td>• A Variable Set: enables the Variable set field.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the client script. Clear the check box to</td>
</tr>
<tr>
<td></td>
<td>disable the script.</td>
</tr>
<tr>
<td>UI Type</td>
<td>Whether to apply this to desktop, mobile, or both.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter the client script that should run on the service catalog item.</td>
</tr>
<tr>
<td>Type</td>
<td>Select when the script should run, such as onLoad or onSubmit.</td>
</tr>
<tr>
<td>Catalog item or Variable set</td>
<td>Select a catalog item or variable set from the list. The field name and</td>
</tr>
<tr>
<td></td>
<td>options available depend on the selection in the Applies to field.</td>
</tr>
<tr>
<td>Applies on a Catalog Item view</td>
<td>Select the check box to apply the catalog client script to catalog items</td>
</tr>
<tr>
<td></td>
<td>displayed within the order screen on the service catalog.</td>
</tr>
<tr>
<td>Applies on Requested Items</td>
<td>Select the check box to apply the catalog client script on a Requested Item</td>
</tr>
<tr>
<td></td>
<td>form, after the item is requested.</td>
</tr>
<tr>
<td>Applies on Catalog Tasks</td>
<td>Select the check box to apply the catalog client script when a Catalog Task</td>
</tr>
<tr>
<td></td>
<td>form for the item is being displayed.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Configure catalog pages
Service catalog enables you to configure the pages within a catalog.

Configure content types
You can configure content types for the service catalog.
You can use service catalog properties to configure content types, which are also called widgets.

Navigate to **Service Catalog > Catalog Policies > Properties** to view service catalog properties.

Navigate to **System UI > Widgets** to see a list of content types available.

## Enable content types for the Service Catalog

By default, only service catalog categories are displayed on the service catalog homepage.

To select additional content types, add these types in a comma-separated list in the **List of content types (comma-separated) to allow on the catalog homepage** property (glide.sc.home.filter).

For example, to include service catalog categories and gauges, set the property to **Catalog Categories, Gauges**.

## Display the expand / collapse icon

By default, the expand / collapse icon is not displayed for categories on the service catalog homepage.

To display this icon on the left of each category, check **Yes** beside the **Toggle whether the expand/collapse icon is rendered for category widgets on the service catalog homepage** property (glide.sc.homepage.show.collapse).
Configure search and navigation

You can use service catalog properties to configure search and navigation within the service catalog homepage.

Navigate to Service Catalog > Catalog Policies > Properties to view service catalog properties.

Restrict search access

Each catalog homepage provides a search bar to help locate items not displayed on the homepage. By default, any user who can access the catalog homepage can search using this search bar.

To restrict access to this search function by role, use the List of roles (comma-separated) that can search the service catalog property (glide.sc.can_search).
For example, to only allow logged-in users to access search, set this to blank. To remove the search function for all users, set this to **None**.

**Note:** Search results only show items that the logged-in user can access.

**Hide search results from inactive categories**

By default, search results are returned from all categories, including inactive categories.

To avoid returning results from inactive categories, set the **Service catalog searches return items in inactive categories** property (glide.sc.search.disabled_cats) to **No**. For example, when designing a new category, you may want to avoid users seeing search results from this category until you are ready to make it active.

**Note:** Security constraints may also make a category or catalog item inaccessible.

**Restrict search by item type**

By default, a search field does not appear when viewing order guides, record producers, and wizard launchers.

To define which catalog item types do not show the search field, list these types in the **List of class names for catalog items that do not have the search field displayed** (glide.sc.item.cannot_show_search) property.

For example, to enable searching when viewing record producers, remove **sc_cat_item_producer** from this list.
Request a reset of a password for a service or an application.

Whose password needs to be reset?

Joe Employee

What application password do you need reset?

How would you like to be contacted with your new password?

[ ] Email  [ ] Telephone  [ ] SMS

Submit

Figure 112: Service catalog search bar removed
Enable breadcrumb links

By default, breadcrumbs appear without links when using content management pages as service catalog homepages.

To display these breadcrumbs with links, set the Use links for breadcrumbs rendered in Service Catalog pages accessed via a CMS site property (glide.sc.use_breadcrumb_links.cms) to Yes. This provides greater navigational control for end users.

Disable search suggestions

By default, service catalog searches display "Did you mean?" suggestions if a search does not return any results and an alternate spelling or similar recent search does.

To disable these suggestions, set the Specify whether search suggestions should be enabled property (glide.sc.search.suggestions) to No.

Refine search results

Service catalog enables you to use properties in order to refine search results.

The auto-completion feature returns values that contain an exact match to the letter combination entered.
Administrators can use the Additional columns for the "request for" Service Catalog widget (glide.sc_request_for.columns) property to add columns to this list, to further refine the search results, and help determine which user to select when two users have the same name.

In this example, the property is set to display two additional columns, Department and Title:
Administrators can use the Ordering of matches for the “request for” Service Catalog widget. (glide.sc.request_for.order_by) property to configure the columns to sort by one of the values.

In this example, the is set to sort the results list by department.
Auto-completion also applies to the Request for field, which can be added to the service catalog homepage.

1. Navigate to **Service Catalog > Catalog**.
2. Click **Add Categories**.
3. Select **Request for**.
4. Place the category on the page.
Configure preview

Service catalog enables you to configure the number of items that have the **Preview** section expanded to display item details.

By default, if not showing item details using pop-ups, the first two items listed in the category display have the **Preview** section expanded to display item details.

To change the number of items with this information expanded, set the **Number of Catalog Items to expand in browsing and search when not using pop-up icons to view details** (glide.sc.auto_expand) property to the number required.

| Expanding to 2 items | Expanding to 1 item |
Geneva  ServiceNow  IT Service Management

Hardware

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPhone 5</td>
<td>16GB 4G SIM card, iOS 12, A12 Bionic chip, Face ID, Super Retina Display</td>
<td>$799.00</td>
</tr>
<tr>
<td>Apple MacBook Pro 15&quot;</td>
<td>2.3GHz Intel i5 Processor, 256GB SSD, Retina display, Touch ID</td>
<td>$2,499.00</td>
</tr>
</tbody>
</table>

© 2017 ServiceNow. All rights reserved.
Set number of items and categories to preview

By default, up to five items or categories appear in each category on the homepage. To change this number, set the **Number of Catalog Items/ Categories to preview in a section** (glide.sc.max_items) property to the required value.

<table>
<thead>
<tr>
<th>Five items</th>
<th>Two items</th>
</tr>
</thead>
</table>

Customize a catalog homepage

1. Navigate to **Service Catalog > Catalog**.
2. Click the add content icon (+) at the top of the page to add a category.
3. Select a category in the middle panel of the pop-up window that appears.
4. Click Add here in the location where the category should appear on the homepage.
5. Optional: Repeat steps 3-4 to add more categories.
6. Close the pop-up window.
7. Optional: To change a category’s location, drag it to the appropriate place.
8. Optional: To remove a category, click the (X) icon on the top right of the category header.

Select a renderer

To select a renderer for a category:

1. Navigate to Service Catalog > Catalog.
2. Click Add Categories.
3. Select a category in the middle panel of the pop-up window.
4. Select a renderer from the list displayed in the right-hand panel, for example Category Items No Title.
5. Click the close (x) button to save the catalog with the renderer settings you defined.

The following default category renderer schemes are available:

- Category Items: shows desktop image, title, and description.
- Category Items No Title: shows desktop image and description.
- Category Details: shows the sub-categories and items in that category.

Enable content types

To select content types, also called widgets, to use for a catalog:

1. Navigate to Service Catalog > Catalog Policies > Properties.
2. In the List of content types (comma-separated) to allow on the catalog homepage (glide.sc.home.filter) property, enter the content types to use in the service catalog.

To see a list of content types available, navigate to System UI > Widgets.

The default value is Service Catalog, which includes only service catalog categories. For example, to include service catalog categories and gauges, set the property to Service Catalog, Gauges.

Use service catalog renderers

Renderers define a specific look and feel for a catalog or category.

Administrators and catalog administrators can use renderers to control:

- How categories appear on a catalog homepage.

Administrators and catalog administrators can apply renderers to catalogs and categories.

Administrators can create or modify renderers.

You can apply renderers to catalogs and categories.

To select a renderer for a catalog:

1. Navigate to Service Catalog > Catalogs.
2. Click Add Catalogs.
3. Select a catalog in the middle panel of the pop-up window.
4. Select a renderer from the list displayed in the right-hand panel, for example **Title Only**.
5. Click **Close** to save the catalog with the renderer settings you defined.

The following default catalog renderer schemes are available:
- **All Details**: shows desktop image, title, and categories.
- **Title and Image**: shows title and desktop image.
- **Title Only**: shows title only.
- **Image Only**: shows desktop image only.

**Configure categories**
Service catalog enables you to configure categories.

Service catalog properties available to configure:
- Appearance: how categories are displayed to users. For example, display subcategories in a panel or as a list in the category view.
- Homepage content types and search and navigation elements. For example, enable or disable service catalog searching for all users.
- Catalog item behavior: how items, item class names and item categories appear to users. For example, define the number of catalog items or categories to preview in a section.

**Customize the multi-catalog homepage**

You can customize the multi-catalog homepage to provide end users with access to multiple catalogs from one homepage.

This is similar to customizing the homepage for an individual catalog.

1. Navigate to **Service Catalog > Catalogs**.
2. Select **Add Catalogs** at the top of the page to add catalogs to this page.
3. Select a catalog in the middle panel of the pop-up window.
4. [Optional] Select a renderer from the right-hand panel, for example **Title Only**.

5. Click **Add here** in the location where the catalog should appear on the homepage.

6. [Optional] Repeat steps 3-5 to add more catalogs.

7. Close the pop-up window to save the changes.

**Note:** Only administrators can see catalogs that do not contain active categories or items.
You can modify the arrangement of catalogs within the homepage:

- To change a catalog’s location, drag it to the appropriate place.
- To remove a catalog, click the X in the catalog title bar.
- To edit details for a catalog, click the pencil icon in the catalog title bar.

The catalogs appear on the homepage.

Create a renderer

Administrators can create or modify renderers using UI macros to provide the rendering instructions. For example, you can create a renderer showing the category homepage image, the description, and the first two catalog items in a category.

To create a renderer:

1. [Optional] Create a UI macro to define specific rendering instructions.
2. Navigate to Service Catalog > Catalog Definition > Renderers.
3. Click New.
4. Select to create a catalog or category renderer.
5. Enter the renderer details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the renderer.</td>
</tr>
<tr>
<td>Macro</td>
<td>The UI Macro to use.</td>
</tr>
<tr>
<td>Render catalog title</td>
<td>Appears for catalogs renderers. A check box to display the catalog title bar on the multi-catalog homepage.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Render title</td>
<td>Appears for category renderers. A check box to display the category title bar on the catalog homepage.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The admin and catalog_admin roles can view the <strong>Render title</strong> even when the check box is not selected.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Note:** To modify a default catalog or category renderer, follow a similar process, by selecting one of the default renderers listed.

This new renderer is added to the list of available choices when applying a renderer.

**Display subcategories in a panel**

By default, when viewing a category, subcategories are displayed in a panel at the bottom of the display. To display categories as a list at the top:

Use the **In category view display subcategories in a panel** property (glide.sc.use_sub_cat_section).

<table>
<thead>
<tr>
<th>Table 204: Name of form</th>
</tr>
</thead>
<tbody>
<tr>
<td>When set to <strong>Yes</strong>, the subcategories appear in a panel at the bottom.</td>
</tr>
<tr>
<td>When set to <strong>No</strong>, the subcategories appear as a list at the top.</td>
</tr>
</tbody>
</table>
Search a service catalog

**Note:** If your organization has multiple service catalogs, searches return results only from the currently viewed catalog.

To find a specific item in a catalog, use the **Search** field. Click the down arrow to see a list of previous searches. Catalog search is available on catalog and category pages.

**Figure 114: Service Catalog Search Dropdown**

Search results list items in active categories along with their short description. Use the breadcrumbs in the header bar or below the short description to quickly navigate to a different page. The **Found In** list shows the categories related to the search results in hierarchical format.
Figure 115: Service Catalog Search Results

You can control the number of results shown on one page with the search results selection list.

Figure 116: Search Results Selection List
In the catalog listing, click a link in the breadcrumbs at the top of the screen to quickly navigate back one or more levels in the hierarchy.

To remove the search term from the breadcrumbs, click the x next to the term.

If a search returns multiple results, obtain details about a specific catalog item by clicking Preview.

---

**Note:** The system performs the service catalog search on English language descriptions only.

### Show item details in collapsible sections

Service catalog enables you to change the number of items that display the preview.

By default, if not showing item details in pop-up windows, the first two items listed in the category display have the Preview section expanded to display item details.

To change the number of items with this information expanded:

Set the **Number of Catalog Items to expand in browsing and search when not using pop-up icons to view details** (glide.sc.auto-expand) property to the number required.

<table>
<thead>
<tr>
<th>Expanding to 2 items.</th>
<th>Expanding to 1 item.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Expanding to 2 items." /></td>
<td><img src="image2.png" alt="Expanding to 1 item." /></td>
</tr>
</tbody>
</table>

### Show item details using popup icons

Service catalog enables you to view item details using a Preview link, which expands the items details below the item.
To make these details accessible as a pop-up when users point to the item icon:

Set the **When browsing a category use the pop-up icon to show item details (glide.sc.cat_view_use_popup_for_details)** property to **Yes**.

<table>
<thead>
<tr>
<th>When set to <strong>No</strong>, the item details appear when clicking <strong>Preview</strong>.</th>
<th>When set to <strong>Yes</strong>, the item details appear as a pop-up when the cursor hovers over the item icon.</th>
</tr>
</thead>
</table>

Hide the exists in categories display

Service catalog enables you to hide the other categories that a specific item also exists in.

By default, catalog items that are in several categories show **Exists in categories** information that shows any other categories the items are available in.

Set the **Show the additional categories section when viewing a catalog item**(glide.sc.show_additional.cats) property to **No**.
Manage a service catalog homepage

The homepage for a service catalog provides the primary front end for ordering items within that catalog. Administrators and catalog administrators can design a homepage in any of the following ways.

- Customizing the catalog homepage.
- Adding, removing, and arranging categories.
- Enabling content types.
- Using catalog properties to provide additional control over behavior and appearance.
- Using renderers to define the appearance of categories.

**Note:** End users can access the catalog through the customizable user homepage, or with content management pages that use content blocks for categories.

Configure mobile devices

Users can access the service catalog on mobile devices in order to:

- View and order products and services.
- Submit incidents and problems using record producers.

**Note:** Users cannot access order guides, wizards, or content items from mobile devices.

Administrators and catalog administrators can configure the layout, presentation, and other aspects of the service catalog for mobile devices.

This includes:

- Defining rendering options for mobile categories.
- Defining rendering options for mobile catalog items.

Accessing the Service Catalog on Mobile Devices

To access the service catalog, navigate to **Self-Service > Catalog**.
Catalog items are grouped into categories, which may also contain one or more subcategories. You can browse and select an item. To browse for an item within a category, tap the category name to view all items and subcategories in that category.

**Figure 117: Service Catalog Homepage Mobile**
To request an item:

1. Select an item.
2. Tap any field with an arrow (>) to add information, such as the requester's name or location, the need-by date, or item quantity.

3. Tap Add to add the item to your cart. The order screen appears.
4. Tap **Edit** to edit your order, if required.

5. To order the item as specified, tap **Order**, then tap **OK** when prompted to confirm ordering. A confirmation message appears.
6. Tap the item to see further details.
7. Tap the back arrow to return to the confirmation message.
8. Tap **Continue Browsing** to return to the service catalog.

After the request is submitted, ServiceNow follows request fulfillment processes to fulfill the ordered item.

### Define the mobile layout

You can configure the mobile layout for categories within a service catalog.

**Role required:** admin

By default, service catalog categories appear on mobile devices in the same order as on desktop devices.

1. Navigate to **Service Catalog > Mobile Admin > Mobile Layout** to display a list of service catalogs.
2. Click the lookup icon for the service catalog you want to configure.
   The mobile layout details for that catalog displays.
3. Click **Edit** to select which categories appear on mobile devices, and in which order.
4. Add, remove, or reorder the selected mobile categories, and then click **Save**.

**Note:** To return the display to the default desktop layout settings for the portal page associated with that catalog, click the **Replace categories with desktop layout** related link.
Limit description sizes in mobile UI

By default, item descriptions in the smartphone interface are truncated to a maximum of two lines.

To display full descriptions:

1. Navigate to **Service Catalog > Catalog Policies > Properties**.
2. Set the **Limit descriptions in category and item listings to two rows in the Mobile UI** property (glide.sc.mobile.limit.description) to **No**.

<table>
<thead>
<tr>
<th>If set to <strong>Yes</strong>, descriptions are limited to two lines</th>
<th>If set to <strong>No</strong>, the full descriptions are given</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Figure 119: Set to Yes" /></td>
<td><img src="image2" alt="Figure 120: Set to No" /></td>
</tr>
</tbody>
</table>

Configure content management system

The Content Management System (CMS) enables users to create a custom interface for the service catalog.

Manage catalog sites

Service catalog enables you to manage catalog sites.
If you are using the ServiceNow content management system as well as the service catalog, the Sites related list allows you to set which catalogs are supported within sites. This enables you to ensure that end users can always access an appropriate catalog. You can also view and edit values for your sites.

In the Sites related list, click Edit to add a site for this catalog.

To edit catalog site details:

1. Click the reference icon beside the site name.

2. Enter values in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS homepage</td>
<td>The homepage for this site.</td>
</tr>
<tr>
<td>CMS search page</td>
<td>The location of the search page for the site.</td>
</tr>
<tr>
<td>CMS ‘Continue Shopping’ page</td>
<td>The location to direct end users to when they click the Continue Shopping button in that CMS site. This field is designed to reference a content page url suffix.</td>
</tr>
</tbody>
</table>

3. Click Update.

Set up catalog portal pages

The Catalog Portal Page [sc_catalog_view_mtom] table links catalogs to CMS portal pages and defines the default catalog to portal page combination used by URLs.
For example, the default portal page for the service catalog is the catalog_default page.

Catalog portal page records appear in the Catalog Portal Pages related list on the Catalog form. The Catalog Portal Page table generates two values in a URL: sysparm_catalog_view and sysparam_catalog. Use the Catalog Portal Page form to enter a custom link, if required.

**Resolve missing catalog portal pages**

If a catalog record is not associated to a catalog portal page record, ServiceNow attempts to present a view based on a set prefix of: catalog_<catalog name>.

For example, if the default service catalog has no catalog portal page record, the system sets sysparm_view to catalog_Service_Catalog. If this happens, when you navigate to Self-Service > Service Catalog, you view the new and apparently blank catalog_Service_Catalog portal page, instead of the existing and populated catalog_default portal page.

To correct this, go to the Sites related list on the Catalog form and add a new catalog portal page record manually.

For example, for the default service catalog, add a record with values of:

- Catalog: Service Catalog
- Portal Page: Catalog (catalog_default)
- Default: true

**Manage catalog portal pages**

Service catalog enables you to create and manage multiple portal pages for a catalog.

A catalog portal page provides a homepage for a specific catalog. You can use portal pages to create different catalog views for different user groups. Each portal page accesses the same catalog content and presents that content in different ways.

Catalog portal page details include the owner, title, and view to use for that page.

- **Note:** The View field on a portal page is the value used when you refer to the homepage in a URL or module. When you upgrade to the Eureka release, this view value for the default service catalog portal page is automatically set to catalog_default. If you previously changed this value, you should manually reapply this change after upgrade.

1. The Catalog Portal Pages related list shows portal pages available for that catalog. Each catalog has a default page, created automatically when the catalog is created.

2. Select an appropriate action:
   - Click New to create a new portal page.
   - Click Edit to select an additional portal page for the catalog.
   - Select a portal page to view and edit details for that page.

**Service Catalog request fulfillment**

When a user orders a catalog item, ServiceNow creates a request and attaches the catalog item attached to it.

The processing of this request or request fulfillment is driven by a fulfillment process that must be defined.

This process lets administrators automate requesting approvals, assigning requests, and fulfilling requests, using tools similar to those used elsewhere in task administration or workflow.
To define the fulfillment process, administrators need to:

1. Set up fulfillment groups to perform the work.
2. Define the fulfillment processes those groups use to perform the work.

Define a fulfillment process

Each catalog item uses a fulfillment process, to define the request fulfillment process when that item is ordered.

Fulfillment processes are used when ordering standard catalog items, but are not used for some extended types of catalog item, such as content items.

To define a fulfillment process:

- Use either a workflow or an execution plan.

Tip: ServiceNow typically recommends using workflows for your request fulfillment processes.

Request fulfillment workflows

Service Catalog workflows enable administrators to easily define a complex, multi-step process for fulfilling and approving the request.

Service Catalog workflows can be defined using the graphical workflow editor, enabling you to:

- Edit workflows graphically
- Modify activities and conditions
- Define transitions between workflow activities
- Summarize workflow progress through stages
- Validate workflows to identify potential problems
- Publish workflows for other users

ServiceNow typically recommends using workflows for request fulfillment processes.

Service catalog workflow definition

Use the Graphical Workflow Editor to create service catalog workflows that drive catalog request fulfillment.

After creating a workflow, attach it to any catalog item in the Workflow reference field on the item form.

Creating a workflow involves:

- Defining the new workflow fields
- Defining workflow activities
- Publishing the new workflow

Service catalog workflows

Two service catalog workflows are provided by default.

- **Service Catalog Request**: a simple workflow that fulfills a simple order
- **Service Catalog Item Request**: a more complex workflow that fulfills a more complex order

Use these examples to see how the workflow engine can work for the service catalog.
Figure 121: Service Catalog Request
Figure 122: Service Catalog Item Request

Create a new catalog workflow

To create a service catalog workflow to fulfill a laptop request:

1. Navigate to Workflow > Workflow Editor
2. Select New.
3. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Laptop Fulfilment</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Requested Item [sc_req_item]</td>
</tr>
<tr>
<td></td>
<td>Please keep the following information in mind:</td>
</tr>
<tr>
<td></td>
<td>• Workflows on the Service Catalog Requested Item [sc_req_item] table should fulfill the request of a single catalog item. Each requested item can trigger its own fulfillment workflow, which runs when those specific items are ordered. We recommend you use this table for workflows for requested items.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To enable approval-type workflows to operate smoothly, make sure that the appropriate users have the correct role, and that the role grants access to the necessary tables for users in all the relevant departments and domains.</td>
</tr>
<tr>
<td></td>
<td>• Use caution when using before query business rules, as they can also restrict access to the sc_req_item record.</td>
</tr>
<tr>
<td></td>
<td>• Workflows on the Request [sc_request] table always run when a service catalog request is made, regardless of what item was ordered. These workflows usually control the entire request process, which may involve delivering several parts (the request items). So Request table workflows are not usually assigned to a specific item from the maintain item form. If you do use the Request table for service catalog requests, you should add conditions to the workflow to make sure it only runs when the correct item is requested.</td>
</tr>
<tr>
<td>Field</td>
<td>Input value</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expected time</td>
<td>Days 7 Hours 00:00:00. Because workflows cannot calculate the end time (not all of the activities within the workflow have defined times), the <strong>Expected time</strong> on the workflow becomes the <strong>Delivery Time</strong> on the catalog request. Note: When both <strong>Expected time</strong> and <strong>Schedule</strong> are filled in, the catalog delivery time is then calculated based on the combination of both. For example, if you put 2 days as <strong>Expected time</strong>, it is calculated as 48 hours. If you then add a schedule that define a work day as 8 hours, the delivery time becomes 48 / 8 = 6 days. If your schedule excludes weekends, the calculation will also add 2 days for the weekend, making the delivery time 8 days.</td>
</tr>
<tr>
<td>Schedule</td>
<td>8-5 weekdays.</td>
</tr>
<tr>
<td>Timezone</td>
<td>US/Pacific. The timezone that the schedule applies to.</td>
</tr>
<tr>
<td>Description</td>
<td>A workflow for the fulfillment of laptop requests.</td>
</tr>
</tbody>
</table>

4. **Click** Submit.

A graphical representation of the new workflow displays with an **Activities** pane on the right.

After creating a workflow, attach it to any catalog item in the Workflow reference field on the item form.
Associate item with domain-specific workflow

When using service catalog workflows with domain separation, ensure your catalog items use the domain-specific workflow.

If you create a domain-specific version of a workflow, existing catalog items continue to use the original workflow. To configure the catalog item to use the domain-specific workflow, select the new workflow in the Workflow field on the catalog item record.

Publish a catalog workflow

Open the Workflow Actions menu ( ) and select Publish to publish the workflow. The resulting workflow displays.
Delete a catalog workflow record

Workflow stage fields for service catalog workflows display when a user deletes a record required by the workflow.

If a user deletes a catalog item and that catalog item has active request workflows running, the workflow stage field displays **Catalog item removed**. Similarly, deleting the associated workflow context causes the stage field to display **Workflow context removed**.
Add an activity to a catalog workflow

To define workflow activities:

1. In the Activities pane, expand Approvals and drag the activity Approval - User onto the arrow between Begin and End. This activity generates an approval from the manager of the person requesting the laptop.

2. Fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Manager's Approval</td>
</tr>
<tr>
<td>Stage</td>
<td>Waiting for Approval</td>
</tr>
<tr>
<td>User</td>
<td>Click the lock icon (🔒) and then click the variable picker icon (🔍). Select Requested &gt; Requested For &gt; Manager</td>
</tr>
</tbody>
</table>

![Image of Approval - User activity]

3. Click Submit.

4. Expand Utilities in the Activities pane and drag the activity Set Values to the space below the approval.

5. Drag from the yellow box beside Rejected on the Approval - User activity to the new Set Values activity.

6. Drag again from the yellow box beside Always on the Set Values activity to End. This activity marks the request as rejected if the manager rejects the request and then ends the workflow.

7. Fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Rejected</td>
</tr>
</tbody>
</table>
8. Drag the activity **Set Values** onto the arrow between **Approval - User** and **End**, and then fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Approved</td>
</tr>
<tr>
<td>Stage</td>
<td>Fulfillment</td>
</tr>
<tr>
<td>Set These Values</td>
<td>Approval and Approved</td>
</tr>
</tbody>
</table>

This activity marks the request as approved if a manager approves it.

9. Drag the activity **Create Task** onto the arrow between **Approval - User** and **End**, and then fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Laptop Procurement</td>
</tr>
<tr>
<td>Stage</td>
<td>Fulfillment</td>
</tr>
<tr>
<td>Task Type</td>
<td>Catalog Task [sc_task]</td>
</tr>
<tr>
<td>Priority</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>Fulfillment group</td>
<td>Procurement</td>
</tr>
<tr>
<td>Short Description</td>
<td>Procure a Laptop</td>
</tr>
</tbody>
</table>
This task tells Procurement to procure a laptop for the user.

10. Drag the activity **Notification** onto the arrow between **Laptop Procurement** and **End**, and then fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Procurement</td>
</tr>
<tr>
<td>Stage</td>
<td>Fulfillment</td>
</tr>
</tbody>
</table>

To

Click the lock icon (🔒) and then click the variable picker icon (🔍). Select **Request > Requested For**

Subject

Your laptop has been procured.
This activity marks the request as approved if a manager approves it.

11. Drag the activity **Create Task** onto the arrow between **Procurement** and **End**, and then fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Set Up Laptop</td>
</tr>
<tr>
<td><strong>Stage</strong></td>
<td>Fulfillment</td>
</tr>
<tr>
<td><strong>Task Type</strong></td>
<td>Catalog Task</td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td>3 - Moderate</td>
</tr>
<tr>
<td><strong>Fulfillment Group</strong></td>
<td>Hardware</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
**Short Description** | Set up laptop.

This task tells Hardware to configure the laptop and prepare it for use.

12. Drag the activity **Create Task** onto the arrow between **Set Up Laptop** and **End**, and then fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Pick Up Laptop</td>
</tr>
<tr>
<td><strong>Stage</strong></td>
<td>Delivery</td>
</tr>
<tr>
<td><strong>Task Type</strong></td>
<td>Catalog Task</td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td>3 - Moderate</td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>Leave this field blank. The <strong>Advanced</strong> script assigns this task to the user who requested the item.</td>
</tr>
<tr>
<td><strong>Short Description</strong></td>
<td>Pick up laptop.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Select the check box and set the <strong>Advanced Script</strong> value to: task.assigned_to=current.requested_for;</td>
</tr>
</tbody>
</table>

This task informs the requester to come pick up the laptop.

13. Drag the activity **Log Message** onto the arrow between **Pick Up Laptop** and **End**, and then fill in the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Delivered</td>
</tr>
<tr>
<td><strong>Stage</strong></td>
<td>Completed</td>
</tr>
<tr>
<td><strong>Message</strong></td>
<td>The laptop delivery workflow is complete.</td>
</tr>
</tbody>
</table>

This leaves a message in the log to record the successful completion of the workflow.

**Execution Plans**

An execution plan describes how a catalog item is procured, configured, and installed.

Execution plans enable you to describe simple, linear processes. Each execution plan contains one or more tasks. For example, an organization might create an execution plan for delivering a corporate standard PC that contains these tasks:

1. Procure the PC from a supplier.
2. Configure the PC according to the requester's specifications.
3. Deliver the PC to the requester.

An execution plan is not specific to any one catalog item. There could be many different models of PC that a user can order, all using the same execution plan. It is usually not necessary to create a new execution plan for each individual catalog item in a mature service catalog.

**Note:** Execution plans are not as powerful or flexible as workflows, and cannot be designed using a graphical editor. Execution plans are useful in some circumstances, for example, if you need
to build your processes programmatically or through imports. ServiceNow recommends using workflows for request fulfillment processes.

Create an execution plan

Administrators and catalog administrators can create and manage execution plans.

To create an execution plan:

1. Navigate to Service Catalog > Catalog Policy > Execution Plans.
2. Click New.

3. Enter a Name and Short description for the execution plan.
4. Specify delivery information in the Total delivery time and On Calendar fields.
5. Click Submit.

Add catalog item variables to a task

For example, when a user requests a laptop, the fulfillment group may need to know what screen size and how much memory to order.

Each catalog item can contain one or more variables for gathering information from the user who requests the item. Assuming that the relevant catalog items have been associated to the execution plan, you can associate these variables to the specific created tasks that need the information.

To add catalog item variables to a task:

1. Navigate to Service Catalog > Catalog Policy > Execution Plans.
2. Open an execution plan.
3. In the Execution Plan Tasks related list, open a task.
Make sure the form shows the Plan view. If not, right-click the header bar and select View > Plan.

4. Go to the Available Variables related list and click Edit.

5. Use the slushbucket to select the variables that are appropriate for the task.
   Consider all the types of catalog items that might use this execution plan, and select all the variables that might be assigned to them.

6. Click Save to associate these variables to the execution plan task, making them accessible.

Execution plan tasks

An execution plan contains one or more execution plan tasks.

Each task represents work that needs to be completed by a specific group as part of the overall request fulfillment process.

Administrators create templates for tasks as part of defining an execution plan. The catalog tasks themselves are then created when the relevant item is requested, based on these task templates.

Execution plan approval tasks

Approval tasks are specific types of tasks within execution plans.

If an approval task is rejected, the execution plan can roll back to a previous task.

To set up an approval task including a rollback action:

1. Navigate to Service Catalog > Execution Plans.
2. Select an execution plan.
3. From the Execution Plan Tasks related list, select New Approval to create the approval task.
4. Fill in the fields for that approval task.

5. Use the Upon reject field to define the action to take if the task is rejected:
   - Cancel all future Tasks: [default] cancels all future tasks in the execution plan and also cancels the parent request item.
   - Go to a previous Task: displays the Rejection goto field where you can select which task this execution plan should roll back to.
6. **Save** the task, then scroll down to the Approved By list and select one or more approvers for the tasks.

You can also use an Approval script to select approvers.

7. Select **Update** to add the task to the execution plan.

This example shows how the process works in practice, using a request to order a Blackberry phone.

First, the request is ordered:

Next, complete the first two steps, which leads to the approval task.
Reject the request to roll back the execution plan to a previous task, and reset any intermediate tasks to pending:
After a plan has been rolled back, ServiceNow adds to the rolled-back task a note indicating that it was rolled back and why.

**Note:** Rolling back rolls back all intermediate tasks within the execution plan. Other plans within the same request are not rolled back, however.

---

**Set up a fulfillment group**

Fulfillment groups perform the tasks related to fulfilling an order.

This can include approving an order based on characteristics such as content and price, or any direct action required to complete the order, such as loading software or installing hardware. Any existing user group (in **User Administration > Groups**) can be assigned fulfillment tasks.

To create a group specifically for order fulfillment:

1. Navigate to **Service Catalog > Catalog Policy > Fulfillment Groups**.
2. Click **New**.
3. Fill in the Group form as described under creating groups.
   These groups have the type catalog and are assigned the catalog and itil roles, but are otherwise normal groups.

---

**Specify delivery information**

Use the **Total delivery time** field to specify an estimated delivery time for each task in your execution plan. This estimate is calculated based on the combined total of times for the *tasks* in that execution plan.

By default, time estimates do not use a "working days" calendar system, but are based on simple elapsed time. For example, for a 5-day execution plan, if you submit the request on a Friday, the delivery date
is Wednesday of the following week (5 elapsed days later), even if your organization does not work weekends.

Use the On Calendar field to specify a calendar system to apply to the execution plan, to help estimate more accurate delivery times.

If using this calendar system for estimated delivery time, ensure that estimates are expressed in working hours and days. For example, a task which is supposed to take 1 day on a 9-5 calendar is assumed to take 24 working hours, and so actually takes 3 working days.

Note: This calendar system is used to help provide delivery estimates only, and is not linked to any SLAs you might set on execution tasks.

Create execution plan tasks

An execution plan contains one or more task templates. Each task template defines work that needs to be completed by a specific group.

Execution plans are associated to catalog items; when the relevant catalog item is requested, these task templates are used to generate tasks, to be performed as part of the request fulfillment process for that requested item. Each generated task within that requested item is assigned a catalog task number.

Example

The execution plan for an executive desktop computer catalog item might define the following task templates in the execution plan:

- Obtain managerial approval
- Order hardware
- Install standard corporate applications
- Deliver computer to requester

When this catalog item is ordered, the following request, requested item and tasks are then created:

- Request REQ0002 -- 1 PC
  - Requested Item ITEM0004 -- 1 X executive desktop
    - Catalog Task0001 -- Obtain managerial approval
    - Catalog Task0002 -- Order hardware
    - Catalog Task0003 -- Install standard corporate application
    - Catalog Task0004 -- Deliver computer to requester

Create task templates

Each execution plan contains one or more task templates, which define actions that must be taken to fulfill a request.

After creating the execution plan, you should now define these task templates.

When the relevant catalog item is ordered, request tasks will be generated for that requested item, based on this information.

Define a task template

1. Navigate to Service Catalog > Catalog Policy > Execution Plans.
2. Open an execution plan.
3. In the Execution Plan Tasks related list, click New.
4. Fill in the fields on the Execution Plan Task form (see table).
5. Click Submit.
Name: Procure PC Hardware
Delivery plan: PC Delivery Plan
Order: 100
Delivery time: Days 1, Hours 00 00 00
Assigned to: Procurement
SLA: 
Condition: Add Filter Condition, Add "OR" Clause
--- choose field --- --- oper --- --- value ---
Short description: Order from vendor or move from in-stock inventory
Instructions: Order from preferred vendor
- IBM
- CDW
- Dell
OR
Move from "In Stock" inventory. Locate CMDB CI that have status of "In Stock" and assign it to the requested item, this action will take it out of the "In Stock" status and assign the CI to the customer.
Work notes: 

Available Variables [18] Waits for
--- Available Variables --- New Edit Search for text Search
<p>| Delivery Task = Procure PC Hardware |
| Variable Name |
| CPU Speed |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the task. This becomes the created task's name.</td>
</tr>
<tr>
<td><strong>Fulfillment group</strong></td>
<td>The group that performs the task. Whenever a user requests a catalog item associated with this execution plan, the task is automatically assigned to the fulfillment group. Leave blank if automatic assignment to a group is not required.</td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>The individual who performs the task. Leave blank if automatic assignment to a user is not required.</td>
</tr>
<tr>
<td><strong>SLA</strong></td>
<td>The service level agreement that applies to catalog items associated with this execution plan.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is normally left blank, as the functionality has been superseded by the service level management functionality.</td>
</tr>
<tr>
<td><strong>Delivery plan</strong></td>
<td>The parent execution plan for this task.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>A number representing the task's sequence in the execution plan. It is good practice to &quot;leave gaps&quot; between order numbers (for example, 100, 200, 300, and so on) so you can insert new tasks without changing the order number of existing tasks. If the order for several execution plan tasks is the same, each of these tasks starts at the same time.</td>
</tr>
<tr>
<td><strong>Delivery time</strong></td>
<td>Amount of time the task is expected to take. This value becomes a component of the overall time to complete the execution plan.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>Condition under which the task is performed (if the condition is not met, the task is skipped).</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>Brief description of the task's activity. This information populates the created task's short description field.</td>
</tr>
<tr>
<td><strong>Instructions</strong></td>
<td>Details of the activities to be performed for the task. This information populates the created task's description field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes</td>
<td>A journal field for entering comments about the task template. Note: this information is separate from the created task's work notes field.</td>
</tr>
</tbody>
</table>

*Apply conditions to tasks*

Administrators and catalog administrators can define conditions under which a particular execution plan task runs, or is skipped, when the relevant item is requested.

For example, an execution plan may contain the following tasks:

1. Order hardware
2. Receive hardware
3. Configure hardware
4. Deliver hardware

However, when an item is requested, if the hardware in question is already on site, it does not need to be ordered and so the first task in the list can be skipped.

*Note:* Skipped task records are still created, but are marked as skipped, and are not processed within the execution plan.

*Conditional Tasks*

To make an execution plan task conditional, defining the conditions under which the task runs.

1. Navigate to **Service Catalog > Execution Plans**.
2. Open an execution plan, and then open a task within that plan.
3. Use the **condition** field to select the condition under which the task runs.

If no conditions are set, the task runs every time a user orders an item associated with this execution plan.

Here is an example of conditional task for an IT lab based in Atlanta:
In this example, the **Deliver to IT Labs** step does not run if the request itself is in Atlanta; there is no need to deliver something to the IT lab if it is already there.
Use condition scripts to run tasks
Administrators can use a condition script in addition to or instead of any condition to determine whether or not a task should run.

**Note:** If you are using both a condition (via the condition field) and a condition script, both must be true before the task will run.

To use a script, you must configure the Execution Plan Task form to add the "Condition script" field. If the script returns true, the task runs. If the script returns false, the task does not run.

Ensure you add the variable used in the script to the execution plan task.
Geneva    ServiceNow    IT Service Management

Figure 123: Use Condition Scripts

© 2017 ServiceNow. All rights reserved.

---

**Execution Plan Task**

**Procure PC Hardware** (Plan view)

- **Name**: Procure PC Hardware
- **Delivery plan**: PC Delivery Plan
- **Fulfillment group**: Procurement
- **Order**: 100
- **Assigned to**: 
- **SLA**: 
- **Delivery time**: Days 1
  - Hours 00 00 00

**Condition**

- **Condition script**:

```
var rc = true;
if (current.request_item.request_for.name == 'Fred Luddy')
    rc = false;
```

**Short description**: Order from vendor or move from in-stock inventory

**Instructions**:

Order from preferred vendor
- IBM
- CDW
- Dell

**OR**

Move from "in Stock" inventory. Locate CMDB CI that have status of "in Stock" and assign it to the requested item, this action will take it out of the "In Stock" status and assign the CI to the customer.

**Work notes**

---

© 2017 ServiceNow. All rights reserved. 753
Process skipped tasks

If a task is skipped, the request fulfillment process moves on to the next task.

If the last task in an execution plan is skipped, the process is finished and the appropriate request item is closed as complete. Skipped tasks have their state set to **Closed Skipped** and display as gray boxes on a requested items list.
<table>
<thead>
<tr>
<th>Requested Items</th>
<th>New</th>
<th>Go to</th>
<th>Number</th>
<th>Item</th>
<th>Stage</th>
<th>Request</th>
<th>Requested for</th>
<th>Opened by</th>
<th>Due date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSM000016</td>
<td>Google Nexus 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000010</td>
<td>VPN RSA Token</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000014</td>
<td>Asus G Series</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000013</td>
<td>Apple iPhone 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000012</td>
<td>Notebook Computer Loaner</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000010</td>
<td>Blackberry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000009</td>
<td>Office Printer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000007</td>
<td>Blackberry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000006</td>
<td>Executive Desktop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000005</td>
<td>Telephone Extension</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000004</td>
<td>Sales Laptop</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSM000002</td>
<td>Blackberry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Use execution plans

Service catalog enables you to associate execution plans with catalog items. Once you have created the execution plan record, you can then associate it with catalog items, create task templates, and associate any catalog item variables to tasks if required.

You can also:
- Apply conditions to tasks
- Create approval tasks, enabling you to step back to a previous step if the approver rejects the request.

Associate execution plan with items

After you submit the execution plan record, you select a catalog item to use the execution plan. This association can be done at a later date, but doing it at this stage enables you to access relevant catalog item variables in the execution plan.

1. Navigate to Service Catalog > Catalog Definition > Maintain Items.
2. Select a catalog item.
3. In the Execution Plan field, select the new execution plan.
4. Click Update.

Configure checkout

Administrators and users with the catalog_admin role can enable and configure the two-step checkout model.

The service catalog defaults to a one-step checkout model. When a user clicks Proceed to checkout or Order now, items in the shopping cart are ordered and the order summary or status screen appears. The one-step checkout model runs in the following order:

Press Checkout > Order Summary

The service catalog also supports a two-step checkout model. Under this model, when a user clicks Proceed to checkout or Order now, an order confirmation screen appears, allowing the user to edit the order, choose a delivery location, or upload an attachment before submitting the order. The two-step checkout model runs in the following order:

Press Checkout Order > Confirmation Screen > Submit Order > Order Summary.

Enable the two-step checkout process

To set up a two-step checkout process:

1. Navigate to Service Catalog > Catalog Policy > Properties.
2. Locate the property Use the two step catalog checkout model (default false).
3. Select the Yes check box to enable the two-step process.
4. Locate the property Show the ‘Back to Catalog’ button on the two step checkout screen.
5. Select the Yes check box to provide a button that navigates back to the catalog from the order confirmation screen (default). Clear the check box to hide the button.

Specify requester location

In the two-step checkout model, end users may specify a recipient, delivery address, and special instructions for an order.
Are the contents of your cart correct? Please double check the items and remove and edit where appropriate.

<table>
<thead>
<tr>
<th>Item (Includes Monthly Charges)</th>
<th>Delivery Time</th>
<th>Price (ea.)</th>
<th>Quantity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPhone 5, Apple iPhone 5</td>
<td>2 Days</td>
<td>$799.99</td>
<td>1</td>
<td>$799.99</td>
</tr>
<tr>
<td></td>
<td></td>
<td>+$30.00 Monthly</td>
<td></td>
<td>+$30.00 Monthly</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>$799.99</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If this request is for someone other than yourself please provide detailed information in the fields provided below:

- **Requested for**: System Administrator
- **Shipping address**: 750 3rd Avenue, New York, NY 10017
- **Special instructions**:

Figure 125: Checkout
Administrators can control how the delivery address is populated. By default this is defined by the client script called `set location`.

When the two-step checkout process is enabled, the `set location` script retrieves the address of the user and enters formatted details in the Deliver to field.

### Service Catalog for end users

Service Catalog enables you to view and order items from departments within your organization.

These catalog items can include goods, services, and information.

Anything that can be ordered individually can be ordered as a catalog item. Anything that only exists as a part of a larger whole cannot be a catalog item. For example, a laptop can be a catalog item, but a high-resolution display for a laptop cannot.

After placing an order, the customer can track its progress. Predefined groups follow a series of tasks to deliver the item, based on a fulfillment process, including any approvals required.

### View and navigate a service catalog

The homepage for a service catalog lists the goods and services available to order from that catalog.

Catalog items are grouped into categories, which may also contain one or more subcategories. By default, the first ten items in a category appear under the category name on the service catalog homepage.

To access the default service catalog homepage, navigate to **Self-Service > Service Catalog**.
Figure 126: Service Catalog Homepage

Click a category name to see a list of all subcategories and items in the category.
Request a catalog item

To place a request from a service catalog, navigate to the catalog homepage and select the item to order. When an item is ordered, the ServiceNow ITSA Suite generates a request to track the order and displays a summary that includes the order status in the **Stage** column:
Each individual catalog item in a request creates a discrete request item. For example, a request for 2 PCs, 1 chair, and 1 desk would produce four request items on a single request.

Shopping cart screens

The shopping cart screen displays previews of the cart immediately before an order is placed.

You can configure the layout for either the one-step or two-step catalog checkout process.

Order status screens

The order status screen is the final summary screen a user sees in the service catalog after placing an order successfully.

Place an order

When a customer orders something from the catalog, a request is generated to keep track of the order.
If a service catalog request is canceled, all associated purchase orders and transfer orders that have not been received are canceled.

Each individual catalog item that is part of a request creates a discrete request item with the request. For example, a request for 2 PCs, 1 Chair, and 1 Desk would produce:

- Request REQ00010002
  - Requested item RITM0000001 -- 2 X PC
  - Requested item RITM0000002 -- 1 X Chair
  - Requested item RITM0000003 -- 1 X Desk

To place requests in bulk:

1. Create a Service Catalog request.
2. On the checkout page, enter the users for whom to copy the request, up to a maximum of 10, in the **Copy this Request for:** reference fields.
Order Status

Summary
Your request number is **REQ10002**, which you can use to refer to this request in future interactions with the service desk.

You may also bookmark the following link to get back to **REQ10002**.

Note that clicking on the bookmark link (above) will simply take you back to this screen.

<table>
<thead>
<tr>
<th>Description</th>
<th>Delivery Date</th>
<th>Stage</th>
<th>Price (ea.)</th>
<th>Qty</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loaner Laptop (T42)</td>
<td>2009-08-05</td>
<td>+</td>
<td>£0.00</td>
<td>1</td>
<td>£0.00</td>
</tr>
<tr>
<td>IBM Thinkpad X60</td>
<td>2009-08-10</td>
<td>+</td>
<td>£1,763.36</td>
<td>1</td>
<td>£1,763.36</td>
</tr>
</tbody>
</table>

Total: £1,763.36

Delivery Information
Estimated Delivery Date of Complete Order: **2009-08-10**

Catalog

Copy this Request for:
- Asset Manager
- ITIL User
- System Administrator

Order Now
3. Click Order Now.

**View audit history**

To view the audit history of a variable:

1. Navigate to **Self-Service > Requested Items**.
2. Open a requested item to display the Requested Item form.
3. For the purpose of demonstration, change the value of a service catalog variable inside the item.
4. Right-click the header bar and select **History > List**.
5. The Record History form contains a related list detailing all changes to the requested item, including all variables.

   **Note:**
   Audits of variables are prefixed with "VARIABLE:"

**Service Catalog item designer**

The Service Catalog item designer enables non-administrators to create, maintain, and publish catalog items.

The catalog item designer uses a structured design and publishing process to ensure consistency of usage. The item designer is best suited to manage items that have basic questions, approvals, and tasks.

   **Note:** To create and manage more complex items, use the service catalog features for creating items.

**Process flow for catalog item design**

- Administrators or catalog administrators set up the design environment to enable a controlled item design process, and process category requests.
- Catalog managers request categories, then manage their categories.
- Catalog managers and catalog editors create, edit, and publish catalog items within their categories.

**Service Catalog roles**

The catalog item designer roles are:

<table>
<thead>
<tr>
<th>Role Title [Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator [admin]</td>
<td>Can set up the catalog item designer environment and process requests for categories. Can also perform other service catalog management functions.</td>
</tr>
<tr>
<td>Catalog administrator [catalog_admin]</td>
<td></td>
</tr>
<tr>
<td>Catalog Item Designer [catalog_item_designer]</td>
<td>Can view the status of their category requests.</td>
</tr>
<tr>
<td>Role Title [Name]</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Catalog Manager [catalog_manager]</td>
<td>Can view and assign catalog editors to their categories. Can also create, modify, and publish items within their categories.</td>
</tr>
<tr>
<td>Catalog Editor [catalog_editor]</td>
<td>Can create, modify, and publish items within categories they are assigned to.</td>
</tr>
</tbody>
</table>

Catalog item designer administration

Administrators and catalog administrators can control the options available to catalog managers and catalog editors who use the catalog item designer.

These control options include defining question types, approval types, and task assignment types. You can restrict these options to ensure that items are designed consistently and with few variations, or expand them to enable greater design flexibility.

You can also process category creation requests and view or modify definitions of notifications used by the catalog item designer.

Process Flow

The catalog item designer uses the records in three distinct areas for creating, publishing, and requesting items:

1. **Creating** The catalog item designer uses staging records for items that are being created, with staging records for any associated questions, approvals, and tasks. For example, a staging Item [sc_ic_item_staging] record can have associated staging Approval [sc_ic_aprvl_defn_staging] records. These records are staging only, and not available for order within the Service Catalog.

2. **Publishing** A published item is available within the Service Catalog to be requested. When item editors publish an item, the following actions occur:
   - Staging items create or update the equivalent catalog items.
   - Questions are copied into variables on that catalog item.
   - Associated approvals and tasks are copied into equivalent published tables. For example, Approval [sc_ic_aprvl_defn_staging] records are copied to equivalent Approval Definition [sc_ic_aprvl_defn] records for the item.

3. **Requesting** Requested items and associated records are created when a published catalog item is ordered. When a self-service user requests a catalog item:
   - A requested item is generated based on the last-published item and the last-published versions of any variables used by that item.
   - Associated approvals and tasks are copied from the published records into equivalent requested item tables. For example, Approval Definition [sc_ic_aprvl_defn] records are copied to equivalent Approval Definition (Requested Item) [sc_ic_req_item_aprvl_defn] records.

Process flow for administering catalog item designer

1. A user requests a category, either requesting to become the manager of that category, or assigning another user as the category manager.
a. An administrator or catalog administrator processes that request, creating the category with a selected category manager.

b. [Optional] The category manager assigns catalog editors to a category they manage.

2. Category managers and catalog editors can use the catalog item designer to:
   a. Create new items within a category they are assigned to.
   b. Create questions, approvals, tasks, and sections, for the item.
   c. Publish items to the category after review.

3. Self-service users can use the service catalog to request items in the category, like any service catalog item.

Define question types

Question types define the options available to catalog editors or catalog managers when they define questions for a catalog item.

You can modify question types, expanding or restricting the list of types available, to meet requirements for your organization's design environment. For example, you can deactivate date-based question types.

Note: This list of available question types is also used when you create a new service in service creator. For example, if you deactivate Multi Line Text, it is deactivated for both the catalog item designer and the service creator.

To create or modify a question type:

1. Navigate to Item Designer > Administration > Question Types.
2. Click New or open an existing question type.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The question type name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Question class | The base variable type to use as the class for this question type. The most common variable types are available, but some complex types, such as macros, are available only when you use the Catalog Item form. The following classes are available:  
  - Checkbox  
  - Date  
  - Date/Time  
  - Label  
  - Multi Line Text  
  - Multiple Choice  
  - Numeric Scale  
  - Reference  
  **Note:** Reference fields are only available as preconfigured questions. If you set the question class to Reference, the Preconfigured Question check box is automatically selected and made read-only.  
  - Select Box  
  - Single Line Text  
  - Yes / No |
| Order        | The sequence this question type appears in.                                                                                                                      |
| Active       | A check box to indicate whether the question type is active or not. Clear this check box to deactivate a question type, so that it cannot be used when creating a new question or a new service.  
  **Note:** Deactivating a question type that is in use does not affect catalog items that are already using that question type. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preconfigured question</td>
<td>A check box to indicate whether users can select this as a preconfigured question type when defining a question. This is checked by default, and only one active non-preconfigured question type is available per question class. Some preconfigured question types are provided by default, such as a list of users. If Preconfigured Question is checked, the Read only, Question, Help text, and Default value fields also appear. Depending on the question class, additional fields may also appear to define variable attributes for that class. For example, if you select a preconfigured question type based on the Multiple Choice question class, the Question Type Choices field appears, allowing you to select the choices available for that question type.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the question type.</td>
</tr>
<tr>
<td>Read only</td>
<td>Whether the question type can be selected or not. Appears if Preconfigured Question is checked.</td>
</tr>
<tr>
<td>Question</td>
<td>The question itself, as displayed. Appears if Preconfigured Question is checked.</td>
</tr>
<tr>
<td>Help text</td>
<td>Help text to appear with the question. Appears if Preconfigured Question is checked.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value for the question. Appears if Preconfigured Question is checked.</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.

Define approval types

Approval types are available to catalog editors or catalog managers when they define approvals for an item.

For example, you can define Facilities Items Approvers, a specific list of approvers for facilities items.

To create a new approval type:

1. Navigate to Item Designer > Administration > Approval Type Definitions.
2. Click New.
3. Fill in the fields, as appropriate.

**Table 208: Approval Type form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name for the approval type.</td>
</tr>
<tr>
<td>Version</td>
<td>[Read-Only] The version of the approval type. The version number gets incremented whenever you save a change to that type.</td>
</tr>
<tr>
<td>State</td>
<td>[Read-Only] The approval type state. It is initially set to Draft. When you publish the approval type, the state changes to Published.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the approval type.</td>
</tr>
<tr>
<td>Type</td>
<td>The method for approving items that use the approval type. Can be User, Group or Script. This selection determines which other fields are available.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User(s)</td>
<td>The individual users who can approve catalog items that use this approval type. This field is available only if the Type is set to User.</td>
</tr>
<tr>
<td>Group(s)</td>
<td>The groups who can approve catalog items that use this approval type. This field is available only if the Type is set to Group.</td>
</tr>
<tr>
<td>Script output</td>
<td>The end result of the script, creating either a set of users or groups. This field is available only if the Type is set to Script.</td>
</tr>
<tr>
<td>Approver script</td>
<td>A script to define that approval type, such as a script to define the requester's manager. This field is available only if the Type is set to Script.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Publish approval types

Publish an approval type after it is defined correctly for catalog editors or catalog managers to use when they create items.

- To publish an approval type, navigate to Item Designer > Administration > Approval Type Definitions, open an entry, then click Publish.
- To view a list of published approval types, navigate to Item Designer > Administration > Published Approval Type Definitions.

Change approval types

Service catalog enables you to change the details of an approval type.

- To change details for an approval type, navigate to Item Designer > Administration > Approval Type Definitions, open an entry, then edit the details and save your changes.

  Note: After you save your changes, the version number for that approval type increases by 1.

- To make your changes live, publish the changed approval type.

Expire approval types

To remove an approval type from use, you can expire it, making it inactive.

To expire an approval type, navigate to Item Designer > Administration > Approval Type Definitions, open an entry, then click Expire.

Define task assignment types

Task assignment types define the assignment options available to catalog editors and catalog managers when they define tasks for an item.

When a user then requests that item, these assignment options determine which users are assigned to complete these tasks. For example, you can use information the user enters when requesting an item to dynamically assign a task to the requester’s on-call IT support contact.
To create a new assignment type:

1. Navigate to **Item Designer > Administration > Task Assignment Definitions**.
2. Click **New**.

3. Fill in the fields as appropriate.

### Table 209: Task Assignment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief summary of the task assignment type.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer description of the task assignment type.</td>
</tr>
<tr>
<td>Active</td>
<td>[Read Only] A check box that indicates whether the task assignment type is active or not. To deactivate a task assignment type, expire it.</td>
</tr>
<tr>
<td>Assignment type</td>
<td>The type of assignment. Set to <strong>Direct assignment</strong> to define users or groups explicitly, or <strong>Scripted assignment</strong> to calculate assignments dynamically using a script.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>The state of the task definition. Set to Draft if the record is being created or modified, or Published if the task assignment type is published.</td>
</tr>
<tr>
<td>Group</td>
<td>The group to assign to tasks that use this assignment type. This field is available only if the Assignment type is set to Direct assignment.</td>
</tr>
<tr>
<td>User</td>
<td>The specific user to assign to tasks that use this assignment type. This field is available only if the Assignment type is set to Direct assignment.</td>
</tr>
<tr>
<td>Assignment script</td>
<td>A script to determine who should perform tasks that use this assignment type. This field is available only if the Assignment type is set to Scripted assignment. For example, a script to identify the requester's on-call support team as the group to assign.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Publish task assignment types

You can publish task assignment types after defining them.

- To change details for a task assignment type, navigate to Item Designer > Administration > Task Assignment Definitions, open an entry, then edit the details and save your changes.

  **Note:** After you save your changes, the version number for that task assignment type increases by 1.

- To make your changes live, publish the changed task assignment type.

Change task assignment types

Service catalog enables you to change the details of a task assignment type.

- To change details for a task assignment type, navigate to Item Designer > Administration > Task Assignment Definitions, open an entry, then edit the details and save your changes.

  **Note:** After you save your changes, the version number for that task assignment type increases by 1.

- To make your changes live, publish the changed task assignment type.

Expire task assignment types

To remove an assignment type from use, you can expire it, making it inactive.

To expire an assignment type, navigate to Item Designer > Administration > Task Assignment Definitions, open an entry, then click Expire.
Process category requests

Any self-service user can submit a request to create a catalog category. Administrators and catalog administrators review category creation requests and approve or reject them. For example, you might reject a request if it duplicates an existing category.

1. Navigate to Item Designer > Administration > All Category Requests.
2. Open a category request.
3. Perform one of the following actions:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To approve the request:</strong></td>
<td>Click <strong>Create Category</strong>. The category is created, the nominated category manager receives an email notification, and is granted the catalog manager role for that category. The category manager can then manage the new category.</td>
</tr>
<tr>
<td><strong>To reject the request:</strong></td>
<td>Click <strong>Reject</strong>. Category request rejections cannot be reversed. To create a new category, the original requester must submit a new request.</td>
</tr>
</tbody>
</table>

View notifications

You can list definitions of notifications sent to users who request a category.

Navigate to **Item Designer > Administration > Notifications**.

![Notification screen](image)

**Figure 130: Notifications**

By default, the following three notification definitions are active:

- **Item Designer Category Request Opened** An acknowledgement after a self-service users submits a request for a new category.
- **Item Designer Category Rejected** A message indicating that a request for a new category is rejected.
• **Item Designer Category Published** A message indicating that a request for a new category is approved, with a link to the new category.

You can modify these definitions as required, using standard email notification functions.

**View all items**

To view all items:

1. Navigate to **Item Designer > Administration > All Items** to view a list of all catalog items created using the item designer.
2. Click an item name to view and edit details for that item.

**Catalog item designer for end users**

Category managers, users with the catalog_manager role, can use the catalog item designer to manage their categories, assign editors to those categories, and create, modify, and publish catalog items.

For example, a facilities team leader can manage a Facilities category. Catalog editors can use the catalog item designer to create, modify and publish items within their categories. For example, facilities team members can create, edit, and publish items within the Facilities category.

**Note:** You can only manage standard catalog items [sc_cat_item] using the catalog item designer, not more complex items such as order guides. In addition, UI policies and client scripts are not supported by the item designer. To implement these more advanced functions, use the service catalog features for creating items.

**Process flow for using catalog item designer**

1. A user requests a category, either requesting to become the manager of that category, or assigning another user as the category manager.
   a. An administrator or catalog administrator processes that request, creating the category with a selected category manager.
   b. [Optional] The category manager assigns catalog editors to a category they manage.

2. Category managers and catalog editors can use the catalog item designer to:
   a. Create new items within a category they are assigned to.
   b. Create questions, approvals, tasks, and sections for the item.
   c. Publish items to the category after review.

3. Self-service users can use the service catalog to request items in the category, like any service catalog item.

**Request a category**

Self-service users can request a new category within a service catalog.

For example, a facilities team leader responsible for managing office furniture could request a new category of Office Furniture Requests, within the Facilities catalog.
To request a category:

1. Navigate to **Self-Service > Service Catalog**.
2. Select the **Can We Help You? > Item Designer Category Request** item.
3. Fill in the request form.
Request a category that you can use to create your own catalog items

Item Designer category requests allow you to request a new category within the catalog. Once created, you will be able to create and publish items that allow users to request products and services.

For each item, you will be able to define:

- the questions the user must complete to submit the request
- approvals that must be completed for the request to progress to fulfillment
- at least 1 task that will be used to fulfill the request

By filling out this request, you or your designate will be the manager of the item designer category. You can also assign editors who will also have permission to create/update items within this category.

Once this request is fulfilled and the category is created, you will be notified via email and sent a link to begin creating your items.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>Choose the catalog your new category will appear in</td>
</tr>
<tr>
<td>Name</td>
<td>Name of your new category (e.g. Database Support)</td>
</tr>
<tr>
<td>Manager</td>
<td>Category manager (you, or your designate)</td>
</tr>
<tr>
<td>Description</td>
<td>Category Description</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments</td>
</tr>
</tbody>
</table>

Submit
4. Click *Submit.*
   The catalog request record state is set to Requested, and you are granted the catalog item designer role so you can view the status of the request.

5. Log out from your ServiceNow instance, then log back in again, to ensure you have activated this role in your account.

6. Navigate to *Item Designer > My Item Categories* to view the status of the request.

**Manage a category**

After an administrator approves a category request, the category is immediately created with the selected category manager.

New categories are created as active, available to display in the selected catalog. Categories with no items are not displayed in the catalog.

- Navigate to *Item Designer > My Item Categories* to view and edit categories you manage. Click the category number to open that category.
To assign editors to a category, select users in the Editors field of the relevant category form, then click Update.

To deactivate a category, click Deactivate. The category is then no longer visible in the service catalog.

To reactivate a category, reopen the category form and click Activate.
Category managers can also create and manage items in their categories, and publish items to make them available to users.

Create an item

Category managers and catalog editors can create items using the item designer.

1. Navigate to Item Designer > Create New.
2. Fill in the fields as appropriate.

### Table 210: Designer view

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the item.</td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>[Read-Only] The state of the item. Initially the state is set to Draft. When you publish the item, the state changes to Published.</td>
</tr>
<tr>
<td><strong>Details section</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Availability</strong></td>
<td>The interface where this item is available. Choose from Desktop and Mobile, Desktop Only, or Mobile only.</td>
</tr>
<tr>
<td><strong>Catalogs</strong></td>
<td>The catalogs the item should be published to.</td>
</tr>
<tr>
<td><strong>Categories</strong></td>
<td>The categories the item should be published to within the selected catalogs.</td>
</tr>
<tr>
<td><strong>Short Description</strong></td>
<td>A brief description of the item.</td>
</tr>
<tr>
<td><strong>Desktop image</strong></td>
<td>An image of the item. This field is available only if Availability is set to either Desktop Only or Desktop and Mobile.</td>
</tr>
<tr>
<td><strong>Mobile image</strong></td>
<td>An image of the item for the smartphone interface. This field is available only if Availability is set to either Mobile Only or Desktop and Mobile.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>A full description of the item. This description appears in the catalog when a user selects the item or clicks the associated More Information link.</td>
</tr>
<tr>
<td><strong>Costs section</strong></td>
<td></td>
</tr>
<tr>
<td><strong>One off cost</strong></td>
<td>The price for the item and the currency for that price.</td>
</tr>
<tr>
<td><strong>Recurring cost</strong></td>
<td>A price that occurs repeatedly at a regular interval. For example, a printer maintenance service could have a $100.00 monthly recurring price.</td>
</tr>
<tr>
<td><strong>Recurring cost frequency</strong></td>
<td>The time frame when the cost recurs. Select a frequency, such as Monthly or Quarterly, if you enter a value in the Recurring cost field.</td>
</tr>
</tbody>
</table>

3. Click **Next** to save the record.

4. Under **Related Links**, click the appropriate link to add questions, approvals, sections, or tasks for the item.

*Define an item question*
Item questions appear in the catalog when a user requests the item.
The user answers the questions to provide the information needed to fulfill the request. For example, a request for a new laptop might have a multiple choice question to specify the screen size, allowing the requester to select one of a set of options.

You can organize questions into sections, to provide a logical flow for a multi-question item. If you plan to use sections, consider creating the sections so that you can select the appropriate section when defining the questions.

To add a question:

1. On the Item form, click the Add a Question related link.
### Add Question

Use questions to gather the information you need from your customers. You can choose the format you want to receive the answers in. Select a question Type and use Options to see any standard questions already created by your administrator. A simple single column layout will be automatically created, however you can also design the layout of your questions using Sections and Columns.

<table>
<thead>
<tr>
<th>Type</th>
<th>Single Line Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>-- Create your own Single</td>
</tr>
<tr>
<td><strong>Section</strong></td>
<td><strong>Column</strong></td>
</tr>
<tr>
<td>Question</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>1</td>
</tr>
<tr>
<td>Default value</td>
<td></td>
</tr>
<tr>
<td>Help text</td>
<td></td>
</tr>
</tbody>
</table>

**Submit**
2. Fill in the fields, as appropriate.

Table 211: Add question

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type for the question, defining the format you would like to receive the information in. By default, the options are Checkbox, Date, Date/Time, HTML, Multi Line Text, Multiple Choice, Numeric Scale, Reference, Select Box, Single Line Text, or Yes/No. Each type allows you to create your own option, using the Option field. Administrators and catalog administrators determine the question types available.</td>
</tr>
<tr>
<td>Option</td>
<td>The standard questions available within the selected question type, as set by the value of the Type field. By default, all question types contain Create your own &lt;type&gt; as an option, allowing you to define your own question of that type. These types may contain additional fields, allowing you to further define the question options. For example, Create your own Numeric Scale allows you to define Scale Min and Scale Max values. Some types also have additional preconfigured options available. By default, the following extra options are available: • Comments: allow the user to enter a short message. Available if the Type is Multi Line Text. • Contact preference: ask the user to select their preferred contact method: email, telephone, or SMS. Available if the Type is Multiple Choice. • Configuration item: allow the user to select a single configuration item from those defined in the system. Available if the Type field is Reference. • Active user: allow the user to choose from a list of active user records. Available if the Type is Reference. Administrators and catalog administrators define the options available for each question type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mandatory</td>
<td>A check box to indicate whether users are required to provide an answer before they can submit the request. Only available for some question types.</td>
</tr>
<tr>
<td>Read only</td>
<td>A check box for indicating whether the question is read only. Only available for some question types.</td>
</tr>
<tr>
<td>Section</td>
<td>The section this question appears in. Sections allow you to group questions logically. Choose from the sections that have already been defined for the item.</td>
</tr>
<tr>
<td>Column</td>
<td>The column this question appears in within the selected section. Fields appear in the left column by default, but can be moved to a right column.</td>
</tr>
<tr>
<td>Question</td>
<td>The text of the question.</td>
</tr>
<tr>
<td>Order</td>
<td>The numeric sequence for the question. Questions appear in the selected column in the order defined here.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default answer for the question, if any. Only available for some question types.</td>
</tr>
<tr>
<td>Help text</td>
<td>Text that helps the user decide how to answer this question. Help text appears under the More information link below the question.</td>
</tr>
<tr>
<td>Question Choices</td>
<td>The choices a user can choose for answering the question. Double-click on the row to add an entry to the list. This field appears only for question types which have choices, such as Multiple Choice.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.  
   The new question is added to the **Questions** related list.

4. To edit a question, open it from the related list.

*Define an item approval*

An approval for an item identifies a user or group that must approve each request for this item.

An approval for an item identifies a user or group that must approve each request for this item. All listed approvers must approve this request for it to be fulfilled; a rejection halts the process immediately. For example, you could define approvers for a facilities item to be the facility management team.

Users can view their open approvals by navigating to **Self-Service > My Approvals**, or by opening the requested item and viewing the approval in the **Group approvals** related list.
To add an approval to an item:

1. On the Item form, click the Add an Approval related link.

2. Fill in the fields, as appropriate (see table).

3. Click Submit.

   The new approval is added to the Approvals related list.

4. To edit an approval, open it from the related list.
Table 212: define an item approval

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>A check box for indicating whether this approval is active.</td>
</tr>
<tr>
<td>Order</td>
<td>The sequence in which the approvals are requested. Approvals are only created when any approvals with lower order numbers are completed. For example, if Approval 1 has order 100 and Approval 2 has order 150, Approval 2 is only created when Approval 1 is completed. If multiple approvals have the same order number they are requested at the same time.</td>
</tr>
<tr>
<td>Type</td>
<td>The approval type. Set to User for a specific user, Group for a specific group, or Predefined Approval to select approvers from a predefined list.</td>
</tr>
<tr>
<td>User</td>
<td>A specific user to be the approver. Appears if the approval type is set to User.</td>
</tr>
<tr>
<td>Group</td>
<td>A specific group to be the approver. Appears if the approval type is set to Group. The first group member who responds to the approval request responds for the entire group.</td>
</tr>
<tr>
<td>Predefined</td>
<td>A check box allowing you to select an approval type created by the administrator or catalog administrator. Appears if the approval type is set to Predefined. For example, if you select the default predefined approval of Requester’s Manager, the approval is sent to the manager of the person who requests the item.</td>
</tr>
</tbody>
</table>

Define an item task
Item tasks describe the work required to fulfill a request for an item.

Item tasks are generated as standard catalog tasks when an item is ordered, like the tasks generated by workflows. Tasks are assigned to users or groups as part of the fulfillment process when that item is ordered. For example, an item to request a new laptop could have a task to deliver the laptop to the user.

Users can view their open tasks by navigating to Service Catalog > Open Records > Tasks, or can open the requested item and view the task in the Catalog Tasks related list.

To add a task to an item:

1. On the Item form, click the Add a Task related link.
Add Task

Tasks will be created after any approvals have been successfully processed. Select who will be assigned the task from the following options:

- User specified
  - The group and/or user that the task will be assigned to
- Predefined
  - Additional options that have been defined by your administrator

Use the Order field to choose the sequence in which tasks will be created in relation to other tasks. If multiple tasks have the same Order number, they will be created at the same time so that the tasks can be worked in parallel.

Assignment: User specified

Active: ✓

Order: 100

The Short description and Description fields will be displayed in the task. These should be used to describe the steps required to complete the task.

Short description

Description

Submit
2. Fill in the fields, as appropriate (see table).
3. Click **Submit**.

The new task is added to the **Tasks** related list.
4. To edit a task, open it from the related list.

### Table 213: Add task

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description of the task.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description that provides details and instructions for the people performing the task.</td>
</tr>
<tr>
<td>Assignment</td>
<td>The assignment type. Select <strong>User specified</strong> to select your own assignment options, or <strong>Predefined</strong> to select from predefined task assignment definitions set by an administrator.</td>
</tr>
<tr>
<td>Group</td>
<td>The group to perform the task. Appears if the assignment is set to <strong>User specified</strong>.</td>
</tr>
<tr>
<td>User</td>
<td>The user to perform the task. Appears if the assignment is set to <strong>User specified</strong>. If you select a group first, only users from that group are available in the <strong>User</strong> selection list.</td>
</tr>
<tr>
<td>Assign to</td>
<td>A predefined assignment option. Appears if <strong>Assignment</strong> is set to <strong>Predefined</strong>. Select from the <strong>task assignment types</strong> created by the administrator or catalog administrator. Assignment types commonly base the task assignment on information provided with the request. For example, if you select <strong>Local database team for the requestor</strong>, the system assigns the task to someone from the designated team.</td>
</tr>
<tr>
<td>Order</td>
<td>The sequence in which tasks are created. Tasks are only created when any tasks with lower order numbers are completed. For example, if Task 1 has order 100 and Task 2 has order 150, Task 2 is only created when Task 1 is completed. If multiple tasks have the same order number, they are created at the same time, so the tasks can be performed at the same time.</td>
</tr>
</tbody>
</table>
Define an item section

You can add sections to organize the questions into logical groups, each with its own heading, which can streamline the request process.

For example, an item to request a new laptop could have sections for the laptop's hardware specifications and software requirements.

You can add sections to organize the questions into logical groups, each with its own heading, which can streamline the request process. For example, an item to request a new laptop could have sections for the laptop's hardware specifications and software requirements.

Add the sections before you add the questions to simplify the layout process.

1. On the Item form, click the **Add a Section** related link.

2. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>The section title that describes the type of questions in the section. For example, you can define sections such as <strong>User Details</strong>.</td>
</tr>
<tr>
<td>Position</td>
<td>A number indicating the vertical position of the section. Position 1 shows at the top, position 2 is below that, and so on.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
The new section is added to the Sections related list.

4. To edit a section, open it from the related list. By default, a single two-column section is created for each item.

Publish an item

When you publish an item, it is available in the catalog for ordering.

When you create an item, it is in a Draft state. You can review the item, make changes, and refine the layout as many times as needed to get the details exactly right.

When the item is ready, a category manager or catalog editor can publish it, making it available as a catalog item in the service catalog.

To publish an item:
1. Navigate to Item Designer > Administration > All Items.
2. Open the item record.
3. Click Publish.

The item is now a live catalog item, available for ordering.

Republish an item

Each time you make changes to an item, you must republish it in order for the changes to reflect in the item catalog.

If you make and save the changes to an item in the Item Designer > Administration > All Items module, the item state returns to Draft. The live catalog item remains available to order, but does not have the changes you made. This enables you to make changes to the item in a staging area, then apply those changes to the live catalog item after review.

To apply your changes, republish the item:
- Navigate to Item Designer > Administration > All Items, open the item record, then click Publish.

Unpublish an item

When you unpublish an item, it is removed from the service catalog.

Navigate to Item Designer > Administration > All Items, open the item record, and select Unpublish.

The item is then inactive within the service catalog, but remains available for editing and republishing. This is useful if you do not want customers to order the catalog item while you are making changes.

Expire an item

When you expire an item, it is removed from both the service catalog and the item designer.

Navigate to Item Designer > Administration > All Items, open the item record, and select Expire.

The item is removed from the list of active items, and cannot be edited or republished.

View a published item

Service catalog enables you to view the list of published items.

Navigate to Item Designer > Published Items to view a list of published catalog items.

It is best not to edit an item record from the Published Items module. This directly accesses that catalog item using standard service catalog functions, not the catalog item designer, losing the benefits of the controlled publishing environment.
For example, if you copy an item, the copied catalog item is not listed in the Published Items module. To access this copy, navigate to Service Catalog > Catalog Definition > Maintain Items and locate the item named Copy of [item name]. The copied item is an active catalog item. Consider deactivating it by clearing the Active check box until your changes are complete.

Create a new item version
If you alter a question associated with an item, then you can republish the item.

The system may need to create a new version of the item and deactivate the previous version to ensure that items currently being requested are not affected by these changes. For example, if you change the default value of a question associated to an item, a new version of that item is automatically created when the changed item is published.

As a result, you may see multiple records with the same item name in the Catalog Item Table [sc_cat_item] when viewing all items. The published version of the item is the only active one.

Installed with catalog item designer
The catalog item designer adds or modifies tables, user roles, script includes, and other components. Demo data is available with the catalog item designer.

Tables installed with catalog item designer

### Tables

The catalog item designer adds the following tables.

<table>
<thead>
<tr>
<th>Display Name [Table Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requesting Item Designer Category Request [sc_ic_category_request]</td>
<td>Requests made by users for a new category.</td>
</tr>
<tr>
<td>Item [sc_ic_item_staging]</td>
<td>Item definitions, used when designing the item.</td>
</tr>
<tr>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Approvals for items.</td>
</tr>
<tr>
<td>Approval Definition [sc_ic_aprvl_defn]</td>
<td>Approvals for catalog items.</td>
</tr>
<tr>
<td>Approval Definition (Requested Item) [sc_ic_req_item_aprvl_defn]</td>
<td>Approvals for requested items.</td>
</tr>
<tr>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Approval types for items.</td>
</tr>
<tr>
<td>Approval Type Definition [sc_ic_aprvl_type_defn]</td>
<td>Approval types for catalog items and requested items.</td>
</tr>
<tr>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>Task assignment types for items.</td>
</tr>
<tr>
<td>Task Assignment Definition [sc_ic_task_assign_defn]</td>
<td>Task assignment types for catalog items and requested items.</td>
</tr>
<tr>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Tasks for items.</td>
</tr>
<tr>
<td>Task Definition [sc_ic_task_defn]</td>
<td>Tasks for catalog items.</td>
</tr>
<tr>
<td>Task Definition (Requested Item) [sc_ic_req_item_task_defn]</td>
<td>Tasks for requested items.</td>
</tr>
<tr>
<td>Display Name [Table Name]</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Question [sc_ic_question]</td>
<td>Questions for items. Stored as Variables [sc_item_variables_task] records for catalog items and requested items.</td>
</tr>
<tr>
<td>Question Choice [sc_ic_question_choice]</td>
<td>Choices if the question is a choice type (select box, multiple choice or checkbox).</td>
</tr>
<tr>
<td>Question Class [sc_ic_question_class]</td>
<td>Base variable types to use as the class for a question type.</td>
</tr>
<tr>
<td>Question Type [sc_ic_question_type]</td>
<td>Question types for items.</td>
</tr>
<tr>
<td>Question Type Choice [sc_ic_question_type_choice]</td>
<td>Choices if the question type is a choice type (select box, multiple choice or checkbox).</td>
</tr>
</tbody>
</table>

Table relationships installed with catalog item designer

Some equivalent information is stored as records in different tables in creating, publishing, or requesting areas to provide a controlled environment for item design.

For example, catalog items are stored as Item [sc_ic_item_staging] records in the creating area, as Catalog Item [sc_cat_item] records in the publishing area, and as Requested item [sc_req_item] records in the requesting area.

This table illustrates the relationships for these records.

<table>
<thead>
<tr>
<th>Creating</th>
<th>Publishing</th>
<th>Requesting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Task Definition [sc_ic_task_defn]</td>
<td>Task Definition (Requested Item) [sc_ic_req_item_task_defn]</td>
</tr>
<tr>
<td>Item [sc_ic_item_staging]</td>
<td>Catalog item [sc_cat_item]</td>
<td>Requested item [sc_req_item]</td>
</tr>
<tr>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Approval Definition [sc_ic_aprvl_defn]</td>
<td>Approval Definition (Requested Item) [sc_ic_req_item_aprvl_defn]</td>
</tr>
<tr>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Approval Type Definition [sc_ic_aprvl_type_defn]</td>
<td></td>
</tr>
<tr>
<td>Question [sc_ic_question]</td>
<td>Variables [sc_item_variables_task]</td>
<td></td>
</tr>
<tr>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>Task Assignment Definition [sc_ic_task_assign_defn]</td>
<td></td>
</tr>
</tbody>
</table>

User roles installed with catalog item designer

The catalog item designer adds the following user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>catalog_editor</td>
<td>catalog</td>
<td>Can create, modify, and publish items within categories they are assigned to.</td>
</tr>
<tr>
<td>catalog_item_designer</td>
<td>none</td>
<td>Can view the status of their category requests.</td>
</tr>
<tr>
<td>Role</td>
<td>Contains Roles</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>catalog_manager</td>
<td>none</td>
<td>Can request a category, view and assign catalog editors to their categories, and create, modify, and publish items within their categories.</td>
</tr>
</tbody>
</table>

UI policies installed with catalog item designer

The catalog item designer adds the following UI policies.

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow category entry</td>
<td>Item [sc_ic_item_staging]</td>
<td>Allow category entry only if a catalog is selected.</td>
</tr>
<tr>
<td>Show Mobile Image</td>
<td>Item [sc_ic_item_staging]</td>
<td>Make the mobile image field visible if availability is set to Both Desktop and Mobile or Mobile Only.</td>
</tr>
<tr>
<td>Show Desktop Image</td>
<td>Item [sc_ic_item_staging]</td>
<td>Make the desktop image field visible if availability set to Both Desktop and Mobile or Desktop Only.</td>
</tr>
<tr>
<td>Show Published Item</td>
<td>Item [sc_ic_item_staging]</td>
<td>Show the catalog item if the staged item is published.</td>
</tr>
<tr>
<td>Hide Item field on Item Designer - Approval view</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Hide the catalog item field from the item designer approval view.</td>
</tr>
<tr>
<td>Show &quot;User&quot; field when Type=User</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Make the user field visible and mandatory if a user approval is selected.</td>
</tr>
<tr>
<td>Show &quot;Group&quot; field when Type=Group</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Make the group field visible and mandatory if a group approval is selected.</td>
</tr>
<tr>
<td>Show &quot;Predefined approval&quot; field when Type=predefined_approval</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Make the Predefined approval field visible if a predefined approval is selected and the predefined type is selected.</td>
</tr>
<tr>
<td>Show Predefined approval description when appropriate</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Make the predefined approval description visible and mandatory if a predefined approval is selected.</td>
</tr>
<tr>
<td>Show &quot;User(s)&quot; field when Type=User</td>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Make the User(s) field visible and mandatory if a user approval is selected.</td>
</tr>
<tr>
<td>Show &quot;Group(s)&quot; field when Type=Group</td>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Make the Group(s) field visible and mandatory if a group approval is selected.</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show &quot;Script&quot; fields when Type=Script</td>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Make the <strong>Script output</strong> and <strong>Approver script</strong> fields visible if a script approval is selected.</td>
</tr>
<tr>
<td>Show published information</td>
<td>Approval Type [sc_ic_aprvl_type_defn_staging]</td>
<td>Make the approval definition and approval definition version visible if the published definition is not empty.</td>
</tr>
<tr>
<td>Show assignment type fields</td>
<td>sc_ic_task_assign_defn_staging</td>
<td>Make the Assignment type field visible if it is a direct assignment.</td>
</tr>
<tr>
<td>Show published assignment definition</td>
<td>sc_ic_task_assign_defn_staging</td>
<td>Make the published assignment definition visible if the published definition is not empty.</td>
</tr>
<tr>
<td>Show custom assignment fields</td>
<td>sc_ic_task_defn_staging</td>
<td>Make the <strong>User(s)</strong> and <strong>Group(s)</strong> fields visible if the assignment has a user specified.</td>
</tr>
<tr>
<td>Hide Item field</td>
<td>sc_ic_task_defn_staging</td>
<td>Hide the Item field if the item is not empty.</td>
</tr>
<tr>
<td>Hide meta fields</td>
<td>sc_ic_question</td>
<td>Hide fields used by underlying logic, but not requiring user input.</td>
</tr>
<tr>
<td>Hide Mandatory</td>
<td>sc_ic_question</td>
<td>Hide field if type is <strong>checkbox</strong> or <strong>label</strong>.</td>
</tr>
<tr>
<td>Show default value</td>
<td>sc_ic_question</td>
<td>Show default values, depending on the type of variable selected.</td>
</tr>
<tr>
<td>Numeric Scale type fields</td>
<td>sc_ic_question</td>
<td>Show numeric scales: <strong>Maximum</strong> and <strong>Minimum</strong> if the preconfigured variable type <strong>Number</strong> is selected.</td>
</tr>
<tr>
<td>Show Choices related list when appropriate</td>
<td>sc_ic_question</td>
<td>Show the Choices related list if the variable type <strong>Multiple Choice</strong> or <strong>Select Box</strong> is selected.</td>
</tr>
<tr>
<td>Hide Read Only</td>
<td>sc_ic_question</td>
<td>Hide the Read only field if the variable type <strong>Label</strong>, <strong>Date</strong> or <strong>Date/Time</strong> is selected.</td>
</tr>
<tr>
<td>Read only question type</td>
<td>sc_ic_question</td>
<td>Hide field if the variable type <strong>Read only</strong> is selected.</td>
</tr>
<tr>
<td>Hide Item field on Item Designer - Question view</td>
<td>sc_ic_question</td>
<td>Hide Staging item field if the item is selected.</td>
</tr>
<tr>
<td>Force preconfigured Reference type fields</td>
<td>sc_ic_question_type</td>
<td>Set the value of preconfigured field to true and read-only if the variable type <strong>reference</strong> is selected.</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Choices related list when appropriate</td>
<td>sc_ic_question_type</td>
<td>Show <strong>Choices</strong> related list if the variable type <strong>Multiple Choice</strong> or <strong>Select Box</strong> is selected.</td>
</tr>
<tr>
<td>Preconfigured checkbox type fields</td>
<td>sc_ic_question_type</td>
<td></td>
</tr>
<tr>
<td>Preconfigured Reference fields</td>
<td>sc_ic_question_type</td>
<td>Show reference and reference qualifier fields if the question type is preconfigured reference type.</td>
</tr>
<tr>
<td>Preconfigured Questions</td>
<td>sc_ic_question_type</td>
<td>Show question text, read only, help text, and default value fields if the preconfigured question type is selected.</td>
</tr>
<tr>
<td>Preconfigured Numeric Scale type fields</td>
<td>sc_ic_question_type</td>
<td>Show numeric scales: <strong>Maximum</strong> and <strong>Minimum</strong> if the preconfigured variable type <strong>Number</strong> is selected.</td>
</tr>
<tr>
<td>Show &quot;Predefined Approval&quot; field when Type=predefined_approval</td>
<td>sc_ic_aprvl_defn</td>
<td>Make the <strong>Predefined Approval</strong> field visible and mandatory if no type is selected.</td>
</tr>
<tr>
<td>Show &quot;Group&quot; field when Type=Group</td>
<td>sc_ic_aprvl_defn</td>
<td>Make the <strong>Group</strong> field visible and mandatory if no type is selected.</td>
</tr>
<tr>
<td>Show &quot;User&quot; field when Type=User</td>
<td>sc_ic_aprvl_defn</td>
<td>Make the <strong>User</strong> field visible and mandatory if the user type is selected.</td>
</tr>
<tr>
<td>Show &quot;Script&quot; fields when Type=Script</td>
<td>sc_ic_aprvl_type_defn</td>
<td>Make the <strong>Script</strong> field visible and mandatory if the script type is selected.</td>
</tr>
<tr>
<td>Show &quot;User(s)&quot; field when Type=User</td>
<td>sc_ic_aprvl_type_defn</td>
<td>Make <strong>User(s)</strong> field visible and mandatory if the user type is selected.</td>
</tr>
<tr>
<td>Show &quot;Group(s)&quot; field when Type=Group</td>
<td>sc_ic_aprvl_type_defn</td>
<td>Make <strong>Group(s)</strong> field visible and mandatory if the group type is selected.</td>
</tr>
<tr>
<td>Show assignment type fields</td>
<td>sc_ic_task_assign_defn</td>
<td>Make the <strong>User(s)</strong> and <strong>Group(s)</strong> fields visible and hide the <strong>Script</strong> field if the direct assignment variable type is selected.</td>
</tr>
<tr>
<td>Custom task fields</td>
<td>sc_ic_task_defn</td>
<td>Make the <strong>User(s)</strong> and <strong>Group(s)</strong> fields visible and hide the <strong>Assignment Definition</strong> field if variable type Create my own selected.</td>
</tr>
</tbody>
</table>
Script includes installed with catalog item designer

The catalog item designer adds the following script includes.

**Note:** Many of the business rules link to these script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sc_ic_Section</td>
<td>Wrapper class for item designer question layout sections.</td>
</tr>
<tr>
<td>sc_ic_Factory</td>
<td>Entry point for all customization of the service catalog item designer script.</td>
</tr>
<tr>
<td>sc_ic_ColumnSecurityManager</td>
<td>Security manager for the sc_ic_column table.</td>
</tr>
<tr>
<td>sc_ic_QuestionSecurityManager</td>
<td>Security manager for the sc_ic_question table.</td>
</tr>
<tr>
<td>sc_ic_CatalogItemRecordProducer</td>
<td>Wrapper class for sc_cat_item_producer for the item creator.</td>
</tr>
<tr>
<td>sc_ic_Base</td>
<td>Base class for all item designer wrapper classes.</td>
</tr>
<tr>
<td>sc_ic_QuestionClass</td>
<td>Wrapper class for the Question class table (sc_ic_question_class).</td>
</tr>
<tr>
<td>sc_ic_TaskDefnStagingSecurityManager</td>
<td>Security manager for the sc_ic_task_defn_staging table.</td>
</tr>
<tr>
<td>sc_ic_SectionSecurityManager</td>
<td>Security manager for the sc_ic_section table.</td>
</tr>
<tr>
<td>sc_ic_CategoryRequest</td>
<td>Wrapper for the category request table.</td>
</tr>
<tr>
<td>sc_ic_ApprovalDefnStagingAJAX</td>
<td>Helper function which can be called from client scripts.</td>
</tr>
<tr>
<td>sc_ic_QuestionChoiceSecurityManager</td>
<td>Security manager for the sc_ic_question_choice table.</td>
</tr>
<tr>
<td>sc_ic_ApprovalDefnStagingSecurityManager</td>
<td>Security manager for staged approval definitions.</td>
</tr>
<tr>
<td>sc_ic_TaskAssignDefnStaging</td>
<td>Wrapper class for sc_ic_task_type_definition_staging.</td>
</tr>
<tr>
<td>sc_ic_TaskDefnStaging</td>
<td>Wrapper class for staged task definitions.</td>
</tr>
<tr>
<td>sc_ic_Question</td>
<td>Wrapper class for item designer questions. Subclass to modify and inject using sc_ic_Factory. See sc_ic_Factory for more information.</td>
</tr>
<tr>
<td>sc_ic_SectionAJAX</td>
<td>Service dealing with sections that can be called from client scripts.</td>
</tr>
<tr>
<td>sc_ic_CatalogTask</td>
<td>Wrapper class for sc_task for item designer functionality.</td>
</tr>
<tr>
<td>sc_ic_CatalogItem</td>
<td>Wrapper class for sc_cat_item for the item designer.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>sc_ic_QuestionChoice</code></td>
<td>Wrapper class for question choices (sc_ic_question_choice).</td>
</tr>
<tr>
<td><code>sc_ic_CatalogItemVariable</code></td>
<td>Wrapper for catalog item variables.</td>
</tr>
<tr>
<td><code>sc_ic_ApprovalDefnStaging</code></td>
<td>Wrapper for that approval definition staging table.</td>
</tr>
<tr>
<td><code>sc_ic_ReqItemApprovalDefn</code></td>
<td>Wrapper for requested item approval definitions.</td>
</tr>
<tr>
<td><code>sc_ic_Item</code></td>
<td>Subclasses, injected using sc_ic_Factory. For more information, see sc_ic_Factory.</td>
</tr>
<tr>
<td><code>sc_ic_CatalogItemVariableChoice</code></td>
<td>Wrapper class for variable choices.</td>
</tr>
<tr>
<td><code>sc_ic_ReqItemTaskDefn</code></td>
<td>Wrapper for requested item approval definitions.</td>
</tr>
<tr>
<td><code>sc_ic_ItemStagingSecurityManager</code></td>
<td>Security manager for the sc_ic_item_staging table.</td>
</tr>
<tr>
<td><code>sc_ic_BaseTypeDefnStaging</code></td>
<td>Base class for all type definition staging classes</td>
</tr>
<tr>
<td><code>sc_ic_Column</code></td>
<td>Wrapper class for item designer question layout columns.</td>
</tr>
<tr>
<td><code>sc_ic_ApprovalTypeDefnStaging</code></td>
<td>Wrapper class for staged approval type definitions.</td>
</tr>
<tr>
<td><code>sc_ic_CatalogItemRecordProducerService</code></td>
<td>Wrapper class for sc_cat_item_producer_service for the item designer.</td>
</tr>
<tr>
<td><code>sc_ic_QuestionAJAX</code></td>
<td>Service for item designer questions that can be called from the client.</td>
</tr>
<tr>
<td><code>sc_ic_QuestionType</code></td>
<td>Wrapper class for item designer question types. Subclass to modify and inject using sc_ic_Factory. See sc_ic_Factory for more information.</td>
</tr>
<tr>
<td><code>sc_ic_TaskDefnStagingAJAX</code></td>
<td>Service for staged task definitions that can be called from client scripts.</td>
</tr>
<tr>
<td><code>sc_ic_RequestedItem</code></td>
<td>Item creator wrapper class for the sc_req_item table.</td>
</tr>
<tr>
<td><code>sc_ic_ApprovalTypeDefn</code></td>
<td>Wrapper class for the approval type definition table.</td>
</tr>
<tr>
<td><code>sc_ic_TaskAssignDefn</code></td>
<td>Wrapper class for task assignment definitions.</td>
</tr>
<tr>
<td><code>sc_ic_TaskDefn</code></td>
<td>Wrapper class for task definitions.</td>
</tr>
<tr>
<td><code>sc_ic_SecurityManager</code></td>
<td>Base security manager class for the item designer tables.</td>
</tr>
<tr>
<td><code>sc_ic_BaseFactory</code></td>
<td>Base factory class. All customizations should be made in the sc_ic_Factory class. See sc_ic_Factory for more information on how to mount customizations.</td>
</tr>
<tr>
<td><code>sc_ic_ApprovalDefn</code></td>
<td>Wrapper for approval definitions.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>sc_ic_getCategoriesForModule</td>
<td>Class that gets categories.</td>
</tr>
</tbody>
</table>

## Client scripts installed with catalog item designer

The catalog item designer adds the following client scripts.

<table>
<thead>
<tr>
<th>Script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get next order number</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Populates the order field by adding 100 to the biggest order on an approval definition defined against the item.</td>
</tr>
<tr>
<td>Get Approval Type Description</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>Displays or hides the approval type description on change of the predefined field value.</td>
</tr>
<tr>
<td>Reload when an image is deleted</td>
<td>Item [sc_ic_item_staging]</td>
<td>Reloads the Item designer form when a Desktop or Mobile image is deleted and sets the record back to state Draft if it has been Published.</td>
</tr>
<tr>
<td>Process Dialog action</td>
<td>Item [sc_ic_item_staging]</td>
<td>Prompts to make a decision about keeping the modifications to the item before completing the selected action which will cause an update. Performs the prompt if the state of the item is set to Published and there are unsaved changes to the item record.</td>
</tr>
<tr>
<td>Dialog functions</td>
<td>Item [sc_ic_item_staging]</td>
<td>Defines available dialog functions for actions such as display, process and refresh.</td>
</tr>
<tr>
<td>Force update of Column dropdown</td>
<td>Question [sc_ic_question]</td>
<td>Updates the Section drop-down values on load of the Question dialog box.</td>
</tr>
<tr>
<td>Mandatory checked</td>
<td>Question [sc_ic_question]</td>
<td>Ensures read only is not true if the question is mandatory.</td>
</tr>
<tr>
<td>Read only checked</td>
<td>Question [sc_ic_question]</td>
<td>Ensures mandatory is not true if the question is read only.</td>
</tr>
<tr>
<td>Populate meta fields &quot;Type&quot; changed</td>
<td>Question [sc_ic_question]</td>
<td>Populates the meta field values on change of Type on the Add Question form.</td>
</tr>
<tr>
<td>Populate meta fields &quot;Option&quot; changed</td>
<td>Question [sc_ic_question]</td>
<td>Populates the meta field values on change of Option on the Add Question form.</td>
</tr>
<tr>
<td>Script</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Get Question Type Description</td>
<td>Question [sc_ic_question]</td>
<td>Displays the Question type description on change of the Option field value for the following Types: Multi Line Text, Multiple Choice, Reference.</td>
</tr>
<tr>
<td>Update Order on Section change</td>
<td>Question [sc_ic_question]</td>
<td>Updates the Order value on the question record to the next question order number available for a selected Section on change.</td>
</tr>
<tr>
<td>Hide Question Type Choices related list</td>
<td>Question Type [sc_ic_question_type]</td>
<td>Controls the visibility of Question Type Choice related list for questions of type Select Box and Multiple Choice.</td>
</tr>
<tr>
<td>Adjust position for display</td>
<td>Section [sc_ic_section]</td>
<td>Adjusts the position value on a section record to determine the correct display order.</td>
</tr>
<tr>
<td>Validate and adjust Position</td>
<td>Section [sc_ic_section]</td>
<td>Validates that the position on a section record value is greater than 0 and displays a field message if not.</td>
</tr>
<tr>
<td>Get next position</td>
<td>Section [sc_ic_section]</td>
<td>Populates the position field by adding 1 to the biggest position number on a section defined against the item.</td>
</tr>
<tr>
<td>Get next order number</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>Populates the order field by adding 100 to the biggest order on an approval definition defined against the item.</td>
</tr>
</tbody>
</table>

Business rules installed with catalog item designer

The catalog item designer adds multiple business rules.

The following business rules perform the action described.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>When</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate Category</td>
<td>Item [sc_ic_item_staging]</td>
<td>BEFORE</td>
<td>Abort action if category is invalid.</td>
</tr>
<tr>
<td>Set Question for non-preconfigured types</td>
<td>Question Type [sc_ic_question_type]</td>
<td>BEFORE</td>
<td>For non-preconfigured question types, set the label using the class name.</td>
</tr>
<tr>
<td>Prevent multiple non-preconfigured</td>
<td>Question Type [sc_ic_question_type]</td>
<td>BEFORE</td>
<td>Abort the insert/update action and display an error message to the user if a non-preconfigured question type already exists.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>When</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Name field</td>
<td>Section [sc_ic_section]</td>
<td>BEFORE</td>
<td>Set name field to label field and add additional message detail.</td>
</tr>
<tr>
<td>Set value if nil</td>
<td>Question Choice [sc_ic_question_choice]</td>
<td>BEFORE</td>
<td>Set text field to empty string if value is null.</td>
</tr>
<tr>
<td>Check for duplicate</td>
<td>Section [sc_ic_section]</td>
<td>BEFORE</td>
<td>Abort the insert/update action and display an error message to the user if a section already exists.</td>
</tr>
<tr>
<td>Check for Questions before deleting</td>
<td>Section [sc_ic_section]</td>
<td>BEFORE</td>
<td>Prevent deletion of columns by aborting the delete action and display an error message to the user if the column contains questions.</td>
</tr>
<tr>
<td>Position must be between 0 or 1</td>
<td>Column [sc_ic_column]</td>
<td>BEFORE</td>
<td>Show message to user.</td>
</tr>
<tr>
<td>Check for Questions before deleting</td>
<td>Column [sc_ic_column]</td>
<td>BEFORE</td>
<td>Show message to user.</td>
</tr>
<tr>
<td>Group/user required for user specified</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>BEFORE</td>
<td>Show message to user.</td>
</tr>
</tbody>
</table>

The following business rules do not contain independent logic, but simply call methods in script includes, as indicated below. To find out which business rules call which script includes, refer to the default class registrations within the sc_ic_BaseFactory script include.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>When</th>
</tr>
</thead>
<tbody>
<tr>
<td>sc_ic: Copy Approval Definitions</td>
<td>Requested Item [sc_req_item]</td>
<td>AFTER</td>
</tr>
<tr>
<td>sc_ic: Copy Task Definitions</td>
<td>Requested Item [sc_req_item]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Approval definition changed</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Update detail field</td>
<td>Approval [sc_ic_aprvl_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set the item to draft</td>
<td>Approval Type [sc_ic_aprvi_type_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Check and update manager/editor roles</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Copy changes to real Category</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>When</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>------</td>
</tr>
<tr>
<td>Add Item Designer role on insert</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Column changed</td>
<td>Column [sc_ic_column]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set layout changed on delete</td>
<td>Column [sc_ic_column]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Create default Section</td>
<td>Item [sc_ic_item_staging]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set draft if changed</td>
<td>Item [sc_ic_item_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Check for Valid Name</td>
<td>Question [sc_ic_question]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Question definition changed</td>
<td>Question [sc_ic_question]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Question meta changed</td>
<td>Question [sc_ic_question]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set definition changed on delete</td>
<td>Question [sc_ic_question]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set Question Type and Base Type</td>
<td>Question [sc_ic_question]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set question name</td>
<td>Question [sc_ic_question]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Question Choice changed</td>
<td>Question Choice [sc_ic_question_choice]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set Order number</td>
<td>Question Choice [sc_ic_question_choice]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set layout changed on delete</td>
<td>Section [sc_ic_section]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Create default Columns</td>
<td>Section [sc_ic_section]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Section changed</td>
<td>Section [sc_ic_section]</td>
<td>AFTER</td>
</tr>
<tr>
<td>Set Draft</td>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set assignment details</td>
<td>Task Assignment [sc_ic_task_assign_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set assignment details</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Set task definition changed on item</td>
<td>Task [sc_ic_task_defn_staging]</td>
<td>AFTER</td>
</tr>
</tbody>
</table>

**Email notifications installed with catalog item designer**

The catalog item designer adds the following email notifications.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Condition</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Designer Category Request Opened</td>
<td>Item Designer Category Request [sc_ic_category_request]</td>
<td>state EQUALS requested</td>
<td>manager</td>
</tr>
</tbody>
</table>
### Installed with Service Catalog Management

Several types of components are installed with the service catalog management. Activating the Service Level Management plugin adds or modifies several tables, user roles, and other components.

### Script includes installed with Service Catalog Management

#### Script includes

Service Catalog Management adds the following script includes.

#### Table 215: Script includes for Service Catalog Management

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DemoSCCreateltem</td>
<td>Demonstrates the use of service catalog scoped API.</td>
</tr>
</tbody>
</table>

### Service Catalog video tutorial

This video introduces the Service Catalog application.

### Service Desk

The ServiceNow platform includes a default homepage and a Service Desk application to provide a basic set of service desk functions.

Both of these can be customized to suit the processes you are involved in and the needs of the organization.
The ITIL Homepage provides commonly used reports that give an overview of the processes you are involved in. Access the ITIL Homepage from the homepage icon on the edge (UI15) or favorites tab (UI16).

By default, the ITIL Homepage includes the following reports.

- **Users by location**: a pie chart displaying users divided by location.
- **Open Items by Escalation**: tasks with an open state, grouped by escalation.
- **My Groups Work**: outstanding work for your group.
- **My Work**: your outstanding work.
- **ITIL Summary Counts**: tasks that are critical, overdue, and over a week old.

Because these reports link directly to the appropriate records and tables, you can use the work queues and the reports on critical tasks to manage your work directly from the homepage.

### Service Desk Call

Service Desk Call allows ITIL users to create a call record and quickly capture basic information from a customer contact, before deciding whether the call is an incident, a problem, a change, or a service catalog request.

Service desk personnel can more quickly process customer calls by retaining and reusing the information captured during the call. Users with the itil role can read, create and edit an existing call, but cannot delete existing calls or edit a call after it is transferred.

At the end of the call, the ITIL user can decide the action to take.

- Transfer the call record to an incident, problem, change, or service catalog request.
- Record the call as another type of contact, such as a wrong number.

### Activate Service Desk Call

You can activate the Service Desk Call plugin.

**Role required**: admin

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.
   - If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the **Load demo data** check box.
   - Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click **Activate**.

### Installed with Service Desk Call

Several types of components are installed with Service Desk Call.

**Tables installed with Service Desk Call**

Service Desk Call plugin adds the following table.
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call</td>
<td>The base table for service desk call that contains all call information.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Service Desk Call

Service Desk Call plugin adds the following client script.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Script contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Populate company</td>
<td>Call [new_call]</td>
<td>Code to populate the company field on the form with an appropriate value based on the selected caller.</td>
</tr>
</tbody>
</table>

### Business rules installed with Service Desk Call

Service Desk Call plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallTypeChanged</td>
<td>Call [new_call]</td>
<td>Creates a new incident, problem, or change record, based on the call type selection.</td>
</tr>
<tr>
<td>CallTypeChanged to Request</td>
<td>Call [new_call]</td>
<td>Redirects to a new service catalog request page based on the call type and request item selection.</td>
</tr>
<tr>
<td>Calculate time spent</td>
<td>Call [new_call]</td>
<td>Calculates the time spent between opening the form and saving it.</td>
</tr>
<tr>
<td>Domain - Set Domain - SD Call</td>
<td>Call [new_call]</td>
<td>Supports domain separation.</td>
</tr>
</tbody>
</table>

### Service Desk Call and domain separated systems

Saving a call record may create two records: a service desk call record and a transferred record. For systems using domain separation, these two records may be stored in different domains.

The service desk call record is saved in the ITIL user's domain. This domain is determined as follows:

- Use the ITIL user's domain if the ITIL user has a domain.
- Otherwise, use the default domain.

Any transferred record is saved in the caller's domain. This domain is determined as follows:

- Use the caller's domain if the caller has a domain.
- Otherwise, use the default domain.
Service Desk Call uses

ITIL users, users with the itil role, can quickly capture basic information within a call record while in contact with the customer.

After the information has been gathered, they can decide how to classify that call record, for example, as an incident.

ITIL users can use service desk call to perform any of the following tasks.

• Create a new call record.
• Transfer a call record to an incident, problem, change, or service request.
• View call record information.

Create a new call

You can create a new call when a user contacts you for assistance with their issue.

Role required: itil

1. Navigate to Service Desk > Calls > New Call.
2. Complete the form.

Table 216: Call form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An auto-generated identifying number for the call record.</td>
</tr>
<tr>
<td>Caller</td>
<td>The person who contacted the service desk. This is mandatory if the call type is Incident, Problem, Change, or Request.</td>
</tr>
<tr>
<td>Company</td>
<td>The company where the call originated.</td>
</tr>
<tr>
<td>Call type</td>
<td>A field that specifies the status of the call.</td>
</tr>
<tr>
<td></td>
<td>• Select a task type, such as Incident, to transfer the call.</td>
</tr>
<tr>
<td></td>
<td>• Select Hang Up, Wrong Number, Status Call, or General Inquiry to save the call record without transferring.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time when the call record was opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The ITIL user who communicated with the customer.</td>
</tr>
<tr>
<td>Contact type</td>
<td>The type of communication used to contact the service desk.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description of the caller’s issue or question.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the call that might be helpful for others to know. This field is visible to the customer.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

   If the call type is **Incident**, **Problem**, **Change**, or **Request**, this transfers the call, creating another record of the appropriate task type. A message provides the task number as a link.

**Tasks by same caller or company**

When you submit a call, two related lists are associated with the call record: **Tasks by Same Caller** and **Tasks by Same Company**. Checking these related lists can be useful to check for duplicate calls.
Figure 132: Call related lists

These list all active incidents, problems, changes and service catalog requests for that caller or company.

The **Tasks by Same Caller** list shows all active records where the value in the **Caller** field on the Call form matches the value in:

- The **Caller** field on the Incident form.
- The **Opened by** field on the Problem form.
- The **Requested by** field on the Change Request form.
- The **Requested for** field on the service catalog Request form.
The **Tasks by Same Company** list shows all active records where the value in the **Company** field on the Call form matches the value in:

- The company of the caller on the Incident form.
- The company of the user that opened the problem on the Problem form.
- The company of the user that requested the change on the Change form.
- The company of the user the request was made for on the service catalog Request form.

**Call transfer**

Details gathered during the customer contact determine the type of record. Saving the call with a call type of **Incident, Problem, Change, or Request** saves the call record and also creates a new record of the task type selected.

For example, the service desk receives a phone call from a customer reporting email issues with his laptop. When the call is answered, the service desk user opens a call record and enters basic information during the course of the phone call. At the end of the phone call, the service desk user decides it should be logged as an incident, sets the **Call type to Incident**, and saves the call record. A new incident record with details taken from the original call record is created. The new incident is handled through standard incident management processes.

After a call is transferred, the number of the new record appears in the **Transferred to** field on the Call form and the Calls list. A link to the new record appears above the Calls list.

**Transfer a call to an incident, problem or change**

When you select a task call type, you transfer the call to an incident, problem, or change request.

**Role required:** itil

1. In the Call form, set **Call type to Incident, Problem or Change**.
2. Click **Submit** to transfer the call.

   A record of the appropriate type is created, with the following information copied from the call.

   - Short description
   - Description
   - Company
   - Contact Type
   - Opened By
   - Caller
   - Location (Incident only, populated with the caller's location)
   - Requested by (Change only, populated with the caller's name)

**Transfer a call to a service catalog request**

You can transfer a call to a service catalog request and enter the relevant details for the requested catalog item as part of a single process.

**Role required:** itil

1. In the Call form, set **Call Type to Request**.
   
   A **Request item** field appears on the form.
2. Select the catalog item to request.
   
   Content items, record producers and order guides are not supported.
3. Click **Submit**.
   
   The order form for that catalog item appears.
4. Select any other options for that catalog item, as required.
5. Order the item.
The service catalog request is created with the following information.
- The **Caller** is copied to the **Requested For** field in the request.
- The **Description** field in the Call form is copied to **Special instructions**.

The requested item is listed in the **Task by Same Caller** related list in the call.

**View service desk calls**

You can view call records from several Service Desk modules.
- **Service Desk > Calls > My Calls** lists all calls that you created.
- **Service Desk > Calls > My Open Calls** lists all calls you created that have transferred records, such as incidents, that are still open.
- **Service Desk > Calls > All Open Calls** lists all calls created in the last month that have transferred records that are still open.

![Call records](image)

**Figure 133: My calls**

The **Time Spent** column shows the time between creating and saving the call record.

**Service Level Management**

Service Level Management (SLM) enables you to monitor and manage the quality of the services offered by your organization.

Service Level Managers are responsible for a set of agreements between a service provider and customer that define the scope, quality and speed of the services being provided. The intention of SLM is to provide the customer with an expectation of service within a known timescale and the ability to monitor when service levels are not being met.
SLM can be used across the organization in departments such as HR, Facilities, and IT to keep track of how internal and external teams are performing against their agreed service levels.

The service level management application offers the following features:

- SLA definitions
- Task SLAs
- Integration with other ServiceNow plugins

**SLA definitions**

Use the SLA Definition record to define a specific set of criteria that would result in an SLA being generated. You must define some of the following parameters:

- **Table**: SLAs can be defined against any task table
- **Duration**: You can specify the time duration in which the service must be provided to the customer.
- **Schedule**: You can specify the schedule, which indicates valid working and non working days that the service provider follows to deliver the service. The selected schedule will be used to determine when the SLA will breach.
- **Conditions**: You can specify the conditions under which the SLA will start, pause, stop, or reset.

**Task SLAs**

When an SLA Definition is triggered against a particular task the Task SLA record is generated and contains all the tracking data for the specific SLA on that record. For example if an SLA Definition exists for P1 incidents a Task SLA record will attach to the P1 incident record and capture all the data associated with it. In many cases there will be multiple Task SLA records against a single task since many definitions apply.

**Additional service level management plugins**

The following plugins introduce extra functionality within SLM:

- SLA Contract Add-on
- Service Portfolio Management- SLA Commitments

**Configure SLAs**

Configure SLAs to define a set amount of time for a task to reach a certain condition, to ensure that incidents are closed or resolved according to the expectations set for customers.

**SLA definition**

An *SLA definition* is used to create and progress SLAs, enabling you to use an SLA system for your organization’s tasks.

An SLA definition record defines the timings, conditions, workflows, and other information required to create and progress task SLAs.

For example, the default **Priority 1 resolution (8 hour)** SLA Definition defines the Task SLAs to attach to incidents with a P1 - Critical priority, specifies appropriate conditions for those Task SLAs, and uses the
default SLA workflow to create events such as to send a notification, when an incident's Task SLA reaches 50% of its allotted time.

Create an SLA Definition

You can create one or more Service Level Agreement (SLA) definitions based on your organization’s requirements.

To create an SLA definition:

1. Navigate to **Service Level Management > SLA > SLA Definitions**.
2. Click **New**. The **SLA Definition** form is displayed.
3. Enter the details in the appropriate fields.

### Table 217: SLA Definition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specify an identifying name for the SLA.</td>
</tr>
</tbody>
</table>
| Type                | Select the type of agreement being defined: SLA, OLA or Underpinning contract.  
  **Note:** Type is used for reporting purposes only. |
| Table               | Select the table whose records will be tracked by this SLA. This must be a table that extends the Task table such as Incident [incident]. |
| Workflow            | Select the workflow that determines what activities occur in response to the SLA. Workflows are typically used to create events that send notifications. |
| Enable logging      | Select Enable logging check box to activate debug logging just for the specific SLA definition. This includes details of the conditions that have matched or not matched and also the before and after values for the Task SLA and Task records.  
  **Note:** This field appears when **Duration type** is not a user specified duration. |
<p>| Duration type       | Specify the method for calculating the duration of the SLA. This can be a [User specified duration], or a [Relative Duration], such as End of next business day. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration</strong></td>
<td>Specify the length of time the SLA runs before it is marked Breached. This field appears when the duration is User specified duration. Note: The number of days specified in this field is converted to 24-hour blocks. If the Schedule field identifies a schedule with eight-hour days, a duration of 1 Day sets the SLA to breach three business days later.</td>
</tr>
<tr>
<td><strong>Relative duration works on</strong></td>
<td>Specify the record against which the relative duration should be calculated. Select to use either Task record or SLA record. This field appears when the duration is User specified duration.</td>
</tr>
<tr>
<td><strong>Schedule</strong></td>
<td>Specify the hours during which the SLA timer runs.</td>
</tr>
<tr>
<td><strong>Timezone</strong></td>
<td>Specify the time zone for the SLA. The timezone can be definition, schedule, location, or configuration item. Note: The SLA definition's time zone is used when creating Task SLAs if the Use the following time zone for SLA property is selected in Service Level Management &gt; Properties &gt; SLA Engine.</td>
</tr>
<tr>
<td><strong>Start condition</strong></td>
<td>Define the conditions under which the SLA will be attached. If one or more of these conditions change, then the SLA will be canceled.</td>
</tr>
<tr>
<td></td>
<td>• Retroactive start: Select Retroactive start to choose a date and time field from the task that will provide the start time of the task SLA. If you select the Retroactive start check box, the Set start to field appears offering the date and time fields available on the task type that this SLA definition applies to. For example if you select Retroactive start on a Priority 1 SLA definition and then choose Created in the Set start to field, then the SLA is attached with the start time being the date and time from the Created field on the Incident.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pause condition</td>
<td>Define the conditions under which the SLA will suspend increasing elapsed time. If one or more of these conditions no longer match, then the elapsed time will continue to increase.</td>
</tr>
<tr>
<td>Stop condition</td>
<td>Define the conditions under which the SLA completes. If all of these conditions match, then the task SLA will complete regardless of whether it is breached.</td>
</tr>
<tr>
<td>Reset condition</td>
<td>Define the conditions under which the running SLA will be completed and a new SLA will be attached. For a new SLA to be attached the start condition must match.</td>
</tr>
<tr>
<td>Condition type</td>
<td>Select the condition type to determine when an SLA attaches, pauses, completes, or resets.</td>
</tr>
</tbody>
</table>

Fields that can be added by configuring the form

Workflows for SLA

SLA typically uses workflows to send notifications.

You can create and edit workflows with the Workflow Editor. The default workflow that is available with the Service level management plugin is Default SLA Workflow.

The Default SLA Workflow creates the events that send out notifications. For example, it creates an event to send a notification to the user assigned to a task, such as an incident, when the task SLA reaches 50% of its allotted time.

Workflows for SLA considerations

As you configure a workflow for SLA, make sure you do the following.

- Create a workflow field for workflow stages
- Avoid updating tasks from the workflow
- Include a repair path in every workflow

Create a workflow field for workflow stages

Create a new Workflow type field to contain the workflow stage for an SLA workflow. If you want the Task SLA record to show the current stage of the workflow, you must create a new Workflow type field on the Task SLA table.

When you create a workflow for the Task SLA table, the If condition matches and Condition fields are not visible because the SLA engine controls when a workflow is triggered for a Task SLA record.

Note: Do not use the existing Stage field on task SLAs because this field is maintained by the SLA engine.
Avoid using workflow to update a task

Ensure that a task is never updated within the workflow. When a task record for an SLA is updated within the workflow, the business rules for the task record cause the SLA engine to process the SLA again. This may cause the workflow to enter into a recursive loop.

Include a repair path in every workflow

Ensure that a repair path is included in every workflow so that each time a task SLA record needs to be repaired, it follows a repair path until the repair process is complete.

The Default SLA Repair workflow provides a basic default repair path.

SLA duration

You can select one of two SLA durations types to define the length of time within which a task must be completed before the SLA is breached. If an SLA schedule is defined, the duration works in conjunction with the schedule.

When you define an SLA, you can select either a user specified duration or a relative duration.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User specified</td>
<td>Specifies a static duration period, such as 8 hours, often in conjunction with a business schedule.</td>
</tr>
<tr>
<td>duration</td>
<td></td>
</tr>
<tr>
<td>Relative duration</td>
<td>Specifies a duration relative to the start time of the task SLA and is defined using a script. For example, you can select a relative duration such as End of next business day or Next business day by 4pm.</td>
</tr>
</tbody>
</table>
• Relative duration usage scenarios

Specify a relative duration

To specify a relative duration, select an option such as **Next business day by 4 pm** or **End of next business day** from the list of available relative durations in the **Duration type** field.

When you select a relative duration such as **Next business day by 4 pm**, the **Relative duration works on** field displays. This enables you to specify the record against which the relative duration should be calculated. You can select to use **Task record** or **SLA record** and the one you select will be available as current for the relative duration script.

**Note:** The example breach date information message is not displayed if a relative duration is selected.

If your task record has a target date and time field, you can create an SLA with a relative duration based on that field.

Relative duration usage scenarios

You can use relative durations such as **Next business day by 4 pm** for incident tasks to determine resolution time for an incident that is logged prior to 10 am the current day. The script for this default relative duration will not only set the SLA breach time to 4 pm the following day, but also adds 1 more day to this if the current time is after 10 am.

Schedules within SLA

Schedules within SLA enable you to define the time periods during which the SLAs accumulate business time.

Schedules are typically based on the working hours of the resource or departments to whom a task is allocated. Configure schedules in the SLA engine properties and in the definition of each SLA.

Schedule property for the SLA engine

In the SLA Engine properties, select the source of the schedules for all SLAs. You can select one of these options from the **Use the following schedule (calendar) for SLA** property:

- **The SLA definition's schedule**
  Each SLA uses the schedule that is specified in its definition.

- **The CIs schedule**
  Each SLA uses the schedule associated with the configuration item (CI) specified on the task.

Schedules in SLA definitions

When you define an SLA, you can select a schedule during which the SLA will accumulate business time. For example, you can select a schedule of **8-5 weekdays** or **8-5 weekdays excluding holidays**.

These set of schedules are defined in the core configuration.
SLA duration and schedules

Schedules have an impact on the duration specified in an SLA definition. This impact is reflected in the timings that are taken into consideration while calculating an SLA.

**Note:** If a schedule is not selected for an SLA, the SLA will run 24X7.

Consider a scenario where you select a duration of one day, which is 24 hours, and a schedule of 9 am to 5 pm, which is 8 hours. The SLA calculation will distribute the 24 hours across three working days of 8 hours each. So a team working on a task associated with this SLA has 3 days to complete the task before the SLA is breached.

![Diagram showing distribution of 24 hours across 3 days with a 9 am to 5 pm schedule]

SLA conditions

SLA conditions determine when a task SLA record is attached, paused, reset, and completed.

On the SLA definition, you specify four conditions that are evaluated each time a task record is created or updated. For example, for an SLA to attach to a task, the start conditions must match and stop conditions must not match.

SLA conditions work in the following ways:

- SLA conditions
- SLA condition evaluation

**SLA conditions**

You can set four SLA conditions: start, pause, stop, reset.

**Start condition** Enables you to define the conditions under which the SLA will be attached. If one or more of the
specified start conditions change, then the SLA will be canceled.

- Select **Retroactive start** to choose a date and time field from the task that will provide the start time of the task SLA. If you select the **Retroactive start** check box, the **Set start to** field appears offering the date and time fields available on the task type that this SLA definition applies to. For example if you select **Retroactive start** on a Priority 1 SLA definition and then choose **Created** in the **Set start to** field, then the SLA is attached with the start time being the date and time from the **Created** field on the Incident.

**Pause condition**

Enables you to define the conditions under which the SLA will suspend increasing elapsed time. If one or more of these conditions no longer match, then the elapsed time will continue to increase.

**Stop condition**

Enables you to define the conditions under which the SLA completes. If all of the specified stop conditions match, then the task SLA will complete regardless of whether it is breached.

**Reset condition**

Enables you to define the conditions under which the running SLA will be completed and a new SLA will be attached. For a new SLA to be attached, the start condition must match.

**SLA condition evaluation**

Every task in the system is evaluated in the following order:

- Process new SLAs-- Determine if a new SLA record must be attached to a task
- Process existing SLA records attached to a task.

SLA conditions are evaluated in the following ways:

- Attach if start condition matches and the stop condition doesn't match.
- Complete if the stop condition matches.
- Pause if the pause condition matches.
- Reattach if both the reset and the start conditions match.
- Cancel if the start condition no longer matches.

Consider this evaluation order when you create conditions. For example, if your Start condition is a subset of your Stop condition, the Stop condition will always match when the Start condition matches and the SLA will never attach. This includes processing any new SLAs that were just created.

Similarly, if your Pause condition is a subset of your Start condition, the SLA will attach but will permanently be in Paused state. As soon as the Pause condition does not match, the equivalent Start condition will also not match and that task SLA record will be cancelled.

In addition, if you create a SLA definition with a Start condition and a Pause condition that are mutually exclusive, your SLA will never pause but will always be canceled first. For example, for an SLA definition where the Start condition is **State is one of "New, Active"** and the Pause condition is **State is "Awaiting**
**User Info**, when the Task is updated to state **Awaiting User Info**, the start condition will no longer match and the task SLA will be canceled.

**SLA transitions**

SLA records pass through a series of transitions during processing.

The following transitions exist for an SLA:

- **Attach**: when an SLA is created and bound to a task.
- **Pause**: when an SLA should temporarily stop tracking time.
- **Complete**: when an SLA is marked complete.
- **Reattach**: when an SLA is marked completed and a new copy is reapplied.
- **Cancel**: when an SLA is cancelled.

**SLACondition methods**

![SLA Condition Diagram]

**Figure 134: SLA Conditions Methods**

Each of these conditions is defined as a method within a Script Include, referenced by an SLA Conditions Rule record.
SLA condition rules

SLA condition rules control how the different conditions you define in an SLA definition are combined to determine whether an SLA should attach, pause, complete, reattach, or cancel.

The way that the conditions in an SLA definition are interpreted, to control transitions in state, can be varied using SLA Condition Rules. SLA Condition Rules are defined globally, and can be overridden for specific SLA definitions.

**SLAConditionBase** is the default set of SLA condition rules.

Navigate to **Service Level Management > Administration > SLA Condition Rules** to see a list of SLA condition records.

**SLAConditionBase script**
The **SLAConditionBase** script implements the default SLA condition processing.

To view the script, navigate to **Service Level Management > Administration > SLA Condition Rules**, then click on the **SLAConditionBase** entry to view details. The record in the **Class name** field is the script include that defines the condition processing.

---

**Note:** We recommend you do not modify this script, but use it as an example for creating your own script includes.

---

The following diagram shows how the transitions work:
The `SLAConditionSimple` script include provides an example modification of default SLA condition processing.

The `SLAConditionSimple` script include is one of the default supplied SLA condition rules. This shows an example of how you can modify and extend condition processing, by overriding the `SLAConditionBase` methods, with a 'simple' variation that interprets each condition to match a particular transition. For example, for an SLA to attach only the start condition is checked. This affects attach, reattach, and cancel.

To edit this script, navigate to Service Level Management > Administration > SLA Condition Rules, then click on the `SLAConditionSimple` entry to view or modify details. Click Class name field to open the script include that defines the condition processing.

The following diagram shows how the transitions work:
Extend SLA condition rules
You can create custom SLA condition class and condition rule records.
Custom SLA condition class and condition rule records enable you to modify the logic around one or more of the transitions involved in task SLA processing. The custom records can then be applied globally to the processing of all task SLA records or on a per SLA definition basis.

Create a custom SLA condition rule
To create a custom SLA condition rule:

1. Define an SLA Condition Class.
2. Create an SLA Condition Rule.

Define an SLA Condition Class
SLA condition classes contain script to define processing for an SLA condition rule.
To define an SLA Condition Class:

Navigate to System Definition > Script Includes and click New.
Within the script in the SLA Condition Class, provide methods to modify one or more of the default SLA transitions (attach, pause, complete, reattach, cancel), defining the conditions for SLA processing. For example, the attach method defines when an SLA is created and attached to a task. The methods need to test a condition, referencing the condition fields on the SLA Definition form.

**Note:**

For example, including the following method in an SLA Condition Class attaches the SLA if its condition matches the SLA’s `start_condition` field:

```javascript
attach: function() {
    return (this._conditionMatches(this.sla.start_condition));
},
```

The following is an example which shows the format of a script include that would extend the `SLAConditionBase` class and provide methods for each of the SLA transitions:

```javascript
var SLAConditionLocal = Class.create();
SLAConditionLocal.prototype =
    Object.extendsObject(SLAConditionBase, {
        attach: function() {
            // insert script here
        },
        pause: function() {
            // insert script here
        },
        complete: function() {
            // insert script here
        },
        reattach: function() {
            // insert script here
        },
        cancel: function() {
            // insert script here
        });
```

Create an SLA Condition Rule

Define an SLA condition class.

1. Navigate to **Service Level Management > SLA Condition Rules** and click **New**.
2. Name the SLA Condition Rule.
3. Select the Script Include defined above in the **Class Name** reference field.

Invoke an SLA condition rule globally

By default, the **SLAConditionBase** is used for the SLA condition rules. This can be changed by doing the following:

1. Navigate to **Service Level Management > SLA Properties**.
2. Change the value of the `com.snc.sla.default_conditionclass` **SLA property** to the new condition rule name:

   | The name of the Script Include class that will be used to evaluate SLA Conditions for the 2011 SLA engine (use to override with your own extension of the SLAConditionBase class) |
   | SLAConditionBase |

**Note:** This is the default condition rule, if no condition rule is specified on an SLA definition.

Invoke SLA condition rules on a specific SLA definition

In cases where a particular SLA requires that specific SLA condition rules should be used, you can specify the condition rule to be used within the relevant SLA definition form,

1. Navigate to **Service Level Management > SLA > SLA Definitions**.
2. Open an SLA definition record.
3. Configure the form to add the **Condition type** field to the form.
4. Specify the appropriate SLA condition rule in the **Condition type** field
Use SLA retroactive start

You can use retroactive start to retain the timing information for an SLA when a task record changes.

When a task record changes, typically a new SLA may be attached, with a new set of timing information. This is useful if you are re-assigning an incident to another group and want to attach a new SLA record with new timing information.

However, you may want to retain the task's time information in specific situations. For example, an incident is raised with a priority of 3 - Moderate and the priority changes to 1 - Critical after 3 hours. A priority 1 SLA is attached to the incident at that time. You can use retroactive start to ensure this SLA timing is adjusted retroactively to count from when the incident was first created, rather than from when the incident's priority changed. This reflects the actual time the user contacted you.

Note: When retroactive start is enabled, it may result in task SLAs being breached as soon they attach, which will trigger multiple notifications. To prevent the workflow from being processed for these breached SLAs, set the com.snc.sla.workflow.run_for_breached property to false.

1. Navigate to Service Level Management > SLA > SLA Definitions.
2. Open the relevant SLA definition record.
3. In the Start condition section, select the Retroactive start check box.
4. From the Set start to, select the event from which the SLA starts.
   This option determines the start time used for every task SLA record created from this SLA definition.
   For example, you can select Opened to start the SLA from when the task form was initially opened to create the record, which accurately reflects the time the end user contacts the service desk.
   Alternatively, you can select Created to start the SLA from when the task form was initially saved.
5. Click Update.

Use SLA retroactive pause

To prevent immediate breaches and notifications when retroactive start is enabled for SLA definitions, enable the retroactive pause property to apply pause times to the new SLA.

You can use retroactive pause to retain the task's time information in specific situations.

2. For the Compute prior SLA pause time for new, retroactive SLAs (2011 SLA engine only) property, select the Yes check box.
   Enabling this property ensures that the new task SLA record gets any pause time that would have been accumulated during the period between the retroactive start time and now. This pause time increases the breach time with the appropriate amount.
3. Click Save.

Configure SLA properties

You can configure the SLA engine, logging, and repair properties based on the requirements within your organization.

To configure SLA properties:
1. Navigate to Service Level Management > Properties.
2. Select one of the following:

**SLA Engine**
configure properties for the SLA engine.

**SLA Logging**
configure logging properties for SLA Script
Includes and logging output destination.

**SLA Repair**
configure properties for the SLA Repair process.

### SLA Engine properties

Administrators can manage the SLA engine using SLA engine properties.

Navigate to **Service Level Management > Properties > SLA Engine** to view SLA engine properties.

#### Table 218: SLA Engine Properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.sla.calculation.percentage               | Maximum 'Actual elapsed percentage' value after which the 'SLA - update calculations' scheduled job will stop regularly calculating the SLA’s time values. This is used to prevent 'long since breached' records from being unnecessarily updated. Setting to '0' will stop all calculations, where leaving this blank will allow all SLAs to be calculated. By default, this is set to 1,000%, so that recalculation stops after the breach is exceeded by a factor of 10.  
  - Type: integer  
  - Default value: 1000 |
| com.snc.sla.schedule.source                     | Use the following schedule when creating new task SLAs. *The SLA definitions schedule:* this will use the schedule specified on the SLA definition. *The CIs schedule:* this will use the schedule specified on the CI selected on the task that the task SLA is being attached to.  
  - Type: choice list  
  - Default value: sla.schedule |
<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.sla.timezone.source | Use the following time zone when creating new task SLAs: The caller's time zone = task.caller_id.time_zone, The SLA definition's time zone = sla.timezone, The CIs location's time zone = task.cmdb_ci.location.time_zone, The task's location's time zone = task.location.time_zone, The caller's location's time zone = task.caller_id.location.time_zone  
  - Type: choice list  
  - Default value: task.caller_id.time_zone |
| com.snc.sla.engine.version | Run the 2011 SLA engine (2010, 2011)  
  - Type: choice list  
  - Default value: 2011 |
| com.snc.sla.engine.async | Run the 2011 SLA engine asynchronously after task insert or update operations.  
  - Type: true | false  
  - Default value: false |
| com.snc.sla.compatibility.breach | Enable compatibility with 2010 'breached' status of SLAs (default: false)  
  Only enable if you require the old way of showing breached status (in the stage value), for reporting purposes. Using only the 'breached flag' is preferred  
  - Type: true | false  
  - Default value: false |
| com.snc.sla.default_conditionclass | The name of the Script Include class that will be used to evaluate SLA Conditions for the 2011 SLA engine (use to override with your own extension of the SLAConditionBase class)  
  - Type: String  
  - Default value: SLAConditionBase |
| com.snc.sla.retroactive_pause | Compute prior SLA pause time for retroactive SLAs (2011 SLA engine only)  
  For SLAs which have SLA definitions using retroactive starts, this allows those SLAs to "recover" prior pause time calculated.  
  - Type: true | false  
  - Default value: true |
<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.workflow.run_for_breached</td>
<td>An update to a Task can result in an SLA being attached that is already breached - for example when an Incident that has already been open for a while is upgraded to a high priority with a short resolution SLA. By default if there is a workflow specified in the SLA Definition it will not run if the Task SLA is attached and the Planned End Time has already passed. Enable this property if you would like the workflow to run for a Task SLA that is already breached when it is attached to the Task.</td>
</tr>
<tr>
<td>com.snc.sla.calculate_planned_end_time_after_breach</td>
<td>Continue to re-calculate the &quot;Planned End Time&quot; of SLAs after they have breached</td>
</tr>
<tr>
<td>com.snc.sla.calculation.use_time_left</td>
<td>Use field business_time_left to calculate breach time instead of business_percentage field. Using business_time_left is more accurate because the business_percentage field is rounded to 2 decimal places. This means that once the business percentage reaches 99.995%, it is recorded as 100%, and the task SLA is marked as breached.</td>
</tr>
<tr>
<td>glide.sla.calculate_on_display</td>
<td>Recalculate Task SLA records when a Task form is displayed. This ensures that the task SLAs calculations are up to date but this may increase form load time.</td>
</tr>
</tbody>
</table>
### Property name
com.snc.sla.always_populate_business_fields

### Description
When this property is set to true, the business fields such as Business elapsed time will be populated with the same values as those in the actual fields when there is no schedule specified on the Task SLA.

If the property is false, the business fields will be empty when a Task SLA has no schedule.

- Type: true | false
- Default value: true for new instances, false for upgraded instances

### SLA Logging properties

Administrators can configure SLA logging using SLA properties.

Navigate to Service Level Management > Properties > SLA Logging to view SLA logging properties.

The Logging level for... properties set logging levels for relevant script includes. This allows you to activate extra logging targeted at whenever that script include is invoked via a task SLA.

For example, if you know of an issue with the TaskSLAworkflow script include, you can use the com.snc.sla.workflow.log property to enable logging on that script include. These properties are all set to Notice level by default.

#### Table 219: SLA Logging Properties

<table>
<thead>
<tr>
<th>SLA Logging Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.task_sla_controller.log</td>
<td>Logging level for TaskSLAController</td>
</tr>
<tr>
<td>com.snc.sla.task_sla.log</td>
<td>Logging level for TaskSLA</td>
</tr>
<tr>
<td>com.snc.sla.condition.log</td>
<td>Logging level for SLAConditionBase</td>
</tr>
<tr>
<td>com.snc.sla.workflow.log</td>
<td>Logging level for TaskSLAWorkflow</td>
</tr>
<tr>
<td>com.snc.sla.calculatorng.log</td>
<td>Logging level for SLACalculatorNG</td>
</tr>
<tr>
<td>com.snc.sla.repair.log</td>
<td>Logging level for SLARepair (SLA repair must be enabled to use this)</td>
</tr>
<tr>
<td>com.snc.sla.log.destination</td>
<td>Logging output destination.</td>
</tr>
<tr>
<td></td>
<td>Select the log destination: either output to both the Database and node logs (the default), or output to node logs only.</td>
</tr>
<tr>
<td></td>
<td>Database and node logs (gs.log) are visible as system logs from ServiceNow, node logs (gs.print) only appear in log files.</td>
</tr>
</tbody>
</table>

### Logging levels

The following logging levels are available for the Logging level for... properties:
Table 220: Logging Levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emerg</td>
<td>Emergency</td>
<td>Total failure.</td>
</tr>
<tr>
<td>Alert</td>
<td>Alert</td>
<td>System corruption of a database, for example.</td>
</tr>
<tr>
<td>Crit</td>
<td>Critical</td>
<td>Typically used for hardware errors, for example.</td>
</tr>
<tr>
<td>Err</td>
<td>Errors</td>
<td>Errors</td>
</tr>
<tr>
<td>Warning</td>
<td>Warnings</td>
<td>Warnings</td>
</tr>
<tr>
<td>Notice</td>
<td>Notice</td>
<td>Possible action required but not essential.</td>
</tr>
<tr>
<td>Info</td>
<td>Informative</td>
<td>No action required.</td>
</tr>
<tr>
<td>Debug</td>
<td>Debugging</td>
<td>Generally not used except for capturing everything for fault-finding.</td>
</tr>
</tbody>
</table>

**Note:** By default, logging levels are set to **Notice**

SLA Repair properties

Administrators can manage the SLA repair function using system properties.

Navigate to **Service Level Management > Properties > SLA Repair** to view **SLA repair** properties.

Table 221: SLA repair properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.repair.enabled</td>
<td>Enable SLA repair. When enabled the Repair modules and UI Actions will be activated.</td>
</tr>
<tr>
<td></td>
<td>• Type: true / false</td>
</tr>
<tr>
<td></td>
<td>• Default value: true for new instances and false for upgraded instances</td>
</tr>
<tr>
<td>com.snc.sla.repair.use_repair_workflow</td>
<td>When repairing SLAs, use the Repair workflow instead of the one configured on the SLA Definition.</td>
</tr>
<tr>
<td></td>
<td>• Type: true / false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false for new instances, true for upgraded instances</td>
</tr>
<tr>
<td></td>
<td>• Learn more: <a href="#">Configure SLA repair</a> on page 845</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.snc.sla.repair.workflow</td>
<td>The name of the Repair workflow.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: Default SLA Repair workflow</td>
</tr>
</tbody>
</table>

### SLA process example

As work is done on the relevant task, the SLA may change stage appropriately, depending on the information defined for that SLA in the relevant SLA definition.

For example, if an incident is resolved within the time specified, the SLA stage is typically set to Complete.

Similarly, if the incident does not reach the required condition within the set amount of time, the Task SLA record associated to that Incident marked as Has Breached. For example, by default, if a P1 incident is not resolved within 8 hours, the Task SLA for that incident will have Has Breached set to true.

This example demonstrates how an SLA can be attached to an incident, then progressed to completion.

1. Navigate to **Incident > Create New**.
2. Set both **Impact** and **Urgency** to 1. This changes the **Priority** to 1 - Critical.
3. Save the form.
   - The **Task SLA** Related List should now have a Priority 1 SLA attached to this incident.
### Incident - INC0010001

- **Impact:** High
- **Urgency:** High
- **Priority:** Critical
- **Short description:** P1 Incident

**Additional comments:**

**Work notes:**

**Activity:** 2015-06-01 07:12:35 System Administrator Changed: Impact, Urgency, Priority

---

**Related Links**

#### Task SLAs

<table>
<thead>
<tr>
<th>Task SLA</th>
<th>SLA definition</th>
<th>Type</th>
<th>Stage</th>
<th>Start time</th>
<th>Stop time</th>
<th>Actual elapsed time</th>
<th>Actual elapsed percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority 1 resolution (8 hour)</td>
<td>SLA</td>
<td>In progress</td>
<td>2015-06-01 07:12:35</td>
<td>(empty)</td>
<td>1 Second</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Note: The default **Priority 1 resolution (8 hour)** SLA definition record is used to create and attach this Task SLA.

4. Change the **Impact** to 2, which changes the **Priority** to 2 - High, then save the form. The Priority 1 SLA is now marked **Cancelled**, and a Priority 2 SLA has been attached, because of the conditions on the SLAs.

5. Change the **Incident State** to Awaiting User Info, then save the form. **Awaiting User Info** is a **Pause** condition on the Priority 2 SLA, so the SLA is marked Paused.

Note: The pause duration on Task SLA gets updated only after the SLA moves out of pause.

6. Change the **Incident State** to Active, then save the form. Because the incident is no longer in a **Pause** condition, it resumes timing.
7. Enter any **Close code** and **Close notes** values in the **Closure Information** section of the incident.

8. Change the **Incident State** to Resolved, then save the form. The SLA is marked Completed.

---

**Add custom business rules to SLAs**

You can add custom business rules to your SLAs.

**Role required**: admin

To add custom business rules to SLAs:

Select one of the following methods to add custom business rules.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Use setWorkflow(false)** | 1. Prior to updating your task, add a call to `setWorkflow(false)` on the GlideRecord object for the task within the business rule that is updating the task. This prevents the business rules from being processed.  

**Note:** The `setWorkflow(false)` disables processing of all engines and the update does not appear in the audit history of the task.  

For example, a script that copies the breach time to a custom field on the task. |

```javascript
(function(){
    if (current.planned_end_time.changes()) {
        var taskGr = current.task.getRefRecord();
        taskGr.u_sla_breach_time = current.planned_end_time;
        taskGr.setWorkflow(false);
        taskGr.update();
    }
}());
```
Option | Description
--- | ---
**Create a sys_trigger (Schedule job) to update the task**

1. In your custom business rule, use the **Script** field to generate a scheduled job to update the task. To ensure that the scheduled job is queued for processing immediately, it must be of type **Run once**, and have next action time of **Now**.

**Note:** The **ScheduleOnce script include** includes functions to specify the target record and when to run the scheduled job. This enables you to specify the script to be executed and call another function to create the appropriate record in the **sys_trigger** table.

For example, a script to create a scheduled job that copies the breach time from the task SLA to a custom field on the task.

```javascript
(function(){
  if (current.planned_end_time.changes()) {
    var scheduleJob = new ScheduleOnce();
    scheduleJob.setDocument(t.task.getRefRecord);
    scheduleJob.script = "current.u_sla_breach_time.setValue('" +
                        current.getValue('planned_end_time') +
                        "');current.update();"
    scheduleJob.schedule();
  }
}())();
```

---

**Add custom business rules to SLAs considerations**

Prior adding custom business rules to the task SLA table, you must consider a few points regarding the processing and calculation of the task SLA based on your organization’s needs.
Add custom fields to the task SLA table

You can add custom fields to the task SLA table and write business rules to populate them. This does not impact the SLA engine. However, you must consider performance implications, if any, of these business rules since task SLAs are updated frequently during their lifecycle.

Points to consider

- Business rule that directly updates the parent task when an SLA is updated.
  Avoid writing a business rule on the task SLA table that updates the parent task directly. Doing so causes recursive processing of the business rules.
- Business rule that updates the default fields on a task SLA.
  Avoid writing a business rule on the task SLA table that updates the default fields. These default fields are managed and updated by the SLA engine. and any updates made to them might result in the following.
  - Fields being ignored, overwritten, or both the next time the SLA is calculated.
  - Incorrect calculations of other values on the task SLA.

SLA processing

The SLA engine performs two passes to evaluate SLA definitions and their conditions based on a task.

The SLA engine performs the following passes:

1. Checks the SLA definitions that do not have an active SLA record associated to the task. The SLA engine determines if the SLA definition applies to the task and if it needs to create a SLA record. The following condition checks are performed:
   a. If the Start condition is true and the Stop condition is true, do nothing. No SLA record is created, because the Stop condition overrides the Start condition.
   b. If the Start condition is true and the Stop condition is false, a new SLA record is created for this task using the SLA definition. The SLA record is then set to the In Progress stage.

2. Checks all active SLA records associated to the task. The engine determines if the SLA records are changing stage. The condition checks are performed in the following order:
   a. If the Stop condition is true, the SLA changes to Completed and becomes inactive.
   b. If both the Reset and Start conditions are true, the SLA changes to Completed and a new task SLA is created.
   c. If the Start condition is false, the SLA changes to Cancelled and becomes inactive.
   d. If the SLA is active, the Pause condition is true, and the SLA stage is In Progress, the SLA is paused.
   e. If the SLA is active, the Pause condition is false, and the SLA stage is Paused, the SLA changes back to In Progress.
Actual and business elapsed times

Task SLA records contain two sets of timing information: Actual elapsed and Business elapsed.

The difference between these two sets of timing is vital when you create and report on SLA definitions.

- **Actual elapsed** values are calculated on a 24x7 basis.
- **Business elapsed** values are calculated based on the schedule specified in the task SLA. The schedule is taken from the SLA definition by default.

**Note:** If no schedule is specified, then the Business elapsed time is the same as the Actual elapsed time. This can be disabled by changing the com.snc.sla.always_populate_business_fields property to false in the SLA Engine. When this property is set to false, the Business fields will be 0 or empty.

By default, the related list for the task SLA record displays the actual elapsed time only. You can configure the list to also display the business elapsed time.

**Elapsed times and schedules**

Consider a scenario where an SLA has a defined schedule of 9 am to 5 pm on weekdays. With this schedule, the difference between actual and business elapsed times can be significant.

For example, if a task SLA starts at 2 pm on a weekday, its business elapsed time at 9 am on the next weekday is 3 hours while its actual elapsed time is 19 hours.

**SLA Schedule: 9:00 AM- 5:00PM**

![Diagram of SLA Schedule]

**Figure 137: Business elapsed time vs actual elapsed time**

In addition, if a schedule defines an 8 hour working day, then 24 hours or one day in business elapsed time equates to 3 days in actual elapsed time.
Example

For example, an incident is opened on Friday, December 12 at 9 pm, outside of the SLA schedule of 8 am to 5 pm on weekdays.

If the current time is the following Monday at 9:30 am, then:

- **Business elapsed time** is 1 hour and 30 minutes because the SLA business timer stopped at 5 pm on Friday and restarted at 8 am on Monday.
- **Actual elapsed time** is 60 hours and 30 minutes, representing the real time between the incident being opened and the current time.

Elapsed percentages are also similarly calculated. The actual elapsed percentage is over 750% while the business elapsed percentage is 19% on an 8 hour SLA.

SLA calculation

SLAs are calculated and assessed by a business rule and scheduled jobs that run in the background.
The mechanisms that control SLA Workflow and SLA Automation are independent of each other. You may have a requirement to send out email notifications from the SLA Workflow displaying the current elapsed percentage of the SLA. However, this does not work because using percentage in a notification only displays the most recently calculated value of the Task SLA. This results in inaccurate values sent out in email when using SLA calculated values in a Task SLA email notification.

One solution is to specify elapsed percentage in SLA notifications by using notifications for each percentage level. For example, an email notification for “75 percent SLA Warning” is created and a special event is used to trigger that notification. The event can be called "sla.warning.75". Another solution is hard-coding these email notifications to trigger at a specified duration percentage, and configure the workflow linked to that SLA definition to send an email notification after waiting an elapsed percentage.

Run the 2011 SLA engine asynchronously

By default in the 2011 engine, the Run SLAs business rule runs synchronously after a task is changed and evaluates the conditions for transitioning the SLA state.

You can run this calculation asynchronously for performance reasons such as avoiding delays when a user saves a new incident record.

**Note:** In the 2010 engine, the asynchronous Process SLAs business rule runs this processing

2. For the Run the 2011 SLA engine asynchronously after task insert or update operations property, select the Yes check box.
3. Click Save.

Recalculate SLA times automatically

By default when a user opens a task, the SLA timing information for that task is not automatically recalculated.

You can enable this information to be automatically recalculated each time the task is opened, to provide current information rather than information from the last scheduled job.

2. For the Recalculate Task SLA records when a task’s form is displayed property, select the Yes check box.

**Note:** This property is disabled by default because there is a potential performance impact when several users concurrently open tasks.

3. Click Save.

Use exact times in SLA calculations

When business percentages are used for SLA calculations, they are rounded up to two decimal places. As a result, breaches can occur when SLA calculations are rounded up to 100%. You can enable SLA calculations to instead use the business time or actual time left.

For example, a business percentage of 99.951% is rounded up to 100%, which causes a breach.

For more accurate SLA calculations, enable the SLA engine property for using the exact value of the business time left if a schedule is specified or the actual time left if the SLA has no schedule specified.

2. For the Use field "business_time_left" to calculate breach time instead of "business_percentage" field property, select the Yes check box.
3. Click **Save**.

### Scheduled jobs for SLA

SLA has default scheduled jobs to regularly refresh the time calculations on each active task SLA.

- SLA update (breach after 30 days): repeats every 5 days
- SLA update (breach within 1 day): repeats every hour
- SLA update (breach within 1 hour): repeats every 10 minutes
- SLA update (breach within 10 min): repeats every 1 minute
- SLA update (breach within 30 days): repeats every day
- SLA update (already breached): repeats every day

**Note:** By default, the SLA update (already breached) scheduled job will calculate either for up to one year after it was breached or if 1000% of its allocated time is breached. You can set this maximum actual elapsed percentage value property in the SLA Engine properties.

Scheduled job runs more frequently when the task SLA is closer to being breached.

### Repair SLAs

SLA Administrators can repair SLA records to ensure SLA timing and duration information is accurate.

Repair of SLAs is useful to determine accurate timing information if your system has SLA records that contain incorrect values. For example, you may need to repair SLA records as a result of:

- poorly defined schedules
- poorly defined conditions on an SLA Definition
- some other system anomaly

The repair function removes the SLA record, then recreates and recalculates it from the start, including recreating the workflow. The repair uses the history from the Task and if appropriate will also create new Task SLAs that did not previously exist. For example, a new Task SLA may be needed if a new SLA Definition has been added since an associated Incident was created or updated.

The workflow used when recreating the SLAs is controlled by system properties and can be found by navigating to **Service Level Management > Properties > SLA Repair**. Any workflow that is used in the repair process will attempt to follow a repair path when processing the SLA Percentage Timer activities. This can be used to avoid running activities that are not needed for the repair over and over again.

You can repair single SLAs from the relevant form or multiple SLAs from relevant lists.

**Note:** SLA repair is not available on SLA definitions, as running a repair operation for an SLA definition could affect large numbers of records on your system, with significant performance impact.

You can also configure and manage SLA repair functions.

### Configure SLA repair

Administrators can set SLA repair properties and view repair logs.
Enable or disable SLA repair

The Repair SLA function is enabled for all new installed instances running the 2011 engine, but is disabled by default for upgraded instances. If disabled, no SLA repair functions are available, including all SLA repair modules, SLA repair logs, and UI actions.

**Note:** Repair actions will not be available for instances that are not running the 2011 engine.

To enable or disable SLA repair, use the `com.snc.sla.repair.enabled` repair property.

**Note:** You can also configure SLA workflow usage.

View repair logs

An SLA repair log record is created each time a repair action takes place with details such as who initiated the repair and start and end date and time. The log record contains a number of child **SLA Repair Log Entry** records related to it. Each repair log entry has a type of either **Before repair** or **After repair** that will contain the appropriate values from each Task SLA record that is repaired. If there is only a **Before repair** entry record for a task SLA, this indicates that it has been deleted. If there is only an **After record**, the repair function has created a task SLA that did not previously exist.

Navigate to **Service Level Management > Repair Logs** to view repair log information:

- **Active Repairs**: view repairs that are still in progress.
- **My Repairs**: view repairs you have run.
- **All Repairs**: view all repairs.
- **Repair Entries**: view SLA Repair Log entries for all repairs that have run.

Repair SLA from a form

You can repair task SLA records from the Task form, or from the task SLA form for an SLA associated to a Task.

You can also repair multiple task SLA records from a list.

1. To repair all SLAs associated to a specific task, open that form and select the **Repair SLAs** related link.
2. Alternatively, to repair a specific SLA on a specific Incident record, open the Incident record, open the SLA record associated with that incident, then select the **Repair** button on that SLA form.
   The SLAs selected are repaired. When the repair process is completed, the user selecting to repair receives a standard notification of the repair results.
Repair SLAs from a list

You can repair multiple SLA records from a list of task or SLA records.

You can also repair SLA records from the relevant Task form, or from the SLA form for the SLA associated with the task.

1. Navigate to a list of SLA records or task records.
2. Check the records to repair against.
3. Select the Repair SLAs for selected list action.
4. Alternatively, to repair SLAs for all records on that list, select the Repair for all filtered definitions related link.

The SLAs selected are repaired. When the repair process is completed, the user selecting to repair receives a standard notification of the repair results.

SLA Repair workflow

You can configure workflow usage for SLA repair operations.

Workflow usage

The SLA repair workflow is used if SLA repair functionality is enabled.

When the SLA repair function is in progress and new task SLA records are created, the workflow will follow a repair path through the workflow. The repair path is based on the result of the SLA Percentage Timer activities. While repair is in progress, the result of this activity will be repair, which enables the workflow to follow a different path in order to skip certain actions, such as generating events for notifications. This avoids duplicate notifications from being sent out during the repair process for each SLA that is repaired.

To specify that the SLA repair function should use the SLA’s original workflow for repair operations, go to Service Level Management > Properties > SLA Repair and remove the selection from the com.snc.sla.repair.use_repair_workflow repair property.

Note: If you choose to use a non-default repair workflow, or a workflow you have changed, you should modify this workflow to ensure it includes appropriate repair conditions on the SLA Percentage Timer activities. When a task SLA is repaired, the repair transitions are followed for any activities that occurred in the past. For example, the Default SLA Repair workflow configures the repair conditions to follow repair transitions.

Workflows for new or upgraded instances

For new instances, the SLA Repair function uses the Default SLA workflow, which incorporates repair activities. For upgrades, the SLA Repair function uses the Default SLA Repair workflow because the Default SLA workflow will not be updated in case it has been customized.
To change the default workflow the SLA repair function uses, go to Service Level Management > Properties > SLA Repair and set the com.snc.sla.repair.workflow repair property.

SLA for the end user

You can view the details for every task SLA record created for a task.

Each task can have one or more task SLA records associated with it. For example, the diagram below considers three SLA definitions irrespective of whether they attach to a task or not. The SLA definitions for priority P1 and Assignment group Network match the task in terms of priority and assigned to group. As a result, two task SLA records are created. However, the SLA definition for priority 2 does not match and hence no task SLA record is created.

Figure 139: How task SLAs are created
In the task SLA record, you can view the task SLA details such as the stage the task SLA is in and if it has breached.

In addition, you can get an overview of the timings for the task SLA such as the actual and business elapsed time and percentage, and the actual and business time left in days and hours.

**SLA timeline**

You can visualize the timeline of a task SLA record and follow when the record transitions from one stage to another.

The important aspects of the timeline view are:

- **From and to dates:** The *From* date and time is first history record of the task when it was created. The *To* date and time is the most recent update to the task.
- **Blue dots:** The blue dots signify an update to the incident with the first dot signifying when the incident was created. You can hover over the blue dot to view the details of the updates that were made to the task and the SLA conditions that matched the update as shown in the screenshot below. For example, the screenshot below displays that the task SLA record attached at first when the start conditions matched and is currently paused since the pause conditions matched. It also displays that task SLA is in *Awaiting user info* state, which is the reason for pause condition match.

- **Time of the update:** When you hover over the blue dot, the SLA Timeline also displays the time of the update in the time bar at the bottom of the form.
• Time spans: The spans displayed on the timeline have different colors to denote the different stages the task SLA record has progressed through. You can point to the stage spans to view details of every stage including the actual and business elapsed times.

• Retroactive start calculation: The SLA definition is configured to have a retroactive start and the timeline includes this information when the task SLA attaches to the incident.
• SLA schedule: The SLA timeline displays the schedule that the task SLA record follows. For example, in the screenshot below, the schedule for this SLA is 8-5 weekdays and so the actual business time will always be based on the same.

![SLA Timeline Screenshot](image)

• Business elapsed time: The SLA timeline displays the total business elapsed time the task SLA record has accumulated. For example, in the screenshot below, the task SLA has accumulated a total of 8 minutes business elapsed time prior to getting canceled.

![Task History Screenshot](image)

### Activate SLA timeline

You can activate the SLA timeline plugin (com.snc.sla.timeline) if you have the admin role. This plugin activates related plugins if they are not already active.

Role required: admin

1. Navigate to **System Definition > Plugins**.
2. Right-click the plugin name on the list and select **Activate/Upgrade**.

   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the **Load demo data** check box.

   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.

4. Click **Activate**.

**Installed with SLA timeline**

One type of component is installed with the SLA timeline.

*Script includes installed with SLA timeline*

SLA timeline adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLATimeline</td>
<td>Generates the timeline data for a task SLA record by replaying the task’s history and using the SLATimelineAPI to determine the appropriate stage transitions and timings for the task SLA.</td>
</tr>
<tr>
<td>SLATimelineAPI</td>
<td>Provides a number of functions that simulate how the SLA engine processes a particular task and SLA definition without actually creating any task SLA records.</td>
</tr>
</tbody>
</table>

**View SLA timeline**

You can view an SLA timeline from a Task SLA record or from an SLA definition.

Role required: admin

To view the SLA timeline:

You can open an SLA definition from the following:

<table>
<thead>
<tr>
<th>Location</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA definition</td>
<td>Navigate to Service Level Management &gt; SLA &gt; SLA Definitions. Click the Show SLA Timeline link.</td>
</tr>
<tr>
<td>Task SLA record</td>
<td>Open a task SLA record from the task form. Click the Show SLA Timeline link.</td>
</tr>
<tr>
<td>Task form</td>
<td>Right-click on a Task SLA in the related list on a task form such an incident record and select the Show SLA Timeline option.</td>
</tr>
</tbody>
</table>

The SLA timeline for the selected task or incident is displayed. It includes all the task SLA record details and the visual representation of the progress of the task SLA over the lifetime of the task.

**SLA timeline tutorial**

This tutorial provides an example of using the SLA timeline to determine the reasons an SLA attaches, pauses, cancels, or resets.
Consider the following scenario:

You are viewing the details of INC0010003 and the following three task SLA records that are attached to the incident:

1. Task SLA record Priority 3 resolution - Canceled
2. Task SLA record Priority 2 resolution - Complete
3. Task SLA record Priority 2 resolution - Complete

View the SLA timeline to determine the reason for the cancellation of task SLA for Priority 3 resolution and the duplication of task SLAs for Priority 2 resolution.

**SLA timeline tutorial: evaluate canceled task SLA record**

Task SLAs are canceled when the task no longer meets the start conditions defined in the SLA definition.

Role required: admin

To investigate the reason for the cancellation of the task SLA record for Priority 3 resolution, you can **open the SLA timeline**.

You can further understand the details represented in the **SLA timeline**. After you have viewed the details presented in the timeline view, you can determine the cause of the cancellation with the following details:

1. Point to the last blue dot in the timeline to get the details when the task SLA was canceled.
   
   The information displayed when you point to the last blue dot confirms that the cancel SLA condition matched. It also displays the fields that were changed and their new values.
Note: When you point to the blue dot, the SLA timeline also displays the time of the update in the time bar at the bottom of the form. In this case, the time of the update is November 13, 2015 at 15:32 hours.

2. Note the time period when the task SLA canceled.
   The incident notes show that the incident priority was increased during that time, which was noted as November 13, 2015 at 15:32 hours, from priority 3 to priority 2 per the customer’s request.
3. View the start conditions defined for the Priority 3 resolution (1 day) SLA definition, which generated the task SLA record.

The Priority 3 resolution (1 day) SLA definition specifies that the SLA will be canceled if one of the start conditions is not met. In the case of INC0010003, one of the start conditions is not met when the priority was updated to P2, causing the task SLA to cancel.
SLA timeline tutorial: evaluate duplicate task SLA records

Task SLAs are completed in a variety of scenarios. You must look at the start, reset, and complete conditions to determine the reason a task SLA is completed.

Role required: admin

To investigate the reason for the duplication of the second and third task SLA record, the Task SLA record Priority 2 resolution (8 hours), you can open the SLA timeline.

You can further understand the details represented in the SLA timeline. After you have viewed the details presented in the timeline view, you can determine the cause of the duplication with the following details:

1. Point to the blue dot (update to the incident) that is at the point where the timeline stops for the SLA to view the status of the two duplicate SLA records.
<table>
<thead>
<tr>
<th>Task SLA record</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task SLA record Priority 2 resolution (Task SLA 1)</td>
<td>Complete: Reset SLA condition matched along with the fields that were changed and their new values as shown in the screenshot below.</td>
</tr>
</tbody>
</table>
Task SLA record | Priority 2 resolution (Task SLA 2)
---|---
**Status** | Complete: Stop SLA conditions matched along with the fields that were changed and their new values as shown in the screenshot below.

![SLA Timeline](image)

**Note:** When you point to the blue dot, the SLA timeline also displays the time of the update in the time bar at the bottom of the form.

2. Note the time when the task SLA completed and view the incident notes for the same time period.
Task SLA record Priority 2 resolution (Task SLA 1)

The incident notes show that the assignment group was updated during that time from Database to Hardware.
3. View the conditions defined for the Priority 2 resolution (8 hours) SLA definition.
### Task SLA record

<table>
<thead>
<tr>
<th>Conditions match and consequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task SLA record Priority 2 resolution (Task SLA 1)</td>
</tr>
</tbody>
</table>
SLA notifications

SLA sends notifications at certain events defined in the workflow.

By default, SLA notifications are sent on three occasions:

1. SLA is at 50% of the duration specified in the SLA Definition
2. SLA is at 75% of the duration specified in the SLA Definition
3. SLA is breached

**Note:** SLA notifications are typically only sent to the user the incident is assigned to. However, when the SLA is breached, notifications are sent to the user the incident is assigned to and their manager.
Legacy SLA engines

If you are on an earlier version of the SLA engine, you can upgrade to the 2011 engine to make use of the complete service level management functionality.

The SLA engine has three versions:

<table>
<thead>
<tr>
<th>SLA engine version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation engine (pre-2010)</td>
<td>Tracks only one SLA per task.</td>
</tr>
<tr>
<td>The 2010 engine (the Service level management plugin)</td>
<td>Supports multiple SLAs per task. Business rules handle the processing of these SLAs while workflows handle notifications. The majority of logic is in a single large business rule called Process SLAs.</td>
</tr>
<tr>
<td>The 2011 engine (also part of the Service level management plugin)</td>
<td>The 2010 SLA engine functionality is concentrated into a number of script includes. Provides retroactive pause calculations and enables the customization of SLA condition processing through the use of condition rules.</td>
</tr>
</tbody>
</table>

Legacy SLA fields

Previously, only a single SLA could be attached to a task via the Escalation engine. The information for the SLA was stored in the task table using the SLA Due, Made SLA, and Escalation fields.

The Task SLA engine now enables multiple SLAs to be attached to a single task, making the earlier task fields redundant. Their equivalents are in the task_sla table for each SLA attached to the task.

- **Task SLA, Breach time**: This is equivalent to the SLA Due field
- **Task SLA, Has breached**: This will be true if the SLA has breached, the opposite of Made SLA field.
- There is no equivalent field for **Escalation** field. Notifications can be sent via the SLA workflow and an increase in priority can trigger additional SLAs to be attached to the task.

**Note**: The **Business Duration** field is neither part of the Escalations Engine nor the Task SLA Engine.

The fields on the **Task** are considered legacy and are not updated by the Task SLA engine. In case these fields are being updated, the legacy Escalation engine may still be running. This can happen if you have upgraded from Express or a previous instances.

To prevent the Escalation engine from running, set the com.snc.sla.run_old_sla_engine property to false. If this property is set to false and the fields are still being updated, check the customizations made to your instance.

Migrate to service level management

Migrate SLA processing from the escalations engine to use the service level management functionality.

The two core differences between the old SLA engine and the new service level management plugin are that tasks can now run multiple SLAs simultaneously, and the **escalation** concept has been replaced with the more robust Workflow Editor. This allows administrators greater control on what actions, notifications, and events are triggered by tasks, to take into account more mature Service Level processes.
If an instance has been using the original SLA engine and has just activated the Service Level Agreements (SLA) Plugin, the old SLAs will not work. For the old SLAs to work, they must be converted to the new SLA Definition records, which will attach the appropriate Task SLA records to the matching Task records. This is done manually by creating new SLA Definition records that reflect the definition of the old SLA. Old SLAs will continue to function, but any time a task is updated, the appropriate new Task SLAs will attach.

Once new Task SLAs are implemented, they will attach themselves to any new or updated incident, including ones which already have old SLAs attached. If the new Task SLA is set to retroactively start, it will automatically calculate the duration from that point in the past, which means that the duration will still be accurate.

When enabled, the property Compute prior SLA pause time for new, retroactive SLAs (2011 SLA engine only) property calculates the pause time when a retroactive SLA is attached.

For example: if a retroactive SLA attaches to an incident one hour after its creation, and meets the pause conditions for half an hour, then the elapsed time is half an hour rather than the full hour.

| Note: | This property is only used with audited tables. Tables which are not audited ignore the pause time before the creation of the record. |

Move from the 2010 Engine to the 2011 Engine

You can upgrade SLA processing to use the 2011 Engine.

The service level management plugin was enhanced with the ability to script the condition rules for SLA transitions, giving control over how the conditions in an SLA Definition are used. Please review the documentation before enabling the enhancements to understand how the new engine will impact existing customizations.

| Note: | Activating the 2011 SLA engine will deactivate all business rules on the task_sla table (except for the rule Task SLA Empty Schedule Warning, which is part of the 2011 engine). If you have added any additional business rules or customized the default business rules, these will not be automatically deactivated. So you should review these customizations, and manually deactivate such business rules, before making this change. |

The default Process SLAs rule on the task table will also be deactivated, so any customizations to this script must be incorporated into the new SLA engine.

In addition, breach information is removed from the Stage field, and stored in the new Has breached field.

To enable the new functionality:

1. Navigate to Service Level Management > SLA Properties.
2. Change the following property from 2010 to 2011:

Which version of SLA engine to run (Default ‘2011’ for new installations)

2010

By default, the 2011 Engine sets the Stage field to In Progress, shaded red to indicate the breached status, and sets the Has Breached field to true. The SLA continues to run until the stop conditions are met.

Organize the migration process

There are several ways to convert the old SLAs to the new Task SLAs.
Perform the following steps to organize the conversion process:

1. Convert the old SLAs to new SLA Definitions, but leave the Active flag unchecked on each one.
2. Back up the old SLAs by exporting the table to XML.
3. Deactivate the old SLAs, setting the Run the old SLA engine (System Policy -> SLA Management) system property (com.snc.sla.run_old_sla_engine) to false. This deactivates the legacy SLA engine preventing both engines from running and conflicting. This property is set to true by default, but will be set to false by the new SLA plugins, effectively deactivating the old SLAs.
4. Activate the new SLA Definitions by checking the Active flags on each one.
5. Navigate to Incident > Open and use the List Editor to "touch" each record. As each record is updated, the new Task SLA will attach to each incident. If there are too many open incidents to effectively touch using the List Editor, run a business rule that will update every open incident.

**Convert an SLA to an SLA Definition**

You must replicate the default SLA record as a new SLA definition.

1. Transfer the Name and Table fields.
2. If desired, check the Retroactively Start checkbox.
   If checked, this will cause the SLA to calculate from the moment the record is created (or from the date and time on the selected task), rather than the moment the SLA is attached. This is especially helpful for Task SLAs that will attach to active incidents that have old SLAs currently running.
3. Transfer the Conditions field to the Start Conditions field. Make sure to add Active is True as well, so that the new Task SLAs don't attach to closed incidents when they are updated.
5. Set the Duration Type and Duration fields. The old SLAs did not support relative duration, so to define the Task SLA to behave similarly to the old SLA, select User Defined Duration as the Duration Type and put the total length of time of all of the escalations here. For instance, an old SLA that has escalations of 4 hours to Moderate, 2 hours to High, and 2 hours to Overdue, the new Task SLA should have Duration set to Days 0 Hours 08:00:00.
6. Calendars have been replaced by Schedules, so if schedules haven't been defined yet, they will need to be.
7. Instead of escalations, attach an SLA Workflow.
   There is a default SLA workflow, however, you must create a new workflow to replicate the escalation levels on the old SLA. Escalation Levels are defined hour-by-hour, whereas the SLA Workflow uses a percentage timer. So for the above example of 4 hours to Moderate, 2 hours to High, and 2 hours to overdue, the workflow will need a 50% timer and then two 25% timers. The new task SLA records do not use the Escalation or Made SLA fields on the task record.

The following example is an old SLA for Priority 1 incidents to be resolved on a Monday-Friday (8-5) Calendar, with escalations to Moderate at 4 hours, to High at 2 hours, and to Overdue at 2 hours:
Figure 140: Old SLA Example

This is the new Task SLA created from the same information:
Figure 141: New SLA Example

This is the workflow which powers the new Task SLA.

**Note:** This example workflow responds to each escalation by firing off an event. A business rule can be configured to respond to escalation events, or the workflow can be adjusted to match the organization’s process.
Figure 142: New SLA Workflow

Task SLA table

The Task SLA [task_sla] table stores Task SLA records for the SLAs attached to particular tasks. For each task, attached SLAs are accessible in a related list on the Task’s form.
The SLA form for a task shows further details:

<table>
<thead>
<tr>
<th>Priority 1 resolution (8 hour)</th>
<th>Priority 2 resolution (24 hour)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA</td>
<td>SLA</td>
</tr>
<tr>
<td>In progress</td>
<td>Cancelled</td>
</tr>
<tr>
<td>90 Days 12 Hours 58 Minutes</td>
<td>90 Days 12 Hours 58 Minutes</td>
</tr>
<tr>
<td>27,182.2</td>
<td>9,054.07</td>
</tr>
</tbody>
</table>
### Task SLA - Created 2015-06-03 05:53:41

<table>
<thead>
<tr>
<th>SLA definition</th>
<th>Priority 1 resolution (8 hour)</th>
<th>Stage</th>
<th>In progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>INC00000025</td>
<td>Schedule</td>
<td></td>
</tr>
<tr>
<td>Updated</td>
<td>2015-06-03 05:53:41</td>
<td>Timezone</td>
<td>US/Pacific-NW</td>
</tr>
</tbody>
</table>

#### Timings

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop time</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual elapsed time</td>
<td>Days 90</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hours 12 56 34</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual elapsed</td>
<td>27,162.2</td>
<td>Business</td>
<td>Days 00</td>
</tr>
<tr>
<td>percentage</td>
<td></td>
<td>elapsed</td>
<td>Hours 00 00 00</td>
</tr>
<tr>
<td>Actual time left</td>
<td>Days 0</td>
<td>percentage</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hours 00 00 00</td>
<td>Business</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>time left</td>
<td></td>
</tr>
</tbody>
</table>

Figure 144: Task SLA form
Stage values

The following **Stage** values are defined:

- In progress
- Cancelled
- Paused
- Completed

**Note:** The Breached stage value is also available for systems either using the 2010 SLA engine, or running in compatibility mode.

Timing information

The **Timings** fields on the Task SLA contain the crucial information powered by the SLA Engine:

**Table 222: Task SLA Time-Based Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The time the SLA was started.</td>
</tr>
<tr>
<td>Stop time</td>
<td>The time the SLA ended.</td>
</tr>
<tr>
<td>Breach time</td>
<td>The time the SLA will breach, adjusted for business pause duration (for task SLAs with a schedule specified) or pause duration (for task SLAs with no schedule). <strong>Note:</strong> Breach time is the same as Planned end time.</td>
</tr>
<tr>
<td>Actual Elapsed Time</td>
<td>Time between start time and now (minus pause duration).</td>
</tr>
<tr>
<td>Actual Elapsed Percentage</td>
<td>Percentage of total SLA that has elapsed (minus pause duration).</td>
</tr>
<tr>
<td>Actual Time Left</td>
<td>Time remaining until SLA breach.</td>
</tr>
<tr>
<td>Business Elapsed Time</td>
<td>Time within the specified schedule between start time and now (minus pause duration).</td>
</tr>
<tr>
<td>Business Elapsed Percentage</td>
<td>Percentage of total SLA that has elapsed within the specified schedule (minus pause duration).</td>
</tr>
<tr>
<td>Business Time Left</td>
<td>Time within the schedule remaining until SLA breach.</td>
</tr>
<tr>
<td>Original breach time</td>
<td>The date/time the SLA would breach, as calculated when the SLA is first attached. <strong>Note:</strong> You may have to configure the form to see this field.</td>
</tr>
</tbody>
</table>
Reactivate an old SLA Engine

To reactivate the old escalations SLA engine:

Update the property `com.snc.sla.run_old_sla_engine` to `true`.

Installed with Service Level Management

Several types of components are installed with service level management.
Activating the Service Level Management plugin adds or modifies several tables, script includes, and other components.

Tables installed with Service Level Management

Service Level Management adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Definition [contract_sla]</td>
<td>Provides the conditions, duration, and schedule for an SLA Definition.</td>
</tr>
<tr>
<td>SLA Conditions [sla_condition_class]</td>
<td>Defines how the conditions in the SLA Definition are used to determine the transitions between different stages of each task SLA.</td>
</tr>
<tr>
<td>SLA Repair Log[sla_repair_log]</td>
<td>Used to provide a log of when the SLA Repair function is set to action.</td>
</tr>
<tr>
<td>SLA Repair Log Entry [sla_repair_log_entry]</td>
<td>Extends syslog and stores the before or after values of a task SLA record that has been repaired.</td>
</tr>
<tr>
<td>Task SLA [task_sla]</td>
<td>Associates a task with the SLA Definition that applies to it.</td>
</tr>
</tbody>
</table>

Properties installed with Service Level Management

Service Level Management adds the following system properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| SLA Engine properties | Core SLA properties.  
See `SLA Engine properties` on page 830 for details. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Logging properties</td>
<td>Properties to configure SLA logging. See <em>SLA Logging properties</em> on page 833 for details.</td>
</tr>
<tr>
<td>SLA Repair properties</td>
<td>Properties to configure SLA repair functions. See <em>SLA Repair properties</em> on page 834 for details.</td>
</tr>
</tbody>
</table>

**UI actions installed with Service Level Management**

Service Level Management adds the following UI actions.

**Table 225: Service Level Agreement UI actions**

<table>
<thead>
<tr>
<th>UI action</th>
<th>Tables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Task SLA [task_sla]</td>
<td>Calculates up to date timing information for the task SLA and then reloads the form.</td>
</tr>
<tr>
<td>Show Workflow</td>
<td>Task SLA [task_sla]</td>
<td>Displays the workflow in a pop-up window.</td>
</tr>
<tr>
<td>Show Schedule</td>
<td>SLA Definition [contract_sla]</td>
<td>Displays the schedule in a calendar view in a new window or tab.</td>
</tr>
<tr>
<td>Show SLA Timeline</td>
<td>Task SLA [task_sla]</td>
<td>List context menu. Displays a timeline visualization of the Task SLA including highlighting periods of pause time and when the SLA breaches.</td>
</tr>
<tr>
<td>Show SLA Timeline</td>
<td>Task SLA [task_sla]</td>
<td>Form action. Displays a timeline visualization of the Task SLA including highlighting periods of pause time and when the SLA breaches.</td>
</tr>
<tr>
<td>Show SLA Timeline</td>
<td>SLA Definition [contract_sla]</td>
<td>Form action. Opens the SLA timeline visualization form with no task record selected. The user can then choose which record to show the SLA timeline visualization for.</td>
</tr>
</tbody>
</table>
### UI actions

<table>
<thead>
<tr>
<th>UI action</th>
<th>Tables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show progress</td>
<td>SLA Repair Log [sla_repair_log]</td>
<td>Opens the progress dialog for an SLA repair that is still in progress.</td>
</tr>
<tr>
<td>Repair all filtered SLAs</td>
<td>Task SLA [task_sla]</td>
<td>Initiates a repair for all the task SLAs in the list.</td>
</tr>
<tr>
<td>Repair SLAs</td>
<td>Task [task]</td>
<td>Form action. Initiates a repair for all the task SLAs related to the task.</td>
</tr>
<tr>
<td>Repair SLAs</td>
<td>Task [task]</td>
<td>Available as a list action. Initiates a repair for the task SLAs that have been selected (checked). This is applicable to UI11 only.</td>
</tr>
<tr>
<td>Repair SLAs</td>
<td>Task [task]</td>
<td>Available as a list action. Initiates a repair for the task SLAs that have been selected (checked). This is applicable to UI16 only.</td>
</tr>
<tr>
<td>Repair</td>
<td>Task SLA [task_sla]</td>
<td>Form action. Initiates a repair for the task SLA record.</td>
</tr>
<tr>
<td>Repair SLAs</td>
<td>Task SLA [task_sla]</td>
<td>Available as a list action. Initiates a repair for the task SLAs that have been selected (checked).</td>
</tr>
</tbody>
</table>

### UI policies installed with Service Level Management

Service Level Management adds the following UI policies.

**Table 226: Service Level Agreement UI policies**

<table>
<thead>
<tr>
<th>UI policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show duration field</td>
<td>SLA Definition [contract_sla]</td>
<td>Hide/shows fields when the duration type is not specified.</td>
</tr>
<tr>
<td>Retroactive start</td>
<td>SLA Definition [contract_sla]</td>
<td>Shows set start to field when retroactive start is true.</td>
</tr>
<tr>
<td>Hide execution tracker</td>
<td>SLA Repair Log [sla_repair_log]</td>
<td>Unconditionally hide the execution tracker field.</td>
</tr>
<tr>
<td>Hide Pause time</td>
<td>Task SLA [task_sla]</td>
<td>Unconditionally hide the pause time field.</td>
</tr>
</tbody>
</table>

### Script includes installed with Service Level Management

Service Level Management adds the following script includes.
**Table 227: Script includes for service level management**

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLAUIActions</td>
<td>Determines whether a UI Action should be displayed or hidden for the SLA application and the tables it supports.</td>
</tr>
<tr>
<td>SLARepair</td>
<td>Provides functions to repair SLAs based on records, filters or sys ids of records from the contract_sla, task_sla or task tables.</td>
</tr>
<tr>
<td>SLARepairLog</td>
<td>Provides methods to record audit information about the Task SLAs that are repaired by calls to SLARepair.</td>
</tr>
<tr>
<td>SLARepairAJAXProcessor</td>
<td>Exposes an API which allows clients to invoke the Repair SLAs functionality and be notified once the repair has completed.</td>
</tr>
<tr>
<td>RepairTaskSLA</td>
<td>Extensions of TaskSLA to allow for the changes necessary to repair SLAs without changing the normal SLA calculation process.</td>
</tr>
<tr>
<td>RepairTaskSLAController</td>
<td>Extension of TaskSLAController to allow for the changes necessary to repair SLAs without changing the normal SLA calculation process.</td>
</tr>
<tr>
<td>TaskSLA</td>
<td>An abstraction around a task_sla record that allows for transitioning it through its various states.</td>
</tr>
<tr>
<td>SLAWorkflowDuration</td>
<td>Allows current to be configured as task or task_sla when the workflow duration is being calculated.</td>
</tr>
<tr>
<td>SLACalculatorNG</td>
<td>Provides services to help calculate updates to task_sla records.</td>
</tr>
<tr>
<td>SLAMessage</td>
<td>Provides services to generate the messages that get displayed on the task_sla form.</td>
</tr>
<tr>
<td>TaskSLAController</td>
<td>Checks the SLA conditions and update the task_sla records and any related workflows.</td>
</tr>
<tr>
<td>TaskSLAworkflow</td>
<td>Controls the task_sla workflow.</td>
</tr>
<tr>
<td>SLAConditionBase</td>
<td>Base class of methods to test a contract_sla's conditions, at key points in the TaskSLA state machine.</td>
</tr>
<tr>
<td>TaskSLALogging</td>
<td>A collection of helper methods suitable for use for task_sla logging purposes.</td>
</tr>
<tr>
<td>SLAvalidation</td>
<td>Provides a set of functions which allow the Caller to validate particular characteristics of their SLA records.</td>
</tr>
<tr>
<td>SLAProperties</td>
<td>Provides helper methods to test and set various SLA properties.</td>
</tr>
<tr>
<td>SLACalculator</td>
<td>Provides functions that calculate updated values for task_sla records.</td>
</tr>
</tbody>
</table>
### Script include

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLABreachChange</td>
</tr>
<tr>
<td>SLAEngineChange</td>
</tr>
<tr>
<td>SLATimezone</td>
</tr>
<tr>
<td>SLASchedule</td>
</tr>
<tr>
<td>SLACConditionSimple</td>
</tr>
<tr>
<td>SLADefinitionSNC</td>
</tr>
<tr>
<td>SLADefinition</td>
</tr>
<tr>
<td>SLADefinitionAJAX</td>
</tr>
<tr>
<td>RepairTaskSLAWorkflow</td>
</tr>
<tr>
<td>SLAREpairProperties</td>
</tr>
</tbody>
</table>

### Client scripts installed with Service Level Management

Service Level Management adds the following client scripts.

**Table 228: Client scripts for service level management**

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form message - Example end time</td>
<td>SLA Definition [contract_sla] duration</td>
<td>Displays an information message providing an example breach time based on the values in the definition.</td>
</tr>
<tr>
<td>Form message - Example end time</td>
<td>SLA Definition [contract_sla] duration type</td>
<td>Displays an information message providing an example breach time based on the values in the definition.</td>
</tr>
<tr>
<td>Client script</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Form message - Example end time</td>
<td>SLA Definition [contract_sla]</td>
<td>Displays an information message on the schedule field when the schedule is changed.</td>
</tr>
<tr>
<td></td>
<td>schedule</td>
<td></td>
</tr>
<tr>
<td>Form message - Example end time</td>
<td>SLA Definition [contract_sla]</td>
<td>Displays an information message providing an example breach time based on the values in the definition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field Message - Pause condition</td>
<td>SLA Definition [contract_sla]</td>
<td>Displays an information message on the <strong>Pause condition</strong> field when Duration type is not a user specified duration.</td>
</tr>
<tr>
<td></td>
<td>Duration type</td>
<td></td>
</tr>
<tr>
<td>Field Message - Schedule</td>
<td>SLA Definition [contract_sla]</td>
<td>Displays an information message on the schedule field when it is empty.</td>
</tr>
<tr>
<td></td>
<td>Schedule</td>
<td></td>
</tr>
<tr>
<td>Field messages</td>
<td>Task SLA [task_sla]</td>
<td>Displays an information message on the stage field with the pause time when a task SLA is paused.</td>
</tr>
</tbody>
</table>

**Business rules installed with Service Level Management**

Service Level Management adds the following business rules.

**Table 229: Business rules for service level management**

<table>
<thead>
<tr>
<th>Business rule name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Definition Empty Schedule Warning</td>
<td>SLA Definition [contract_sla]</td>
<td>Display an error message if no active entries in the definition’s schedule or child schedules.</td>
</tr>
<tr>
<td>SLA Workflow Condition Check</td>
<td>SLA Definition [contract_sla]</td>
<td>Display an error message if the definition has a workflow with a condition type or a condition set.</td>
</tr>
<tr>
<td>Pause SLA</td>
<td>Task SLA [task_sla]</td>
<td>Sets the pause time for the task_sla record and deletes all sys_trigger records associated with it.</td>
</tr>
<tr>
<td>Resume SLA</td>
<td>Task SLA [task_sla]</td>
<td>Sets the pause duration and clears out the pause time for the task_sla record.</td>
</tr>
<tr>
<td>Resume Workflow</td>
<td>Task SLA [task_sla]</td>
<td>Broadcasts an event to resume the current workflow.</td>
</tr>
<tr>
<td>Business rule name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Run SLA calculation</td>
<td>Task SLA [task_sla]</td>
<td>Performs a recalculation of the timings for a task SLA record.</td>
</tr>
<tr>
<td>Task SLA Empty Schedule Warning</td>
<td>Task SLA [task_sla]</td>
<td>Display an error message if neither the task_sla record’s schedule or child schedules contain any active entries.</td>
</tr>
<tr>
<td>SLA Engine version changed</td>
<td>System Property [sys_properties]</td>
<td>Update SLA Engine business rules, and SLA triggers, when the SLA Engine version is changed.</td>
</tr>
<tr>
<td>SLA Breach compatibility validate change</td>
<td>System Property [sys_properties]</td>
<td>Ensure that the 2011 SLA Engine breach compatibility property change is valid.</td>
</tr>
<tr>
<td>SLA Repair enabled flag changed</td>
<td>System Property [sys_properties]</td>
<td>When the “Enable SLA Repair” property is changed make the appropriate updates to enable/disable the UI actions and modules associated with SLA Repair.</td>
</tr>
<tr>
<td>SLA Breach compatibility option changed</td>
<td>System Property [sys_properties]</td>
<td>Update SLA stage values appropriately, when the 2011 SLA Engine breach compatibility property has been changed.</td>
</tr>
<tr>
<td>SLA Engine version validate change</td>
<td>System Property [sys_properties]</td>
<td>Ensure that the SLA Engine version property change is valid.</td>
</tr>
<tr>
<td>SLA Repair validate workflow name change</td>
<td>System Property [sys_properties]</td>
<td>Ensure that the workflow name specified in the repair workflow property is valid.</td>
</tr>
<tr>
<td>Calc SLAs on Display</td>
<td>Task [task]</td>
<td>Recalculates the task SLA records when a task's form is displayed and system property “glide.sla.calculate_on_display” is true.</td>
</tr>
<tr>
<td>Process SLAs</td>
<td>Task [task]</td>
<td>Creates new task SLAs and then processes all active SLAs for the task. This applies to the 2010 engine only.</td>
</tr>
<tr>
<td>Run SLAs</td>
<td>Task [task]</td>
<td>Executes the run function of TaskSLAController to create new Task SLAs and then process the existing ones for the Task. This applies to the 2011 engine only.</td>
</tr>
<tr>
<td>SLA Workflow Condition Type</td>
<td>Workflow Version [wf_workflow_version]</td>
<td>If the workflow is for task SLAs, then set the condition type field empty.</td>
</tr>
</tbody>
</table>
### Email notifications installed with Service Level Management

#### Email notifications

Service Level Management uses the following email notifications.

**Table 230: Email notifications for service level management**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA warning</td>
<td>Used to send a warning message as an SLA approaches the breach time.</td>
</tr>
<tr>
<td>SLA breached</td>
<td>Used to send a warning message when an SLA breaches.</td>
</tr>
<tr>
<td>SLA Repair Complete</td>
<td>Sends an email when an SLA Repair job completes which includes a link to the repair log record.</td>
</tr>
</tbody>
</table>
Scheduled jobs installed with Service Level Management

Scheduled jobs

Service Level Management adds the following scheduled jobs.

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA update (already breached)</td>
<td>Refreshes the timings in task SLA records that have already breached. This</td>
</tr>
<tr>
<td></td>
<td>is limited to task SLAs where the breach time is within the last 365 days.</td>
</tr>
<tr>
<td></td>
<td>This job runs once a day.</td>
</tr>
<tr>
<td>SLA update (breach after 30 days)</td>
<td>Refreshes the timings in task SLA records where the breach time is more</td>
</tr>
<tr>
<td></td>
<td>than 30 days away. This is limited to task SLA records where the breach</td>
</tr>
<tr>
<td></td>
<td>time is within the next 365 days. This job runs every 5 days.</td>
</tr>
<tr>
<td>SLA update (breach within 1 day)</td>
<td>Refreshes the timings in task SLA records where the breach time is more</td>
</tr>
<tr>
<td></td>
<td>than 1 hour away and less than 24 hours away. This job runs every hour.</td>
</tr>
<tr>
<td>SLA update (breach within 1 hour)</td>
<td>Refreshes the timings in task SLA records where the breach time is more</td>
</tr>
<tr>
<td></td>
<td>than 10 minutes away and less than 1 hour away. This job runs every 10</td>
</tr>
<tr>
<td></td>
<td>minutes.</td>
</tr>
<tr>
<td>SLA update (breach within 10 min)</td>
<td>Refreshes the timings in task SLA records where the breach time is in the</td>
</tr>
<tr>
<td></td>
<td>next 10 minutes This job runs every minute.</td>
</tr>
<tr>
<td>SLA update (breach within 30 days)</td>
<td>Refreshes the timings in task SLA records where the breach time is more</td>
</tr>
<tr>
<td></td>
<td>than 1 day away and less than 30 days away. This job runs once a day.</td>
</tr>
</tbody>
</table>

Workflows installed with Service Level Management

Workflows

Service Level Management adds the following workflows.
Table 232: Workflows for service level management

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default SLA workflow</td>
<td>Sends notifications at various check points of the SLA’s life span to notify the assignee of the duration left before it has breached. This workflow is also configured to work with the SLA Repair functionality to skip notifications being sent on a repair of SLAs.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This workflow is used by default for new instances.</td>
</tr>
<tr>
<td>Default SLA Repair workflow</td>
<td>This workflow is designed to work with the SLA Repair functions for upgraded instances where the default SLA workflow may have been customized. It is equivalent to the default SLA workflow with the addition of repair conditions on certain activities. The repair conditions will skip notifications being sent for an SLA that is being repaired.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The SLA repair function uses this workflow by default for upgraded instances because the Default SLA workflow may have been customized.</td>
</tr>
</tbody>
</table>

Service Portfolio Management

Service Portfolio Management addresses three core business needs.

- The plugin can be used to document the various business services offered using a standardized, structured format. This list of offerings can be offered to the user base in a consumer-friendly catalog.
- Once services are defined, the system will start automatically tracking performance against defined availability commitments. If outages are reported, the platform handles availability tracking.
- Once service offerings are documented and performance is being tracked, the information can be relayed in realtime performance gauges available to end users. These gauges can be displayed on customized homepages, or users can view their My Subscriptions home page and see the status of any service offerings to which they are subscribed.

Installed with Service Portfolio Management

Service Portfolio Management installs the following components.
Table 233: Service Portfolio Management components

<table>
<thead>
<tr>
<th>Component</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Rule</td>
<td>Recalculate Availability</td>
<td>Performs availability calculations when an outage is created or modified.</td>
</tr>
<tr>
<td>Script Include</td>
<td>AvailabilitySummarizer</td>
<td>Summarizes daily availability for Service Offerings that have availability commitments.</td>
</tr>
<tr>
<td>Scheduled Job</td>
<td>Calculate Availability</td>
<td>Runs every night to calculate the availability of Service Offerings that have availability commitments.</td>
</tr>
<tr>
<td>Module</td>
<td>Business Service Entries</td>
<td>Located in the Service Catalog application, this module enables an administrator to define which Business Services appear in the Business Service Catalog that end users see.</td>
</tr>
<tr>
<td>Homepage gauge</td>
<td>My Service Subscriptions</td>
<td>This gauge displays all service offerings to which the user is subscribed.</td>
</tr>
</tbody>
</table>

Table 234: Service Portfolio Management tables

<table>
<thead>
<tr>
<th>Display Name [Table Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Offering [service_offering]</td>
<td>Extends the cmdb_ci_service table. The Subscribes to Service Related List that is available in the User form uses this table.</td>
</tr>
<tr>
<td>Service Commitments [service_offering_commitment]</td>
<td>Stores records from the Service Commitments Related List in the Service Offerings form.</td>
</tr>
<tr>
<td>Service Scope [service_scope]</td>
<td>Stores user-defined limits to the service levels of a Business Service.</td>
</tr>
</tbody>
</table>

Set up Service Portfolio Management

Set up Service Portfolio Management to define business services, document them, track performance against defined availability commitments, and relay the performance information in real-time to your end users.

To set up and use Service Portfolio Management:

1. Define the service offerings and commitments
   Create Service Offering records that define different levels of service for an existing Business Service. For example, you might offer two levels of Desktop Support in your organization, a Standard offering for upgrades and virus protection, and an Executive offering that also includes some type of availability guarantee. Create a complete set of Service offerings on page 892, defined by Service commitments on page 895 which define the specifics of the offering.
2. Define the scope of the service offerings
   Scope in Service Portfolio Management refers to the detailed service parameters that define the limits of a Business Service. Specific additional services related to the Business Service can be defined as **In Scope** or **Out of Scope**. For instructions on creating and applying scope definitions to Business Services, see *Business service scope* on page 890.

3. Configure the price of the service offering
   Each Service Offering must have a pricing model and a price unit. These values are set on the parent Business Service and are inherited by the offerings, which then must establish the actual price per unit that is charged for the service. For details, see *Service pricing* on page 898.

4. Configure the business service catalog for the end user
   All the data created in the previous steps is displayed on the Service Catalog page for a Business Service. The layout of this page is not configurable, but an administrator can control how the Business Service is categorized and who can view the Business Service in the Catalog. For details see *Business service catalog* on page 884.

5. Subscribe to the service offering by users
   Subscribe your users to a Service Offering. Subscribed users can then add availability data as gauges to their home page for each Service Subscription they have. Each gauge contains links that enable the user to open the Service Offering record, display an availability report, or create an outage. See *Service subscriptions* on page 899 for information on subscribing to Service Offerings.

### Business service catalog

A module installed with the Service Portfolio Management plugin enables an administrator to control what services an end user is allowed to see in the Service Catalog and how those services are categorized.

**Note:** Functionality described here requires the Service Portfolio Management plugin.

The Business Service Catalog retrieves the information it displays from the following records:

- Business Service Scope
- Price model
- Service Offerings
- Service Commitments

### Configure business service entries

To list the business services that you provide, include them in the Service Catalog and make them active for your customers to see. Use categories to organize your business services.

Role required: catalog_admin or admin

1. Navigate to *Service Catalog > Catalog Policies > Business Service Entries*
2. Click **New**.
3. Select a **Business Service** that you want to make it available in the Service Catalog.
Business Service Catalog Entry
New record

Name: Executive Laptop Support

Catalogs:

Category: If you want users to be able to search for this item, add it to a Category

Icon: Click to add...

Short description:

Description:

Picture: Click to add...

Submit  Try It
4. Enter a **Name** for the catalog item.
5. Click the lock icon to open the **Catalogs** field and add Service Catalog.
6. Select a **Category** under which this business service is listed.
7. Verify that the **Active** check box is selected.
8. Optional: Add a **Short description** and **Description**.
9. Attach a graphic to display at the top of the Service Catalog page for this business service.
10. Click the **Preview Item** link to view the layout of the Service Catalog page. The details of the functionality you have configured for the business service opens in a read-only pop-up window.
Directors and above use this business service to request support for their laptop.

**Service Scope**

<table>
<thead>
<tr>
<th>In Scope</th>
<th>Out of Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure network access</td>
<td>Replace power cord</td>
</tr>
<tr>
<td>Configure wireless card</td>
<td></td>
</tr>
<tr>
<td>Install software</td>
<td></td>
</tr>
<tr>
<td>Troubleshoot applications</td>
<td></td>
</tr>
</tbody>
</table>

**Price model:** per

**Service Offerings**

**Executive Laptop Support**

- Operational
- **Location:** San Diego
- **Manager:** David Lo
- **Tech Contact:**
- **Billed Monthly:** $0.00 per
- **Commitments:**
  - Service Pack Upgrades Response time
  - Virus Protection updates

© 2017 ServiceNow. All rights reserved.
11. Close the preview pane, right-click the header, and click Save.
   Modifying the line items that appear in each service offering, such as Location and Billed Monthly, requires knowledge of scripting and Jelly tags. The service offering line items can be modified by navigating to System UI > UI Macros and selecting the UI macro named servicecatalog_delivery. For more information, see UI Macros.

Make the business service visible in the business service catalog

After you configure the service catalog entry for your business service, configure the service catalog to display the service.

1. Navigate to Business Services > Business Service Catalog.
2. If the category in which your Business Service appears is not in the Service Catalog, click the plus sign for Add Content in the upper right corner.
3. In the list of Sections, select the desired category and position it on the page by clicking Add here.
Hosting Services [Service Catalog]

Hosting Services
Hosting services for servers, applications, or other forms of compute infrastructure.
4. Close the selection list, and then click the Business Service you just added to check the contents of the Service Catalog page.

Business service scope

Scope is an arbitrary detail that is used to define the limits of a business service.

**Note:** Functionality described here requires the Service Portfolio Management plugin.

Scope items can be of any type or granularity and are used to define what the Business Service can provide (*In Scope*) and what it cannot provide (*Out of Scope*). Scope allows an administrator to grant or deny specific services that define a more detailed view of a Business Service. For example, *Nightly Backups* might be In Scope for the Desktop Support Business Service, but *Disaster Recovery* is Out of Scope.

The *In Scope* and *Out of Scope* definitions appear in the Business Service Catalog page that end users see when they access the Service Catalog.

**Applying Scope to a Business Service**

To view the entire list of scope entries in your system, add `service_scope_list.do` to the end of your instance address and press Enter.

1. Navigate to Business Services > Business Services.

2. Select a Business Service for which you want to define scope.

   Only a parent Business Services can have scope.

3. Click **New** in either list to create a new *In Scope* or *Out of Scope* definition or click **Edit** to add an existing scope definition.

   These can be anything that is pertinent to the Business Service and helps define the limits of the service that is being offered.

4. Give the scope item a descriptive name and a definition.
5. Click **Submit**.

The new scope definition appears in the list in which it was created.

**Figure 146: Applying Scope to a Business Service**
6. Create another scope definition or select one from the existing list.

Service offerings

A service offering derives from a business service, refining the parent business service to a specific business need.

Service offerings are the starting point for configuring Service Portfolio Management.

A Service Offering consists of a set of Service Commitments which uniquely define the service offering’s level of service in terms of availability, scope and pricing. For example, an organization may offer two levels of Desktop Support in your organization: a Standard offering of upgrades and virus protection and an Executive offering with the standard commitments plus some type of availability guarantee, such as 98% availability from 8-5 on weekdays.

To create a service offering:

1. Navigate to Business Services > Service Offerings and click New.
2. Give the offering a unique and descriptive name.
3. Make sure to include the Parent service from the list of available Business Services.
4. Set the Price and select a currency.
   The Price model and the Price unit fields are read-only. These values can only be set in the Service Portfolio view of the parent Business Service.
5. In versions at Dublin and later, select a Vendor and a Contract for this service offering.
   This information is used when creating vendor credit records.
6. Complete the form, right-click in the header bar and select Save from the pop-up menu.
   The related lists for the offering appear.
7. Configure Service Commitments and Subscribe by User using the procedures in this page.

Note:

Modifying the line items (such as Location, Manager, Tech Contact, and Billed Monthly) that appear in each service offering requires knowledge of scripting and Jelly. The service offering line items can be modified by navigating to System UI > UI Macros and selecting the UI macro named servicecatalog_delivery.

Availability report

When a service commitment contains an availability guarantee, the service offering form displays an availability commitment report that is generated on the fly.

This report tracks the actual availability of the offering. For a 7 day chart, no reporting data is available until 5 days after the service offering is created. For 30 day charts, 23 days of data is required before a report can be generated, and for a 12 month chart, the database must contain at least 10 months of data.

Click the links under the different availability commitments to see the charts for those time periods. The completed Service Offering form with an active availability report looks like this:
Figure 147: Service Offering Availability

Availability Commitment Reports
99% Availability 24x7
- Last 7 days
- Last 30 days
- Last 12 months

99.97% Availability London Hours
- Last 7 days
- Last 30 days
- Last 12 months

Bond Trading London availability (Last 12 months) against 99.97% Availability London Hours

Service Commitments (7)
- 20 Minute Response Time Business Hours
- 99.97% Availability 24x7
- 99.97% Availability London Hours
- P1 Response Time 24x7 (95%)
- P1 Resolution Time 24x7 (90%)
- P2 Response Time 24x7 (90%)
- P2 Resolution Time LA Hours (90%)

Related Links
Subscribed by Group (2)
Subscribed by Location
Subscribed by Department
Subscribed by User (2)
Subscribed by Company
Service Offering SLA Results (1,760)
Outages

Service commitments for availability can be adjusted with commitments for maintenance to accommodate planned outages.

Service Portfolio Management tracks and reports on outages for all Service Offerings that include availability commitments. Outages are recorded manually and tracked in reports in Service Offering records and in the Service Subscription gauges added to users’ home pages. There are three types of outages:

- **Outage**: Unplanned outages such as those caused by hardware or network issues. This is the only type of Outage considered when calculating availability of a service.
- **Planned outage**: Necessary outages caused by planned maintenance or upgrades.
- **Degradation**: Indicates a problem affecting a service that does not result in a disruption of that service.

To create an outage record:

1. Open a blank outage record using one of the following methods:
   - Navigate to **Business Services > Outages**.
   - Right-click in the header bar of a Service Subscription gauge in a home page with a status of Available and select **Create Outage record** from the pop-up menu.
2. In the Outage record, select the service offering from the list in the Configuration item field.
3. Select an outage Type.
4. Enter the text in the Message field that appears in the Service Offering gauge.
5. When added to the Homepage, this gauge is called My Services.
6. Define the length of the outage.
7. Select the Begin and End dates and times with the calendar, or enter the Duration as a function of days and hours.
8. Add a description of the outage in the Short Description field or leave it blank.
   - If you leave this field blank, the system adds a description automatically when you save the outage record, using the format <configuration item name> Outage. If vendor ticketing is activated, the system uses the short description to identify this outage in the Related outage field of the Vendor Credit form.
9. Click **Submit**.

The outage is used to evaluate the availability of the offering and appears in the reports generated for this offering.
Service commitments

Service commitments are specific services that define the unique availability guarantees, scope, and pricing for a service offering.

As a set, service commitments define the level of a business service.

A service offering derives from a business service, tailoring the parent business service to a specific business need. A service offering consists of a set of service commitments which uniquely define the service offerings.

1. Navigate to Business Services > Service Offerings.
2. Open a Service Offering record.
3. In the Service Commitments related list, click New.
4. Give the commitment a descriptive name.
   
   You can specify any kind of service.

5. Select the Type of commitment from the list.
   
   - Availability and Maintenance Window: Used in system processing. If you select Maintenance Window, the Schedule field is required.
   
   - Response Time, Delivery and Other: Display additional information in the Business Service Catalog. This information details the type of Service Commitment the user may expect from a given Service Offering. These Service Commitment types do not provide additional functionality or a homepage gauge.

   - Recovery time objective: Guarantee of how long it will take to recover the system from the recovery point. Set the recovery time in the Time Amount field that appears when you select this commitment type. This field is available with vendor ticketing.
• Recovery point objective: Guarantee of how often backups are performed. Set the backup interval in the Time amount field that appears when you select this commitment type. This field is available with vendor ticketing.
• SLA: Allows commitments to be defined by a Service Level Agreement (SLA) that tracks whether a vendor provides a level of service for a defined percentage of the time. The SLA results are calculated automatically and can be viewed on the My Services - SLAs homepage or in the Service Offering SLA Results table (Business Services > Service Offering SLAs > SLA Results).

6. Select a Vendor and a Contract for this service commitment. This information is used in when creating vendor credit records.
7. Enter the information needed to calculate credit owed by this vendor for any contract breaches. These fields are available with vendor ticketing
   • Breach penalty amount: Amount assessed per unit of time for a breach.
   • Per: Unit of time used to calculate the total credit owed for a breach.
   • Breach penalty time: Amount of free time provided by the vendor per breach.

8. Complete the form and click Submit. You are returned to the Service Offering form, and the new commitment appears in the Service Commitment Related List.
9. Click **New** to add another service commitment or click **Edit** to add an existing commitment to this offering.

To view all the commitments in the system, navigate to **Business Services > Commitments**. You can add, edit, or delete commitments in this module.

**Subscribe by user**

A service offering subscription for a user enables that user to add subscribed availability data as gauges to the home page.

These Service Subscriptions display the actual availability of an offering and indicate any outages, planned or otherwise. Links on the gauges allow the user to open a service offering record, open an outage record, or view an availability report. To add users to the subscribers list, click **Edit** in the Subscribed by user related list.
Service pricing

Each service offering in service portfolio management must have a price model and a price unit that is defined on the parent business service.

The actual price per unit is then set in the service offering record, which specifies the service commitments for the level of service delivered.

Set the service offering price

Every service offering that has the parent business service inherits the pricing structure. The actual price per unit is established in the service offering record using this price model and unit.

Every service offering that has this parent business service inherits the pricing structure. The actual price per unit is established in the service offering record using this price model and unit.

To set the service offering price, navigate to Business Services > Service Offerings and select an offering for which you have defined a pricing structure. Enter the Price for each service unit and update the record.

Set price models and units

Set the pricing structure for a service offering in the service portfolio view of the parent business service.

The service offering inherits the pricing model and unit description from its parent.

1. Navigate to Business Services > Business Services (the Service Portfolio view), and then select the parent Business Service to a Service Offering you have created.
2. Select a Price model.
   The choices are Per Unit and Fixed. If you select Per Unit, the Price unit field appears.
3. Type the name of a unit to use for pricing, such as service, server, person, etc.
4. Optional: Type a description in the Unit description field of the service that is delivered for a price unit.
5. Click Update.
Service subscriptions

Service portfolio management enables administrators to subscribe to service offerings by user.
Note: Functionality described here requires the Service Portfolio Management plugin.

Service Portfolio Management allows administrators to subscribe to Service Offerings by user. These users can then add each Service Subscription to their ServiceNow home page as gauges to display selected availability data. Each gauge has links that enable a user with a subscription to open the Service Offering record, display an availability report, or view an outage record.

Service subscription widget

Widgets display outage data, availability commitments, and availability performance over the last 7 days, 30 days, and 12 months.

Role required: You must have a role to add and edit homepages and dashboards.

You can add widgets to your dashboard that display availability data for the Service Offerings to which you are subscribed.

Widgets can be added for individual offerings or for all the offerings to which you are subscribed.

1. Click Add content in the upper left corner of the home page.
2. Select Service Offerings in the content list on the left to display all the choices.
3. Select individual offerings or select My Service Subscriptions to add all the gauges to which you are subscribed.
4. Select the location for the gauges and close the Add content dialog box.

• View selected availability reports: Click the availability percentage value (actual) to view a report for any of the three evaluation periods.

Figure 148: Service portfolio edit gauge 2

• Edit the outage record: Click the icon in the header bar of a gauge indicating an outage to open the record for that outage.
Subscribe to a service offering

Your users can subscribe to a service offering and they can add the subscribed availability data as gauges to their ServiceNow home page.

To subscribe to a service offering:

1. In a Service Offering record, click **Edit** in the Subscribe by User Related List.
2. In the slushbucket that appears, move the subscribed users to the Subscribed by User List.
3. Save your changes.

These users can now add a gauge for this Service Offering to their ServiceNow homepages.

Service 360

Service 360 is an extension of Service Portfolio Management.

It enhances a user’s Service Portfolio by rendering a powerful, consolidated visualization—a single view shows business service performance across a customer’s entire organization for business processes such as Operation, Risk, Investment, and Finance.
As a reporting tool, Service 360 leverages Performance Analytics to provide an executive-centric approach to Service Portfolio Management by identifying which business services require focus and attention. Service 360 helps executives find answers to the following questions.

- Are my services operational?
- Are my services cost effective?
- Are my services governed & secure?

The tool answers these questions through two reporting layers.

1. A dynamic treemap that is a D3 rendering of all business services across an entire organization based on a score from a specific Category and an Indicator from the Category.

2. A dashboard, which is a scorecard, that leverages Performance Analytics to render reports from key performance indicators to provide a true 360-degree view into a single Business Service.

Performance Analytics provides critical information about historic service performance (the past), shows real-time data about the process (the present), and forecasts service performance (the future) for customers. Using Service 360 and Performance Analytics together enhances the quality of an organization’s Service Portfolio by allowing executives and business service owners to quickly move from strategic to tactical by drilling down to specific records—all with just a few clicks.

Note: Service 360 is dependent on Performance Analytics for its reporting tools and capabilities. As such, Performance Analytics must be activated to use this product.

Key concepts

The following table defines key Service 360 concepts.

Note: Service 360 relies heavily on Performance Analytics for its reporting tools and capabilities.

Note: IE7 is no longer supported by Performance Analytics Dashboards.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Service</td>
<td>Any service that directly supports a business process, or a service that is delivered to business customers by business units.</td>
</tr>
<tr>
<td>Treemap</td>
<td>A D3 rendered hierarchy (similar to a heat map) that allows users to view specific scores from key performance indicators. For Service 360, the scores are related to business services.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Serves as the homepage for a specific Business Service. A dashboard can have multiple tabs, and each tab can hold one or more widgets. Only users with the pa_admin and pa_power_user roles can edit dashboards.</td>
</tr>
</tbody>
</table>
Tile
Displays a score for a specific record on the treemap when a category and indicator are selected. In the case of Service 360, each tile corresponds to a single Business Service. If click-through is enabled, a tile can be "clicked on" or selected to view additional information about the entity represented in the tile. Click-through is enabled for Service 360 out-of-box.

Category
A group of indicators on the treemap related to a specific, strategic business area. The out-of-box categories are Risk, Operation, Investment, and Finance.

Indicator
A type of performance measurement used by businesses to measure current conditions, and to forecast business trends. Indicators are commonly used to evaluate success. Success may be defined as making progress toward strategic goals, or as the repeated achievement of some level of operational goals (for example, zero breached service level agreements, or zero projects over budget).

Widget
A visual presentation of the indicator on a dashboard. Widgets can display the indicator as a chart, speedometer, dial, scorecard, or column based on various breakdowns like time series, scores, and location.

Service 360 application dependencies

Service 360 depends on other applications within ServiceNow to collect the data displayed in reports. Service 360 depends on the following plugins.

Note: Service 360 can work without all of the following plugins being activated. Data is collected and displayed if your organization is actively utilizing the various tools, like Risk Management and Financial Management, activated by the plugins. However, if one of the listed plugins is not activated, or is activated but not utilized, there is no data collected to display in the corresponding widgets, dashboard, and treemap. These components display with the message "No Records to Display," or "No data available."

Table 236: Plugin dependencies

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Plugin ID</th>
<th>Description</th>
</tr>
</thead>
</table>
To reap the benefits of Service 360, Performance Analytics — Premium plugin will have to be installed as well. This plugin will allow the user to automate recurring information needs with scorecards and dashboards and by taking configurable snapshots of any data at regular intervals. To activate both Service 360 and Performance Analytics — Premium, contact your ServiceNow account manager.

There are additional applications (Risk Management, Project Portfolio Management, and Financial Management) that require additional licenses to activate the plugins. Once activated, the following plugins populate the Service 360 treemap and dashboard with additional categories, indicators, and widgets.

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Plugin ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portfolio Management</td>
<td>com.snc.service_portfolio</td>
<td>Allows an organization to document the business services it proves using a standardized, structured format. Performance against availability commitments is calculated and can be displayed in a homepage.</td>
</tr>
<tr>
<td>Service Portfolio Management —SLA Commitments</td>
<td>com.snc.service_portfolio.sla</td>
<td>Adds SLA commitments to support Service Portfolio Management.</td>
</tr>
<tr>
<td>Incident Management</td>
<td>com.snc.incident</td>
<td>The base incident management plugin used to manage IT related incidents.</td>
</tr>
<tr>
<td>Problem Management</td>
<td>com.snc.problem</td>
<td>The base problem management plugin used to manage IT related problems.</td>
</tr>
<tr>
<td>Change Management</td>
<td>com.snc.change_request</td>
<td>The base change management plugin used to manage IT related change requests.</td>
</tr>
</tbody>
</table>

Table 237: Plugins that require additional licenses

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Plugin ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRC: Risk</td>
<td>com.sn_risk</td>
<td>Allows organizations to identify, assess, and respond to risk throughout the enterprise.</td>
</tr>
<tr>
<td>Financial Management</td>
<td>com.snc.finance_management</td>
<td>Enables Financial Analysts to assemble spending data, build cost models, and generate reports to show how funds are being used.</td>
</tr>
<tr>
<td>Project Portfolio Suite</td>
<td>com.snc.project_portfolio_suite</td>
<td>Activates an integrated set of applications for project portfolio management and IT software development.</td>
</tr>
</tbody>
</table>
Default configuration

To be useful as a reporting tool, Service 360 comes with fully configured indicators (both in Performance Analytics and Service 360), widgets, categories, dashboards, and treemaps, by default. Each indicator has its own treemap.

Default categories and indicators

The following categories and indicators are provided by default.

Table 238: Out-of-box categories and indicators in Service 360

<table>
<thead>
<tr>
<th>Category</th>
<th>Indicator</th>
<th>Dependency</th>
<th>Data Source</th>
<th>Time Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>Percent of Service Availability</td>
<td>Service Portfolio Management</td>
<td>service_availability</td>
<td>Historical</td>
<td>A measure of the actual availability of a particular service based on the duration of the uptime and downtime for a particular service’s offerings, commitments, and planned outages. The score displayed in the treemap is the most current percent of service availability.</td>
</tr>
<tr>
<td>Operation</td>
<td>Percent of SLA Tasks Achieved</td>
<td>Service Portfolio Management – SLA Commitments</td>
<td>service_sla_result</td>
<td>Historical</td>
<td>The percent of Service Level Agreement (SLA) tasks that are not violated, so that it is possible to measure the successful response to service commitments. The percent displayed in treemap is the most current.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------</td>
<td>-------------------------------------------</td>
<td>------------------</td>
<td>----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operation</td>
<td>Number of SLA Tasks Breached</td>
<td>Service Portfolio Management – SLA Commitments</td>
<td>service_sla_result</td>
<td>Real time</td>
<td>The number of Service Level Agreement (SLA) tasks that were not responded to at the guaranteed service commitment. The number displayed in the treemap, is the number of breached SLA tasks that are still active and unresolved.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------</td>
<td>------------</td>
<td>-------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Operation  | Net Promoter Score (NPS)       | Assessments| asmt_metric_result | Historical     | NPS is a measure of user satisfaction, which uses a 0-10 scale to divide the service consumers into three categories:  
• promoters (9-10)  
• passives (7-8)  
• detractors (0-6)  
NPS can be as low as -100 or as high as +100; anything above 0 is positive, but a score above +50 is excellent. Any score below 0 needs serious improvement. The score displayed in the treemap is from the most recent assessment, usually at the end of the previous quarter. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Indicator</th>
<th>Dependency</th>
<th>Data Source</th>
<th>Time Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>Number of Open Incidents</td>
<td>Incident Management</td>
<td>incident</td>
<td>Real time</td>
<td>Displays the number of open incidents on any given day to measure the workload of the Service Desk related to a single business service. The score is an indicator of issues with a particular service. The score displayed in the treemap is the most current score.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operation</td>
<td>Number of Open Problems</td>
<td>• Problem Management • Performance Analytics – Content Pack – Problem Management</td>
<td>problem</td>
<td>Real time</td>
<td>Display of the number of open problems on a given day to measure the workload of the Service Desk. The score is also an indicator of issues with a particular service. The score displayed in the treemap is the most current score. Note: By default, business services with smaller number of open changes is shown in a larger tile in the Service 360 treemap. To display the reverse (larger number shown in larger tile), go to Performance Analytics and set its Number of open changes indicator's direction to Minimize.</td>
</tr>
</tbody>
</table>

© 2017 ServiceNow. All rights reserved.
<table>
<thead>
<tr>
<th>Category</th>
<th>Indicator</th>
<th>Dependency</th>
<th>Data Source</th>
<th>Time Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>Number of Open Changes</td>
<td>• Change Management</td>
<td>change_request</td>
<td>Real time</td>
<td>Display of the number of open change requests to measure the workload of the Service Desk. The score displayed in the treemap is the most current score.</td>
</tr>
<tr>
<td>Risk</td>
<td>Inherent Score</td>
<td>GRC: Risk</td>
<td>sn_grc_profile</td>
<td>Historical</td>
<td>The inherent score of a risk is the known risk a particular entity, in this case a business service, poses to the organization. This score is based on the likelihood the risk would occur, and the significance of the risk if it did occur. The score displayed in the treemap is the most current score.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>------------</td>
<td>-----------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Risk</td>
<td>Residual Score</td>
<td>GRC: Risk</td>
<td>sn_grc_profile</td>
<td>Historical</td>
<td>The residual score of a risk is the lowest risk score a particular entity, in this case a business service, can achieve by employing controls and governance over the risk. The score is based on the likelihood the risk would occur, and the significance of the risk if it did occur after the risk is mitigated. The score displayed in the treemap is the most current score.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------</td>
<td>--------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Risk</td>
<td>Calculated Score</td>
<td>GRC: Risk</td>
<td>sn_grc_profile</td>
<td>Historical</td>
<td>The calculated score of a risk is the actual score for the amount of risk a particular entity, in this case a business service, poses to the organization. This score cannot be higher than the inherent score, and it cannot be lower than the residual score. The score displayed in the treemap is the most current score.</td>
</tr>
<tr>
<td>Investment</td>
<td>Number of Upcoming Projects</td>
<td>Project Portfolio Suite</td>
<td>pm_portfolio_project</td>
<td>Real time</td>
<td>The number of projects with a start date occurring after the current day. Once the start date occurs, the project is no longer counted. The number displayed in the treemap is the most current count.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------------------------------</td>
<td>-----------------------------</td>
<td>---------------------------</td>
<td>----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Investment</td>
<td>Number of Active Projects Over Budget</td>
<td>Project Portfolio Suite</td>
<td>pm_portfolio_project</td>
<td>Real time</td>
<td>A project is over budget if its actual cost-to-date is greater than its budgeted cost, which only applies to active projects. The score displayed in the treemap is the most current.</td>
</tr>
<tr>
<td>Investment</td>
<td>Total Budgeted Cost of Active Projects</td>
<td>Project Portfolio Suite</td>
<td>pm_portfolio_project</td>
<td>Real time</td>
<td>This cost is a sum of the budget for each active project that has a state set as work in progress. Used for project management planning only, not for any other calculations, or in Cost Management. The cost displayed in the treemap is the most current sum.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------</td>
<td>--------------------------</td>
<td>-------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Investment</td>
<td>Total Estimated Cost of Active Projects</td>
<td>Project Portfolio Suite</td>
<td>pm_portfolio_project</td>
<td>Real time</td>
<td>A rolled-up cost calculated from the sums of the estimated cost for all tasks in a project, if any exist. This cost per project is then summed again to display the total estimated cost in the treemap for all active projects relating to a specific business service. The cost displayed in the treemap is the most current.</td>
</tr>
<tr>
<td>Investment</td>
<td>Total Actual Cost of Active Projects</td>
<td>Project Portfolio Suite</td>
<td>pm_portfolio_project</td>
<td>Real time</td>
<td>A rolled-up cost calculated from the sums of the estimated costs for all tasks in a project, if any exist. This cost per project is then summed again to display they total actual cost in the treemap for all active projects relating to a specific business service. The cost displayed in the treemap is the most current.</td>
</tr>
<tr>
<td>Category</td>
<td>Indicator</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Time Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------</td>
<td>---------------------</td>
<td>------------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Finance</td>
<td>Cost Allocation</td>
<td>Financial Management</td>
<td>• itfm_cost_allocation</td>
<td>Historical</td>
<td>The cost allocated to a particular business service to keep it running and ensure its service offerings and commitments are met. It is the cost allocated per quarter using a default cost model.</td>
</tr>
</tbody>
</table>

**Note:**
This is a custom indicator taken directly from ITFM. Selecting a tile that corresponds to business service redirects you to the business service overview in the ITFM application, and not the Service 360 dashboard.
**Note:** Real time indicates that by drilling into a specific indicator, real time records are available to view real time data. The data displayed in the widgets and on the treemap are from the previous time frequency (for example, yesterday, last week, or last month).

---

### Default tabs and widgets in Performance Analytics

Since click-through is enabled for Service 360, if any one of the tiles on the treemap is selected, the user is able to drill-in to a Performance Analytics dashboard that contains numerous tabs with more specific widgets as well as additional indicators to achieve a true 360 degree view into the specific business service.

The following additional indicators are displayed in the widgets on the dashboard.

**Table 239: Additional out-of-box tabs and widgets in Performance Analytics**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Widget</th>
<th>Dependency</th>
<th>Data Source</th>
<th>Data Availability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Business Service Overview</td>
<td>N/A, custom widget</td>
<td>Business service Record</td>
<td>Real time</td>
<td>Displays key information pertaining to a specific Business Service. For example the Business Service Owner, the owner’s contact information, the business service’s business criticality, and operational status, all obtained from the Business Service record.</td>
</tr>
<tr>
<td>Availability</td>
<td>Average service availability trend</td>
<td>Service Portfolio Management</td>
<td>service_availability_historical</td>
<td>Displays a 90-day trend of the percent of service availability instead of a single score.</td>
<td></td>
</tr>
<tr>
<td>Tab</td>
<td>Widget</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Data Availability</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------</td>
<td>------------------------------------</td>
<td>----------------------</td>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Availability</td>
<td>Service availability by service offering</td>
<td>Service Portfolio Management</td>
<td>service_availability</td>
<td>Historical</td>
<td>A list of the service offerings for a particular business service to compare the availability of each service offering relative to another. Report of the percent availability per offering of the past four days, the trend of the availability over the past four days, and the percent change between the previous two day’s scores.</td>
</tr>
<tr>
<td>Availability</td>
<td>Service availability by service commitment</td>
<td>Service Portfolio Management</td>
<td>service_availability</td>
<td>Historical</td>
<td>A list of service commitments for a particular business service to compare the availability of each service commitment relative to another. Report of the percent availability per commitment of the past four days, the trend of the availability over the past four days, and the percent change between the previous two day’s scores.</td>
</tr>
<tr>
<td>Tab</td>
<td>Widget</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Data Availability</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------------</td>
<td>--------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NPS</td>
<td>NPS score by assessment metric</td>
<td>Assessments</td>
<td>asmt_metric_result</td>
<td>Historical</td>
<td>There are numerous assessment metrics, which are the particular questions, asked in a survey. This widget breaks down the scores by metric so it is easy to locate which areas of service are causing detractors, and thus those are the specific areas that need to be improved. NPS assessments are usually sent out quarterly, so this widget displays information from the previous quarter’s assessment.</td>
</tr>
<tr>
<td>NPS</td>
<td>NPS responses by quarter</td>
<td>Assessments</td>
<td>asmt_metric_result</td>
<td>Real time</td>
<td>Breaks down the scores for all respondents per quarter into passive, promoter, or detractor so that a user can quickly see if the number of detractors is increasing or decreasing over the past 4 quarters.</td>
</tr>
<tr>
<td>Tab</td>
<td>Widget</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Data Availability</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>--------</td>
<td>------------</td>
<td>-------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>NPS</td>
<td>Number of NPS respondents</td>
<td>Assessments</td>
<td>asmt_metric_result</td>
<td>Real time</td>
<td>A number that represents the number of people that responded to the NPS survey for a particular quarter. There is also a trend-line to see if the number is increasing or decreasing over time, as well as the percent of responses, to know what percent of the total surveys sent out were returned.</td>
</tr>
<tr>
<td>SLA</td>
<td>Achieved SLA task trend</td>
<td>Service Portfolio Management – SLA Commitments</td>
<td>service_sla_result</td>
<td>Real time</td>
<td>Displays a 7-day trend of the percent of SLA tasks achieved as well as the number of completed SLA tasks.</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk trend by type</td>
<td>GRC: Risk</td>
<td>sn_grc_profile</td>
<td>Historical</td>
<td>Can display a 7-day, 1-month, 3-month, 6-month, year-to-date, 1-year, or all-scores trend comparing inherent, residual, and calculated risk scores over the selected time.</td>
</tr>
<tr>
<td>Tab</td>
<td>Widget</td>
<td>Dependency</td>
<td>Data Source</td>
<td>Data Availability</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------</td>
<td>-----------------------------</td>
<td>------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Investment</td>
<td>Cost comparison of active projects</td>
<td>Project Portfolio Suite</td>
<td>pm_portfolio_project</td>
<td>Real time</td>
<td>Compares the budgeted, estimated, and actual costs for active projects side-by-side instead of as individual scores.</td>
</tr>
<tr>
<td>Investment</td>
<td>Completion percentage by project</td>
<td>Project Portfolio Suite</td>
<td>pm_portfolio_project</td>
<td>Real time</td>
<td>A list of all active projects and their respective completion percent as corresponding tasks are created, worked-on, and completed in the Project Management application.</td>
</tr>
<tr>
<td>Workload</td>
<td>Workload trend by type</td>
<td>incident, problem, change_request</td>
<td>Real time</td>
<td></td>
<td>Can display a 7-day, 1-month, 3-month, 6-month, year-to-date, 1-year, or all-scores trend, comparing the number of open incidents, problems, and changes over the selected time.</td>
</tr>
</tbody>
</table>

**Default breakdowns in Performance Analytics**

Incident Management, Problem Management, and Change Management are provided out-of-box, and are associated with the Workload indicators in Service 360. The workload indicators are supported by Performance Analytics—Content Packs for Incident Management, Change Management and Problem Management, which are premium plugins. If these content packs are activated prior to Service 360, and the indicators associated with workload are modified, activating Service 360 overrides the changes so that the indicators will work as they were originally intended. If the content packs are activated prior to Service 360, and the indicators associated with workload are deleted, activating Service 360 will not re-install the indicators, so there will be no indicators for workload.
By selecting any of these widgets on the dashboard, you are able to drill-in further to view a detailed scorecard for the indicator. A scorecard is an additional graphical visualization of the scores of an indicator. The basic look and feel of a scorecard cannot be changed, but they can be enhanced by adding targets, thresholds, trend lines, and useful comments for significant changes. In a scorecard, the scores of an indicator can be analyzed further by viewing the scores by breakdowns, aggregates, time series, and drilling down to the records on which the scores are based.

The following breakdowns are created to enhance Service 360.

Table 240: Additional out-of-box tabs and widgets in Performance Analytics

<table>
<thead>
<tr>
<th>Breakdown</th>
<th>Data Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Service</td>
<td>cmdb_ci_service</td>
<td>Breaks down indicator information, such as risk scores or active project information, by the business service it is associated with.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>service_offering</td>
<td>Breaks down the business service by associated service offerings.</td>
</tr>
<tr>
<td>Service Commitment</td>
<td>service_commitment</td>
<td>Breaks down the business service offerings by associated service commitments.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>sys_user</td>
<td>Breaks down the business services by different types of users.</td>
</tr>
<tr>
<td>NPS Metric</td>
<td>asmt_metric</td>
<td>Breaks down the NPS indicator by assessment metric on the NPS assessment.</td>
</tr>
<tr>
<td>NPS Response</td>
<td>sys_choice</td>
<td>Breaks down the NPS indicator by the type of response to the assessment i.e. was the respondent a promoter, passive, or detractor.</td>
</tr>
<tr>
<td>Service Projects</td>
<td>pm_project</td>
<td>Breaks down all projects in the Project Portfolio Suite to only gather data corresponding to business services.</td>
</tr>
<tr>
<td>Project Manager</td>
<td>sys_user</td>
<td>Breaks down the project indicator by users who are designated as a Project Manager.</td>
</tr>
<tr>
<td>Project Phase</td>
<td>sys_choice</td>
<td>Breaks down the project indicator by the phase or state by which the projects are designated.</td>
</tr>
<tr>
<td>Project Portfolio</td>
<td>pm_portfolio</td>
<td>Breaks down the projects by the portfolio to which they belong.</td>
</tr>
<tr>
<td>Breakdown</td>
<td>Data Source</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project Priority</td>
<td>sys_choice</td>
<td>Breaks down the projects by the priorities of the associated tasks in the project.</td>
</tr>
</tbody>
</table>

### Default jobs in Performance Analytics

Some of the indicators have weekly or monthly activity frequency, and thus do not have scores that change daily. Real-time data is still enabled for these indicators, however, the score may remain the same until the end of the frequency.

Jobs collect data for the provided indicators and breakdowns. These jobs are run on a set schedule, or can be executed at will by the pa_admin or pa_data_collector. All jobs collect data from the previous period. For example, if the time interval is set to collect data daily, then a daily job collector collects data from the previous day.

The following Performance Analytics jobs are provided out-of-box.

#### Table 241: Out-of-box jobs in Performance Analytics

<table>
<thead>
<tr>
<th>Job Name</th>
<th>Run Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[PA Service 360] Daily Collection for Operation</td>
<td>Daily</td>
<td>Collects data for all operation indicators, except those for workload, on a daily basis.</td>
</tr>
<tr>
<td>[PA Service 360] Daily Collection for Workload</td>
<td>Daily</td>
<td>Collects data for all workload indicators on a daily basis.</td>
</tr>
<tr>
<td>[PA Service 360] Monthly Collection for NPS</td>
<td>Monthly</td>
<td>Collects data for all NPS indicators on a monthly basis. NPS assessments may only be sent out once a quarter, so even though this runs once a month, the scores may be the same over multiple months.</td>
</tr>
<tr>
<td>[PA Service 360] Weekly Collection for Investment</td>
<td>Weekly</td>
<td>Collects data for all investment indicators on a weekly basis.</td>
</tr>
<tr>
<td>Job Name</td>
<td>Run Frequency</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| [PA Service 360] Weekly Collection for Risk | Weekly        | Collects data for all risk indicators on a weekly basis. Service 360 comes with sample risk historical PA scores for display purposes. Prior to pulling live risk data, delete these sample historical scores from Performance Analytics’ scoresheet. You will lose Risk history PA data if you at any point after using Service 360 for Risk decide to:  
  • Delete Performance Analytics scores collected for past time periods.  
  • Run the job using relative start data of past periods, which would over-write history data with current data, producing straight lines on trend. |

**Configure Service 360**

Service 360 uses Performance Analytics for reporting purposes and to provide answers to the questions of executives. As such, Performance Analytics must be activated to use this product.

To configure Service 360, create categories and indicators, then link Service 360 to Performance Analytics.

**Create categories**

You can create new categories in addition to the default ones.

To create new categories:

1. Navigate to Business Services > Administration > Categories.
2. Select New.
3. Complete the form using the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name*</td>
<td>Name of the new Category.</td>
</tr>
<tr>
<td>Treemap*</td>
<td>Designate the treemap on which the category appears. Unless you have created additional treemaps, this is typically Service 360.</td>
</tr>
<tr>
<td>Order</td>
<td>The order that the category appears in the list and dropdown once created. 100 is the top of the list and drop-downs, 200 is second, and so on in increments of 100.</td>
</tr>
<tr>
<td>Color</td>
<td>Select the color that the treemap displays when this category is selected.</td>
</tr>
</tbody>
</table>
### Additional indicators

You can create new indicators in addition to the default ones.

The steps to create indicators depend on the data source of the information you wish to display in the treemap.

**Create indicators for performance analytics**

Performance analytics is the primary method of establishing indicators for Service 360.

If the reporting tools from performance analytics are selected as the data source, it cannot be added to the Service 360 treemap until it is set up in Performance Analytics.

It is critical that the indicator is setup properly in Performance Analytics prior to being added to the treemap.

1. Use the following basic steps to create the desired indicator.

   a) Navigate to **Performance Analytics > Data Collector > Indicator Sources**. Create and define an Indicator Source, which forms the basis for the data that is collected. Indicator Sources can be reused for multiple indicators.

   b) Navigate to **Performance Analytics > Indicators > Breakdowns** to define a Breakdown. Breakdowns are sometimes referred to as dimensions because they divide data up by making cross-sections in different ways.

   c) Navigate to **Performance Analytics > Indicators > Automated Indicators** to create Automated Indicators, which are the most commonly used.

      **Note**: It is also possible to create Formula Indicators or Manual Indicators by navigating to the appropriate module.

   d) Navigate to **Performance Analytics > Data Collector > Jobs**. Create a job collector and/or schedule the Data Collection that collects the data to display on scorecards and dashboards.

   e) Navigate to **Performance Analytics > Widgets** to create and define a new widget that determines how an indicator is visually displayed.

   f) Once the widget is created, navigate to **Performance Analytics > Dashboards > Service 360** and add the widget to the appropriate tab on the dashboard.

2. Customize how you report on data kept in your ServiceNow instance.

3. Once the indicators are setup in Performance Analytics, navigate to **Business Services > Administration > Indicators**.

4. Click **New**.
5. Complete the form using the following table.

**Important:** Ensure that the **Data Source** field is set to **Performance Analytics** so that the previous configured indicator can be added to the treemap.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name*</td>
<td>Name of the new indicator.</td>
</tr>
<tr>
<td>Category*</td>
<td>Select the category with which you want this indicator to be grouped.</td>
</tr>
<tr>
<td></td>
<td>For example, the out-of-box indicators for availability are grouped under</td>
</tr>
<tr>
<td></td>
<td>the category <strong>Operation</strong>, while indicators for inherent and residual</td>
</tr>
<tr>
<td></td>
<td>risk scores are grouped under the <strong>Risk</strong> category.</td>
</tr>
<tr>
<td>Direction*</td>
<td>Options are <strong>Minimize</strong> or <strong>Maximize</strong>. Choose the direction that is</td>
</tr>
<tr>
<td></td>
<td>considered a positive change for the indicator. If the goal of the indicator</td>
</tr>
<tr>
<td></td>
<td>is to <strong>Minimize</strong> the score, then large value scores will have larger</td>
</tr>
<tr>
<td></td>
<td>tiles. The reverse is true for <strong>Maximize</strong>. For example, the goal of Risk</td>
</tr>
<tr>
<td></td>
<td>is to minimize the risk, so the direction is set to <strong>Minimize</strong> so that</td>
</tr>
<tr>
<td></td>
<td>higher risk scores appear more prominently in larger tiles.</td>
</tr>
<tr>
<td></td>
<td>Note: This field only appears if <strong>Data Source</strong> is set to <strong>Custom Script</strong></td>
</tr>
<tr>
<td></td>
<td>or <strong>Query Condition</strong>.</td>
</tr>
<tr>
<td>Result Limit*</td>
<td>Defines the maximum number of results allowed. The upper limit is 100.</td>
</tr>
<tr>
<td>Result Precision*</td>
<td>Select the number of decimal digits to display in the scores for the</td>
</tr>
<tr>
<td></td>
<td>indicators.</td>
</tr>
<tr>
<td></td>
<td>Note: This only appears if <strong>Data Source</strong> is set to <strong>Custom Script</strong> or</td>
</tr>
<tr>
<td></td>
<td><strong>Query Condition</strong>.</td>
</tr>
<tr>
<td>Automatic Refresh Interval</td>
<td>Used to identify the refresh frequency for the treemap.</td>
</tr>
<tr>
<td>Active</td>
<td>If this check box is not selected, the indicator does not display in the</td>
</tr>
<tr>
<td>Order</td>
<td>The order that an indicator appears in the drop-down menu and list for a</td>
</tr>
<tr>
<td></td>
<td>particular category. The order must correspond to the order value of the</td>
</tr>
<tr>
<td></td>
<td>category to which you want the indicator to belong. For example, if the</td>
</tr>
<tr>
<td></td>
<td>category order is 100, then the indicator order would start at 100 and</td>
</tr>
<tr>
<td></td>
<td>increase to 101, 102, and so on, incrementally.</td>
</tr>
<tr>
<td>Data Source</td>
<td>Defines the location from which this indicator receives data. The following</td>
</tr>
<tr>
<td></td>
<td>options are available.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Performance Analytics</strong>, which populates the treemap with the scores from indicators created in Performance Analytics. Indicators must be created in Performance Analytics prior to being created as an indicator in Service 360.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Custom Script</strong>, which allows you to write a script that collects data from another application to display in the treemap. Custom scripts only display on the treemap, and are not shown on the Service 360 dashboard.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Query Condition</strong>, which allows you to select a table to run filters on to obtain data to display in the treemap. Results from the query conditions only display in the treemap, and are not shown on the Service 360 dashboard.</td>
</tr>
<tr>
<td>PA indicator*</td>
<td>Select the indicator from Performance Analytics that is to be displayed on the treemap.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if <strong>Data Source</strong> is set to <strong>Performance Analytics</strong>.</td>
</tr>
<tr>
<td>Default Breakdown*</td>
<td>Select the default breakdown that determines how the indicator is displayed. In the case of Service 360, the default breakdown is <strong>Business Service</strong> so that the indicator displays the scores for each business service in the system respectively, if the data is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if <strong>Data Source</strong> is set to <strong>Performance Analytics</strong>.</td>
</tr>
<tr>
<td>Custom Script*</td>
<td>HTML editor that allows you to create and customize the script.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if <strong>Data Source</strong> is set to <strong>Custom Script</strong>.</td>
</tr>
<tr>
<td>Query Table*</td>
<td>Source table to be queried.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if <strong>Data Source</strong> is set to <strong>Query Condition</strong>.</td>
</tr>
<tr>
<td>Aggregate Type*</td>
<td>The function to apply when calculating the score for a query on the query table. Possible values are <strong>Count</strong>, <strong>Sum</strong>, <strong>Average</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggregate Field</td>
<td>The field on the Query Table on which the Aggregate Type is run. Note: This field only appears if Data Source is set to Query Condition.</td>
</tr>
<tr>
<td>Group by*</td>
<td>Select the field to sort the queried data. Note: This field only appears if Data Source is set to Query Condition.</td>
</tr>
<tr>
<td>Query Conditions</td>
<td>As needed, set filter conditions to enhance the query. Note: This field only appears if Data Source is set to Query Condition.</td>
</tr>
<tr>
<td>Click Through URL Navigation Type</td>
<td>This feature enables the treemap to drill-in to another display when a tile on the treemap is selected. For Service 360, when a tile is</td>
</tr>
<tr>
<td></td>
<td>selected you are re-directed to the Service 360 dashboard in Performance Analytics. There are three options: New Window, Current Window, or</td>
</tr>
<tr>
<td></td>
<td>Modal Dialog.</td>
</tr>
<tr>
<td>Click Through URL Script</td>
<td>Edit the sample script using the HTML editor to customize the URL that you are re-directed to when a tile on the treemap is selected.</td>
</tr>
</tbody>
</table>

Note: * indicates a mandatory field.

6. Click Submit.

Create indicators for custom scripts
Custom scripts are one of the data sources used to collect data for the treemap.

1. Navigate to Business Services > Administration > Indicator.
2. Click New.
3. Complete the form using the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name*</td>
<td>Name of the new indicator.</td>
</tr>
<tr>
<td>Category*</td>
<td>Select the category with which you want this indicator to be grouped. For example, the out-of-box indicators for availability are grouped</td>
</tr>
<tr>
<td></td>
<td>under the category Operation, while indicators for inherent and residual risk scores are grouped under the Risk category.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Direction</strong>*</td>
<td>Options are <strong>Minimize</strong> or <strong>Maximize</strong>. Choose the direction that is considered a positive change for the indicator. If the goal of the indicator is to <strong>Minimize</strong> the score, then large value scores will have larger tiles. The reverse is true for <strong>Maximize</strong>. For example, the goal of Risk is to minimize the risk, so the direction is set to minimize so that higher risk scores appear more prominently in larger tiles. <strong>Note:</strong> This field only appears if Data Source is set to <strong>Custom Script</strong> or <strong>Query Condition</strong>.</td>
</tr>
<tr>
<td><strong>Result Limit</strong>*</td>
<td>Defines the maximum number of results allowed. The upper limit is 100. <strong>Note:</strong> This only appears if Data Source is set to <strong>Custom Script</strong> or <strong>Query Condition</strong>.</td>
</tr>
<tr>
<td><strong>Result Precision</strong>*</td>
<td>Select the number of decimal digits to display in the scores for the indicators. <strong>Note:</strong> This only appears if Data Source is set to <strong>Custom Script</strong> or <strong>Query Condition</strong>.</td>
</tr>
<tr>
<td><strong>Automatic Refresh Interval</strong></td>
<td>Used to identify the refresh frequency for the treemap.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>If this check box is not selected, the indicator does not display in the treemap.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>The order that an indicator appears in the drop-down menu and list for a particular category. The order must correspond to the order value of the category to which you want the indicator to belong. For example, if the category order is 100, then the indicator order would start at 100 and increase to 101, 102, and so on, incrementally.</td>
</tr>
<tr>
<td><strong>Data Source</strong></td>
<td>Defines the location from which this indicator receives data. The following options are available.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Performance Analytics</strong>, which populates the treemap with the scores from indicators created in Performance Analytics. Indicators must be created in Performance Analytics prior to being created as an indicator in Service 360.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Custom Script</strong>, which allows you to write a script that collects data from another application to display in the treemap. Custom scripts only display on the treemap, and are not shown on the Service 360 dashboard.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Query Condition</strong>, which allows you to select a table to run filters on to obtain data to</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>display in the treemap. Results from the query conditions only display in the treemap, and are not shown on the Service 360 dashboard.</td>
</tr>
<tr>
<td>PA indicator*</td>
<td>Select the indicator from Performance Analytics that is to be displayed on the treemap.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if Data Source is set to Performance Analytics.</td>
</tr>
<tr>
<td>Default Breakdown*</td>
<td>Select the default breakdown that determines how the indicator is displayed. In the case of Service 360, the default breakdown is Business Service so that the indicator displays the scores for each business service in the system respectively, if the data is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if Data Source is set to Performance Analytics.</td>
</tr>
<tr>
<td>Custom Script*</td>
<td>HTML editor that allows you to create and customize the script.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if Data Source is set to Custom Script.</td>
</tr>
<tr>
<td>Query Table*</td>
<td>Source table to be queried.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if Data Source is set to Query Condition.</td>
</tr>
<tr>
<td>Aggregate Type*</td>
<td>The function to apply when calculating the score for a query on the query table. Possible values are Count, Sum, Average, Minimum, or Maximum.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if Data Source is set to Query Condition.</td>
</tr>
<tr>
<td>Aggregate Field</td>
<td>The field on the Query Table on which the Aggregate Type is run.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if Data Source is set to Query Condition.</td>
</tr>
<tr>
<td>Group by*</td>
<td>Select the field to sort the queried data.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears if Data Source is set to Query Condition.</td>
</tr>
</tbody>
</table>
### Field  Description

Query Conditions  As needed, set filter conditions to enhance the query.  

*Note:* This field only appears if Data Source is set to Query Condition.

Click Through URL Navigation Type  This feature enables the treemap to drill-in to another display when a tile on the treemap is selected. For Service 360, when a tile is selected you are re-directed to the Service 360 dashboard in Performance Analytics. There are three options: New Window, Current Window, or Modal Dialog.

Click Through URL Script  Edit the sample script using the HTML editor to customize the URL that you are re-directed to when a tile on the treemap is selected.

### Important: Ensure that the Data Source field is set to Custom Script. Additional fields display at the top of the form. Beneath the Data Source field, a sample script appears. Use the HTML editor to customize the script as needed. The result of running the script must be an array in order for the information to display in the treemap.

4. Click Submit.

#### Create indicators for query conditions
Query conditions are one of the data sources used to collect data for the treemap.

1. Navigate to Business Services > Administration > Indicator.
2. Click New.
3. Complete the form using the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name*</td>
<td>Name of the new indicator.</td>
</tr>
<tr>
<td>Category*</td>
<td>Select the category with which you want this indicator to be grouped. For example, the out-of-box indicators for availability are grouped under the category Operation, while indicators for inherent and residual risk scores are grouped under the Risk category.</td>
</tr>
<tr>
<td>Direction*</td>
<td>Options are Minimize or Maximize. Choose the direction that is considered a positive change for the indicator. If the goal of the indicator is to Minimize the score, then large value scores will have larger tiles. The reverse is true for Maximize. For example, the goal of Risk is to minimize the risk, so the direction is set to minimize so that higher risk scores appear more prominently in larger tiles.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Result Limit*</td>
<td>Defines the maximum number of results allowed. The upper limit is 100.</td>
</tr>
<tr>
<td>Result Precision*</td>
<td>Select the number of decimal digits to display in the scores for the indicators.</td>
</tr>
<tr>
<td><strong>Note:</strong> This only appears if Data Source is set to Custom Script or Query Condition.</td>
<td></td>
</tr>
<tr>
<td>Automatic Refresh Interval</td>
<td>Used to identify the refresh frequency for the treemap.</td>
</tr>
<tr>
<td>Active</td>
<td>If this check box is not selected, the indicator does not display in the treemap.</td>
</tr>
<tr>
<td>Order</td>
<td>The order that an indicator appears in the drop-down menu and list for a particular category. The order must correspond to the order value of the category to which you want the indicator to belong. For example, if the category order is 100, then the indicator order would start at 100 and increase to 101, 102, and so on, incrementally.</td>
</tr>
<tr>
<td>Data Source</td>
<td>Defines the location from which this indicator receives data. The following options are available.</td>
</tr>
<tr>
<td>• Performance Analytics</td>
<td>which populates the treemap with the scores from indicators created in Performance Analytics. Indicators must be created in Performance Analytics prior to being created as an indicator in Service 360.</td>
</tr>
<tr>
<td>• Custom Script</td>
<td>which allows you to write a script that collects data from another application to display in the treemap. Custom scripts only display on the treemap, and are not shown on the Service 360 dashboard.</td>
</tr>
<tr>
<td>• Query Condition</td>
<td>which allows you to select a table to run filters on to obtain data to display in the treemap. Results from the query conditions only display in the treemap, and are not shown on the Service 360 dashboard.</td>
</tr>
<tr>
<td>PA indicator*</td>
<td>Select the indicator from Performance Analytics that is to be displayed on the treemap.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Breakdown*</td>
<td>Select the default breakdown that determines how the indicator is displayed. In the case of Service 360, the default breakdown is <strong>Business Service</strong> so that the indicator displays the scores for each business service in the system respectively, if the data is available.</td>
</tr>
<tr>
<td>Custom Script*</td>
<td>HTML editor that allows you to create and customize the script.</td>
</tr>
<tr>
<td>Query Table*</td>
<td>Source table to be queried.</td>
</tr>
<tr>
<td>Aggregate Type*</td>
<td>The function to apply when calculating the score for a query on the query table. Possible values are <strong>Count</strong>, <strong>Sum</strong>, <strong>Average</strong>, <strong>Minimum</strong>, or <strong>Maximum</strong>.</td>
</tr>
<tr>
<td>Aggregate Field</td>
<td>The field on the Query Table on which the Aggregate Type is run.</td>
</tr>
<tr>
<td>Group by*</td>
<td>Select the field to sort the queried data.</td>
</tr>
<tr>
<td>Query Conditions</td>
<td>As needed, set filter conditions to enhance the query.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Click Through URL Navigation Type</td>
<td>This feature enables the treemap to drill-in to another display when a tile on the treemap is selected. For Service 360, when a tile is selected you are re-directed to the Service 360 dashboard in Performance Analytics. There are three options: New Window, Current Window, or Modal Dialog.</td>
</tr>
<tr>
<td>Click Through URL Script</td>
<td>Edit the sample script using the HTML editor to customize the URL that you are re-directed to when a tile on the treemap is selected.</td>
</tr>
</tbody>
</table>

**Important:** Ensure that the Data Source field is set to Query Condition. Additional fields display at the top of the form and beneath the Data Source field. Complete the query as appropriate.

4. Click **Submit**.

**Link Service 360 to performance analytics**

Linking Performance Analytics to Service 360 is a crucial step to enable the ‘Click-Through’ feature for Service 360.

Without ‘Click-through’ enabled, when a tile is selected on the Treemap for the new indicator, you are re-directed to the Service 360 dashboard.

1. Navigate to **Performance Analytics > Dashboard > Service 360** and copy the URL specific to the dashboard you wish to display.
2. Navigate to **Business Services > Administration > Indicators** and select the indicator you wish to link to the Service 360 dashboard.
3. On the **Click through** tab, select **New Window** in the **Click Through URL Navigation Type** field.
4. In the **Click Through URL Script** field, use the HTML editor to edit the sample script and paste the copied URL into the script where appropriate.
5. Click **Update**.

The click through can be enabled to re-direct to other pages so long as it has a valid URL.

**Installed components**

Service 360 installs numerous plugins, tables, and user roles.

Just like Performance Analytics - Premium, Service 360 is a premium plugin. To turn on both plugins, contact a ServiceNow representative to get the following components installed:

- Plugins
- User Roles

Additional components can be optionally installed if you wish to obtain additional licenses for Risk Management, Project Portfolio Management, and Financial Management. Contact a ServiceNow representative for more information.
Plugins

The following plugins are installed with Service 360.

Note: All additional plugins, tables, and other installed components associated with the following plugins are also installed when the Service 360 plugin is activated.

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Plugin ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service 360</td>
<td>com.snc.service_360</td>
<td>Installs Service 360 functionality, as well as all of the plugins listed in this table, except Performance Analytics - Premium. Contact a ServiceNow representative to get Service 360 plugin installed.</td>
</tr>
<tr>
<td>Tree map</td>
<td>com.snc.treemap</td>
<td>Enables support for treemap view on any application.</td>
</tr>
<tr>
<td>Performance Analytics – Premium</td>
<td>com.snc.pa.premium</td>
<td>Performance Analytics allows the user to automate recurring information needs with scorecards and dashboards and by taking configurable snapshots of any data at regular intervals. Contact a ServiceNow representative to get this plugin activated.</td>
</tr>
<tr>
<td>Service Portfolio Management</td>
<td>com.snc.service_portfolio</td>
<td>Service Portfolio Management allows an organization to document the business services it proves using a standardized, structured format. Performance against availability commitments is calculated and can be displayed in a homepage.</td>
</tr>
<tr>
<td>Service Portfolio Management —SLA Commitments</td>
<td>com.snc.service_portfolio.sla</td>
<td>Adds SLA commitments to support Service Portfolio Management.</td>
</tr>
</tbody>
</table>
Tables

Service 360 collects information and data from existing tables installed with the plugins listed above. Therefore, no additional tables are installed with the Service 360 plugin.

User roles

Roles specific to Service 360 are those for Service Portfolio Management.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>360_user</td>
<td>The basic user role. User is allowed to view all treemaps, dashboards, categories, and indicators except those which require additional roles. This user cannot make any changes to the existing forms. Assigning this role also assigns the pa_viewer role so that this user can view the Service 360 dashboard.</td>
</tr>
<tr>
<td>portfolio_admin</td>
<td>In addition to all existing abilities for managing the Service Portfolio, related commitments, and availability, the Portfolio Admin is now able to view all treemaps, categories, and indicators, as well as, create additional categories and indicators and edit existing records.</td>
</tr>
</tbody>
</table>

If the optional Risk Management, Project Portfolio Management, and Financial Management plugins are installed, a user needs the following additional security roles assigned for these applications in order to view the reports in Service 360.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_risk.user</td>
<td>Grants user access to view Risk Management information. A 360_user with this role is able to view the Risk category, and related indicators. Having this role does not allow you to edit the records related to Risk in Service 360.</td>
</tr>
<tr>
<td>project_user</td>
<td>User of the project management application. A 360_user with this role is able to view the Investment category, and related indicators. Having this role does not allow you to edit the records related to Investment in Service 360.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>financial_analyst</td>
<td>This role gives rights to the financial management application, and grants the ability to use the Workbench. A 360_user with this role is able to view the Finance category, and related indicators. Having this role does not allow you to edit the records related to Finance in Service 360.</td>
</tr>
<tr>
<td>financial_mgmt_admin</td>
<td>Grants admin rights to the financial management modules. A 360_user with this role is able to view the Finance category, and related indicators. Having this role does not allow you to edit the records related to Finance in Service 360.</td>
</tr>
<tr>
<td>financial_mgmt_user</td>
<td>Grants user rights to the financial management modules. A 360_user with this role is able to view the Finance category, and related indicators. Having this role does not allow you to edit the records related to Finance in Service 360.</td>
</tr>
</tbody>
</table>

To set up dashboards and indicators in Performance Analytics, the user needs one of the following roles.

Table 245: Roles required to set up Performance Analytics dashboards and indicators

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pa_admin</td>
<td>An administrator can create new indicators, formulas, thresholds, and targets. An administrator can also add breakdowns, apply aggregates, create and edit dashboards, and change system configuration files, such as colors and layout. This role also includes the pa_data_collector role which would enable the admin to define and edit data collection jobs and job events, view job logs, and define and edit indicator sources, breakdown sources, bucket groups, and scripts.</td>
</tr>
<tr>
<td>pa_power_user</td>
<td>A power user has the same abilities as the administrator, except they are not able to change system configuration files and alter the data collection jobs.</td>
</tr>
</tbody>
</table>

Script Includes

Script includes specific to Service 360 are:
Table 246: Script includes specific to Service 360

<table>
<thead>
<tr>
<th>Script Includes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EstimateOverBudgetProjectFilter</td>
<td>Script filter for projects estimated over budget.</td>
</tr>
<tr>
<td>ServiceProjectsBehindScheduleFilter</td>
<td>Script filter for projects behind schedule.</td>
</tr>
<tr>
<td>Service360ClickThroughUtils</td>
<td>Script to generate the click through URL for Service 360.</td>
</tr>
</tbody>
</table>

My Services SLAs homepage

The My Services - SLAs homepage displays SLA result information. The My Services - SLAs homepage displays SLA result information for the service offerings (with SLA service commitments) to which a user is subscribed. For each service offering, a gauge displays SLA service commitment results for the last 7 days, last 30 days, and last 12 months.

For any cell in a gauge:
- To view the number of tasks that met the SLA versus the total number of tasks, point to the green check (indicates commitment is met) or red X (indicates commitment is not met).
- To open a report on the commitment, click the cell.

Figure 150: My Services - SLAs homepage

SLA commitments

The Service Portfolio Management - SLA Commitments plugin adds functionality to Service Portfolio Management.

In Service Portfolio Management, Service Offerings define different levels of service for an existing business service and Service Commitments define the services that are included with the service
For example, an organization may offer two levels of desktop support: a Standard offering provides commitments of upgrades and virus protection, and an Executive offering provides the standard commitments plus an availability guarantee of 98% from 8-5 on weekdays. Service Level Agreements (SLAs) allow the service desk to track whether they provide a level of service in a defined amount of time.

Service Portfolio Management - SLA Commitments allow commitments to be defined by an SLA, so that staff can track how efficiently the service desk meets commitments for a service offering.

**Note:** Service Offering SLAs run against records that have an associated Service Offering CI, and do not create standard task SLA [task_sla] records.

### Activate the SLA commitments plugin

Before activating this plugin, consider the installed components, dependencies, and impact.

- **Installed Components:** modules, a homepage, fields, tables, business rules, script includes, and a scheduled job.
- **Dependencies (installed automatically with the plugin):** Service Portfolio Management Plugin, Service Level Agreements (SLA) Plugin (active by default in the current version).
- **Impact:**
  - The plugin modifies the Process SLAs business rule to process Service Offering SLAs. Customers who have modified this business rule must contact customer support prior to installation or the plugin does not work and SLA results are not evaluated.
  - A new type of service commitment (SLA) is added to Service Portfolio Management.

1. Navigate to **System Definition > Plugins.**
2. Right-click the plugin name on the list and select **Activate/Upgrade.**
   
   If the plugin depends on other plugins, these plugins are listed along with their activation status.
3. Optional: If available, select the **Load demo data** check box.
   
   Some plugins include demo data—sample records that are designed to illustrate plugin features for common use cases. Loading demo data is a good policy when you first activate the plugin on a development or test instance. You can load demo data after the plugin is activated by repeating this process and selecting the check box.
4. Click **Activate.**

### SLA commitments new tables

The following tables are added.

<table>
<thead>
<tr>
<th>Display Name [table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Offering SLA [service_offering_sla]</td>
<td>Stores SLA definitions that apply only to service offerings. Extends contract_sla.</td>
</tr>
<tr>
<td>Service Offering SLA Results [service_sla_result]</td>
<td>Stores the SLA result calculations (daily, weekly, monthly, annual) for each service offering and each service commitment of type SLA.</td>
</tr>
</tbody>
</table>
SLA commitments new fields

The following tables are modified.

Table 248: New fields

<table>
<thead>
<tr>
<th>Display Name [table name]</th>
<th>Modification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Commitments [service_commitment]</td>
<td>Add fields to support SLA as a new type of service commitment.</td>
</tr>
<tr>
<td>Task SLA [task_sla]</td>
<td>Add field to support SLA calculations.</td>
</tr>
<tr>
<td>SLAs [contract_sla]</td>
<td>Add field to support new service offering SLA table.</td>
</tr>
</tbody>
</table>

SLA commitments business rules

The following business rules are added.

Table 249: Business rules

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate SLA Result History</td>
<td>when a new SLA service commitment is added to a service offering, calculates SLA result records for the previous year so that the My Services - SLAs homepage displays relevant information.</td>
</tr>
<tr>
<td>Process SLAs (modified)</td>
<td>runs after every task is inserted or modified and evaluates the Start, Pause, and End conditions for the SLA. This rule is modified to process Service Offering SLAs along with standard SLA definitions. Customers who have modified this business rule cannot install the updated version automatically.</td>
</tr>
</tbody>
</table>

SLA commitments script includes

The following script includes are added.

Table 250: Script includes

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLAResultSummarizer</td>
<td>calculates daily, weekly, monthly, and annual SLA results records used by SLA homepage gauges. Called by the Calculate SLA Results scheduled job.</td>
</tr>
<tr>
<td>SLAResultCalculator</td>
<td>used by the SLAResultSummarizer script include.</td>
</tr>
<tr>
<td>SLAResultRecord</td>
<td>used by the SLAResultSummarizer script include.</td>
</tr>
</tbody>
</table>
SLA commitments scheduled job

The Calculate SLA Results scheduled job is added that calls the SLAResultSummarizer script include. It runs nightly and calculates the daily SLA results for the previous day. It also calculates the weekly, monthly, or annual results after the last day of a week, month, or year. These records are used by SLA homepage gauges.

Define commitments on a service offering with an SLA

Define a service offering that consists of a set of service commitments, which are specific services. Service commitments uniquely define the level of service in terms of availability, scope, and pricing. You can define your service commitments with an SLA that allows the service desk to track whether they provide a level of service in a defined amount of time.

To define a commitment on a service offering with an SLA, complete the following procedures:

1. Define an SLA that applies to service offerings.
2. Add the SLA to a service commitment.
3. Add the SLA service commitment to the service offering.

Define SLAs that apply to service offerings

Define an SLA which is a record that specifies the time within which a service must be provided and you can apply this to a service offering.

To define an SLA that applies to service offerings:

1. Navigate to Business Services > Service Offering SLAs > SLAs.
2. Click New.
3. Enter the SLA definition details.
4. Click Submit.
Add SLAs as service commitments

Service commitments define the services that are included with the service offering. Hence, adding Service Level Agreements (SLAs) as service commitments enable the service desk to track whether they provide a level of service within the stipulated time.

To add an SLA as a service commitment:
1. Navigate to Business Services > Commitments.
2. Click New.
3. In the Name field, enter a name for the SLA service commitment.
4. In the Type field, select SLA.
5. In the SLA field, enter an SLA definition. Any SLA definition may be referenced; however, Service Offering SLAs provide the advantage that they are evaluated only when the Configuration Item on the relevant task is a service offering.
6. In the SLA percentage, enter the percentage (as a decimal) of tasks that must meet the SLA Definition for the SLA to be considered met.
For example, an SLA Service Commitment may require Priority 1 incidents to be resolved within 1 hour (defined in the SLA field) 90% of the time (defined in the SLA percentage field).

7. Click Submit.

Add SLA service commitments to service offerings

Service offerings define different levels of service for a business service. Therefore, adding SLA service commitments define the services that are included in the service offering at different levels of service.

To add an SLA service commitment to a service offering:

1. Navigate to Business Services > Service Offerings.
2. Open the service offering to which you are adding the SLA service commitment.
3. In the Service Commitments related list, click Edit....
4. Using the slushbucket, select the SLA service commitment to add and click Save.

You can run a slushbucket filter of SLA is not empty to view all available SLA service commitments.
Index

Special Characters

<feature name>
  activate 167

A

actual elapsed time 842
  add
    change state 190
    custom business rules 838
    new state 185
  add new change state 190
  add related records
    new record 521
  add state change condition 203
  Add Variable set 597
Administration
  service catalog 655, 679
advanced configuration options
  password reset 461
application
  Contract Management 310
application dependencies 903
Applying roles 653
approval
  types
    changing 771
    defining 769
    expiring 771
    publishing 771
Asset an CI management
  set asset states and substates 40
Asset and CI management
  adding depreciation to asset 33
  allocate pre-allocated assets 36
  consume consumable assets 44
  create assets 29
  create consumable assets 43
  create fixed assets 38
  create license assets 40
  create pre-allocated assets 34
  delete assets 45
  depreciation with fixed assets 39
  life cycle of consumables 41
  split pre-allocated assets 36
  view consumable assets 42
asset classes
  create 25
Asset Management
  Asset and CI management 27
  asset classes 25
  asset classes, create 25
  Asset Management Overview module 5, 5
  calculate software licenses 103
  counters 115, 116, 116, 117, 118, 122, 122, 124, 126, 128
  create a custom license type 108
create license calculation script 109
  determine where software is installed 82
  IBM PVU Process Pack 131
  installed with 8
  installed with Model Management 18
  Installed with Oracle process pack 145
  installed with Software Asset Management 72
license calculation types 104
license calculations 103
manage software licenses 90, 94, 96
managing software models 97, 100
obtaining asset information 23
Oracle mapping 147
Oracle process pack 144, 144
Oracle software counter 144, 147
Oracle software license 146
Oracle software models 144
process 23
software asset management 86
software discovery models 110, 111, 111, 112
software license reconciliation 115, 116, 116, 117, 118, 122, 122, 124, 126, 128
Asset Management Overview module
  use 5
asset state
  set 40
asset substate
  set 40
assets
  delete 45
assignment rule
  for change requests 174
  incidents 395
attachment contents 415
automated conflict detection 234
B
Baseline
  creating 244
  differences
    displaying 244
Baseline CMDB 243
blackout schedule 209
blocked user 494
bulk CI changes
  proposed change 236
Bulk CI changes
  installed components
    Business rules 168
    Client scripts 168
    tables 168
bulk requests
  enabling 688
  using 762
business elapsed time 842
business service catalog
  business service entries, configuring 884

© 2017 ServiceNow. All rights reserved. 943
business service entries, making visible 888
business service map 399

canceled task 854
catalog
designer 765
Catalog
designer 765
Catalog Item Designer
create an item 782
create new item version 795
define an item approval 788
define an item question 784
define an item section 793
define an item task 790
expired item 794
installed components
tables 795
manage a category 780
process flow 765
publish an item 794
republish an item 794
request a category 777
unpublish an item 794
view published item 794
catalog items
add 589, 589
adding ordered item links 608
additional catalogs 589
additional categories 589
configure cart layout 663
defining 586
editing
from the service catalog 589
exists in categories display
hiding 716
restrict behavior
by item type 680
service catalog 586
set recurring price 682
setting preview number 704
catalog variables
service catalog 628, 632
using 628, 632
categories
create 923
categorizing incidents 387, 387
category
requests
processing 774
change 149, 207
Change
properties 169
change management 149, 152, 152, 222, 226
Change Management
affected CIs 218
Associate multiple CIs 218
change risk assessment 210, 211, 233
Disable multiple CI association 221
Extend multiple CI association 221
impacted CIs 218
ITIL 149
manage CI changes 217, 218
risk assessment 232
change password
SMS codes 472
change request
assignment rules 174
close 222
create 222
close request on hold 238
progress 222
review 222
change request on hold 238
change risk calculator
advanced conditions, using 216
condition filter, using 216
module 214
script, using 216
change state
new 190
change state example 190
Change State Model 179
change state tutorial 190
change type
new 175
change verification rule 246
changing
approval types 771
task assignment types 773
CI
proposed changes
add 245
displaying 245
CI class
reclassify 267
CI relation rollups
create 261
CI relations formatter
CI relationship builder 258
flat layout 254
tree layout 255
CI relationship editor 255
CI relationships
security 261
select targets 260
CI type
create 266
close incidents 403
Close Incidents
customizing
behavior 522
closing related incidents
problem 506
CMDB
- Extended 287
CMDB Classifications
- CI Attributes 264
- CMDB tables 263
- relationship rules 265
compare template 207
configuration
- CMDB 262
- CMDB 265
- Related Lists of CI components 265
Configuration
- attach 406
- incident 406
configuration management 239, 240
Configuration Management
- CI forms 287
- related lists 287
configure
- SLA 815
- SLA properties 829
- standard change catalog 205
configure Service 360 923
configure SLA properties 829
configure state model 203
configure state transition 203
configure UI action
- create a record on another table 521
conflict detection
- activate 157
- installed components
  - properties 157
  - tables 159
consumable assets
- consume 44
- create 43
- view 42
consumables
- life cycle of 41
contact administration
- responsibilities, incident alerts 360
containment service rule metadata 283
content items
- adding 606
- service catalog 606
contract management
- approval history 327
- components 311
- contract life cycle 315
- contract notification 325
- installed components
  - business rules 313
  - client scripts 312
  - roles 312
  - script includes 312
  - tables 311
  - user roles 312
Contract Management
- use contract management 315, 317, 320, 321, 322, 323, 324, 325, 326, 327, 328, 335, 335
Contract Management Overview Module 310
Contract Rate Cards and Expense Lines 329, 330, 331, 332, 332, 332, 332, 333
contracts 317
Contracts
- monitoring 333, 334
conversion process
- organize 865
convert SLA
- task SLA 866
copy
- catalog item 589
create 605
create change
- from incident 423
Create Incident Alerts
- create an alert directly 362
- create an alert from an incident 365
- view related lists 365
Create Knowledge
- access an external knowledge article 507
- communicate a workaround 507
- modify the UI action 514
- post knowledge 514
- post news 514
- use the knowledge check box 515
create problem
- from incident 425
create variable set 638
credential store type
- create 449
- credential store types 447
credential stores
- create 443
- deleting 445
test connection 445
Ctrl-Alt-Del 497
Ctrl+Alt+Del 449, 450
custom business rules
- add 838
custom shopping cart
- create 688
customizing
- behavior
  - Close Incidents 522
D
define assignment rule
- problems 523
Define order 641
defining
- approval
  - types 769
- question
  - types 766
task assignment
  - types 771
Delivery forms 676, 677, 678, 678, 679
dependency views
- incident management 407
Dependent identification rule 268
designer
catalog 
    item 765
device identification 
    help the help desk 293
Devices 
    mobile 717
Discovery 
    vs. Help the Help Desk 293
duplicate task 857
duration 
    SLA 821

E

Elapsed time 842
Email 
    inbound 523
problems 523
enterprise cmdb 
    relationships 307
enterprise configuration management database action icons 288
entitle a license 
    configuration item 92
    user 92
Escalation 864
Escalation engine 864
execution plan 
    tasks 742
execution plan approval tasks 742
Execution Plan Tasks 746, 746
execution plans 
    using 756
Expense Line 
    expense allocation rules 342, 346
    expense allocations 343, 343, 345
    expense line 343
    expense lines 342, 343, 345, 346, 346
    installed with 340
    scripted allocations 346
expense lines 
    example 338
    plugin 338
Expense Lines 
    expense allocations 342
    expense line 342
expiring 
    approval 
    types 771
    task assignment 
    types 773

F

failed login attempts 
    managing 492
failed logins 
    viewing 493
fixed assets 
    create 38
    use depreciation 39

Flexible checkout 676, 677, 678, 678, 679
fulfillment group 
    set up 745
fulfillment process 
    define 728

G

Gather Problem Data 
    check known errors and the knowledge base 500
    check related records 500
    use the business service map 500
    use the CDMB 500
    use the cmdb baseline 504
get started with SLAs 864

H

help the help desk 
    login script 
    install 297
    use 297
Help the Help Desk 
    detect software on 64-bit systems 303
    determine values for the Assigned to field 301
    Error message 304
    run script 299, 302, 303
    SOAP authentication 294, 294, 296, 296
    user roles 292
    view scan results 302
Help the Help Desk password 
    encode 298
help the help desk status 
    access 300
How SLA works 841

I

IBM 
    process pack 136
    Process Pack 131, 131, 132, 132, 135, 137, 140, 142
    PVU 131, 131, 132, 132, 135, 136, 137, 140, 142
Identification 268
Identification and Reconciliation 268
Identification Types 
    defining 471
incident alert 353
Incident alert 
    Incident alert task 368
Incident Alert 
    contact 355
incident alert management 
    example 380
    roles 380
Incident Alert Management 
    activate 347
    create incident alerts 362, 362, 365, 365
features 347
    installed with 347
    process incident alerts 367, 368, 368, 370, 371, 373
    use contacts with incident alerts 355, 355, 356, 358, 359

Flexible checkout 676, 677, 678, 678, 679
fulfillment group 
    set up 745
fulfillment process 
    define 728

G

Gather Problem Data 
    check known errors and the knowledge base 500
    check related records 500
    use the business service map 500
    use the CDMB 500
    use the cmdb baseline 504
get started with SLAs 864

H

help the help desk 
    login script 
    install 297
    use 297
Help the Help Desk 
    detect software on 64-bit systems 303
    determine values for the Assigned to field 301
    Error message 304
    run script 299, 302, 303
    SOAP authentication 294, 294, 296, 296
    user roles 292
    view scan results 302
Help the Help Desk password 
    encode 298
help the help desk status 
    access 300
How SLA works 841

I

IBM 
    process pack 136
    Process Pack 131, 131, 132, 132, 135, 137, 140, 142
    PVU 131, 131, 132, 132, 135, 136, 137, 140, 142
Identification 268
Identification and Reconciliation 268
Identification Types 
    defining 471
incident alert 353
Incident alert 
    Incident alert task 368
Incident Alert 
    contact 355
incident alert management 
    example 380
    roles 380
Incident Alert Management 
    activate 347
    create incident alerts 362, 362, 365, 365
features 347
    installed with 347
    process incident alerts 367, 368, 368, 370, 371, 373
    use contacts with incident alerts 355, 355, 356, 358, 359
incident alerts
subscribe to 381
incident management
dependency views 407
Incident Management
categorizing incidents 386
create a record producer 389, 392
create a record producer with a template 392
diagnosing incidents 398
identifying incidents 386
incident closure 402
incident escalation 400
incident investigation and diagnosis 398
incident resolution and recovery 408
log incidents 392
logging incidents 389
prioritizing incidents 388
service improvements 414
incident promotion
change 400
problem 400
UI action 415
incident resolution information
tracking 405
incident SNX 423
incident ticketing integrations
bi-directional 419
implementations 416
uni-directional 416
incidents
assign to group 395
categories 387, 387
resolved
automatically closing 405
Independent identification rule 268
indicators
create
custom scripts, for 927
Performance Analytics, for 924
query conditions, for 930
installed components 933
installed with
Email notifications 167
events 167
Installed with Catalog Item Designer 795, 796, 796, 797, 800, 802, 803, 805
IT service management 5
items
viewing 777
ITIL
service design 242
service transition 242
ITIL configuration 239, 240
ITIL configuration management 289
ITIL Configuration Management
integration 240
ITL change management 149
ITSM 5

K
KB Field 415

Key concepts 902

L

legacy SLA field 864
license assets
create 40
license calculations
calculate software licenses 103
create custom license type 108
create script 109
license calculation types 104
link cart
catalog item 688
Link Service 360 to Performance Analytics 933
Locations module 148
login
create a credential store type 449
define credential store types 445
enrollment check script includes 488
enrollment form processor script includes 489
extension scripts 477
extension scripts example 478
identification form processor script includes 488
installed password reset script includes 488
password change 458, 461
password generator script includes 489
password reset 429, 430, 458, 461
post processor script includes 490
user account lookup script includes 489
verification processor script includes 490
Login
extension scripts 476
installed workflows 436, 447
password reset 430, 432
Password Reset 451
password reset properties 453
logins
viewing failed 493
logs
failed login 493

M

Made SLA 864
maintenance schedule 209
manage change 149
Manage CI Changes
affected CI's 217, 218
change requests 218
dependency views 218
impacted services 217
Manage Software Licenses
create an entitlement 90
downgrade a license 94
merge software licenses 96
Managing Assets
retire assets 45
manual conflict detection 235
map 407
model categories
create 567
create asset manually 569
delete 570edit 570
view 567
model management
business rules 18
client scripts 19
installed with 18
properties 20
script includes 21
tables 21
UI policies 22
user roles 22
models
application 556
bundle
add model components 553
bundled 553
consumables 552
creating new 549, 556, 556, 556
delete 557
fields 549
hardware
compatible models 551
substitute models 552
publish to catalog 557
skills 557
software 556
modify 207
Monitoring Password Reset Activity 491, 493, 494, 494, 496, 496
move from 2010 engine to 2011 engine 865
move to SLA plugin
old engine 864
multiple incidents
closing 402
create business rule 404
create UI action 403
form view 414
using a UI action 404
Notification
SLA 863
notification message content 382
notifications
viewing 776
Notify with Incident Alert Management
adding 377
Conference call 375
conference call information 378
launching 375
participants 377
responses to conference call invitations viewing 379
sending 375
SMS Notifications 375
using 374
viewing 378
NotifyNow
SMS codes 472
O
old SLA engine
reactivate 873
Order guide 597
Organization Management
create new manufacturer 147
create new vendor 147
Locations module 148
out-of-box configuration 905
overview 901
P
password
reset 491
password change
advanced configuration options 461
SMS codes 472
Password Change
design the process 452
monitor activity 495
password reset
activate 429, 430
advanced configuration options 461
configure on an active directory 442
downloading Windows installer 451
enroll 498
enroll SMS 499
enroll using security questions 499
example 493
identification types 471
installed components
business rules 432
script includes 437
soap messages 439
tables 430
monitor activity 495
orchestration add on 430
password change 429
process form fields 458
roles 432
N
new
change type 175
new call wizard
using 411
new change type 175
new manufacturer
create 147
new SLA condition rule
define 826
new state
add 185
new state change condition
add 203
new vendor
create 147
NG CI relations formatter 251
notification
filter 381
subscribe to 383
Geneva    ServiceNow    Index

SMS codes 472
UI macros 435
Password Reset
design the process 452
installed with 430
monitor activity 495
plan the process 451
Windows Application 449, 450
Windows installation 450
Password Reset CMS Integration 439
Password Reset Properties
set a property 453
password reset questions
configuring 469, 470
password reset scripting
examples 473
Perl API Incident 408
pre-allocated asset
allocate 36
split 36
pre-allocated assets
create 34
price model
set 898
price unit
set 898
problem
closing related incidents 506
Problem
requesting a change 524
Problem Management
associate a task to an outage 519, 519
create knowledge 506
create knowledge from a problem 510
create knowledge from an incident 508
create knowledge manually 510
create outage from task 519
creating knowledge 507, 507, 514, 514, 514, 514, 515
gather problem data 500, 500, 500, 500, 500, 500, 504
make an attachment visible 514
Perl API problem 522
task outage 518
problem template
create 516
problem templates 517
Process Incident Alerts
close an alert 370
resolve an alert 368
run incident report 373
run post incident review 368
view dashboard 371
processing requests
category 774
processing within SLA 841
procurement
activate 527
consumable asset 547
create 539
create an asset 544
create purchase order 537
edit a catalog task 536
purchase order
cancel 542
reorder 543
purchase order line item
cancel 543
reorder 543
purchase order management 535
purchase order status 541
purchase orders
expected delivery date 542
receive assets 545, 545
receiving slip 546
receiving slip line 546
reserve asset 544
roles 524
service catalog
cancel request 535
track request 535
view a catalog task 536
workflows 525
Procurement 527
procurement overview module
use 527
product catalog
activate items 566
create item 561
create vendor catalog items 558
deactivate item 566
installed components
business rules 549
client scripts 548
roles 548
script includes 548
tables 547
items 561
link to hardware catalog 559
link to software catalog 560
publish to hardware catalog 560
publish to software catalog 561
synchronize information 558
vendor catalog 557
view vendors 561
Product Catalog 547
propose 207
proposed changes
create validation script 248
edit validation script 248
verify 247
publishing
approval
types 771
task assignment
types 773
purchase order
create from a request 532
pwd_user_lockout table 494
Q
question
types
defining 766
R

Reconciliation 268
Record Producer
create from tables 603
create new 600
set up 605
related incidents
checking 398
related list
icon 399, 399
related records
autoclose 521
relationship editor
filter list of CI relationships 256, 260
select a CI relationship type 256, 260
select targets 256
relationship filter
create 254
edit 254
relative duration 819
remote credential stores 442
request fulfillment
manage 727
workflows 728
request items
source 532
requests
category
processing 774
reset password
SMS codes 472
reset passwords
monitor activity 495
reset your password 497
retire 207
retroactive pause
SLA 829
risk assessment
changes 232
define 211
S

schedule
SLA 821
scheduled jobs
SLA 845
Scope
business 890
service 890
script includes
password reset extension 480
Security Questions Verification 469, 470
Service 360
application dependencies 903
configure Service 360 923
create categories 923
create indicators
custom script 927
Performance Analytics, for 924
query conditions, for 930
installed components 933
key concepts 902
link to Performance Analytics 933
out-of-box configuration 905
overview 901
service catalog
adding to 606
catalog items 586
catalog variables 632
content items 606
defining 586
hiding prices 687
navigating 758
requesting item 760
searching 713
set up 578
variables
auditable 638, 764
viewing 758
Service catalog
Catalog Items 586
Categories 583, 585, 585, 649, 702, 712, 715, 715, 725
Extension 592, 688, 708
Items 648
Requests 761
script 591
Scripting 592, 688, 708
Variable pricing 681, 681, 681, 682, 682, 687
Service Catalog
access controls 645, 645, 649, 650, 650, 650, 651, 654, 655, 655, 656
administration 655
Create new 579
desktop order status
configure 668
hiding prices 685, 687
item widgets
configure 665
Manage items 581
Manage portal pages 581, 727
mobile order status
configure 670
Modules 579
Multiple 590, 708, 725
multiple service catalogs 579
one-step shopping cart
configure 671
order guide widgets
configure 664
properties 572
roles 571
set up 579
setup 578
terms 571
two-step shopping cart
configure 672
two-step shopping cart mobile
configure 670
UI policy
creating 609
using 758
add 941, 942
define 940, 940
homepage 937
new business rules 939
new fields 939
new tables 938
scheduled job 940
script includes 939
SLA condition class
define 826
SLA condition rule
create 827
customize 826
extend 826
invoke globally 828
invoke on a specific SLA 828
SLA condition rules 824, 826
SLA Definition
create 816
SLA definitions 815
SLA Due 864
SLA engine 841
SLA process 835
SLA processing 841
SLA properties
configure 829
SLA record 854, 857
SLA timeline
activate 852
installed components 853
view 853
SLA Timeline
installed components
script includes 853
SLA timeline tutorial 853, 854, 857
SLA transitions 823
SLA workflow
SLA 818
workflow 818
SLAConditionBase 824
SLAConditionSimple 825
SMS code
password change 472
SMS codes
change password 472
password reset 472
reset password 472
via NotifyNow 472
SNCRoleUtil function 395
SOAP credentials
set up for password reset 442
software
find on network 82
installed 82
scan installations 85
software asset management template
overview module 69
using 69
Software Asset Management
activate 81
installed with 72
Overview module 69
setup process 81
software contracts
creating 143
viewing 143
software discovery models
automatic matching to an existing model 111
create new models 112
edit 111
Software License Compliance Checker
using 114
Software licenses
add new 86
create and manage subscription license 88
create software user license entitlement 91
downgrade a license 94
entitle license to configuration item 92
entitle license to user 92
entitlements 89
upgrading 93
view list of unallocated software licenses 24, 95
Software Licenses
creating enterprise licenses 88
customize and upgrade 93
standard change catalog
configure 205
standard change proposal 207
state model
activation 153
emergency change 182
installed components
properties 155
state model 155, 156, 156
tables 156
normal change 181
State Model
activate 152
installed components 155
stockrooms
create 64
create stock rules 68
create types 67
delete 65, 65
type rules 67
types 65
view assets 63
Strong identification rule 268
suggested CI relationship
add 251
T
table
Task SLA 869
Task
conditions 750
script 752
skipped 754
task assignment
types
changing 773
defining 771
expiring 773